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Introduction
This chapter introduces you to ACR/Summary and to this user guide. It
contains the following sections:







“About the User Guide” on page 11
“Other Documentation” on page 13
“About ACR/Summary” on page 13
“Major Features” on page 14
“Contacting Customer Support” on page 16

About the User Guide
This guide provides instructions for ACR/Summary for z/OS. Following is
a description of the components of this guide:

 The remainder of this chapter provides an overview of ACR/Summary
including a description of the major features.

 Chapter 2, “Preparing to Use ACR/Summary” provides the information
you will need to get ready to use ACR/Summary.

 Chapter 3, “Tutorial” gives you practice with the basic procedures for
setting up and running a balancing job.

 Chapter 4, “Setting the User Options” discusses ACR/Summary systemwide user options that you can optionally modify.

 Chapter 5, “Entering Basic Job Information” explains what a balancing
job is, discusses the types of job definitions, and provides a high-level
description of the process of creating balancing jobs. In addition, it
shows you how to define the basic job information.

 Chapter 6, “Creating Job Definitions” provides information for setting
up job definitions other than the basic job information.

 Chapter 7, “Creating File Definitions” explains how to define an input
source file for your job and create file definitions that will enable ACR/
Summary to locate the pertinent records and extract the required
values.

 Chapter 8, “Testing and Running Jobs Online” shows you how to test
your definitions online before putting them into production.
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 Chapter 9, “Running Balancing Jobs and Other JCL in Batch” explains
how to create and run the JCL for multiple functions and lists the ACR/
Summary DD statements.

 Chapter 11, “Understanding Variable Cycle Processing” explains how to
control the retrieval of a history item based on the run date and time or
the cycle ID of another job or both.

 Chapter 24, “Using Translation Tables and Cycle Tables” explains how
to set up and use internal and external translation tables and cycle
tables.

 Chapter 10, “Balancing in File Interface Mode” explains the most
typical application interface mode for running a balancing job.

 Chapter 11, “Balancing in Direct Input Mode” explains the application
interface mode that enables you to enter the control values to be used in
balancing directly, rather than having them extracted from input
sources.

 Chapter 12, “Balancing in Program Interface Mode” explains the
application interface mode that requires a programmer to make simple
source code additions to extract the application control values and call
the program interface program.

 Chapter 13, “Balancing in Spool Monitor Mode” explains the
application interface mode that utilizes a started task to extract control
values from data residing on the JES spool.

 Chapter 14, “Using the History Analysis Function” explains a feature
that analyzes your history data and reports the findings.

 Chapter 15, “Using DB2 Tables as Input Sources” provides two methods
of using a DB2 table as an input source.

 Chapter 16, “Using the Batch Utilities” describes the batch utilties, most
of which are used for reporting on and maintaining your databases.

 Chapter 17, “Using the Online Utilities” discusses the utilities for
maintaining ACR/Summary definitions, moving definitions into
production, browsing the history database, and performing date
conversion.

 Chapter 18, “Setting Up Free-Form Reports” explains how to set up a
custom report that can include any of the control values obtained when
the job is run, along with their descriptions.

 Chapter 19, “Setting Up User Reports” explains how to set up a custom
report that can print any of the data that can be included in the Control
Report in the order that you specify.
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 Chapter 20, “Using File Control Balancing” describes a feature that
enables you to capture information from output files and verify input
files before using them in a job.

 Chapter 21, “Setting Up Cycle Processing” explains cycle IDs and
describes the methods you can use to set, verify, and/or override a cycle
ID.

 Chapter 22, “Modeling Job and File Definitions” explains a feature that
allows file definitions and job definitions stored in the definition
database to be referenced by one or more balancing jobs.

 Chapter 23, “Using User Exits” provides information about COBOL
source files supplied with ACR/Summary that you can modify to
perform special processing tasks.

 Appendix A, “Batch Definition Transactions” describes the format and
use of batch definition transactions and provides record layouts.

 Appendix B, “Guide to Reports” provides a table to help you find
information about individual reports. Reports appear in the section
describing the corresponding utility or process.

 Appendix C, “Non-Biased Variance and Standard Deviation
Computations” explains and demonstrates these two computation
types available for history analysis.
This manual also contains a glossary and an index.

Other Documentation
The ACR/Summary and ACR/Detail Installation Guide for z/OS provides
instructions on installing ACR/Summary for z/OS.
For an explanation of batch system messages, see the Messages and Codes
manual.

About ACR/Summary
ACR/Summary is rule-based software that verifies the accuracy of key
business information including totals, subtotals, record counts, dates, and
text across applications, files, databases, and reports. ACR/Summary is
available for z/OS, Windows, UNIX, Linux, and IBM i.
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Major Features
The major features of ACR/Summary are listed below and detailed in the
next sections:







“User Interface” on page 14
“Application Interface Modes” on page 14
“Balancing Function” on page 15
“History Analysis Function” on page 15
“Utilities” on page 15

User Interface
The user interface consists of panels that enable you to set up your ACR/
Summary environment and set up and run balancing online and in batch.
For more information, see “Using the User Interface” on page 19.

Application Interface Modes
The application interface mode is the bridge between your application and
ACR/Summary. The following modes are available:

 File interface mode. This is the typical mode. It requires no changes to
your application code. It is especially well-suited for converting existing
applications to ACR/Summary automated balancing. For more
information, see “Balancing in File Interface Mode” on page 385.

 Program interface mode. This mode requires source code additions to
your application, and is typically used only for new applications or
applications whose programs are being developed or modified. There
are two methods of using program interface:

 The UAC200PI application program interface can be used to pass
the file and job information to UAC2000, the ACR/Summary file
interface program, which extracts the data based on your file
definitions and then performs the balancing.

 The UAC1000 balancing program is the original program interface
method. With this approach, you must add program statements to
your application code to extract the data. Your application then calls
the UAC1000 program, which checks the accumulated data and
performs the balancing.
For more information, see “Balancing in Program Interface Mode” on
page 403.
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 Direct input mode. Although this mode is primarily used for testing, it
can also be used to enter production control values that are not in a
machine-readable medium, such as numbers called in by users. For
more information, see “Balancing in Direct Input Mode” on page 395.

 Spool monitor mode. This mode is used to capture spooled output,
including console messages, for verification. For more information, see
“Balancing in Spool Monitor Mode” on page 433.

Balancing Function
The balancing function is the primary function of ACR/Summary. It
automatically compares and evaluates information extracted from the files
that drive your batch processes to detect errors.
Typically, an application consists of a job stream made up of one or more
job steps. At any point along this stream, you can insert a balancing step
(also called a balancing job) that will invoke the balancing function.
For most of your application job steps, the balancing requirements can be
met by including one ACR/Summary balancing step. If needed, a single
application job step can invoke multiple ACR/Summary balancing steps.
For more information, see “ACR/Summary Job Flow” on page 157.

History Analysis Function
History analysis applies history analysis definitions to historical production
data in the history database and produces the requested reports.
The following tasks can be performed:







Historical data can be summarized at multiple levels.
Values from corresponding periods can be analyzed.
Missing or incomplete data can be located.
Values falling outside an acceptable range can be highlighted.
Unusual fluctuations in values can be discovered.

Utilities
Utilities update the definition database and perform reporting and
maintenance functions on the history and definition databases. These
databases will be described in the following chapter. All utilities can be
accessed through the user interface.
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Contacting Customer Support
If you need assistance, contact Infogix Customer Support.
Support Phone: +1.630.505.1890
Support Email: support@infogix.com
Support Website: http://support.infogix.com
Fax Number: +1.630.505.1883
Visit our Website: www.infogix.com
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This chapter provides the procedures and interface information you will
need to get ready to use ACR/Summary. It contains the following sections:












“Navigation Conventions” on page 17
“Starting and Exiting ACR/Summary” on page 18
“Using the User Interface” on page 19
“Using the Cursor and Function Keys” on page 26
“ACR/Summary Components” on page 28
“Performing the Initial Setup” on page 34
“Specifying the ACR/Connector Domain Table” on page 43
“Creating, Opening, Saving, Copying, and Deleting Jobs” on page 44
“Setting the User Options” on page 50
“Analyzing Your Balancing Needs” on page 50

Navigation Conventions
This chapter provides detailed instructions to access menus, select options,
and accept your entries.
To avoid unnecessary detail, the > symbol will sometimes be used to
indicate the selections you need to make to navigate to a panel. For
example, here are the instructions for accessing the Basic File Information
panel in the Expert File Editor:
Select Window > Expert File Editor > File > New > Basic File
Information.
This condenses what would otherwise be a 6-step procedure:
1. Press F4 to move the cursor to the action bar.
2. Press the Tab key to move the cursor to the Window menu and press

Enter. The Window menu opens.
3. Type 2 (Expert File Editor) and press Enter. A blank Extract Window

displays.
4. Press F4 to move the cursor to the action bar.
5. Make sure the cursor is next to or on the File menu and press Enter.

ACR/Summary User Guide for z/OS
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6. Select 1 (New) from the File menu and press Enter. The Basic File

Information panel displays.
Unless otherwise noted, assume you start your navigation from the Job
Window.

Starting and Exiting ACR/Summary
To start ACR/Summary, do the following:
1. Log on to the mainframe and ACR/Summary according to your

company’s procedure. The Infogix start-up panel displays.
2. Select Product > ACR/Summary.

To exit ACR/Summary, do the following:
1. Save your work by selecting File > Save.
2. Use the F3 (Exit) function key until you have exited the product or

receive the confirmation exit panel (then press F5). If you have not
saved your work, you will be given an opportunity to save.
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Using the User Interface
Data is displayed in windows and panels. The distinction is hierarchical.
There is one primary window (the Job Window) and several secondary
windows (the Extract Window, Free-form Reports Window, Translation
Table Windows, and so on), all of which enable you to open panels to
perform specific tasks. When you open panels from within a window, the
window remains in the background.
Start-Up
Panel

The Job Window and
Extract Window are
always used.

ACR/Summary
Job Window

Cycle Table
History
Analysis
Translation

Extract Window

Table Window

Entry
Panel

Selection
Panel

Panel

Selection
Panel
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Windows
When you first start ACR/Summary, the system immediately brings you to
the Job Window, your primary starting point. From there, you can open
secondary windows through the Window menu on the action bar or you can
open specific panels related to the Job Window.
File Edit View Run Setup Window Help
-------------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 19

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.
C.
D.
E.
F.

Basic Job Information
Job Information:
Report Options:
Input Sources: 000
< NEW... >
Internal Items: 000
< NEW... >
Extended Internal Items: 000
< NEW... >
Extraction Variables: 000
< NEW... >
History Items: 000
< NEW... >

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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The following example shows the Job Window in expanded mode
(explained in the note below) with its major components.
Action Bar------>
Window Title---->

Selection Field->

Command Line---->
Function Keys---->

File Edit View Run Setup Window Help
-------------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 42

_
_
_
_
_
_
_
_
_
_
_
_
_
_

A.

Basic Job Information
Job Information:
AAAAAAAA AAAAAAAA
Store History:
Yes
Set Return Code:
Abend
Set File Control:
No
Access User Exit:
Only out of balance
Truncate/Round Results:
Round
Model Definitions:
No
Comments Exist:
Yes
Generate XML messages:
Yes
Report Options:
Control Report Title:
Print Control Report(COPY1): Always
Print Control Report(COPY2): No

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Action Bar. This lists several menus that provide access to other windows
or panels. To access the menu options, do one of the following:

 Position the mouse under a menu and press Enter.
 Press F4 or Home, tab to the item you want, and press Enter.
 Use the hot keys. The first letter of each menu (underscored) is a hot
key. Enter the letter on the command line and press F4.
Note:

Expanding/Compressing the Job Window:
You can control the level of detail displayed in the Job Window
as follows:
 Enter V next to a section to toggle on/off the display of
subsections.
 Select View > Compress Views or Expand Views to show
the lowest level of detail or the greatest, respectively.

Window Title. This is the window’s unique identifier.
Selection Fields. These allow you to select the item to the right of the
field. In the example above, you can either enter S to select the item and
open a related panel, D, to delete the item, or V to toggle expansion/
compression of the sub-headings.

ACR/Summary User Guide for z/OS
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Command Line. This allows you to enter TSO commands and press Enter
to accept the command.
The Function Keys that are available for a specific window appear at the
bottom of the window. Each of the function keys performs a particular
action. For more information, see “Using the Cursor and Function Keys” on
page 26.
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Panels
This section describes the types of panels used in ACR/Summary. When
you open panels from a window, the window remains in the background.

Entry Panels
Entry panels require that you type data in one or more entry fields and
press F5 to accept the data you entered. Below is an example of an entry
panel followed by descriptions of its major components. To see the panel
below, type S next to Job Information and press Enter.
Panel Title----->

Entry Fiel-e---->

Job Information
Enter a job ID:
Job name: ________
Step name: ________
Qualifier: __
Enter control report title:
________________________________________

Selection Field->

Function Keys---->

Select options to access:
_ Job run options...
_ Cycle processing options...
_ Alternate job ID information...
_ Rerun/audit trail options...
_ Extract file options...
_ Display/change comments...
F1=Help
F2=Split
F3=Exit
F5=Accept

F9=Swap

Panel Title. The panel title is the panel’s unique identifier.
Entry Field. Entry fields require you to type a string of alphanumeric
characters.
Selection Field. Selection fields require you to type a single letter,
number, or symbol (usually an S) to initiate an action related to the item to
the right of the field.
Function Keys. The function keys (F1, F2, etc.) that are available for any
of the panels display at the bottom of the window.
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Selection Panels
Selection panels require that you type a number, which corresponds to an
option in the selection panel, and press Enter or F5 to accept the option. If
F5 is to be pressed, it will be listed at the bottom of the screen. Below is an
example of a selection panel, followed by descriptions of its major
components.
Panel Title----->
Numeric
Selection Field->

Function Keys---->

Open Options
Select a choice:
__ 1. Open a job, bring in all associated files
2. Open a job, bring in selected files

F1=Help

F2=Split

F3=Exit

F9=Swap

Panel Title. This is the panel’s unique identifier.
Numeric Selection Field. These fields require you to type a number
corresponding to an item in the list to the right of the field.
Function Keys. The function keys (F1, F2, etc.) that are available for any
of the panels display at the bottom of the window.

Help Panels
Help panels contain descriptions or instructions regarding the application.

Types of Help
Below are the different ways you can use online Help in ACR/Summary.
Context-Sensitive Help
Context-sensitive Help is directly related to the location of the cursor on a
panel or window. Place the cursor at the location on the panel (for example,
an entry field) for which you need help and press F1. Below are the locations
from which context-sensitive Help is available.

 Menus. Place the cursor to the left of a menu on the action bar and press
F1. A Help panel is displayed describing the menu options.

 Selection Fields. When there is a list of items with single-spaced
selection fields to the left, place the cursor in one of the fields and press
F1 for a description of the letters or symbols you can enter.

 Entry Fields. Place the cursor in the entry field and press F1 to view a
description of the data required in that field.
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 Window/Panel/Selection Panel· If you press F1 when the cursor is not
in any of the previously mentioned locations, you will receive
information for the current panel or window.

Help Menu Options
To access these options, do the following: 1) In the Job Window, press F4 to
activate the action bar, 2) press the Tab key until the cursor is next to the
Help menu, 3) press Enter and enter the option you want, and 4) follow the
instructions on the panel that displays.
When you have finished, press F3 until you exit Help.
The help menu options are as follows:
1.
2.
3.
4.
5.

About ACR/Summary
How do I?...
Contents ...
What's new?...
Product expiration ...

1. About ACR/Summary. This option displays the release number.
2. How do I...This option provides instructions on how to perform

specific tasks in ACR/Summary.
3. Contents. This option provides definitions for various terms used in

ACR/Summary.
4. What’s new? This option describes new features for this release and for

the previous release.
5. Product expiration. This option displays the product expiration date

entered in the control file that is currently allocated to the online
system. The product expiration date is displayed in the YY/MM/DD
format.
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Using the Cursor and Function Keys
Moving the Cursor
Use the following keys to move the cursor in a panel or window.
Key

Function

Arrow keys

Moves the cursor a space at a time to the left, right, up, or
down.

Tab key

Moves the cursor from one menu or field to the next.

Home key

Moves the cursor to the upper, left-hand corner of the
window.

F4

Moves the cursor between the action bar and the body of
the window.

Using Function Keys
Every panel and window in ACR/Summary displays the function keys that
are currently available. If you do not see the function keys on the panels and
windows, type PFSHOW on the command line and press Enter. The
function keys will display. If you type PFSHOW OFF, they disappear.
Below are descriptions of the function keys in ACR/Summary.
Key

Function

F1

F1 displays context-sensitive online help.

F2

F2, an ISPF function, splits the screen between ACR/Summary
and the mainframe environment.

F3

F3 exits the panel or window you are currently viewing without
saving your changes and displays the previous panel or window.

F4

F4 toggles the cursor between the action bar and the body of the
window.
When adding job definitions, F4 allows you to remain in the
function so that you can quickly add similar job definitions.
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F5

F5 accepts entries you make in the panels that need to be saved to
the definition database.

F6

F6 adds a definition in the Extract Window, displays a list of items
in the Rules panel, and sometimes allows you to exit without
saving changes.
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Key

Function

F7

F7 displays the previous item panel when multiple items are
available.
F7 is also an ISPF function that moves the panel view up.

F8

F8 displays the next item panel when multiple items are available.
F8 is also an ISPF function that moves the panel view down.

F9

F9, an ISPF function, toggles the screen between the ACR/
Summary product and the mainframe environment.

F10

F10, an ISPF function, moves the panel view to the left.

F11

F11, an ISPF function, moves the panel view to the right.
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ACR/Summary Components
ACR/Summary uses the components described in the following sections:

 “Online Work Area” on page 29
 Partitioned datasets:
 “Definition Library (DEFNLIB)” on page 29
 “Transactions Library (TRANLIB)” on page 30
 “JCL Procedure Library (PROCLIB)” on page 31
 “User Options File” on page 32
 “Spool Monitor Parameter File” on page 33
 Two keyed VSAM files described in “Definition and History Databases”
on page 34
The following diagram shows these components.
Partitioned
Datasets
JCL Procedure
Library (PROCLIB)

Online
work area

User Options
File (USEROPT)
Transaction
Library (TRANLIB)

Definition
Library (DEFNLIB)

Spool Monitor
Parameter File (USPPARM)

Definition
Database
(DEFN)

History
Database
(HIST)
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Online Work Area
When a job is created, working copies of job and file definitions are stored
in a temporary work space called the online work area.

Definition Library (DEFNLIB)
Saving the job and file definitions places a permanent copy into the
definition library and another copy into the definition database (unless you
choose not to save to the database). These definitions remain until you
remove or replace them. You will learn more about the definition database
in “Definition and History Databases” on page 34.

Create
Definitions

Online
work area

Save

Definition Library
(DEFNLIB)

Definition
database
(DEFN)

Apply definitions

Extract previously stored

History
Database
(HIST)

Balancing

results as history items

store balancing results

The Definition Library and Definition and History Databases
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Transactions Library (TRANLIB)
This library stores batch transactions, which are 80-character images of the
records in the definition database (where the information needed to
perform the balancing function is stored). Batch transactions serve the
following purposes:

 Can be downloaded for use in ACR/Workbench or moved into the
production database.

 Can provide an audit trail of what is on the definition database.
 Can be manipulated quickly and easily in a TSO edit session.
 Provide a means to make mass changes to a set of definitions.

Create
Definitions

Online work
area

Create Batch
Transactions

Transaction Library
(TRANLIB)

Definition Library
(DEFNLIB)

Save

Update Batch Transactions Utility

Definition
Database
(DEFN)
History
Database
(HIST)

Apply Definitions

Extract Previously Stored

Balancing

results as history items

Store balancing results

Transactions Library

30

Infogix, Inc.

Preparing to Use ACR/Summary  2
ACR/Summary Components

JCL Procedure Library (PROCLIB)
This library stores the JCL you create. The JCL tells the system what
definitions to use and where to find the input files.
Through the interface, you can create JCL for running balancing jobs in
production, for generating reports, for running utilities, and for other
purposes.
To run balancing in batch, you will submit the JCL stored in the JCL
procedure library. When you run balancing online, the JCL is submitted
automatically. After the job completes, results are printed on the Control
Report and optionally stored in the history database to be referenced at a
later time.

User
Interface
Setup

Create
JCL

Create
Definition

Online work
area

Save

Create Batch
Transactions

Definition Library
(DEFNLIB)

Definition
Database
(DEFN)
History
Database
(HIST)

JCL Procedure
Library (PROCLIB)

Submit

Transaction Library
(TRANLIB)

Update Batch Transactions Utility

Apply Definitions

Extract Previously Stored

Balancing

results as history items

Store balancing results

JCL Procedure Library
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User Options File
ACR/Summary lets you globally override the system defaults for certain
processing options and for report formatting for balancing jobs. For
example, you can change the defaults for formatting dates and currency
amounts on reports. User options are stored in the user options file. For
more information, see “Setting the User Options” on page 115.

User
Interface

Create
Definitions

Setup

User
Options

Online work
area
Definition Library
(DEFNLIB)

Save

Definition
Database
(DEFN)
History
Database
(HIST)

User Options File
(USEROPT)

Transaction Library
(TRANLIB)

Create Batch
Transactions

Update Batch Transactions Utility

Apply Definitions

Extract Previously Stored

Balancing

results as history items

Store balancing results

User Options File
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Spool Monitor Parameter File
Spool monitor is an application interface mode that utilizes a started task
to extract control values from data residing on the Job Entry System (JES)
spool. It differs from the file interface facility’s direct spool access in that it
is initiated by the presence of specific data on the JES spool.
If the Spool Monitor feature is being utilized, the spool monitor parameter
file contains the ACRSPMC (ACR Spool Monitor Control) control record.
For more information, see “Balancing in Spool Monitor Mode” on
page 433.

User
Interface

C

1. Create the ACRSPMC control
record
2. Create the ACRSPMC JCL
3. Create the SUM2000 JCL

Setup

Spool
Monitor

Spool Monitor
Parameter File
Online work
area

Save

Definition Library
(DEFNLIB)

Definition
Database
(DEFN)
History
Database
(HIST)

Transaction Library
(TRANLIB)

Create Batch
Transactions

Update Batch Transactions Utility

Apply Definitions

Extract Previously Stored

Balancing

results as history items

Store balancing results
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Definition and History Databases
The definition database is a key-sequenced VSAM file containing various
types of ACR/Summary definitions, including job definitions, file
definitions, history analysis definitions, and table definitions. The
definitions contain the parameters specifying the processing requirements.
Definitions are typically created through the user interface but can be
created as batch definition transaction records.
The history database is a relative-record VSAM file containing the results of
previous balancing and history analysis runs. Each history record consists
of a job ID, cycle ID, and the control values extracted for each internal (or
extended internal) item.

Performing the Initial Setup
To use the TSO user interface, each user must perform a one time set up
process. The system leads you through all the necessary panels to store the
names of the user files and the database files, allocate the user files, specify
report files, and build a job card. The final step is the creation and
initialization of the databases. Generally, a separate initialization is used to
set up a test environment for each user. Initialization utilities can also be
used to create the production database.
You can repeat the setup any time you want to reestablish part or all of your
user environment. Reinitializing a database erases the contents.
You can start the initial setup in one of two ways:.

 If you have never performed the initial setup, after you start the
product, the Welcome to ACR/Summary panel displays. Follow the
prompts.

 If you want to repeat the setup later, select Setup > Initial Setup. The
Welcome to ACR/Summary panel displays.
The following setup panels will be displayed in sequence.
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“User File Defaults Panel” on page 35
“Allocate User Files Panel” on page 36
“Report File Defaults Panels” on page 37
“Job Card Panel” on page 38
“Library Information Panel” on page 39
“Database Initialization JCL Panel” on page 39
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User File Defaults Panel
The User File Defaults panel allows you to verify or change the default user
dataset names for user files and database files.
The default dataset name begins with your user ID, followed by a period,
followed by SUM, followed by a period, followed by an abbreviation for the
library name.
We recommend you use the existing names unless they conflict with your
site standards. If you want to make changes later, you can access this panel
by selecting Setup > Files > User File Defaults.
User File Defaults
Specify user file dataset names:
Definition library: . . . USR1.SUM.DEFNLIB__________________________
Transaction library: . . . USR1.SUM.TRANLIB__________________________
User options file: . . . . USR1.SUM.USEROPT__________________________
JCL library: . . . . . . . USR1.SUM.PROCLIB__________________________
Spool monitor parm file: USR1.SUM.USPPARM__________________________
Specify database dataset names:
Definition database(VSAM): USR1.SUM.DEFN_____________________________
History database(VSAM):
USR1.SUM.HIST_____________________________
How should generated JCL be treated?
1_ 1. Displayed
2. Automatically submitted
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

The first two sections of the screen are self-explanatory. The components
were described in “ACR/Summary Components” on page 28.
How should generated JCL be treated. Specify whether to display
JCL job streams as you create them (recommended) or automatically
submit.
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Allocate User Files Panel
The Allocate User Files panel enables you to allocate the space needed for
various files. If the datasets already exist, they will be deleted and
reallocated.
Allocate User Files
Place an 'S' next to items to select:
Volser
_
_
_
_
_

USR1.SUM.DEFNLIB__________________________
USR1.SUM.TRANLIB__________________________
USR1.SUM.USEROPT__________________________
USR1.SUM.PROCLIB__________________________
USR1.SUM.USPPARM__________________________

______
______
______
______
______

Number of tracks
Primary Secondary
0035
0035
0035
0035
0035

0005
0005
0005
0005
0005

Unit: SYSALLDA

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Place an ‘S’...Select each dataset you want to allocate. During initial
setup, you should normally select all datasets listed:
USR1.SUM.DEFNLIB. Definition library (also called the online work
area), which stores a working copy of your saved definitions.
USR1.SUM.TRANLIB. Transaction library, which stores all batch
definition transactions created using the create batch transactions
utility.
USR1.SUM.USEROPT. User options file, which stores global product
options you specify.
USR1.SUM.PROCLIB. JCL procedure library, which stores JCL you
generate with ACR/Summary.
USR1.SUM.USPPARM. Stores spool monitor parameters when you
create spool monitor definitions.
Volser. Optionally enter the site-specific volume serial number where the
user datasets will be allocated. This can usually be left blank.
Primary tracks. Optionally change the number of tracks initially
allocated for each dataset.
Secondary tracks. Optionally change the number of tracks added
incrementally if needed.
Unit. Unit where the data will be stored.
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Report File Defaults Panels
This panel shows the default dataset names for the report files that will be
used when you run online balancing and allows you to change their default
space allocations. The datasets will be allocated when online balancing is
executed.
For each report, the default dataset name begins with your user ID,
followed by a period, followed by SUM, followed by a period, followed by an
abbreviation for the report name. We recommend you use the existing
names unless they conflict with your site standards. If you want to make
changes later, you can access this panel by selecting Setup > Files >
Report File Defaults.

(First) Report File Defaults Panel
Report File Defaults

0 DATA SETS ALLOCATED

Control report copy1 DSName:
USR1.SUM.CONTROL1_________________________
Primary space: 0010 Secondary space: 0005 (tracks)
Control report copy2 DSName:
USR1.SUM.CONTROL2_________________________
Primary space: 0010 Secondary space: 0005 (tracks)
Recap report DSName: . . . . . USR1.SUM.RECAP____________________________
Primary space: 0010 Secondary space: 0005 (tracks)
User report DSName: . . . . . . USR1.SUM.USER_____________________________
Primary space: 0005 Secondary space: 0005 (tracks)
Unit: SYSALLDA
Managementclass:
F1=Help

F2=Split

Volume: ______
Storageclass: ________ Dataclass:
F3=Exit

F5=Accept

_________

F9=Swap

N DATA SETS ALLOCATED. This message at the top of the screen
displays number of successfully allocated datasets from the previous panel.
Primary space. Optionally change the number of tracks initially allocated
for each dataset.
Secondary space. Optionally change the number of tracks that will be
added incrementally if needed.
Unit. Unit where the data will be stored.
Volume. Volser where the report datasets will be stored (optional).
Managementclass, Storageclass, Dataclass. Optionally, if you use
SMS classes, these classes determine where the reports are stored.
After you press F5, the second Report File Defaults panel displays.
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(Second) Report File Defaults Panel
Report File Defaults (cont'd.)
History analysis report DSName: USR1.SUM.HANALY___________________________
Primary space: 0005 Secondary space: 0005 (tracks)
Extract file DSName: . . . . . USR1.SUM.EXTFILE__________________________
Primary space: 0005 Secondary space: 0005 (tracks)
Free-form report: . . . . . . . USR1.SUM.FREE_____________________________
Primary space: 0010 Secondary space: 0001 (tracks)
Unit: SYSALLDA
Managementclass:
F1=Help

F2=Split

Volume: ______
Storageclass: ________ Dataclass:
F3=Exit

F5=Accept

_________

F9=Swap

Use the instructions for the previous panel to complete this panel and press
F5 to accept.

Job Card Panel
This panel allows you to set up a batch job card, which will automatically
place a job statement (which you will edit) at the top of the JCL you create.
Job Card
Specify job card information:
----+----1----+----2----+----3----+----4----+----5----+----6----+----7
//USR1A____JOB_(ACCOUNTING),'YOURNAME',_________________________________
//__REGION=4M,CLASS=E,MSGCLASS=X,NOTIFY=USR1____________________________
//*_____________________________________________________________________
//*_____________________________________________________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Type the job statement starting on the first line. Continue on to the next
three lines if necessary.
Job statements are site-specified, but a typical job statement includes the
job name, accounting information, the reference name field, job class,
message class and the user ID to notify when messages are sent.
A //* indicates a comment line, which will be ignored during processing.
Press F5 to create the job card. Double-check the information before
pressing F5 again.
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Library Information Panel
This panel lists the dataset and member name of the JCL procedure library
(PROCLIB) and the names of the definition and history databases.
Typically you will want to accept the defaults. You may need make changes
if your installation has set up multiple PROCLIBs or multiple definition and
history databases.
Specify JCL library information:
Dataset name: . . . . USR1.SUM.PROCLIB
Member name: . . . . . SUMINIT
Definition database:
USR1.SUM.DEFN
History database: . . USR1.SUM.HIST

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Database Initialization JCL Panel
The Database Initialization panel allows you to enter information required
to initialize the ACR/Summary databases for production or testing. We
suggest that every user have his/her own test databases. Both a definition
database and a history database are required to run balancing.
The fields in the Database Initialization JCL panel include, among others,
the 1) Estimated number of unique job IDs and 2) Average number of
histories per job ID. These entries will be used to calculate DASD space for
both test and production databases.
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Database Initialization JCL Panel
Note:

 To run this JCL in batch, see Creating, Editing, and
Submitting JCL on page 370.
 To view a report sample, see “Database Initialization
Report” on page 43.

Database Initialization JCL

Job name:

USR1A___

Specify
1_ 1.
2.
3.

database(s) to initialize:
Definition and history
Definition only
History only

Definition database:
DSN: USR1.SUM.DEFN_____________________________
Managementclass: ________ Storageclass: ________
Dataclass: ________ Volume: ______
History database:
DSN: USR1.SUM.HIST_____________________________
Managementclass: ________ Storageclass: ________
Dataclass: ________ Volume: ______
Estimated number of unique job IDs:
00000010 (1-99999999)
Average number of histories per job ID: 010 (1-999)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Job name. Job name specified in your job card. The last character is an
alphanumeric which you can optionally change to make it more
meaningful. For example, in the panel above, the last character is A. You
could optionally change the last character from A to I to identify the job as
an initialization job in the output queue.
Specify database(s) to initialize. During initial setup you will need to
initialize both databases. You can re-initialize either or both files as needed.
Be careful because when you reinitialize, the contents of the existing
database(s) are erased.
Definition database. Verify the dataset name.
Managementclass, Storageclass, Dataclass, Volume. For the
definition database, complete any combination of the Managementclass,
Storageclass, Dataclass, and Volume fields that is valid at your site. Volume
is the site-specific volume serial number.
History database. Verify the dataset name.
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Managementclass, Storageclass, Dataclass, Volume. For the
history database, complete any combination of the Managementclass,
Storageclass, Dataclass, and Volume fields that is valid at your site. Volume
is the site-specific volume serial number.
Estimated number of unique job IDs. Maximum number of unique
job identifiers (job IDs) you will have in this database. Each balancing job
is identified by a job ID made up of the job name, step name, and qualifier.
Average number histories per job ID. The typical number of history
records retained for each job identifier. This number is specified in the Job
Run Options when you set up a job, as described in “Store History” on
page 162. If this number varies greatly depending on the job, enter an
average.
After you press F5 to accept, optionally edit, and submit the JCL, the
following will happen:

 The panel will generates the layout shown in the next section.
 A report on the initialization will be generated. See “Database
Initialization Report” on page 43.
Note:

If the database will span multiple packs, see “Database
Initialization JCL for Multivolume History Database” on page 52.
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Database Initialization Record Layout
Field

Description

Pos.

Length

Format

Value

1

Record ID

1-8

8

X(8)

HFS

2

Number of Job ID
Keys

9-16

8

9(8)

00000001 99999999

3

Number of ACR
Histories

17-24

8

9(8)

00000001 99999999

4

Reserved

25-80

56

X(56)

Blanks

1

Record ID

1-8

8

X(8)

DFDSN

2

Definition Database
DSN

9-52

44

X(44)

3

Reserved

53-80

28

X(28)

Blanks

1

Record ID

1-8

8

X(8)

HFDSN

2

History Database
DSN

9-52

44

X(44)

3

Reserved

53-80

28

X(28)

Record 1

Record 2

Record 3

Blanks

Database Initialization JCL for Multivolume History Database
For a large history database, you may want it to span multiple packs. If you
specify a record range, as shown below, your database will be initialized, but
when it is filled, it will not reach the second pack:
DEFINE
CLUSTER (
NAME(USR1.DAILY.HIST1)
REUSE
SHR(1,3)
VOLUMES(TEMPA1 TEMPA2)RECORDS(03500000 03500001))
- <--- with a range
To reach the second pack, define your JCL as shown below;
DEFINE
CLUSTER (
NAME(USR1.DAILY.HIST1)
REUSE
SHR(1,3)
VOLUMES(TEMPA1 TEMPA2)RECORDS(03600000))
-
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Database Initialization Report
This report is generated when you initialize your definition and/or history
database. It shows:

 A list of the initialization transactions and any validation messages
 A summary of the transactions
The DDNAME for the report in your output will be UNIIR.
Example
ACR/S releasenumber
INFOGIX, INCORPORATED
COPYRIGHT INFOGIX, INC
DATE: mm/dd/yy
DATABASE INITIALIZATION REPORT
PAGE
TIME: 16:45:34
---------------------------------------------------INPUT TRANSACTION LISTING------------------------------------------------------TRANS
NO.
T R A N S A C T I O N
VALIDATION MESSAGES
------- ----+----1----+----2----+----3----+----4----+----5----+----6----+----7----+----8 -----------------------------------------HFS
0000001000000100
HFDSN USR1.SUM.HIST
DFDSN USR1.SUM.DEFN

001

--------------------------------------------------database INITILIZATION SUMMARY--------------------------------------------------DEFINITION DSN
= USR1.SUM.DEFN
HISTORY DSN
= USR1.SUM.HIST
NUMBER OF JOB ID KEYS
= 10
NUMBER OF ACR HISTORIES = 30

Specifying the ACR/Connector Domain Table
ACR/Connector users need to specify the name of the ACR/Connector
Domain Table, which lists all the ACR/Connector domain names that were
created during the installation and set up of ACR/Connector. Select Setup
> Files > Specify ACR/Connector Domain.
The ACR/Connector Domain File Name panel displays.
ACR/Connector Domain File Name
Domain File Name:

F1=Help

F2=Split

USR1.SUM.IIADOMS__________________________

F3=Exit

F5=Accept

F9=Swap

Enter the dataset name of the file that contains the ACR/Connector domain
names. This will be the one created during the installation and set up of
ACR/Connector. The default name is IIADOMS.

ACR/Summary User Guide for z/OS

43

2  Preparing to Use ACR/Summary
Creating, Opening, Saving, Copying, and Deleting Jobs

Creating, Opening, Saving, Copying, and Deleting
Jobs
Clearing the Job Window to Start a New Job
Instructions for creating a new job begin in “Entering Basic Job
Information” on page 155. If you just started ACR/Summary and no jobs
are open, you can go to that section and begin creating the job. However, if
you already have a job open but you want to start a new job, follow these
instructions to clear the Job Window:
1. Select File > New.
2. If the currently open job has no unsaved changes, the Job Window will

be cleared and you can start the new job.
3. If the currently open job has unsaved changes, you will be prompted to

save the definition changes. If you select the option to save the
definition changes, the Save panel appears. Complete the panel based
on the information in “Saving a Job” on page 45. The Job Window will
be cleared and you can start the new job.

Opening an Existing Job
To open an existing job, do the following:
1. Select File > Open. The Open Options panel will be displayed.
Open Options
Select a choice:
__ 1. Open a job, bring in all associated files
2. Open a job, bring in selected files

F1=Help

F2=Split

F3=Exit

F9=Swap

2. Complete the Select a choice field with one of the following options:

 Open a job, bring in all associated files. Opens the job you
specify along with all the file definitions associated with that job.
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 Open a job, bring in selected files. Opens the job you specify
and allows you to select which associated file definitions to bring
into that job. This allows you to edit the definitions for an input
source without opening (bringing in) all of the input sources
associated with a specific job ID. You can select one input source,
display the file in the Extract Window, make changes to the file
definitions, and then save those changes. This decreases the amount
of time you would spend opening and saving a large job that
contains many file IDs.
3. The (Job) ID List displays. Select the job ID you want to open. (To find

a job in a long list, enter F followed by a space and the job ID you want
to locate.)
4. If another job is currently open and it has unsaved changes, you will

receive a prompt to save the changes. If you select the option to save
the definition changes, the Save panel appears. Complete the panel
based on the information in “Saving a Job” on page 45.
5. If you selected Open a job, bring in selected files in the Open Options

panel, the File IDs panel will be displayed, listing all of the file IDs
associated with the job. Select the file you want to bring in.
The job information, including the input source files that were brought in
with the job, will now be displayed in the Job Window.

Saving a Job
You can save your currently open job, file, table, and history analysis
definitions at any time. We recommend that you save frequently while
entering or modifying definitions to avoid losing any work. To save, select
File > Save and complete the Save panel.
The sections that follow explain several ways to use the Save function:

 "Completing the Save Panel"
 "Saving and Exiting"

ACR/Summary User Guide for z/OS

45

2  Preparing to Use ACR/Summary
Creating, Opening, Saving, Copying, and Deleting Jobs

Completing the Save Panel
To access the Save panel, select File > Save. The Save panel displays. It
lists each set of definitions for the current job, along with their status since
the last time you saved them to the definition database during the current
online session.
Save

Row 1 from 32

Your current definition database is:
USR1.SUM.DEFN_____________________________
Choose a save option:
1_ 1. Save to definition library and definition database
2. Save to definition library only
Type an 'S' or a '/' to the left of the modifications or
deletions that you want to save:
Status
ID
Type
_
MOD
JOBABC STEP1
JOB ID
_
DEL
MONTHLY
FILE ID
************************ Bottom of data ************************

Command ===> _________________________________________________
F1=Help
F2=Split
F3=Exit
F5=Save all F7=Up
F8=Down
F9=Swap

Choose a save option. Decide where you want to save your definitions.
This option also controls where your definitions will be saved if you save
when exiting.
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The following diagram shows both options:
Create and
Edit
Definitions

Online Work Area

Save
option 1
and 2

Definition Library
(DEFNLIB)
Save
option 1
Definition Database
(DEFN)

Balancing

1. Save to definition library and definition database. You will

normally choose this option so that you will be able to run a job that
uses these definitions.
Note:

If you have Infogix Insight, you can have the batch cards and
audit information on ACR/Summary and ACR/Detail definition
updates (including the user ID of the person making the change
and the date and time of the change) sent to Infogix Insight
during online save. For information on implementing this feature,
see the Definition Audit information in the ACR/Summary and
ACR/Detail Installation Guide for z/OS.

2. Save to definition library only. Allows you to use the definition

library as a test environment. If you choose this option, the definition
library and the definition database will no longer match, and you
cannot run a job using these definitions.
To view the definitions in the definition library, open the job. To view
the definitions in the database, use the List Definitions database report
utility. See “List Definitions Utility” on page 493.
If you have been using option 2, you can do one of the following:

 To restore the definition library so that it contains the (older)
definitions that exist in the definition database, see “Restore
Definition Library” on page 550.
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 To run your balancing job using the definitions in the definition
library, open the job and save it using option 1.
Type an 'S'... Enables you to select which sets of definitions to save.
Status. MOD means modified but not saved to the definition database.
DEL means marked for deletion from the definition database. (Anything
you mark for deletion is not actually deleted until you run the reorganize
history utility.) If the Status column is blank, you haven’t made any unsaved
changes.
To save all your work for the current job, press F5 (Save all).

Saving and Exiting
When you are ready to exit, press F3 or choose File > Exit. If you made
changes that were not saved to the definition database, you will be
prompted to save.
If you choose to save at this point, all of your work will be saved to the
definition library and the definition database, or just to the definition
library, depending on which save option is selected on the Save panel.
If you want to save only selected types of definitions, when the prompt
appears, press F3 to return to the Job Window and follow the instructions
in “Completing the Save Panel” on page 46 to save what you want, then exit
without doing any further saves.

Copying a Job
This feature allows you to duplicate existing job and file definitions. It saves
you time when you need to create the same job and/or file definitions a
second time.

Copying Job and File Definitions to a New Job ID
Use the following procedure:
1. Select File > Copy to display the Copy Options panel.
2. Select Copy job and file definitions to a new job ID.

A list of your current jobs displays.
3. Select the job from which you want to copy both the job and file

definitions.
The Copy Job and File Definitions to a new Job ID panel
displays.
4. Complete the job name, step name, and qualifier, if any, of the job to

which the job and file definitions are being copied.
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5. Accept your entries to display the File ID Copy Options panel. You

will get this panel for each of the file IDs associated with the job you are
copying from.
The current file ID, dataset name, and file organization fields
will already be filled in.
Do you want to rename the current file ID?: Options:
Yes. Makes an exact copy of the file definitions with the new name.
Changes to these definitions will not be recognized in other jobs as
long as the File ID remains unique.
No. The file definitions associated with the file ID will be shared. Any
changes to shared definitions will be recognized in all jobs that use
those definitions.

Copying File Definitions to an Existing Job ID
1. Select File > Copy to display the Copy Options panel.
2. Select Copy file definitions to an existing job ID.

A list of your current jobs displays.
3. Select the job to which you will copy the file definitions.

The File ID Selection List panel displays.
4. Select the file definitions you want to copy.

The File ID Options panel displays.
The current file ID, dataset name, and file organization fields
will already be filled in.
Do you want to rename the current file ID?: Options:
Yes. Makes an exact copy of the file definitions with the new name.
Changes to these definitions will not be recognized in other jobs as
long as the File ID remains unique.
No. The file definitions associated with the file ID will be shared. Any
changes to shared definitions will be recognized in all jobs that use
those definitions.
If yes... If you answered Yes, enter the new name and qualifier, if any.
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Deleting a Job
To delete an entire job, from the Job Window, enter D next to Job
Information and press Enter. You will be prompted to confirm the deletion.
To purge the job from the definition library or the definition database, see
“Purging Definitions” on page 739.
To delete one or more individual job definitions (such as the definition for
an internal item or the definition for a rule) without deleting the entire job,
see “Deleting Job Definitions” on page 255.

Setting the User Options
User options enable you to override a variety of defaults for system-wide
ACR/Summary processing. User options file settings can be overridden
within specific job and file definitions. For information on setting user
options, see “Setting the User Options” on page 115.

Analyzing Your Balancing Needs
Before you can set up a balancing job, you need to plan exactly what the job
will do. This analysis, which is outlined below, is similar to what you would
do if you were performing the verification manually.

Determining the Application Interface Mode
The application interface modes available were discussed in “Application
Interface Modes” on page 14. The following sections assume you are using
the typical mode, file interface mode, where values to be used in balancing
are extracted from an input source.
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Determining the Input Source Information
An input source is an application report or file that contains values you
want to extract for use in balancing. Before you can define input sources for
a job, you need to know the following:

 The file name of each input source.
 The file organization type of each input source. Valid types include:
 Physical Sequential.
 VSAM Key Sequenced.
 Direct Spool Dataset.
 DB2 Table.
Note:

If you need to access another file organization type, you can
write a program to read the data and use program interface mode
to pass it to ACR/Summary. See Balancing in Program Interface
Mode on page 403.

 The values that should be extracted from each input source.
 Where the records containing the values to be extracted are located in
the file. This will help determine the access mode and file definition
types you should use to retrieve the values. For more information, see
“Selecting an Access Mode” on page 270.

 How the extracted values should be formatted (for example, as counts,
amounts, text items, or dates).

Planning for Internal (and Extended Internal) Items
Determine the internal (and extended internal) items that should be
defined. In your balancing job, these items serve as storage places for the
following types of data:

 Values extracted from the input source.
 Values derived from calculated items (see the next section)

Determining Calculated Items and History Items Needed
Determine if any calculated items need to be defined. A calculated item
specifies mathematical manipulation of values from internal (or extended
internal) items, history items, other calculated items, literals (numeric
constants or text), or functions. Calculated items can be used in
reconciliation rules in the same way as internal items, extended internal
items, and history items.
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Calculated items can be conditional or non-conditional. When a nonconditional calculated item is used in a reconciliation rule, the calculation
is performed before the rule is evaluated. A conditional calculation is
performed after rules are evaluated.
Determine if any history items need to be defined. A history item specifies
retrieval from the history database of a value that was stored in a previous
run of the current job or of a different job. This allows the value to be used
in calculated items or rules that you define for the current job run. The
retrieved value can be an internal or extended internal item, job run date,
job run time, or cycle number.

Planning the Balancing Rules and Messages
Rules
Balancing rules specify the criteria to be applied to the values of internal (or
extended internal) items, calculated items, and/or history items to
determine if an input source is in or out of balance. (The results of one rule
can be used in another rule).

Return Codes
The return code is a 4-digit code that you define when you create a rule.
Codes between 0050 and 3999 are recommended because they do not
duplicate system-generated codes.

Messages
Each return code can be associated with a message that will appear in the
Control Report to give information about the problem or to provide
instructions for actions to be taken.

Planning for Reports
A Control Report will automatically be generated for every job to report on
the results of the job unless you specify otherwise. This report shows
whether the values being balanced are in- or out-of-balance. When you set
up a job, you will be able to customize the Control Report for the job. In
addition to the Control Report, you can set up the following types of
reports:

 (Balancing) User Report. See “Setting Up User Reports” on page 595.
 Free-form Report. See “Setting Up Free-Form Reports” on page 575.
 Recap Report. See “Recap Report” on page 189.
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You can optionally set several system-wide options for report formatting.
See “Setting the User Options” on page 115.

Example
For a basic example of analyzing your balancing needs, see “Tutorial” on
page 55.
After you have completed the preparations described in this chapter, you
can begin setting up your jobs, as explained in the following chapters.
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3
Tutorial
This chapter contains a tutorial that demonstrates the basic procedures for
setting up and running balancing jobs using ACR/Summary. It consists of
the following sections:






“Preparing for the Tutorial” on page 55
“Determining Your Balancing Requirements” on page 56
“Basic Balancing between Two Reports” on page 60
“Basic Balancing Using History” on page 100

Preparing for the Tutorial
Before you begin this tutorial, you need to do the following:
1. Access ACR/Summary and familiarize yourself with the product

interface. See “Preparing to Use ACR/Summary” on page 17.
2. Follow the instructions in “Performing the Initial Setup” on page 34.
3. Verify that you have access to the sample reports that will be used as

input sources in the tutorial. These are the sample reports:
UPDT0501
SUMM0501
UPDT0601
The default dataset for these sample reports after installation is the
following:
XXXX.XXXX.TRNGRPT
where XXXX.XXXX is the high-level qualifier and middle-level
qualifier assigned during installation. If necessary, ask your system
administrator to copy these reports to a dataset prefixed with your user
ID.
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Determining Your Balancing Requirements
This tutorial assumes that you have a simple batch job that runs once a
month and creates two reports: the Update Report and the Summary
Report.
Using these reports, you will learn two types of balancing:

 Basic balancing between two reports
 Basic balancing using history

Requirements for Basic Balancing between Two Reports
This balancing job takes values from each report and verifies whether or not
they are in balance based upon rules. The reports, which are described
below, are the input sources to your balancing job.
The Update Report (UPDT0501) contains the valid and invalid transaction
totals for new additions, changes, and deletions.
XYZ COMPANY

UPDATE CONTROL REPORT
05/01/YY PAGE1
INVALID
VALID
INPUT
TRANSACTIONS
TRANSACTIONS TRANSACTIONS

TRANSACTIONS
CHANGE TRANSACTIONS
DELETE TRANSACTIONS
ADD TRANSACTIONS
TOTAL

54
12
1

67

5,900
1,900
2,000

5,954
1,912
2,001

9,800

9,867

The Summary Report (SUMM0501) contains the total number of
transactions.
XYZ COMPANY
SUMMARY REPORT
REPORT OP23-1-1
RUN DATE 05/01/XX
NUMBER OF TRANSACTIONS IN OLD MASTER
NUMBER OF TRANSACTIONS IN NEW MASTER
NUMBER OF VALID INPUT TRANSACTIONS

PAGE1
100,300
100,400
9,800

Determine your balancing requirements as follows:
1. Decide what you want to balance. For this job, assume you want to

accomplish the following:
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 Verify the total number of input transactions on the Update Report.
You can do this by adding the total number in the Invalid
Transactions column with the total number in the Valid
Transactions column and comparing the result with the total
number in the Input Transactions column.

 Verify that the total from the Valid Transactions column in the
Update Report is equal to the Number of Valid Input Transactions
from the Summary Report.
2. Identify the field items.

A field item must be created for each value that is extracted from an
input source. For this job, you will identify three field items from the
Update Report and one from the Summary Report as shown in the
following diagram.
XYZ COMPANY

UPDATE CONTROL REPORT
INVALID
TRANSACTIONS

05/01/04
VALID
TRANSACTIONS

PAGE 1
INPUT
TRANSACTIONS

CHANGE
TRANSACTIONS

54

5,900

5,954

DELETE
TRANSACTIONS

12

1,900

1,912

ADD TRANSACTIONS

1

2,000

2,001

TOTAL

67

9,800

9,867

Update Report
Extractions

Field items for each value you want to extract
from the Update Report:
-Number of invalid transactions
-Number of valid transactions
-Number of input transactions

ZYX COMPANY

SUMMARY REPORT

REPORT OP23-1-1

RUN DATE 05/01/08

PAGE1

NUMBER OF TRANSACTIONS IN OLD MASTER

100,300

NUMBER OF TRANSACTIONS IN NEW MASTER

100,400

NUMBER OF VALID INPUT TRANSACTIONS

9,800

Summary Report
Extractions

Field item for the value you
want to extract from the
Summary Report:
-Number of Valid Input
Transactions

3. Identify the internal items.
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Before it can be used in balancing rules, the value from each field item
must be stored as an internal item or in an extended internal item.
Note:

Extended internal items, which are used to store longer values,
are not included in the tutorial. For more information, see
Processing of Print Leading Zeros Indicator on page 194.

4. Identify the rules that will be used to manipulate the internal items.

 Rule 1 will be: INVALID TRANSACTIONS plus VALID
TRANSACTIONS must equal INPUT TRANSACTIONS.

 Rule 2 will be: VALID TRANSACTIONS from the Update Report
must be equal to VALID INPUT TRANSACTIONS from the
Summary Report.
5. Determine the messages you need to define for each rule.

When defining a rule, you will assign a return code to it to identify an
out-of-balance situation (a situation that does not conform to the rule).
Each return code will then be associated with a message. Messages are
included in the Control Report that is run at the end of the balancing
job. They can help identify why a job is out of balance or provide
instructions about the measures that should be taken.
You will create the following messages for this job:

 If Rule 1 is out of balance, the user should call Chris King for
assistance.

 If Rule 2 is out of balance, the user should call Technical Support.

Requirements for Basic Balancing Using History
For this balancing job, you want to compare values from the current month
to a previous month to verify that transaction volumes are acceptable.
To do this, you will learn how to store a history item and specify the cycle
number of the job.
1. Decide what you want to balance. For this job, assume you want to

accomplish the following: Verify the total transactions this month are
within 20 percent of the total from last month.
2. Identify the field items (or field values). For this job, you will identify

field items for the number of invalid transactions, the number of valid
transactions, and the number of input transactions.
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XYZ COMPANY

UPDATE CONTROL REPORT
INVALID
TRANSACTIONS

05/01/04
VALID
TRANSACTIONS

PAGE 1
INPUT
TRANSACTIONS

CHANGE
TRANSACTIONS

54

5,900

5,954

DELETE
TRANSACTIONS

12

1,900

1,912

ADD TRANSACTIONS

1

2,000

2,001

TOTAL

67

9,800

9,867

XYZ COMPANY

UPDATE CONTROL REPORT
INVALID
TRANSACTIONS

06/01/04
VALID
TRANSACTIONS

PAGE 1
INPUT
TRANSACTIONS

CHANGE
TRANSACTIONS

37

4,800

4,837

DELETE
TRANSACTIONS

19

1,900

1,919

ADD TRANSACTIONS

4

2,000

2,004

TOTAL

67

8,700

8,760

3. Identify the internal items. As in the first job, each value must be

stored as an internal item.
4. Identify the history items. For each value you want to store to use later

in a comparison, you must define a history item.
5. Identify the rule that compares the history item to the currently

extracted item:
VALID TRANSACTIONS (0501) = TOTAL VALID TRANSACTIONS
(0601) +/- 20%
6. Determine the messages you need to define for the rule. You will create

the following message for this job:
MONTHLY VALID TRANSACTIONS OUTSIDE TOLERANCE LIMIT.
CALL STEVE JONES.
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Basic Balancing between Two Reports
This portion of the tutorial shows you how to define a balancing job to
compare the Update Report (UPDT0501) and the Summary Report
(SUMM0501).

Entering Job Information for the Update Report
Job information identifies the balancing job and determines how ACR/
Summary will process it. This must be the first panel that you complete. You
will need to provide the job name and step name.
Note:

Job information may need to be provided by others in your organization
who know about the flow of data processing

1. Enter S next to Job Information to display the Job Information Panel.
Job Information
Enter a job ID:
Job name:
Step name:
Qualifier:
Enter control report title:

Select options to access:
_ Job run options...
_ Cycle processing options...
_ Alternate job ID information...
_ Rerun/audit trail options...
_ Extract file options...
_ Display/change comments...
F1=Help
F2=Split
F3=Exit
F5=Accept

F9=Swap

2. Enter the following information:

Job Name: JOBXYZ
Step Name: UPDATE
Control Report title: MONTHLY FILE UPDATE SYSTEM
The Control Report is an output report, which is used to display the
results of your balancing run. Here, you need to specify the title, which
will print on this report.
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3. Press F5 to accept. The Job Window is displayed.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 2 from 17

A.

Job Information:
JOBXYZ
UPDATE
Report Options:
MONTHLY FILE UPDATE SYSTEM
B. Input Sources: 000
< NEW... >
C. Internal Items: 000
< NEW... >
D. Extended Internal Items: 000
< NEW... >
E. Extraction Variables: 000
< NEW... >
F. History Items: 000
< NEW... >
Command Line ===>
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

4. Select File > Save to display the Save Panel.
Note:

If system messages appear (indicating that the definition library is
being compressed), press Enter to return to ACR/Summary.

Notice that MOD appears in the Status column next to your job
definitions. This means that you have modified your job definitions (by
creating them, in this case). Your balancing job cannot use your
definitions until you save them to the ACR/Summary definition
database.
Save

Row 1 from 1

Your current definition database is:
XXXX.SUM.DEFN
Choose a save option:
1
1. Save to definition library and definition database
2. Save to definition library only
Type an 'S' or a '/' to the left of the modifications or
deletions that you want to save:
Status
ID
Type
MOD
JOBXYZ UPDATE
JOB ID
************************ Bottom of data ************************
Command ===>
F1=Help
F8=Down

F2=Split
F9=Swap
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F5=Save all
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5. Press F5 to save all your definitions. The message, “Definitions saved.

XML message sent.” appears above the command line.
6. Press PF3 to return to the Job Window.

You have entered and saved basic information about your balancing job.
Your next task is to enter information about a report that JOBXYZ will
balance. The reports, files, or other inputs that you want to balance are
known as the input sources for your balancing job.

Adding an Input Source for the Update Report
ACR/Summary can balance information contained in most types of files. In
this tutorial, the input sources are physical sequential files.
1. Select NEW under Input Sources to display the Input Sources Panel.
2. Enter the following information:

File Description: UPDATE Report
File DDNAME: UPDT0501
DSNAME: XXXX.XXXX(UPDT0501)
where XXXX.XXXX is the high-level qualifier and middle-level
qualifier assigned during installation. We will not change the
remaining fields.
3. Press F5 to accept. The system displays the Physical Sequential File

Information Panel.
Physical Sequential File Information
Specify
1
1.
2.
3.
4.
5.
6.
7.

access
Select
Select
Select
Select
Select
Select
Select

mode:
first x records
last x records
x records based on file key processing
x records from nth record (Relative record)
all records (total/tally/hash)
records satisfying selection on one line
records satisfying selection on multiple lines

Reset extraction variables? Y

(Y/N)

Hard copy DDNAME:
Use delimited data fields? N

F1=Help
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F3=Exit

F5=Accept
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ACR/Summary can process lines in the report in several different ways
called access modes. Access mode 1 selects records from the beginning
of the file. This is how records are selected in this tutorial.
4. Review the panel. We will not make any changes. Press F5 to accept.

The system displays the Record Information Panel.
5. Enter 00100 in the Maximum number of records to process field.

This field limits the number of records processed in production runs.
6. Press F5 to accept. The system displays the updated Job Window.

Notice now that the DDNAME UPDT0501 and DSNAME
XXXX.XXXX(UPDT0501)appear under Input Sources.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 5 from 18

C.
D.
E.
D.
E.
F.

UPDT0501
XXXX.XXXX(UPDT0501)
< NEW... >
Internal Items: 000
< NEW... >
Extended Internal Items: 000
< NEW... >
Extraction Variables: 000
< NEW... >
History Items: 000
< NEW... >
Calculated Items: 000
< NEW... >
Rules: 000
< NEW... >

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

Creating File Definitions for the Update Report
File definitions tell the system how to extract data from the input source.
You need to create file definitions to tell the system exactly what data will
be extracted for balancing.
The Extract Window displays the contents of each report. To extract a
value, you must first locate the record (or the line on the report) using an
embedded key.
An embedded key locates a record by searching for criteria that you define.
The criteria should be unique to the records selected. Often the criteria is a
literal, or text description of the value you want to extract. Once a record
has been located, values can be extracted using field values.
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Identifying the Embedded Key for the Update Report
The following procedures step you through setting up an embedded key and
a field value for the Update 0501 Report.
These steps use the mark-and-capture method to select appropriate
characters in the Extract Window. The mark-and-capture method is only
available for physical sequential files, VSAM KSDS files, and the history file.
1. Select Window > Extract. The system displays the File ID List Panel.
Row 3 from 3
File ID List
UPDT0501
XXXX.XXXX.TRNGRPT(UPDT0501)
********************* Bottom of data **********************

Command ===>
F1=Help
F2=Split

F3=Exit

F7=Up

F8=Down

F9=Swap

2. Select UPDT0501. The system displays the input source in the Extract

Window.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS
TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

64

1
---67

F3=Exit
F9=Swap

VALID
TRANSACTIONS
5,900
1,900
2,000
-------9,800

INPUT
TRANSACTIONS
5,954
912
2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

Infogix, Inc.

Tutorial  3
Basic Balancing between Two Reports
3. Position the cursor to the first character in TOTAL as shown below.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS

1
---67

TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

VALID
TRANSACTIONS
5,900
1,900
2,000
-------9,800

INPUT
TRANSACTIONS
5,954
912
2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

4. Press F6 (Add). The Definition Type Panel is displayed, prompting you

to make a selection.
Select a definition type:
1.
2.
3.
4.
5.

Reference record...
Relative record...
Page/line record...
Embedded key...
Field value...

F1=Help

F3=Exit
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5. Select Embedded Key. The system displays the Embedded Key

Record Panel.
Embedded Key Record
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
TOTAL
67
9,800
9,867

Delimited data field number: ____ (1-1000)
Start position: 00001 Length:
Key occurrence: 001
If start position can vary, specify maximum start position:
If the key value is missing, bypass this balancing step? N

00001
(Y/N)

Use the value of this extraction variable as the embedded key:
Extended? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Notice that the key value field is filled with TOTAL

67.

6. Enter 5 in the Length field. Notice the key value now only includes the

word TOTAL.
7. Press F5 to accept.
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Identifying the Field for Total Number of Invalid Transactions
You need to specify three field values for this embedded key.
1. Place the cursor on the first character of 67, the total in the Invalid

Transaction column, as shown in the next figure.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS

1,900

1
---67

TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

VALID
TRANSACTIONS
5,900

F3=Exit
F9=Swap

2,000
-------9,800

INPUT
TRANSACTIONS
5,954
912
2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press F6 (Add). The system displays the Definition Type Panel,

prompting you to make a selection.
Select a definition type:
1.
2.
3.
4.
5.

F1=Help

Reference record...
Relative record...
Page/line record...
Embedded key...
Field value...

F3=Exit
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3. Select Field Value. The system displays the Field Value Panel.
Field Value

Line reference:

----+----1----+----2----+----3----+----4
67
9,800
9,867

Delimited data field number: ____ (1-1000)
Field position: 00028 Field length:
Can this field value position vary? N (Y/N)

1

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Extract decimal indicator? N (Y/N)
Will this be stored as a date in an internal item? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is this an extended internal item?
N (Y/N)
Will this field be translated using a translation table? N

F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

4. Enter 2 in the Field length field. We will not change the remaining

fields.
5. Press F5 to accept. The system displays the Output Value Panel.
Output Value
Specify
1
1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: I
or
extraction variable number:
Override sign processing?

F1=Help

F2=Split

N

F3=Exit

001
(1-999)

Extended? N

(Y/N)

F5=Accept

F9=Swap

6. Verify the output format is set to 1 (Count).
7. Verify that the Assign to internal item number field is set to 001.

68

Infogix, Inc.

Tutorial  3
Basic Balancing between Two Reports
8. Press F5 to accept. The system displays the Internal Items Panel.
Internal Items
Internal
Item number
001

-------------- Description -------------

Print format:
1
1. Count
2. Amount
3. Date
4. Text
Print decimals:
Specify
1
1.
2.
3.

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left
Calculated item number: 000 (1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?

F1=Help

1

1. Default

F2=Split

2. Print

F3=Exit

3. Do not print

F5=Accept

F6=Cancel

F9=Swap

9. Enter NUMBER OF INVALID TRANSACTIONS in the

Description field.
10. Enter 2 in the Print the internal item value field. This will print the

internal item value in the right column of the Control Report.
11. Press F5 to accept. The system displays the Extract Window.
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Identifying the Field for Total Number of Valid Transactions
1. Place the cursor on the first character of 9,800, as shown in the next

figure.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS

VALID
TRANSACTIONS
5,900
1,900

1
---67

TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

INPUT
TRANSACTIONS
5,954
912

2,000
-------9,800

F3=Exit
F9=Swap

2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press F6 (Add). The system displays the Definition Type Panel.
3. Enter Field Value. The system displays the Field Value Panel.
Field Value

Line reference:

----+----1----+----2----+----3----+----4
9,800
9,867

Delimited data field number: ____ (1-1000)
Field position: 00044 Field length:
Can this field value position vary? N (Y/N)

1

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Extract decimal indicator? N (Y/N)
Will this be stored as a date in an internal item? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is this an extended internal item?
N (Y/N)
Will this field be translated using a translation table? N

F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

4. Enter 5 in the Field length field.
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5. Press F5 to accept. The system displays the Output Value Panel.
Output Value
Specify
1
1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: I 002
or
extraction variable number:
(1-999)
Override sign processing?

F1=Help

F2=Split

N

Extended? N

(Y/N)

F3=Exit

F5=Accept

F9=Swap

6. Verify the output format is set to 1 (Count).
7. Verify that the Assign to internal item number field is set to 002.
8. Press F5 to accept. The system displays the Internal Items Panel.
Internal Items
Internal
Item number
002

-------------- Description -------------

Print format:
1
1. Count
2. Amount
3. Date
4. Text
Print decimals:
Specify
1
1.
2.
3.

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left
Calculated item number: 000 (1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?

F1=Help

1

1. Default

F2=Split

2. Print

F3=Exit

3. Do not print

F5=Accept

F6=Cancel

F9=Swap

9. Enter NUMBER OF VALID TRANSACTIONS in the Description

field.
10. Enter 2 in the Print the internal item value field.
11. Press F5 to accept. The system displays the Extract Window.
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Identifying the Field for Total Number of Input Transactions
1. Now position the cursor on the first character of 9,867, as shown in the

next figure.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS

VALID
TRANSACTIONS
5,900
1,900

1
---67

TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

INPUT
TRANSACTIONS
5,954
912

2,000
-------9,800

F3=Exit
F9=Swap

2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press F6 (Add). The system displays the Definition Type Panel.
3. Enter Field Value. The system displays the Field Value Panel.
Field Value

Line reference:

----+----1----+----2----+----3----+----4
9,800
9,867

Delimited data field number: ____ (1-1000)
Field position: 00044 Field length:
Can this field value position vary? N (Y/N)

1

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Will this be stored as a date in an internal item? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is this an extended internal item?
N (Y/N)
Will this field be translated using a translation table? N

F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

4. Enter 5 in the Field length field.
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5. Press F5 to accept. The system displays the Output Value Panel.
Output Value
Specify
1
1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: I
or
extraction variable number:
Override sign processing?

F1=Help

F2=Split

N

003

(Y/N)

F3=Exit

F5=Accept

F9=Swap

6. Verify the output format is set to 1 (Count).
7. Verify that the Assign to internal item number field is set to 003.
8. Press F5 to accept.The system displays the Internal Items Panel.
Internal Items
Internal
Item number
003

-------------- Description -------------

Print format:
1
1. Count
2. Amount
3. Date
4. Text
Print decimals:
Specify
1
1.
2.
3.

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left
Calculated item number: 000 (1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?

F1=Help

1

1. Default

F2=Split

2. Print

F3=Exit

3. Do not print

F5=Accept

F6=Cancel

F9=Swap

9. Enter TOTAL INPUT TRANSACTIONS in the Description field.
10. Enter 2 in the Print the internal item value field.
11. Press F5 to accept. The system displays the Extract Window.
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Reviewing File Definitions for the Update Report
Now that the file definitions have been created for the Update 0501 Report,
you can review them to see if the definitions have been set up properly.
1. In the Extract Window, select View > Definitions. The system

displays the definition view of the Update 0501 Report.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-OCC 001 OF EMBEDDED KEY=TOTAL
PICK UP VALUE AT 00028 FOR 02, STORE IN I-001
PICK UP VALUE AT 00044 FOR 05, STORE IN I-002
PICK UP VALUE AT 00062 FOR 05, STORE IN I-003
***************************** Bottom of data *****************************

Command Line ===>
F1=Help
F2=Split
F8=Down
F9=Swap

F3=Exit

F4=Actions

F6=And/Or

F7=Up

2. Check the results in the Extract Window. The following are the

definitions you should see for the Update 0501 Report.
OCC 001 OF EMBEDDED KEY=TOTAL
PICK UP VALUE AT 0028 FOR 02, STORE IN I-001
PICK UP VALUE AT 0044 FOR 05, STORE IN I-002
PICK UP VALUE AT 0062 FOR 05, STORE IN I-003

3. If your results do not match, select the line with the error. The system

will display the appropriate panel for you to make your changes.
4. Press F5 to accept the changes. The system returns to the definition

view for the Update 0501 Report.
5. Press F3 to exit. The system displays the Extract Window.
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6. Press F3 to exit. The system displays the Job Window with your new

internal item definitions.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 21

A.

B.

C.

D.

Basic Job Information
Job Information:
JOBXYZ
UPDATE
Report Options:
MONTHLY FILE UPDATE SYSTE
Input Sources: 001
UPDT0501
XXXX.XXXX.TRNGRPT(UPDT0501)
< NEW... >
Internal Items: 003
001
NUMBER OF INVALID TRANSACTIONS
002
NUMBER OF VALID TRANSACTIONS
003
TOTAL INPUT TRANSACTIONS
< NEW... >
Extended Internal Items: 000
< NEW... >

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

Testing Definitions for the Update Report
Step extraction provides a method to test your file definitions before
running balancing. They walk you through your file definitions and show
which values have actually been extracted from your input source.
Other testing methods include Step X Records and Full Extraction. See
Chapter 8, “Testing and Running Jobs Online” for more information.
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For this test, you’ll see the extracted values for report UPDT0501.”
1. Select Window > Extract > UPDT0501. The system displays the

Extract Window.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS
TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

VALID
TRANSACTIONS
5,900
1,900

1
---67

F3=Exit
F9=Swap

2,000
-------9,800

INPUT
TRANSACTIONS
5,954
912
2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Select Run > Step extraction. The cursor appears over the first

value to be extracted while a message (containing information about
the definition) displays in the message area of the Extract Window.
Run
-----------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000020 COL 0000 0007
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-TOTAL
67
9,800
9,867

THIS STEP=OCC 001 OF EMBEDDED KEY=TOTAL
Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down
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Note:

For each extracted item you defined, there are two items to look for:
 The text description of each definition is shown above the
command line.
 The cursor moves to the start position of the field we are currently
extracting.

3. Press Enter to continue the extraction process. The cursor appears

over the next value to be extracted. Continue pressing Enter for each
value to be extracted for each record in the input source.
Note:

If you wish to “fast forward” the process, select either the Step X
records option or the Finish extraction option. If you choose Step X
records, you will be prompted for the number of records you want
the system to process before beginning step extraction again. If you
choose Finish extraction, the system immediately performs the
remaining steps of the process and displays the Extracted Values
panel.

When the extraction process is complete, the system displays the
Extracted Values Panel.
Extracted Values

Row 1 to 3 of 3

_
NUMBER OF VALID TRANSACTIONS
67
_
NUMBER OF VALID TRANSACTIONS
9800
_
TOTAL INPUT TRANSACTIONS
9867
***************************** Bottom of data **************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

4. Once extraction has finished, press F3 to exit. The system displays the

Extract Window.
5. Press F3 to exit. The system displays the Job Window.

Defining the Rule and the Message for the Update Report
The goal of our balancing example is to verify that the total invalid
transactions added to the total valid transactions is equal to the total input
transactions. We have extracted these values and placed them into internal
items I-001, I-002, and I-003, respectively.

ACR/Summary User Guide for z/OS

77

3  Tutorial
Basic Balancing between Two Reports

Next, we must tell the system to verify these values. We do this by creating
rules and messages. Rules specify which values to balance (these may
include internal items, history items, calculated items), and what action to
take if the rule equation is out of balance. Return codes are set when an outof-balance condition occurs. When a return code is set, the messages, which
are defined with it, will be printed on the Control Report.
Messages are lines of instructional text associated with a return code. If the
corresponding return code gets set, the message text gets printed on the
Control Report. Messages, primarily, identify why a step is not in balance
and outline procedures to correct it. Messages can also provide reminders,
explanations, names and telephone numbers of people to call if a particular
situation arises.
1. Select NEW under Rules. The Balancing Rules Panel displays.
Balancing Rules
Specify the type of rule to define:
1. Standard...
2. Conditional...

F1=Help

F3=Exit

2. Select Standard. The system displays the Standard Rules Panel.
Standard Rules
Rule number: 001 Alternate Balancing Rule?: N
-------------------------------Formula------------------------------LHS:
Balancing operator:
RHS:

(EQ, NE, GT, LT, GE, LE)

Description:
Return code:
Is rule active? Y
Calculated item to process:
Rule action:
1. Default
1
2. Set completion code
3. Set abend code

F1=Help
F7=Prev

F2=Split
F8=Next

(Y/N)

Set tolerance? N
Print decimals:

Print format:
1
1. Count
2. Amount
3. Date
4. Text

F3=Exit
F9=Swap

F4=Retain

(Y/N)

Print commas:
1
1. Default
2. Print
3. Do not print

F5=Accept

F6=Items

The rule is active. This means the status of the rule always has an effect
on the job.
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3. Enter I-001 + I-002 in the LHS field. LHS refers to left-hand side of

the equation.
4. Enter EQ in the Balancing Operator field.
5. Enter I-003 in the RHS field. The equation you have just defined

verifies that Update 0501 Report internal item I-003 is equal to the
sum of I-001 and I-002.
6. Enter # INVALID TRANSACTIONS + # VALID

TRANSACTIONS = TOTAL INPUT TRANSACTIONS in the
Description field.
This rule verifies the total number of input transactions. This includes
valid and invalid transactions.
7. Enter 3001 in the Return code field.

The return code corresponding to a particular rule will be set if an outof-balance condition occurs. We recommend that you use values
between 2000 and 3999 for rule return codes. A return code of 0000
can be used if you want your message to print in every case, not just
when the rule is out of balance. Return codes outside the range of
2000-3999 are reserved for Infogix and system messages.
8. Press F5 to accept. The system displays the Direct Messages Panel.
Direct Messages
Message number: 001
Return
Message text
code
---------------------------------------0000

Write message to:
1
1. Control report
2. Console and control report (no response required)
3. Console and control report (response required)
F1=Help
F6=Items

F2=Split
F7=Prev

F3=Exit
F8=Next

F4=Retain
F9=Swap

F5=Accept

1. Enter Call Chris King (EX. 9945) as the message text.

This means that anytime the TOTAL INPUT TRANSACTIONS (Rule
#1) is out of balance, the message “Call Chris King (EX. 9945)” prints
on the Control Report.
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2. Press F5 to accept. The system displays the Job Window.
File Edit View Run Setup Window Help
----------------------------------------------------------------------ACR/Summary Job Window
Row 19 from 23

001 # INVALID TRANSACTIONS + # VALID TRANSACTIONS = TOTAL INPUT
< NEW... >
H. Messages: 001
000 CALL CHRIS KING (EX. 9945)
< NEW... >
******************************* Bottom of data **************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

3. Select File > Save.

Notice that MOD appears in the Status column next to your job and file
definitions. This means you have modified or added them since the last
time you saved to the definition database. Your balancing job cannot
access your definitions until you save them to the definition database.
4. Enter S next to JOBXYZ.

You have completed the definitions for the UPDATE step of JOBXYZ.

Running Balancing for the Update Report
Once you are satisfied with your job and file definitions, you are ready to
run your balancing job. Balancing extracts the values from the appropriate
input sources, performs specified calculations, applies the rules, and prints
the Control Report.
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If the input sources are out of balance, the Control Report shows you what
is out of balance.
1. Select Run > Balancing. The system displays the Balancing Run

Options Menu.
Balancing Run Options
Set overrides for one or more of the following:
Cycle number: . .
Run number: . . .
Rule set override:
Store history override:
F1=Help

F2=Split

(Y/N/I)
F3=Exit

F5=Accept

F9=Swap

2. Enter an 8-digit cycle number representing today’s date in the Cycle

Number field. For example, if today is May 1, 2012, you could enter
20120501.
A cycle number is an 8-digit representation for a balancing run. It does
not matter which numbers are used as cycle numbers, as long as they
can be sequenced in ascending order and have meaning to the user.
In the beginning of this job we kept all the default print options for the
Control Report. The Balancing Run Options Panel gives us the
opportunity to override those options. Any changes made here will be
made FOR THIS RUN ONLY! If you wish to make permanent changes,
you must access the Job Run Options Panel.
3. Press F5 to accept. The system displays the message “Balancing

process has been invoked”.
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When balancing is complete, the system displays the Control Report.
Menu Utilities Compilers Help
----------------------------------------------------------------------BROWSE
XXXX.XXXX.CONTROL1
Line 00000000 Col 001 080
********************************* Top of Data ****************************
ACR/S releasenumber
INFOGIX, INCORPORATED
DATE: mm/dd/yy
BALANCING CONTROL REPORT
TIME: 10.44.30
MONTHLY FILE UPDATE SYSTE
JOB=JOBXYZ STEP=UPDATE QUAL
CYCLE#=20120501 RUN#=000
A. INTERNAL ITEMS:
ITEM NO.
DESCRIPTION
-------- ------------------------------------------------------------I-001.
NUMBER OF VALID TRANSACTIONS
I-002.
NUMBER OF VALID TRANSACTIONS
I-003.
TOTAL INPUT TRANSACTIONS
EXTENDED INTERNAL ITEMS:
NONE.
HISTORY ITEMS:
NONE.
Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

B.

F3=Exit
F5=Rfind
F12=Cancel

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

The report is too large to print on one panel. You can scroll down or
right. Press F8 to page down.
Menu Utilities Compilers Help
----------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000018 Col 001 080
C. CALCULATED ITEMS:
NONE.
D. BALANCING RULES & RESULTS:
RULE NO.
BALANCING RULE
-------- ------------------------------------------------------------1. # INVALID TRANSACTIONS + # VALID TRANSACTIONS = TOTAL INPUT TRANSA
(I-001 + I-002) EQ (I-003)
E. SPECIAL INSTRUCTIONS:
NONE.
****
CALL CHRIS KING (EX. 9945)

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right
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F3=Exit
F5=Rfind
F12=Cancel

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap
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4. Press F7 to page up, then press F11 to page right.
Menu Utilities Compilers Help
----------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000000 Col 053 132
********************************* Top of Data ****************************
IX, INCORPORATED
PAGE 001
BALANCING CONTROL REPORT
COPYRIGHT INFOGIX, INC.
MONTHLY FILE UPDATE SYSTE
DATA BASE VERSION: 0000009/0000001
=JOBXYZ
STEP=UPDATE
QUAL=
CYCLE#=20120501 RUN#=000
PTION
----------------------------------------

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

INPUT
------------------

F3=Exit
F5=Rfind
F12=Cancel

F7=Up

OUTPUT
-----------67
9,800
9,867

Scroll ===> PAGE
F8=Down
F9=Swap

5. Press F8 to page down to check the result.
Menu Utilities Compilers Help
----------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000018 Col 053 132

NG RULE
---------------------------------------TIONS = TOTAL INPUT TRANSACTIONS

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right
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F3=Exit
F5=Rfind
F12=Cancel

RESULT
ERROR/TOLERANCE
------------------ ----------IN BALANCE

F7=Up

Scroll ===> PAGE
F8=Down F9=Swap
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Note:

If your results are out of balance, return to “Reviewing File
Definitions for the Update Report” on page 74 to see which
definitions are incorrect.

If any rule is out of balance, the entire balancing step is out of balance.
If that happens, the report prints a message at the bottom that says:
**OUT OF BALANCE** (RETURN CODE =####)
The return code displayed (####) will be the highest return code
generated from all out-of-balance rules. In addition, the report footer
displays the names of the definition database, the history database,
and the load library used. This information is particularly useful for
verifying that the correct ACR/Summary database files and program
library were used
6. Press F3 to exit. The Job Window displays.

Adding an Input Source for the Summary Report
Remember, the input source refers to the file that stores the data from a
report. Internal items will be extracted from this file.
1. Select NEW under Input Sources. The system displays the Input

Sources Panel.
2. Enter the following information:

File Description: SUMMARY REPORT
File DDNAME: SUMM0501
DSNAME: XXXX.XXXX(SUMM0501)
where XXXX.XXXX is the high-level qualifier and middle-level
qualifier assigned during installation. We will not change the
remaining fields.
3. Press F5 to accept. The system displays the Physical Sequential File

Information Panel.
4. Press F5 to accept the default access mode of 1, Select first x records.

The system displays the Record Information Panel.
Record Information
Maximum number of records to process: 00000

F1=Help

F2=Split

F3=Exit

F5=Accept

(1-99999)

F9=Swap

5. Enter 00100 in the Maximum number of records to process field.
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This field limits the number of records processed in the balancing step.
Be sure to indicate a large enough number to capture the records in the
file that you need for balancing.
6. Press F5 to accept. The system displays the updated Job Window.

Notice DDNAME SUMM0501 and DSNAME
XXXX.XXXX(SUMM0501) under Input Sources.
File Edit View Run Setup Window Help
----------------------------------------------------------------------ACR/Summary Job Window
Row 6 from 24

C.

D.
E.
F.

SUM0501
XXXX.XXXX(SUMM0501)
< NEW... >
Internal Items: 003
001
NUMBER OF INVALID TRANSACTIONS
002
NUMBER OF VALID TRANSACTIONS
003
TOTAL INPUT TRANSACTIONS
< NEW... >
Extended Internal Items: 000
< NEW... >
Extraction Variables: 000
< NEW... >
History Items: 000
< NEW... >

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

Creating File Definitions for the Summary Report
These steps use the mark-and-capture method you learned earlier.
1. Select Window > Extract. The system displays the File ID List Panel.
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2. Enter S next to the input source SUMM0501. The system displays the

Extract Window.
File Edit View Run Window Help
---------------------------------------------------------------------Extract Window
File name: SUMM0501
LINES 00000010 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
S U M M A R Y
C O N T R O L R E P O R T
PAGE
REPORT OP23-1-1
RUN DATE 01/01/03

NUMBER OF TRANSACTIONS IN OLD MASTER

100,300

NUMBER OF TRANSACTIONS IN NEW MASTER

100,400

NUMBER OF VALID INPUT TRANSACTIONS

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

9,800

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

Identifying the Embedded Key Record for the Number of Valid
Input Transactions
1. Position the cursor using the keyboard arrow keys on the first

character of the NUMBER OF VALID INPUT TRANSACTIONS record.
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For this example, you are going to capture Number of Valid Input
Transactions as the embedded key record.
File Edit View Run Window Help
---------------------------------------------------------------------Extract Window
File name: SUMM0501
LINES 00000010 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
S U M M A R Y
C O N T R O L R E P O R T
PAGE
REPORT OP23-1-1
RUN DATE 01/01/03

NUMBER OF TRANSACTIONS IN OLD MASTER

100,300

NUMBER OF TRANSACTIONS IN NEW MASTER

100,400

NUMBER OF VALID INPUT TRANSACTIONS

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

9,800

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press F6 (Add). The system displays the Definition Type Panel.
Select a definition type:
1.
2.
3.
4.
5.

F1=Help

Reference record...
Relative record...
Page/line record...
Embedded key...
Field value...

F3=Exit
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3. Select Embedded Key. The system displays the following panel.
Embedded Key Record
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
NUMBER OF VALID INPUT TRANSACTIONS
9,800

Delimited data field number: ____ (1-1000)
Start position: 00001 Length:
Key occurrence: 001
If start position can vary, specify maximum start position:
If the key value is missing, bypass this balancing step? N

00001
(Y/N)

Use the value of this extraction variable as the embedded key:
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

4. Enter 34 in the Length field. We will not change the remaining fields.
5. Press F5 to accept.

Identifying the Field Value for the Number of Valid Input
Transactions
After you specify the embedded key record, you can specify the field values
to pick up.
1. Now position the cursor on the first character of 9,800, as shown in the

following figure.
File Edit View Run Window Help
---------------------------------------------------------------------Extract Window
File name: SUMM0501
LINES 00000010 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
S U M M A R Y
C O N T R O L R E P O R T
PAGE
REPORT OP23-1-1
RUN DATE 01/01/03

NUMBER OF TRANSACTIONS IN OLD MASTER

100,300

NUMBER OF TRANSACTIONS IN NEW MASTER

100,400

NUMBER OF VALID INPUT TRANSACTIONS

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

9,800

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press F6 (Add). The system displays the Definition Type Panel again.
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3. Select Field Value. The system displays the Field Value Panel.
Field Value

Line reference:

----+----1----+----2----+----3----+----4
9,800

Delimited data field number: ____ (1-1000)
Field position: 00060 Field length:
Can this field value position vary? N (Y/N)

1

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Extract decimal indicator? N (Y/N)
Will this be stored as a date in an internal item? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is this an extended internal item?
N (Y/N)
Will this field be translated using a translation table? N

F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

4. Enter 5 in the Field length field. This number specifies the character

length of the field value you want to define.
5. Press F5 to accept. The system displays the Output Value Panel.
Output Value
Specify
1
1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: I 004
or
extraction variable number:
(1-999)
Override sign processing?

F1=Help

F2=Split

N

F3=Exit

Extended? N

(Y/N)

F5=Accept

F9=Swap

6. Verify that the output format is set to 1 (Count). Output format refers

to how this field is represented on the Control Report. This internal
item represents a count.
7. Verify the Assign to internal item number field defaults to 004.
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8. Press F5 to accept. The system displays the Internal Items Panel.
Internal Items
Internal
Item number
004

-------------- Description -------------

Print format:
1
1. Count
2. Amount
3. Date
4. Text
Print decimals:
Specify
1
1.
2.
3.

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left
Calculated item number: 000 (1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?

F1=Help

1

1. Default

F2=Split

2. Print

F3=Exit

3. Do not print

F5=Accept

F6=Cancel

F9=Swap

9. Enter NUMBER OF VALID INPUT TRANSACTIONS in the

Description field.
10. Press F5 to accept. This is the only field value for this embedded key

record. The system displays the Extract window.

Reviewing File Definitions for the Summary Report
Now that we have created the file definitions for Summary Report, we can
review them to determine if they are properly defined.
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Begin by accessing the Extract Window for Summary Report:
1. In the Extract Window, select View > Definitions. The system

displays the definition view of the Summary Report in the Extract
Window.
File Edit View Run Window Help
---------------------------------------------------------------------Extract Window
Row 1 to 2 of 2
File name: SUMM0501
OCC 001 OF EMBEDDED KEY=NUMBER OF VALID INPUT TRANSACTIONS
PICK UP VALUE AT 00060 FOR 05, STORE IN I-004
***************************** Bottom of data ***************************

Command Line ===>
F1=Help
F2=Split
F8=Down
F9=Swap

F3=Exit

F4=Actions

F6=And/Or

F7=Up

2. Check the results in your Extract Window.

The following list displays the definitions you should see for the
Summary Report.
OCC 001 OF EMBEDDED KEY=NUMBER OF VALID INPUT TRANSACTIONS
PICK UP VALUE AT 0060 FOR 05, STORE IN I-004

3. If your results do not match, enter S next to the line that contains the

error. The system will display the appropriate panel for you to make
your changes.
If you make changes, press F5 to accept the changes and return to the
definition view of the Summary Report.
4. Press F3 to exit. The system displays the Extract Window.
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5. Press F3 to exit. The system displays the Job Window with your new

internal item.
File Edit View Run Setup Window Help
---------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 2

A.

B.

C.

Basic Job Information
Job Information:
JOBXYZ
UPDATE
Report Options:
MONTHLY FILE UPDATE SYSTE
Input Sources: 002
UPDT0501
XXXX.UNI.TRNGRPT(UPDT0501)
SUMM0501
XXXX.UNI.TRNGRPT(SUMM0501)
< NEW... >
Internal Items: 004
001
NUMBER OF INVALID TRANSACTIONS
002
NUMBER OF VALID TRANSACTIONS
003
TOTAL INPUT TRANSACTIONS
004
NUMBER OF VALID INPUT TRANSACTIONS
< NEW... >

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

Running Step-by-Step Extraction for the Summary Report
1. Select Window > Extract. The system displays the File ID List Panel.
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2. Enter S to the input source SUMM0501. The system displays the

Summary Report in the Extract Window.
File Edit View Run Window Help
---------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
01/01/03
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
54

DELETE TRANSACTIONS

12

ADD TRANSACTIONS
TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

1
---67

F3=Exit
F9=Swap

VALID
TRANSACTIONS
5,900
1,900
2,000
-------9,800

INPUT
TRANSACTIONS
5,954
912
2,001
------9,867

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

1. Select Run > Step extraction.

The cursor appears over the first value to be extracted while a message
(containing information about the definition) displays in the message
area of the Extract Window.
Run
-----------------------------------------------------------------------Extract Window
File name: SUMM0501
LINES 00000010 COL 0000 0007
---+----1----+----2----+----3----+----4----+----5----+----6----+----7-NUBER OF VALID INPUT TRANSACTIONS
9,800

THIS STEP=OCC 001 OF EMBEDDED KEY=NUMBER OF VALID INPUT TRANSACTIONS
Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. Press Enter to continue the extraction process for each file definition.
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The cursor appears over the next value to be extracted. As you keep
pressing Enter, the cursor will continue extracting values until there
are no definitions left.
Note:

If at any time during the step extraction you wish to “fast forward” the
process, select either the Step X records option or the Finish
extraction option from the Run Menu. If you choose Step X records,
you will be prompted for the number of records you want the system
to process before beginning step extraction again. If you choose
Finish extraction, the system immediately performs the remaining
steps of the process and displays the Extracted Values Report
Panel. If you decide that you want to go back to step extraction, you
will need to begin the step extraction process again.

When the extraction process is complete, the system displays the
Extracted Values Panel.
Extracted Values

Row 1 to 1 of 1

_
NUMBER OF VALID INPUT TRANSACTIONS
9800
***************************** Bottom of data ****************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

3. After reviewing the report, press F3 to exit. The system displays the

Extract Window.
4. Press F3 to exit. The system displays the Job Window.

Defining the Rule and Message for the Summary Report
In these steps, you will define a rule that compares the number of valid
transactions from the update report to the number of valid transactions
from the summary report.
1. Select NEW under Rules. The system displays the Balancing Rules

Panel.
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2. Select Standard. The system displays the Standard Rules Panel.
Standard Rules
Rule number: 002 Alternate Balancing Rule?: N
-------------------------------Formula------------------------------LHS:
Balancing operator:
RHS:

(EQ, NE, GT, LT, GE, LE)

Description:
Return code:
Is rule active? Y
Calculated item to process:
Rule action:
1. Default
1
2. Set completion code
3. Set abend code

F1=Help
F7=Prev

F2=Split
F8=Next

(Y/N)

Set tolerance? N
Print decimals:

Print format:
1
1. Count
2. Amount
3. Date
4. Text

F3=Exit
F9=Swap

F4=Retain

(Y/N)

Print commas:
1
1. Default
2. Print
3. Do not print

F5=Accept

F6=Items

3. Enter I-002 in the LHS field.
4. Enter EQ in the Balancing Operator field.
5. Enter I-004 in the RHS field.

The formula you have just defined verifies that the internal item value
(I-002) of the Number of Valid Transactions from the Update Report is
equal to the internal item value (I-004) of the Number of Valid
Transactions from the Summary Report.
6. Enter VALID TRANSACTIONS FROM UPDATE 0501 = VALID

TRANSACTIONS FROM SUMMARY in the Description field.
7. Enter 3021 in the Return code field.

We recommend that you use values between 2000 and 3999 for return
codes. Use a return code of 0000 if you want your message to print in
every case, not just when the rule is out of balance. Return codes
outside the range of 2000-3999 are reserved for Infogix and system
messages. We will not change the remaining fields.
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8. Press F5 to accept. The system displays the Direct Messages Panel.
Direct Messages
Message number: 002
Return
Message text
code
----------------------------------------

Write message to:
1
1. Control report
2. Console and control report (no response
required)
3. Console and control report (response
F1=Help
F6=Items

F2=Split
F7=Prev

F3=Exit
F8=Next

F4=Retain
F9=Swap

F5=Accept

Messages are lines of instructional text associated with a return code.
We have already set up the return codes. Now we can enter the text for
the message.
Because we specified a return code, the system automatically displays
the Direct Messages Panel.
Note:

The return code is filled in with the value entered on the Rules
Panel.

9. Enter Call Tech Support in the two-line Message Text field.

This means that anytime the VALID TRANSACTIONS (0501) value
(rule number 001) is out of balance, the message “Call Tech Support”
prints on the Control Report.
Note:
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10. Press F5 to accept. The Job Window should now look like the following

figure.
File Edit View Run Setup Window Help
---------------------------------------------------------------------ACR/Summary Job Window
Row 22 from 27

002 VALID TRANSACTIONS FROM UPDATE 0501 = VALID TRANSACATIONS F
< NEW... >
H. Messages: 002
0000 CALL CHRIS KING (EX. 9945)
3021 CALL TECH SUPPORT
< NEW... >
******************************* Bottom of data ***************************

#UNSP001 - Message updated.
Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

11. Select File > Save to save your definitions before continuing.

You have completed the additional job and file definitions for job JOBXYZ.
Next, we will run balancing.

Running Balancing for the Summary Report
1. Select Run > Balancing. The system displays the Balancing Run

Options Menu.
Balancing Run Options
Set overrides for one or more of the following:
Cycle number: . .
Run number: . . .
Rule set override:
Store history override:
F1=Help

F2=Split

(Y/N/I)
F3=Exit

F5=Accept

F9=Swap

2. Enter the same Cycle Number you used in the previous lesson.

Recall that, in the previous lesson, we used an 8-digit number
representing the current date as the cycle number. Because we are
using the same cycle number, the results from this run will overlay the
previous results in the history database.
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3. Press F5 to accept. A message, “Balancing process has been invoked,”

displays. When balancing is complete, the Control Report is displayed.
Menu Utilities Compilers Help
---------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000000 Col 001 080
********************************* Top of Data
**********************************
ACR/S releasenumber
INFOGIX, INCORPORATED
DATE: 08/05/15
BALANCING CONTROL REPORT
TIME: 10:58:16
MONTHLY FILE UPDATE SYSTE
JOB=JOBXYZ
STEP=UPDATE
QUAL
CYCLE#=20120501 RUN#=000
A. INTERNAL ITEMS:
ITEM NO.
DESCRIPTION
-------- ------------------------------------------------------------------I-001.
NUMBER OF INVALID TRANSACTIONS
I-002.
NUMBER OF VALID TRANSACTIONS
I-003.
TOTAL INPUT TRANSACTIONS
I-004.
NUMBER OF VALID INPUT TRANSACTIONS
EXTENDED INTERNAL ITEMS:
NONE.
B. HISTORY ITEMS:
Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F5=Rfind
F12=Cancel

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

The report is too large to print on one panel. You can scroll down or
right.
4. Press F8 to page down.
Menu Utilities Compilers Help
---------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000018 Col 001 080
NONE.
C. CALCULATED ITEMS:
NONE.
D. BALANCING RULES & RESULTS:
RULE NO.
BALANCING RULE
-------- -------------------------------------------------------------1.
# INVALID TRANSACTIONS + # VALID TRANSACTIONS = TOTAL INPUT TRANSACT
(I-001 + I-002) EQ (I-003)
2.

E.

VALID TRANSACTIONS FROM UPDATE 0501 = VALID TRANSACATIONS FROM SUMMA
(I-002) EQ (I-004)
SPECIAL INSTRUCTIONS:
NONE.

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F12=Cancel

F5=Rfind

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

5. Press F7 to page up.
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6. Press F11 to page right.
Menu Utilities Compilers Help
---------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000000 Col 053 132
********************************* Top of Data *********************************
IX, INCORPORATED
PAGE 001
BALANCING CONTROL REPORT
COPYRIGHT INFOGIX, INC.
MONTHLY FILE UPDATE SYSTE
DATA BASE VERSION: 0000013/0000002
=JOBXYZ
STEP=UPDATE
QUAL=
CYCLE#=20120501 RUN#=000
PTION
----------------------------------------

INPUT
------------------

OUTPUT
----------------67
9,800
9,867

9,800

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F5=Rfind
F12=Cancel

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

7. Press F8 to page down.
Menu Utilities Compilers Help
---------------------------------------------------------------------BROWSE
XXXX.SUM.CONTROL1
Line 00000018 Col 053 132

G RULE
--------------------------------------IONS = TOTAL INPUT TRANSACTIONS

RESULT
-----------------IN BALANCE

ID TRANSACATIONS FROM SUMMARY

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F12=Cancel

ERROR/TOLERANCE
------------------

IN BALANCE

F5=Rfind

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

Check your results to verify if your job is in balance. If your results are
out of balance, you will need to return to the section “Reviewing File
Definitions” to see which definitions are incorrect.
8. Press F3 to exit. The system displays the Job Window.
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Basic Balancing Using History
To compare values from two jobs, you will learn how to store history items
and then use those items in a rule. The basic requirements for this
balancing job are described in “Requirements for Basic Balancing Using
History” on page 58.

Entering Job Information for the Comparison
To compare values from two jobs, you will learn how to store history items
and then use those items in a rule.
To create a new job, we must clear the old one. We can do this from the File
Menu in the Job Window.
1. Select File > New. The system displays the cleared Job Window.
2. Select Job Information and press Enter. The system displays the

Job Information panel.
Enter the following information:
Job Name: JOBXYZ
Setup Name: COMPARE
Control Report Title: COMPARE MONTHLY REPORT 0501
WITH 0601
3. Press F5 to accept. The system displays the Job Window.
4. Enter V next to Job Information. This will expand the Job Information

section.
File

Edit

View

Run

Setup

Window

Help

ACR/Summary Job Window
_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

Basic Job Information
Job Information:
JOBXYZ
COMPARE
Store History:
Yes
Set Return Code:
No
Set File Control:
No
Access User Exit:
Only out of balance
Truncate/Round Results:
Round
Model Definitions:
No
Comments Exist:
No
Report Options:
Input Sources: 001
SUMM0501
XXXX.UNI.TRNGRPT(SUMM0501)
< NEW... >

Command Line ===>
F1=Help
F2=Split
F9=Swap
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Row 1 from 24

F3=Exit

F4=Actions

F7=Up

F8=Down
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5. Enter S next to Store History. The system displays the Store History

panel.
Store History

Store balancing values in history? Y

(Y/N/I)

If yes, enter the number of runs to keep:

F1=Help

F2=Split

F3=Exit

001

F5=Accept

(1-999)

F9=Swap

6. Enter 005 in the Enter the number of runs to keep field and press F5.

We will not change the remaining fields.
The system displays the Job Window.
7. Enter V next to Job Information. This will compress the Job

Information section.

Adding an Input Source for UPDT0601
1. Select NEW under Input Sources. The system displays the Input

Sources Panel.
2. Enter the following information:

File Description: UPDATE0601 REPORT
File DDNAME: UPDT0601
DSNAME: XXXX.XXXX(UPDT0601)
where XXXX.XXXX is the high-level qualifier and middle-level
qualifier assigned during installation.
3. Press F5 to accept.
4. Press F5 to accept the Physical Sequential Panel.
5. Enter 00100 in the Maximum number of records to process field.
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6. Press F5 to accept. The system displays the updated Job Window.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 18

A.

Basic Job Information
Job Information:
JOBXYZ
COMPARE
Report Options:
COMPARE MONTHLY REPORT 0501 WITH 0601
B. Input Sources: 001
UPDT0601
XXXX.SUM.TRNGRPT(UPDT0601)
< NEW... >
C. Internal Items: 000
< NEW... >
D. Extended Internal Items: 000
< NEW... >
E. Extraction Variables: 000
< NEW... >
F. Extraction Variables: 000
< NEW... >
Command Line ===>
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Creating File Definitions for the Comparison
1. Select Window > Extract. The system displays the File ID List Panel.
2. Enter S to the input source UPDT0601. The system displays the

Extract Window.
File Edit View Run Window Help
------------------------------------------------------------------------Extract Window
File name: UPDT0601
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-XYZ COMPANY
UPDATE CONTROL REPORT
mm/dd/yy
PAGE 1

CHANGE TRANSACTIONS

INVALID
TRANSACTIONS
37

DELETE TRANSACTIONS

19

ADD TRANSACTIONS
TOTAL

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down
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---60

F3=Exit
F9=Swap

VALID
TRANSACTIONS
4,800
1,900
2,000
-------8,700

INPUT
TRANSACTIONS
4,837
1,919
2,004
------8,760

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right
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Identifying the Embedded Key Record for UPDT0601
1. Place the cursor on the first character of the record that begins with the

word TOTAL.
2. Press F6 (Add).
3. Enter 4 (Embedded Key).
4. Enter 5 in the Length field. We will not change the remaining fields.
5. Press F5 to accept.

Identifying the Field Value for Total Number of Valid
Transactions
1. Place the cursor on the number 8 of 8,700.
2. Press F6 (Add).
3. Enter 5 (Field Value).
4. Enter 5 in the Length field. We will not change the remaining fields.
5. Press F5 to accept.
6. Verify 001 is in the Assign to internal item number field.
7. Verify the output format is set to 1 (Count). We will not change the

remaining fields.
8. Press F5 to accept.
9. In the Internal Items Panel, enter NUMBER OF VALID INPUT

TRANSACTIONS (0601) in the Description field. We will not
change the remaining fields.
10. Press F5 to accept. The system displays the Extract Window.

The next section provides a way to review the definitions you just set up.
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Reviewing File Definitions
Begin by accessing the Update 0601 Report in the Extract Window:
1. In the Extract Window, select View > Definitions. The system

displays the definition view of the Update 0601 Report in the Extract
Window.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
Row 1 to 2 of 2
File name: UPDT0601
OCC 001 OF EMBEDDED KEY=TOTAL
PICK UP VALUE AT 00044 FOR 05, STORE IN I-001
***************************** Bottom of data****************************

Command Line ===>
F1=Help
F2=Split
F8=Down
F9=Swap

F3=Exit

F4=Actions

F6=And/Or

F7=Up

2. Check the results in the Extract Window.
OCC 001 OF EMBEDDED KEY=TOTAL
PICK UP VALUE AT 0044 FOR 05, STORE IN I-001

3. If your results do not match, use the arrow keys to move the cursor

next to the line that contains the error. Enter S.
4. If you are making corrections, press F5 to accept the changes.
5. Press F3 to exit the View Definitions Panel.
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6. Press F3 to exit the Extract Window. The system displays the Job

Window.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 19

A.

Basic Job Information
Job Information:
JOBXYZ
COMPARE
Report Options:
COMPARE MONTHLY REPORT 0501 WITH 0601
B. Input Sources: 001
UPDT0601
XXXX.UNI.TRNGRPT(UPDT0601)
< NEW... >
C. Internal Items: 001
001
NUMBER OF VALID INPUT TRANSACTIONS (0601)
< NEW... >
D. Extended Internal Items: 000
< NEW... >
E. Extraction Variables: 000
< NEW... >
F. History Items: 000
Command Line ===>
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

7. Select Window > Extract > UPDT0601. The system displays the

Extract Window.
8. Select Run > Step Extraction.
9. Press Enter to continue the extraction process for each file definition.

The system displays the Extracted Values panel.
Extracted Values

Row 1 to 1 of 1

_
NUMBER OF VALID INPUT TRANSACTIONS (0601
8700
***************************** Bottom of data ****************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

10. Press F3 to exit the report.
11. Press F3 to exit the Extract Window. The system displays the Job

Window.
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Specifying History Items
A history item specifies retrieval from the history database of a value that
was stored in a previous run of the current job or of a different job. The
retrieved value can be an internal or extended internal item, job run date,
job run time, or cycle number. History items can be used in calculated items
or rules that you define for the current job run.
In this tutorial, when we run JOBXYZ, the COMPARE step uses the values
from the UPDATE step as history items.
Each run of a job is referred to as a cycle and is referenced from the current
run of a job. For example, the current run is referred to as cycle +00. The
previous run of the job is referred to as cycle -01. The run before last is cycle
-02, etc.
The table below describes the terms you need to know for specifying history
items.
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Term

Description

Cycle
Number

A cycle number is an eight-digit date or other ascending
sequence number that you extract from an input source or
assign when you run a balancing job. It uniquely identifies the
set of data you are balancing.

Relative
Cycle

A relative cycle is the number of runs of the same job and step
as it relates to the current run. For example, the current run is
numbered +00, the last run before this current run is numbered
as -01.
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Defining the History Item (E-001)
1. In the Job Window, select NEW under History Items. The system

displays the History Items Panel.
History Items
Item number
001

-------------- Description ------------________________________________________
________________________________________

History job ID:
Job name: ________ Item type: I Item number: 000 (I/X: 1-100)
Step name: ________
Qualifier: __
Relative cycle: +000 (-998 to +000)
If item type is cycle number, specify format:
__ 1. YYMMDD
2. MMDDYY 3. MMDDCCYY 4. DDMMYY
5. YYJJJ
6. DDMMCCYY 7. As is
8. CYYMMDD
9. CCYYMMDD 10.CCYYJJJ
Should most recent cycle be retrieved when cycle does not match
current cycle? N (Y/N)
Specify an action to take when a history is not found:
2_ 1. Set the history item to zero or spaces and continue processing
2. Set all rules involving this item out of balance
3. Skip all balancing rules involving the history item
Set advanced features? N (Y/N) Cross platform history item? N (Y/N)
F1=Help
F2=Split
F8=Next F9=Swap

Note:

F3=Exit

F4=Retain

F5=Accept

F7=Prev

The history item number defaults to 001.

2. Enter NUMBER OF VALID TRANSACTIONS (0501) in the

Description field.
3. Enter JOBXYZ in the Job Name field.

The History Job ID field contains the names of the job and step from
which the internal items are to be retrieved. ACR/Summary searches
for the job and step name in the history database, then extracts the
specified value.
4. Enter 002 in the Internal Item Number field. This specifies the

original internal item number of this value.
5. Enter UPDATE in the Step Name field.
6. Enter -001 in the Relative Cycle field.

Relative cycle identifies the run of this job and step1. We are searching
for the internal item number from the last time this job was run,
therefore we choose -01.
The default value for the Should most recent cycle be retrieved when
cycle does not match current cycle field is N. We will not change this
value.
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For more information about options for relative cycles, see “What Is
Relative Cycle Processing?” on page 427,
7. Press F5 to accept. The system displays the Job Window. Notice that

the history item number ID E-001.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 13 from 20

001
NUMBER OF VALID TRANSACTIONS (0501)
< NEW... >
F. Calculated Items: 000
< NEW... >
G. Rules: 000
< NEW... >
H. Messages: 000
< NEW... >
***************************** Bottom of data ***************************

#DWBPJ204 - History item updated.
Command Line ===>
F1=Help
F2=Split
F3=Exit
F9=Swap

F4=Actions

F7=Up

F8=Down

We have just defined the internal items and history items. Next we will set
up rules.
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Entering the Rule and Message for the Comparison
1. Select NEW under Rules.
2. Select Standard in the Rules Panel. The system displays the Standard

Rules panel
Standard Rules
Rule number: 001 Alternate Balancing Rule?: N
-------------------------------Formula------------------------------LHS:
Balancing operator:
RHS:

(EQ, NE, GT, LT, GE, LE)

Description:
Return code:
Is rule active? Y
Calculated item to process:
Rule action:
1. Default
1
2. Set completion code
3. Set abend code

F1=Help
F7=Prev

F2=Split
F8=Next

(Y/N)

Set tolerance? N
Print decimals:

Print format:
1
1. Count
2. Amount
3. Date
4. Text

F3=Exit
F9=Swap

F4=Retain

(Y/N)

Print commas:
1
1. Default
2. Print
3. Do not print

F5=Accept

F6=Items

3. Enter I-001 in the LHS field.
4. Enter EQ in the Balancing Operator field.
5. Enter E-001 in the RHS field.
Note:

E-001 represents the history item. Because history items are
retrieved from reports external to the current report, they are
designated by E-###.

6. Enter VALID TRANSACTIONS (0501)= TOTAL VALID

TRANSACTIONS (0601) WITHIN 20% VARIANCE in the
Description field.
7. Enter 3000 in the Return code field.
8. Enter Y in the Set Tolerance field. We will not change the remaining

fields.
9. Press F5 to accept.

ACR/Summary User Guide for z/OS

109

3  Tutorial
Basic Balancing Using History

The system displays the Tolerance/Skip Processing Panel.
Tolerance/Skip Processing
Specify
1
1.
2.
3.

the type of processing to define:
Absolute tolerance
Percentage tolerance
Skip this rule if the left-hand
value equals the skip value

Tolerance or skip value:
F1=Help
F9=Swap

F2=Split

_________
F3=Exit

F5=Accept

10. Enter 2 (Percentage Tolerance).

We are indicating that when two values are compared they will be
allowed a variation by percentage in order to be considered in balance.
11. Enter 20 in the Tolerance or skip value field.

This number represents the percentage allowable for a report to be in
balance, +/- 20%.
12. Press F5 to accept. The system displays the Direct Messages Panel.
13. Enter MONTHLY VALID TRANSACTIONS OUTSIDE

TOLERANCE LIMIT CALL STEVE JONES in the two-line
Message Text field.
14. Press F5 to accept. The Job Window should now look like the following

graphic.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 18 from 22

001 VALID TRANSACTIONS (0501)=TOTAL VALID TRANSACTIONS (0601) W
< NEW... >
H. Messages: 001
3000 MONTHLY VALID TRANSACTIONS OUTSIDE TOLER
< NEW... >
******************************* Bottom of data *************************

e #UNSP001 - Message updated.
Command Line ===>
F1=Help
F2=Split
F9=Swap
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F7=Up
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15. Select File > Save and save your definitions.

We have completed the additional job and file definitions. Next, we will
run balancing.

Running Balancing for the Comparison
1. In the Job Window, select Run > Balancing. The system displays the

Balancing Run Options panel.
2. In the Cycle Number field, enter an 8-digit cycle number representing

a date one month later than the last run.
For example, if today’s date was May 1, 2012, and you used 20120501
to represent that date in the last run, you would enter a date
representing one month later, such as 20120601.
3. Press F5 to accept.

When balancing is complete, the system displays the Control Report.
BROWSE
XXXX.SUM.CONTROL1
Line 00000000 Col 001 080
********************************* Top of Data **********************************
ACR/S releasenumber
INFOGIX, INCORPORATED
DATE: 08/05/22
BALANCING CONTROL REPORT
TIME: 11:18:16
COMPARE MONTHLY REPORT 0501 WITH
JOB=JOBXYZ
STEP=COMPARE QUAL
CYCLE#=20120601 RUN#=000
A. INTERNAL ITEMS:
ITEM NO.
DESCRIPTION
-------- -------------------------------------------------------------------I-001.
NUMBER OF VALID INPUT TRANSACTIONS (0601)
EXTENDED INTERNAL ITEMS:

B.

NONE.
HISTORY ITEMS:

DESCRIPTION
ITEM NO.
JOB
STEP
QUAL ITEM CYCLE
CYCLE# RUN# RUNDATE
RUN
-------- -------------------------------------------------------------------Command ===>
Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F5=Rfind
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right F12=Cancel

The report is too large to print on one panel. You can scroll down or
right.
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4. Press F8 to page down.
BROWSE
E-001.

XXXX.SUM.CONTROL1
NUMBER OF VALID TRANSACTIONS (0501)
JOBXYZ
UPDATE
I-002
-001

Line 00000018 Col 001 080
20120501

000 08/05/14

10:4

C.

CALCULATED ITEMS:
NONE.
D. BALANCING RULES & RESULTS:
RULE NO.
BALANCING RULE
-------- -------------------------------------------------------------------1.
VALID TRANSACTIONS (0501)=TOTAL VALID TRANSACTIONS (0601) WITHIN 20%
(I-001) EQ (E-001)
E. SPECIAL INSTRUCTIONS:
NONE.

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F12=Cancel

F5=Rfind

F7=Up

Scroll ===> PAGE
F8=Down
F9=Swap

5. Press F7 to page up.
6. Press F11 to page right.
BROWSE
XXXX.SUM.CONTROL1
Line 00000000 Col 053 132
********************************* Top of Data **********************************
IX, INCORPORATED
PAGE 001
BALANCING CONTROL REPORT
COPYRIGHT INFOGIX, INC. 2012
RE MONTHLY REPORT 0501 WITH 0601
DATA BASE VERSION: 0000018/0000003
=JOBXYZ
STEP=COMPARE QUAL=
CYCLE#=20120601 RUN#=000
PTION
---------------------------------------)

INPUT
-----------------8,700

OUTPUT
------------------

PTION
CYCLE# RUN# RUNDATE
RUNTIME PROGRAM
INPUT
OUTPUT
----------------------------------------- ------------------ -----------------Command ===>
Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F5=Rfind
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right F12=Cancel
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7. Press F8 to page down.
BROWSE
0080501

XXXX.SUM.CONTROL1
000 08/05/14

Line 00000018 Col 053 132
9,800

10:44:30 ISPTASK
...........................................

NG RULE
---------------------------------------ANSACTIONS (0601) WITHIN 20% VARIANCE

Command ===>
F1=Help
F2=Split
F10=Left
F11=Right

F3=Exit
F12=Cancel

RESULT
-----------------IN BALANCE

F5=Rfind

F7=Up

ERROR/TOLERANCE
-----------------+/20.%

Scroll ===> PAGE
F8=Down
F9=Swap

Verify if your job is in balance. If your results are out of balance, return
to “Reviewing File Definitions” on page 104.
8. Press F3 to exit. The Job Window displays.
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Setting the User Options
This chapter discusses ACR/Summary system-wide user options that you
can optionally modify. It contains the following sections:






“What Is the User Options File?” on page 115
“User Options Panel” on page 116
“User Options Detailed Descriptions” on page 118
“Editing the User Options File” on page 141

What Is the User Options File?
The user options file, XXXXXXXX.USEROPT, is optional but is normally
created during ACR/Summary initial setup. System defaults are available if
it does not exist.
This file allows you to set system-wide options for all of your ACR/
Summary jobs. The options allow you to customize 1) processing (such as
temporarily “shutting off” all balancing jobs) and 2) report formatting.
Any options you specify in the user options file are applied to every
ACR/Summary batch job that references the file. The name of the default
user options file is automatically specified in the UNIUF DD statement of
each balancing job’s JCL.
User options that you specify for dynamically allocating files can be
overridden for individual jobs as necessary by adding DD statements to the
job JCL.

Creating a User Options File
If you want to have a user options file and one was not created during initial
setup, select Setup > Files. Then complete option 1, Specify user file
defaults and option 2, Allocate user files. For more information, see “User
File Defaults Panel” on page 35 and “Allocate User Files Panel” on page 36.
The user options file you create during the setup process is empty. Records
are added as you specify user options.
You can create multiple user options files if you have multiple processing
environments. One way to do this is by copying and editing an existing file.
If you have specified many user options, copying an existing file may be
faster than choosing all the options again to create a new user options file.
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The ACR/Summary and ACR/Detail user options files cannot be used
interchangeably. If you use both products, you need to create a separate
user options file for each product.
The UNIUOPT user exit enables you to globally specify a user options file
for all ACR/Summary balancing jobs. See “User Options File (UNIUOPT)
User Exit” on page 667. However, a user options file specified in a job JCL
will override the user exit.
You can set most user options in the following ways:

 Select user options from the User Options panel.
 Manually edit a user options file. For instructions, see “Editing the User
Options File” on page 141.

User Options Panel
From the Job Window select Setup > User Options. The User Options
panel displays.
Select each user option you want to specify. The corresponding panels will
display.Following is a summary description of each option and where to go
for more information.

 Dynamic allocation of files. Dynamically allocate files, including
files you balance with ACR/Summary, the history and definition
databases, and ACR/Summary reports. See “Dynamic Allocation of
Files” on page 118.

 Date/Time formats. Customize the formatting of dates and times in
reports. See “Date/Time Formats” on page 121.

 Currency formats. Customize the formatting of currency amounts in
reports. See “Currency Formats” on page 123.

 Negative signs. Customize the formatting of negative numbers in
reports. See “Negative Signs” on page 124.

 Write to operator (WTO) messages. Have ACR/Summary jobs
write any error-level messages they produce to the console, rather than
just to SYSOUT. See “Write to Operator Messages” on page 124.

 Global messages. Specify default messages for return codes that do
not have messages associated with them in individual jobs. See “Global
Messages” on page 125.

 Global processing options. Shut off ACR/Summary processing, or
override z/OS step completion code options for ACR/Summary jobs.
See “Global Processing Options” on page 128.
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 XML options. Specify options for generating the Control Report, User
Report, and/or Free-Form Report in XML format. See “XML Options”
on page 129.

 Infogix Assure Information. Specify the details to connect to the
Infogix Assure database server. See “Infogix Assure Information” on
page 131

 Email Notification. Specify the details to send emails. For each email
recipient, the balancing/reconciliation job builds the JCL to send email
and report attachments according to the report switches specified for the
messages.
The remaining options require Yes or No answers:

 Automatically rerun balancing steps? Automatically reruns all
balancing jobs of a job stream. See “Automatic Rerun” on page 134.

 Keep a dual history of balancing steps? Keeps a dual history of the
balancing jobs in a second history database to permit rapid recovery in
case of DASD failure. See “Dual History” on page 137.

 Store all reruns of balancing steps? Stores all of the reruns for a
balancing job in the history database, including the control values and
balancing results. The stored reruns remain linked to the active history,
so the audit trail is always current. See “Store All Reruns” on page 138.

 Allow insert of history records? Enables insertion of history
records with cycle numbers lower than those of records already in the
history database for the same job. See “Allow Insert of History Records”
on page 139.

 Automatically compress definition library? By default, in order
to make efficient use of mainframe resources, the definition library is
compressed each time you bring up the Save panel. If compressing take
too long, you can choose No to disable automatic compression. See
“Automatically Compress Definition Library” on page 140.

 Always prompt before product exit? Specify whether you will
receive a confirmation prompt before exiting the product. Regardless of
your selection, you will be prompted to save if you have changed your
definitions. See “Always Prompt Before Product Exit” on page 140.

 Print commas in count fields? Specifies whether to print the
thousands place indicator (default is a comma) for fields formatted as
counts. See “Print Commas in Count Fields” on page 140.

 Print commas in amount fields? Specifies whether to print the
thousands place indicator (default is a comma) for fields formatted as
amounts. See “Print Commas in Amount Fields” on page 140.
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 Use 22-character numeric format? Specifies whether to use 22
character formatting for count and amount fields instead of the default
of 18 characters. See “22-Character Numeric Formatting” on page 141.

User Options Detailed Descriptions
Dynamic Allocation of Files
Dynamic allocation allows you to minimize the number of DD statements
that must be included in your production JCL to run ACR/Summary.
When a balancing job is processed, any files that are specified in the JCL are
used. For example, there may be a UNIDF DD statement containing the
name of the definition database to use. If the JCL does not specify which
definition database file to use, the user options file will be searched for a
dynamic file allocation record indicating the DDNAME of the definition
database file. If found, this DDNAME will be used.

Restrictions
Dynamic allocation is not available for the LOADLIB or any non-Infogix
file.
The control file (for licensing) and the user options file can be dynamically
allocated only through user exit programs. See “Using the User Exit
Programs” on page 661.

Ways to Dynamically Allocate
You can specify files to dynamically allocate in the following ways:

 Through the user options:
 To use the user interface, see “Dynamic Allocation Through the
User Options Panel” on page 119.

 To edit the user options file manually, you would create and
manually edit the UNIDSN, UNIPDS, and UNIOUT records in the
user options file. For more information, see “UNIDSN, UNIPDS,
and UNIOUT Record Layouts” on page 144.

 By editing the JCL. You can specify the dynamic allocation of input files,
files used for ACR/Summary processing, and output reports by adding
DD statements to the JCL for your balancing jobs. JCL edits override
the settings in the user options file.

 As mentioned in "Restrictions" above, you can dynamically allocate the
control file and the user options file through user exit programs.
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Files You Can Dynamically Allocate
The table below lists some of the files that you can dynamically allocate.
Option Type

DDNAME

File Description

VSAM and Sequential
Datasets

UNIDF

Definition database

VSAM and Sequential
Datasets

UNIHF

History database

VSAM and Sequential
Datasets

UNIHF2

Dual History database

Partitioned Dataset

User specified

File to be balanced

SYSOUT

UNIACR

Control Report

SYSOUT

UNIEXTR

Extract File

SYSOUT

UNIRCR

Recap Report

SYSOUT

UNIUSR

User Report

SYSOUT

UNISSR2

History Analysis Report

INSGTCF*

INSGTCF

Infogix Insight
Configuration File

INSGTRF*

INSGTRF

Infogix Insight
Environment File

* For more information on allocating these options, see “Modify the UNICNTL Member” Located
in UNI.SKLLIB” in the ACR/Summary and ACR/Detail Installation Guide for z/OS.

Dynamic Allocation Through the User Options Panel
If you selected Dynamic allocation of files from the User Options panel the
Dynamic Allocation Files List (not shown) will display. This panel lists any
files currently specified for dynamic allocation in your user options file.
To dynamically allocate a file, select NEW from the Dynamic Allocation
Files List. The Dynamic Allocation panel displays.
Dynamic Allocation
Type of
__ 1.
2.
3.
F1=Help

file to allocate:
Physical sequential or VSAM
Partitioned dataset (PDS)
Sysout
F2=Split
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Type of file to allocate. After you select the type you want, the
corresponding panel will display:
1. Physical sequential or VSAM. See "Dynamic Allocation: PS/VSAM"
2. Partitioned dataset (PDS). See "Dynamic Allocation: PDS"
3. Sysout. See "Dynamic Allocation: SYSOUT"

Dynamic Allocation: PS/VSAM
If you chose Physical sequential or VSAM on the Dynamic Allocation panel,
the Dynamic Allocation - PS/VSAM panel will display.
Dynamic Allocation - PS/VSAM
DDName: ________
DSName: __________________________________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

DDName. DDNAME of the file to allocate.
DSName field. Dataset name of the file to allocate.
Press F5 to display the Dynamic Allocation Files List. Your entry will be
included in the list.
Dynamic Allocation: PDS
If you chose Partitioned dataset on the Dynamic Allocation panel the
Dynamic Allocation - PDS panel will display.
Dynamic Allocation - PDS
DDName: ________
DSName: __________________________________________
Member name: ________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

DDName. DDNAME of the file to allocate.
DSName field. Dataset name of the file to allocate.
Member name. Name of the member to allocate.
Press F5 to display the Dynamic Allocation Files List. Your entry will be
included in the list.
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Dynamic Allocation: SYSOUT
If you chose Sysout on the Dynamic Allocation panel the Dynamic
Allocation - Sysout panel will display.
This option is typically used to allocate report files. It allows you to specify
where the reports files should go on the JES spool. Unlike the other two
types of files you can dynamically allocate, the assumption is that these files
do not exist, but will be created during balancing. If you look at your
balancing job JCL, it will usually read SYSOUT=X, which means it defaults
to whatever class you specify.
Dynamic Allocation - Sysout
DDName: . . . ________
Sysout class: _
Writer name:
F1=Help

________

F2=Split

F3=Exit

F5=Accept

F9=Swap

DDName. DDNAME of the file to allocate. Files commonly chosen for
dynamic allocation on this panel are UNIACR (the Control Report),
UNIACR2 (copy 2 of the Control Report) and UNIUSR (the User Report).
See the table on “Files You Can Dynamically Allocate” on page 119 for the
DDNAMEs of additional commonly allocated files.
Sysout class. The output class the file should be directed to. For example,
*, A.
Writer name. Name of the writer used to route the output, if applicable.
Press F5 to display the Dynamic Allocation Files List. Your entry will be
included in the list.

Date/Time Formats
If you selected Date/Time formats from the User Options panel, the Date/
Time Formats panel will display, allowing you to customize the dates and
times in reports.
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You can specify these options through this panel or make manual edits to
UNIXOPT. See “UNIXOPT Record Layout” on page 151.
Date/Time Formats
Specify output format order (use YMD) for date: ___
Specify character to separate date elements: _
Suppress zeros in dates?
N
Print century before year? N

(Y/N)
(Y/N)

Specify character to separate time elements: _
Specify output format and notation for time:
2_ 1. HH:MM
2_ 1. 12-hour format
2. HH:MM:SS
(AM/PM)
3. HH:MM:SS.NN
2. 24-hour format
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify output format order for date. Indicate the correct format for
dates by typing the characters Y (Year), M (Month), and D (Day) in the
order you prefer.
The default is Year/Month/Day. Any dates on reports will appear in the
format you specify. For instance, if you specify MDY, January 13, 2012 will
appear on reports as 01/13/12.
Specify character to separate date elements. Specify the symbol or
character to separate the year, month, and day. The default is a slash (/).
Any character is allowed.
Suppress zeros in dates? Enter Y to suppress leading zeros in days and
months. For example, in dd/mm/yy format, the date 01/02/12 will be
printed as 1/2/12.
Print century before year? Enter Y to print the century before the year.
Otherwise blanks will print in the century position.
Specify character to separate time elements. Specify the symbol or
character to separate the hour, minutes, and seconds. The default is a
colon (:). Any character is allowed.
Specify output format and notation for time. Specify the output
format and the notation for time. The default output format is HH:MM:SS,
and the default notation is the 24-hour format.
Press F5 to accept.
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Currency Formats
If you selected Currency formats from the User Options panel the Currency
Formats panel will display, allowing you to customize the formatting of
currency amounts in reports.
You can specify these options through this panel or make manual edits to
UNIXOPT. See “UNIXOPT Record Layout” on page 151. To accept the
default for any of the options, leave the option blank.
Currency Formats
Thousands marker symbol: _
Decimal marker symbol:
_
Currency symbol: . . . . . ______ (enter NONE for spaces)
Second currency symbol:
______
Length of currency symbol: 1 (1-6)
Number of spaces between amount and currency symbol: 0 (0-8)
Print currency symbol:
1_ 1. Before amount
2. After amount
3. Both before and after amount
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Thousands marker symbol. Symbol to use to separate every set of three
digits to the left of the decimal point. You can use any symbol. The default
is a comma.
Decimal marker symbol. Symbol to use as a decimal marker. You can
use any symbol. The default is a period.
Currency symbol. Symbol you want to use as the currency symbol. Any
character string can be used. The default is a dollar sign ($). Enter NONE if
you want the currency symbol to be one or more spaces.
Second currency symbol. If you select option 3 for the Print currency
symbol field, specify what this second (trailing) currency symbol will be.
Any string can be used.
Length of currency symbol. The number of characters used for the
currency symbol. The default is 1.
Number of spaces between amount and currency symbol. Indicate
the number of spaces of “padding” you want between the amount and the
symbol.
Print currency symbol. Specify the location of the symbol.
Press F5 to accept.

ACR/Summary User Guide for z/OS

123

4  Setting the User Options
User Options Detailed Descriptions

Negative Signs
If you selected Negative signs from the User Options panel will display,
allowing you to override the system defaults for the formatting of negative
signs in reports.
You can specify these options through this panel or make manual edits to
UNIXOPT. See “UNIXOPT Record Layout” on page 151. To accept the
default for any of the options, leave the option blank.
Negative Signs
Negative sign symbol: . . . . .
Second negative sign symbol:
Length of negative sign symbol:
Number of spaces between amount

-_____
-_____
1 (1-6)
and negative sign symbol: 0

(0-8)

Print negative sign symbol:
1_ 1. Before amount
2. After amount
3. Both before and after amount
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Negative sign symbol. Enter up to 6 characters or symbols that you want
to use as the negative sign. Any character string can be used. The default is
the conventional minus sign (-).
Second negative sign symbol. If you select option 3 for the Print
negative sign symbol field, specify what this second negative sign symbol
will be. Any string of up to 6 characters can be used.
Length of negative sign symbol. The number of characters used for the
negative sign symbol.
Number of spaces between amount and currency symbol. Indicate
the number of spaces of “padding” you want between the amount and the
symbol.
Print negative sign symbol. Specify the location of the symbol.
Press F5 to accept.

Write to Operator Messages
If you selected Write to operator (WTO) messages from the User Options
panel the Write To Operator (WTO) Messages panel will display, allowing
you to specify that error (E-level) messages will be written not only to a
SYSOUT dataset but also to the console.
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You can specify these options through this panel or make manual edits to
UNIXOPT. See “UNIXOPT Record Layout” on page 151.
Write To Operator (WTO) Messages
Specify error message routing and treatment:
1_ 1. Do not route error messages to console
2. Route error messages to console, no required operator
response
3. Route error messages to console, required operator response
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify error message routing and treatment. Options:
1. Do not route error messages to console. This is the default.
2. Route error messages to console, no required operator response. Flash

error messages to the operator for corrective action. Processing will
continue.
3. Route error messages to console, required operator response. Route

error messages to the console and stop processing until the operator
responds.
Press F5 to accept.

Global Messages
A global message is a message that will print in the Control Report when
any job issues its associated return code, providing no message has been
defined for that return code at the job level.
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Creating Global Messages
To define global messages, do the following:
1. Define a global messages job name. Use any unique, valid job name.

You can define the name in one of the following ways:

 Specify the global messages job on the Global Messages panel in
user options.
Global Messages
Name of the job containing the messages
to be used for all balancing rules: ________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Name of the job containing the messages to be used for all
balancing rules. Name of the global messages job, as described
above.

 Edit the UNIXOPT record to specify the global messages job. See
“UNIXOPT Record Layout” on page 151.
2. Create a separate global messages job for each return code for which

global messages should be generated. Each global messages job must
follow these guidelines:

 The job name should be the global messages job name specified in
step 1.

 The step name should be RCnnnn, where nnnn is the return code for
which you want to specify one or more global messages.

 The qualifier field must be left blank.
For example, if MYGLOBAL is the global messages job name, and
the return code for which you want global messages to be
generated is 3000, the job ID would be MYGLOBALRC3000.
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 Define the messages. In Job Window for the global messages job,
select New under the Messages section and select Direct Message
to display the Direct Messages panel (see “Direct Messages Panel”
on page 250. Create the first message to be associated with the
return code indicated in the step name. Up to 100 messages may be
created.
Note:

In a global messages job, the system does not process the entry
in the Direct Messages panel’s Return Code field. All messages
you create will be associated with the return code indicated in the
job’s step name, regardless of your entry in the Return Code
field.
If you want to create global messages for multiple return codes,
you must create multiple global messages jobs.

3. Save each global messages job and update the definition database.

Processing of Global Messages
When you run any job that generates a return code for which there is no
message defined at the job level, the following processing will take place:
1. The system searches the user options file for the global messages job

name.
2. One of the following will take place:

 If no global messages job name has been defined in the user options
file, the message NONE will be printed on the Control Report for the
return code.

 If a global messages job name is found, the system will continue to
the next step.
3. The definition database will be searched for a job that has both the

global messages job name and a step name in the format RCnnnn,
where nnnn is the return code generated.
4. If such a job is found, the global messages defined in that job will be

printed on the Control Report.
5. If such a job is not found, the message NONE will be printed on the

Control Report for the return code.
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Global Processing Options
You can specify these options through the User Options panel or by editing
the UNIEXEO record in the user options file, which is typically created
during setup.
If you selected Global processing options from the User Options panel the
Global Processing Options panel will display. You can specify these options
through the User Options panel or by editing the UNIEXEO record. For
more information, see “UNIEXEO Record Layout” on page 150.
Global Processing Options
Shut off processing and set zero return code: N
Override set zero return code option:

N

(N/Y/X)

Override set step return code option:

Y

(N/Y/X)

Override set abend return code option: X

(N/Y/X)

F1=Help

F2=Split

F3=Exit

F5=Accept

(N/Y)

F9=Swap

Shut off processing and set zero return code. To turn off ACR/
Summary processing, enter Y in this field and, also in the Override set zero
return code option field. Press F5 to accept. When a job starts, it will set a
return code of 0000 and immediately shut down without performing
balancing. When you are ready to reactivate processing, change the fields
back to N.
Override set zero return code option. Enables you to override the joblevel z/OS step completion code option on the Set Return Code panel (See
“Set Return Code” on page 163) for jobs that currently set a completion
code of zeros. Options:
Y. Jobs that would otherwise set a completion code of zeros will now set a
non-zero completion code if one or more rules are out of balance.
X. Jobs that would otherwise set a completion code of zeros will now force
a user abend if any rule is out of balance.
N. Do not override.
Override set step return code option. Enables you to override the joblevel z/OS step completion code option on the Set Return Code panel for
jobs that currently set a non-zero completion code. Options:
N. Jobs that would otherwise set a non-zero completion code will now set a
completion code of zeros.
X. Jobs that would otherwise set a non-zero completion code will now force
a user abend if any rule is out of balance.
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Y. Do not override.
Override set abend return code option. Enables you to override the
step completion code option on the Set Return Code panel for jobs that
currently force a user abend. Options:
N. Jobs that would otherwise forced a user abend will now set a completion
code of zeros.
Y. Jobs that would otherwise forced a user abend will now set a completion
code if one or more rules are out of balance.
X. Do not override.
Press F5 to accept.

XML Options
If you selected XML options from the User Options panel the XML Options
panel will display. This panel allows you to specify user options for creating
Control Reports, User Reports, and/or Free-Form Reports in XML format
and for error handling when using these features. These options apply only
to reports for jobs run in batch.
You can specify these options at the system level through the User Options
panel or by directly editing the UNIXOPT record. See “UNIXOPT Record
Layout” on page 151. The options you select here for the each report can be
overridden at the job level. In file interface mode (the typical mode), the
corresponding job level options can be overridden at the JCL level. For JCL
override instructions, see “SUM2000 JCL Parms for the File Interface
Balancing Program” on page 388.
XML Options
Control report:
1_ 1. Do not generate
2. Generate, write copy 1 to file
3. Generate, autoload copy 1 to database
4. Generate, write copy 2 to file
5. Generate, autoload copy 2 to database
User report:
Freeform report:
1_ 1. Do not generate
1_ 1. Do not generate
2. Generate, write to file
2. Generate, write to file
3. Generate, autoload to database
3. Generate, autoload to
database
Action to take when write to database fails:
1_ 1. Issue warning and continue processing
2. Issue warning, write XML to file, and continue processing
3. Issue error and stop processing
Maximum number of characters (in 10,000s) to write to database:
Pass alternate job ID: N (Y/N)
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

ACR/Summary User Guide for z/OS

____

129

4  Setting the User Options
User Options Detailed Descriptions

Control report. Options are as follows
1. Do not generate. Do not generate the report in XML format.
2. Generate, write copy 1 to file. Create a copy of the control report copy 1

in XML format and write to the file specified.
3. Generate, autoload copy 1 to database. Create a copy of the control

report copy 1 in XML format and write to the associated database. The
fail option and maximum size specified on this panel will apply.
4. Generate, write copy 2 to file. Create a copy of the control report copy 2

in XML format and write to the file specified.
5. Generate, autoload copy 2 to database. Create a copy of the control

report copy 2 in XML format and write to the associated database. The
fail option and maximum size specified on this panel will apply.
User report. Options are as follows
1. Do not generate. Do not generate the report in XML format.
2. Generate, write to file. Create a copy of the report in XML format and

write to the file specified.
3. Generate, autoload to database. Create a copy of the report in XML

format and write to the associated database. The fail option and
maximum size specified on this panel will apply.
Freeform report. Options are as follows
1. Do not generate. Do not generate the report in XML format.
2. Generate, write to file. Create a copy of the report in XML format and

write to the file specified.
3. Generate, autoload to database. Create a copy of the report in XML

format and write to the associated database. The fail option and
maximum size specified on this panel will apply.
Action to take when write to database fails. Options are as follows:
1. Issue warning and continue processing. The job will complete but the

report will not be generated in XML format.
2. Issue warning, write XML to file, and continue processing. The report

will be written to a file in XML format.
3. Issue error and stop processing. The job sets an error-level step

completion code.
Maximum number of characters (in 10,000s) to write to
database.
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Specify the maximum number of characters of XML formatted data that
should be written to the XML database for each report. This field applies
only if you are writing the XML to a database. XML formatted reports that
exceed this limit will follow the error handling option specified in the
Action to take when write to database fails field on this panel.
The maximum number is specified in increments of 10,000 characters.
Valid values are as follows:

 Blank or 0000. Use the default of 50, which represents 500,000
characters.

 0001 through 1677. Represents 10,000 to 16,777,000 characters.
Pass alternate job ID. It is an option to pass the alternate job ID to the
XML if the running job is an alternate job.
Y. Yes, to pass the alternate job ID.
N. No, to not pass the standard job ID.

Infogix Assure Information
If you selected Infogix Assure Information from the User Options panel, the
Infogix Assure Information panel will display. This panel allows you to
specify the details to connect to the Infogix Assure server. This is an
optional feature in ACR/Summary to retrieve historical data from Infogix
Assure. You must enter all the connection parameters, to ensure a secure
connection to the Infogix Assure server.
Infogix Assure Information
URL:
http://acr2012:8080________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
User ID:
admin______________________________________________________________
Password:
admin______________________________________________________________
Time zone:
America/Chicago____________________________________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

URL. Enter the URL of Infogix Assure server in the following format:
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http://<hostname>:<portnumber>/
Where, <hostname> and <portnumber> are the name of the host, and the
port number of Infogix Assure server.
If there are multiple Infogix Assure instances running on the same port
using multiple context root, enter the name of the context root whose
history you wish to retrieve explicitly in the URL as shown below:
http://<hostname>:<portnumber>/<solution.context.root.api>/
User ID. Enter the user ID to connect to Infogix Assure server.
Password. Enter the password to connect to Infogix Assure server.
Time zone. Enter the time zone of the Infogix Assure server.
Example: If the Infogix Assure sever is running on US Central Time, the
time zone must be America/Chicago.
The list of valid time zones are listed in the below link:
http://en.wikipedia.org/wiki/List_of_tz_database_time_zones

Email Notification
Email notification is only allowed in batch balancing/reconciliation mode.
When email notification is turned on, the rule highest return code is used
to check against all the messages setup for the job. Multiple messages may
be setup for the same return code. Instead of sending an email for each
message, the return code messages and report attachments for each email
recipient are consolidated. As a result, each email recipient will receive one
email.
For each email recipient, the balancing/reconciliation job builds the JCL
to send email and report attachments according to the report switches
specified for the messages. The send-mail JCLs are then held in the JES
Internal Reader and it will be submitted automatically as soon as the
balancing/reconciliation job is completed. If the job sends email to N
recipients, a total of N send-mail jobs will be run and the users will be
notified with N job completion messages on MVS. All the send-mail jobs
will have the same job name as entered in the User Options File.
The following reports can be attached for each email. All attachments are
required to be sent in VBA format.
User Report and Freeform Report are already in VBA format and they are
attached to the email as is. For others which are in FBA format (SYSOUT,
UNIACR, UNIACR2, UNIACR3, UNIACR4, UNIRCR), they are converted
to VBA format with LRECL 137 before they are attached to the email.
 SYSOUT
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Control Report
Recap Report
User Report
Freeform Report

To build the send-mail JCL, the following information is required to be
entered in the MAILINFO/JOBCARD1/JOBCARD2 records in the User Options
File:
 Name of the Communications Server Simple Mail Transfer Protocol
(CSSMTP)

 Class assigned to the Communications Server Simple Mail Transfer
Protocol (CSSMTP)







DASD unit type
Primary space required for allocating each report
Secondary space required for allocating each report
First job statement of the send-mail JCL
Second job statement of the send-mail JCL

In addition, a master switch to turn on/off email notification is added to
the User Options File.
Email notification processing requires a bigger amount of memory to run
the job, increase the region size as needed.
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Automatic Rerun
When a job is using automatic cycle processing (see “Completing the Cycle
Processing Options Panel” on page 629) the automatic rerun option should
be used to provide automatic tracking of the last run of the job. The
automatic rerun option allows you to rerun a job without making changes
to the balancing job’s JCL.
Automatic rerun is not available if you are using cycle processing with the
J0, J9, or G9 options, which allow only one cycle per calendar day.

Setting Up Automatic Rerun
Automatic rerun is set up as follows:
1. At the system level, set the automatic rerun user option in either of the

following ways:

 Set the Automatically rerun balancing steps? field on the User
Options panel.

 Set the Automatic Rerun Option field in UNIXOPT (see “UNIXOPT
Record Layout” on page 151).
2. At the job level, set the automatic rerun option on the Rerun/Audit

Trail Options panel in Basic Job Information when you set up the job.
Note:

For more on step 1 and step 2 above, see Setting the System
Level and Job Level Options for Automatic Rerun on page 135.

3. Edit the JCL to add the execution of program UACARUN before

running the balancing step. UACARUN tracks the execution of the
balancing steps and automatically treats each balancing step as a rerun
if the job stream is rerun and the UACARUN step is bypassed.
Here is an example of the required JCL edit:
//STEP0 EXEC PGM=UACARUN
For detailed information on creating and editing JCL, see “Running
Balancing Jobs and Other JCL in Batch” on page 369.
The UACARUN program can accept two parameters as follows:

 A job name parameter, JNAM. Use this if you want to override the
job name from the JOB statement. If used, the JNAM parameter
must be first.

 A rerun parameter (which can be any word beginning with R, for
example, RERUN, R, or RESTART) specifying a rerun.
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Symbolic parameters are allowed if the UACARUN step is being
executed within a JCL procedure. Examples using the two parameters
are shown below:
//STEP0 EXEC PGM=UACARUN,PARM='R'
//STEP0 EXEC PGM=UACARUN,PARM='RERUN'
//STEP0 EXEC PGM=UACARUN,PARM='&RST'
//STEP0 EXEC PGM=UACARUN,PARM='JNAM=J2801 '
//STEP0 EXEC PGM=UACARUN,PARM='JNAM=P5000D,R'
4. Optionally include a UNIDF DD statement in the UACARUN step just
below the EXEC statement. For example:
//UNIDF DD DSN=USERID.SUM.DEFN,DISP=SHR

This causes UACARUN to check the definition database for a Job ID
that corresponds to the JOB statement.
When a Job ID cannot be found, the automatic rerun is not invoked.
The omission of the UNIDF DD bypasses this check. This check allows
you to create a standard set of JCL that can be included in all of your
recovery/restart JCL.

Setting the System Level and Job Level Options for Automatic
Rerun
This section provides further information for step 1 and step 2 in the
previous section, "Setting Up Automatic Rerun."
Usually, you will use one of the following combinations:

 Set the automatic rerun user option to Y and turn it off for jobs not
needing it at the job level by setting Select an automatic rerun
option on the Rerun/Audit Trail Options panel to 3 (Disable rerun for
this step regardless of system level)

 Set the automatic rerun user option to N and turn it on for jobs needing
it at the job level by setting Select an automatic rerun option on
the Rerun/Audit Trail Options panel to 2 (Invoke rerun only if system
level is not set to do so).
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The following table summarizes possible combinations of options that you
can choose for step 1 and step 2 and their results.
Balancing Step Level

System (User Options) Level: Setting
for Automatically rerun balancing steps

Balancing Step Level: Setting
for Select an automatic rerun
option on Rerun/Audit Trail
Options panel

Y

N

1. Use system default

Auto rerun in effect

Auto rerun not in
effect

2. Invoke rerun only if system
level is not set to do so.

Auto rerun not in
effect

Auto rerun in effect

3. Disable rerun for this step
regardless of the system level
setting.

Auto rerun not in
effect

Auto rerun not in
effect

Bypassing UACARUN: Rerunning a Job
When you want to do a rerun, you have to bypass the UACARUN JCL step.
You can do this in any of the following ways:

 Use a job RESTART parameter to specify that the job should be
restarted in a step following the UACARUN step.

 Supply a COND parameter on the UACARUN EXEC statement, and
then pass a condition code from an automatic job restart facility that
will cause the UACARUN step to be bypassed.

 Supply a PARM on the UACARUN EXEC statement indicating that a
rerun is in process.
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Dual History
When ACR/Summary stores history records, they are written to one
database, the (primary) history database. The dual history option also
writes history to a secondary history database whenever it writes to the
primary history database. The secondary history database should be
allocated on a separate DASD volume. This allows rapid recovery after a
DASD failure.
To specify this option via the interface, do the following:
1. Enter Y for the dual history option on the User Options panel or set the

option manually in the UNIXOPT record (see “UNIXOPT Record
Layout” on page 151).
2. Specify the name of your user options file in your JCL or in the

UNIUOPT user exit, described in “User Options File (UNIUOPT) User
Exit” on page 667.
3. Use the database initialization JCL stream (UACINIT) to initialize a

secondary history database. We recommend that you give the dual
history database the same DDNAME as the primary database, but add
a 2 as a suffix. For example, if your primary history database is
UNIUHF, the secondary history database should be UNIHF2.
Be sure to allocate the secondary history database to a different DASD
volume.
4. Use the Copy History utility to copy the primary history database to the

secondary history database whenever you wish to synchronize the two
databases.
5. Do one of the following:

 Give the dataset name of the secondary history database name to
each ACR step by adding a DD statement, For example:
//UNIHF2 DD DSN=UAC.UNIHF2,DISP=SHR

 Dynamically allocate the secondary history database. See “Dynamic
Allocation of Files” on page 118.
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Store All Reruns
The store all reruns option lets you create a rerun audit trail by maintaining
history records for all of the reruns for a job in the history database. These
records contain the control values used and the balancing results. As
successive reruns are performed, they are stored as history records linked
together to expand the audit trail.
The List History utility may be used to retrieve the rerun audit trail
information from the history database.

Setting Up Store All Reruns
Set up this feature as follows:
1. At the system level, set the user option in one of the following ways:

 Set the Store all reruns of balancing steps? option on the User
Options panel.

 Set the Rerun History Audit trail Indicator field in the UNIXOPT
record (see “UNIXOPT Record Layout” on page 151).
2. At the job level, set the Select an audit trail option field on the Rerun/

Audit Trail Options panel in Basic Job Information when you set up
the job.
The next section provides further information for these steps.

Setting the System Level and Job Level Options for Store all
Reruns
This section provides further information for the previous section, "Setting
Up Store All Reruns."
Usually, you will use one of the following combinations:

 Set Store all reruns of balancing steps (in UNIXOPT, this is the Rerun
History Audit Trail Indicator) in the user options to Y and turn it off for
jobs not needing it at the job level by setting Select an audit trail
option on the Rerun/Audit Trail Options panel to 3 (Disable audit trail
regardless of system level).

 Set Store all reruns of balancing steps in the user options to N and turn
it on for jobs needing it at the job level by setting Select an audit trail
option on the Rerun/Audit Trail Options panel to 2 (Invoke audit trail
only if system level is not set to do so).
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The following table summarizes possible combinations of options that you
can choose and their results.

Balancing Step Level

User Options Level: Setting
for Store all reruns of
balancing steps? on the
User Options panel

Balancing Step Level: Setting for Select an
audit trail option field on the Rerun/Audit
Trail Options panel

Y

N

1. Use the system default

Store all
reruns in
effect

Store all
reruns not in
effect

2. Invoke audit trail only if system level is not
set to do so

Store all
reruns not in
effect

Store all
reruns in
effect

3. Disable audit trail regardless of system
level

Store all
reruns not in
effect

Store all
reruns not in
effect

Allow Insert of History Records
Use this option to enable you to add records to the database with cycle
numbers lower than those of the records already stored there. This kind of
insert is normally prohibited.
You might need to do this, for example, if a daily balancing job doesn’t run
and the omission isn’t caught until the next day’s job has already run and
updated the history database.
Enabling this feature requires the following steps:
1. Set the user option in either of the following ways:

 Set the Allow insert of history records? option on the User Options
panel to Y.

 Set the History Inserts field in the UNIXOPT record (see
“UNIXOPT Record Layout” on page 151) to Y.
2. Create an options file. See “Using an Options File (UNIOF)” on

page 633
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Automatically Compress Definition Library
Set this option to N to turn off the default setting that automatically
compresses the definition library whenever you bring up the Save panel.
Compression saves valuable mainframe resources, ACR/Summary
automatically compresses the definition library whenever you bring up the
Save Panel.
You may want to turn it off automatic compression if compressing the
library whenever you save takes a significant amount of time.
This option is not stored in the user options file. You can only choose it on
the User Options panel.

Always Prompt Before Product Exit
Set this option to N to turn off the default setting that prompts you to
confirm that you want to exit ACR/Summary when you press F3 from the
Job Window or choose File > Exit.
If you do this, you will still be prompted to save any changes before you exit.
To re-enable the prompt, choose Y.
This option is not stored in the user options file. You can only choose it on
the User Options panel.

Print Commas in Count Fields
Set this option to N to turn off the default setting that prints the thousands
place indicator (the default character is a comma) in count fields on the
Control Report, User Report, and Free-form Report.
You can specify this option through the User Options panel or by changing
the setting for the Print Commas for Counts field in the UNIXOPT record
(see “UNIXOPT Record Layout” on page 151).

Print Commas in Amount Fields
Set this option to N to turn off the default setting that prints the thousands
place indicator (the default character is a comma) in amount fields on the
Control Report, User Report, and Free-form Report.
You can specify this option through the User Options panel or by changing
the setting for the Print Commas for Amounts field in the UNIXOPT record
(see “UNIXOPT Record Layout” on page 151).
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22-Character Numeric Formatting
Set this option to Y to format counts and amounts on the Control Report,
User Report, and Free-Form Report using 22-character formatting. (The
default is 18-character formatting.) This enables proper alignment of
longer numbers, including a currency symbol, commas, decimal point,
sign, and up to 15 digits.
You can specify this option through the User Options panel or by changing
the setting for the 22-Character Numeric Formatting field in the UNIXOPT
record (see “UNIXOPT Record Layout” on page 151).

Editing the User Options File
The easiest way to set user options is through the User Options panel (see
“User Options Panel” on page 116). After you have created the records you
need by selecting the options you want from the User Options panel, you
can view and edit the records directly by selecting Edit > Edit JCL or Run
> Edit/Submit JCL.
You can also simply open the user options file and create the record types
you need. You can create up to five types of records in the user options file:
UNIXOPT. Most user options are specified on this record. If you don’t
create this record, ACR/Summary system-wide defaults are automatically
applied. You can create only one UNIXOPT record within the user options
file. See the section entitled “UNIXOPT Record Layout” on page 151 for
information on the options available on the UNIXOPT record, the record’s
layout, and a list of valid values for each field.
UNIEXEO. You can shut down ACR/Summary processing by setting an
option on this record. You can also override step completion code options
for ACR/Summary jobs. You can create only one UNIEXEO record within
the user options file. See the section entitled “UNIEXEO Record Layout” on
page 150 for information on the options available on the UNIEXEO record,
the record’s layout, and a list of valid values for each field.
UNIDSN. You can dynamically allocate VSAM and physical sequential
files used in ACR/Summary processing by setting up one or more UNIDSN
records. You need to create one UNIDSN record for each VSAM or physical
sequential file you want to dynamically allocate. For example, you might
want to dynamically allocate the ACR/Summary definition and history
databases, which are VSAM files. In this case, you would need to set up one
UNIDSN record for the definition database and one for the history
database. See “UNIDSN, UNIPDS, and UNIOUT Record Layouts” on
page 144.
ACR/Summary User Guide for z/OS

141

4  Setting the User Options
Editing the User Options File

UNIPDS. You can dynamically allocate files that you balance with
ACR/Summary by setting up one or more UNIPDS records. You need to
create one UNIPDS record for each input file you want to dynamically
allocate. See “UNIDSN, UNIPDS, and UNIOUT Record Layouts” on
page 144.
UNIOUT. You can dynamically allocate output reports produced by
ACR/Summary by setting up one or more UNIOUT records. You need to
create one UNIOUT record for each output report you want to dynamically
allocate. For example, you might want to dynamically allocate the ACR/
Summary Control Report and Recap Report. In this case, you would need
to set up one UNIOUT record for the Control Report and one for the Recap
Report. See “UNIDSN, UNIPDS, and UNIOUT Record Layouts” on
page 144.
CAURL1 - CAURL4, CAUSERID, CAPASSWD, CATMZONE. You
can specify the Infogix Assure connection details using these record
layouts. See “CAURL1, CAURL2, CAURL3 and CAURL4 Record Layouts”
on page 146 and “CAUSERID, CAPASSWD, and CATMZONE Record
Layouts” on page 148.
Following is a procedure for opening the user options file to create and edit
record. (You can also create and edit records in the user options file by
using your site’s text editing facility.)
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On the ACR/Summary Job Window, select Edit > Edit JCL to display the
Files and Submit Jobs panel.
File Edit Confirm Menu Utilities Compilers Test Help
------------------------------------------------------------------------------EDIT
USERIDA.SUM.USEROPT
Columns 00001 00072
Command ===>
Scroll ===> PAGE
****** ***************************** Top of Data ******************************
000001 UNIDSN
UNIDF
UNIV.TEST28.UNIDF
000002 UNIOUT
UNIACR
*AWRITER23
000003 UNIPDS
MREPORT
CUST.RPTS
CURRENT
000004 UNIXOPT
NNY.
141CR
242YMDY/YY N
000005 UNIEXEO
1XXX
000003 CAURL1
http://assureserver:8080
000004 CAURL2
000005 CAURL3
000006 CAURL4
000007 CAUSERID userid
000008 CAPASSWD password
000009 CATMZONE America/Chicago
****** **************************** Bottom of Data ****************************

F1=Help
F8=Down

F2=Split
F9=Swap

Note:

F3=Exit
F10=Left

F5=Rfind
F11=Right

F6=Rchange
F12=Cancel

F7=Up

The file above includes a sample of each type of record you can
create in the user options file. If you specified user options through
the interface, or if you already created records directly in the file,
your file will contain one or more of the record types shown above.
However, the options specified on the records will probably be
different. If you have not specified user options, your file will be
empty. CAURL2-CAURL4 records are optional. They may be
removed from the file if the URL information is blank.

Dataset name. Enter the name of the user options file you want to edit
(usually XXXXXXX.USEROPT). For example, you might enter
USERIDA.SUM.USEROPT.
Press F5 to display the user options file. See the sections that follow for
descriptions and record layouts of each type of record you can create/edit
in the user options file:

 “UNIDSN, UNIPDS, and UNIOUT Record Layouts” on page 144
 “UNIEXEO Record Layout” on page 150
 “UNIXOPT Record Layout” on page 151

ACR/Summary User Guide for z/OS

143

4  Setting the User Options
Editing the User Options File

 “CAURL1, CAURL2, CAURL3 and CAURL4 Record Layouts” on
page 146

 “CAUSERID, CAPASSWD, and CATMZONE Record Layouts” on
page 148

UNIDSN, UNIPDS, and UNIOUT Record Layouts
To directly specify dynamic file allocation options in the user options file,
you need to create one or more records that conform to the record layouts
shown in the record layouts below. The Description column shows the type
of information to enter in each field. The Values column shows what you
need to enter.
The type(s) of record(s) you need to create depend on the types of files you
want to dynamically allocate:

 For each VSAM file or sequential dataset to be dynamically allocated,
such as the history database or the definition database, create a
UNIDSN record. See "UNIDSN (VSAM File or Sequential Dataset)
Record Layout" below.

 For each partitioned dataset, such as each input file balanced by your
job, create a UNIPDS record. See “UNIPDS (Partitioned Dataset)
Record Layout” on page 145.

 For each output report or file, such as the Control Report, create a
UNIOUT record. See “UNIOUT (Output Report or File) Record Layout”
on page 146.
After the layouts, samples of each type of record are shown. See “Samples
of Dynamic Allocation Records” on page 148.

UNIDSN (VSAM File or Sequential Dataset) Record Layout
VSAM and Sequential Datasets
Field#

Description

Position

Length

Format

Values

1

Type

1-10

10

X(10)

UNIDSN

2

DDNAME

11-18

8

X(8)

3

Reserved

19-20

2

X(2)

41

Dataset
Name

21-64

44

X(44)

5

Reserved

65-80

16

X(16)

Blanks

Blanks

1. Dataset Name must be fully qualified without quotes.
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UNIPDS (Partitioned Dataset) Record Layout
Partitioned Datasets
Field#

Description

Position

Length

Format

Values

1

Type

1-10

10

X(10)

UNIPDS

2

DDNAME

11-18

8

X(8)

3

Reserved

19-20

2

X(2)

41

Dataset
Name

21-64

44

X(44)

5

Reserved

65

1

X(1)

6

Member
Name

66-73

8

X(8)

7

Reserved

74-80

7

X(7)

Blanks

Blank

Blanks

1. Dataset Name must be fully qualified without quotes.
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UNIOUT (Output Report or File) Record Layout
SYSOUT Datasets
Field1

Description

Position

Length

Format

Values

1

Type

1-10

10

X(10)

UNIOUT

2

DDNAME

11-18

8

X(8)

3

Reserved

19-20

2

X(2)

4

Reserved

21

1

X(1)

5

Sysout Class

22

1

X(1)

6

Writer Name

23-30

8

X(8)

7

Reserved

31-80

50

X(50)

Blanks

Blanks

1. Placing an asterisk (*) in column 1 of any record causes it to be treated as a comment.

CAURL1, CAURL2, CAURL3 and CAURL4 Record Layouts
To directly specify the Infogix Assure server URL in the user options file,
you need to have CAURL1-CAURL4 (280 characters) records that conform
to the record layouts shown below. If history is retrieved form Infogix
Assure, CAURL1 is mandatory. CAURL2-CAURL4 are optional.
For example, if the length of the URL is 100 characters, CAURL1-CAURL2
record layouts are necessary.

CAURL1 Record Layout
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAURL1.

2

URL

11-80

70

X(70)

Position 1-70 of
the Infogix
Assure URL.
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CAURL2 Record Layout
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAURL2.

2

URL

11-80

70

X(70)

Position 71-140
of the Infogix
Assure URL.

CAURL3 Record Layout
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAURL3.

2

URL

11-80

70

X(70)

Position 141210 of the
Infogix Assure
server URL.

CAURL4 Record Layout
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAURL4.

2

URL

11-80

70

X(70)

Position 211 280 of the
Infogix Assure
server URL.
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CAUSERID, CAPASSWD, and CATMZONE Record Layouts
CAUSERID Record Layout
To directly specify the Infogix Assure server user ID (for Infogix Assure
history retrieval) in the user options file, you need to have a CAUSERID
record that conforms to the record layout shown below. This record is
mandatory if history is retrieved from Infogix Assure.
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAUSERID

2

User ID

11-80

70

X(70)

Infogix Assure
server User ID

CAPASSWD Record Layout
To directly specify the Infogix Assure server password (for Infogix Assure
history retrieval) in the user options file, you need to have a CAPASSWD
record that conforms to the record layout shown below. This record is
mandatory if history is retrieved from Infogix Assure.
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CAUSERID

2

Password

11-80

70

X(70)

Infogix Assure
server User
password.

CATMZONE Record Layout
To directly specify and store the Infogix Assure server time zone to retrieve
history in the user options file, you need to have a CATMZONE record that
conforms to the record layout shown below. This record layout is optional.
Field#

Description

Pos.

Length

Format

Value

1

Type

1-10

10

X(10)

CATMZONE

2

Time Zone

11-70

60

X(60)

Time Zone

Samples of Dynamic Allocation Records
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Begins in Col. 1

Begins in Col.11

Begins in Col. 21

UNIDSN

UNIDF

UNIV.TEST28.UNIDF

UNIDSN

UNIHF

UNIV.TEST28.UNIHF

UNIDSN

UNIHF2

UNIV.TEST28.UNIHF
2

UNIPDS

MREPORT

CUST.RPTS

UNIOUT

UNIACR

**WRITER23

UNIOUT

UNIRCR

**
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UNIEXEO Record Layout
To directly specify global processing options in the user options file, you
need to create a UNIEXEO record that conforms to the record layout shown
below.
Note:

In program interface mode, the only global processing options you can
specify are ACR/Summary shut-off and setting a zero return code. The
zero return code is simply passed back to the calling program in this
case, since ACR/Summary can’t actually “set” a return code in program
interface mode. For more information, see Balancing in Program
Interface Mode on page 403.

File Interface Mode
Field#

Description

Pos.

Length

Format

Value

File Interface
1

Type of user options card

1

10

X(10)

UNIEXEO

2

Master on/off switch to shut
of or turn on ACR/S
balancing.

11

1

X(1)

blank=on
(default), 1=on
(default), 0=off

31

Override any jobs that
normally set a zero
completion code

12

1

X(1)

blank, Y, N, X

42

Override any jobs that
normally set a completion
code

13

1

X(1)

blank, Y, N, X

53

Override any jobs that
normally force a z/OS user
abend

14

1

X(1)

blank, X, N, Y

6

Reserved

15

66

X(66)

Blanks

1 - blank = no override necessary (default), N = no override necessary, Y = override to set
completion code, X = override to force a z/OS user abend.
2 - blank = no override necessary (default), N = override to set zero completion code, Y = no
override necessary, X = override to force a z/OS user abend.
3 - blank = no override necessary (default), N = override to set zero completion code, Y =
override to set completion code, X = no override necessary

150

Infogix, Inc.

Setting the User Options  4
Editing the User Options File

Program Interface Mode
Program Interface
1

Type of user options card

1

10

X(10)

UNIEXEO

2

Master on/off switch to shut
off/
turn on balancing

11

1

X(1)

blank=on
(default), 1=on,
(default), 0=off

3

Set unconditional zero ACR
return code after balancing

12

3

X(3)

NNN

4

Reserved

15

66

X(66)

Blanks

UNIXOPT Record Layout
The UNIXOPT record, typically created during setup, needs to conform to
the record layout shown below.
Field

Description

Position

Length

Format

Value

1

Type

1-10

10

X(10)

UNIXOPT

2

Dual History Option

11

1

X(1)

Y, N, blank

31

Automatic Rerun Option

12

1

X(1)

Y, N, blank

42

Currency Information
Provided

13

1

X(1)

Y, N, blank = N

5

Thousands Place Marker

14

1

X(1)

6

Decimal Place Marker

15

1

X(1)

7

Currency Symbol

16-21

6

X(6)

8

Second Currency
Symbol

22-27

6

X(6)

9

Currency Padding
Length

28

1

9(1)

0-8

10

Currency Symbol
Location

29

1

9(1)

2,4,6 (front, back,
both)

11

Currency Symbol Length

30

1

9(1)

1-6

12

Negative Sign

31-36

6

X(6)
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Field

Description

Position

Length

Format

13

Second Negative Sign

37-42

6

X(6)

14

Negative Sign Padding
Length

43

1

9(1)

0-8

15

Negative Sign Location

44

1

9(1)

2,4,6 (front, back,
both)

16

Negative Sign Length

45

1

9(1)

1-6

173

Date Information
Provided

46

1

X(1)

Y, N, blank=N

18

Date Output Format

47-49

3

X(3)

YMD, MDY, etc.

19

Date Separator

50

1

X(1)

20

Date Zero Suppress
Indicator

51

1

X(1)

Y, N

21

Century Indicator

52

1

X(1)

Y, N

22

WTO Message Option

53

1

X(1)

Y, N, blank

23

History Inserts

54

1

X(1)

Y, N, blank

24

Print Commas for
Counts

55

1

X(1)

Y, N, blank=Y

25

Print Commas for
Amounts

56

1

X(1)

Y, N, blank=Y

26

22-Character Numeric
Formatting

57

1

X(1)

Y, N, blank=N

27

Reserved (used by ACR/
Detail only)

58

1

X(1)

Blanks

284

Control Report XML
Option

59

1

X(1)

1 or blank, 2, 3, 4, 5

295

User Report XML Option

60

1

X(1)

1 or blank, 2, 3

306

XML DB Fail Option

61

1

X(1)

1 or blank, 2, 3

317

XML DB Message Size
(in 10,000s)

62-65

4

X(4)

Blank, 0000 through
1677

328

Free-Form Report XML
Option

66

1

X(1)

1 or blank, 2, 3

33

Time Separator

67-67

1

X(1)
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Field

Description

Position

Length

Format

Value

3411

Time Output Format

68-68

1

X(1)

1, 2, 3 or Blank

3512

Time Output Notation

69-69

1

X(1)

1, 2 or Blank

369

Job Name for Global
Messages

70-77

8

X(8)

3710

Rerun History Audit trail
Indicator

78

1

X(1)

Y, N, blank

38

Send Alternate Job ID

79-79

1

X(1)

Y, N, Blank

39

Reserved

80-80

1

X(1)

Blank

1 Automatic Rerun Option:
Y = Use automatic rerun, system-wide, except if job level is set to 2 (Invoke rerun only if system level is
not set to do so).
N = Do not use automatic rerun, system-wide, except if job level is set to 2 (Invoke rerun only if
system level is not set to do so).
Blank = Use the balancing-step-level specification.
2 Currency Information Provided: Enter Y if you plan to specify any currency options in fields 5–11.
3 Date Information Provided: Enter Y if you plan to specify any date options in fields 18–21.
4 Control Report XML Option
1 or blank - Do not generate the report in XML format, 2 - Generate, write copy 1 to file, 3 - Generate,
autoload copy 1 to database, 4 - Generate, write copy 2 to file, 5 - Generate, autoload copy 2 to database
5 User Report XML Option:
1 or blank - Do not generate the report in XML format, 2 - Generate, write to file, 3 - Generate, autoload to
database
6 XML DB Fail Option:
1 or blank - display warning and continue, 2 - Display warning message, write message to file and continue,
3 - Display error and stop
7 XML DB Message Size - Maximum size for writing the XML to a database (in increments of 10,000
characters.
0000 or blank - use the default of 50 (500,000 characters)
0001 through 1677 - 10,000 to 16,777,000 characters
8 Free-Form Report XML Option:
1 or blank - Do not generate the report in XML format, 2 - Generate, write to file,
3 - Generate, autoload to database
9 Job Name for Global Messages: If you set up an ACR/Summary job containing global messages,
enter the job’s eight-character job name in this field. Leave the step name and qualifier blank.
10 Rerun History Audit trail Indicator:
Y =Use rerun history audit trail, system-wide, N =Do not use rerun history audit trail, system-wide
Blank = Use the job-definition-level specification.
11 Time Output Formats: 1- HH:MM 2 or blank - HH:MM:SS 3 - HH:MM:SS.NN
12 Time Output Notations: 1- 12-hour format (AM or PM will be printed) 2 or blank – 24-hour format
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5
Entering Basic Job Information
This chapter provides a general procedure for creating balancing jobs and
detailed instructions for defining the basic job information.
These instructions assume you are creating your job definitions through the
user interface using file interface mode (the typical mode) or direct input
mode. For more information on interface modes, see “Application Interface
Modes” on page 14.
Both the basic job information and the report options described here can be
accessed through the Job Window.
This chapter contains the following sections:














“Balancing Jobs” on page 155
“Definitions and Definition Types” on page 156
“ACR/Summary Job Flow” on page 157
“Defining the Basic Job Information” on page 158
“Getting Started with Job Information” on page 159
“Setting the Job Run Options” on page 161
“Using the Cycle Processing Options” on page 167
“Specifying an Alternate Job ID” on page 167
“Using the Rerun/Audit Trail Options” on page 168
“Setting the Extract File Options” on page 170
“Adding Job or File Comments” on page 177
“Specifying Report Options” on page 179

After completing the basic job information, you will need to refer to the
following chapters, at a minimum, in order to finish defining the job:

 Chapter 6, “Creating Job Definitions”
 Chapter 7, “Creating File Definitions”

Balancing Jobs
A balancing job (also called a balancing step) invokes the balancing
function, which automatically compares and evaluates information
extracted from the files that drive your batch processes in order to detect
content and process errors. This is the basic purposes of ACR/Summary.
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Each job must be supplied with the following:

 An ACR/Summary job ID. This identifies a set of job definitions (audit
and control requirements) that you create to be used in balancing.

 A cycle ID. This is an 8-digit cycle number and a 3-digit run number
that together uniquely identify the application processing cycle that is
to be verified. Cycle numbers are usually based on system dates, but any
ascending number may be used.

Definitions and Definition Types
A balancing job is set up by defining a set of parameters called definitions.
Definitions for balancing jobs contain the information needed to locate the
records you want, format and extract the desired values, perform the
calculations and balancing comparisons, and report the results.
Definitions for history analysis jobs, which are run separately from
balancing jobs, enable you to analyze the results of previous balancing runs.
The types of definitions used in ACR/Summary are as follows:

 Job definitions. These control the balancing process and specify how
to balance the extracted and accumulated values. Job definitions also
indicate which file definitions to use.

 File definitions. These are used by balancing jobs. They specify how
to locate, extract, and accumulate the desired values to be used in
balancing from a particular input file.

 Table definitions. These include the following:
 Definitions for translation tables used to translate values in the
input file to other values or formats.

 Definitions for cycle tables used in balancing or in history analysis
to verify whether the cycle number being processed is valid.

 History analysis definitions. These specify the results from
previous job runs that are to be retrieved from the history database,
analyzed, and presented in an easy-to-read report format.
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ACR/Summary Job Flow
Following is a brief description of how a simple balancing job in the typical
file interface mode is set up and tested.
1. Follow the instructions in “Analyzing Your Balancing Needs” on

page 50.
2. Follow the instructions in “Help Panels” on page 24.
3. Specify the basic job information as described in “Defining the Basic

Job Information” on page 158 and the following sections of this
chapter.
4. Define your input sources. These are the files and other input source

types from which data will be extracted to be used in balancing.
Supported input source types include report files, sequential files,
VSAM files, DB2 tables, and datasets that reside on the JES spool.
When you define an input source, you also create the file definitions
that specify how the records will be located and what data will to be
extracted. For instructions, see “Creating File Definitions” on page 261.
5. Define the internal items, extended internal items, calculated items,

rules, and messages.

 Internal, and extended internal items are used to store extracted
values.

 History items specify retrieval of values from a previous run of the
same job or another specified job from the history database.

 Calculated items specify mathematical manipulation of values from
internal (or extended internal) items, history items, other
calculated items, literals (numeric constants), or functions.
Values from internal and extended internal items, history items, and
calculated items can then be used in balancing rules. Rules compare
the extracted values and evaluate the results. The results can
themselves be tested and evaluated to execute still other rules. The
combination of all rule results determines whether the job is in or out
of balance. If a rule is out of balance, it can set a return code, issue a
message, and/or even stop processing. Rules and other job definitions
used in conjunction with rules are explained in “Creating Job
Definitions” on page 193.
6. Test the job and file definitions online as described in “Testing and

Running Jobs Online” on page 359
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7. Run the job. The balancing job applies all of your job definitions and

any associated table definitions to your file definitions and determines
if your balancing needs have been met. To run in batch, see “Running
Balancing Jobs and Other JCL in Batch” on page 369.
8. View the reports. The reports that you can receive at the end of the job

include:
“Control Report (Copy1 or Copy2)” on page 180
“Free-Form Report” on page 192
“User Report” on page 192
“Recap Report” on page 189
“Trace Report” on page 390
9. If your reports show that the job is not in balance, see “What To Do If

You Get Unexpected Results” on page 368.
10. Migrate into production. This step involves moving the definitions you

have set up into the production database and setting up the production
JCL for the application programs.
11. Operate and monitor. This step involves processing the job according

to the production schedule, and then producing, distributing, and
reviewing the balancing reports. Any out-of-balance situation should
be reviewed and the indicated actions (including possible reruns)
should be taken to ensure correct application processing.

Defining the Basic Job Information
This section explains how to define the following types of basic job
information:

 “Getting Started with Job Information” on page 159
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“Setting the Job Run Options” on page 161
“Using the Cycle Processing Options” on page 167
“Specifying an Alternate Job ID” on page 167
“Using the Rerun/Audit Trail Options” on page 168
“Setting the Extract File Options” on page 170
“Adding Job or File Comments” on page 177
“Specifying Report Options” on page 179
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Getting Started with Job Information
From the Job Window, select Job Information to display the Job
Information panel.
Job Information
Enter a job ID:
Job name: ________
Step name: ________
Qualifier: __
Last update by:

Date:

Time:

Enter control report title:
________________________________________
Select options to access:
_ Job run options...
_ Cycle processing options...
_ Alternate job ID information...
_ Rerun/audit trail options...
_ Extract file options...
_ Display/change comments...
F1=Help
F2=Split
F3=Exit
F5=Accept

F9=Swap

Complete the fields as follows:
Enter a job ID. Each balancing job is identified by a job ID. The Job ID is
made up of 3 parts, the job name, step name, and qualifier, as follows:
Job name. This must start with a letter and be a valid JCL name. If you do
not use an alternate job ID or a JCL parm, the name on the job card is the
one that will be used to find definitions on the database.
Step name. The name should meet your site’s standards for naming steps.
Qualifier. Typically set to blanks. Complete if you want to create a job/
step/qualifier (JSQ), as explained below.
What is a Job/Step/Qualifier (JSQ)?
The JSQ feature enables multiple invocations of the balancing function
with the same job name/step name. The base job (the job that will run first)
is created with a job name and step name and no entry in the Qualifier
field. Each JSQ is assigned the same job name and step name. In the
Qualifier field, you enter a unique qualifier to indicate the sequence in
which the JSQs should run. Use 00, 01, etc., or alpha values such as AA, A1,
etc. When you run the base job, after it completes, each JSQ having the
same job name/step name is run in ascending order. Within any given JSQ,
the items from other JSQs can be referenced as history items, if needed.

ACR/Summary User Guide for z/OS

159

5  Entering Basic Job Information
Getting Started with Job Information

JSQ Purpose
JSQs are useful in the following situations:

 A single job needs to have more than 100 internal items, extended
internal items, or calculated items.

 You need to use a unique naming convention for business entities
(divisions, departments, companies, etc.).
JSQ Example
Suppose you need to define 220 internal items for a job. You could resolve
the problem as follows:
Create a “base job” called Job1/Step1 and define 100 internal items for it.
Leave the Qualifier field blank.
To accommodate an additional 100 internal items, you define a JSQ. This
job will have the same job name and step name as the base job. You could
enter 00 in the Qualifier field.
To accommodate the remaining 20 internal items, you define another JSQ
with the same job name and step name as the base job. You could enter 01
in the Qualifier field.
Last update by/Date/Time. This displays the ID associated with the
most recent update to this set of definitions, along with the date and
time of the update.
Enter control report title. Title that will display on the Control Report
and, if printed, the Recap Report.
Select option to access. Select each option you want to process and
complete the corresponding screens. See the following sections for
instructions.
“Setting the Job Run Options” on page 161
“Using the Cycle Processing Options” on page 167
“Specifying an Alternate Job ID” on page 167
“Using the Rerun/Audit Trail Options” on page 168
“Setting the Extract File Options” on page 170
“Adding Job or File Comments” on page 177
After completing these options, complete the report options, which are also
part of the basic job information. See “Specifying Report Options” on
page 179
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Setting the Job Run Options
From the Job Window, select Job Information > Job Run Options to
display the Job Run Options panel.
Job Run Options
Select a run option to modify:
__ 1. Store history...
2. Set return code...
3. Perform file control...
4. Access user exit...
5. Truncate/round results...
6. Model definitions...
7. Generate XML messages...
F1=Help

F3=Exit

Select a run option... Select from the following options:
1. Store history. Displays a panel that allows you to specify options for

storing history records for this job in the history database. For more
information, see “Store History” on page 162.
2. Set return code. Displays a panel that allows you to set options for the

4-digit code that is generated when the rule detects an out-of-balance
condition. See “Set Return Code” on page 163.
3. Perform file control. Displays a panel that designates this job as a file

control job. File control jobs verify the input files and capture
information from output files. For more information, see “Perform File
Control” on page 164.
4. Access user exit. Displays a panel that enables you to select the option

you want for the File Interface User Exit program (UNIEXIT). For
more information, see “Access User Exit” on page 164
5. Truncate/round results. Displays a panel that allows you to truncate

decimal places from results produced by calculated items and rules
(the default is to round).
6. Model definitions. Used only in job modeling. For more information,

see “Model Definitions” on page 166.
7. Generate XML messages. Displays a panel that allows you to turn off

the generation of XML messages. For more information, see “Generate
XML messages” on page 167.
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Store History
From the Job Window, select Job Information > Job Run Options >
Store History to display the Store History panel.
Store History

Store balancing values in history? Y

(Y/N/I)

If yes, enter the number of runs to keep:

F1=Help

F2=Split

F3=Exit

001

F5=Accept

(1-999)

F9=Swap

This panel enables you to specify whether you want to store history records
for this job in the history database and, if so, the maximum number to store.

History Records
Each history record contains the job ID, cycle ID, and the control value
extracted for each internal (or extended internal) item. You can also specify
how many history records you want to keep. History records are stored in
the history database and can be used in another run of the same job or in
another job.
Complete the fields as follows:
Store balancing values in history?
Y Each time the balancing job runs, all its internal (or extended internal)
items will be stored in the history database.
N No internal (or extended internal) items will be stored
I internal (or extended internal) items will be stored only when the job is in
balance.
If yes... Unless you selected N, enter the maximum number of history
records to store, up to 999. After the maximum is reached, the newest run's
results replace the oldest ones.
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Set Return Code
From the Job Window, select Job Information > Job run options >
Set return code to display the Set Return Code panel.
Set Return Code
Choose a z/OS step completion code option:
(options below apply only to batch jobs)
1_ 1. Set z/OS step completion code to 0000
2. Set z/OS step completion code to equal the Infogix return code
3. Force a z/OS user abend
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

This panel allows you to set options for the 4-digit code that you define
when you create a rule. The code is generated when the rule detects an outof-balance condition and appears on the Control Report. If more than one
rule detects an out-of-balance condition, the highest return code generated
can be used as the return code for the job.
Note:

The return code options have no effect on program interface jobs. What
is passed to the IBM return code from a job is defined by the program
instructions as described in Balancing in Program Interface Mode on
page 403

Complete the field as follows:
Choose a z/OS step completion code option.
1. Set z/OS step completion code to 0000. Sets a step completion code of

zero but does not set a return code in the application; the job stream,
therefore, continues to process and the out-of-balance condition is
noted on the Control Report.
2. Set z/OS step completion code equal to the Infogix return code. Uses

the highest return code as the step completion code when a job run is
out of balance or in error; subsequent steps may also respond to the
return code.
3. Force a z/OS user abend. Sets a user abend code that stops the job

stream in batch mode when a job run is out of balance or in error. The
system forces an abend when running balancing in batch mode; it does
not abend when running online balancing.
When using job-step qualifiers (JSQ), the job will abend at the base level or
at the qualifier level, wherever the abend code is set within the job
parameters.
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Perform File Control
From the Job Window, select Job Information > Job Run Options >
Perform File Control to display the Perform File Control panel.
Perform File Control
Perform file control balancing? _
F1=Help
F9=Swap

F2=Split

F3=Exit

(Y/N)
F5=Accept

Entering Y in the Perform file control balancing field allows you to do the
following:

 Verify a job step’s input files as well as capture information from output
files.

 Capture information about the dataset, specifically DSN and Volser.
 Verify that the output of one job stream is equal to the input of another.
 Avoid using the same file two days in a row.
The captured information is stored in the history database and used to
verify those output files when they are later used by other job steps as input
files. Up to 10 files can be captured/verified in a job.
File control balancing is not an application interface mode and does not
perform the balancing function.
For more information see “Using File Control Balancing” on page 613.
Note:

After you choose file control balancing, the only way to revert back to
control value balancing is to delete the job and start over.

Access User Exit
From the Job Window, select Job Information > Job Run Options >
Access User Exit to display the Access User Exit panel.
Access User Exit
Specify when to access the file interface user exit:
2_ 1. Access the user exit on every execution
2. Access only if the job is out of balance

F1=Help
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This panel enables you to select the option you want for the File Interface
User Exit program (UNIEXIT). UNIEXIT is a COBOL program that you can
modify to perform custom processing. UNIEXIT controls the ability to set
return codes and kick off additional jobs. It works in conjunction with the
options you set in the Set Return Code and the Standard Rule panels. For
more information on this program, see “File Interface (UNIEXIT) User
Exit” on page 674
The user exit feature is used only to modify the COBOL program.
Specify when to access... The options are:

 Access the user exit on every execution. UNIEXIT will be accessed
unconditionally upon completion of the File Interface Program.

 Access only if the job is out-of-balance. UNIEXIT will be accessed upon
completion of the File Interface Program only if the following are both
true:

 The job is out of balance.
 The set return code option or the balancing rule action code sets a
non-zero z/OS step completion code or a z/OS user abend.

Truncate/Round Results
The Truncate/Round Results panel allows you to specify how the system
handles decimals for the following types of values:

 Results from calculated items and rules.
 Values moved from extraction variables into internal/extended internal
items or into other extraction variables.
Truncate/Round Results
Select a truncation/rounding option:
1_ 1. Round results
2. Truncate results
F1=Help
F5=Accept

F2=Split
F9=Swap

F3=Exit

Select a truncation/rounding option.
1. Round results. Rounds or pads the number to the nearest specified

number of decimals.
2. Truncate results. Truncates or pads the number to the specified

number of decimals.
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For example, if the indicator is set to truncate, the results will be as follows:
Target
(Dec 0)

Target
(Dec 1)

Target
(Dec 2)

Target
(Dec 3)

Target
(Dec 4)

Target
(Dec 5)

123.56

123
(truncate)

123.5
(truncate)

123.56
(no change)

123.560
(pad)

123.5600
(pad)

123.56000
(pad)

0.6543

0
(truncate)

0.6
(truncate)

0.65
(truncate)

0.654
(truncate)

0.6543
(no change)

0.65430
(pad)

Source

If the indicator is set to round, the results will be as follows:
Target
(Dec 0)

Target
(Dec 1)

Target
(Dec 2)

Target
(Dec 3)

Target
(Dec 4)

Target
(Dec 5)

123.56

124
(round)

123.6
(round)

123.56
(no change)

123.560
(pad)

123.5600
(pad)

123.56000
(pad)

0.6543

1
(round)

0.7
(round)

0.65
(round)

0.654
(round)

0.6543
(no change)

0.65430
(pad)

Source

Press F5 to accept the entry.

Model Definitions
From the Job Window, select Job Information > Job Run Options >
Model Definitions to display the Model Definitions panel.
Model Definitions
Select one of the following options:
1_ 1. This job will not use model definitions
2. The current job definitions will be merged with model
job ID's
3. This model job ID and all job IDs with the same job
name and step name but with different JSQs from the
model will execute when the job is submitted
Model definition
Job name:
Step name:
Qualifier:

F1=Help
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F2=Split

F3=Exit

F5=Accept

F9=Swap
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This panel is used in modeling job definitions. Modeling job definitions
allows you to have a standard set of controls that can be executed from any
job. For more information, see “Modeling Job Definitions” on page 640.
This panel is explained in “Specifying a Job as a Model User” on page 643.

Generate XML messages
From the Job Window, select Job Information > Job Run Options >
Generate XML messages to display the Generate XML messages panel.
Generate XML Messages
Generate XML messages? Y
F1=Help

F2=Split

(Y/N)

F3=Exit

F5=Accept

F9=Swap

This panel is used to turn off the generation of XML messages.
Y. Always generates start-of-job and end-of-job messages. Report
messages will be generated if the corresponding XML export option is
turned on.This is the default option.
N. Do not generate the XML messages. Start-of-job, end-of-job and all the
report messages will not be generated.

Using the Cycle Processing Options
Use the Cycle Processing Options panel if you want to automatically
generate all or part of the cycle ID or to verify cycle numbers against a cycle
table. This is one of several methods of setting the cycle ID. For more
information, see “Setting Up Cycle Processing” on page 625.

Specifying an Alternate Job ID
Alternate job IDs allow you to access the job definitions for a particular
primary Job ID in another job or jobs. One of the main reasons to use an
Alternate job ID is to have an alias for testing, when you cannot submit jobs
using the production names. To create an alternate job ID for testing, you
would do the following:
1. Enter the job definitions (basic job information, internal items, etc.)

under the primary (production) job ID.
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2. Specify an alternate (test) job ID for that primary job ID on the

Alternate Job ID panel, shown below.
3. Run balancing using the alternate job ID, which points to the primary

job ID's definitions, which are then used for extraction and balancing.
In order to assign an alternate ID, you need to access the (second) Alternate
Job ID panel. From the Job Window, select Job Information >
Alternate job ID information > New.
Alternate Job ID
Specify alternate job ID:
Job name:
Step name:
Qualifier:
F1=Help
F5=Accept

________
________
__
F2=Split
F9=Swap

F3=Exit

Specify the alternate job ID by entering the job name, step name, and
qualifier, if any, of the alternate job ID you want to assign. You cannot enter
duplicate Alternate Job IDs. If you want to update an existing Alternate Job
ID, exit this panel and select the alternate job ID you want to change.

Using the Rerun/Audit Trail Options
The rerun/audit trail options consist of 1) the automatic rerun option and
2) the audit trail option. Both options can be set at the system level through
the user options or, as explained here, at the job level for a specific job.

Automatic Rerun Option
The automatic rerun option uses the UNIARUN program to allow you to
rerun a job without making JCL changes.
For detailed information, see “Setting the System Level and Job Level
Options for Automatic Rerun” on page 135.

Rerun/Audit Trail Option
The rerun/audit trail option permits you to maintain history records for all
of the reruns for a job in the history database. The stored reruns remain
linked to the active history, so the audit trail is always current. For more
information, see the user option “Store All Reruns” on page 138.
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Setting the Rerun/Audit Trail Options
From the Job Window, select Job Information > Rerun/audit trail
options to display the Rerun/Audit Trail Options panel.
Rerun/Audit Trail Options
Select an automatic rerun option:
1_ 1. Use the system default
2. Invoke rerun only if system level is not set to do so
3. Disable rerun for this step regardless of system level
Select an audit trail option:
1_ 1. Use the system default
2. Invoke audit trail only if system level is not set to do so
3. Disable audit trail regardless of system level

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Complete the fields as follows:
Select an automatic rerun option.
Note:

Automatic rerun is not available if you are using cycle processing
with the J0, J9, or G9 options, which allow only one cycle per
calendar day. See Completing the Cycle Processing Options Panel
on page 629.

1. Use the system default. Use the option in the user options file.
2. Invoke the rerun only if system level is not set to do so. Invoke the

rerun if the user options file setting is not set to do so.
3. Disable rerun for this step regardless of system level. Disable the rerun

for this step regardless of the user options setting. For information on
the combining job level specifications set here with the settings in user
options file, see “Dynamic Allocation of Files” on page 118.
Select an audit trail option.
1. Use the system default. Use option in the user options file.
2. Invoke audit trail only if system level is not set to do so. Invoke the

audit trail only if the user options file is not set to do so.
3. Disable audit trail for this step regardless of system level. Disable the

audit trail regardless of the setting in the user options file. For
information on combining job level specifications set here with user
options settings, see “Store All Reruns” on page 138.
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Setting the Extract File Options
The Extract File Options enable you to create an extract file (also called a
balancing extract file) with DDNAME UNIEXTR containing information
extracted during balancing that can be read into another job as input.
Depending on your specifications, the file can contain any combination of
the following: internal items, extended internal items, history items,
calculated items, rules, and messages.
This file can provide a means of downloading balancing results for use in
workstation applications, passing results to other platforms, and
generating correction transactions based on the balancing results.
To create an extract file, from the Job Window, select Job Information >
Extract file options to view the Extract File Options panel.
Extract File Options
Select sections to modify:
_ Internal items...
_ History items...
_ Calculated items...
_ Rules...
_ Messages...
_ Extended internal items...
F1=Help
F3=Exit

Select an item type that you want to include in the extract file. The
corresponding panel will be displayed. Complete it with your preferences.
Each of the sections has similar options to extract the item type. The
options include:

 Do not extract items.
 Extract items.
 Extract items only if the job is out of balance.
 Extract items only if the job is in balance.
The Rules Extract File Options include two additional options:

 Extract out-of-balance rules only.
 Extract in-balance rules only.
For History items and Calculated items, you can also specify what item
information to extract. For Rules, you can also specify what balancing rule
information to store.
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When you return to the Extract File Options panel, you can select and
specify your preferences for additional item types until you have specified
all of the item types you want to include in the extract file. Be sure to change
your JCL to allocate a file or write the results to SYSOUT.
The layout for the extract file is provided in the next section.
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Extract File (UNIEXTR) Record Layout
Header Record Layout
Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

4

Run Date

32-37

6

X(6)

5

Run Time

38-43

6

X(6)

6

Reserved

44-200

157

X(157)

Blanks

Value

A1

Internal Item Record Layout

172

Fld#

Description

Position

Length

Format

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

B1

4

Internal Item
Number

32-34

3

X(3)

001-100

5

Internal Item
Value Sign

35

1

X(1)

+ or -

6

Value

36-50

15

X(15)

Control
Value

7

Description

51-130

80

X(80)

8

Reserved

131-200

80

X(80)

Blanks
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Extended Internal Item Record Layout
Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

G1

4

Internal Item
Number

32-34

3

X(3)

001-100

5

Internal Item
Value Sign

35

1

X(1)

+ or -

6

Value

36-115

80

X(80)

Control
Value

7

Description

116-195
80

X(80)

8

Reserved

196-200

5

X(5)

Blanks

History Item Record Layout - Record 1 of 2
Fld#

Description

Position

Length

Format

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

C1

4

History Item
Number

32-34

3

X(3)

001-100

5

History Item
Value Sign

35

1

X(1)

+ or -

6

Value

36-115

80

X(80)

Control
Value

7

Description

116-195

80

X(80)

8

Reserved

196-200

5

X(5)
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History Item Record Layout - Record 2 of 2
Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

C2

4

History Item
Number

32-34

3

X(3)

001-100

5

EITB Job ID

35-52

18

X(18)

6

EITB Cycle ID

53-63

11

X(11)

7

Relative
Cycle

64-66

3

X(3)

-99 to +00

8

Reserved

67-200

134

X(134)

Blanks

Calculated Item Record Layout - Record 1 of 2
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Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

D1

4

Calculated
Item Number

32-34

3

X(3)

01-100

5

Calculated
Value Sign

35

1

X(1)

+ or -

7

Calculated
Value

36-65

30

7

Description

66-145

80

X(80)

8

Reserved

146-200

55

X(55)

X(30)
Blanks
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Calculated Item Record Layout - Record 2 of 2
Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

D2

4

Calculated
Item Number

32-34

3

X(3)

001-100

5

Formula

35-154

120

X(120)

6

Reserved

155-200

46

X(46)

Blanks

Value

Balancing Rule Record Layout - Record 1
Fld#

Description

Position

Length

Format

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

E1

4

Rule Number

32-34

3

X(3)

001-100

5

Result (BALIND)

35-52

18

X(18)

6

Description

53-132

80

X(80)

7

Reserved

133-200

68

X(68)
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Balancing Rule Record Layout - Record 2
Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

E2

4

Rule Number

32-34

3

X(3)

001-100

5

Formula

35-154

120

X(120)

6

Tolerance
Value Sign

155

1

X(1)

7

Tolerance
Value

156-185

30

X(30)

8

Reserved

186-200

15

X(15)

+ or -

Blanks

Balancing Rule Record Layout - Record 6 (Special Instructions)

176

Fld#

Description

Position

Length

Format

Value

1

Job ID

1-18

11

X(11)

2

Cycle ID

19-29

11

X(11)

3

Record Type

30-31

2

X(2)

F1

4

Special
Instruction
Number

32-34

3

X(3)

01-100

5

Return Code

35-38

4

X(4)

0000-9999

6

Text

39-118

80

X(80)

7

Reserved

119-200

82

X(82)

Blanks
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Adding Job or File Comments
This feature allows you to fill up to 58 panels of 17 lines with your own
comments regarding a job or input source file. All of the comments will
print when you generate a List Definitions Report that includes detailed job
and/or detailed file information.
The system automatically captures audit information (including the user ID
of the person making the change and the date and time of the change) on
updates to the following definition types:

 Jobs (including User Report and Freeform Report definitions)
 Files
 External and internal translation tables
 Cycle tables
 History Analysis definitions
You can use job or file comments to retain additional information on such
updates.

Adding Job Comments
To type in or paste in comments about a job, from the Job Window, select
Job Information > Display/change comments, and press F5=Accept
to view the Job Comments panel, shown below.

Adding File Comments
To type in or paste in comments about an input source file, from the Input
Sources panel (see “Defining an Input Source” on page 261) in the Add/
Change Comments field, enter Y, and then press F5=Accept three times
to view the File Comments panel, shown below.
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Deleting a Line of Comments
To delete a line of comments, go to the line and press F10. The line will be
marked for deletion, but not physically deleted until the job or file is saved.
Job (or File) Comments
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
F1=Help
F9=Swap
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Specifying Report Options
You can use the Report Options to specify the numeric format for the
reports that you can run when you run balancing, customize the Control
Report, and set up the optional Free-Form Report, User Report, and Recap
Report.
From the Job Window, select Report Options to display the Report
Options panel.
Report Options
Specify
1_ 1.
2.
3.

a numeric format option:
Default to user options
Use 22-character numeric format
Do not use 22-character numeric format

Select options to modify:
_ Control report copy1...
_ Control report copy2...
_ Control report XML option...
_ Free-form report...
_ User report...
_ Recap report...

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify a numeric format option.
Specify whether you will use 22-character format (instead of typical 18character format) for counts and amounts on the Control Report, User
Report, and Free-Form Report. 22-character formatting enables proper
alignment of longer numbers that may include a currency symbol, commas,
a decimal point, a sign, and up to 15 digits.
1. Default to user options. Use the user options setting for the 22-

character numeric field when running the job in batch. In online
processing, typical 18-character formatting will be used.
2. Use 22-character numeric format. Use 22-character format whether

the job is run online or in batch.
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3. Do not use 22-character-numeric format. Use 18-character formatting.

Select options to modify. Select the report option you want. The
corresponding panel will display. See the pertinent section below:







“Control Report (Copy1 or Copy2)” on page 180
“Control Report XML Option” on page 188
“Free-Form Report” on page 192
“User Report” on page 192
“Recap Report” on page 189

Control Report (Copy1 or Copy2)
The Control Report is the primary output of an ACR/Summary balancing
run. It shows you the values balanced, rules applied, results, return codes,
and messages. Unless you specify otherwise, this report is automatically
generated when balancing is completed.
The DDNAME for the report in your output will be UNIACR.
Use the Control Report (Copy1 and/or Copy2) option to customize your
Control Report.
From the Job Window, select Report Options > Control report copy1
or Control report copy2 to display the Print Control Report (Copy1) or
Print Control Report (Copy2) panel. These panels enable you to customize
the Control Report to your needs. For a report sample, see “Control Report
Example and Content” on page 185.
The Copy1 and Copy2 panels are almost identical. (The Headings field
appears on Copy1 only.) Depending on your selections on the panels, you
can print 1 or 2 reports, each of which can show all or selected information
concerning the balancing run. Each report will be written to a different DD.
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If you do not complete the Print Control Report (Copy1) panel or the
(Copy2) panel, one copy will be printed when you run the job, using the
defaults on the (Copy1) panel. All sections will be included, and the width
will be 132 bytes.
Print Control Report (Copy1)
Specify
1_ 1.
2.
3.
4.

a print option:
Print the report
Print the report
Do not print the
Print the report

for all balancing steps
only if a job is out of balance
report
only if a job is in balance

Choose report overrides:
_ Size...
_ Headings...
_ Sections...
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Complete the fields as follows:
Specify a print option. Select the option you want.
Choose report overrides. Select any of the items listed to view and
change the defaults on the corresponding panels, which are explained
below.

Report Size
From the Job Window, select Report Options > Control report copy1
or Control report copy2 > Size to display the Report Size panel.
Report Size (Copy1)
Indicate a control report size:
1_ 1. Produce a 132-column report
2. Produce a complete 80-column report
3. Produce a condensed 80-column report

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Select the size you want. The 80-column condensed option will not show
the following:

 JOB/STEP/QUAL, item number, cycle reference, cycle run date/time
or program name for history items.

 The formula for calculated items.
 The formula for the standard rules.
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 Conditions or rule actions for conditional rules.
Headings (Only Available from on Copy1 Panel)
From the Job Window, select Report Options > Control report copy1
> Headings to display the Headings panel.
Headings
Select options to modify:
_ Report title...
_ Column headings...
_ Report headings...

F1=Help
F9=Swap

F2=Split

F3=Exit

Select any of the items listed to view and change the defaults on the
corresponding panels, which are explained below. Settings for the options
on this panel will affect both Copy 1 and Copy 2.
Report Title
From the Job Window, select Report Options > Control report copy1
or Control report copy2 > Headings > Report title to display the
Control Report Title panel. Optionally use this panel to modify the Control
Report title.
Control Report Title
Enter a title for the control report:
________________________________________
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Column Headings
The Column Headings panel enables you to enter your own descriptive
headings for the two rightmost columns of the report. These columns are
for control values.
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From the Job Window, select Report Options > Control report copy1
or Control report copy2 > Headings > Column Headings to display
the Column Headings panel.
Column Headings
Enter a left column heading:
__________________
Enter a right column heading:
__________________
F1=Help
F5=Accept

F2=Split
F9=Swap

F3=Exit

Complete the fields as follows:
Enter a left column heading. A descriptive heading for the left column
of control values. If blank, the word INPUT will be used.
Enter a right column heading. A descriptive heading for the right
column of control values. If blank, the word OUTPUT will be used.
Report Headings
The Report Headings panel enables you to optionally modify a portion of
any one of the top three lines of your Control Report with up to 40
characters of text.
From the Job Window, select Report Options > Control report copy1
or Control report copy2 > Headings > Report Headings to display
this panel.
Report Headings
Title
Title
Title
Title

line number:
1
text: . . . . . .
length: . . . . .
position: . . . .

F1=Help

F2=Split

----+----1----+----2----+----3----+----4
________________________________________
40
15_

F3=Exit

F5=Accept

F9=Swap

Title line number. The report line where you want the text to appear (13).
Title text. Up to 40 characters of text.
Title length. Length of the text that will appear.
Title position. The column position where the text will begin. To avoid
overlaying information, observe the following guidelines:
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If Line Number is 1, the valid positions are 18-120.
If Line Number is 2, the valid positions are 2-96.
If Line Number is 3, the valid positions are 2-98.
If you specified an 80-column width for the report, the only valid positions
are 1-80.

Sections
The Sections panel allows you to specify your preferences for printing
internal items, history items, calculated items, rules, and extended internal
items.
From the Job Window, select Report Options > Control report copy1
or Control report copy2 > Sections to display this panel.
Sections
Copy1
Select sections to modify:
_ Internal items...
_ History items...
_ Calculated items...
_ Rules...
_ Extended internal items...
F1=Help

F2=Split

F3=Exit

F9=Swap

Select any of the item types listed to view and change the defaults on the
corresponding panels.
Note:

For pre-Release 4.0 jobs only, the default for the Extended
Internal Items field is Do not print. If you want the report to
include the extended internal items section, you need to change
the setting for the Extended Internal Items field.
You must do this for every job created before Release 4.0 that
now includes extended internal items.
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Control Report Example and Content
Following is a sample of the report with an explanation of each section. The
DDNAME for the report in your output will be UNIACR.

Example: Page 1 of 2
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:36:04

INFOGIX, INCORPORATED
BALANCING CONTROL REPORT
SAMPLE REPORT 1
JOB=REPORT
STEP=SAMPLE
QUAL=
CYCLE#=00000003 RUN#=000

PAGE 001
COPYRIGHT INFOGIX, INC.
DATA BASE VERSION: 0000037/0000011

A. INTERNAL ITEMS:
ITEM NO.
DESCRIPTION
INPUT
OUTPUT
-------- -------------------------------------------------------------------------------- ------------------ -----------------I-001.
TEXT INTERNAL ITEM
'TEXT1
'
I-002.
COUNT INTERNAL ITEM
4,021
I-003.
AMOUNT INTERNAL ITEM
$321.11
I-004.
DATE INTERNAL ITEM
05/12/09
EXTENDED INTERNAL ITEMS:
X-001.
X-002.
X-003.

COUNT EXTENDED ITEM
AMOUNT EXTENDED ITEM
TEXT EXTENDED ITEM

1,234,567,890,123,456,789,012,341
$1,234,567,890,123,456,789.001111
'LONG TEXT OF 39 BYTES LONG FIRST 111111'
05/12/09

X-004.
DATE EXTENDED ITEM
B. HISTORY ITEMS:
ITEM NO.
-------E-001.

E-002.

E-003.

E-004.

E-005.

E-006.

E-007.

DESCRIPTION
JOB
STEP
QUAL ITEM CYCLE
CYCLE# RUN# RUNDATE
RUNTIME PROGRAM
INPUT
--------------------------------------------------------------------------------- -----------------HISTORY TEXT II
'TEXT1
'
REPORT
SAMPLE
I-001
-002
00000001 000 08/06/10
15.29.52 UAC2000

OUTPUT
------------------

HISTORY COUNT II
REPORT
SAMPLE

I-002

-002

00000001

000 08/06/10

15.29.52 UAC2000

4,021

HISTORY AMOUNT II
REPORT
SAMPLE

I-003

-002

00000001

000 08/06/10

15.29.52 UAC2000

HISTORY DATE II
REPORT
SAMPLE

I-004

-002

00000001

000 08/06/10

15.29.52 UAC2000

HISTORY COUNT EI
REPORT
SAMPLE

X-001

-002

00000001

000 08/06/10

15.29.52 UAC2000

HISTORY AMOUNT EI
REPORT
SAMPLE

X-002

-002

00000001

000 08/06/10

15.29.52 UAC2000

HISTORY TEXT EI
REPORT
SAMPLE

X-003

-002

00000001

000 08/06/10

15.29.52 UAC2000
'LONG TEXT OF 39 BYTES LONG FIRST 111111'

$321.11

05/12/01

1,234,567,890,123,456,789,012,341

$1,234,567,890,123,456,789.001111

**OUT OF BALANCE**
(RETURN CODE = 3001)
INFOGIX DATABASE: USR1.SUM.DEFN
(UNIDF) / USR1.SUM.HIST
PROGRAM= UAC2000 LOAD LIBRARY NAME=UNI.TAPESHIP.release#.LOADLIB
JOB START DATE=mm/dd/yy

ACR/Summary User Guide for z/OS

(UNIHF)
JOB START TIME=15.36.04

185

5  Entering Basic Job Information
Specifying Report Options

The report sections are as follows:
Header and Footer
The header displays the product release number, the report page number,
the date and time of the report, the database version you are using (showing
the number of times the definition database/history database has been
updated), the job ID, and the cycle ID for this run.
The footer displays the definition and history databases, the program that
generated the report, and the job start date and time.
The remaining sections are identified by a letter and section name, as
follows:
Note:

Control values that do not fit on the line will be printed on the next
line.

A. Internal Items and Extended Internal Items. For each regular or
extended internal item, this section lists the item type (I for internal item,
X for extended internal item) and item number, along with its description,
and value.
B. History Items. This section lists each history item number (for
example, E-001) along with the job ID from which the item is being
retrieved, internal (or extended internal) item number in that job, relative
cycle, cycle ID, run date, run time, name of the program that produced the
report (UAC2000 is the balancing program), and the control value
extracted.

186

Infogix, Inc.

Entering Basic Job Information  5
Specifying Report Options

Example: Page 2 of 2
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:36:04

B.

INFOGIX, INCORPORATED
BALANCING CONTROL REPORT
RELEASE 4.0 SMOKETEST
JOB=REPORT
STEP=SAMPLE
QUAL=
CYCLE#=00000003 RUN#=000

PAGE 002
COPYRIGHT INFOGIX, INC.
DATA BASE VERSION: 0000037/0000011

HISTORY ITEMS:

DESCRIPTION
JOB
STEP
QUAL ITEM CYCLE
CYCLE# RUN# RUNDATE
RUNTIME PROGRAM
INPUT
--------------------------------------------------------------------------------- -----------------HISTORY DATE EI
REPORT
SAMPLE
X-004
-002
00000001 000 08/06/10
15.29.52 UAC2000
C. CALCULATED ITEMS:
ITEM NO.
CALCULATION FORMULA
RESULT
-------- -------------------------------------------------------------------------------- -----------------C-001.
I-2 PLUS 100 COUNT
4,121
(I-002) + (100)
ITEM NO.
-------E-008.

CALC MESSAGE
------------------

C-002.

I-3 PLUS 100 AMOUNT
(I-003) + (100)

C-005.

100 PLUS X-1 COUNT
(100) + (X-001)

1,234,567,890,123,456,789,012,441

C-006.

100 PLUS X-2 AMOUNT
(100) + (X-002)
LARGE MINUS SMALL REVENUE
(I-003) - (100)

$1,234,567,890,123,456,889.001111

C-007.

D.

OUTPUT
-----------------05/12/01

BALANCING RULES & RESULTS:
RULE NO.
BALANCING RULE
-------- -------------------------------------------------------------------------------1.
X-1 EQUAL I-2
(X-001) EQ (I-002)

$421.11

**BYPASSED**

RESULT
-----------------**OUT OF BALANCE**

ERROR/TOLERANCE
------------------

$1,234,567,890,123,456,789,008,320
2.

X-3 NOT EQUAL I-1
IN BALANCE
(X-003) NE (I-001)
3.
LARGE LARGEST, SMALL SMALLEST
ACTION BYPASSED
IF R-001 AND R-002
IN-BALANCE THEN SET RETURN CODE 0001 CALCULATE C-007
E. SPECIAL INSTRUCTIONS:
RETURN
RULE NO.
CODE
INSTRUCTIONS
-------- ------ -------------------------------------------------------------------------------1.
3001
X-1 EQUAL I-2
**OUT OF BALANCE**
(RETURN CODE = 3001)
INFOGIX DATABASE: USR1.SUM.DEFN
(UNIDF) / USR1.SUM.HIST
PROGRAM= UAC2000 LOAD LIBRARY NAME=UNI.TAPESHIP.R40V0M00.LOADLIB
JOB START DATE=08/06/10

(UNIHF)
JOB START TIME=15:36:04

C. Calculated Items. This section lists each calculated item by number
and description along with the formula used and the result. Each side of the
formula LHS (Left Hand Side) and RHS (Right Hand Side) is enclosed in
parentheses.
D. Balancing Rules & Results. This section lists each rule by number
and description along with the comparison formula and the result. If a rule
is out of balance or is using a tolerance, the error/tolerance column shows
the amount the rule is out of balance or out of the tolerance range.
E. Special Instructions. If one or more rules are out of balance, this
section shows the text of any messages. If all rules are in balance, it shows
None unless a message has been defined for the return code 0000 (in
balance).
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Control Report XML Option
The Control Report XML Option panel applies only when the job is run in
batch.
From the Job Window, select Report Options > Control report XML
option to display this panel.
Control Report XML Option
Control Report XML Option:
1_ 1. Default to user options
2. Do not generate
3. Generate, write copy 1 to
4. Generate, autoload copy 1
5. Generate, write copy 2 to
6. Generate, autoload copy 2
F1=Help
F2=Split
F3=Exit

file
to database
file
to database
F5=Accept F9=Swap

Control Report XML Option. Set a job-level option for generating the
Control Report in XML format. Your settings here will override the
corresponding (system-wide) XML options (see “XML Options” on
page 129). You can override the job-level option you set here at the JCL
level. To do this, see “SUM2000 JCL Parms for the File Interface Balancing
Program” on page 388.
1. Default to user options. Defaults to the option specified for the

Control Report field described in “XML Options” on page 129.
2. Do not generate. Do not generate the report in XML format.
3. Generate, write copy 1 to file. Create a copy of the control report copy 1

in XML format and write to the file specified.
4. Generate, autoload copy 1 to database. Create a copy of the control

report copy 1 in XML format and write to the associated database. The
fail option and maximum size specified at the system-wide (user
options) level will apply (see “XML Options” on page 129).
5. Generate, write copy 2 to file. Create a copy of the control report copy 2

in XML format and write to the file specified.
6. Generate, autoload copy 2 to database. Create a copy of the control

report copy 2 in XML format and write to the associated database. The
fail option and maximum size specified at the system-wide (user
options) level will apply (see “XML Options” on page 129).
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Recap Report
The Recap Report can be specified to provide a high-level summary
(showing the status and return code) for the identified history records. You
can produce a summary of daily processing, of variable cycle processing, or
of a complete system or subsystem.
The report is often run in batch with the last job of the day. If a recap item
is entered for each job that runs that day, the Recap Report can be scanned
to find any problems that may have occurred.

Creating the Recap Report
If you want a Recap Report, you must define a recap item for each job to be
included in the report. Up to 100 recap items can be included.
From the Job Window, select Report Options > Recap report to
display the Recap Item Window.
Recap Item Window

Row 1 from 4

_
A. Recap Report Print Option:
_
Do not print the report
_
B. Recap Items:
_
< NEW... >
************************ Bottom of data ************************

Command Line ===> ____________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Recap Report Print Option: Do not print the report. Select and
change the N to Y if you want to print the Recap Report.
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Recap Items. To create each recap item, select New and complete the
Recap Items panel. The Recap Items panel below shows sample entries.
Recap Items
Item number: 001
Specify recap job ID:
Job name:
SMOKETST
Step name:
BUILD1__
Qualifier:
__
Relative
cycle:
+000

F1=Help
F5=Accept

(-998 to +000)

F2=Split
F9=Swap

F3=Exit

Item number. The first item is set to 001 and the item number
automatically increments by one each time you add a recap item.
Specify recap job ID. Complete the files to identify the job whose status
and return code will be reported.
Relative cycle. The specific run of the job that you want to include in the
Recap Report, relative to the current cycle.
Relative cycles are numbered -998 to +000. A relative cycle of +000 refers
to the current cycle, -001 refers to the prior cycle, and so forth. In most
cases, you will use +000, which is the most current cycle.
The report is generated when you run the job.
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Recap Report Example and Content
The DDNAME for the report in your output will be UNIRCR.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 09:24:56

INFOGIX, INC
BALANCING RECAP REPORT
THIS IS THE MONTLY JOB
JOB=BCAPCHK
STEP=001
QUAL=
CYCLE#=00960806 RUN#=000

JOB
-------BCAPCHK
BCAPCHK
BCAPCOMM
BCAPUPDT

STEP JQ CYC
CYCLE# RUN#
-------- -- ---- -------- ---001
000 20090630 000
001
-001 20090625 000
001
000 20090630 000
001
000 ******** ****

RUNDATE
---------09/06/17
09/06/16
09/06/18
********

COPYRIGHT INFOGIX, INC
PAGE
001

RUNTIME
-------12.41.52
18.35.30
12.10.39
********

RUN STATUS
-------------IN BALANCE
OUT OF BALANCE
NO BALANCING
*NOT IN FILE**

CODE
---0000
2000
0000
****

Report Header
The header displays the product release number, the report page number,
the date and time of the report, the job ID, and the cycle ID for this run.
Report Fields
The fields in the following example can be interpreted as follows:
Field

Description

JOB, STEP,
JQ

The job ID (job name, step name, and qualifier). Matches this
information in the report header.

CYC

The relative cycle for the balancing job. The current cycle is
represented by 000.

CYCLE#

The cycle number used for each job ID.

RUN#

The run number used for each JOB ID.

RUNDATE

The date when the job was run.

RUNTIME

The time when the job was run.

RUN
STATUS

The status of the job. Valid values include:
IN BALANCE. All rules were in balance.
OUT OF BALANCE. One or more rules were out of balance.
NO BALANCING. This job did not include balancing rules.
*NOT IN FIILE*. This history record was not in the history
database.

CODE

The return code for the balancing result.
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Free-Form Report
From the Job Window, select Report Options > Free-form report to
display the first panel required for creating a Free-Form Report.
This is a custom report that can include any of the control values obtained
when the job is run, along with their descriptions. See “Setting Up FreeForm Reports” on page 575 for full instructions and an example.

User Report
From the Job Window, select Report Options > User report to display
the first panel required for creating a User Report.
This is a customized report limited to 8 columns that prints any of the data
that can be included in the Control Report in the order that you specify. For
more information, see “Setting Up User Reports” on page 595.
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After you have completed the instructions provided in “Entering Basic Job
Information” on page 155, you will be ready to set up the job definitions
described here.
Job definitions specify how values are processed. This chapter provides
information for setting up several types of job definitions. These
instructions assume you are creating your job definitions through the user
interface using the file interface mode (the typical mode) or direct input
mode.
This chapter contains the following sections:
















“Processing of Print Leading Zeros Indicator” on page 194
“Processing of Print Leading Zeros Indicator” on page 194
“Defining Internal Items” on page 196
“Defining Extended Internal Items” on page 199
“Defining Extraction Variables” on page 201
“Defining History Items” on page 207
“Infogix Assure History Item” on page 217
“Defining Calculated Items” on page 224
“Defining Rules” on page 231
“Using Alternate Balancing Rules” on page 245
“Defining Messages” on page 249
“Navigating through Existing Job Definitions” on page 255
“Deleting Job Definitions” on page 255
“Setting the Print Options” on page 256
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Processing of Print Leading Zeros Indicator
This option is applied to pad leading zeros to the Count field. The “Print
commas” indicator must be disabled when “Print Leading Zeros” is
enabled. The option supports leading and trailing negative signs.

Processing in Control Report
 For an internal item or a history item that is pulled from an internal
item, 18 bytes will be used to format the item value when the 18character format is specified in the User Options File. 22 bytes will be
used to format the item value if a 22-character format is specified.

 For an extended internal item, a history item that is pulled from an
extended internal item, a calculated tem, or a balancing rule; 43 bytes
will be used to format the item value. However, if the value can fit into
18/22 bytes (according to the 18-character format indicator in the User
Options File), 18/22 bytes will be used to print the item value.

About Internal Items and Extended Internal Items
This section explains internal items and extended internal items.

Characteristics Shared by Regular and Extended Internal Items
Internal items (regular and extended) are used to store control values
obtained when your file definitions are processed.
A control value can be either of the following:

 A value obtained during extraction (a count, amount, text item, or date).
 The result of a calculated item. A calculated item specifies mathematical
manipulation of values from internal (or extended internal) items,
history items, other calculated items, literals (numeric constants or
text), or functions.
Both regular and extended internal items can be used in calculated items
and rules and, if the job stores history, will be stored in the history database
so that you can define them as history items for reuse in a later run of the
same job or of another job (see “Defining History Items” on page 207.
You can use a maximum of 100 regular and 100 extended internal items in
the same balancing job.
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Differences Between Regular and Extended Internal Items
Internal Items
 In the panels, internal items are identified with an I. For example,
I-001, I-002, etc.

 Internal items cannot be used to store lengthy extracted values. For
example, only 15 bytes of numeric data or 8 bytes of text can be stored
in an internal item.

Extended Internal Items
 Extended internal items are identified with an X. For example, X-001,
X-002, etc.

 Extended internal items enable you to store significantly longer control
values than regular internal items. These longer values are called
extended data. Extended data simplifies job creation when working
with lengthy values by reducing the number and complexity of the
definitions required. This is because extended data can be used just like
regular data in calculated items, history items, and rules.

Restrictions for Extended Data
 Literals, selection fields, and keys do not support extended data.
 Storage of extended internal items in the history database may impact
performance.
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Maximum Lengths for Regular and Extended Data
The following table shows the maximum lengths for regular vs. extended
data in each suppported format.

Format of
Extracted Data1

Maximum Length
Regular Data

Extended Data

Numeric2

A maximum of 15 digits
can exist within the
specified length.

A maximum of 30 digits
can exist within the
specified length.

Alphanumeric3

8

80

Packed decimal3

8

16

Zoned decimal

A maximum of 15 digits
can exist within the
specified length.

A maximum of 30 digits
can exist within the
specified length.

Binary

8

8

Unsigned packed

8

16

(Overpunch

)2

1 - The data formats listed in column 1 are described in Understanding Field
Formats on page 288
2 - For numeric and zoned decimal (overpunch) values, 80 positions can be
identified for extraction, but only 15 or 30 digits can exist within these positions.
Additional digits will not be evaluated.
3 - Packed decimal and alphanumeric are the only valid formats for values
stored in extraction variables.

Defining Internal Items
Internal items and extended internal items were described in the preceding
sections.
To access the Internal Items panel, do one of the following:

 From the Job Window, select NEW under Internal Items.
 From the Field Value panel or the Detail Field panel, if the value will be
assigned to an internal item, the Internal Items panel displays
automatically.
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Internal Items
Internal
Item number
-------------- Description ------------012
________________________________________
________________________________________
Print format:
Print the internal item value:
1
1. Count
1
1. In the left column of the control report
2. Amount
2. In the right column of the control report
3. Date
3. Item is a calculated item result; print on
4. Text
left
5. Time
6. Date & Time
Print decimals:
Calculated item number: 000 (1-100)
Specify an action to take when an internal item is not found:
1
1. Set internal item to zero or spaces and continue processing
2. The internal item is required for an in-balance condition
3. Skip all balancing rules involving the internal item
Print commas? 1 1. Default
Print leading zeros? N (Y/N)
F1=Help
F8=Next

F2=Split
F9=Swap

2. Print

F3=Exit

3. Do not print

F4=Retain

F5=Accept

F7=Prev

Internal Item number. Defaults to the next available number. We
recommend that you let this field increment automatically.
Description. Describe the internal item. This description will be included
in reports.
Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 256 for more information.
Print Location. Specify where the internal item will print in the Control
Report.
1. In the left column of the control report. Prints the item in the left

column of the report. This column heading has the default heading
INPUT.
2. In the right column of the control report. Prints the item in the right

column of the report. This column heading has the default heading
OUTPUT.
3. Item is a calculated item result; print on left. Stores the value of a

calculated item in this internal item that will print in the internal item
section of the report.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.

ACR/Summary User Guide for z/OS

197

6  Creating Job Definitions
Defining Internal Items

Calculated Item Number. Number of the calculated item to be stored in
this internal item, if any. For more information, see “Defining Calculated
Items” on page 224).
Specify an action to take when an internal item is not found.
Indicate the processing you want if the item is missing.
1. Set internal item to zero or spaces and continue processing. The

item is not required for an in-balance condition. The rule is evaluated
with the missing item set to 0 if it is a numeric item or spaces if it is a
text item. The item value will display as 0 on the Control Report.
2. The internal item is required for an in-balance condition. All rules

containing the missing item will be set to out-of-balance. The message
**KEY NOT FOUND* (ITEM NOT EXTRACTED for access modes 6
and 7) displays on the Control Report.
3. Skip all rules involving this item. Any rule using this item will be

ignored, and the message **KEY NOT FOUND* (ITEM NOT
EXTRACTED for access modes 6 and 7) displays on the Control
Report.
Note:

When a rule uses an internal item, history item or calculated item
that is missing, the rule stores the indicator value for that item. After
all items are processed, the indicator with the highest order of
precedence is used to determine how to process the rule. See Rule
Processing When Item Is Not Found on page 245.

Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 256.
Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.
The “Print commas” indicator must be disabled when “Print Leading Zeros”
is enabled. See “Processing of Print Leading Zeros Indicator” on page 194
for more information.
When you are finished with the panel, do one of the following:

 If you selected Internal Items from the Job Window and you want to
create more of them now, press F4 to remain in the internal item
function. This will accept the original item, increment the item number,
and retain the field values. You only need to change the values that
make the new item unique.

 Press F5 to accept.
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Defining Extended Internal Items
Extended internal items were explained in the “Processing of Print Leading
Zeros Indicator” on page 194.
You can access the Extended Internal Items Panel in the following ways:

 Typical method: Set up the field value or detail field from the Extract
Window as described in “Defining Field Values” on page 299 or
“Defining Detail Fields” on page 334. The Extended Internal Items
panel is displayed automatically.

 From the Job Window, select New under Extended Internal Items.
Extended Internal Items
Extended internal
item number
-------------- Description ------------010
________________________________________
________________________________________
Print format:
1_ 1. Count
2. Amount
3. Date
4. Text
5. Time
6. Date & Time
Print decimals: _
Calculated item number: 000 (1-100)
Specify an action to take when an item is not found:
1_ 1. Set item to zero or spaces and continue processing
2. The item is required for an in-balance condition
3. Skip all balancing rules involving the item
Print commas? 1 1. Default
Print leading zeros? N (Y/N)
F1=Help

F2=Split

2. Print

F3=Exit

3. Do not print

F4=Retain

F5=Accept

F9=Swap

Extended internal item number. Defaults to the next available
number. We recommend that you let this field increment automatically.
Description. Describe the item. This description will appear on reports.
Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 256 for information.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
Calculated item number. The number of the calculated item to be
stored in this item, if any.
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Specify an action to take when an item is not found. Indicate the
processing that should take place if the item is not found.
1. Set item to zero or spaces and continue processing. The item is not

required for an in-balance condition. If it is missing, the item value will
display as zero on Control Report. The balancing rule will be evaluated
with the item equal to zero or spaces.
2. The item is required for an in-balance condition. If it is missing, the

message ITEM NOT EXTRACTED will display instead of the item
value on the Control Report. An out-of-balance condition will be set for
all rules containing this item.
3. Skip all balancing rules involving the item. If the item is missing,

any rule using this item may be ignored and the message ITEM NOT
EXTRACTED will display instead of the item value on the Control
Report.
For more information, see “Rule Processing When Item Is Not Found” on
page 245.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 256.
Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.
The “Print commas” indicator must be disabled when “Print Leading Zeros”
is enabled. See “Processing of Print Leading Zeros Indicator” on page 194
for more information.
When you are finished with the panel, do one of the following:

 If you selected Extended Internal Items from the Job Window and you
want to create more of these items now, press F4 to remain in the
extended internal item function. This will accept the original item,
increment the item number, and retain the field values. You only need
to change the values that make the new item unique.

 Press F5 to accept.
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Defining Extraction Variables
Extraction variables are items you define to store regular or extended data
from file definitions or external translation table definitions for further
processing.
You can specify up to 999 extraction variables per job.

Specifying Extended Formatting for an Extraction Variable
You should use an extended extraction variable if you plan to store a packed
decimal number that is 9 to 16 bytes long (16 to 30 digits) or text that is 9 to
80 characters long.
To indicate an extended extraction variable, set the Extended field to Y on
every file definition and/or external translation table definition that
references it, as detailed below.

Consistency in Specifying Extended Format for an Extraction
Variable
When setting the Extended indicator for an extraction variable, you must be
consistent. For example, for extraction variable 001, you should not set the
Extended field to Y in one file or table definition and, when you reference
extraction variable 001 in another definition, set the Extended field to N.
Warning:

If you are not consistent in setting the Extended field when
referencing the same extraction variable multiple times, when
you run the job, a run-time (#U) error will be generated, and the
value of the extraction variable will be set to spaces (if the format
is text) or zeroes (if the format is packed decimal).

For more information about extended data, see “Maximum Lengths for
Regular and Extended Data” on page 196

Extraction Variable Definitions
An extraction variable definition consists of its number and description.
The number and the first 42 characters of the description of each extraction
variable you have defined will appear in the Extraction Variables section of
the Job Window. The description can be updated by selecting the variable
from the Job Window and making the change on the Extraction Variables
panel.
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Storing and Saving Extraction Variables
The extraction variables defined when creating file definitions will be saved
when you save the job.
The extraction variables defined when creating an external translation
table will be saved as part of the open job definitions only if Save
extraction variables to job is set to Y on the “Translation Panel” on
page 683. If N is selected, the descriptions associated with the extraction
variables in the translation table will not be stored in the job.
To store the value of an extraction variable in history, assign it to an
internal or extended internal item.

Automatic Generation of Extraction Variable Definitions
Pre-Release 4.1 Jobs
When you open a job created before Release 4.1, definitions for the
extraction variables specified in the file definitions will be generated
automatically and added to the Job Window. Saving the job will move them
to the definition database
Pre-Release 4.1 External Translation Tables
When you open an external translation table created before Release 4.1,
definitions for the extraction variables specified in the table definitions will
be generated automatically and added to the job definitions in the
definition database if Save extraction variables to job is set to Y on the
“Translation Panel” on page 683
Automatically Generated Descriptions
The automatically generated extraction variable description will default to
Vnnn, where V stands for extraction variable and nnn is the extraction
variable number. You can change the automatically descriptions. For more
information, see “Extraction Variables Panel” on page 205.

Extraction Variable Uses
Using Extraction Variables in File Definitions
Extraction variables can store values from the following file definition types
for further processing: field items, embedded keys, total, tally, or hash
records, and detail fields. In a selection field, an extraction variable can be
used to evaluate the current record for selection.
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The following table summarizes extraction variable uses in file definitions:
Access Mode

Definition

Source

Target

1 through 4

Field Item

Input Source

Extraction Variable

1 through 4

Embedded Key1

Extraction Variable

Embedded Key

5

Tally Item

Input Source

Extraction Variable

5

Total Item

Input Source

Extraction Variable

5

Hash Item

Input Source

Extraction Variable

6 and 7

Detail Field

Input Source

Extraction Variable

6 and 7

Detail Field

Extraction Variable

Internal Item

6 and 7

Detail Field

Extraction Variable

Extraction Variable

6 and 7

Selection Field2

Extraction Variable

Selection Criteria

1 The use of extraction variables to store a value from an embedded key and pass it to another embedded key is
called embedded key substitution. Embedded key substitution is explained below.
2 If the input type is extraction variable, the value from the specified extraction variable can be evaluated against one
or more values or ranges. If the input type is Input Area, the value from the input area can be evaluated against the
value of a specified extraction variable.

Using Extraction Variables in External Translation Table
Definitions
An extraction variable can be referenced in an external translation table
definition. For more information, see “Using Extraction Variables in
External Translation Tables” on page 693.

Using Extraction Variables in Embedded Key Substitution
In access modes 1 through 4, extraction variables can be used in embedded
key substitution. This technique provides you with more flexibility in
locating values across multiple input sources.
To use embedded key substitution, in one input source, save a field value as
an extraction variable. Then use the value of that extraction variable as the
value of an embedded key in a second input source.
When defining the embedded key in the second input source, do the
following:

 Enter the position and length of the value in the source file that you
want to be equal to the extraction variable value.
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 In the Use the value of this extraction variable as the
embedded key field, specify the extraction variable number you want
to use. When you view the embedded key definition, the extraction
variable will be in the format (V-nnn), where nnn is the extraction
variable number.

 Because you want to use the extraction variable from the first input
source, be sure to set Reset extraction variables to N in the file
organization panel.
Example of Embedded Key Substitution
This example will use the input sources shown below:
Input Source 1:
1111 abcd
2222 efgh

Input Source 2:
2222 1234
1111 3456

For input source 1, suppose you want to define 1111 as an embedded key and
then pick up the value starting on position 6 on that line. For input source
2, you want to find the value of the embedded key defined in input source 1
and pick up the value starting on position 6 on that line.
To do this, in input source 1, you could set up your definitions as follows:

 Define 1111 as an embedded key by setting the start position to 1 and the
length to 4.

 Use a field value to pick up the value at position 1 for a length of 4 and
assign it to extraction variable 1.

 Use a field value to pick up the value at position 6 for a length of 4 and
assign it to internal item 1.
Your definitions for input source 1 would look like this:
OCC 001 OF EMBEDDED KEY=1111
PICK UP VALUE AT 0001 FOR 04, STORE IN EXTRACTION VAR 001
PICK UP VALUE AT 0006 FOR 04, STORE IN I-001
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In input source 2, you could set up your definitions as follows:

 Define the value of extraction variable 1 as an embedded key. Set the
start position to 1 and the length to 4 because those are the positions in
the input file you want to match to the extraction variable value. In the
Use the value of this extraction variable as the embedded key
field, enter 001, which is the number of the extraction variable you
specified in input source 1.

 Use a field value to pick up the value at position 6 for a length of 4 and
assign it to internal item 2.
Your definitions for input source 2 would look like this:
OCC 001 OF EMBEDDED KEY=(V-001)
PICK UP VALUE AT 0006 FOR 04, STORE IN I-002

Creating New Extraction Variables
Extraction Variables Panel
An extraction variable is defined by completing the Extraction Variables
panel, shown below. This panel can be accessed in the following ways:

 Typical method: When you are creating or revising a file or translation
table definition that references an extraction variable, you can enter the
number of an extraction variable that has not yet been defined, and the
panel will display.

 Select NEW under Extraction Variables in the Job Window.
Extraction Variables
Extraction
variable
001

-------------- Description ------------________________________________________
________________________________________

Number of decimals:

F1=Help
F8=Next

F2=Split
F9=Swap

_

F3=Exit

F4=Retain

F5=Accept

F7=Prev

Extraction variable. This field defaults to a sequentially assigned
number (001-999), but you can change it.
Description. Enter a meaningful description. We recommend that you
indicate in the description whether the extraction variable is in extended
format. This will make it easy to keep an individual extraction variable
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consistently regular or extended when you reference it in file or table
definitions throughout. the job. See “Consistency in Specifying Extended
Format for an Extraction Variable” on page 201.
Number of decimals. This field is useful when extracting mixed decimal
numeric values (field format 1).
Optionally specify the number of decimal places to use when storing the
value.
Leave the field blank if you want the system to use the default (original)
processing, which is as follows: The decimal places from the source will be
ignored and the value will processed as follows:

 For values from non-DB2 input sources, the number of decimals stored
will be 0 for counts and 2 for amounts.

 For floating point values from DB2 input sources, the number of
decimals stored will be the same as the number specified for the
internal or extended internal item with the same item number. To
notify you of this processing, the following warning will be generated if
you leave the field blank when using a DB2 input source:
#UDX073W: EXTRACTION VARIABLE ITEM NO. NO. OF DECIMALS IS
BLANK; THE PRINT DECIMALS FROM THE INTERNAL ITEM/EXTENDED
INTERNAL ITEM WITH THE SAME ITEM NO. WILL BE USED

Extraction Variable List Window
Extraction variables that have been defined are added to a selection list.
You can display the list by pressing F6 from panels where F6=ExtVar is
listed at the bottom of the panel. Below is an example of an extraction
variable list.
Extraction Variable List Window

Row 1 from 3

_
001 EXTENDED - DATE OF TRANSACTION IN EUROPEAN FORMAT
_
002 REGULAR - REGION CODE
_
003 EXTENDED - LAST NAME
********************* Bottom of data **********************

Command Line ===> _______________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

When the list displays, you can do one of the following:

 To reference an existing extraction variable in a file or external
translation table definition, select it from the list.

 To create a new extraction variable, exit the list and reference an
extraction variable number that has not yet been defined. When you do
this, the “Extraction Variables Panel” on page 205 will be displayed.
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Defining History Items
A history item specifies retrieval from the history database of a value that
was stored in a previous run of the current job or of a different job. The
retrieved value can be an internal or extended internal item, job run date,
job run time, or cycle number. A history item allows the value to be used in
calculated items or rules that you define for the current job run.
Up to 999 history items can be specified per job ID.
To access the History Items panel from the Job Window, select NEW under
History Items.
History Items
Item number
001

Infogix Assure? -------------- Description ------------_ (Y/N)
________________________________________
________________________________________
History job ID:
Job name: ________ Item type: I Item number: 000 (I/X: 1-100)
Step name: ________
Qualifier: __
Relative cycle: +000
Generate thru: ____ (-998 to +000)
If item type is run time, convert to centisecond? _ (Y/N)
If item type is cycle number, specify format:
__ 1. YYMMDD
2. MMDDYY 3. MMDDCCYY 4. DDMMYY
5. YYJJJ
6. DDMMCCYY 7. As is
8. CYYMMDD
9. CCYYMMDD 10.CCYYJJJ
Use most recent cycle when cycle does not match current cycle? _ (Y/N)
Specify an action to take when a history is not found:
2_ 1. Set the history item to zero or spaces and continue processing
2. Set all rules involving this item out of balance
3. Skip all balancing rules involving the history item
Set advanced features? N (Y/N) Cross platform history item? N (Y/N)
F1=Help
F8=Next

F2=Split
F9=Swap

F3=Exit

F4=Retain

F5=Accept

F7=Prev

Item number. This defaults to the next consecutive history item number.
We recommend that you let this field increment automatically.
Infogix Asssure. Indicates the type of history item source. By default,
ACR/Summary is the history item source.
Y. Yes, when you want to use Infogix Assure as the history item source.
N. No, when you want to use the default history item source.
Description. Enter a description to be printed on reports unless
overridden at the Basic Job Information level.
History Job ID:
Job name, Step name, Qualifier. Enter the job ID for the job that
stored the internal (or extended internal) item whose value you want to use
for this history item. A mask (*) may be embedded in this field for
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modeling. When model definitions are used, an asterisk causes the
corresponding character from the Job ID to replace the asterisk in the
History Job ID. For more information see “Modeling Job and File
Definitions” on page 639.
Item type. Specify the item type to retrieve. Valid values:
I. Internal item.
X. Extended internal item.
D. Job run date. The print format will be Date.
T. Job run time. The print format will be Count.
C. Cycle number. If the cycle format (see below) is As is, the print format
will be Count. If the cycle format is not As is, the print format will be Date.
Note:

For more on print formats, see Setting the Print Options on page
256.

Item number. If the item type is I or X, enter the item number from the
history database that you want to reference for this history item. Otherwise
leave the field populated with zeros.
Relative Cycle. This field can be used in one of the following ways:

 To specify a single history cycle to be retrieved relative to the current
cycle, enter a cycle. (The current cycle is +000, the previous cycle is 001, the one previous to that is -002 and so forth.)

 To specify that item values from multiple history cycles are to be
accumulated into one history item (this is called cycle accumulation),
enter a number that represents the oldest cycle to be accumulated. (You
will then specify the most recent cycle to be accumulated on the Cycle
Accumulation panel. See “Defining Cycle Accumulation” on page 214.)
Note:

 Cycle accumulation is not applicable to the item types run date,
run time or cycle number.
 When the history job ID is the same as the current job ID (this is
called run-to-run balancing), do not use a Relative Cycle of +000.
Instead, specify -001 to pick up the previous run from the history
database. Otherwise, during a rerun, using +000 will retrieve the
control values from the rerun cycle, yielding incorrect balancing
results.

Generate thru. This field is optional. Valid values are -998 to +000, and
identify the highest cycle to use to generate the history item. If the field is
not blank, a set of consecutive history items are generated. One history item
is generated for each relative cycle specified in the range. The item number
defined in the panel is used to generate the first history item.
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If item type is run time, convert to centisecond.
Y. Yes, if you want to convert the retrieved run time to a centisecond value.
N. No, if you want to retain the value of the retrieved run time.
If item type is cycle number, specify format. If the item type is C,
complete this field.
Use most recent cycle when cycle does not match current cycle?
Indicates how the relative cycle is to be interpreted when an exact cycle ID
match is not found for the relative cycle, as follows:
Y. Yes, when an exact cycle ID match is not found, you want to use the most
recent history record that is less than the cycle ID as the +000 relative cycle.
Subsequent relative cycles are then based from this history. For example, 001 becomes the previous history.
N. No, when an exact cycle ID match is not found, the starting point will not
be readjusted. The first history less than the current cycle will be -001.
Specify an action to take when a history is not found. Indicates
what will be done if the item is not in the history database. Missing items
display the message **NOT IN FILE** for a missing history key or
**VARIABLE CYCLE** **NOT IN FILE** for a missing variable cycle
history key on the Control Report.
1. Set the history item to zero or spaces and continue processing. The

item is not required for an in-balance condition. The rule is evaluated
with the missing item set to 0 if it is a numeric item or spaces if it is a
text item.
2. Set all rules involving this item out of balance. The item is required

for an in-balance condition. Rules containing the missing item will be
set to out-of-balance.
3. Skip all balancing rules involving the history item. Any rule using

this item will be ignored if this item is missing.
Note:

When a rule uses an internal (or extended internal) item, history
item or calculated item that is missing, the rule stores the indicator
value for that item. After all items are processed, the indicator with
the highest order of precedence is used to determine how to
process the rule. See Rule Processing When Item Is Not Found on
page 245.

Set advanced features? Options:
Y. After you complete the panel and press F4 or F5 (see below), the
“Advanced History Features Panel” on page 210 will be displayed.

ACR/Summary User Guide for z/OS

209

6  Creating Job Definitions
Defining History Items

N. Does not display a panel for setting up advanced history features.
Is this a cross platform history item? If you are using ACR/
Connector, enter Y if the history item will be retrieved from a history
database associated with another server node. After you complete this
panel and press F5, a list of server nodes will be displayed so you can select
the one that corresponds to the cross platform history item.
If you want to create additional history items, press F4 to remain in the
history item function. This will increment the item number and retain the
values. Edit as appropriate to create the new history item.
Otherwise Press F5.

Advanced History Features Panel
If you chose to set advanced features on the History Item panel, the
Advanced Features panel displays.
Advanced History Features
Select features to access:
_ Variable cycle...
_ Cycle accumulation...
_ Equal cycle comparison...

F1=Help

F2=Split

F3=Exit

F9=Swap

Select features to access. See the following sections:

 Variable cycle. See "Defining Variable Cycle Processing".
 Cycle accumulation. See “Defining Cycle Accumulation” on page 214.
 Equal cycle comparison, See “Defining Equal Cycle Comparison
Options” on page 215.
Press Enter.
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Defining Variable Cycle Processing
If you selected Variable cycle from the Advanced History Features panel,
the Variable Cycle panel displays. Variable cycle processing allows you to
control the retrieval of history items based on the run date and time and
cycle ID of another job. For a comprehensive explanation, see
“Understanding Variable Cycle Processing” on page 427.
Variable Cycle
Variable cycle indicator:
1
1. Variable cycle processing not in effect
2. Compared to cycle ID and most recent run date and time
3. Compared to most recent run date and time
4. Compared to most recent cycle number
Variable cycle information:
Job name: ________
Step name: ________
Qualifier: __
Relative cycle: +000

(-998 to +000)

Most recent indicator:
2_ 1. Use most recent
2. Exact match only
Is this a variable cycle cross platform(XP) history item? N
F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

Variable cycle indicator. Specify the criterion for determining whether
the retrieved history item should be used in the current job. Options:
1. Variable cycle processing not in effect. Do not use variable cycle

processing in the current job.
2. Compared to cycle ID and most recent run date/time. Use this option

when your balancing jobs use the same cycle ID format and it is
possible that the retrieved history item cycle ID could be the same as
the current job cycle ID. This option will use a retrieved history item
for balancing if either of the following is true:

 The retrieved history item cycle ID is greater than the variable cycle
history job’s cycle ID.

 The cycle IDs are equal and the run date and time of the retrieved
history item is greater than the run date and time of the variable
cycle history job’s cycle ID.
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3. Compared to most recent run date and time. Use this option if the

current job and the job that stored the history item do not store history
in the same cycle number format. For example, if one format is
Gregorian and the other format is Julian. This option will use a
retrieved history item for balancing if its run date and time are greater
than the run date and time of the variable cycle job ID.
When you choose this option, the processing logic is different:

 When filtering in history records for external item and variable
cycle, histories will not be filtered based on cycle number.

 The Variable Cycle Most Recent Indicator will not be used.
 The Equal Cycle Comparison has no effect since Compared to
most recent run date and time will not exclude histories based
on cycle number.
If you select this option, the message **VALUE IGNORED** will be
displayed instead of the message **NOT IN FILE** if the relative
history cycle is in the database, but it fails the variable cycle selection
criteria. For example, if the Relative cycle is -001, and the -001 cycle
fails the most recent run date/time check, the **VALUE IGNORED**
message will be displayed, because although the -001 cycle was found,
the run date and time was not greater than that of the variable cycle job
ID.
4. Compared to most recent cycle number. Use this option if you always

want to retrieve history items from prior cycles. This option is intended
for those situations where both of the following are true:

 You use the date for the cycle number.
 If the source job runs on the same day, you do not want the history
item.
This option will use a retrieved history item for balancing if its cycle
number is greater than the cycle number of the variable cycle history
job.
Variable cycle information:
Job name/Step name/Qualifier. Enter the job ID of the variable cycle
job.
Relative cycle. Identifies the specific history cycle for the variable cycle
job ID. A relative cycle of +000 refers to the current cycle -001 refers to the
previous cycle, -002 to the cycle before that, and so forth.
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Most recent indicator. Indicates how the relative cycle is to be
interpreted when an exact cycle ID match is not found for the relative cycle,
as follows:
1. Use most recent. When an exact cycle ID match is not found, you want

to use the most recent history record that is less than the cycle ID as
the +000 relative cycle. Subsequent relative cycles are then based from
this history.
2. Exact match only. When an exact cycle ID match is not found, the

starting point will not be readjusted. The first history less than the
current cycle will be -001.
Is this a variable cycle cross platform history item? If you are using
ACR/Connector and the variable cycle record information must be
retrieved from a history database associated with another server node in
your ACR/Connector network, enter Y. If you have not specified the domain
file name for ACR/Connector, see “Specifying the ACR/Connector Domain
Table” on page 43. You will then be able to select the node from the domain
name list after you complete and accept your entries on this panel.
Press F5 to accept.
If you answered Y to Is this a variable cycle cross platform history item?,
a list of server nodes will be displayed so you can select the one associated
with the history database from which the variable cycle information must
be retrieved. Otherwise the Job Window displays.
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Defining Cycle Accumulation
If you selected Cycle accumulation on the Advanced History Features
panel, the Cycle Accumulation panel displays. Cycle accumulation allows
you to specify that the system should accumulate internal item or extended
internal item values from multiple runs into one history item. For example,
you could use this feature to retrieve and accumulate all occurrences of a
daily job and compare the total to the weekly result.
Cycle Accumulation
Specify
3_ 1.
2.
3.

a cycle accumulation option:
Retrieve from the relative cycle thru the -001
Retrieve from the relative cycle thru the +000
Do not perform cycle accumulation

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify a cycle accumulation option. Indicate the most recent cycle in
the range of cycles you wish to accumulate. After you read the definitions,
see “Scenarios” on page 215 below to help determine which option to select.
1. Retrieve from the relative cycle thru the -001. Accumulate all item

values from the Relative Cycle specified above through relative cycle
-001.
2. Retrieve from the relative cycle thru the +000. Accumulate all item

values from the Relative Cycle specified above through relative cycle
+000.
3. Do not perform cycle accumulation. Use this option to turn off cycle

accumulation processing that you specified previously.
Press F5 to accept. The Job Window displays.
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Scenarios
These scenarios will be helpful if you want to retrieve and accumulate all
occurrences of a daily job and compare the total to the weekly result
Scenario 1
If the weekly job runs with the same cycle ID as that of the last daily job, you
can specify cycle accumulation option 2 (Retrieve from the relative cycle
through the +000) and set the Relative cycle to -004. The system will
retrieve and accumulate daily cycles +000, -001, -002, -003, and -004.
Scenario 2
If the weekly job runs with a cycle ID greater than that of the last daily job,
you can do either of the following:

 Specify cycle accumulation option 1 (Retrieve from the relative cycle
through the -001), set the Relative cycle to -005 and set the Most
recent indicator to 2 (Exact match only). The system will retrieve
and accumulate daily cycles -001, -002, -003, -004, and -005.

 Specify cycle accumulation option 2 (Retrieve from the relative cycle
through the +000), set the Relative cycle to -004, and set the Most
recent indicator to 1 (Use most recent). The system will retrieve and
accumulate daily cycles +000, -001, -002, -003, and -004.

Defining Equal Cycle Comparison Options
From the Advanced History Features panel, select Equal Cycle Comparison
to display the Equal Cycle Comparison panel. This feature allows you to
override the date/time check normally imposed on history items when a
rerun occurs, thus avoiding the need for a delete and another rerun.
Equal Cycle Comparison
Specify an option:
__ 1. If the current job is a rerun, ignore the original
date/time
2. Future histories are not allowed

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify an option. Indicate whether you want to override the normal run
date/time checks when retrieving history.
1. If the current job is a rerun, ignore the original date/time. The

system will override the normal run date/time checks when retrieving
history. If the cycle numbers are equal, history will be extracted.
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2. Future histories are not allowed. The system will perform the normal

run date/time checks when retrieving history. History items with a run
date and time greater than the current job’s original date/time for the
cycle will be ignored, and the message HISTORY ITEM NOT FOUND
will appear.
Press F5 to accept.

Equal Cycle Comparison Example
Suppose two jobs run nightly, as follows: 1) At 10:00, Job A runs and stores
history, and 2) at 11:00, Job B runs and retrieves history from job A.
When processing is normal, the Equal Cycle Comparison feature is not
relevant, but what if you have the following problem situation?
1. At 10:00, Job A does not start.
2. At 11:00, Job B starts and attempts unsuccessfully to retrieve history

from Job A.
3. At 11:30, Job A runs and stores history.
4. At 12:00, Job B is rerun and attempts to retrieve history from Job A.

Equal Cycle Comparison Option is 1
When you use Equal Cycle Comparison option 1 (If the current job is a
rerun, ignore the original date/time), in a rerun situation, the date/time
check is omitted and Job B successfully retrieves history from Job A, even
though the original run date and time of Job B is earlier than the run date
and time of Job A. There is no need to delete the original run of Job B.
Equal Cycle Comparison Option is 2
When you use Equal Cycle Comparison option 2 (Future histories are not
allowed), the date/time check is always performed. Because the original
run date and time of Job B is earlier than the run date and time of Job A,
history retrieval is not allowed.
The message HISTORY ITEM NOT FOUND will be generated, and you
must delete the original run of Job B and rerun the job again.
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Infogix Assure History Item
To access the Infogix Assure History Item panel from the Job Window,
enter Y as the Infogix Assure option in the “Defining History Items” on
page 207 panel, and press F5.
Infogix Assure History Item
Item number
-------------- Description ------------084
________________________________________
________________________________________
Control Entity: ________________________________________
Field name: ________________________________________
Relative cycle: -001 Generate thru:
(-998 to +000)
Cycle referencing method:
Most recent indicator:
1
1. Relative cycle
2
1. Use most recent
2. Relative cycle range
2. Exact match only
3. Variable cycle range
Print the item value:
1
1. In the left column of the control report
2. In the right column of the control report
Specify an action to take when a history is not found:
2
1. Set the history item to zero or spaces and continue processing
2. Set all rules involving this item out of balance
3. Skip all balancing rules involving the history item
F1=Help
F2=Split
F3=Exit
F4=Retain
F5=Accept
F7=Prev
F8=Next
F9=Swap

Item number. This defaults to the next consecutive history item number.
We recommend that you let this field increment automatically.
Description. Enter a description to be printed on reports unless
overridden at the Basic Job Information level.
Control Entity. Enter the name of the control entity to retrieve this
history item.
Field name. Enter the control field name that stores the value in the
history database. If the Item Type entered in the following panel (“Infogix
Assure History Item - Relative Cycle” on page 220) is not Control Field,
leave the field blank.
Relative Cycle. This field can be used in one of the following ways:

 To specify a single history cycle to be retrieved relative to the current
cycle, enter a cycle. (The current cycle is +000, the previous cycle is 001, the one previous to that is -002 and so forth.)

 To specify the oldest cycle to perform the function.
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Generate thru. This field is optional. Valid values are -998 to +000, and
identify the highest cycle to use to generate the history item. If the field is
not blank, a set of consecutive history items are generated. One history item
is generated for each relative cycle specified in the range. The item number
defined in the panel is used to generate the first history item.
Cycle referencing method: Specify the cycle referencing method to retrieve
the history data.
1. Relative cycle. This referencing method retrieves values from an

individual cycle run.
2. Relative cycle range. This referencing method retrieves values from

multiple sequential cycles.
3. Variable cycle range. This method references a second control

entity, and retrieves data for cycles that match with the second control
entity.
Most recent indicator: Indicates how the relative cycle should be
interpreted.
1. Use most recent. If a history record is not found with a cycle ID

equal to the current cycle ID, the history record most recent to and less
than cycle ID is used as the +000 relative cycle. The subsequent
relative cycles are then based from this history (e.g., -001 becomes the
previous history to this).
2. Exact match only. By default, this is the most recent indicator. The

starting point is not adjusted. The first history less than the current
history is -001. Only an exact match on the cycle is considered the
+000.
Print the item value. Specify where the history item must be printed in
the Control Report.
1. In the left column of the control report. Prints the item in the left

column of the report. By default, the column heading is INPUT.
2. In the right column of the control report. Prints the item in the right

column of the report. By default, the column heading is OUTPUT.

218

Infogix, Inc.

Creating Job Definitions  6
Infogix Assure History Item

Specify an action to take when a history is not found. Indicates
what will be done if the item is not in the history database or an error is
encountered during history retrieval.
1. Set the history item to zero or spaces and continue processing. The

item is not required for an in-balance condition. The rule is evaluated
with the missing item set to 0 if it is a numeric item or spaces if it is a
text item.
2. Set all rules involving this item out of balance. The item is required for

an in-balance condition. Rules containing the missing item will be set
to out-of-balance.
3. Skip all balancing rules involving the history item. Any rule using this

item will be ignored if this item is missing.
Note:

When a rule uses an internal (or extended internal) item, history
item or calculated item that is missing, the rule stores the indicator
value for that item. After all items are processed, the indicator with
the highest order of precedence is used to determine how to
process the rule. See Rule Processing When Item Is Not Found on
page 245.

If you want to create additional Infogix Assure history items, press F4
to remain in the history item function. This will increment the item
number and retain the values. Edit as appropriate to create the new
Infogix Assure history item.
Otherwise Press F5.
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Infogix Assure History Item - Relative Cycle
To access the Infogix Assure History Item - Relative Cycle panel from the
Job Window, select Relative cycle as the referencing method in the Infogix
Assure History Item panel.
Infogix Assure History Item – Relative Cycle
Control point name: __________________________________________
Item type:
1
1. Control field
2. Extended control field
3. Update date
4. Update time
5. Cycle number
Print format:
1 1. Count
2. Amount
3. Date
4. Text
5. Time
6. Date & Time
Print commas?
1 1. Default 2. Print
3. Do not print
Print decimals: _ Print leading zeros? N (Y/N)
It item type is update time, convert to centisecond?
(Y/N)
If item type is cycle number, specify format:
_ 1. YYMMDD
2. MMDDYY 3. MMDDCCYY 4. DDMMYY
5. YYJJJ
6. DDMMCCYY 7. As is
8. CYYMMDD
9. CCYYMMDD 10.CCYYJJJ
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

Control point name. Specify the control point name that has the data
you wish to retrieve. The field is applicable for the control field and
extended control field item types only. If the field is blank, the value from
the current control point is retrieved.
Item type:
The field identifies the type of history item retrieved. The valid item types
are:
Control field. By default, the item type is control field.
Extended control field. Select this item type when the control value has
more than 8 characters or 15 digits.
Update date. Control entity last updated date. The print format is Date.
Update time. Control entity last updated time.
Cycle number. If the cycle format is As is, the print format will be Count.
If the cycle format is not As is, the print format will be Date.
Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 256 for more information.
If the field type of the control field is specified as ‘Date’ in Infogix Assure,
data will be extracted according to the specified Print Format. If the Print
Format is ‘Date’, the date portion of the returned value will be extracted. If
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the Print Format is ‘Time’, the time portion will be extracted. If the Print
Format is ‘Date & Time’, the entire returned value (timestamp) will be
extracted.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 256.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.The “Print commas”
indicator must be disabled when “Print Leading Zeros” is enabled.
See “Processing of Print Leading Zeros Indicator” on page 194 for more
information.
If item type is update time, convert to centisecond.
Y. Yes, if you want to convert the retrieved time to a centisecond value.
N.No, if you want to retain the value of the retrieved time.
If item type is cycle number, specify the format. If the item type is a
cycle number, complete this field.
Press F5 to accept.
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Infogix Assure History Item - Relative Cycle Range
To access the Infogix Assure History Item - Relative Cycle Range panel
from the Job Window, select Relative cycle range as the referencing method
in the Infogix Assure History Item panel.
Infogix Assure History Item – Relative Cycle Range

To relative cycle:

(-998 to +000)

Item type:
1
1. Control field
2. Extended
control field

Function:
1
1. Sum
2. Average
3. Count
4. Maximum
5. Minimum
6. Standard deviation (sample)
7. Standard deviation (population)

Print format:

1

1. Count
4. Text

2. Amount
5. Time

3. Date
6. Date & Time

Print commas?

1

1. Default

2. Print

3. Do not print

Print decimals: _
F1=Help

Print leading zeros?

F2=Split

F3=Exit

N

(Y/N)

F5=Accept

F9=Swap

To relative cycle. Specify a 3-digit number to identify the highest history
cycle to perform the function.
Item type:
The field identifies the type of history item retrieved. The valid item types
are:
Control field. By default, the item type is control field.
Extended control field. Select this item type when the control value has
more than 8 characters or 15 digits.
Function. Specify the function you want to perform on the retrieved
cycles.
Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 252 for information on the options.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 252.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
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Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.The “Print commas”
indicator must be disabled when “Print Leading Zeros” is enabled.
See “Processing of Print Leading Zeros Indicator” on page 194 for more
information.
Press F5 to accept.

Infogix Assure History Item - Variable Cycle Range
To access the Infogix Assure History Item - Variable Cycle Range panel
from the Job Window, select Variable cycle range as the referencing
method in the Infogix Assure History Item panel.
Infogix Assure History Item – Variable Cycle Range
To relative cycle:

(-998 to +000)

Item type:
1
1. Control field
2. Extended
control field

Print format:

1

Print commas?
1
Print decimals: _

Function:
1
1. Sum
2. Average
3. Count
4. Maximum
5. Minimum
6. Standard deviation (sample)
7. Standard deviation (population)
1. Count
2. Amount
3. Date
4. Text
5. Time
6. Date & Time
1. Default 2. Print
3. Do not print
Print leading zeros? N (Y/N)

Variable cycle information:
Control entity:
Relative cycle:
(-998 to +000)
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

To relative cycle. Specify a 3-digit number to identify the highest history
cycle to perform the function.
Item type:
The field identifies the type of history item retrieved. The valid item types
are:
Control field. By default, the item type is control field.
Extended control field. Select this item type when the control value has
more than 8 characters or 15 digits.
Function. Specify the function you want to perform on the retrieved
cycles.
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Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 252 for information on the options. The Print
Format field should match the format specified in the items contained
within the formula. The decimal places in the individual items do not have
to match.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 252.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.The “Print commas”
indicator must be disabled when “Print Leading Zeros” is enabled. See
“Processing of Print Leading Zeros Indicator” on page 194 for more
information.
Variable cycle information.
Control entity. Specify the control entity to reference when you
determine the history cycles to retrieve for variable cycle processing.
Relative cycle. Specify the relative cycle of interest for the variable control
entity. Only the histories with the cycles that match those available for the
control entity are retrieved.
Press F5 to accept.

Defining Calculated Items
A calculated item specifies mathematical manipulation of values from
internal (or extended internal) items, history items, other calculated items,
literals (numeric constants or text), or functions. Calculated items can be
used in rules in the same way as internal items, extended internal items,
and history items.
Calculated items can be conditional or non-conditional. When a nonconditional calculated item is used in a reconciliation rule, the calculation
is performed before the rule is evaluated. A conditional calculation is
performed after rules are evaluated. For more on conditional calculated
items, see below.
The values of calculated items are not stored in history. If you want to store
the value of a calculated item in the history database, you must assign it to
an internal (or extended internal) item.
Up to 100 calculated items can be specified per job ID.
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Formula
The formula for computing the value of a calculated item is defined ion the
Calculation Rule section of the Calculated Items panel as the following
arithmetic expression:
LHS (Left-hand side)

Calculation Operator

RHS (Right-hand side)

Conditional Calculated Items
A calculated item can be conditional. To make it conditional, set the Will
this be a conditional calculated item? field to Y on the Calculated
Items Panel. This means it will be processed only if one of the following is
true:

 The standard rule that references it in the Standard Rules panel’s
Calculated item to process field is processed and is in balance.

 The conditional rule that references it in the Conditional Rules panel’s
Calculated item to process field is processed when the condition is
met.
See the section below for the messages that may be generated.

Messages Generated When a Calculated Item is Not Processed
When a conditional calculated item is not processed, one of the following
messages will appear in the Control Report:

 BYPASSED. This indicates that 1) the standard rule that referenced the
calculation was not in balance, or 2) the conditional rule that referenced
the calculation was processed but the condition was not met.

 NOT PROCESSED. This indicates that the Calculated item to process
field on the Calculated Items panel was set to Y but the item was not
referenced in a rule.

 INACTIVE. This indicates that the standard or conditional rule in
which the item was referenced remained inactive.
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To access the Calculated Items panel, from the Job Window, under
Calculated Items, select New. The following example shows the definition
for a calculated item.
Calculated Items
IItem number: 001 Will this be a conditional calculated item (Y/N)? N
-------------------------- Calculation Rule -----------------------LHS: ________________________________________________________________
________________________________________________________________
Calculation operator: +
(+, -, *, /, >, A+, A-, %)
RHS: ________________________________________________________________
________________________________________________________________
Description: ________________________________________
________________________________________
If @CYCLE is used, specify format:
1. YYMMDD
2. MMDDYY 3. MMDDCCYY 4. DDMMYY
5. YYJJJ
6. DDMMCCYY 7. As is
8. CYYMMDD
9. CCYYMMDD 10.CCYYJJJ
Print format:
1 1. Count 2. Amount 3. Date 4. Time 5. Date & Time
Print commas?
1 1. Default
2. Print
3. Do not print
Required Item? 2 1. Required 2. Not Required 3. May Skip
Print decimals: _
Print leading zeros? N (Y/N)
F1=Help
F2=Split
F3=Exit
F4=Retain
F5=Accept
F6=Items
F7=Prev
F8=Next
F9=Swap
F10=TimeCsec

Item Number. Number (1–100) that uniquely identifies the calculated
item.
Calculation Rule:
Will this be a conditional calculated item. Enter Y if you are going to
reference this item in the Calculated item to process field of a standard
or conditional rule. This makes the calculated item conditional. For more
information, see “Conditional Calculated Items” on page 225.
RHS/LHS. Right-hand side or left-hand side of the expression. On either
side, you can enter a literal (numeric constant) or up to 15 items specified
as 3-character fields. On the right-hand side only, you can enter a function.
The 15 items can be any combination of internal, extended internal, history,
and/or calculated items to be summed up.

 A numeric constant is a positive or negative number (if the number is
positive, the sign in the first position is optional) consisting of up to 30
digits, up to 9 of which can be decimal places. Only one numeric
constant is allowed per side, and it must be the only entry on that side.

 “Date & Time” item is allowed in the LHS and RHS of a Calculated Item.
Date & Time item is a combination of a date item and a time item. Date
& Time item must be entered in the following format: ITEM1 & ITEM2
(e g I-001 & I-002).
Where, ITEM1 stores the date count value, and ITEM2 stores the
centisecond count.
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 If you want to enter a time value in centisecond, press F10 to convert
time in the HHMMSSNN format to a centisecond value.

 To select from a list of the items you have defined for this job, press F6
or type in the item number.

 You can use a function only on the right-hand side. The operator must
be > (input to). You specify a function to which the left-hand side is
input. The functions are as follows:

 @DATE. The left hand side value is a literal, an internal item, or an
extended internal item defined as a count containing a numeric
Gregorian date in the format CCYYMMDD. The entire date,
including century, year, month, and day, is converted into a date
count value. Use this feature for date comparisons or other
calculations. For example, you can determine aging by subtracting
the original date from the current date. The literal +99999999 can
be used to obtain the date count value for the current date. Century
positions will print only if you specify this in the user options.

 @DAY. The left-hand side contains a date count value from which
the DD Gregorian value should be extracted. The two-digit day is
converted into a value that can be used mathematically. Use this
function to find the day of the month in order to set a range in a
comparison.

 @MONTH. The left-hand side contains a date count value from
which the MM Gregorian value should be extracted. The result is
multiplied by 100 (for example, a date in May would result in a value
of 500). This function converts the month into a value that can be
used mathematically. Use this function to find the month of
processing. It can be added to the @DAY value to create a date.

 @YEAR. The left-hand side contains a date count value from which
the CCYY Gregorian value should be extracted. The result is
multiplied by 10,000 (for example, a date in 2012 would result in a
value of 20120000). This function converts the year into a value
that can be used mathematically. Use this function to extract a year
for comparisons. Can be added to month and day to form a date.
This function can be used to indicate a range.

 @TIME. The left-hand side requires a literal +999999. The function
returns the current time. Use this function with another calculation
to determine the time since the last run.
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 @DAYOFWK. The left hand side value is a literal, an internal item,
or an extended internal item defined as a count containing a
numeric Gregorian date in the format CCYYMMDD. The literal
+99999999 can be used as the current date (today). The value
returned will be a number representing the day of the week:
1=Monday, 2=Tuesday, 3=Wednesday, 4=Thursday, 5=Friday,
6=Saturday, 7=Sunday. Use this function to determine the day of
the week for checking the proper processing date.

 @TIMECSEC. The left hand side contains a time value in the
HHMMSSNN format. It can be a literal or an item. Use this function
to convert the time value to a centisecond value.
If the value is not a valid time, zero is substituted during
reconciliation. The allowed Print Formats for the function are
Count, Time, Date & Time.

 @DTTMCSEC. The left hand side requires a literal +99999999.
This function returns the centisecond value of the current date and
time of the job.
The allowed Print Formats for the function are Count, Time, Date
& Time.

 @CYCLERUN. The left hand side contains a count or an item. This
value will be added to the cycle ID. Cycle ID is a combination of cycle
number and run number.
The allowed Print Format for the function is Count.

 @CYCLE. The left hand side contains a positive or negative count (a
number of days), which can be either 1) a literal, or 2) an item value.
This value will be added to the cycle number. To use the cycle
number with no addition, enter +0 on the left hand side.

 If the print format is Date, the cycle format “As is” is not
allowed, because the result is stored as a date count value.

 If the print format is Count and the cycle format is not As is, the
result is printed in the cycle format you specify.

 If the print format is Count and the cycle format is As is, the
result is stored as a count value.
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The following table shows that, when you use the @CYCLE function,
different print formats will yield different results. Here, the cycle number is
07312012 and the date format in user options is MM/DD/YY.
Report
Display with
User Option
MM/DD/YY

Calculation
Formula

Cycle
Number
Format

Print
Format

Calculation Result (Internally
Stored As)

+1 > @CYCLE

MMDDCCYY

Date

The cycle number value will be
converted to the date count value
150327 before the calculation
(150327 + 1). The resulting date
count, 150328, will be converted to
a date in MMDDYY format.

08/01/12

+1 > @CYCLE

MMDDCCYY

Count

The cycle number value will be
converted to the date count value
150327 before the calculation
(150327 + 1). The resulting date
count,150328, will be converted to
MMDDYY format. The leading
zero is suppressed for a count.

8012012

+1 > @CYCLE

Accept as is

Count

The cycle value will be used
without conversion. After the
computation 07312012 + 1, the
resulting value (7312013) will be
stored in the calculated item. The
leading zero is suppressed for a
count.

7312013

 @MAXIMUM. Returns the maximum value in a list, or from a range
of specified items.

 The left hand side contains a list or a range of items used to
compute the function. Text items within the range are skipped
during processing.

 List of items are entered as I-001 & E-001 & X-003
 Range of items are entered as I-001 : I-010
 Items specified in a range should be of the same item type. Valid
item types include Internal Items, Extended Internal Items,
History Items, and Calculated Items.
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 @MINIMUM. Returns the minimum value in a list, or from a range
of specified items.

 The left hand side contains a list or a range of items used to
compute the function. Text items within the range are skipped
during processing.

 List of items are entered as I-001 & E-001 & X-003
 Range of items are entered as I-001 : I-010
 Items specified in a range should be of the same item type. Valid
item types include Internal Items, Extended Internal Items,
History Items, and Calculated Items.
Calculation Operator. The operator to be used in calculations. Options:
+ Add the LHS to the RHS. (This option is the default.)
- Subtract the RHS from the LHS.
* Multiply the LHS by the RHS.
/ Divide the LHS by the RHS.
> The LHS value is input to the RHS function.
A+ Add the LHS to the RHS and compute the positive absolute
value of the result.
A- Add the LHS to the RHS and compute the negative absolute
value of the result.
% The left-hand side value is a percentage of the right-hand side.
Description. Description of the calculated item.
If @CYCLE is used, specify format. If you are using the @CYCLE
function, specify the cycle format.
Print format. Format for printing the item on reports. See “Setting the
Print Options” on page 256 for information on the options. The Print
Format field should match the format specified in the items contained
within the formula. The decimal places in the individual items do not have
to match.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 256.
Required Item. Indicates what will be done if this item is not extracted.
1. Required. The item is required for an in-balance condition. All rules

containing the missing item will be set to out-of-balance. The message
**KEY NOT FOUND* (ITEM NOT EXTRACTED for access modes 6
and 7) displays on the Control Report.
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2. Not required. The item is not required for an in-balance condition. The

rule is evaluated with the missing item set to 0 if it is a numeric item or
spaces if it is a text item. The item value will display as 0 on the Control
Report.
3. May Skip. Skip all rules involving this item. Any rule using this item

will be ignored, and the message **KEY NOT FOUND* (ITEM NOT
EXTRACTED for access modes 6 and 7) displays on the Control
Report.
Note:

When a rule uses an internal (or extended internal) item, history
item or calculated item that is missing, the rule stores the indicator
value for that item. After all items are processed, the indicator with
the highest order of precedence is used to determine how to
process the rule. See Rule Processing When Item Is Not Found on
page 245.

Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
Print leading zeros. Indicate whether to print the leading zeros on
reports. The supported Print Format is ‘Count’.The “Print commas”
indicator must be disabled when “Print Leading Zeros” is enabled. See
“Processing of Print Leading Zeros Indicator” on page 194 for more
information.
When you have completed the panel, you can do one of the following:

 If you want to create additional calculated items, press F4 to remain in
the calculated item function, accept the original calculated item,
increment the item number, and retain the field values so you only need
to change the values that make the new calculated item unique.

 Press F5 to accept and exit.

Defining Rules
Rules define the criteria to be applied to the values of internal (or extended
internal) items, calculated items, and/or history items to determine if
values extracted from an input source are in or out of balance.
A job may need to have up to 100 rules defined to determine if a variety of
values are in balance. (If you need multiple sets of rules, you can have up to
10 sets of 100 rules each. See “Using Alternate Balancing Rules” on
page 245.) If one or more rules are out of balance, the entire job is
considered out of balance.

ACR/Summary User Guide for z/OS

231

6  Creating Job Definitions
Defining Rules

Typically, you will want to have a rule set a return code for an out-ofbalance condition and create a text message associated with the return
code. Return codes and the messages you associate with them appear on the
Control Report.
Two types of rules can be defined, as described in the following sections:

 “Defining Standard Rules” on page 232
 “Defining Conditional Rules” on page 238

Defining Standard Rules
A standard rule compares values from any combination of internal,
extended internal, calculated, and history items to determine if they are inor out-of-balance.
The comparison for a standard rule has the following format:
Left-hand side

Operator

Right-hand side

You can optionally use, on one side or the other (but not both) of the
comparison, either a literal or a numeric constant. Standard rules can be
either active or inactive.
To learn more about standard rules, see the following sections:

 “Active Standard Rules” on page 232
 “Inactive Standard Rules” on page 233
To go directly to the standard rules panel, see “Completing the Standard
Rules Panel” on page 233.

Active Standard Rules
An active standard rule defines criteria for a comparison (using items,
literals, and constants as described above) that is evaluated when balancing
is performed. The status of an active standard rule can also be evaluated by
conditional rules. If the result is out-of-balance, a standard rule can
perform one of the following actions:

 Set the return code as specified in the Set Return Code option on the
Basic Information screen.

 Set the 4-digit code of your choice as the completion code for the job. If
more than one rule is out-of-balance, the highest code will be set.

 Trigger an abend of the job.
Following are examples of active standard rules:
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I-001 = X-002, set an abend code
I-001 > +100, set a return code of 3075
I-001 + C-001 < E-003, set a return code of 3200
If the rule is in-balance, activate a conditional calculated item.

Inactive Standard Rules
Inactive standard rules are not evaluated each time a job is run. They are
used when control items must be compared under specific circumstances.
Inactive standard rules can only be evaluated within a conditional rule. The
criteria of the condition is defined by the conditional rule.
Inactive standard rules can:

 Evaluate control items in a balancing job. Using an inactive standard
rule in the left side of a conditional rule equation will evaluate the
criteria defined by the inactive standard rule.

 Perform an action in a balancing job. Using an inactive standard rule in
the process rules section of a conditional rule equation activates the
rule, causing it to perform as an active standard rule.
Following are examples of inactive standard rules:
R001: I-002 > $50,000
R002: I-011 > +90

Completing the Standard Rules Panel
Select Rules > New > Standard to display the Standard Rules panel.
Rule number. Defaults to the next available number. We recommend
that you let this field increment automatically.
Alternate Balancing Rule. Enter Y if you are using alternate balancing
rules. You will then be allowed to enter a rule number higher than 100. For
more information, see “Using Alternate Balancing Rules” on page 245.
LHS/RHS. Left-hand side/Right-hand side (of the comparison). The
following information applies to both the LHS and RHS:
Enter a literal, numeric constant, or any combination of up to 15 internal,
extended internal, history, or calculated items.

 A text literal is a text string of up to 80 characters prefaced by a single
quotation mark (for example, '05/05/12). No ending quotation mark is
used. Only one literal is allowed per side, and it must be the only entry
on that side.
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 A numeric constant is a positive or negative number (if the number is
positive, the sign in the first position is optional) consisting of up to 30
digits, up to 9 of which can be decimal places. Only one numeric
constant is allowed per side, and it must be the only entry on that side.

 Range comparison can be specified in the RHS. Range comparison
works only with history items.
A rule using range comparison would be E-xxx : E-yyy.
If range comparison is specified on the RHS, a set of consecutive rules
are generated. One rule is generated for each history item specified in
the range. The item number defined in the panel is used to generate the
first rule.

 If you want to enter a time value in centisecond, press F10 to convert
time in the HHMMSSNN format to a centisecond value.

 To select internal items, extended internal items, history items, or
calculated items, enter the item directly or press F6 to select from a list
of the items defined for the job. Acceptable formats for item numbers
include I-001 and I-1 but not I1. If your operand contains more than
one item, the items must be linked with plus (+) or minus signs (-).
Balancing Operator. Specifies the relationship between the LHS and
RHS when the rule is in balance.








EQ. LHS should equal RHS.
NE. LHS should not equal RHS.
GT. LHS should be greater than RHS.
LT. LHS should be less than RHS.
GE. LHS should be greater than or equal to RHS.
LE. LHS should be less than or equal to RHS.

Description. Description that will appear on the Control Report and in
the Job Window.
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Return Code. 4-digit return code that should be generated if the rule is
out of balance. Codes between 0050 and 3999 are recommended because
they do not duplicate system-generated codes. Defaults to 0000. If the
highest return code issued by any rule within your job is 0000, the job will
be reported as in balance. Otherwise the job will be out of balance.
Note:

If you are defining an inactive rule, it will not set a return code if it is
out of balance and it is included on the left-hand side (in the
Evaluate field) of a conditional rule. However, its status will print on
the Control Report. Inactive rules can set a return code if they are
out of balance and they are on the Process Rules field of a
conditional rule.

Is rule active? Determines if the rule will be active or inactive.
If setting a completion code of 0000 is the default action specified for the
current job on the Set Return Code panel (see the section entitled “Set
Return Code” on page 163), you also need to specify Rule Action option 2 or
3 instead of accepting the default.
Set Tolerance? Enter Y if the Balancing operator is EQ to use the
tolerance or skip processing features (the operator in the equation must be
EQ.) This allows a rule to be in balance even if the LHS and RHS are not
exactly equal. See “Tolerance/Skip Processing Panel” on page 236.
Calculated item to process. Optionally enter the number of a calculated
item that will be processed if this rule is in balance. This type of calculated
item is called a conditional calculated item. For more information, see
“Defining Calculated Items” on page 224.
Print decimals. This field specifies the number of decimal places that will
print for counts or amounts (0-9) in reports.
Leading zeros. Indicate whether to print the leading zeros on reports.
The supported Print Format is ‘Count’.The “Print commas” indicator must
be disabled when “Print Leading Zeros” is enabled. See “Processing of Print
Leading Zeros Indicator” on page 194 for more information.
Rule Action. Action to be performed if the rule is out of balance. If setting
a completion code of 0000 is the default action specified for the current job
on the Set Return Code panel (see the section entitled “Set Return Code” on
page 163), you also need to specify Rule Action option 2 or 3 instead of
accepting the default.
1. Default. The system will take the default action specified for the

current job on the Set Return Code panel (see “Set Return Code” on
page 163).
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2. Set completion code. The rule will set a completion code. Specify the

code in the Return Code field.
3. Set abend code. Abend the balancing job. Abends apply only to job

runs in batch.
Print Format. Indicates how the item values used in the rule will print on
the Control Report. See “Setting the Print Options” on page 256 for
information on the options.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts related to this rule in reports. For more
information, see “Setting the Print Options” on page 256.
Truncate/Round. Indicate whether to override the default Job level
truncate/round options for this Calculated Item. Use Default, to use the
truncate/round settings specified at the Job level. Select Round, to round
the number to the nearest decimal. Select Truncate to truncate the value to
the specified number of decimals.
When you have completed the panel, you can do one of the following:

 If you want to create additional standard rules, press F4 to remain in the
panel, accept the original standard rule, increment the item number,
and retain the field values. Change the values to make the new standard
rule unique.

 Press F5 to accept.
 Press F10 to convert the time values. See “Perform Time Conversion” on
page 573 for more information.
Depending on your entries, the following panels will display:

 “Tolerance/Skip Processing Panel” on page 236 if you indicated that
you want to set a tolerance.

 “Direct Messages Panel” on page 250 if you entered a return code and a
message is not already defined for it

Tolerance/Skip Processing Panel
If you entered Y in the Set Tolerance? field on the Standard Rules panel,
the Tolerance/Skip Processing panel displays. When using the EQ operator
for a rule, you can allow an in-balance condition even when the left- and
right-hand sides of the rule are not exactly equal.
Specify the type of processing to define.
1. Absolute tolerance. In the Value field, enter the maximum allowable

absolute value of the difference between the two sides of the
comparison formula, using up to nine decimal places.
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2. Percentage tolerance. In the Value field, enter a percentage of the value

of the LHS of the rule. For example, enter a 5 for 5%.
3. Skip processing of the rule (and skip processing of any conditional

rules that reference it) if the value of the left-hand-side equals the skip
value you enter in the Value field.
Tolerance or skip value. Complete the information corresponding to
the option you selected above.
Press F5 to accept. If you specified a return code and a message is not
already defined for it, the Direct Messages panel will appear (see “Defining
Messages” on page 249).
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Defining Conditional Rules
A conditional rule uses IF/THEN logic to evaluate the status of up to 10
other rules to determine if a condition is met. You can specify whether the
condition should be true or false.
To learn more about conditional rules, see the following sections:







“IF/THEN Logic” on page 238
“Active Conditional Rules” on page 239
“Inactive Conditional Rules” on page 239
“How Conditional Rules Are Evaluated” on page 240
“If True and If False Logic in Conditional Rules” on page 240

 “AND Logical Expressions” on page 241
 “OR Logical Expressions” on page 242
To go directly to the Conditional Rules panel, see “Completing the
Conditional Rules Panel” on page 243.

IF/THEN Logic
Valid Conditions
When evaluating a conditional rule:

 The valid condition for a standard rule is assumed to be in-balance.
 The valid condition for a conditional rule is assumed to be condition
met.
The negate ¬ [NOT] symbol (see "NOT" below) can be used to change the
valid conditions.
AND and OR
The rules to be evaluated in the IF portion of the rule are specified on the
Conditional Rule screen. Rules are linked by + [AND] and | [OR] symbols.
Each rule on the IF side is evaluated to determine whether the condition is
met. For example, here is Rule 4 (R4), an active conditional rule:
Left-hand side
IF R1 + R2 True

Right-hand side
THEN process R3

The above rule is interpreted as:
If (Rule 1 is in balance) and (Rule 2 is in balance) are true, then process Rule
3.
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NOT
The negate ¬ [NOT] symbol can be used before a rule to change the valid
conditions. If the negate symbol is used:

 The valid condition for a standard rule is assumed to be out-ofbalance.

 The valid condition for a conditional rule is assumed to be condition
not met.
Following is an example where the ¬ [NOT] symbol is used with R2:
Left-hand side
IF R1 + ¬R2 True

Right-hand side
THEN process R3

Assuming that R2 is a standard rule, the above rule can be interpreted as:
If (Rule 1 is in balance) and (Rule 2 is out-of-balance) are true, then
process Rule 3.

Active Conditional Rules
Description
Active conditional rules are evaluated every time the job is run.
The THEN (right-hand side) portion of the rule defines the action to be
taken if the condition is met, which can be either of the following:

 Execute Process Rules. This activates up to 10 inactive standard rules.
 Set Return Code. This sets the 4-digit return code shown in the Return
Code field on the Conditional Rule screen.
Additionally, if the rule references a conditional calculated item, the
conditional calculated item will be processed if the condition is met.

Inactive Conditional Rules
Description
Inactive conditional rules are intended for use within active conditional
rules as a means to associate subsets of rules within a rule. They take the
place of the logical expressions (parentheses). That is, the rule number of
the inactive conditional rule is used in place of the logical expression.
Inactive conditional rules are used when you need to:

 Use both AND and OR logical expressions to describe a condition.
 Evaluate more than 10 rules in an active conditional rule.
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In an inactive conditional rule, the status of a rule is evaluated to determine
if a condition (which can be true or false) is met. The THEN (right-hand
side) portion of the rule does not trigger an action. The THEN portion
simply sets the status of the evaluation to condition met or condition not
met.

How Conditional Rules Are Evaluated
This section provides a detailed explanation of how conditional rules are
processed.

If True and If False Logic in Conditional Rules
The following tables show active conditional rules and what they mean
depending on whether you specify that the condition described in the
Evaluate field on the Conditional Rule screen must be true or false.
The rules used in the sample If statements in the tables are standard rules,
so their status is described as in or out of balance. If these were inactive
conditional rules, their status would be described as condition met or not
met. If they were active conditional rules, their status would be action taken
option bypassed.
This table shows what will happen when the TRUE logic is applied:
If False

Then

Description

What Will Happen

R1

Process R3

If “rule 1 is in balance” is true,
then process rule 3.

If Rule 1 is in balance, Rule 3
will be processed.

¬R1

Process R3

If “rule 1 is not in balance” is
true, then process rule 3.

If Rule 1 is out-of-balance,
Rule 3 will be processed.

R1 + R2

Process R3

If “rule 1 is in balance and rule
2 is in balance” is true, then
process rule 3.

If Rule 1 AND Rule 2 are in
balance, Rule 3 will be
processed.

R1 + ¬R2

Process R3

If “rule 1 is in balance and rule
2 is not in balance” is true,
then process rule 3.

If Rule 1 is in balance AND
Rule 2 is out-of-balance, Rule
3 will be processed

R1 | R2

Process R3

If “rule 1 is in balance or rule
2 is in balance” is true, then
process rule 3.

If Rule 1 OR Rule 2 are in
balance, Rule 3 will be
processed.

R1 | ¬R2

Set return
code 3010

If “rule 1 is in balance or rule
2 is not in balance” is true,
then set return code 3010.

If Rule 1 is in balance OR
Rule 2 is out-of-balance,
return code 3010 will be set.
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This table shows what will happen when the FALSE logic is applied:
If False

Then

Description

What Will Happen

R1

Process R3

If “rule 1 is in balance” is
false, process rule 3.

If rule 1 is out of balance, rule
3 will be processed.

¬R1

Process R3

If “rule 1 is not in balance” is
false, process rule 3.

If rule 1 is in balance, rule 3
will be processed.

R1 + R2

Process R3

If “rule 1 is in balance and rule
2 is in balance” is false,
process rule 3.

If rule 1 OR rule 2 is out of
balance, rule 3 will be
processed.

R1 + ¬R2

Process R3

If “rule 1 is in balance and rule
2 is not in balance” is false,
process rule 3.

If rule 1 is out of balance OR
rule 2 is in balance, rule 3 will
be processed.

R1 | R2

Process R3

If “rule 1 is in balance or rule
2 is in balance” is false,
process rule 3.

If rule 1 AND rule 2 are out of
balance, rule 3 will be
processed.

R1 | ¬R2

Set return
code 3010

If “rule 1 is in balance or rule
2 is not in balance” is false,
set return code 3010.

If rule 1 is out of balance AND
rule 2 is in balance, return
code 3010 will be set.

If you look at the “What Will Happen” column in the table above, you will
notice that AND and OR logical expressions are evaluated differently in
these If False statements than in the If True statements shown in the
previous table.

AND Logical Expressions
When an AND logical expression is evaluated within an If True statement,
the expression will be true if every condition connected by the AND is true.
But an If False statement will be false (and the actions you have specified
for the rule will be performed) if any condition connected by the AND is
false.
The following If True statement has the same effect as the “If ¬R1 | ¬R2 is
false” statement:
If R1 + R2 is true, then set return code 3010.
It is easy to see in the above statement that if BOTH rules are IN BALANCE,
the rule will set return code 3010.
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Avoiding AND and OR Connectors in the Same IF Statement
IF statements that combine AND and OR connectors can be difficult to read
and maintain. Here is an example of a potentially confusing AND/OR
combination:
IF R1 | ¬R2 + R4 is false, then set return code 3010.
This rule will take action IF
(“Rule 1 is in balance” is false OR “Rule 2 is out of balance” is false)
AND “Rule 4 is in balance” is false.
Notice that the statement is evaluated from left to right. ACR/Summary
automatically evaluates the first logical expression first: R1 | ¬ R2. Then, it
evaluates the entire IF statement as an AND logical expression consisting
of the true or false result of evaluating the first logical expression, AND R4.
To keep your rules as clear and simple as possible, you can use an inactive
conditional rule to replace either the AND condition or the OR condition if
they are in the same IF statement.

OR Logical Expressions
Within an If True statement, an OR logical expression will be true if any
condition connected by the OR is true. For example, the following rule
contains an OR logical expression that connects two conditions:
If (R1 + R2) | R3 is true, then set return code 3010.
In the rule above, “Rule 1 is in balance AND Rule 2 is in balance” is one
condition and/or “Rule 3 is in balance” is the other. If either or both of these
conditions are true, the rule will take action and set return code 3010.
In contrast, when you use an OR logical expression within an If False
statement, every condition connected by the OR must be false for the rule
to take action. For example, the following rule will take action if Rule 1 is
out of balance AND Rule 2 is in balance:
If R1 | ¬R2 is false, then set return code 3010.
Here is another true versus false example:
If ¬R1 | ¬R2 is true, then set return code 3010.
In the rule above, if EITHER or both Rule 1 and Rule 2 are OUT OF
BALANCE, the rule will set return code 3010. But what will happen if we
change true to false?
If ¬R1 | ¬R2 is false, then set return code 3010.
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The rule will set return code 3010 only if BOTH rules are IN BALANCE.
Note:

To avoid confusion as to how a lengthy IF statement will be evaluated, it
is best to define an inactive conditional rule for each logical expression
that you would normally enclose in parentheses. Then, combine these
inactive rules together in a single, active conditional rule.

Completing the Conditional Rules Panel
Select Rules > New > Conditional to display the Conditional Rules
panel.
Rule number. Defaults to the next available number. We recommend
that you let this field increment automatically.
Is rule active. Enter Y if the rule will be active. For information, see
“Active Conditional Rules” on page 239 and “Inactive Conditional Rules”
on page 239.
Alternate Balancing Rule. Enter Y if you are using alternate balancing
rules. You will then be allowed to enter a rule number higher than 100. For
more information, see “Using Alternate Balancing Rules” on page 245.
Evaluate. Rule numbers of up to 10 existing rules of any type whose status
the system should check. Do not use hyphens. For example, use R1 or R001.
To have the system check for a positive status, the evaluation is as follows:






Inactive standard rule. Checks for an in-balance status.
Active standard rule. Checks for an in-balance status.
Active conditional rule. Checks for an ACTION TAKEN status.
Inactive conditional rule. Checks for a CONDITION MET status.

To have the system check for the negative status of a rule, enter ¬ (not) in
front of a rule number (for example, ¬R1). The evaluation will be as
follows:






Inactive standard rule. Checks for an out-of-balance status.
Active standard rule. Checks for an out-of-balance status.
Active conditional rule. Checks for an ACTION BYPASSED status.
Inactive conditional rule. Checks for a CONDITION NOT MET status.

Group multiple rules using + (AND) or | (OR) connectors.
Process Rules. Applies to active conditional rules only. You can enter up
to ten inactive standard rules. They will perform any actions you have
specified for them if they are activated by the conditional rule.
Enter rule numbers without hyphens, as in the Evaluate field. If you are
entering multiple rules, leave a blank space between them.
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Perform the RHS of the rule. Enter 2 (If the LHS is false) only if you
want the rule to take action when the condition specified in the Evaluate
field is false. Otherwise leave the default of 1.
Choose action to perform. Options:
1. Execute process rules. If the true or false condition specified by the

LHS is met, activate the inactive standard rules on the RHS for
evaluation. The remaining fields on the panel do not apply.
2. Set return code. If the true or false condition specified by the LHS is

met, take the default action specified for the current job on the Set
Return Code panel.
3. N/A - Inact cond rule only. If this is an inactive conditional rule,

only evaluates and sets the status of the rules on the LHS.
Set Return Code. If you chose to set a return code in the previous field,
enter the return code that should be generated. Codes between 0050 and
3999 are recommended because they do not duplicate system-generated
codes. Defaults to 0000. The job will be out of balance unless the highest
return code issued by any rule in the job is 0000.
Calculated item to process. Optionally enter the number of a calculated
item that will be processed if this rule is in balance. This type of calculated
item is called a conditional calculated item. For more information, see
“Defining Calculated Items” on page 224.
After you complete the panel, do one of the following:

 Press F4 to retain a copy of this rule which you can edit to make a new
rule.

 Press F5 if you do not want to retain a copy.
The following will happen:
1. The Conditional Rule Description panel will display. Complete and

press F5.
2. If applicable, the Direct Messages panel will display. Complete and

press F5.
3. If you pressed F4 above, you will see the copy of the rule you just

created (except that the rule number will be incremented). Edit to
make a new rule.
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Rule Processing When Item Is Not Found
Each internal (or extended internal) item, history item, and calculated item
contains an indicator called Specify action to take or Required item that
helps to control how any rule containing the item should be processed.
When items within a rule are processed, if no items are missing, the rule
uses the indicator value of each item to determine whether the rule is in or
out of balance.
When items in a rule are missing, the indicator value for each missing item
is stored. The indicator with the highest order of precedence, as described
below, determines how to process the rule.

Order of Precedence
The order of precedence referenced above is as follows:
1. Set all rules involving this item out of balance. The item is required.
2. Skip all balancing rules involving this item, including conditional rules

that evaluate or process rules that involve this item.
3. Set this item to zero/spaces and continue processing. The item is not

required.

Reporting Rule Status
The Control Report indicates the status of rules as follows:

 Active standard rules. These are reported as IN BALANCE or OUT-OFBALANCE.

 Inactive standard rules. These are reported as IN BALANCE OR OUTOF-BALANCE only if the rule was made active and therefore evaluated.
You can set up the User Report and Free-form Report to display the
status of inactive standard rules if they were not made active.

 Active conditional rules. These are reported as ACTION TAKEN (if the
condition is met) or ACTION BYPASSED (if the condition is not met).

 Inactive conditional rules. These are reported as CONDITION MET or
CONDITION NOT MET.

Using Alternate Balancing Rules
Alternate balancing rules are additional sets of rules that can be defined for
a single job. Alternate rule sets are useful when the same job is being run by
different departments or for different processing periods.
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Setting Up Alternate Balancing Rules
Alternate balancing rules are triggered by using the balancing control field.
The control field has a format of 01Xn, where:
01 indicates that alternate balancing rules will be used.
X stands for a control field.
n is the rule set number (1-9)
Up to 10 rule sets can be defined for a job. Each rule set can contain up to
100 rules. These may be either standard or conditional rules.
Rules 1-100 are in rule set 0.
Rules 101-200 are in rule set 1
Rules 201-300 are in rule set 2
Rules 301-400 are in rule set 3
Rules 401-500 are in rule set 4
Rules 501-600 are in rule set 5
Rules 601-700 are in rule set 6
Rules 701-800 are in rule set 7
Rules 801-900 are in rule set 8
Rules 901-1000 are in rule set 9
For example, to trigger execution of rule set 5 (numbered from 501 to 600),
the control field should be set to 01X5.
Only one set of alternate balancing rules can be used in a given execution of
a job.
The control field can be set in different ways:

 In program interface mode, a value of 01Xn should be passed to the field
ACR-CONTROL-FIELD in the ACRAREA, where n is a number from 0
to 9.

 In direct input mode, enter 01Xn in one of the following ways:
 Through the user interface in the Control field on the Direct Input
Data Parameters panel

 If you are creating direct input transaction records manually, in
Record 1 the control field through either the user interface screen or
the direct input data transaction.
Both methods are discussed in “Balancing in Direct Input Mode”
on page 395.

 In file interface mode, alternate balancing rules are triggered as follows:
1. Extract the data that indicates the appropriate rule set from the

input source as a field value.
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2. On the Field Value panel, set the Input field format field to 2

(Alphanumeric). Set the Will this field be translated using a
translation table? field to Y.
3. On the Output Value panel’s Specify output format field, enter

6 (Control field for alternate balancing rules). The system will then
use the extracted value to set the value of the control field (field
type = X), which determines the rule set.
4. On the Translation Table panel, set the Table name field to the

name of the translation table you are going to create.
5. Set up a translation table to convert the extracted field value to the

control field, as shown in the "Alternate Balancing Rules Example"
below.
6. When you define any rules (standard or conditional), you must set

the Alternate Balancing Rule field on the rules panel to Y. You
will then be allowed to enter a rule number higher than 100.

Alternate Balancing Rules Example
Suppose you are using a file interface job to process control values from one
of three divisions, Dallas, New York, or Seattle. Each of the divisions will
require a different rule set.
To translate the extracted value to the control value, you would set up a
translation table named DIVISION with the following values:
Table Input

Table Output

Dallas

01X0

New York

01X1

Seattle

01X2

When you set up the job, you would use a field value to extract the division
name (Dallas, New York, or Seattle) from the input source file along with
the other control values.
On the Field Value panel, be sure to do the following:

 Set the Input field format field to 2 (Alphanumeric).
 Set the Will this field be translated using a translation table?
field to Y.
On the Output Value panel, set the Specify output format field to 6
(Control field for alternate balancing rules).
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On the Translation Table panel, set the Table name field to DIVISION.
When the job runs, the following will happen:

 When Dallas is extracted, rules 1-100 will be used.
 When New York is extracted, rules 101-200 will be used.
 When Seattle is extracted, rules 201-300 will be used.
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Defining Messages
Messages are lines of instructional text, up to 80 characters long, that are
associated with a return code. When you set up a balancing rule, you specify
a return code to indicate an out of balance condition. If the rule issues the
return code, or if the return code is 0000, the system prints the associated
messages.
Messages serve the following purposes:

 Identify an out of balance condition and outline correction procedures
 Provide reminders or explanations, and include specific information,
such as a contact name and phone number or an exact item value and
description.

Message Processing
All messages print on the Control Report, and if specified, on the FreeForm and User Reports. Messages associated with a 0000 return code print
whether the rule is in or out of balance. If the system cannot find any
messages associated with the return code, the message NONE prints in the
Messages section of the Control Report, and processing continues. If you
included an item value or description within the message, the printed text
is expanded to 112 characters.
For jobs run on z/OS, you can choose to write messages to the console, with
or without a required response. For jobs run on other platforms, you can
choose to write messages to the System Messages (SYSOUT) Report.
For jobs run on Windows, you can send messages to an email address, and
attach one or more of the following reports: Control Report, SYSOUT
Report, Recap Report, User Report, and Free-Form Report. Specify email
notification settings on the Server Properties dialog in ACR/Summary and
ACR/Detail server.

Setting Up Messages
ACR/Summary has two types of messages: direct and indirect. If you
created a rule and defined a new return code for the rule, the Direct
Message panel opens automatically, enabling you to define a message. To
edit an existing message or create a message at a later time, from the Job
Window, select the message to edit or select NEW and then select either
Direct Message or Indirect Message.
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For messages that are used frequently across multiple jobs, you can set up
a global template that is used by all balancing rules. See “Global Messages”
on page 125.

Direct Messages Panel
If you selected option 1 (Direct messages) from the Messages panel or
created a standard rule, the Direct Messages panel displays.
Message number. This number defaults to the next consecutive number.
It is best to let this field increment automatically.
Return Code. Specify the return code associated with this message. Codes
between 0100 and 3999 and code 0000 are recommended for return codes
because they do not duplicate system-generated codes.
Message text. Specify the text of the message. You can add up to 80
characters of text.
Write message to. Options:
1. Control report. Messages are written to the Control Report.
2. Console and control report, no response required. Write the message

to two places, the console and the control report. No response is
needed from the user.
3. Console and control report, response required. Write messages to the

console and to the control report. An operator must acknowledge the
message. Processing will not change based on the operator response.
If you need more characters, create additional messages for the same return
code or create an indirect message. See “Indirect Messages Panel” on
page 251.
If you accessed the Messages panel from the Job Window and have finished
the Direct Messages panel, to create additional messages, press F4. This
will increment the message number and retain the description. Otherwise
Press F5.
You can include the value for internal, extended internal, or calculated
items, or the description for internal, extended internal, and history items.
This option expands the printed text to 112 characters. To add an item value
or description within the message text, see the "Item List Window" section,
below.
Item List Window
From the Messages panel, press F6 to see a list of available items.
To display the item value in the message text, specify V next to the desired
item. To display the description, specify D.
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The system inserts a symbolic within curly brackets at the end of the
message to retrieve the value or description for the specified item.
Optionally, you can type the symbolic in brackets within the message text.
Below is a list of symbolics:
Innn1

Internal item value

DInnn1

Description of the internal item

Xnnn1

Extended internal item value

DXnnn1

Description of the extended internal item

Ennn1

History item value

DEnnn1

Description of history item

Cnnn1

Calculated item value

DCnnn1

Description of the calculated item

1

nnn represents the item number, for example, 001.

Value Position and Length Panel
If you chose to display the value for an item, the system displays the Value
Position and Length panel.
Starting position of value to display? For a text item, specify the start
position to include a portion of the value. The system displays this field only
for text items.
Length of value to display? For a text or numeric item, specify the
length to include a portion of the value.
Description Position and Length Panel
If you chose to display the description for an item, the system displays the
Description Position and Length panel.
Starting position of description to display? Specify the start position
to include a portion of the description.
Length of description to display? Specify the length to include a
portion of the description.

Indirect Messages Panel
If you selected Indirect messages from the Message panel, the Indirect
Message panel displays.
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Message number. This number defaults to the next consecutive number.
It is best to let this field increment automatically.
Return Code. Specify the return code associated with this message. Codes
between 0100 and 3999 and code 0000 are recommended for return codes
because they do not duplicate system-generated codes.
Job ID. Use the following fields to identify the job:
Job name/Step name/Qualifier. Identify the job whose messages you
wish to import into the current job.
First included line. Specify the first message line to include from the
imported messages.
Last included line. Specify the last message line to include from the
imported messages.
If you accessed the Messages panel from the Job Window and you have
finished the Indirect Messages panel, to create additional messages, press
F4. This will increment the message number and retain the description.
Otherwise Press F5.
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Message Examples
The following table shows sample messages for two jobs and three global
messages defined for return code 3000. The table includes the job ID, the
message line or sequence number, the return code (RC), the message type,
and the message text or the job ID for an indirect message
Job ID

Number

RC

Type

Message Text or Job ID

CLAIMS10
ACRSTEP

001

1001

Direct

DATA ENTRY ERROR IN
AMOUNT {I7}

CLAIMS10
ACRSTEP

002

1002

Direct

CLAIMS ADJUSTMENTS
NEEDED

003

2000

Direct

NO INPUT FOR PUERTO
RICO

CLAIMS10
ACRSTEP

004

3000

Direct

PROGRAM ERROR

CLAIMS20
ACRSTEP

001

1500

Indirect

CLAIMS10 ACRSTEP 001002

CLAIMS20
ACRSTEP

002

3600

Direct

WRONG INPUT FILE USED

GLOBAL
RC3000

001

3000

Direct

PROGRAM LOGIC ERROR

GLOBAL
RC3000

002

3000

Direct

CONTACT RESPONSIBLE
MANAGER

GLOBAL
RC3000

003

3000

Direct

LOG PROBLEM IN P6000

CLAIMS10
ACRSTEP
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Job CLAIMS10
Job CLAIMS10 ACRSTEP include four direct messages, one defined for
each of the following return codes: 1001, 1002, 2000 and 3000.
If balancing is run for this job and each of the four return codes is issued,
return code 3000 and the following messages will print on the Control
Report and any other reports, as specified:






DATA ENTRY ERROR IN AMOUNT $1,234,000
CLAIMS ADJUSTMENTS NEEDED
NO INPUT FOR PUERTO RICO
PROGRAM ERROR

The first message, which includes an item value, shows the actual item
value.
The global messages for return code 3000 will not be used because this job
has a message that uses return code 3000. Global messages are generated
only if there is no corresponding direct message in the current job.

Job CLAIMS20
Job CLAIMS20 ACRSTEP includes two messages: an indirect message
defined for return code 1500 and a direct message defined for return code
3600. The indirect message points to message numbers 001 and 002 in
CLAIMS10.
If balancing is run for this job and generates a return code of 1500, the
indirect message will point to message line numbers 001 and 002 of the Job
CLAIMS10 definitions. The following messages will appear on the Control
Report with a return code of 1500:

 DATA ENTRY ERROR IN AMOUNT {I7}
 CLAIMS ADJUSTMENTS NEEDED
Because the first message is an indirect message, it does not show the actual
item value on the report.

Global Messages
Three global messages have been defined. For additional information, see
“Global Messages” on page 125.
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Navigating through Existing Job Definitions
You can page through existing internal (or extended internal) items,
calculated items, history items, rules and messages from the Job Window
by pressing F7/F8 to move to the previous/next item of a category.
Remember to save any changes.

Deleting Job Definitions
To delete an individual job definition (such as the definition for an internal
item or the definition for a rule) without deleting the entire job, in the Job
Window, enter D next to the definition, press Enter, and respond to the
prompt to confirm the deletion.
You can delete multiple definitions (including items of different types, such
as multiple internal items and multiple extended internal items) at once, as
long as they can be viewed in the window at the same time.
You can also delete an input source and one or more items at the same time.
Note:

Remember, if you delete the Job Information, the entire job will
be deleted, as explained in Deleting a Job on page 50.

Deleting References to Deleted Items
When you delete the definition for an internal item, extended internal item,
history item, calculated item, or rule, and the deleted item is referenced in
the User Report or Free-Form report, or in one or more history items,
calculated items, rules, or messages, the Deleted Item Notification panel
will display after the deletion is confirmed. This panel provides information
about the deletion of references to the deleted item.
The Deleted Item Notification panel shows the following information:

 The item you deleted is listed at the top of the panel.
 Lines beginning with the words “Automatic deletion” indicate that one
or more references to the deleted item were automatically deleted from
the indicated report.

 Lines beginning with the words “Manual deletion” indicate that one or
more references to the deleted item were found in the indicated history
item, calculated item or rule. You should make a note of these
references so that you can delete them from the Job Window.
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 Lines beginning with the words “Item (alt bal rule) deletion omitted”
indicate that 1) you deleted one or more alternate balancing rules and
2) user report and Freeform Report definitions will not be searched for
item references.
Deleted Item Notification
Internal Item 001 deleted from job definition.

Row 1 from 14
<----Item you deleted

Automatic deletion in User Report definitions. <----This and the following item
Automatic deletion in Freeform Report definitions.
reference were deleted by ACR/Summary
Manual deletion required in History Item 001
<----This and the following item
Manual deletion required in History Item 004
references should be deleted manually.
Manual deletion required in Calculated Item 001
Manual deletion required in Calculated Item 002
Manual deletion required in Calculated Item 003
Manual deletion required in Rule (Conditional Calc Item) 004
Manual deletion required in Rule (LHS/RHS) 004
Item (alt bal rule) deletion omitted in User Report definitions.
Item (alt bal rule) deletion omitted in Freeform Report definitions.

Command Line ===> _____________________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Before you press Enter, make a note of the item references that you must
delete manually
To purge definitions from the definition library or the definition database,
see “Purging Definitions” on page 739.

Setting the Print Options
In panels for internal items, extended internal items, calculated items, and
standard rules, you can specify the following options for printing on
reports:
Note:

For maximum lengths, see Maximum Lengths for Regular and
Extended Data on page 196

Print format. Options:
1. Count. Print the item as a number with embedded commas and

decimals as determined by the Decimals field. If the value is negative, a
trailing minus sign (-) will print. Default formatting for negative values
and thousands markers can be overridden in the user options.
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2. Amount. Print the item as a currency amount with a leading currency

indicator (the default is a dollar sign [$]), embedded commas, a
decimal point, and decimals as determined in the Print Decimals
field. If the value is negative, a trailing minus sign (-) will print. Default
formatting for negative values, currency symbols, thousands markers,
and decimal markers can be overridden in the user options. For more
information, see “Constraints for Single-precision and Doubleprecision Numbers” on page 259 below.
3. Date. Print as a Gregorian date printed in the format YY/MM/DD,

unless this default is overridden in the user options.
4. Text. Print as a character string enclosed in single quotation marks.
5. Time. Print the item in the '-99999999TTTTTTTTTTTTT' format,

where -99999999 is the relative day and TTTTTTTTTTTTT is the
formatted time.
6. Date & Time. Print the item in the 'DDDDDDDDTTTTTTTTTTTTT'

format, where DDDDDDDD is the formatted date and
TTTTTTTTTTTTT is the formatted time.
The following examples briefly illustrate ‘Time’ and ‘Date & Time’ print
options.
Assume the date and time formatting options in the User Options File
are set as shown below:
Time Format: HH:MM:SS
Time Notation: 12-hour Time Separator
Date Format: CCYY/MM/DD
Example 1 – Time Item / Result - Same Day:
C-001 = I-001 + 12 hours, where I-001 stores 09:00:00.00.
C-001 = 21 hours 00 minutes 00 seconds 00 centiseconds (< 24
hours).
If Print Format is Count, C-001 is printed as 7560000 (centiseconds).
If Print Format is Time, C-001 is printed as 09:00:00PM.
If Print Format is Date & Time, C-001 is printed as 0000/00/00
09:00:00PM.
Example 2 – Time Item / Result - Day Forward:
C-001 = I-001 + 20 hours, where I-001 stores 09:00:00.00.
C-001 = 29 hours 00 minutes 00 seconds 00 centiseconds (> 24
hours).
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If Print Format is Count, C-001 is printed as 10440000 (centiseconds).
If Print Format is Time, C-001 is printed as +00000001 05:00:00AM,
where +00000001 is the relative day.
If Print Format is Date & Time, C-001 is printed as 1601/01/01
05:00:00:00AM.
Example 3 – Time Item / Result - Day Backward:
C-001 = I-001 - 12 hours, where I-001 stores 09:00:00.00.
C-001 = - (03 hours 00 minutes 00 seconds 00 centiseconds)
(negative).
If Print Format is Count, C-001 is printed as – 1080000
(centiseconds).
If Print Format is Time, C-001 is printed as -00000001 09:00:00PM,
where -00000001 is the relative day.
If Print Format is Date & Time, C-001 is printed as 0000/00/00
09:00:00PM.
Example 4 – Date & Time Item / Result - Same Day:
C-001 = X-001 & I-001 + 12 hours, where X-001 stores 2014/04/14
and I-001 stores 09:00:00.00 (2014/04/14 has date count 150950,
which is 3622800 hours).
C-001 = 3622800 hours + 09 hours 00 minutes 00 seconds 00
centiseconds + 12 hours.
C-001 = 3622821 hours 00 minutes 00 seconds 00 centiseconds.
If Print Format is count, C-001 is printed as 1304215560000
(centiseconds).
If Print Format is Time, C-001 is printed as +150950 09:00:00PM,
where +150950 is the relative day.
If Print Format is Date & Time, C-001 is printed as 2014/04/15
09:00:00PM.
Example 5 – Date & Time Item / Result - Day Forward:
C-001 = X-001 & I-001 + 20 hours, where X-001 stores 2014/04/14
and I-001 stores 09:00:00.00 (2014/04/14 has date count 150950,
which is 3622800 hours).
C-001 = 3622800 hours + 09 hours 00 minutes 00 seconds 00
centiseconds + 20 hours.
C-001 = 3622829 hours 00 minutes 00 seconds 00 centiseconds.
If Print Format is Count, C-001 is printed as 1304218440000
(centiseconds).
If Print Format is Time, C-001 is printed as +150951 05:00:00AM,
where +150951 is the relative day.
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If Print Format is Date & Time, C-001 is printed as 2014/04/16
05:00:00AM.
Example 6 – Date & Time Item / Result - Day Backward:
C-001 = X-001 & I-001 - 12 hours, where X-001 stores 2014/04/14 and
I-001 stores 09:00:00.00 (2014/04/14 has date count 150950, which
is 3622800 hours).
C-001 = 3622800 hours + 09 hours 00 minutes 00 seconds 00
centiseconds – 12 hours.
C-001 = 3622797 hours 00 minutes 00 seconds 00 centiseconds.
If Print Format is Count, C-001 is printed as 1304206920000
(centiseconds).
If Print Format is Time, C-001 is printed as +150949 09:00:00PM,
where +150949 is the relative day.
If Print Format is Date & Time, C-001 is printed as 2014/04/14
09:00:00PM.
Print decimals. For counts and amounts, indicate the number of
decimals to be assigned by the system and printed in reports.
Print commas. Indicate whether to include the thousands place indicator
when printing counts and amounts. The default thousands place indicator
is a comma. Options:
1. Default. Use the user options settings for Print Commas for Counts and

Print Commas for Amounts fields when running the job in batch. In
online processing, the thousands place indicators will be printed.
2. Print. Print the thousands place indicator whether the job is run online

or in batch.
3. Do not print. Suppress printing of the thousands place indicator

whether the job is run online or in batch.

Constraints for Single-precision and Double-precision Numbers
If you use single-precision or double-precision numbers, you need to be
aware of the following constraints:

 Accuracy is not guaranteed for single-precision numbers.
 When using double-precision numbers, accuracy can be guaranteed
provided that the user-defined scale is less than the actual number of
decimals stored in the database.
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For example, the number 9987654.4321987654 could be stored as
+9.98765443219876E+06. In this example, 8 decimals are stored instead
of the 10 in the original number. Thus, a user-defined scale of 7 or less will
be accurate.
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This chapter explains how to define an input source file for your job and
create file definitions to enable ACR/Summary to locate and extract the
values required for balancing.
This chapter contains the following sections:











“Defining an Input Source” on page 261
“Selecting an Access Mode” on page 270
“Getting Started with File Definitions” on page 286
“Understanding Field Formats” on page 288
“Creating File Definitions for the Selected Access Mode” on page 290
“Viewing, Editing and Deleting File Definitions” on page 348
“Date and Cycle Number Extraction and Processing” on page 351
“Time Extraction and Processing” on page 355
“Extracting Directly from a Delimited Data File” on page 356

Defining an Input Source
The input source is a file (often a report from your application) from which
data is extracted for balancing. For example, if you want to compare the
total cost of telephone calls for the current month’s telephone bill with the
previous month’s bill, the dataset that contains the telephone bill data
would be the input source. Up to 100 input sources can be defined for a job.
After you specify the input source, you create the file definitions you will use
to extract the values you need from the input source for balancing.

ACR/Summary User Guide for z/OS

261

7  Creating File Definitions
Defining an Input Source

Input Sources Panel
To display the Input Sources panel, in the Job Window, select NEW under
Input Source.
Input Sources
File number: 002
Comments exist: N Add/Change Comments: N (Y/N)
File description: __________________
File DDNAME: ________ Qualifier: __
DSName: ____________________________________________
Last update by:
Date:
Time:
Display the above DSName in the extract window? Y (Y/N)
If yes, specify the range of lines to display: 00001 to
00100
File organization:
1_ 1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
5. User program...
Is this file a model? N
Use model definitions? N
File DDNAME:
Qualifier:

(Y/N)
(Y/N)

________
__

File Number. Verify or change the file number, which indicates the order
in which the input source files for this job will be processed. The file number
starts at 001 for the first input source defined for a job and increments for
each additional input source.
Comments exist. If the indicator is Y, user-defined comments exist
regarding this input source file.
Add/Change Comments. Enter Y if you want to add or change user
comments regarding this input source file. The panel for comments will
display after you specify the file organization information. For more
information, see “Adding Job or File Comments” on page 177.
File Description. Optional description of this input source file.
File DDNAME. Meaningful name for the input source file. The first
character must be alphabetic. If you are running a job in batch, the File
DDNAME must match the DDNAME in the JCL that points to the file to
which the file definitions will be applied. This does not apply if you are
using DB2 or user program formats. For more information on DB2, see
“Using DB2 Tables as Input Sources” on page 469.
Qualifier. Complete if the file is to be processed more than once during the
job.

262

Infogix, Inc.

Creating File Definitions  7
Defining an Input Source

DSName. Complete with the name of the file or dataset if your input
source is a physical sequential or VSAM file and you plan on viewing the file
in the Extract Window. If you are using a GDG as the input source, be sure
to fully qualify the dataset name. For example: your.dataset.G00123v00.
Last update by/Date/Time. This displays the ID associated with the
most recent update to this set of definitions, along with the date and
time of the update.
Display the above DSName in the extract window. Enter N if you
are using DB2 or direct spool file organization or if you do not want to
display the input source. For more information on DB2, see “Using DB2
Tables as Input Sources” on page 469.
If yes, specify the range... If the input source will be displayed, enter the
number of lines. Additional lines slow down processing, so use the fewest
number needed.
File Organization. Specify the type for the input file, which will control
the panel that displays next. Refer to the corresponding section listed below
for instructions:
“Physical Sequential File Information Panel” on page 264
“VSAM File Information Panel” on page 266
“Direct Spool Information Panel” on page 267
“DB2 Information Panel” on page 268
“User Program Information Panel” on page 268
Is this file a model. Enter Y if this is going to be a base file for modeling.
For more information, see “Modeling Job and File Definitions” on
page 639.
Use model definitions? Enter Y if this file is going use definitions from
a base model.
File DDNAME. If this file will use model definitions enter the DDNAME
of the file whose definitions you want to use.
Qualifier. Complete if the file whose definitions you want to use has a
qualifier.
Press F5 to accept and display the panel corresponding to the file
organization type you indicated above.
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Physical Sequential File Information Panel
If you indicated in the Input Source panel that your input source is a
physical sequential file, the following panel appears
Note:

Sequential files, whether in a physical sequential file or stored
on the JES spool as described in Balancing in Spool Monitor
Mode on page 433, are read sequentially. Depending on the
access mode you select when defining the input source, the
system may or may not read the entire file. Depending on your
file definitions, the records it does read may or may not be
selected to be scanned for extractable data.
Physical Sequential File Information

Specify
1_ 1.
2.
3.
4.
5.
6.
7.

access
Select
Select
Select
Select
Select
Select
Select

mode:
first x records
last x records
x records based on file key processing
x records from nth record (Relative record)
all records (total/tally/hash)
records satisfying selection on one line
records satisfying selection on multiple lines

Reset extraction variables? Y

(Y/N)

Hard copy DDNAME: ________
Use delimited data fields? N
F1=Help

F2=Split

(Y/N)

F3=Exit

F5=Accept

F9=Swap

Specify access mode. Specify how the input source file will be read and
select records for processing. For more information, see “Selecting an
Access Mode” on page 270.
Reset extraction variables. Applies when you have multiple input
source files for the job. An entry of Y resets all extraction variables to zero
before processing the definitions for this input source. One case where you
would use N is described in “Using Extraction Variables in Embedded Key
Substitution” on page 203.
Hard Copy DDName. DDNAME to be used if you want a hard copy of
this input source file to be printed when creating file interface JCL. See
“Running Balancing Jobs and Other JCL in Batch” on page 369. Used only
when running a job in batch.
Use delimited data fields. If this input source file is in delimited format
and you will be extracting delimited fields using the field number directly,
enter Y. If you are using a user program such as UUPDLIM or you are
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specifying the position and length in the record, enter N. For more
information about extracting directly from a delimited data file, see
“Extracting Directly from a Delimited Data File” on page 356.
Press F5 to accept. The panels that will display next depend on your entries
in this panel:

 If you selected access modes 1-4, the “Record Information Panel” on
page 266 displays.

 If you specified that you are using delimited data fields for access modes
5-7, the "Delimited Data File Information Panel" displays, as shown
below.

 If you are not using delimited data fields for access modes 5-7, you will
be returned immediately to the Job Window.

Delimited Data File Information Panel
Delimited Data File Information
Specify the length of fixed data area:
Delimiter character: _

_

_

0000
_

(1-1000)
_

Enclosure character: _
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify the length of fixed data area. Enter the length of the fixed area
of the delimited file.
Delimiter character. Enter one to five characters that will be used to
delimit the fields in each record. Use t or T to indicate a tab.
Enclosure character. Specify the character that will be used to indicate
the start and end of the text field. The delimited character will be ignored
between the enclosure characters.
When you press F5, you will be returned to the Job Window.
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Record Information Panel
If you selected access modes 1-4, the Record Information panel displays.
(The Start on record field appears only in access mode 4.)
Record Information
Maximum number of records to process: 00000
Start on record:
F1=Help

0000000

F2=Split

(1-99999)

(1-9999999)

F3=Exit

F5=Accept

F9=Swap

Maximum number of records to process. For more information, see
“File Access Area” on page 271.
Start on record. This field displays only in access mode 4. For more
information, see “Access Mode 4: X Records from the nth Record” on
page 276.
Press F5 to accept your entries on this panel. If you specified that you are
using delimited data fields for access modes 1-4, the "Delimited Data File
Information Panel" displays, as shown above. Otherwise, F5 returns you to
the Job Window.

VSAM File Information Panel
If you indicated that your input source is a VSAM file, the following panel
displays.
Note:

To extract control values from VSAM files, you specify one or
more keys to access individual records directly instead of
searching through the entire file sequentially. VSAM access is
usually used to extract some type of “file totals control” record
containing total record counts, dollar amounts, etc. for the entire
VSAM application.
VSAM File Information

Specify
__ 1.
2.
3.
4.

access
Select
Select
Select
Select

mode:
first x records
x records based on file key processing
records satisfying selection on one line
records satisfying selection on multiple lines

Maximum number of records to process: _____
Reset extraction variables? Y
F1=Help
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F2=Split

(1-99999)

(Y/N)
F3=Exit

F5=Accept

F9=Swap
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Use the following procedure to complete the VSAM File Information panel.
Specify access mode. Specify how the input source file will be read and
select records for processing. For more information, see “Selecting an
Access Mode” on page 270.
Maximum number of records to process. For more information, see
“File Access Area” on page 271.
Reset extraction variables. Applies when you have multiple input
source files for the job. An entry of Y resets all extraction variables to zero
(0) before processing the definitions for this input source. One case where
you would use N is described in “Using Extraction Variables in Embedded
Key Substitution” on page 203.
Press F5 to accept and return to the Job Window.

Direct Spool Information Panel
If you indicated that your input source is a direct spool file, the following
panel appears.
Direct Spool Information
Specify
_ 1.
2.
3.
4.
5.

access
Select
Select
Select
Select
Select

mode:
first x records
last x records
x records based on file key processing
x records from nth record (relative record)
all records (total/tally/hash)

Specify spool information:
Spool step name:
________
Spool DDNAME: . . ________
Reset extraction variables? Y

Spool step occurrence: ___

(001-999)

(Y/N)

Hard copy DDNAME: ________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify access mode. Specify how the input source file will be read and
select records for processing. For more information, see “Selecting an
Access Mode” on page 270.
Spool step name. Step name of the job that produced the spool output
report.
Spool step occurrence. Occurrence you want if the step name appears
more than once in a job.
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Spool DDName. DD statement referring to the application report in the
field. See “JCL Changes for Jobs with File Organization Type of Direct
Spool (SP)” on page 387 for JCL changes required for the Spool Monitor file
organization type.
Reset extraction variables. Applies when you have multiple input
source files for the job. An entry of Y resets all extraction variables to zero
(0) before processing the definitions for this input source. One case where
you would use N is described in “Using Extraction Variables in Embedded
Key Substitution” on page 203.
Hard Copy DDName. DDNAME to be used if you want a hard copy of
this input source file to be printed when creating file interface JCL. See
“Running Balancing Jobs and Other JCL in Batch” on page 369. Used only
when running a job in batch.
Press F5 to accept. The system returns to the Job Window or, if you selected
access modes 1-4, the Record Information panel displays. See “Record
Information Panel” on page 266.

DB2 Information Panel
This panel is described in Chapter 15, “Using DB2 Tables as Input Sources
on page 469.” Follow the instructions in this chapter if you are DB2 tables
as input sources.

User Program Information Panel
User programs are external COBOL programs that enable access to input
source types that ACR/Summary does not access directly. If you indicated
that your input source is a user program, the following panel is displayed.
For more information about user programs, see the ACR/Summary and
ACR/Detail User Program Guide.
User Program Information
Specify User Program Information:
Program Name: ________
Program Parm Area: __________________
Specify record selection criteria:
1
1. Key values precede detail values
2. Key values follow detail values
Reset extraction variables? Y

(Y/N)

Fastload internal translation table: ________________
F1=Help
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F3=Exit

F5=Accept
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Program Name. Name the program. You can use your own program or
use one of the following user programs that Infogix provides. The Infogix
program names are as follows:

 UUPDLIM. This program can be used to extract data from files
containing records of variable length fields, separated by one or more
separator characters or delimiters. (Delimited data can also be
extracted directly without a user program. See “Extracting Directly
from a Delimited Data File” on page 356)

 UUPXML. This program can be used to extract data from XML files.
 UUPEDIF. This program can be used to extract data from EDI files (in
X12 format).

 UUPVREC. This program can be used to extract data from variable
length records consisting of a fixed “header” area and a variable number
of “line” areas.
For more information on these programs, see the ACR/Summary and
ACR/Detail User Program Guide.
Program Parm Area. Name of the area that will be used to pass
information to the user program. Each program name specified above will
need information to be passed. Up to 18 characters can be passed via this
field.
Specify record selection criteria. Options:
1. Key values precede detail values. The key values will appear before

their corresponding detail values in the input source.
2. Key values follow detail values. The key values will appear after their

corresponding detail values in the input source.
For more information, see
“Understanding Selection Fields and Selection Groups” on page 277
and “Selecting an Access Mode” on page 270.
Reset extraction variables? Indicate whether you will reset the
extraction variables between input sources. See “Defining Extraction
Variables” on page 201 for more information on extraction variables.
Fastload internal translation table. The specified translation table
will be loaded into memory for fastest translation. This increases the
efficiency of translation table processing. If you do not specify a table name,
the system will load whichever table name it encounters first for the value
that needs to be translated. For information on internal translation tables,
see “Defining and Using Internal Translation Tables” on page 730.
Press F5 to accept.
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Selecting an Access Mode
For all input source types except DB2 tables, you specify an access mode,
which determines how the input source file will be read. The access mode
also determines the file definition types that you can use to locate, format,
and extract data from the input source.
The following sections:

 Summarize access mode information in a table to help you choose the
appropriate mode for your input source.

 Describe each access mode in detail.
After you select an access mode, see “Creating File Definitions for the
Selected Access Mode” on page 290.

Brief Description of Each Access Mode
The following table provides a high-level description of each access mode.
For more detail, see “Detailed Description of Each Access Mode” on
page 271.
Abbreviations:
PS
= physical sequential files)
VSAM = VSAM key sequenced files
DS

= Direct spool data sets

Access
Mode

Available for
these File
Types

1 - First X
Records

PS, VSAM,
DS

Description
Selects the first X records (X is the number of records to be
selected from the input source as specified in the Maximum
number of records to process field in the Record Information
panel when you define the input source) and places them in
the file access area.1

2 - Last X
Records

PS, DS

3 - X records
based on file
key(s)

PS, VSAM,
DS

270

Selects the last X records (X is defined as in access mode 1
above) places them in the file access area1.
Selects records based on file key(s) and places them in the file
access area1. Record selection stops when one of the
following occurs 1) the maximum specified in the Max. Record
Count field in the Record Information panel has been reached
or 2) the stop key is found.
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Access
Mode

Available for
these File
Types

Description

4 - X records
from the nth
record

PS, DS

5 - All
records
(total/tally/
hash)

PS, DS

6 - Select
records that
match 1 line

PS, VSAM

Processes all records in the input source using selection
groups. All criteria from all selection groups must be met on
the same record.

7 - Select
records that
match
multiple lines

PS, VSAM

Same as access mode 6 except that, although all criteria from
all selection groups must be met, they need not be met on the
same record.

1

Selects the nth record and x number of records (X is defined
as in access mode 1 above) up to the maximum and places
them in the file access area1.
Processes all records in the input source and derives a total,
tally (count), or hash value of one of the following:
 All records in the file (if no key value is specified).
 Records that match a specified key value.
 Records that do not match a specified key value.

- See “File Access Area” in the next section for an explanation of this term.

Detailed Description of Each Access Mode
Note:

When you select a File Organization/Type in the File
Organization dialog box, the access modes available for that
type display for selection in the Access Mode field.

Access Mode 1: Selects the First X Records
This access mode selects the first 1 to 99,999 records from the input source
and places them in the file access area.
File Access Area
The file access area used in access modes 1 through 4 is a temporary storage
place for the application records that will be scanned for extractable data.
Using a file access area eliminates the need to scan all of the records in the
input file.
The number of records to be selected is specified in the Maximum
number of records to process field in the Record Information panel
when you define the input source.
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This mode is appropriate for input sources where the values to be extracted
reside at the top of the file. The use of a file access area makes processing
quicker because only part of the file is searched.
Beginning
of File

Maximum Record Count

End of File
Sequential File, VSAM, or JES Spool

Access Mode 2: Selects the Last X Records
This access mode selects the last 1 to 99,999 records from the input source
and places them in the file access area. (For an explanation of this term see
“File Access Area” on page 271.) The number of records to be selected is
specified in the Maximum number of records to process field in the
Record Information panel when you define the input source.
This mode is appropriate for input sources where the values to be extracted
reside at the bottom of the file. The use of a file access area makes
processing quicker because only part of the file is searched.

272

Infogix, Inc.

Creating File Definitions  7
Selecting an Access Mode

Beginning of
File

End of File
Sequential File or JES Spool

Access Mode 3: X Records Based on File Key
Access Mode 3 selects records based on one or multiple file keys and places
them in the file access area. (For an explanation of this term see “File Access
Area” on page 271.)

 Use one file key when you want to specify a starting point for selecting
a block of records.

 Use multiple file keys where the values to be extracted reside on records
that contain a common character string.
What is a File Key?
A file key allows you to specify a character string (the key value) to be
searched for in the input file. To be considered a match, the record must
contain the file key value beginning at the specified start position and
having the specified length. For example, a file key might specify the key
value DIVISION TOTALS SECTION starting in column 20 for a length of
23. Only a record containing this value at this location in the file is
considered a match.
Processing differs depending on whether one file key or multiple file keys
are specified, as follows:
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One File Key
Beginning of

Maximum Record Count

File Access Area

End of File
Sequential File or JES Spool

If only one file key is specified, the application file is read sequentially from
the beginning until a record is found that contains the key value string
beginning at the specified position. If found, that record and a block of
subsequent records selected are copied to the file access area. (For an
explanation of this term, see “File Access Area” on page 271.) The block of
records to be copied ends when either the maximum specified in the
Maximum number of records to process field in the Record
Information panel has been reached or when the end of file has been
reached.
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Multiple file keys
Beginning of
File
Record
Containing File
Key 1

Record
Containing
File Key 2

Record
Containing File
Key 3
End of File

Sequential File or JES Spool

File Access Area

If multiple file keys are specified, each is assigned a file key item number.
The file key with the lowest number is called the start file key, and the file
key with the highest number is called the stop file key.
The file is read sequentially from the beginning until a record matching the
start file key is found. If found, that record is copied to the file access area
(if no match is found, no records are selected from the file). After a record
matching the start key is found, each subsequent record is read and
compared to all of the file keys. If a record matches any of the file keys
(except the stop key), the record is selected and copied to the file access
area.
Selection stops when 1) the stop file key is found, 2) the maximum specified
in the Maximum number of records to process field in the Record
Information panel has been reached, or 3) the end of file is reached.
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Access Mode 4: X Records from the nth Record
This access mode selects the nth record and x number of records after it and
places them in the file access area. (For an explanation of this term, see “File
Access Area” on page 271.) For example, if you want to pick up records 10
through 250, you would tell the system to pick up 241 records starting with
record number 10.
Beginning of
File
nth Record in
File

Maximum Record Count

File Access Area

End of
File

Sequential File

Access Mode 5: All records (Total/Tally/Hash)
Total, tally, or hash records process all records in the input source and
derive a total, tally (count), or hash value, respectively, of one of the
following:

 All records in the file (if no key value is specified).
 Records that match a specified key value.
 Records that do not match a specified key value.
For more information, see “Creating File Definitions for Access Mode 5” on
page 308.
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Understanding Selection Fields and Selection Groups
This section will help you understand access modes 6 and 7. This
information applies to both access modes except as noted. It includes the
following subsections:






“Selection Fields” on page 277
“Selection Field Example” on page 277
“Selection Groups” on page 279
“Working with Selection Groups” on page 279

Selection Fields
A selection field is a feature for determining whether the current record will
be selected for further processing or bypassed. Its features include:

 The evaluation can be performed using data from one of the following
input types: 1) data from an input area, which consists of specific
positions of the current record or 2) data from specific positions in a
saved extraction variable.

 You can choose from 16 selection types. For example, the evaluation
can test the format of the value (numeric or alphabetic), or can test the
value using comparisons such as equal to, less than or equal to, or
within range. In addition, you can restrict processing to a specific
portion of the file.

 Depending on your input type and selection type, you can evaluate
against 1) one constant or one range, 2) multiple constants or multiple
ranges, or 3) the value of an extraction variable.

 Multiple selection fields can be combined for evaluation with other file
definition types that are valid for access mode 6 and 7 into a selection
group.
Selection Field Example
This example specifies the evaluation of a field extracted from the current
record (this is called the input area). The contents of this field will be
evaluated against a range of values in nonextended format. (For
information on evaluating against values or ranges in extended format, see
“Defining Selection Fields” on page 317.)
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Using Selection Type 9 (within range), the value in the specified positions
will be evaluated against the lower and upper limits of two ranges. One
range is specified in the Value 1 and Value 2 fields.
Selection Field
----+----1----+----2----+----3----+----4
01:00 01:00AM
01:00PM
00060004
Input type:
1 1. Input Area
2. Extraction Variable
Delimited data field number: ____ (1-1000)
Field position: 00021 Field length:
Field format: 2 1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
Field type: __
1. Count
2. Amount
3. Text
Edit comments?
N (Y/N)
Line reference

----------------- Selection Criteria -----------------If blank is one of the comparison values, it must be entered here.
Value 1: ________________ Value 2: _______________
Additional? N (Y/N)
Selection type: __ 1. Equal to
2. Not =
3. Numeric 4. Alphabetic
5. Greater than 6. Less than 7. Blank
8. Nonblank
9. Within range 10.Begin =
11.End =
12.Locate =
13.Outside range14.Greater = 15.Less = 16.Advance
Extraction variable number:
(1-999) Extended? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

The other range is specified on the Additional Comparison Ranges field that
displays after you accept your entries on the Selection Field panel if you set
the Additional field to Y.
Additional Comparison Ranges
From Value
70000___________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F1=Help

To Value
80000___________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F2=Split

F3=Exit

From Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F5=Accept

To Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F9=Swap

Field definitions will be provided in “Opening the Extract Window” on
page 286.
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Selection Groups
A selection group consists of the following file definition types:

 One selection field or a set of consecutive selection fields at the group
level. Group-level selection fields are not indented in the display.
Consecutive selection fields are joined by AND or OR
Note:

Joining of selection fields using the logical operator OR is
supported only in access mode 6.

You can define one or multiple selection groups at the group level.

 Optionally, one selection field or a set of consecutive selection fields at
the subgroup level (nested).
Note:

Selection fields at the subgroup level (nested) are supported only
in access mode 6.

Subgroup-level selection fields are indented in the display. A subgroup
will be processed only if the record has passed the group-level
evaluation directly above it. Only one level of nesting is supported.
You can define one or multiple selection groups at the subgroup level
within a selection group.

 Any associated relative records, reformat fields, or detail fields. These
can be defined at the group level, the subgroup level, or both, and will
be processed if the record passes the preceding group or subgroup
evaluation.
Note:

Selection fields at the subgroup level (nested) are supported only
in access mode 6.

For information on defining these file definition types, see the
following sections:

 “Defining Relative (Advance) Records (Access modes 6-7)” on
page 330.

 “Defining Reformat Fields” on page 330.
 “Defining Detail Fields” on page 334.
Working with Selection Groups
Demote or Promote Between Group Level and Subgroup Level
To demote a single selection field definition from the selection group level
to the selection subgroup level, from the Extract Window, select View >
Definitions, and enter the right parenthesis symbol ) next to the
definition that you want to demote. The definition will be moved to the right

ACR/Summary User Guide for z/OS

279

7  Creating File Definitions
Selecting an Access Mode

two positions, so that is indented under the preceding group-level selection
field. To demote a block of selection fields to the subgroup level, enter ))
next to the first and last selection field definition in the block.
To promote a single selection field definition from the selection subgroup
level to the selection group level, enter the left parenthesis symbol ( next to
the definition that you want to promote. The definition will be moved to the
left two positions, so that is no longer indented. To promote a block of
selection fields to the group level, enter (( next to the first and last selection
field definition in the block.
These line commands are not allowed to enter on the “Comment” line.
Use of AND/OR Logical Operators in Access Mode 6
In access mode 6, consecutive selection fields at the same level (group or
subgroup) are joined for evaluation using the logical operator AND (the
default) or OR. The AND and OR operators work as follows:

 When AND is used, the criteria of all consecutive selection fields at the
same level must be satisfied before the record will be selected for
processing against the remaining file definitions in the same selection
group or subgroup.

 If OR is used, if the criteria of any one of the consecutive selection fields
at the same level are satisfied, the record will be selected for processing
against any remaining file definitions in the selection group or
subgroup.
The logical operator that is currently being used is displayed to the right of
the first selection field in the group or subgroup.
Toggle Between AND and OR
To toggle between AND and OR, select the first selection field in the group
or subgroup with an S and press F6.
This command is not allowed to enter on the “Comment” line.

Access Mode 6: Select Records that Match 1 Line
Read this only after have read the preceding section, "Understanding
Selection Fields and Selection Groups."
Access mode 6 typically evaluates every record in the input source using
selection groups, always starting with the first group.
Note:

In both access mode 6 and access mode 7, you can use the
following features to bypass records:
 Advance (relative) records.
 The Begin equal to and/or End equal to selection types.
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Records that pass the selection group evaluation can be processed by the
other file definition types available for access modes 6 and 7 to obtain data
for use in balancing rules.
When to Use Access Mode 6
It will be easier to set up your definitions using access mode 6 (rather than
access mode 7) when the following conditions exist:

 You do not need to extract values from the same location on multiple
records (lines).

 The records containing the data you want are not always in the same
sequence as the file definitions in the selection group.
Access Mode 6 Example 1: Simple Selection Group with No Subgroups
SELECT IF POS 0033 FOR 02 = 19
(AND)
PICK UP THE VALUE AT 0057 FOR 07, STORE IN I-001

This is an example of a simple selection group with one selection field.
Using the equal selection type, it evaluates the specified positions of the
input area against one constant. If the record passes, the other field in the
group, a detail field (the line beginning PICK UP THE VALUE) is processed,
and the data in the positions indicated in the detail field is extracted and
assigned to an internal item.
Because there are no more file definitions, the next record will be read and
evaluated against the same file definitions, starting with the first definition
(the selection field).
Note:

The AND in parentheses next to the selection statement is the
default logical operator. It will not be used because there are no
consecutive selection statements at the same level.

Access Mode 6 Example 2: Two Selection Groups, One with a Subgroup
This example shows two selection groups at the group level, the first of
which contains one selection group at the subgroup level.
BEGIN PROCESSING IF POS 0010 FOR 08 = SPELLMAN (AND)
SELECT IF POS 0023 FOR 02 IS > OR = 23
SELECT IF POS 0033 FOR 02 = 19
...
PICK UP THE VALUE AT 0033 FOR 05, STORE IN EXTR VARIABLE 001
SELECT IF POS 0041 FOR 07 IS > OR = 40000
(OR)
SELECT IF POS 0057 FOR 07 IS < OR = 55000
PICK UP THE VALUE AT 0057 FOR 07, STORE IN I-001
SELECT IF EXTRACTION VAR 001 = 19357
(AND)
PICK UP THE VALUE AT 0073 FOR 05, STORE IN I-002
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Processing the First Selection Group
The first selection group starts with three consecutive selection fields at the
group level joined by AND. Notice the following:

 File definitions for selection fields are not always displayed starting
with the word Select. Here, the first selection field starts with the word
Begin.

 The third selection field at the group level has three dots at the end,
indicating that the value in the specified positions is being compared to
one or more values values in addition to 19. To do this, on the Selection
Field panel, you would set the Additional field to Y. When the
Additional Comparison Values panel (or the Additional Comparison
Ranges panel) displays, you would enter the additional values or
ranges.

 Because AND is the logical operator at the group level, the current
record must meets the criteria of all three of the group-level selection
statements in order for the detail field (the line beginning PICK UP THE
VALUE AT 0033) to be processed.
If the record passes, 1) the detail field will be processed and the
resulting value will be stored in extraction variable 1, and 2) the record
will then be passed on to the subgroup for evaluation.
If the record fails, the subgroup will be skipped.

 The subgroup begins with two consecutive indented selection fields
joined by OR. If the current record satisfies the criteria of either of these
fields, the record will pass and the detail field (the line beginning PICK
UP THE VALUE AT 0057) defined at the subgroup level will be
processed.
Processing the Second Selection Group
Selection groups are evaluated independently. The record will be passed on
for testing by the second selection group regardless of whether it passes or
fails the first.
The second selection group consists of one selection field (the line
beginning SELECT IF EXTRACTION VAR 001). This field evaluates the
positions in extraction variable 1 that were specified on the Selection Field
panel using the equal selection type against a constant. If these values are
equal, the record will pass, and the detail field (the line beginning PICK UP
THE VALUE AT 0073) defined for this selection group will be processed.
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Processing the Next Record
After all file definitions have been processed against the first record, the
next record will be read and evaluated against the same definitions, starting
with the first selection statement (the line beginning BEGIN PROCESSING
IF).

Access Mode 7: Select Records that Match Multiple Lines
Read this only after have read “Understanding Selection Fields and
Selection Groups” on page 277.
When to Use Access Mode 7
Access mode 7 will be a more efficient method than access mode 6 when
both of the following conditions exist:

 You want to extract values from the same location on multiple records
(lines).

 The records containing the data you want are always in the same
sequence as the file definitions in the selection group.
Similarities Between Access Modes 6 and 7
The similarities are as follows:

 Both access modes select or bypass records using selection fields.
 Both access modes use some of the same file definition types: selection
fields, relative records, reformat fields, and detail fields.
Differences Between Access Modes 6 and 7
Access modes 6 and 7 differ in some important ways:

 Access mode 7 does not support OR selection and selection subgroups
(nested selection groups).

 In access mode 6, every record in the input source is typically evaluated
against all selection groups, starting with at the top of the definitions,
before the next record is read. This is not always true in access mode 7,
as detailed in the next sections.
Access Mode 7 Processing Steps
In access mode 7, the following occurs:
1. The first record in the file (we will call it Record 1) will be evaluated

against all selection groups. The last selection group that passes will be
noted.
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2. The system then reads the next record (Record 2). This record will be

evaluated starting with the next selection group after the one noted
when the previous record was read. Evaluation of Record 2 will be as
follows:
a. If the record passes all remaining groups through the last group

defined, evaluation of the record will stop. The system will read the
next record and evaluate it just as Record 1 was evaluated.
b. If the record fails any of the remaining selection groups through

the last group defined, it will be evaluated by all selection groups.
1. If the record passes at least one group, the last group that

passes will be noted.
2. If the record fails all groups, the last record that fails will be

noted.
The system will then move to the next record and evaluate it just as Record
2 was evaluated.
Access Mode 7 Processing Example
This example shows how selection groups would be processed in access
mode 7 with various pass/fail scenarios.
Assume you have an input source consisting of 5 records. You have defined
4 selection groups. For each record, the following table shows which
selection group will be processed first, and when the next record will be
read.
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Record

Selection
Group
Evaluated

Result

1

1

Pass

2

Pass

3

Fail

4

Fail

3

Fail

4

Fail

1

Fail

2

Fail

3

Pass

4

Pass

1

Pass

2

Fail

3

Pass

4

Fail

4

Pass

2

3

4

5

Selection
Group
Noted

Next
Record
is Read

Notes

2

Y

See step 1.*

2

Y

See step 2b2.*

Y

See step 2a.*

Y

See step 1.*

3

See step 2a.* Evaluation of all
records in the input source is now
complete.

*All steps are described in Access Mode 7 Processing Steps on page 283

Access Mode 7 File Definitions Example
Assume that your input file is the one shown below. You want to extract the
balance for DANVERS that follows the ADAMS record. The balance you
want for DANVERS is always after the first record for ADAMS.
LAST NAME
-------------SMITH
JONES
SPELLMAN
ADAMS
DANVERS

BALANCE
-------123.4999
45.8770
1.4235
229.3030
103.0001

ACR/Summary User Guide for z/OS

285

7  Creating File Definitions
Getting Started with File Definitions

In access mode 7, you could retrieve this value (103.0001) with very few file
definitions as shown below:
SELECT IF POS 0001 FOR 05 = ADAMS
(AND)
SELECT IF POS 0001 FOR 07 = DANVERS
PICK UP THE VALUE AT 0018 FOR 08, STORE IN I-001

Each record would be read and tested against the first selection group (the
line beginning SELECT IF POS 0001 FOR 05) only until the ADAMS record
passes this group. Then the following records would be read and tested
beginning with the second selection group (the line beginning SELECT IF
POS 0001 FOR 07).
To do this in access mode 6 would require more definitions. You would have
to use an extraction variable, as shown below.
SELECT
PICK
SELECT
SELECT
PICK

IF
UP
IF
IF
UP

POS 001 FOR 05 = ADAMS
(AND)
THE VALUE AT 0001 FOR 05, STORE IN EXTR VARIABLE 001
EXTRACTION VAR 001 = ADAMS
(AND)
POS 001 FOR 07 = DANVERS
THE VALUE AT 0018 FOR 08, STORE IN I-001

Getting Started with File Definitions
After you have completed the basic job information, defined your input
source, and specified an access mode on the File Information panel, you can
begin entering file definitions. File definitions define which records will be
selected to be scanned for extractable data, the data to be extracted, and
how the data will be processed and stored.

Opening the Extract Window
To create file definitions for an input source, from the Job Window, open
the Extract Window in one of the following ways:

 Select the input source. Select Window > Extract.
 Select Window > Extract. Select the input source.
 Enter E or e next to the input source.
When the Extract Window opens, if the input source is a physical sequential
or VSAM file and you specified to display it in the Extract Window, the file
will display. Otherwise the window will be blank.
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Methods of Entering File Definitions
After you open the Extract Window, there are two methods for entering file
definitions:

Mark-and-Capture Method
For files that display in the Extract Window, you can enter the definitions
as follows:
1. Place your cursor on the first character of the item you want to extract

and press F6.
Note:

To search for a string in the displayed input source, select Edit >
Search Arguments. Enter the string you want to search for,
select the occurrence you want, and press F5. Press F5 again to
repeat the search.

Manual Method
For files that do not display in the Extract Window, enter the definitions as
follows:
1. Use a printout of the input source file to determine the locations of the

data you want to extract.
2. Select Window > Extract > (Select the file) > Edit > Add.
3. Select the type of definition you want and complete the corresponding

panels.

Next Steps
For instructions on completing the definition panels, see one of the
following:

 “Creating File Definitions for Access Modes 1-4” on page 290
 “Creating File Definitions for Access Mode 5” on page 308
 “Creating File Definitions (Access Modes 6 and 7)” on page 317
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Understanding Field Formats
When creating file definitions, you will often be required to specify the
format of the data. The options are as follows:
Note:

The only valid formats for extraction variables are alphanumeric
and packed decimal.

Numeric. All of the characters are numeric. Blanks will be ignored,
alphanumeric characters will be stripped out, and the field will be padded
with preceding zeros. For example, suppose the value has a length of eight
and you specify the format as numeric. The results would be as follows:
Value

This will be interpreted as:

1234 (4 blanks after value)

000000000001234

1A2B3C4D

000000000001234

1234ABCD

000000000001234

1 2 3 4 (spaces between numbers)

000000000001234

12341111

000000012341111

(all blanks)

000000000000000

Alphanumeric. Some or all of the characters are alphabetic. This format
allows punctuation and numbers as well as alphabetic characters. The
string below could be formatted as alphabetic.
JOHN DOE’S PHONE# IS (630)555-1212

288

Infogix, Inc.

Creating File Definitions  7
Understanding Field Formats

Packed. The value is stored in packed decimal format, i.e. there are
two digits for each byte, except for the last byte, which consists of the
last digit (0-9) and a sign. For example, with a hex display on the
mainframe, 12345 in packed format would look like this:
12345C
| | |
| | |
| | |--Byte 3 contains 5C. C indicates a positive number.
| |
| |--Byte 2 contains 34
|
|--Byte 1 contains 12

Zoned decimal. Each digit is represented by a single byte. The first
four bits of each byte make up the sign (F), and the last byte, where the
first four bits will contain a C for a positive number or a D for a
negative number. The last four bits of each byte contain the value of
the digit. For example, with a hex display on the mainframe, 12345 in
zoned decimal format would look like this:
F1F2F3F4C5
| | | | |
| | | | |--Byte 5 contains C5. C indicates a positive number.
| | | |
| | | |--Byte 4 contains F4
| | |
| | |--Byte 3 contains F3
| |
| |--Byte 2 contains F2
|
|--Byte 1 contains F1

Binary. Has a decimal equivalent consisting of the decimal digits 0
through 9 and a sign. Binary stores numbers in hexadecimal (base 16),
represented by the characters 0-9 and A-E. For example, with a hex
display on the mainframe, 12345 in binary format would look like this:
3039
| |
| |--Byte 2 contains 39
|
|--Byte 1 contains 30
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Unsigned packed. Same as packed except that there is no sign in the
last byte. Two digits are stored in every byte and the value is always
positive.
For example, with a hex display on the mainframe, 12345 in unsigned
packed format would look like this:
012345
| | |
| | |--Byte 3 contains 45
| |
| |--Byte 2 contains 23
|
|--Byte 1 contains 01

For information on maximum lengths when extracting data in each format,
see “Maximum Lengths for Regular and Extended Data” on page 196.

Creating File Definitions for the Selected Access
Mode
Depending on the access mode and the file organization type that you
choose to use as the input source, different file definition types are
available. This section describes them and explains how to create them.
See the appropriate section:

 "Creating File Definitions for Access Modes 1-4" below.
 “Creating File Definitions for Access Mode 5” on page 308
 “Creating File Definitions (Access Modes 6 and 7)” on page 317

Creating File Definitions for Access Modes 1-4
For information on these access modes, see “Selecting an Access Mode” on
page 270. To get started, follow the instructions in “Methods of Entering
File Definitions” on page 287. The Select a Definition Type panel will be
displayed
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Select a Definition Type Panel for Access Modes 1-4.
Select a definition type:
__

1.
2.
3.
4.
5.
6.

File key...<--Only available in access mode 3
Reference record...
Relative record...
Page/line record...
Embedded key...
Field value...

F1=Help

F3=Exit

Select the type of definition you want to create. See the appropriate section
below:
“Defining File Keys” on page 291
“Defining (Begin/End/Reset) Reference Records” on page 292
“Defining Relative Records (Access Modes 1-4)” on page 295
“Defining Page/Line Records” on page 296
“Defining Embedded Keys” on page 297
“Defining Field Values” on page 299

Defining File Keys
File keys are used only in access mode 3. For a description of file keys, see
“Access Mode 3: X Records Based on File Key” on page 273.
To access the File Key panel, see “Creating File Definitions for Access
Modes 1-4” on page 290
File Key Panel.
File Key
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
47.94___________________________________
________________________________________

Delimited data field number: ____
Position: _____
F1=Help

(1-1000)

Length: __

F2=Split

F3=Exit

F5=Accept

F9=Swap

Key value. Specify the character string or extraction variable that will be
used as the key:

 If you are using a character string as the key and you are using markand-capture, the Key value defaults to the marked value and following
79 characters. Edit as necessary to enter the string you want to use.
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 If you are using a value from an extraction variable as the key, blank out
anything in the Key value field and enter the extraction variable, using
the following format:
To specify a regular extraction variable, use the format (V-nnn), where
nnn is the extraction variable number. For example:
Chars.

1-40

(V-001)___________________________________________

To specify an extended extraction variable, use the format (XV-nnn),
where nnn is the extraction variable number. For example,
Chars.

1-40

(XV-001)__________________________________________

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Position. Number of the first position of the file key value. Verify or enter
the value in the Position field. Enter or verify.
Length. Length of the value to be defined as the file key. If the key value is
from an extraction variable, be sure to use the length of the data that you
want to use as the key value, which is not always as long as the entire
extraction variable value.
Press F5 to accept and return to the Extract Window.
Note:

When you chose access mode 3 in the Input Source panel, a
subsequent panel displayed asking how many records to process.
The system will pick up that number of records after the file key and
place them in the access area for processing.

Defining (Begin/End/Reset) Reference Records
Reference records can be used in access modes 1 through 4. Begin and end
reference records are described below. See “Reset Reference Records” on
page 295.
Begin and End Reference Records
Begin and end reference records restrict the beginning and/or ending point
of the search to a subset of records within the file access area which is called
a reference area. You specify a character string in the begin/end reference
record to indicate where to begin/end the reference area.
For example, if you have indicated in the Input Source panel to process the
first 200 records of the file but for a particular file definition extraction you
only need to search through records number 20 through 40, you may set
the beginning reference point at a particular character string on record 20
and the ending reference record at a particular character string on record
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40. The system looks for the beginning reference point, after if finds it, it
begins searching the records for the extractable data, it continues doing this
until it encounters the ending reference point.
End Reference Record Must Immediately Follow Begin Reference Record
When using begin/end reference records, you must define the end
reference record immediately after the begin reference record with no
intervening definitions. See the following example:
SET BEGIN REF AT OCC 001 OF REFERENCE KEY=A
SET END REF AT OCC 001 OF REFERENCE KEY=B
OCC 001 OF EMBEDDED KEY=1A

To access the panel to define a begin or end reference record, see “Creating
File Definitions for Access Modes 1-4” on page 290. From the Select a
Definition Type panel, select Reference Record to display the Reset
Reference Options panel. Then select Set begin reference or Set end
reference to display the corresponding panel. (The panels are identical
except for the title.
Set Begin (or End) Reference Panel)
Set Begin Reference
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
TOTAL CUSTOMER COST_____________________
___________________43.16________________

Delimited data field number: ____ (1-1000)
Start position: 00000 Length: __ Key occurrence: 001
If start position can vary, specify maximum start position: 0001
Choose an option:
1_ 1. Do not search past the ending reference point
2. Search past the ending reference point
If the previous reference point was not found:
1_ 1. Set this reference point
2. Bypass setting this reference point
If the current reference point is not found:
1_ 1. Continue processing this balancing step
2. Bypass processing this balancing step
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Key value. Specify the character string or extraction variable that will be
used as the begin or end reference record:
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 If you are using a character string and you are using mark-and-capture,
the Key value defaults to the marked value and following 79
characters. Edit as necessary to enter the string you want to use.

 If you are using a value from an extraction variable as the key, blank out
anything in the Key value field and enter the extraction variable, using
the following format:
To specify a regular extraction variable, use the format (V-nnn), where
nnn is the extraction variable number. For example:
Chars.

1-40

(V-001)___________________________________________

To specify an extended extraction variable, use the format (XV-nnn),
where nnn is the extraction variable number. For example,
Chars.

1-40

(XV-001)__________________________________________

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Start position. Position number of the first character of the key value that
will be used to identify the record to use as the begin or end reference
record.
Length. Length of the key value that will be used to identify the record to
use as the begin or end reference record. If the key value is from an
extraction variable, be sure to use the length of the data that you want to use
as the key value, which is not always as long as the entire extraction variable
value.
If start position can vary... If the reference point can begin in another
beginning position other than the one that appears in the Start Position
field, last position in the range of positions where the first character of the
key value must appear.
Choose an option. Enter 2 if you want the search to continue past the
ending reference point.
If the previous reference point... Enter 2 if you want to bypass setting
this reference point if the previous reference point is not found.
If the current reference point... Enter 2 if you want to bypass this job
if the current reference point is not found.
Press F5 to accept.
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Reset Reference Records
A reset reference record clears the begin or end reference point (or both)
that was defined previously. Unless you define new begin/end reference
points, when the next file definition is processed, the search will include all
records in the file access area.
To access the panel to define a reset reference record, see “Creating File
Definitions for Access Modes 1-4” on page 290. From the Select a Definition
Type panel, select Reference Record and then select Reset References
to display the Reset Reference Options panel.
Set Reference Options Panel
Reset Reference Options
Select a choice:
_ 1. Reset beginning reference point
2. Reset ending reference point
3. Reset both reference points
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

Specify the option you want and press F5.

Defining Relative Records (Access Modes 1-4)
This type of relative record can be used in access modes 1 through 4. (To
understand relative records in access modes 6 and 7, see “Defining Relative
(Advance) Records (Access modes 6-7)” on page 330.)
This record type is typically used when there is no unique key value in the
record from which you want to extract data. It locates a record by moving a
specified number of records forward or backward from the currently
selected record. The movement takes place within the file access area or
within the reference area. Reference areas are explained in the previous
section, “Defining (Begin/End/Reset) Reference Records” on page 292.
For example, if you know that a particular record always appears five lines
from the top of the file access area, you can use a relative record to tell the
system to go five lines down and scan that record for extractable data.
To access the panel, see “Creating File Definitions for Access Modes 1-4” on
page 290. The Relative Record Information panel displays.
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Relative Record Information Panel (Access Modes 1-4)
Relative Record Information
Enter the following field:
Number of records to advance
from current reference point:
Relative record direction: _

F1=Help
F9=Swap

F2=Split

_____

(0-99999)

( + or - )

F3=Exit

F5=Accept

Number of records to advance. Number of records to move relative to
the last record selected.
Relative record direction. Indicate the direction of the relative record
from the current reference point.
Press F5 to accept and return to the Extract Window.

Defining Page/Line Records
This file definition type locates a record by searching for the page and line
number where a record you want to scan for extraction is located. A page/
line record is used only if the following are true:

 The records are in fixed block addressing (BA) format based on a report
page number and line number.

 The record appears on the same page and line in every report used with
the definitions you are creating.
This file definition type is more vulnerable to changes in the report format
than other definition types. Pages are counted by looking for carriage
control characters in the records in the file access area. If you do not access
the report from the beginning, the page numbers of the report will not
match the page numbers specified in the page/line record definitions.
To access the panel to define a page/line record, see “Creating File
Definitions for Access Modes 1-4” on page 290. The Page/line Record panel
displays.
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Page/Line Record Panel
Page/Line Record
Go to page : . . . . _____
Go to line number:
___
F1=Help
F2=Split
F5=Accept
F9=Swap

(1-99999)
(1-999)
F3=Exit

Go to page. Page number where the record is located.
Go to line number. Number of the record on that page where the data is
located.
Press F5 to accept and return to the Extract Window.

Defining Embedded Keys
Embedded keys identify records that should be scanned for extractable
data.
Note:

Embedded keys are the method to tell ACR/Summary what fields
should be extracted. Embedded Keys should always be
specified to pick up data. If no embedded keys are specified the
results may be inconsistent between platforms and options.

You can use a value from one of the following as the value of your embedded
key:

 A literal. For example, if you want to extract a dollar amount from a
record that contains the word TOTAL, you could identify TOTAL as the
embedded key and then use a field item to identify the dollar amount to
be extracted.
Note:

If your input source is a VSAM file, specify the VSAM file key as
the literal.

 An extraction variable. Defining the value of an extraction variable as
the value of an embedded key enables you to use embedded key
substitution. For more information, see “Using Extraction Variables in
Embedded Key Substitution” on page 203
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Embedded Key Record Panel,
Embedded Key Record
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
________________________________________
________________________________________

Delimited data field number: ____ (1-1000)
Start position: _____ Length: __ Key occurrence: 001
If start position can vary, specify maximum start position:
If the key value is missing, bypass this balancing step? N

_____
(Y/N)

Use the value of this extraction variable as the embedded key:
Extended? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

___

F9=Swap

Key value. If you selected a position in the input source before pressing
F6, the Key value field will show anything in the position you selected and
the following 79 positions. (You can refer to this information when defining
the Length.) Otherwise, the field will be blank, and you will need to enter
a value or use the value of an extraction variable as the embedded key (see
Use the value...) below.
Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Start position. If you did not select the value you want to use as the key
value from the input source before pressing F6, this field will be blank. In
any case, ensure that this field identifies one of the following:

 The first position of the value you want to find in the input source equal
to the key value or equal to the value of the specified extraction variable.

 If the If start position can vary... field will be completed, the first
position in a range of positions where the leftmost character of the key
value must appear.
Length. Number of characters in the input source you want to compare to
the literal or the specified extraction variable.
Key occurrence. The occurrence of that key you want to retrieve. You can
indicate up to 999 occurrences. If you enter 999, you will retrieve the last
occurrence.
If the start position can vary... If the start position of the key can vary,
enter the maximum position.
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If the key value is missing... Change the default to Y to prevent the rules
from being processed if this embedded key is not found. If you are using
qualifiers, this applies only to the current qualifier.
Use the value of this extraction variable as the embedded key. If
you are using the value from an extraction variable as the key value, enter
the extraction variable number (001 to 999). To select from the list of
existing extraction variables, press F6. If you enter a number for an
extraction variable that has not yet been defined, the “Extraction Variables
Panel” on page 205 will be displayed. If you picked up this extraction
variable in a different input source, be sure to turn off the Reset
extraction variables field in the input source panels. For more
information, see “Using Extraction Variables in Embedded Key
Substitution” on page 203.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number that is 9 to 16 bytes long (16 to 30 digits) or text
that is 9 to 80 characters long. When setting this indicator, you must be
consistent. See“Consistency in Specifying Extended Format for an
Extraction Variable” on page 201.
Press F5 to accept.

Defining Field Values
In access modes 1-4, field values identify the data that will be extracted
from a located record and stored as an internal (or extended internal) item
or extraction variable.
To access the panel to define a field value, see “Creating File Definitions for
Access Modes 1-4” on page 290. The Field Value panel displays.

ACR/Summary User Guide for z/OS

299

7  Creating File Definitions
Creating File Definitions for the Selected Access Mode

Field Value Panel
Field Value
----+----1----+----2----+----3----+----4
Line reference:
Delimited data field number: ____ (1-1000)
Field position: _____ Field length: __
Can this field value position vary? N (Y/N)

1_

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Extract decimal indicator: N (Y/N)
Will this be stored as a date? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is the destination an extended item? N (Y/N)
Will this field be translated using a translation table?
Will this be stored as a time? Y (Y/N)

F1=Help

F2=Split

F3=Exit

F5=Accept

N

(Y/N)

F9=Swap

Line reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor.
Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Field Position. The first position of the field to extract. This number is
displayed automatically if you used the mark-and-capture method.
Otherwise you need to enter it.
Field length. Length of the field to extract. Valid values vary based on the
selected Input field format. See “Maximum Lengths for Regular and
Extended Data” on page 196.
Can this field value position vary. Enter Y if the field value may
sometimes begin in another position within the record.
Input field format. Format of the data you are extracting. For more
information, see “Understanding Field Formats” on page 288.
Extract decimal indicator. This option is useful when extracting data
with mixed decimal places. For data where the field format is 1 (numeric),
indicate how you want decimals to be processed.
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Y. When storing the extracted value in the destination field, the system will
not change the location of the decimal point. Instead, the decimal places in
the destination will be padded or truncated to match the number of
decimals specified in the destination panel.
N or blank. The system will use the following default (original)
processing: When storing the extracted value in the destination field, the
location of the decimal point will be changed if necessary, so that the
number of decimal places in the destination will match the number of
decimal places specified in the destination panel. No truncation or padding
of decimals will be performed.
Example:
The following table shows several source values along with the
corresponding values that will be stored in the destination field depending
on how you set the Extract Decimal Indicator field. In this example, the
number of decimals specified on the destination panel is 2.
Extract Decimal
Indicator = Y

Extract Decimal
Indicator = N

Stored Value

Stored Value

123.0

123.00 (pad)

12.30

123

123.00 (pad)

1.23

123.00

123.00

123.00

123.00125

123.00 (truncate)

123001.25

Source Value

Will this be stored as a date? Enter Y if the field is a date.
Will this be stored as a cycle number. Enter Y if the field value will be
stored as a cycle number. The input source file must be the first input
defined in your application. Otherwise the cycle number will default to
00000001.
Is the destination an extended item? Enter Y if the extracted value will
be a number with 16 to 30 digits or a text value with 9 to 80 characters.
Will this field be translated using a translation table. Type Y if the
field needs to be translated.
Will this be stored as a time? Enter Y if the field is a time.
Press F5 to accept and display the appropriate Output Value panel:
If the field item will be stored as a date, see “Output Value (Date)
Panel” on page 304.
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If the field item will be stored as a cycle number, see “Output Value
(Cycle #) Panel” on page 306.
Otherwise, the Output Value panel described below displays.
Output Value Panel
Output Value
Specify
_ 1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: I 005
or
extraction variable number: ___ (1-999)
Override sign processing?

F1=Help

F2=Split

N

F3=Exit

Extended? N

(Y/N)

F5=Accept

F6=ExtVar

F9=Swap

Specify output format. Format of the output value:
1. Count. Format is numeric.
2. Amount. Format is a dollar value.
3. Text. Format is a character string.
4. Cumulative count/amount. Multiple fields with the same internal (or

extended internal) item number will be accumulated together.
5. Job-step qualifier. The field contains a JSQ for the job. The JSQ will be

appended to the job name and step name of the job-step invoking the
balancing function to build a job ID.
6. The selected field will be the control field for alternate balancing

rules. Typically, the selected value will be translated to determine
which rule set will be used. For more information, see “Using Alternate
Balancing Rules” on page 245.
Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
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Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item? field in the Field Value panel.
Override sign processing. Enter Y to override sign processing. For
more information, see “Override Sign Processing Panel” on page 306
Press F5 to accept. A panel corresponding to your entries will display, as
described in the following sections:

 If you chose to override sign processing, see “Override Sign Processing
Panel” on page 306

 If you chose to store the field value as an internal item, the Internal
Items panel displays. See “Defining Internal Items” on page 196.

 If you chose to store the field value as an extended internal item, the
Extended Internal Items panel displays. See “Defining Extended
Internal Items” on page 199.

 If you chose to store the field value as an extraction variable, the system
returns to the Extract Window.
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Output Value (Date) Panel
Output Value (Date)
Assign to internal item number: X 005
or
extraction variable number: ___ (1-999)
Specify the date input format:
__ 1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. CCYYMMDD
9. CCYYJJJ
10. DDMMMYY
11. DDMMMCCYY
12. MMMDDYY
13. MMMDDCCYY
F1=Help
F2=Split
F3=Exit
F9=Swap

F5=Accept

Extended? N

F6=ExtVar

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Specify the date input format. For more information on dates, see
“Date and Cycle Number Extraction and Processing” on page 351. The date
formats shown on this panel are explained in “Date Formats that Use DD,
MM, C, CC, YY, JJ, and/or MMM” on page 353.
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Output Value (Time) Panel
Output Value (Time)
Assign to internal item number: I 017
or
extraction variable number: ___ (1-999)

Extended? N

Specify the time input format:
__
1. HHMM
2. HHMMSS
3. HHMMSSNN
AM/PM? N

F1=Help

(Y/N)

F2=Split F3=Exit

F5=Accept F6=ExtVar F9=Swap

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Specify the time input format and AM/PM. For more information on
time, see “Time Extraction and Processing” on page 355.
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Output Value (Cycle #) Panel
Output Value (Cycle #)
Options 3-15 store as CCYYMMDD.
Select cycle extract format:
__ 1. Partial date
2. Accept date as is
3. MMDDYY
4. MMDDCCYY
5. DDMMYY
6. YYJJJ
7. DDMMCCYY
8. YYMMDD
9. CYYMMDD
10. CCYYMMDD
11. CCYYJJJ
12. DDMMMYY
13. DDMMMCCYY
14. MMMDDYY
15. MMMDDCCYY

F1=Help

F2=Split

F3=Exit

If partial date, select:
__ 1. Century
2. Year
3. Month
4. Day
5. Month (MMM)

F5=Accept

F9=Swap

Select cycle extract format. For an explanation of how dates are
extracted and processed, see “Date and Cycle Number Extraction and
Processing” on page 351. Specific date formats are explained in “Date
Format Options” on page 352.
If partial date, select. If you selected Partial date in the Select cycle
extract format field, complete this field. The partial date format enables
to you extract a 2-digit century (CC), 2-digit year (YY), 2-digit month
number (MM), 2-digit day number (DD), or 3-character month (MMM for
JAN, FEB, etc.). For more information, see “Partial Date Format” on
page 352.
Press F5 to accept and display the Extract Window.
Override Sign Processing Panel
If you chose to override sign processing on the Output Value panel, the
Override Sign Processing panel will display.
Override Sign Processing
Negative sign indicator to be used instead of default:

__

Reverse the sign of the field item? N_

F1=Help
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Negative sign indicator to be used instead of default. Enter one or
two characters that will override the negative sign indicators as set up in the
user options file. The - character may apply to leading or trailing negative
signs. All other characters apply to trailing negative signs only.
Reverse the sign of the field item. Enter Y to reverse the sign of the
value. Y is valid only if the output format is count, amount, or cumulative
count/amount.
Press F5 to accept.

 If you chose to store the field value as an internal item, the Internal
Items panel, described in “Defining Internal Items” on page 196,
displays.

 If you chose to store the field value as an extended internal item, the
Extended Internal Items panel, described in “Defining Extended
Internal Items” on page 199, displays.
Otherwise, you will be returned to the Extract Window.
Translation Table Panel
If you chose to translate the field value using a translation table, the
Translation Table panel displays.
Translation Table
Table name: ________________
Specify the action to take when translation value not found:
_ 1. Print warning message
2. Suppress warning message

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Table name. Name of the internal or external translation table that will be
used to translate the field value. If the table is internal, the field must be set
to in text format.
Specify the action to take when translation value not found.
Specify 1 to print a warning message. Specify 2 if you do not want to have a
warning message printed in SYSOUT when the value to be translated is not
found in the named translation table. When the value is not found, the field
will be set to blanks or zeros.
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Viewing and Editing the Definitions
After you have finished specifying the file definitions, from the Extract
Window, select View > Definitions to view them.
To edit file definitions, see “Viewing, Editing and Deleting File Definitions”
on page 348.

Creating File Definitions for Access Mode 5
Access mode 5 allows you to define a maximum of 100 total, tally, or hash
records for an input source. For information on these access modes, see
“Selecting an Access Mode” on page 270. To get started, follow the
instructions in “Methods of Entering File Definitions” on page 287. The
Select a Definition Type panel will be displayed.
Select a Definition Type Panel for Access Mode 5
Select a definition type:
__ 1. Tally record...
2. Total record...
3. Hash record....
Is the destination an extended item? N
F1=Help

(Y/N)

F3=Exit

Select a definition type.
Total, tally, or hash records process all records in the input source and
derive a total, tally (count), or hash value, respectively, of one of the
following:

 All records in the file (if no key value is specified).
 Records that match a specified key value.
 Records that do not match a specified key value.
Select the record type corresponding to the type of processing you want:
1. Tally record. See "Defining Tally Records" below.
2. Total record. See “Defining Total Records” on page 310
3. Hash record. See “Defining Hash Records” on page 314.

Is the destination an extended internal item? If you are extracting a
number with 16 to 30 digits or a text value with 9 to 80 characters, enter Y.
For more information, see “Processing of Print Leading Zeros Indicator” on
page 194.
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Defining Tally Records
To access the panel to define a tally record, follow the instructions in
“Methods of Entering File Definitions” on page 287. From the Select a
Definition Type panel, select Tally record to display the Tally Record panel
Tally Record Panel.
Tally Record
Assign to internal item number: I 005
or
extraction variable number: ___ (1-999)

Extended? N

Record information
Include all file records? X (Y/N/X)
Specify which records to include/exclude:
Key value:
----+----1----+----2----+----3----+----4
Chars. 1-40 ________________________________________
Chars. 41-80 ________________________________________
Delimited data field number: ____
Start position:
Length: __

F1=Help

F2=Split

F3=Exit

(1-1000)

F5=Accept F6=ExtVar F9=Swap

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item? field on the Select a Definition Type
panel.
Include all file records.
Y. Include all of the records in the file.
N. Include only those records matching the Key Value, Start position,
and Length specified below.
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X. Exclude the records matching the Key Value, Start position, and
Length specified below.
Key value. If Include all file records is set to N or X, enter the
character string or extraction variable that will be the key value used in
selecting records to be included or excluded.

 If you are using a character string, enter the string.
 If you are using a value from an extraction variable, enter the extraction
variable, using the following format:
To specify a regular extraction variable, use the format (V-nnn), where
nnn is the extraction variable number. For example:
Chars.

1-40

(V-001)___________________________________________

To specify an extended extraction variable, use the format (XV-nnn),
where nnn is the extraction variable number. For example,
Chars.

1-40

(XV-001)__________________________________________

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number to be
used for record selection (this number is displayed automatically if you
used the mark-and-capture method). Otherwise leave the field blank.
Start position. If Include all file records is set to N or X, enter the
position number of the first character of the key value to be used to identify
the records to be included or excluded. If you are using mark-and-capture,
this defaults to the start position (0001 - 9999) of the marked value.
Length. If Include all file records is set to N or X, enter the length of
the key value (01-80) to be used to identify the records to be included or
excluded. If the key value is from an extraction variable, be sure to use the
length of the data that you want to use as the key value, which is not always
as long as the entire extraction variable value.

 If you chose to store the field value as an internal item, the Internal
Items panel displays. See “Defining Internal Items” on page 196

 If you chose to store the field value as an extended internal item, the
Extended Internal Items panel displays. See “Defining Extended
Internal Items” on page 199.
Then the system returns to the Extract Window.

Defining Total Records
To access the panel to define a total record, follow the instructions in
“Methods of Entering File Definitions” on page 287. From the Select a
Definition Type panel, select Total record to display the Total Record
panel.
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Total Record Panel
Total Record
Assign to internal item number: I 006
OR extraction variable number: ___ (1-999) Extended? N
Delimited data field number: ____ (1-1000
Field format:
Field position: ____ Length: __ __ 1. Numeric
2. Packed decimal
3. Zoned decimal
4. Binary
5. Unsigned packed
Negative sign indicator to use instead of default: __
Reverse the sign of this field? N (Y/N)
Extract decimal indicator: N (Y/N)
Include all file records? _ (Y/N/X)
Specify which records to include/exclude:
Key value:
----+----1----+----2----+----3----+----4
Chars. 1-40 ________________________________________
Chars. 41-80 ________________________________________
Delimited data field number: ____ (1-1000)
Start position: 0033 Length: __
F1=Help
F2=Split
F3=Exit
F5=Accept F6=ExtVar F9=Swap

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Extraction variable number. If you want to assign the total value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item field on the Select a Definition Type
panel.
Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number to be
used to derive the total (this number is displayed automatically if you used
the mark-and-capture method). Otherwise leave the field blank.
Field position. Number of the first digit of the field to be totaled.
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Length. Number of positions in the field to be totaled.
Field format. Format of the data you are extracting. For more
information, see “Understanding Field Formats” on page 288.
Negative sign indicator to use instead of default. Complete to
override the default negative sign symbol in the user options file.
Reverse the sign of this field?. Enter Y to reverse the sign of the value.
Extract decimal indicator. This option is useful when extracting data
with mixed decimal places. For data where the field format is 1 (numeric),
indicate how you want decimals to be processed.
Y. When storing the extracted value in the destination field, the system
will not change the location of the decimal point. Instead, the decimal
places in the destination will be padded or truncated to match the
number of decimals specified in the destination panel.
N or blank. The system will use the following default (original)
processing: When storing the extracted value in the destination field,
the location of the decimal point will be changed if necessary, so that
the number of decimal places in the destination will match the number
of decimal places specified in the destination panel. No truncation or
padding of decimals will be performed.
Example:
The following table shows several source values along with the
corresponding values that will be stored in the destination field
depending on how you set the Extract Decimal Indicator field. In this
example, the number of decimals specified on the destination panel is
2.
Extract Decimal
Indicator = Y

Extract Decimal
Indicator = N

Stored Value

Stored Value

123.0

123.00 (pad)

12.30

123

123.00 (pad)

1.23

123.00

123.00

123.00

123.00125

123.00 (truncate)

123001.25

Source Value

Include all file records.
Y. Include all of the records in the file.
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N. Include only those records matching the Key Value, Start Position,
and Length specified below.
X. Exclude the records matching the Key Value, Start position, and
Length specified below.
Specify which records to include/exclude:
Key value. If Include all file records is set to N or X, enter the
character string or extraction variable that will be the key value used in
selecting records to be included or excluded.

 If you are using a character string, enter the string.
 If you are using a value from an extraction variable as the key, enter the
extraction variable, using the following format:
To specify a regular extraction variable, use the format (V-nnn), where
nnn is the extraction variable number. For example:
Chars.

1-40

(V-001)___________________________________________

To specify an extended extraction variable, use the format (XV-nnn),
where nnn is the extraction variable number. For example,
Chars.

1-40

(XV-001)__________________________________________

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number to be
used for record selection (this number is displayed automatically if you
used the mark-and-capture method). Otherwise leave the field blank.
Start position. If Include all file records is set to N or X, enter the
position number of the first character of the key value to be used to identify
the records to be included or excluded. If you are using mark-and-capture,
this defaults to the start position (0001 - 9999) of the marked value.
Length. If Include all file records is set to N or X, enter the length of
the key value (01-80) to be used to identify the records to be included or
excluded. If the key value is from an extraction variable, be sure to use the
length of the data that you want to use as the key value, which is not always
as long as the entire extraction variable value.

 Press F5 to accept. If you chose to store the field value as an internal
item, the Internal Items panel displays. See “Defining Internal Items”
on page 196.

 If you chose to store the field value as an extended internal item, the
Extended Internal Items panel, described in “Defining Extended
Internal Items” on page 199, displays.
Then the system returns to the Extract Window.
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Defining Hash Records
This type of file definition hashes a sequential input file and derives a hash
value of one of the following: 1) All records in the file (if no key value is
specified), or 2) records that match a specified key value, or 3) records that
do not match a specified key value.
For example, you could define hashing of an input source in two jobs, job A
and job B. The hash value from job A needs to be stored in the history
database.
In Job B you could use a rule to compare the hash value it obtains with the
hash value from job A. If the hash values were the same, you would know
that the input files hashed in the two jobs were identical.
If ACR/Connector is used, hash values from jobs that reside on different
platforms can be compared. The files hashed must be in the same format,
for example both ASCII or both EBCDIC.
To obtain the hash value of the input file, from the Select a Definition Type
panel, select Hash record to display the Hash Record panel
Hash Record Panel.
Hash Record
Assign to internal item number: I 005
or
extraction variable number: ___ (1-999)

Extended? N

Record information
Include all file records? _ (Y/N/X)
Specify which records to include/exclude:
Key value:
----+----1----+----2----+----3----+----4
Chars. 1-40 ________________________________________
Chars. 41-80 ________________________________________
Delimited data field number: ____
Start position: 0032 Length: __

F1=Help

F2=Split

F3=Exit

F5=Accept

(1-1000)

F6=ExtVar

F9=Swap

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
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Extraction variable number. If you want to assign the hash value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item field on the Select a Definition Type
panel.
Include all file records.
Y. Include all of the records in the file.
N. Include only those records matching the Key Value, Start Position,
and Length specified below.
X. Exclude the records matching the Key Value, Start position, and
Length specified below.
Key value. If Include all file records is set to N or X, enter the
character string or extraction variable that will be the key value used in
selecting records to be included or excluded.

 If you are using a character string, enter the string.
 If you are using a value from an extraction variable, enter the extraction
variable, using the following format:
To specify a regular extraction variable, use the format (V-nnn), where
nnn is the extraction variable number. For example:
Chars.

1-40

(V-001)___________________________________________

To specify an extended extraction variable, use the format (XV-nnn),
where nnn is the extraction variable number. For example,
Chars.

1-40

(XV-001)__________________________________________

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number to be
used for record selection (this number is displayed automatically if you
used the mark-and-capture method). Otherwise leave the field blank.
Start position. If Include all file records is set to N or X, enter the
position number of the first character of the key value to be used to identify
the records to be included or excluded. If you are using mark-and-capture,
this defaults to the start position (0001 - 9999) of the marked value.
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Length. If Include all file records is set to N or X, enter the length of
the key value (01-80) to be used to identify the records to be included or
excluded. If the key value is from an extraction variable, be sure to use the
length of the data that you want to use as the key value, which is not always
as long as the entire extraction variable value.
Press F5 to accept.

 If you chose to store the field value as an internal item, the Internal
Items panel displays. See “Defining Internal Items” on page 196.

 If you chose to store the field value as an extended internal item, the
Extended Internal Items panel displays. See “Defining Extended
Internal Items” on page 199.
Then the system returns to the Extract Window.
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Creating File Definitions (Access Modes 6 and 7)
For information on these access modes, see “Selecting an Access Mode” on
page 270. To get started, follow the instructions in “Methods of Entering
File Definitions” on page 287. The Select a Definition Type panel will be
displayed
Select a Definition Type Panel (Access Modes 6-7)
Select a definition type:
__ 1. Selection field...
2. Reformat field...
3. Detail field...
For a selection field, enter comparison values
in extended format: N (Y/N)
F1=Help

F3=Exit

Select a definition type. Select the type of definition you want to create.
See the appropriate section below:
“Defining Selection Fields” on page 317
“Defining Reformat Fields” on page 330
“Defining Detail Fields” on page 334
Note:

You can also define a relative record. You must do this from the
Selection Field panel. See Defining Relative (Advance) Records
(Access modes 6-7) on page 330

For a selection field, enter comparison values in extended
format. Enter Y if your comparison value or values will be a number with
16 to 30 digits or a text value with 9 to 80 characters.

Defining Selection Fields
The Selection Field panel enables you to define the criteria for determining
whether the current record will be selected for further processing or
bypassed. The determination is made by evaluating a field extracted either
1) from the current record (this is called the input area) or 2) from a saved
extraction variable against the selection criteria defined in the lower section
of the panel.
To access the Selection Field panel to define a selection field, follow the
instructions in “Methods of Entering File Definitions” on page 287. From
the Select a Definition Type panel, select Selection Field.
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Selection Field Panel
If the access mode is 6, and Enter comparison values in extended format is
N, the following panel will be displayed.
Selection Field
----+----1----+----2----+----3----+----4
01:00 01:00AM
01:00PM
00060004
Input type:
1 1. Input Area
2. Extraction Variable
Delimited data field number: ____ (1-1000)
Field position: 00021 Field length:
Field format: 2 1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
Field type: __
1. Count
2. Amount
3. Text
Edit comments?
N (Y/N)
Line reference

----------------- Selection Criteria -----------------If blank is one of the comparison values, it must be entered here.
Value 1: ________________ Value 2: _______________
Additional? N (Y/N)
Selection type: __ 1. Equal to
2. Not =
3. Numeric 4. Alphabetic
5. Greater than 6. Less than 7. Blank
8. Nonblank
9. Within range 10.Begin =
11.End =
12.Locate =
13.Outside range14.Greater = 15.Less = 16.Advance
Extraction variable number:
(1-999) Extended? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

f the access mode is 6, and Enter comparison values in extended format is
Y, the following panel will be displayed.
Selection Field
----+----1----+----2----+----3----+----4
01:00 01:00AM
01:00PM
00060004
Input type:
1 1. Input Area
2. Extraction Variable
Delimited data field number: ____ (1-1000)
Field position: 00021 Field length:
Field format: 2 1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
Field type: __
1. Count
2. Amount
3. Text
Edit comments?
N (Y/N)
Line reference

----------------- Selection Criteria -----------------Selection type: __ 1. Equal to
2. Not =
3. Numeric
5. Greater than 6. Less than 7. Blank
9. Within range 10.Begin =
11.End =
13.Outside range14.Greater = 15.Less =
Extraction variable number:
(1-999)

F1=Help
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12.Locate =
16.Advance
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If the access mode is 7, and Enter comparison values in extended format is
N, the following panel will be displayed.
Selection Field
----+----1----+----2----+----3----+----4
01:00 01:00AM
01:00PM
00060004
Input type:
1 1. Input Area
2. Extraction Variable
Delimited data field number: ____ (1-1000)
Field position: 00021 Field length:
Field format: 2 1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
Field type: __
1. Count
2. Amount
3. Text
Edit comments?
N (Y/N)
----------------- Selection Criteria -----------------If blank is one of the comparison values, it must be entered here.
Value 1: ________________ Value 2: _______________
Additional? N (Y/N)
Selection type: __ 1. Equal to
2. Not =
3. Numeric 4. Alphabetic
5. Greater than 6. Less than 7. Blank
8. Nonblank
9. Within range 10.Begin =
11.End =
12.Locate =
13.Outside range14.Greater = 15.Less = 16.Advance
Extraction variable number:
(1-999) Extended? N (Y/N)
Additional field? 1 1. Any record 2. Same record 3. Not same record
F1=Help
F2=Split
F3=Exit
F5=Accept
F6=ExtVar
F9=Swap
Line reference

If the access mode is 7, and Enter comparison values in extended format is
Y, the following panel will be displayed.
Selection Field
----+----1----+----2----+----3----+----4
01:00 01:00AM
01:00PM
00060004
Input type:
1 1. Input Area
2. Extraction Variable
Delimited data field number: ____ (1-1000)
Field position: 00021 Field length:
Field format: 2 1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
Field type: __
1. Count
2. Amount
3. Text
Edit comments?
N (Y/N)
----------------- Selection Criteria -----------------Selection type: __ 1. Equal to
2. Not =
3. Numeric 4. Alphabetic
5. Greater than 6. Less than 7. Blank
8. Nonblank
9. Within range 10.Begin =
11.End =
12.Locate =
13.Outside range14.Greater = 15.Less = 16.Advance
Extraction variable number:
(1-999)
Additional field? 1 1. Any record 2. Same record 3. Not same record
Line reference

F1=Help

F2=Split

F3=Exit
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F6=ExtVar

F9=Swap
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Line Reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor. If
you complete all required fields and press Enter, this field will be updated
to include only the number of positions you indicated in the Field Length
field.
Input type. The source of the data to be evaluated:
1. Input Area. The source will be data from specific positions of the

current record.
2. Extraction Variable. The source will be data from specific positions in a

saved extraction variable.
Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Field Position. The first position of the selection field. This number is
displayed automatically if you used the mark-and-capture method.
Otherwise you need to enter it.
Note:

If you are extracting from an extraction variable and you want to
evaluate the entire value in the extraction variable, use zeroes
for Position and Length.

Field length. The number of positions to be evaluated. The maximum
length depends on the data format of the input and on whether the input
area or extraction variable you are using as input is in regular or extended
format. See “Maximum Lengths for Regular and Extended Data” on
page 196. To evaluate the entire value of an extraction variable (up to the
maximum length), use zeroes for position and length.
Field format. Format of the data you are extracting. For more
information, see “Understanding Field Formats” on page 288. This field
should be blank if the Selection Type is 16 (Relative/Advance Record).
Field Type. Type of data the field contains. The field will be stored as this
type.
Edit comments. Enter Y to add/edit your comments or description. A
maximum of 195 characters are allowed. The default value is N.
Selection Criteria:
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Value 1. This field displays if your entry in the For a selection field,
enter comparison values in extended format field on the “Select a
Definition Type Panel (Access Modes 6-7)” on page 317 was N.
Leave this blank if you are comparing against an extraction variable or if
selection type is 3 - Numeric, 4 - Alphabetic, 7 - Blank, or 8 - Nonblank.
Otherwise enter the value (or, for range comparisons, the first value of the
range) to be compared to the selection field. The maximum number of
characters you can enter varies based on the Field Format:

 Alphanumeric. Up to 8 characters.
 Any numeric format. Up to 16 bytes (a sign and 15 digits). However,
when batch records are created, this value is split across 2 fields in the
batch record (Value 1 and Value 2). Therefore, do not edit this field in
batch cards.
Note:

 The length of the selection value must match the field length. If it
does not, the system will not find a match.
 When batch records are created, numeric value is split across 2
fields in the batch record (Value 1 and Value 2). Therefore, do not
edit this field in batch cards.

Value 2. This field displays if your entry in the For a selection field,
enter comparison values in extended format field on the “Select a
Definition Type Panel (Access Modes 6-7)” on page 317 was N.
Complete if Selection Type is Within Range or Outside Range. See Value 1
for the maximum number of characters for alphanumeric and numeric
formatted values. Do not edit this field in batch cards.
Additional? This field displays if your entry in the For a selection field,
enter comparison values in extended format field on the “Select a
Definition Type Panel (Access Modes 6-7)” on page 317 was N.
Depending on your input type and selection type, you can evaluate against
multiple constants or ranges by entering Y in this field and completing the
panel that displays after you press F5.
Selection Type. Type used to evaluate the value from the input record or
extraction variable or, in the case of option 16, to create an advance record
(relative record). Valid values are:
1. Equal to. If Input type is Input Area, select the record if the data is

equal to Value 1 or to the value of the specified extraction variable. If
Input Type is Extraction Variable, select the record if the extraction
variable value is equal to Value 1.
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2. Not =. If Input type is Input Area, select the record if the data is not

equal to Value 1 or it is not equal to the value of the specified extraction
variable. If Input Type is Extraction Variable, select the record if the
extraction variable value is not equal to Value 1.
3. Numeric. Select the record if the data extracted from the input area or

extraction variable is numeric. Numeric characters are 0, 1, 2, 3, 4, 5, 6,
7, 8, 9.
4.

Alphabetic. Select the record if the data extracted from the input area
or extraction variable is alphabetic. Alphabetic characters are a letter
or a space character.

5. Greater than. If Input Type is Input Area, select the record if the

extracted data is greater than Value 1 or greater than the value of the
specified extraction variable. If Input Type is Extraction Variable,
select the record if the extraction variable value is greater than Value 1.
6. Less than. If Input Type is Input Area, select the record if the extracted

data is less than Value 1 or less than the value of the specified
extraction variable. If Input Type is Extraction Variable, select if the
extraction variable value is less than Value 1.
7. Blank. Select the record if the data extracted from the input area or

extraction variable is blank. A blank is a space.
8. Nonblank. Select the record if the data extracted from the input area or

extraction variable is not blank. A blank is a space.
9. Within range. Select the record if the data extracted from the input

area or extraction variable is within the range of Value 1 through Value
2. Data matching Value 1 or Value 2 is considered within range and
would be selected.
10. Begin = (to Value 1). Bypass all other records and begin processing

with the first record where the data extracted from the input area or
extraction variable is equal to Value 1. Do not process any other file
definitions until this record is found.
11. End = (to Value 1). End after processing the first record where the

extracted data is equal to Value 1 or equal to the value of the specified
extraction variable.
12. Locate = (to Value 1). Bypass all other records and locate the next

record where the data extracted from the input area or extraction
variable is equal to Value 1.
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13. Outside range. Select the record if the data extracted from the input

area or extraction variable is outside the range of Value 1 through
Value 2. Data matching Value 1 or Value 2 is considered within range,
and would not be selected.
14. Greater =. If Input Type is Input Area, select the record if the extracted

data is greater than or equal to value 1 or greater than or equal to the
value of the specified extraction variable. If Input Type is Extraction
Variable, select the record if the extraction variable value is greater
than or equal to Value 1.
15. Less =. If Input Type is Input Area, select the record if the extracted

data is less than or equal to Value 1 or less than or equal to the value of
the specified extraction variable. If the Input Type is Extraction
Variable, select the record if the extraction variable value is less than or
equal to Value 1.
16. Advance (Relative record). Valid only if Input Type is blank. From the

current record (or from the beginning of the file), move forward the
number of records that you will indicate on the next panel. When this
record is found, process the remaining file definitions.
Extraction Variable Number. If Input Type is Extraction Variable,
enter the number of the extraction variable. If Input Type is Input Area and
you are evaluating against the value of an extraction variable, enter the
extraction variable number you are evaluating against. To select from the
list of existing extraction variables, press F6. If you enter a number for an
extraction variable that has not yet been defined, the “Extraction Variables
Panel” on page 205 will be displayed.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number up to 16 bytes long (30 digits) or text that up to 80
characters long. When setting this indicator, you must be consistent. See
“Maximum Lengths for Regular and Extended Data” on page 196.
Depending on your entries, after you press F5, additional panels may be
displayed:

 If your entry in the For a selection field, enter comparison
values in extended format field on the “Select a Definition Type
Panel (Access Modes 6-7)” on page 317 was N, one of the following
panels will be displayed:

 If you entered Y in the Additional field, and you are comparing
against one or more individual values in addition to the constant
defined by Value 1, the “Additional Comparison Values Panel” on
page 325 will be displayed.
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 If you entered Y in the Additional field, and you are comparing
against one or more ranges in addition to the range defined by Value
1 and Value 2, the “Additional Comparison Ranges Panel” on
page 325 will be displayed.

 If your entry in the For a selection field, enter comparison
values in extended format field on the “Select a Definition Type
Panel (Access Modes 6-7)” on page 317 was Y, one of the following
panels will be displayed:

 If you are comparing against one or more individual alphanumeric
values, the "Comparison Values (Extended Format Alphanumeric)" in the following section will be displayed.

 If you are comparing against one or more individual numeric
values, the “Comparison Values (Extended Format - Numeric)” on
page 327 will be displayed.

 If you are comparing against one or more alphanumeric ranges, the
“Comparison Ranges (Extended Format - Alphanumeric)” on
page 328 will be displayed.

 If you are comparing against one or more numeric ranges, the
“Comparison Ranges (Extended Format - Numeric)” on page 329
will be displayed.

 If your entered Y in the Edit comments field, the “Edit Comments
Panel” on page 329 will be displayed.
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Additional Comparison Values Panel
Use this panel if you want to evaluate a value extracted from the current
record or from an extraction variable against one or more values in addition
to the constant defined by Value 1 on the Selection Field panel. A maximum
of 56 additional values can be defined.
Additional Comparison Values
Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F1=Help

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F2=Split

F3=Exit

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F5=Accept

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F9=Swap

Additional Comparison Ranges Panel
Use this panel if you want to evaluate a value extracted from the current
record or from an extraction variable against one or more ranges in
addition to the range defined by Value 1 and Value 2 on the Selection Field
panel. A maximum of 28 additional ranges can be defined.
Additional Comparison Ranges
From Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F1=Help

To Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F2=Split
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F3=Exit

From Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F5=Accept

To Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F9=Swap
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Comparison Values (Extended Format - Alphanumeric)
Use this panel to evaluate a value extracted from the current record or from
an extraction variable against up to 8 extended alphanumeric values. To
include blanks in the comparison, leave Value 1 blank. Any other blank
fields will be ignored. This field is case sensitive.
Comparison Values (Extended Format - Alphanumeric)
If blank is one of the comparison values, leave Value 1 blank.
----+----1----+----2----+----3----+----4
Value 1:
________________________________________
________________________________________
Value 2:
________________________________________
________________________________________
Value 3:
________________________________________
________________________________________
Value 4:
________________________________________
________________________________________
Value 5:
________________________________________
________________________________________
Value 6:
________________________________________
________________________________________
Value 7:
________________________________________
________________________________________
Value 8:
________________________________________
________________________________________
F1=Help
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Comparison Values (Extended Format - Numeric)
Use this panel to evaluate a value extracted from the current record or from
an extraction variable against up to 28 numeric values of up to 30 digits
plus a sign. To include zero in the comparison, leave the first numbered
value field blank, and it will be processed as a zero. Any other blank fields
will be ignored.
Comparison Values (Extended Format - Numeric)
If blank is one of the comparison values, leave Value 1 blank.

1:
3:
5:
7:
9:
11:
13:
15:
17:
19:
21:
23:
25:
27:

Comparison Value
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F1=Help

F2=Split
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F3=Exit

2:
4:
6:
8:
10:
12:
14:
16:
18:
20:
22:
24:
26:
28:

Comparison Value
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F5=Accept

F9=Swap
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Comparison Ranges (Extended Format - Alphanumeric)
Use this panel to evaluate a value extracted from the current record or from
an extraction variable against up to 4 alphanumeric ranges made up of
values up to 80 characters in length. To include blanks in the comparison,
leave Value 1 from blank. Any other blank fields will be ignored. This field
is case sensitive.
Comparison Ranges (Extended Format - Alphanumeric)
If blank is one of the comparison values, leave Value 1 blank.
----+----1----+----2----+----3----+----4
Value 1 From: ________________________________________
________________________________________
To: ________________________________________
________________________________________
Value 2 From: ________________________________________
________________________________________
To: ________________________________________
________________________________________
Value 3 From: ________________________________________
________________________________________
To: ________________________________________
________________________________________
Value 4 From: ________________________________________
________________________________________
To: ________________________________________
________________________________________
F1=Help
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Comparison Ranges (Extended Format - Numeric)
Use this panel to evaluate a value extracted from the current record or from
an extraction variable against up to 14 numeric ranges made up of values of
up to 30 digits plus a sign. To include zero in the comparison, leave Value
1 from blank, and it will be processed as a zero. Any other blank fields will
be ignored.
Comparison Ranges (Extended Format - Numeric)
If blank is one of the comparison values, leave Value 1 blank.

Value
Value
Value
Value
Value
Value
Value
Value
Value
Value
Value
Value
Value
Value

1:
2:
3:
4:
5:
6:
7:
8:
9:
10:
11:
12:
13:
14:

F1=Help

From
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F2=Split

F3=Exit

To
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F5=Accept

F9=Swap

Edit Comments Panel
Use this panel to edit or add your comments to the file definition. A
maximum 0f 195 characters are allowed in the comment field. Comments
are not allowed if the input source is a DB2 table.
Comments
----+----1----+----2----+----3----+----4----+----5----+----6----+
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________

F1=Help

F2=Split
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F5=Accept
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Defining Relative (Advance) Records (Access modes 6-7)
This type of relative record (also called advance record) is available in
access modes 6 and 7. (To understand relative records in access modes 1
through 4, see “Defining Relative Records (Access Modes 1-4)” on
page 295.)
This record type locates a record by advancing a specified number of
records forward in relation to the last record selected. It is typically used
when there is no unique key value in the record from which you want to
extract data. A relative record does not have to be part of a selection group.
It can be defined before the first selection group. In this case, the system
advances the specified number of records from the first record in the file.
When the system encounters a relative record, no other file definitions are
processed until the new record is found. Then the remaining file definitions
will be processed against the new record.
Relative Record Selection Panel
To access the panel to define a relative (advance) record, follow the
instructions in “Methods of Entering File Definitions” on page 287. From
the Select a Definition Type panel, select Selection field. When the
Selection Field panel displays, blank out the Input type field and set the
Selection Type to 16 (Advance). The Relative Record Selection Field
panel will be displayed.
Relative Record Selection Field Panel (Access Modes 6-7)
Relative Record Selection Field
Specify number of lines to advance before . . . . . . . :
evaluating additional selection criteria: . . . 001 (1-999)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify number of lines. Number of records to move forward (advance)
relative to the last record selected.

Defining Reformat Fields
Reformat fields are used in access modes 6 and 7 to change the positions
and/or formats of fields from the input source or from a specified literal.
Reformat fields are often used to combine multiple fields from an input
source to create one continuous string of characters. The reformatted string
can then be used to define a selection field or detail field.
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When reformat field definitions are used, a copy of the input record is made
in memory and the reformatting is done to this copy. The data in the input
source or literal is not reformatted.
You can then reformat the copied record with data and/or with literals
supplied in the reformat field definitions. Any combinations of data and
literals can be reformatted.
For example, suppose your input source contains a social security number
you want to extract. In the input source, the number is formatted with
hyphens as follows:
111-22-3333
To extract it without hyphens, you need to define 2 reformat records:

 One record to move the 22 to the left 1 position.
 One record to move the 3333 to the left 2 positions.
If you do this, the result will be 11122333333 (in memory) because the last
2 3’s from the original field are not overlayed. You could then use the first
9 positions (the reformatted social security number) in subsequent
selection field or detail field definitions.
A reformat field can be defined before or after a selection statement, as
follows:
Reformat Before Selection
Reformat fields defined before a selection group stand alone and are not
part of the group. These reformat fields will be applied to each and every
input record before any other definitions are processed. The subsequent
selection or detail field definitions will refer not to the original input data
and positions, but to the reformatted data and positions.
Reformat After Selection
Reformat fields can also be defined after selection (within a selection group
and/or between the selection fields). These reformat fields are part of the
selection group and are only processed against input records satisfying the
selection group’s criteria. If the reformat field is processed, the value will be
changed for all subsequent selection groups.
Reformat Data Types
Generally, you reformat data to the same type. For example, text to text or
numeric to numeric. If you reformat text to numeric, be aware that after the
data is copied to the new location, each position of the output area is
checked, and non-numeric characters are replaced with a zero. For
example, if you reformat 09/01/29 from text to numeric, the result will be
09001029.

ACR/Summary User Guide for z/OS

331

7  Creating File Definitions
Creating File Definitions for the Selected Access Mode

You may need to reformat a packed field to numeric because you cannot
pick up part of a packed field. In this case you would use the reformat to
“unpack” the data. After the data has been reformatted from packed to
numeric, you can use a detail field to extract the portion you need.
Reformat Field Panel for Access Modes 6-7
To access the panel to define a reformat field, follow the instructions in
“Methods of Entering File Definitions” on page 287. From the Select a
Definition Type panel, select Reformat Field.
Reformat Field
Source of data:
1
1. Input record...
2. Literal record...
Edit comments?
F1=Help

N

(Y/N)

F3=Exit

Source of data. Indicate whether the data comes from an input record or
a literal that you will define and press Enter. Refer to the section below
corresponding to your selection.
Edit comments. Enter Y to add/edit your comments or description. A
maximum of 195 characters are allowed. The default value is N. For more
information, see “Edit Comments Panel” on page 329.
Reformat Field Source (Input Record) Panel for
If you selected Input Record as the source of data that is being reformatted
in the initial Reformat Field panel, the Reformat Field Source (Input
Record) panel displays.
Reformat Field Source (Input Record)
----+----1----+----2----+----3----+----4
TOTAL RETAIL PRICE OF SALES
47.94
Delimited data field number: ____ (1-1000)
Line reference

Field position: 0001

F1=Help
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F2=Split

Field length: __

F3=Exit

Field format:
__ 1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

F5=Accept

F9=Swap
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Line reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor.
Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Field Position. The first position of the field to reformat. This number is
displayed automatically if you used the mark-and-capture method.
Otherwise you need to enter it.
Field length. Length of the field to reformat. Extended data lengths are
supported. The maximum length depends on the specified field format. For
valid lengths, see “Maximum Lengths for Regular and Extended Data” on
page 196.
Note:

If you press Enter, the Line Reference field adjusts to show the
number of positions you indicated in this field.

Field format. Format of the data you are extracting. For more
information, see “Understanding Field Formats” on page 288.
Press F5 to accept. The Reformat Field (Output Record) panel displays.
Reformat Field Source (Literal Area) Panel
If you selected Literal Area as the source of data that is being reformatted
in the initial Reformat Field panel, the Reformat Field (Literal Area) panel
displays.
The reformatted data can then be placed in one of the following:

 An output area.
 The note area of the output record. This is an 80-character line printed
on the Control Report and saved in the history database if the job stores
history.
Reformat Field Source (Literal Area)
Literal area: ____________________
If you do not want to use
the entire literal, specify:
Position: ____
F1=Help
F9=Swap

Length: __

F2=Split
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Literal area. Literal to be placed in the note or output area.
Position. Input field position relative to the beginning of the literal area
(0001-0080).
Length. Length of the literal (01-80).
Press F5 to accept.
Reformat Field Destination Panel
After you identify the source of the reformat data and press F5 to accept, the
following panel displays.
Reformat Field Destination
Delimited data field number: ____
Field position: ____

F1=Help

F2=Split

(1-1000)
Field format:
Field length: __ 2_ 1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary

F3=Exit

F5=Accept

F9=Swap

Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and the field
is being reformatted to the delimited data area of the file, enter the field
number (this number is displayed automatically if you used the mark-andcapture method). Otherwise leave the field blank.
Field position. First position of the output field.
Field length. Length of the output field. For valid lengths, see “Maximum
Lengths for Regular and Extended Data” on page 196.
Field format. Format of the output field.
Press F5 to accept.

Defining Detail Fields
A detail field does one of the following:

 Extracts data from specified positions of 1) the currently selected record
or 2) an extraction variable.

 Tallies (counts) the selected records (no values are extracted).
The result can be assigned to an internal item or extraction variable, either
of which can be regular or extended, and can be stored as one of the
following:
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A total of the extracted values.
The date-count value for the last date extracted.
The last text value extracted.
A tally of the selected records.

Use the following procedure to identify a detail field.
In the Extract Window, place the cursor on the first position of the field you
want to identify as the detail field and press F6 to display the Definition
Type panel. Select Detail Field to display the Detail Field panel.
Detail Field Panel
Detail Field
Select an input source:
1
1. Input record...
2. Extraction variable...
Specify a destination:
1
1. Internal item...
2. Extraction variable...
Is the destination an extended item? Y
Edit comments? N

F1=Help

(Y/N)

(Y/N)

F3=Exit

Select an input source. The source of data from which the extracted
value is to be defined:
1. Input Record. The data being extracted is from the currently selected

input record.
2. Extraction variable. The data being obtained is from an extraction

variable.
Specify a destination. The destination of the extracted values:
1. Accumulate and store the extracted data in an internal (or extended

internal) item.
2. Store the data in an extraction variable for use in a later definition.

Is the destination an extended item? Enter Y if the extracted value will
be a number with 16 to 30 digits or a text value with 9 to 80 characters.
Edit comments. Enter Y to add/edit your comments or description. A
maximum of 195 characters are allowed. The default value is N.
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Press Enter to continue. Depending on your choices in the Detail Field
panel, one of the panels described in the following sections will display:

 If you selected Input Record as the source, see “Detail Field Source
(Input Record) Panel” on page 336.

 If you selected Extraction Variable as the source and Internal Item as
the destination, see “Detail Field Destination (Internal Item) Panel
(Source is Extraction Variable, Destination is Internal Item)” on
page 343.

 If you selected Extraction Variable as the source and Extraction
Variable as the destination, see “Detail Field Destination (Extraction
Variable) Panel (Source and Destination Are Extraction Variable)” on
page 345.

 If your entered Y in the Edit comments field, the “Edit Comments
Panel” on page 329 will be displayed.
Detail Field Source (Input Record) Panel
If you selected Input Record as the source, the Detail Field Source (Input
Record) panel displays.
Detail Field Source (Input Record)
----+----1----+----2----+----3----+----4
ADD TRANSACTIONS
1
2,000
2,901
Delimited data field number: ____ (1-1000)
Field format
Field position: 00001 Field length: __
1_ 1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed
Line reference

Extract decimal indicator: N (Y/N)
Negative sign indicator to be used instead of default: __
Is this field a date field? N (Y/N)
Will this field be translated using a translation table? N
Reverse the sign of this field? N (Y/N)
Is this field a time field? Y (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

Line Reference. The field displays data from where you placed the cursor
in the input source and to the right.
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Delimited data field number. If you entered Y for Use delimited
data fields on the Physical Sequential File Information panel and you are
extracting from the delimited area of the file, enter the field number (this
number is displayed automatically if you used the mark-and-capture
method). Otherwise leave the field blank.
Field Position. The first position of the detail field.
Field Length. Length (1-80) of the detail field. Maximum lengths vary
depending on your choice in the Field Format field. For maximum lengths,
see “Maximum Lengths for Regular and Extended Data” on page 196.
Field format. Format of the data you are extracting. For more
information, see “Understanding Field Formats” on page 288.
Extract decimal indicator. This option is useful when extracting data
with mixed decimal places. For data where the field format is 1 (numeric),
indicate how you want decimals to be processed.
Y. When storing the extracted value in the destination field, the system will
not change the location of the decimal point. Instead, the decimal places in
the destination will be padded or truncated to match the number of
decimals specified in the destination panel.
N or blank. The system will use the following default (original)
processing: When storing the extracted value in the destination field, the
location of the decimal point will be changed if necessary, so that the
number of decimal places in the destination will match the number of
decimal places specified in the destination panel. No truncation or padding
of decimals will be performed.
Example:
The following table shows several source values along with the
corresponding values that will be stored in the destination field depending
on how you set the Extract Decimal Indicator field. In this example, the
number of decimals specified on the destination panel is 2.
Extract Decimal
Indicator = Y

Extract Decimal
Indicator = N

Stored Value

Stored Value

123.0

123.00 (pad)

12.30

123

123.00 (pad)

1.23

123.00

123.00

123.00

123.00125

123.00 (truncate)

123001.25

Source Value
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Negative sign to be used instead of default. Optionally complete with
a symbol if you want to use a negative sign other than the default negative
sign in the user options.
Is this field a date field? Enter Y if this field is a date.
Will this field be translated using a translation table? Enter Y if
this field will be translated.
Reverse the sign of this field?. Enter Y to reverse the sign of the field.
Is this field a time field? Enter Y if this field is a time.
Press F5 to accept. Depending on how you completed the fields, one of the
panels described in the following sections will display:

 If you specified that the field is a date and your destination is an internal
(or extended internal) item, see "Detail Field Destination (Internal
Item) Panel (Source is Input Record, Destination is Internal Item, Not
a Date)" below.

 If you did not specify that the field is a date and your destination is an
internal (or extended internal) item, see “Detail Field Destination Date (Internal Item) Panel (Source is Input Record, Destination is
Internal Item, Field is a Date)” on page 339.

 If you specified that the field is a date and your destination is an
extraction variable, see “Detail Field Destination (Extraction Variable)
Panel (Source is Input Record, Destination is Extraction Variable, Field
is a Date)” on page 341.
Detail Field Destination (Internal Item) Panel (Source is Input Record,
Destination is Internal Item, Not a Date)
Detail Field Destination (Internal Item)
Assign the extracted detail value
to internal item number: I 001 (1-100)
Set a processing option for the extracted values:
_ 1. Accumulate the extracted detail values
2. Tally the extracted detail values
3. Extract the last value
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.
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 A 3-digit item number. This number is assigned by the system, but you
can change it.
Set a processing option for the extracted values. Options:
1. Accumulate the extracted detail values. Total all count or amount

values extracted from the selected records.
2. Tally the extracted detail values. Count (tally) the number of times the

detail field was processed.
3. Extract the last value. Retrieve the value from the last selected record.

Press F5 to accept. Complete the panel that displays. See “Defining Internal
Items” on page 196 or “Defining Extended Internal Items” on page 199
After completing the panel, press F5. If you chose to translate the value, the
Translation Table Information panel displays. See “Translation Table
Information Panel” on page 342. Otherwise, the system returns to the
Extract Window.
Detail Field Destination - Date (Internal Item) Panel (Source is Input
Record, Destination is Internal Item, Field is a Date)
Detail Field Destination - Date (Internal Item)
Assign the extracted date-count value
to internal item number: I 001 (1-100)
Specify
_ 1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

the date input format:
YYMMDD
MMDDYY
MMDDCCYY
DDMMYY
YYJJJ
DDMMCCYY
CYYMMDD
CCYYMMDD
CCYYJJJ
DDMMMYY
DDMMMCCYY
MMMDDYY
MMMDDCCYY

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Assign the extracted date-count value to internal item number.
The internal item or extended internal item where the value will be stored.
This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.
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 A 3-digit item number. This number is assigned by the system, but you
can change it.
Specify the date input format. For more information on dates, see
“Date and Cycle Number Extraction and Processing” on page 351. The date
formats shown on this panel are explained in “Date Formats that Use DD,
MM, C, CC, YY, JJ, and/or MMM” on page 353.
Press F5 to accept. The Internal Items panel displays. See “Defining
Internal Items” on page 196.
After completing the panel, press F5. If you chose to translate the value, the
Translation Table Information panel displays. See “Translation Table
Information Panel” on page 342. Otherwise, the system returns to the
Extract Window.
Detail Field Destination (Internal Item) Panel (Source is Input Record,
Destination is Internal Item, Field is a Time)
Detail Field Destination - Time (Internal Item)
Assign the extracted centisecond value
to internal item number: I 003 (1-100)
Specify the time input format: _
1. HHMM
2. HHMMSS
3. HHMMSSNN
AM/PM? N

F1=Help

(Y/N)

F2=Split

F3=Exit

F5=Accept

F9=Swap

Assign the extracted centisecond value to internal item number.
The internal item or extended internal item where the value will be stored.
This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Specify the time format and AM/PM. For more information on time,
see“Time Extraction and Processing” on page 355.
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Detail Field Destination (Extraction Variable) Panel (Source is Input
Record, Destination is Extraction Variable, Field is a Date)
Detail Field Destination (Extraction Variable)
Assign to extraction variable number: 004 (1-999) Extended? Y
Select a processing option:
Specify the date input format:
5
1. Accumulate the extracted values
1
1. YYMMDD
2. Tally the extracted values
2. MMDDYY
3. Extract the last value
3. MMDDCCYY
4. Store the extracted date
4. DDMMYY
5. Store the extracted time
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. CCYYMMDD
9. CCYYJJJ
10. DDMMMYY
11. DDMMMCCYY
12. MMMDDYY
13. MMMDDCCYY
If this is a time, specify input format: 2
AM/PM? N (Y/N)
1. HHMM
2. HHMMSS
3. HHMMSSNN
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

Assign the extracted value to extraction variable number. The
number of the extraction variable where the value of the field will be stored.
Defaults to the next available number. To select from the list of existing
extraction variables, press F6. If you enter a number for an extraction
variable that has not yet been defined, the “Extraction Variables Panel” on
page 205 will be displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item field on the on the “Detail Field Panel”
on page 335.
Select a processing option:
1. Accumulate the extracted detail values. Total all count or amount

values extracted from the selected records. Accumulate the extracted
detail values.
2. Tally the extracted detail values. Count (tally) the number of times the

detail field was processed.
3. Extract the last value. Retrieve the value from the last selected record.
4. Store the extracted date. Store the extracted date in date-count value.
5. Store the extracted time. Store the extracted time in time-count

(centisecond) value.
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Specify the date input format. field. For more information on dates,
see “Date and Cycle Number Extraction and Processing” on page 351. The
date formats shown on this panel are explained in “Date Formats that Use
DD, MM, C, CC, YY, JJ, and/or MMM” on page 353.
Press F5 to accept. If you chose to translate the value, the Translation Table
Information panel displays. See "Translation Table Information Panel"
below. Otherwise, the system returns to the Extract Window.
If this is a time, specify the input format and AM/PM. For more
information on time, see “Time Extraction and Processing” on page 355.
Translation Table Information Panel
Translation Table Information
Table name: ________________
If the translation value is not found:
_ 1. Print warning message (use spaces as translated value)
2. Suppress warning message (use spaces as translated value)
3. Print warning message (use extracted value to continue)
4. Suppress warning message (use extracted value to continue)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Table name. Name of the internal or external translation table that will be
used to translate the field value. If the table is internal, the field must be set
to in text format.
1. Print warning message (use spaces as translated value). Prints a

warning message and uses spaces as the detail field value.
2. Suppress warning message (use spaces as translated value).

Suppresses all warning messages uses spaces as detail field value.
3. Print warning message (use extracted value to continue). Prints the

warning messages and continues processing as if no translation was
attempted.
4. Suppress warning message (use extracted value to continue).

Suppresses the warning messages and continues processing as if no
translation was attempted.
Press F5 to accept and return to the Extract Window.
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Detail Field Destination (Internal Item) Panel (Source is Extraction Variable,
Destination is Internal Item)
Detail Field Destination (Internal Item)
Assign extraction variable number:
(1-999)
to internal item number: X 004 (1-100)

Extended? N

(Y/N)

If moving a portion of the extraction variable:
Move from position: 00020 for length of: 09
Reverse the sign of this field? N (Y/N)
Processing option:
Field format
_ 1. Accumulate the extracted detail values
_ 1. Packed decimal
2. Tally the extracted detail values
2. Alphanumeric
3. Extract the last value
4. Store the extracted value
Specify the date input Format:
1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. CCYYMMDD
9. CCYYJJJ
10. DDMMMYY
11. DDMMMCCYY 12. MMMDDYY
13. MMMDDCCYY
If this is a time, specify input format: 2
AM/PM? N (Y/N)
1. HHMM
2. HHMMSS
3. HHMMSSNN
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

Assign extraction variable number. Enter the number of the
extraction variable from which the detail field value will be extracted. To
select from the list of existing extraction variables, press F6. If you enter a
number for an extraction variable that has not yet been defined, the
“Extraction Variables Panel” on page 205 will be displayed.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number up to 16 bytes long (30 digits) or text that up to 80
characters long. When setting this indicator, you must be consistent. See
“Consistency in Specifying Extended Format for an Extraction Variable” on
page 201.
To internal item number. The internal item or extended internal item
where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
If moving a portion of the extraction variable:
Move from position. First position of the portion to be moved relative to
the first position of the extraction variable.
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For length of. Length of the extraction variable value portion to be stored
in the detail field.
Reverse the sign of this field?. Enter Y to reverse the sign of the field.
Y is valid only if the processing option is 1 (Accumulate the extracted detail
values).
Processing option. Set a processing option for the extracted values:
1. Accumulate the extracted detail values. Total all count or amount

values extracted from the selected records.
2. Tally the extracted detail values. Count (tally) the number of times the

detail field was processed.
3. Extract the last value. Retrieve the value from the last selected record.
4. Store the extracted date. Store the extracted date in date-count value.
5. Store the extracted time. Store the extracted time in time-count

(centisecond) value.
Field format. Specify the format of the Detail field. The extraction
variables are usually stored in the packed field format.
Specify the date input format. For more information on dates, see
“Date and Cycle Number Extraction and Processing” on page 351. The date
formats shown on this panel are explained in “Date Formats that Use DD,
MM, C, CC, YY, JJ, and/or MMM” on page 353.
After completing the panel, press F5. If you chose to translate the value, the
Translation Table Information panel displays. See “Translation Table
Information Panel” on page 342. Otherwise, the system returns to the
Extract Window.
Specify the time input format and AM/PM. For more information on
time, see “Time Extraction and Processing” on page 355.
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Detail Field Destination (Extraction Variable) Panel (Source and
Destination Are Extraction Variable)
Detail Field Destination (Extraction Variable)
Assign extraction variable number: ___ (1-999) Extended? N
to extraction variable number: 001 (1-999) Extended? N

(Y/N)

If moving a portion of the extraction variable:
Move from position: _____ for length of: __
Reverse the sign of this field? N (Y/N)
Processing option:
Field Format:
1 1. Accumulate the extracted detail values
_ 1. Packed decimal
2. Tally the extracted detail values
2. Alphanumeric
3. Extract the last value
4. Store the extracted date
5. Store the extracted time
Specify the date format: __
1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. YYMMDDCC
9. CCYYJJJ
10. DDMMMYY
11. DDMMMCCYY 12. MMMDDYY
13. MMMDDCCYY
If this is a time, specify format:
AM/PM?
(Y/N)
1. HHMM
2. HHMMSS
3. HHMMSSNN
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

Assign extraction variable number. Enter the number of the source
extraction variable. To select from the list of existing extraction variables,
press F6. If you enter a number for an extraction variable that has not yet
been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number up to 16 bytes long (30 digits) or text that up to 80
characters long. When setting this indicator, you must be consistent. See
“Consistency in Specifying Extended Format for an Extraction Variable” on
page 201
To extraction variable number. Displays the number of the extraction
variable where the value of the field will be stored. Defaults to the next
available number. To select from the list of existing extraction variables,
press F6. If you enter a number for an extraction variable that has not yet
been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item field on the “Detail Field Panel” on
page 335.
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Move from position. If you do not want to extract the entire contents of
the extraction variable referenced in the Assign extraction variable number
field, enter first position you want to extract relative to the beginning of the
extraction variable value.
For length of. If you completed the Move from position field, enter the
number of characters to extract starting with that position.
Reverse the sign of this field?. Enter Y to reverse the sign of the
variable’s value.
Processing option. Set a processing option for the extracted values:
1. Accumulate the extracted detail values. Total all count or amount

values extracted from the selected records.
2. Tally the extracted detail values. Count (tally) the number of times the

detail field was processed.
3. Extract the last value. Retrieve the value from the last selected record.
4. Store the extracted date. Store the extracted date in date-count value.
5. Store the extracted time. Store the extracted time in time-count

(centisecond) value.
Field format. Specify the format of the Detail field. The extraction
variables are usually stored in the packed field format.
Specify the date format. For more information on dates, see “Date and
Cycle Number Extraction and Processing” on page 351. The date formats
shown on this panel are explained in “Date Formats that Use DD, MM, C,
CC, YY, JJ, and/or MMM” on page 353.
Specify the time format and AM/PM. For more information on time,
see “Time Extraction and Processing” on page 355.
Capture File Name of the Input Source as an Internal Item
File name can be extracted from the input source or from an extraction
variable. Partial file name can be extracted. The extracted value can be
assigned to an internal item or extraction variable.
This option is available for Access Modes 1,2,3,4 for Field value, and for
Detail and Key field in Access modes 6,7,8.
If the file name is extracted from ‘Input Source’, the data set name of the
input source currently being processed is retrieved.
If multiple data sets are concatenated to the DDname of the input source,
the name of the first data set assigned to the input source is always
returned.

346

Infogix, Inc.

Creating File Definitions  7
Creating File Definitions for the Selected Access Mode

If the extraction variable is storing a file name (e.g. picked up from an input
record or a literal), you can also extract the value from the extraction
variable as file name.
You can extract file name using:

 Levels (total 20 levels)
 Position and length
If position and length are not entered, file name will be extracted using
levels.
If levels are used to extract the file name, a maximum of 8 level separators
are allowed. If no levels (‘from’ and ‘to’) are entered, the entire file name is
extracted.
NOTE: If multiple jobs are included in the JCL stream and some of them have the
same step name, the DDnames specified for the first job will be used for the file
name retrieval. If multiple data sets are assigned to the DDname of the input
source, the name of the first data set will be returned as the file name.
NOTE: When porting the definitions from one platform to the other, the file name
in the F0 card may be removed. It is because the structures of file name on different
platforms are not the same. Review and revise the definitions as needed.

File Definitions for DB2 Files
For more information, see Chapter 15, “Using DB2 Tables as Input Sources
on page 469.”
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Viewing, Editing and Deleting File Definitions
Viewing File Definitions
After you have finished specifying the file definitions, if you want to view
the definitions, from the Extract Window, select View > Definitions. The
definitions display in the Extract Window.
File Edit View Run Window Help
-------------------------------------------------------------------------Extract Window
Row 1 to 4 of 4
_
OCC 001 OF EMBEDDED KEY=TOTAL
_
PICK UP VALUE AT 0028 FOR 02, STORE IN
_
PICK UP VALUE AT 0044 FOR 05, STORE IN
_
PICK UP VALUE AT 0062 FOR 05, STORE IN
***************************** Bottom of data

I-001
I-002
I-003
******************************

Command Line ===> _________________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Press F3 to clear the definitions from the Extract Window.

Deleting an Input Source
To delete an input source or no longer use it in a job, select it with D in the
Job Window. The Delete Input Source panel will appear
Note:
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If you want to select multiple input sources for deletion, you must
first select and process each file DDName individually. Then, you
can save all the deletions simultaneously by selecting File, Save, F6
(Save All).
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Delete Input Source
You have chosen to delete the following input source:
File DDNAME: XXXXXXXX Qualifier:
File description: XXXXXXXX
Associated with the following DSName:
DSName: USERIDA.XXXXX.XXXXX(XXXXXX)
Specify
__ 1.
2.
3.

a deletion
Delete the
Delete the
Cancel the

option:
link between this input source and the job
link and the input source
deletion

WARNING! If you choose option 2, it will affect this
and all other jobs using this input source's file
DDNAME and its associated definitions.

F1=Help

F3=Exit

Specify a deletion option. Options:
1. Marks the File ID for unlinking. You will be able to re-link the input

source by selecting File > Copy > Copy file definitions to an
existing job ID.
2. Marks the File ID for unlinking and deleting. All associated file

definitions will also be deleted.
3. Confirm the deletion.

The File ID is not unlinked nor physically deleted until you complete the
Save process.

Editing File Definitions
Adding a Definition at the Bottom of the Display
1. From the Extract Window, select View > Definitions > Edit > Add.
2. Unless you specified otherwise in the basic file information, the input

source will be displayed. You can then use the standard mark-andcapture procedure (see “Mark-and-Capture Method” on page 287.

Changing a Definition
To change a definition displayed in the Extract Window Definition View,
select it. The definition panels you completed when you created the
definition will be displayed in sequence and you can change them.
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Inserting, Deleting, Copying, Moving, and Repeating Definitions
The following line commands, which are similar to ISPF edit line
commands, can be entered next to definition(s) displayed in the Extract
Window Definition View:
Command

Instructions

I (Insert)

Enables you to add a new definition that will be inserted on the
previous line. After you enter the I, the input source will be
displayed. You can then use the standard mark-and-capture
procedure to add the new definition.
1. Place the cursor on the first character of the item you want to
use in the new definition.
2. Press F6 (Add).
3. Specify the type of definition you want.
4. Complete the definition panels.

D and DD
(Delete)

These commands enable you to delete definitions.

C and CC
(Copy)

These commands copy one or more definitions. You can then
paste them at the specified location.

 To delete one definition, enter D.
 To delete a range of definitions, enter DD next to the first and
last definition in the range.
Note: You still need to delete any corresponding internal (or
extended internal) items by entering D next each item in the
Job Window.

 To copy one definition, enter C next to it.
 To copy a range, enter CC next to the first and last definition
in the range.
To paste the copied definitions, on the line below or above the
destination you want, enter A (paste above) or B (paste below).
R (Repeat)

Enables you to duplicate a definition similar to the one you want
to add. You can then modify it (see “Changing a Definition”
on page 349.

These line commands are not allowed to enter on the “Comment” line.
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Date and Cycle Number Extraction and Processing
Specifying the Position, Length, and Format of the Date to Extract
Position
When using the partial date format, the Position field should show the
first position of the portion of the date you want to extract. For example, if
you want to extract the century portion of the date 01/15/2013, the
Position field should show the first position of the century.
For more information on the partial date format, see “Partial Date Format”
on page 352.

Length
Length Should Include Date Separators
If the date uses separators such as spaces, commas, slashes, or periods,
include the separators in the length. The date separators will be stripped
out when the value is stored. For example:
01/15/2013 is a length of 10.
Jan. 01, 2013 is a length of 13.
Length for Partial Date (to Store as the Cycle Number)
When specifying a partial date the Length field should be the length of the
portion you want to extract (2 or 3). The length will be 3 when extracting a
month in 3-character format.
For more information on the partial date format, see “Partial Date Format”
on page 352.

Date or Cycle Format
A date or cycle specified for extraction should be formatted as numeric
unless it includes a 3-character month (mmm). A date or cycle that includes
a 3-character month should be formatted as alphanumeric.
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Date Format Options
Partial Cycle and As Is Formats
Following is an explanation of the partial date and as is options. These date
formats are available only when extracting dates for use in assigning the
cycle number.
Partial Date Format
The partial date format enables to you extract a 2-digit century (CC), 2-digit
year (YY), 2-digit month number (MM), 2-digit day number (DD), or 3character month (MMM for JAN, FEB, etc.)
Conversion of partial dates to cycle numbers:
The extracted characters will be converted to CCYYMMDD numeric format,
with the portions of the date not selected populated with zeros.
For example, if the date in the input file is 01/12/2013:

 And you use the partial date option to extract the century, the resulting
cycle number will be 20000000.

 And you use the partial date option to extract the month, the resulting
cycle number will be 00001200. You might use this option if you do not
want the century value to be automatically populated with 20 for cycle
numbers whose year value is less than or equal to 80.
Accept date As Is
The as is date format indicates that, in general, the extracted value will be
used as the cycle number with no changes. The exceptions are as follows:

 If you extract fewer than 8 digits, the system will fill the leftmost
positions with zeros.

 If you specify a value for extraction that includes a 3-character month,
the digits extracted will not be converted, but the 3 characters
representing the month will be converted to 2-digit format. For
example, if the value specified is 01.JAN.2013, the cycle number will be
01012013.
For information on specifying position and length when using the partial
date format, see “Position” on page 351 and “Length” on page 351
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Date Formats that Use DD, MM, C, CC, YY, JJ, and/or MMM
The formats listed below are available for extracting dates regardless of
Note:

Date formats use the following conventions:
dd represents the day number. Days less than 10 must have a
leading 0. For example, Jan 1, 2013 cannot be extracted, but Jan
01, 2013 can be extracted.
mm represents the 2-digit month number.
c represents the 1-digit century, where 0 = 19 (as in 1999) and 1
= 20 as in 2010.
cc represents the 2-digit century (CC).
yy represents the 2-digit year.
jjj represents the 3-digit Julian day.
mmm represents the 3-character month (JAN, FEB, etc.).

whether the date will be used as a cycle number. These formats identify the
format of the date in the input source (date separators are not relevant
because they will be stripped out):
YYMMDD
MMDDYY
MMDDCCYY
DDMMYY
YYJJJ
DDMMCCYY
CYYMMDD
CCYYMMDD
CCYYJJJ
DDMMMYY
DDMMMCCYY
MMMDDYY
MMMDDCCYY
If you want the system to pad leading zero for the month component or the
day component of the input date, enter the date separator.
If the input date always has leading zero for its components, do not enter
the date separator. The following date format/cycle formats allow
extraction of dates without the leading zeros:
YYMMDD
MMDDYY
MMDDCCYY
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DDMMYY
DDMMCCYY
CYYMMDD
CCYYMMDD
DDMMMYY
DDMMMCCYY
MMMDDYY
MMMDDCCYY

Calculation of Century Values
When the century is not extracted as part of the date, (in this case, the date
format contains dd, mm, yy, jjj, and/or mmm but no c or cc), the century is
calculated automatically. A century value of 20 is assigned for years less
than or equal to 80. Otherwise a century value of 19 is assigned.

Storage of Extracted Dates and Cycle Numbers
Storage of Extracted Dates
After the century is calculated (if required) as described in “Calculation of
Century Values” on page 354, extracted dates that are not used as cycle
numbers are stored internally as date count values.

Storage of Extracted Cycles
After the century is calculated (if required) as described in “Calculation of
Century Values” on page 354, extracted dates that are used as cycle
numbers are stored internally in CCYYMMDD format.

Display and Printing of Dates
The default format for display and printing of dates is MM/DD/YY.
Note:

Even if you select one of the formats that contain the century,
such as DDMMCCYY, to format dates on reports, only the last 2
digits of the year will print unless you specify Y for the Print
century before year field on the Date Formats panel.

You can control the following defaults through your user options as
described in “Date/Time Formats” on page 121:

 Order of the date elements.
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 Character to use as the date separator (instead of the default slash
mark).

 Display of leading zeros in days and months.
 Whether the century prints before the year. You may want to print the
century to verify that the correct century was calculated.
Note:

Another way to verify that the correct century was calculated is
to run the List History utility for detail values of the job ID in
question and examine the date count values stored in the internal
(or extended internal) items. If a date count value is more than
145731 (December 31, 1999), the century value was assumed to
be 20.

Time Extraction and Processing
Specifying the time format and AM/PM indicator of the extracted
Time
Time Format
Specify the time format of the input data. The following formats are
supported for the extracted time:

 HHMM (hour minute).
 HHMMSS (hour minute second).
 HHMMSSNN (hour minute second centisecond).
If the time has a separator (example a colon(:)), the separator is removed
when the value is extracted.
For example, consider the time format HHMM. The valid time values for
this format are listed below:
12-hour format

24-hour format

Midnight (Start of Day)
12:00 a.m.

00:00

12:01 a.m.

00:01

12:59 a.m.

00:59

1:00 a.m.

01:00

...

...
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12-hour format

24-hour format

11:00 a.m.

11:00

11:59 a.m.

11:59

12:00 p.m.

12:00

12:01 p.m.

12:01

12:59 p.m.

12:59

01:00 p.m.

13:00

...

...

11:00 p.m.

23:00

11:59 p.m.

23:59

Midnight (End of Day)
Shown as start of next day

AM/PM
Specify whether the extracted time contains the abbreviation AM or PM.

Storage of Extracted Time
The extracted time fields are stored internally as centisecond.

Extracting Directly from a Delimited Data File
You can extract delimited values directly from input source records in
delimited data files. This feature allows you to specify multiple delimiters,
including the tab character, for keys, items, and translation tables.

Procedure for Extracting Delimited Fields Directly
1. When setting up your input source, on the Physical Sequential File

Information panel (or Sequential Input File panel for external
translation tables), enter Y in the Use delimited data fields
indicator and complete the Delimited Data File Information panel.
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2. On the file definition panels, (or in the table build rules for external

translation tables) complete the Delimited data field number field
as follows: If you are extracting from the delimited area of the file,
enter the field number (this number is displayed automatically if you
used the mark-and-capture method). Otherwise leave the field blank.

Limitations
When extracting directly from delimited data files, the following limitations
apply:

 Direct delimited data extraction is supported only for physical
sequential files.

 Direct delimited data extraction is allowed only if the data is extracted
directly from the input record. It does not apply when extracting from
extraction variables or literals.

 For access modes 1-4 , the maximum number of records that can be
processed is 15,000.

 Maximums for a delimited data file:
 The maximum length allowed for the fixed data area is 1000.
 The maximum number of delimited data fields allowed per record
is 1,000.

 Delimited data cannot be reformatted to the note area.
 Partial extraction is allowed for all field formats. To extract the whole
field, leave the position and length fields set to zeros or spaces.
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Testing and Running Jobs Online
This chapter shows you how to test your definitions online and edit your
definitions if needed. It contains the following sections:

 “Testing File Definitions (Access Modes 1-2)” on page 359
 “Testing File Definitions (Access Modes 6-7)” on page 362
 “Testing Job Definitions Online” on page 366
When you are ready to run jobs in batch, see “Running Balancing Jobs and
Other JCL in Batch” on page 369.

Testing File Definitions (Access Modes 1-2)
In access modes 1-2, you have the following methods of testing definitions:

 Running step extraction. This feature allows you to perform a step-bystep review of how the system searches for and picks up data in the
input source and edit the definitions as appropriate. For more
information, see "Using Step Extraction" below.

 Using step X records. This feature allows you to alternate between
regular extraction and step extraction. This is useful when you want to
check specific areas in your input file. For more information, see “Using
Step X Records” on page 360.

 Running full extraction. This feature, unlike step extraction or step X
records, does not perform a step-by-step review, stopping at valules
that meet the criteria of the file definitions. It runs regular extraction
behind the scenes. To do this, in the Extract Window, select Run > Full
Extraction.
Regardless of the method you use, the system generates the Extracted
Values panel. See “Sample Extracted Values Panel” on page 361.

Using Step Extraction
You can use step extraction to perform a step-by-step review of how the
system searches for and picks up data in the input source. The cursor will
stop at any value in the input source that meets the criteria of the file
definitions as the corresponding definition displays at the bottom of the
window. The cursor does not stop at any location that does not meet the
criteria of the file definitions.
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Procedure for Step Extraction.
1. In the Extract Window, select Run > Step Extraction.

The cursor displays at the first defined field in the input source and the
corresponding definition displays at the bottom of the panel.
File Edit View Run Window Help
-------------------------------------------------------------------------Extract Window
File name: UPDT0501
LINES 00000020 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-TOTAL
67
9,800
9,867

THIS STEP=OCC 001 OF EMBEDDED KEY=TOTAL
Command Line ===> _______________________________________ SCROLL ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right

2. To complete the extraction, choose one of the following options:

 for each input source, select Run > Step Extraction
 select Run > Finish Extraction
When you select the second option, the entire extraction takes
place behind the scenes and the results are displayed in the
Extracted values panel. See “Sample Extracted Values Panel” on
page 361.
3. Continue to press Enter to continue through the file definitions. If an

extracted value is incorrect, press F3 to exit the Extracted Values
panel. On the Extract Window, select the incorrect item and press
Enter. Review and then edit the incorrect file definition. See “Viewing,
Editing and Deleting File Definitions” on page 348).
If you want to skip step extraction (using regular extraction instead)
for a given number of records, select Run > Step X records, as
described in the next section.

Using Step X Records
The Step X records option allows you to alternate between regular
extraction and step extraction if you want to focus on specific areas in your
input file.
For example, you may want to look specifically at two areas, but those
changes are separated by hundreds of records that your file definitions are
processing accurately. To test just those two areas, from the Extract
360
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Window you can select Run > Step X records and specify that you want
to process 300 records. The program will process the first three hundred
records using regular extraction, and then begin step extraction. After you
have examined those, you can select Run > Step X records again and
have the program process the 250 records before the next section you are
interested in. If you specify more records than remain in the input file, the
program processes the remaining records, finishes the extraction process
and takes you to the Extract Values Report.
When you reach the end of your input file or when you choose Finish
Extraction from the Run menu, the Extracted Values panel is displayed as
shown in “Sample Extracted Values Panel” on page 361.
Procedure for Using Step X Records
1. In the Extract Window, select Run > Step X records.
2. When the Step X Number of Records panel displays, enter the number

of records that you want the system to process using regular extraction
before beginning step extraction and press F5. The system processes
the number of records you specified using regular extraction and
begins step extraction as described in “Using Step Extraction” on
page 359. Correct errors as described in that section.
3. At any time you can do one of the following:

 Select Run > Finish Extraction to process the remaining records
using regular extraction.

 Select Run > Step X records and specify another number of
records to be processed using regular extraction, after which the
next records will be processed using step extraction.
4. When the last record has been processed, the Extracted Values panel

will be displayed.

Sample Extracted Values Panel
This report is produced by running step extraction, using step X records, or
running full extraction.
It shows each extracted value in the order it was encountered in the
extraction process. The two columns contain the internal (or extended
internal) item descriptions and the actual extracted values, respectively. If
an extracted value is incorrect, you can select the item from this panel and
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press Enter. The system takes you to the Definition review panel where you
can edit the definition. For more information, see “Viewing, Editing and
Deleting File Definitions” on page 348.
Extracted Values

Row 1 to 8 of 8

TEXT INTERNAL ITEM
TEXT1
COUNT INTERNAL ITEM
4021
AMOUNT INTERNAL ITEM
321.11
DATE INTERNAL ITEM
12012005
COUNT EXTENDED ITEM
1234567890123456789012341
AMOUNT EXTENDED ITEM
1234567890123456789.001111
TEXT EXTENDED ITEM
LONG TEXT OF 39 BYTES LONG FIRST
DATE EXTENDED ITEM
12012005
***************************** Bottom of data ******************************

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Testing File Definitions (Access Modes 6-7)
In access modes 6-7, you have the following methods of testing definitions:

 Running step extraction. This feature allows you to perform a step-bystep review of how the system searches for and picks up data in the
input source and edit the definitions as appropriate. For more
information, see "Using Step Extraction" below.

 Using step X records. This feature allows you to alternate between
regular extraction and step extraction. This is useful when you want to
check specific areas in your input file. For more information, see “Using
Step X Records” on page 364.

 Running full extraction. This feature, unlike step extraction or step X
records, does not perform a step-by-step review, stopping at valules
that meet the criteria of the file definitions. It runs regular extraction
behind the scenes. To do this, in the Extract Window, select Run > Full
Extraction.

 Step/Full extraction is supported for access modes 6 and 7. However,
External Translations are not supported.
Regardless of the method you use, the system generates the Extracted
Values panel. See “Sample Extracted Values Panel” on page 365.
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Using Step Extraction
You can use step extraction to perform a step-by-step review of how the
system searches for and picks up data in the input source. The cursor will
stop at any value in the input source that meets the criteria of the file
definitions as the corresponding definition displays at the bottom of the
window. The cursor does not stop at any location that does not meet the
criteria of the file definitions.
Procedure for Step Extraction.
1. In the Extract Window, select Run > Step Extraction.

The cursor displays at the first defined field in the input source and the
corresponding definition displays at the bottom of the panel.
File Edit View Run Window Help
ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss
SWB9001P
Extract Window
File name: TIME1F1
LINES 00000008 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-DATE01
01/01/00 10:11 10:11PM 10:11:12:13 10:11:12:13AM JAN 01/00
DATE02
01/02/00 10:11 10:11PM 10:11:12:12 10:11:12:13PM JAN 02/00
DATE03
01/03/00 12:00 12:00AM
12:00PM
DATE04
01/04/00 11:45 11:45AM
11:45PM
DATE05
01/05/00 12:45 12:45AM
12:45PM
DATE06
01/06/00 01:00 01:00AM
01:00PM
DATE07
01/07/00 00:00 00:00AM
00:00PM
DATE08
01/08/00 24:00 24:00AM
24:00PM

THIS STEP=SELECT IF POS 00001 FOR 08 = DATE01

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

(AND)

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

2. To complete the extraction, choose one of the following options:

 for each input source, select Run > Step Extraction
 select Run > Finish Extraction
When you select the second option, the entire extraction takes
place behind the scenes and the results are displayed in the
Extracted values panel. See “Sample Extracted Values Panel” on
page 365.
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3. Continue to press Enter to continue through the file definitions. If an

extracted value is incorrect, press F3 to exit the Extracted Values
panel. On the Extract Window, select the incorrect item and press
Enter. Review and then edit the incorrect file definition. See “Viewing,
Editing and Deleting File Definitions” on page 348).
If you want to skip step extraction (using regular extraction instead)
for a given number of records, select Run > Step X records, as
described in the next section.

Using Step X Records
The Step X records option allows you to alternate between regular
extraction and step extraction if you want to focus on specific areas in your
input file.
For example, you may want to look specifically at two areas, but those
changes are separated by hundreds of records that your file definitions are
processing accurately. To test just those two areas, from the Extract
Window you can select Run > Step X records and specify that you want
to process 300 records. The program will process the first three hundred
records using regular extraction, and then begin step extraction. After you
have examined those, you can select Run > Step X records again and
have the program process the 250 records before the next section you are
interested in. If you specify more records than remain in the input file, the
program processes the remaining records, finishes the extraction process
and takes you to the Extract Values Report.
When you reach the end of your input file or when you choose Finish
Extraction from the Run menu, the Extracted Values panel is displayed as
shown in “Sample Extracted Values Panel” on page 365.
Procedure for Using Step X Records
1. In the Extract Window, select Run > Step X records.
2. When the Step X Number of Records panel displays, enter the number

of records that you want the system to process using regular extraction
before beginning step extraction and press F5. The system processes
the number of records you specified using regular extraction and
begins step extraction as described in “Using Step Extraction” on
page 359. Correct errors as described in that section.
3. At any time you can do one of the following:

 Select Run > Finish Extraction to process the remaining records
using regular extraction.
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 Select Run > Step X records and specify another number of
records to be processed using regular extraction, after which the
next records will be processed using step extraction.
4. When the last record has been processed, the Extracted Values panel

will be displayed.

Sample Extracted Values Panel
This report is produced by running step extraction, using step X records, or
running full extraction.
It shows each extracted value in the order it was encountered in the
extraction process. The two columns contain the internal (or extended
internal) item descriptions and the actual extracted values, respectively. If
an extracted value is incorrect, you can select the item from this panel and
press Enter. The system takes you to the Definition review panel where you
can edit the definition. For more information, see “Viewing, Editing and
Deleting File Definitions” on page 348.
Extracted Values

Row 1 to 8 of 8

TEXT INTERNAL ITEM
TEXT1
COUNT INTERNAL ITEM
4021
AMOUNT INTERNAL ITEM
321.11
DATE INTERNAL ITEM
12012005
COUNT EXTENDED ITEM
1234567890123456789012341
AMOUNT EXTENDED ITEM
1234567890123456789.001111
TEXT EXTENDED ITEM
LONG TEXT OF 39 BYTES LONG FIRST
DATE EXTENDED ITEM
12012005
***************************** Bottom of data ******************************

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Additionally, in access modes 6 and 7, you can edit the JCL to create a Trace
Report that shows a formatted list of the selection groups used for
balancing. This will be helpful in testing your definitions. See “Trace
Report” on page 390.
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Testing Job Definitions Online
Running Balancing Online
After you have finished creating and saving the job and file definitions for
your balancing job, you can run the job online as follows:

Completing the Balancing Run Options Panel
Select Run > Balancing to display the Balancing Run Options panel. The
run options shown here represent some of the JCL parms that can be
passed to batch processing.
Balancing Run Options
Set overrides for one or more of the following:
Cycle number: . . ________
Run number: . . . ___
Rule set override: ____
Store history override: _ (Y/N/I)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Cycle Number. Enter the cycle number in any of these situations:

 You have not set the cycle number using automatic cycle processing.
 You are not extracting a cycle number in your file definitions
 You want to override the cycle number obtained using one of these
methods).
For more information on cycle numbers, see “Setting Up Cycle Processing”
on page 625.
Entering the cycle number here will create JCL. Alternatively, you can
specify a cycle number using a runtime JCL parameter. See “File Interface
Mode JCL” on page 387.
Note:

If you use runtime parameters to set your cycle numbers, consider
adding the century value to the first two positions of cycle numbers
representing cycle dates later than December 31, 1999. This will
enable you to maintain ascending cycle numbers without balancing
errors.

Run number. Optionally enter a number to differentiate multiple runs
with the same cycle number. Valid values are 001 through 999.
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Rule set override. If you are using more than 100 rules, indicate the
additional rule set to be used for this run. This will be in the format 01Xn.
You will not typically use this feature. For more information, see “Using
Alternate Balancing Rules” on page 245.
Store History Override. To override this job’s store history option
defined for the job for the current balancing run only, enter one of the
options below:
Y. Store history.
N. Never store history.
I. Store history only if the job is in balance
Press F5 to accept.
The Balancing Process panel (not shown) displays stating that the
balancing process has been invoked.
Messages will be displayed on the screen. Even if your job completes with a
return code of 0000, messages with important information concerning
balancing and other job-related matters may still appear. Infogix messages
begin with #U.

Viewing the Balancing Reports Automatically
The reports you specified to be generated by the job (see “Specifying Report
Options” on page 179) will display.

Viewing the Balancing Reports at a Later Time
To view the reports later, from the Job Window, select View.
_

1.
2.
3.
4.
5.
6.
7.

Control report/copy1
Control report/copy2
Recap report
User report
Free-form report
Compress views
Expand views

Select the report you want.
The following sections will help you interpret the balancing reports that can
be generated when you run balancing:






“Control Report (Copy1 or Copy2)” on page 180
“Recap Report” on page 189
“User Report” on page 192
“Free-Form Report” on page 192
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What To Do If You Get Unexpected Results
 Look up any #U (Infogix) messages displayed on the screen in the
messages and codes manual. Even if your job completes with a return
code of 0000, messages with important information concerning
balancing and other job-related matters may still appear.

 Check your ACR/Summary job output for return codes and IBM system
messages (such as JCL errors). These messages will also be displayed on
the screen.

 Read appropriate sections of this manual for further information.
 If you need assistance, see “Contacting Customer Support” on page 16.
When you are ready to run your job in batch, see “Running Balancing Jobs
and Other JCL in Batch” on page 369.
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Running Balancing Jobs and
Other JCL in Batch
Implementing ACR/Summary in production usually requires you to insert
a JCL step into an existing job or create a new production JCL stream. The
generated JCL can be edited if needed and then submitted. JCL can be
saved to be used later.
This chapter provides general instructions for creating JCL and explains
the panels specific to each option on the Create JCL panel. In addition, it
lists the DD statements used in ACR/Summary processing.
This chapter contains the following sections:












“Creating, Editing, and Submitting JCL” on page 370
“File Interface JCL Panels” on page 374
“Database Initialization JCL Panel” on page 376
“Automatic Rerun JCL Panel” on page 377
“Direct Input JCL Panel” on page 378
“History Analysis JCL Panel” on page 379
“Spool Monitor JCL Panel” on page 380
“Job Card Panel” on page 380
“ACR/Summary DD Statements” on page 381
“Product Messages (SYSOUT) Report” on page 383

Note:

If you are running balancing in program interface mode, see
Balancing in Program Interface Mode on page 403. For
instructions for job execution, see "Executing the Program".
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Creating, Editing, and Submitting JCL
1. (This step applies only if you are generating JCL for a balancing job.)

Gather the following information:

 Job/Step/Qualifier names.
 DDNAME and file name for each input source (for all application
interface modes except direct input mode).

 DB2 plan name, prefix and system (for jobs that use DB2 tables as
input sources).
2. Select Setup > Create JCL to access the Create JCL panel.
Create JCL
Choose an option:
__ 1. File interface JCL
2. Database initialization JCL
3. Automatic rerun JCL
4. Direct input JCL
5. History analysis JCL
6. Spool monitor JCL
7. Product license report JCL
8. Job card information
9. Program interface JCL

F1=Help

F2=Split

F3=Exit

F9=Swap

Choose an Option. Options:
1. File interface JCL. Select this option to create JCL to run your

balancing job in batch.
2. Database Initialization JCL. Select this option to create JCL to

initialize a new or additional definition and/or history database.
3. Automatic rerun JCL. Select this option to generate the JCL step to

be inserted into a job when using auto rerun. For more information
on automatic rerun, see “Automatic Rerun Option” on page 168
4. Direct Input JCL. Select this option to generate the JCL to run a

direct input job. Direct input enables you to specify the control
values to be used in balancing directly. For information on creating
a direct input job, see “Balancing in Direct Input Mode” on
page 395.
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5. History Analysis JCL. Select this option to generate JCL to run

your History Analysis job in batch. For more information on
history analysis, see “Using the History Analysis Function” on
page 441.
6. Spool monitor JCL. Select this option to generate JCL to run your

balancing job directly from the spool. For more information on
spool monitor, see “Balancing in Spool Monitor Mode” on
page 433.
7. Product license report JCL. Select this option to generate the JCL

for the product license report.
8. Job Card Information. Select this option to change the default job

card used when generating JCL.
9. Program interface JCL. Select this option to create a template for

running the Program Interface JCL. Program Interface mode
allows the users to use their application program to call either
UAC1000, which invokes balancing directly using the ACRXAREA
copybook, or UAC200PI, which invokes the ACR/Summary
UAC2000 file interface program using the UAC2FILE copybook.
The default member name for the Program Interface is SUMCBLPI
Depending on whether to print the Freeform Report using ASA
characters, the JCL generated is a little different. If the Freeform
Report is printed with ASA character, the DCB for UNIUFR will be
(RECFM=VBA,LRECL=255). If not printing with ASA characters, the
DCB for UNIUFR will be (RECFM=VB,LRECL=255)
3. The Library Information panel displays (unless you selected the job

card option). The example below is a Library Information panel where
file interface JCL is being created.
Library Information
Specify JCL library information:
Dataset name: . . . . USERIDA.SUM.PROCLIB_______________________
Member name: . . . . . SUM2000_
Definition database:
USERIDA.SUM.DEFN__________________________
History database: . . USERIDA.SUM.HIST__________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

4. Complete the panel as follows:
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Dataset name. Defaults to the JCL procedure library dataset
specified on the User File Defaults panel. Unless you changed it there,
this field will default to username.SUM.PROCLIB. If you changed the
dataset name, or if you change it here, do the following:

 Be sure to use a partitioned dataset.
 Remember the new name, because this is where your generated JCL
member will be stored when you want to reuse it (edit and submit
it) at a later time.
Member name. Shows the default name of the member that will
store the JCL specific to this option. Unless you changed the member
name for this JCL on the User File Defaults panel, this field will default
to the member name shown below:
File Interface JCL: member name SUM2000
Database Initialization JCL: member name SUMINIT
Automatic Rerun JCL: member name SUMARUN
Direct Input Mode Balancing JCL: member name SUM3000
History Analysis JCL: member name SUN2000
Spool Monitor JCL: member name ACRSPMF
Product License Report JCL: member name UNI10PR
If you changed the member name, remember the new name, because
this will be the member name for this JCL when you want to reuse (edit
and submit) the JCL at a later time.
The following fields are on all Library Information panels except those
for Spool Monitor JCL and Job card information (which does not use a
Library Information panel):
Definition database. The name of the file that contains the
definitions. The field defaults to the name specified on the User File
Defaults panel.
History database. The name of the file that contains the history
records. The history database defaults to the name specified on the
User File Defaults panel.
5. Complete the entry panel(s) for the JCL option you selected. The

panels for the Create JCL options are explained in the following
sections.
6. When you press F5 after completing all entry panels, the generated

JCL displays. You can submit the JCL as it is or edit it as appropriate.
Some common edits are listed below:
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 For balancing jobs that use access modes 6 or 7, if you want to
request a Trace Report, see “Trace Report” on page 390 for the JCL
edits.

 For balancing jobs, if you want to use run-time overrides, see
“SUM2000 JCL Parms for the File Interface Balancing Program” on
page 388. Set the parameters you want in the generated JCL.

 The generated JCL will output any reports you create to the
SYSOUT for your job. If you want to view the reports from the user
interface, change the report DD statements to go to the file name
defaults you specified during setup. (The output DDNAMES
referenced in “ACR/Summary DD Statements” on page 381 are the
default DDNAMES.)
7. When you have completed any edits, enter SUB in the command line to

submit the JCL.
8. Press F3 to return to the Job Window.
9. Use your output utility to review the output.

For examples of reports, see:







“Control Report Example and Content” on page 185
“Recap Report Example and Content” on page 191
“Trace Report Description” on page 391
“Product Messages (SYSOUT) Report” on page 383.
“Database Initialization Report” on page 43

10. If you get unexpected results, see “What To Do If You Get Unexpected

Results” on page 368. The messages will not be displayed on the screen
as in online mode. Instead, you can scan the SYSOUT for the #U
character string at the beginning of each Infogix message. Even if your
job completes with a return code of 0000, messages with important
information concerning balancing and other job-related matters may
still appear, and you can look them up in the Messages and Codes
manual.
11. You can edit and submit a member you created through the Create JCL

panel at a later time through the Edit Files and Submit JCL panel,
regardless of whether you already submitted it. To access the panel, do
one of the following:

 Select Edit > Edit JCL.
 Select Run > Edit/Submit JCL.
The Edit Files and Submit JCL panel displays a list of the members of
the PROCLIB PDS specified on the panel.
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12. Enter S to select a member and display the JCL.
13. Edit as appropriate before entering SUB to submit. Edits are saved

unless cancel is typed on the command line.

File Interface JCL Panels
File Interface JCL Panel
If you chose option 1 from the Create JCL panel, the File Interface JCL
panel displays. This panel allows you to enter information required to
generate JCL to run balancing in batch.
File Interface JCL
Job name: JOBXYZA_
Step name: ________
Specify a DDName and DSName for each input file:
DDName
DSName
________ __________________________________________
________ __________________________________________
________ __________________________________________
________ __________________________________________
________ __________________________________________
________ __________________________________________
Override execution parameters? Y (Y/N)
Generate DB2 JCL? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

Hard copy DD
________
________
________
________
________
________

F9=Swap

Job name. Defaults to your default jobname specified in your job card
information, but you can change it.
Step name. Enter a name to be used as the step name in the generated
JCL.
DDName. Enter the DDNAMEs of all input source files you specified for
this job.
DSName. Enter the dataset name of each input source listed in the
DDNAME column.
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Hard copy DD. If you want to print a hard coy of the input source, enter
the DDName to receive hard copies. This should be the Hard copy
DDNAME you specified when you set up the input source, as described in
“Physical Sequential File Information Panel” on page 264 or “Direct Spool
Information Panel” on page 267.
Note:

 For access mode 1, only the number of records processed will be
put in the access area. For all other access modes, all records will
be put into the access area. Therefore, all records will be
reported.
 If your hard copy dataset is larger than 133 characters, change
the LRECL and BLKSIZE parameters to the appropriate sizes for
your file.

Override execution parameters? Options:
Y. Leave the default Y if you want to do any of the following: 1) enter the job
name and step name of a balancing job in your job definitions that you want
to run instead of the job identified on this panel, 2) assign a cycle number
to the job (usually because the job definitions do not assign one), and/or 3)
assign a run number to the job.
N. Change to N if you want to use the execution parameters from the
executing job for the definitions.
Note:

You can define a number of run-time overrides in the JCL. See
SUM2000 JCL Parms for the File Interface Balancing Program
on page 388.

Generate DB2 JCL? Change to Y if you want to generate DB2 JCL.
Press F5 to accept.

Execution Parameter Overrides Panel
If you answered Y to Override execution parameters? on the File
Interface JCL panel, the Execution Parameters Overrides panel displays,
enabling you to assign your own values to the parameters displayed. Any
fields you leave blank will be assigned based on the JCL.
Execution Parameter Overrides
Job name:
Step name:
Cycle number:
Run number:
F1=Help

(JNAM=)
(STEP=)
(CYC#=)
(RUN#=)
F2=Split
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________
________
________
___
F5=Accept

F9=Swap
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Job name. The name of the job in your definition database that you want
to execute.
Step name. The step name of the job in your definition database that you
want to execute.
Cycle number. Optionally enter a cycle number you want to be assigned
when the job executes. (Usually you would do this because the job
definitions do not assign one.) See “Setting Up Cycle Processing” on
page 625 for additional information on cycle numbers and run numbers.
Run number. Optionally enter a run number that you want to be assigned
when the job executes.
Press F5 to accept and display the JCL.

DB2 JCL Panel
If you answered Y to Generate DB2 JCL? on the File Interface JCL panel,
the DB2 JCL panel displays.
DB2 JCL
Specify information below:
DB2 plan:
________
DB2 prefix: ________
DB2 system: ______
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

DB2 plan. Name of the DB2 plan created by the database administrator.
DB2 prefix. The prefix to be used for batch execution of the DSN
command.
DB2 system. The name of the DB2 subsystem.
When you press F5, the JCL displays.

Database Initialization JCL Panel
If you chose option 2 from the Create JCL panel, the Database Initialization
JCL panel displays. Because this panel is also used during initial setup, see
“Database Initialization JCL Panel” on page 39 for panel instructions,
additional information, and report samples.
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Automatic Rerun JCL Panel
If you chose option 3 from the Create JCL panel, the Automatic Rerun JCL
panel displays. This panel allows you to enter information required to
automatically rerun an ACR/Summary balancing job. Unlike the other
Create JCL options, this will not generate JCL that can be submitted
independently. This creates a JCL step that can be inserted into another
production job stream along with the balancing job.
Automatic Rerun JCL

Step name: ________
Execution parameters:
Job name: (JNAM=) ________
Rerun:
(RERUN) ________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Step name. Step name for the automatic rerun step.
Execution parameters:
Job name. Job name to override the job name from the job statement. It
must exist in the database.
Rerun. Enter RERUN to rerun this job every time.
Note:

If a job name is being specified, the job name parameter must be
entered first.

Press F5 to accept.
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Direct Input JCL Panel
If you chose option 4 from the Create JCL panel, the Direct Input JCL panel
displays. This panel allows you to enter information required to generate
JCL to run balancing in direct input mode.
Direct Input JCL
Job name: USR1A___
Direct input data location:
Dataset name: USR1.SUM.TRANLIB__________________________
Member name: DIRDATA_

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Job name. Defaults to your default jobname specified in your job card
information. Change to the name of your direct input job.
Dataset name. The dataset that contains the direct input data. Defaults to
the data library specified for the transaction library on the User File
Defaults panel, but you can change it.
Member name. The member that contains the direct input data (if
applicable). Defaults to DIRDATA. Change to the name specified when the
transactions were created.
Press F5 accept.

378

Infogix, Inc.

Running Balancing Jobs and Other JCL in Batch  9
History Analysis JCL Panel

History Analysis JCL Panel
If you chose option 5 from the Create JCL panel, the History Analysis JCL
panel displays. This panel allows you to enter information required to
generate JCL for a set of history analysis definitions.
History Analysis JCL
Job name: JOBXYZAA

Step name: ________

History analysis ID: ________________
Cycle number: . . . ________
Run number: . . . . ___
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Job name. Defaults to your default jobname specified in your job card
information. Change to the name of your history analysis job.
Step name. Enter a name to be used as the step name in the generated
JCL.
History analysis ID. The analysis ID for the history analysis definitions
you want to execute.
Cycle number. Number to use as the current cycle for this execution of
history analysis. If the cycle number is not specified, the system will use the
cycle reference job ID specified in Basic Analysis Information.
Run number. Identifies this run of these history analysis definitions.
Press F5 to accept.
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Spool Monitor JCL Panel
If you chose option 6 from the Create JCL panel, the Spool Monitor JCL
panel displays. This panel allows you to enter information required to
generate JCL for executing a job in spool monitor mode.
Spool Monitor JCL
Job name: USR1A___

Step name: ________

Specify spool monitor JCL library information:
Authorization library: . . UNI.TAPESHIP.releasenum.LOADLIB_________
File interface JCL library: USRIDA1.SUM.PROCLIB_____________________
Parameter records DSName:
USRIDA1.SUM.USPPARM_____________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Job name. Defaults to your default jobname specified in your job card
information. Change to the name of your spool monitor job.
Step name. Enter a name to be used as the step name in the generated
JCL.
Specify spool monitor JCL library information:
Authorization library. Verify that this is the authorized library
containing the load module ACRSPMF.
File interface JCL library. Verify that this is the name of the PDS that
contains the balancing jobs to be submitted by ACRSPMF.
Parameter records DSName. Defaults to the value specified on the
User File Defaults panel. Verify that this is the DSName for the spool
monitor parameter file.
Press F5 to accept.

Job Card Panel
If you chose option 7 from the Create JCL panel, the Job Card Information
panel displays. This panel is also accessed during the initial setup. For
instructions, see “Job Card Panel” on page 38.
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ACR/Summary DD Statements
For all application interface modes except spool monitor, these DD
statements are required unless the corresponding ACR/Summary file is
dynamically allocated. (For spool monitor mode, these statements are
required in your file interface JCL.)
DD Statement

Defines

ACRIRDR

Internal Reader used in Spool Monitor

ACRJLIB

Library that Spool Monitor uses to submit jobs.

ACRSPLOG

Log or trace of activity for Spool Monitor

ACRSPMC

Spool Monitor controls information file.

UNIACR

132-column Balancing Control Report file, copy A.

UNIACR2

Second 132-column Balancing Control Report file, copy
B.

UNIACR3

80-column Balancing Control Report file, copy A.

UNIACR4

Second 80-column Balancing Control Report file, copy
B.

UNIAR

Archive History Report

UNIARF

Restore History Database file (restored from archive)

UNIARF

Restore History Database Report

UNICF

VSAM system control file.

UNICMD

Control File update card inputs.

UNICRXML

XML message file for Control Report.

UNICSV

Output of the Create Comma Delimited Text File utility.

UNIDATA

Input to the Create Comma Delimited Text File utility.

UNIDBR

Build ACRUPDT Report file (from Build Batch
Transactions utility).

UNIDF

VSAM Definition database.

UNIDLR

Definition Database Listing Report file.

UNIDXR

Definition Database Cross Reference Report file.

UNIETR

Trace report file.

UNISSR2

History Analysis Report

UNIEXTR

Balancing Extract File.
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DD Statement

Defines

UNIFAX

Update Report for Control File (licensing) update.

UNIFRXML

XML message file for Free-Form Report.

UNIFRXML

XML message file for Free-Form Report.

UNIHF

VSAM History database.

UNIHF1

Source file for Copy All History Records and Reorg
utilities.

UNIHF2

Target file for Copy All History Records, Copy Selected
History Records, Delete Dual History and Reorg utilities.

UNIHFW

History database utilities work file.

UNIHLR

History Database Listing Report (all options except
Detail).

UNIHLR

History Database Listing Report (Detail option).

UNIHRR

History Database Reorg Report.

UNIHSTD

List History - History Data Detail Report

UNIHTR

History Database Report (all Copy History options
except Copy All Records).

UNIINP

Batch transaction records for utilities.

UNIIR

Database Initialization Report file.

UNILST

Product Report from UNI10PR that is sent to Infogix for a
license update.

UNIMR

Print Management Report file.

UNIOF

(Cycle) Options file.

UNIRCR

Balancing Recap Report file.

UNIREPT

CPU Report from UNI10PR that is sent to Infogix with
UNILST for a license update.

UNIRSR

Restore History Database Report.

UNISRT

Internal sort file used in such utilities such as Update
from Batch Transactions.

UNISSR2

Summary Spreadsheet Report.

UNITR

Transaction Listing Report file for multiple utilities.

UNIUF

User Options file.

UNIUFR

Free-Form Report file.
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DD Statement

Defines

UNIUFR

Free-Form Report file.

UNIUPDT

Build Batch utility file.

UNIURXML

XML message file for User Report.

UNIUSR

Balancing User Report file.

UNIWXML

XML message file for User Report.

Product Messages (SYSOUT) Report
This report is automatically created when running balancing, an integrity
check, a database initialization or update, and multiple utilities.
The DDNAME for the report in your output will be SYSOUT.
It shows the step completion code (return code) alone if there were no
errors (return code 0000). Otherwise it shows each step completion code
and the corresponding error message(s).

Product Messages Report - Successful Balancing Run
STEP COMPLETION CODE IS: +00000

Product Messages Report - Unsuccessful Balancing Run
#UFI990E: JOBXYZ /UPDATE /
NO BALANCING INFORMATION IN
INFOGIX
DATA BASE (ACRDEFN)
#UFI990E: UAC2000 TERMINATED DUE TO 00001 ERRORS
STEP COMPLETIO CODE IS: +4000
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Balancing in File Interface Mode
This chapter describes the file interface mode. (The following chapters
describe additional modes.)
This chapter contains the following sections:

 “Understanding File Interface Mode” on page 385
 “File Interface Mode JCL” on page 387
 “JCL Changes for Jobs with File Organization Type of Direct Spool
(SP)” on page 387

 “SUM2000 JCL Parms for the File Interface Balancing Program” on
page 388

 “Trace Report” on page 390
Note:

All of the application interface modes have similar JCL and DD
statements. An EXEC statement executes either an ACR/Summary
program or an application program (which, in turn, invokes
ACR/Summary). The DD statements define the data sets used by ACR
programs.

Understanding File Interface Mode
File interface mode is the most typical application interface mode because
it can extract the control values from application reports. These reports are
tied to most manual balancing procedures, so file interface mode is the
logical choice for automating existing balancing operations. File interface
mode can also be used to extract control values from sequential files, VSAM
files, direct spool files, and DB2 tables. An extra job-step is added to the JCL
to execute the file interface program (UAC2000). No source-code changes
to your application are required.
The following briefly describes the processing steps.

 UAC2000 is executed as a separate step in the application job-stream
(the user interface can be used to generate the file interface JCL).
When UAC2000 is executed, the job name and step name associated
with its execution are automatically obtained from the operating
system to build a job ID.
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 Using the job ID as a key, UAC2000 searches the database for the
corresponding job definitions. Through file items, these job definitions
point to the file definitions for that job ID. The file definitions specify
what control values should be extracted from the application files,
which are usually report datasets.
For more information about job definitions, see “Creating Job
Definitions” on page 193.

 Next, UAC2000 applies the file definitions against one or more
application files, extracts the control values from the files, and
associates each control value with an internal item, a cycle number, a
JSQ, or a control field.
For more information about file definitions, see “Creating File
Definitions” on page 261.
If desired, the application report datasets may be printed through the
Hard Copy DD. If no JSQ is provided the execution will start with
blank JSQ, then subsequently search the definition database for nonblank JSQs with the same job and step name and process a separate
job for each in numeric order.

 The control values are then passed to the balancing function, which
retrieves additional definitions and previously stored control values
from the database, performs the balancing, stores the control values
and the results in the history database for subsequent balancing and
reporting, and produces the Control Report.

 If history analysis definitions exist for the job name and step name on
the definition database, the history analysis function is invoked. The
history analysis definitions are processed and the History Analysis
Report is created.

 Finally, a return code indicating an in- or out-of-balance condition is
passed from the balancing function back to UAC2000.

 UAC2000 uses the set return code option in the job definitions to
control further processing. This option directs the program either to
ignore the return code, set it as a step completion code, or abend the job
with a user completion code.
If a step completion code or user completion code is set, the JCL COND
parameter or other software utilities (e.g., job schedulers) can be used to
halt or continue with further job or job-step processing.
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File Interface Mode JCL
JCL for the File Interface Program can be generated through the user
interface (note, however, that certain parameters in this JCL may have to
be changed to conform to naming conventions and standards in your
particular data center). ACR/Summary uses the job name on the JOB
statement and the step name on the EXEC statement to build the job ID
used to retrieve the job and file definitions needed to extract and balance
the control values.

JCL Changes for Jobs with File Organization Type
of Direct Spool (SP)
If your file organization type is direct spool (SP), make the following edits
to the generated JCL:
Because ACR/Summary gives you the ability to read reports directly from
the JES spool, you will need to make additional changes to your JCL as
shown in the following example:
before:

//USERJOB JOB ...
//USER EXEC PGM=APPLICATION
//REPORTA DD SYSOUT=A
after:
//USERJOB JOB ...
//OUT1 OUTPUT CLASS=A
//OUT2 OUTPUT CLASS=x,WRITER=UACR
//USER EXEC PGM=APPLICATION
//REPORTA DD
SYSOUT=(,),FREE=CLOSE,OUTPUT=(*.OUT1,*.OUT2)

where x is equal to any held output class. For JES3 users, x should equal any
output class held for EXTERNAL WRITER. The extra output card does not
actually create another copy of your report, it just creates another pointer
within JES. After ACR/Summary completes processing, this pointer will be
deleted.
The file definitions would reference the application report's DDNAME for a
file organization type of SP, the user's spool step name of USER, and a Spool
DDNAME of REPORTA.
Note:

For information on creating file interface JCL, see Running Balancing
Jobs and Other JCL in Batch on page 369.
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SUM2000 JCL Parms for the File Interface
Balancing Program
The file interface balancing program is UAC2000. This program can be
supplied with parameters in the SUM2000 member (default name) to
override or control the processing at run-time. Each parameter is
associated with a key word.
If multiple parameters are used, they can be specified in any order. The
string is enclosed in single quotes, and the parameters are separated by
commas. The sequence of the parameters does not matter.
For example, suppose you want to override the job name and step name
used in the UAC2000 job-step. You could specify the override using the
JNAM and STEP parameters, as follows:
//ACRSTEP EXEC PGM=UAC2000,PARM='JNAM=P4000,STEP=ACR01'
//ACRSTEP EXEC PGM=UAC2000,PARM='JNAM=P4000,STEP=ACR01
//

,STEP=ACR01’

If all the parameters cannot be included in a single line, additional lines can
be added. However the parameters on each additional line must start with
the delimiter (,) and on or after the sixteenth position.
Parm

Specified as:

Job name

PARM='JNAM=jjjjjjjj'
where jjjjjjjj is the 1- to 8-character job name.
Example: JNAM=CUST

Step name

PARM='STEP=ssssssss'
where ssssssss is the 1- to 8-character step name.
Example: STEP=STEP1

Job-step qualifier

PARM='JQ=qq'
where qq is the 2-character JSQ.
Example: JQ=02

Cycle Number

PARM='CYC#=nnnnnnnn'
where nnnnnnnn is the 8-digit Cycle Number.
Example: CYC#=20080815

Run Number

PARM='RUN#=nnn'
where nnn is the 3-digit Run Number.

Control Field

PARM='CNTL=01Xr'
where r is the rule set number for Alternate Balancing Rules.
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Parm

Specified as:

Store History

PARM='ROPT=abcdefgh'
where:
a is the store history override option (Y, N, or I).
 Y = Store history every time the balancing job runs;
 N = Never store history;
 I = Store history only when the ACR/Summary job is in balance.
Positions b-h are reserved. Use a total of seven dots to fill positions b-h
so as not to override the options they control.
Example, ROPT=Y.......

Rerun

PARM='RERUN'
where RERUN causes the UAC2000 program to rerun the last cycle
processed. When cycles other than the last cycle need to be rerun, use
the PARM='CYC#=nnnnnnnn,' option.

SYSOUT

PARM='SYSOUT'
where SYSOUT causes the UAC2000 program to produce a SYSOUT
report even when no #U messages are created.
If you specify the SYSOUT parameter, an informational header
message will be generated whenever the job runs. The message will
say, “USY0001: INFOGIX JOB STARTED.”

Bypass

PARM='BYPASS'
causes the UAC2000 program to bypass balancing.

File Work Area Size

PARM='CORE=nnnn'
where nnnn is the size (in multiples of 1024) of the area that the File
Interface Program will use in obtaining storage for the file work area.
This parameter is used to help avoid storage fragmentation when
multiple JSQs will be executed and you do not use region sizes of 10 M
or more.
nnnn should be large enough to accommodate the largest work area
needed by the files that will be processed. Use the following calculation:
nnnn = (rrrr * (sss + 8))/ 1024
where rrrr is the number of records that will be specified on the Basic
File Information record and sss is the length of a record on that file.
Set your region size as follows:
 If no Access Mode 2 files will be accessed during this execution,
then:
Region size = core parameter size + 1024K
 If Access Mode 2 files will be accessed during this execution, then:
Region size = 2 * (core parm size) + 1024K
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Parm

Specified as:

Control Report XML
Option

PARM='CRXML=n'
where n is one of the following:
1 - do not generate the Control Report in XML format
2 - generate, write to file (Copy 1)
3 - generate, autoload to database (Copy 1)
4 - generate, write to file (Copy 2)
5 - generate, autoload to database (Copy 2)

User Report XML
Option

PARM=’URXML=n'
where n is one of the following:
1 - do not generate the User Report in XML format
2 - generate, write to file
3 - generate, autoload to database

Free-Form Report
XML Option

PARM='FRXML=n'
where n is one of the following:
1 - do not generate the Free-Form Report in XML format
2 - generate, write to file
3 - generate, autoload to database

‘DEBUG=abcdefgh’

The DEBUG parameter is used to display the debugging message for
XML writer, Visibility API, and Infogix Assure History API.
Processing options:
a = Debug indicator for XML Writer (Y,N or (.))
b = Debug indicator for Visibility API/Stub version (Y,N or (.))
c = Debug indicator for Infogix Assure History API (Y,N or (.))
d-h = Reserved value.
Report message (‘SEND CR’, ‘SEND UR’ and ‘SEND FR’) will only be
displayed if AUTOLOAD is specified for the XML export option.
The default value for the debug indicator is N. Enter Y to turn on the
debug indicator.
The debug indicator can be separately turned ON for XML Writer,
Visibility API and Infogix Assure History API. Only File Interface
supports this parameter. Program Interface and Direct Input do not
support this parameter.

Trace Report
In access modes 6 or 7, you can edit the JCL to create a Trace Report that
shows a formatted list of the selection groups used for balancing. The
DDNAME for the report in your output will be UNIETR.
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Setting Up the Report
To generate the report, edit the SUM2000 JCL as follows:
1. Add the UNIETR DD statement after the UNIACR4 DD statement as

shown below:
//UNIETR DD SYSOUT=&OUT,
// DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
2. Add the following two lines to the end of your balancing JCL:
// STEPNAME.UNITRACE DD *
FILEDDNAME

In these two lines, STEPNAME is the stepname for your balancing job,
and FILEDDNAME is the File DDName of your input file.

Trace Report Description
You can generate this report only for access mode 6 or 7. The report shows
a formatted list of the selection groups as they were loaded in preparation
for processing the input file. See "Processing for Each Record", below.

Report Sections with Examples
File Definition List
The first report section, a sample of which is shown below, is a formatted
list of the selection groups as they were loaded in preparation for processing
the input file.
Note:

In this example, the source data is compared against a range of
extended values. Because the SELECT FROM VALUE and
SELECT TO VALUE are long, they are shown on separate lines
after the message SEE EXTENDED SELECT VALUE BELOW.

FILE DEFINITION LIST: KEY1DDZ
RECORD
SEQ. NO SELECTION/EXTRACTION INFORMATION
001001
SELECT(0012/30/TXT) DDF0000 TEST(RANGE
)
***SEE EXTENDED SELECT VALUE BELOW***
SELECT FROM VALUE: (111111111111111111111111111111
SELECT TO VALUE:
(555555555555555555555555555555
001001
KEY (0001/08/TXT) DDF0000 KEY (K-01
) XLATE(KEY-1
/L)
001001
DTL (0001/08/TXT) DDF0000 TEXT
INTO I-001 XLATE(
/ )

LV OP
L1 AND
)
)

Processing for Each Record
The next report section shows the following for each record read:

 The record count and the first 132 characters of the record.
 Each selection definition evaluated and whether it passed or failed.
 For selection definitions that passed, the processing of the associated
key and detail field definitions.
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 Notification of key related processes, including completion of a key, key
breaks, partial keys dropped, and keys dropped because they have no
associated detail data

 For selection rules, the Source Value column shows the extracted value
processed by the definition, and the Action Taken column shows the
result of the evaluation (PASSED or FAILED).
Following is an example showing the processing that occurred when a
record passed the evaluation:
INPUT RECORD: 00000001
0
1
2
3
4
5
6
7
8
9
A
B
C
D
----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0-TAMPA
55555555555555555555555555555555555555555555555555
------------------------------------------------------------------------------------------------------------------------------------RECORD1ST
SEQ # NF.SELECTION/EXTRACTION INFORMATION
LV OP SOURCE VALUE
ACTION
-----------------------------------------------------------------------------------------------------------------------------------001001
SELECT(0012/30/TXT) DDF0000 TEST(RANGE
)
***SEE EXTENDED SELECT VALUE BELOW***
L1 AND***SEE BELOW*** PASSED
SOURCE VALUE:
555555555555555555555555555555
SELECT FROM VALUE: (111111111111111111111111111111
)
SELECT TO VALUE:
(555555555555555555555555555555
)
KEY COMPLETE WITH EXTRACTION THAT FOLLOWS:
001001
KEY (0001/08/TXT) DDF0000 KEY (K-01
) XLATE(KEY-1
/L)
KEY-1
001001
DTL (0001/08/TXT) DDF0000 TEXT
INTO I-001 XLATE(
/ )
TAMPA

The formatting of each definition type is shown in the next section.

Formatting of File Definitions
Selection Field Formats
Source

Target (to compare
against)

Format

Input record or
Extraction Variable

Constant or Range
(Non-extended)

(Format when source is input record)
SELECT (AAA/BB/CCC) DDFNNNN TEST(DDDD) VAL1(EEEE) VAL2(FFFF)
(Format when source is extraction variable)
SELECT (VNNN/B1/BB) DDFNNNN TEST(DDDD) VAL1(EEEE) VAL2(FFFF)

Input record or
Extraction Variable

Constant or Range
(Extended)

(Format when source is input record)
SELECT (AAA/BB/CCC) DDFNNNN TEST(DDDD) ***SEE EXTENDED SELECT VALUE BELOW***
SELECT FROM VALUE (EEEE)
SELECT TO VALUE
(FFFF)
(Format when source is extraction variable)
SELECT (VNNN/B1/BB) DDFNNNN TEST(DDDD)
SELECT FROM VALUE (EEEE)
SELECT TO VALUE
(FFFF)

***SEE EXTENDED SELECT VALUE BELOW***

Input record

Extraction Variable

SELECT (AAA/BB/CCC) DDFNNNN TEST(DDDD) V-NNN

Extraction Variable

Input Record

SELECT(VNNN/B1/BB) DDFNNNN TEST(DDDD) AAA/BB/CCC

Where:
AAA is the field position of the source data from an input source file.
VNNN (with no hyphen) indicates that the source is an extraction variable. NNN is the extraction variable number.
B1 is the starting position of the source data
BB is the length of the source data.
CCC is the format of the source data (not applicable to extraction variables).
DDFNNNN is the 4-digit delimited data field number. When the source is not a delimited file, NNNN is 0000.
TEST is the hard coded literal 'TEST'.
DDDD (up to 8 Ds) is the selection operator.
EEEE is the constant or the start of the range to which the source value is being compared. If AAA is numeric, EEEE can be up to 16 bytes. If AAA is alphanumeric, EEEE
can be up to 80 bytes.
FFFF is the end of the range to which the source value is being compared. This will be blanks if a range comparison is not specified. If AAA is numeric, EEEE can be up to 16
bytes. If AAA is alphanumeric, EEEE can be up to 80 bytes.
V-NNN (with a hyphen) indicates that the target value (to compare against) is an extraction variable. NNN is the extraction variable number.
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Key Field Formats
Format Description

Format

Source is an input record, literal, or function

KEY (AAAA/BB/CCC) DDFNNNN KEY (K-DD) XLATE(FFFF/G)

Source is an extraction variable

KEY (VAAA/BB/CC) DDFNNNN KEY (K-DD) XLATE(FFFF/G)

Key is a cycle number

KEY (AAAA/BB/CCC) DDFNNNN CYC (DDDDDDDD) XLATE (FFFF/G)

Where:
AAAA is the field position of the source data from an input source file or literal.
VAAA is the field position of the source data in an extraction variable.
BB/CCC are the length/format of the source data.
DDFNNNN is the delimited data field number. When the source is not a delimited file, NNNN is 0000.
DD is the key number.
DDDDDDDD is the cycle number.
XLATE indicates that a translation table is defined for this field.
FFFF (up to 16 Fs) is the literal when the source is a literal.
G is blank if no translation is being used or Y if translation is being used.

Detail Field Formats
Source

Target

Format

Input record

Internal item

DTL (AAAA/BB/CCC) DDFNNNN DDDDD INTO I-NNN XLATE(FFFF/G)

Literal

Internal item

DTL (AAAA/BB/CCC) DDFNNNN DDDDD INTO I-NNN LIT(FFFF/G)

Extraction Variable

Internal item

DTL (VAAA/BB/CC) DDFNNNN DDDDD INTO I-NNN XLATE(FFFF/G)

Input record

Extraction
variable

DTL (AAAA/BB/CCC) DDFNNNN DDDDD INTO V-NNN XLATE(FFFF/G)

Literal

Extraction
variable

DTL (AAAA/BB/CCC) DDFNNNN DDDDD INTO V-NNN LIT(FFFF/G)

Extraction variable

Extraction
variable

DTL (VAAA/BB/CC) DDFNNNN DDDDD INTO V-NNN XLATE(FFFF/G)

Where:
AAAA is the field position of the source data from an input record or literal.
VAAA is the field position of the source data in an extraction variable
BB/CCC are the length/format of the source data.
DDFNNNN is the delimited data field number. When the source is not a delimited file, NNNN is 0000.
NNN is the number of the internal item or extraction variable.
DDDDD is the type of detail field.
XLATE indicates that a translation table is being used.
LIT indicates that the source is a literal.
FFFF (up to 16 Fs) is the literal.
G is blank if no translation is being used or Y if translation is being used.
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Reformat Field Formats
Reformatted
Area is

Format

Input record or
Literal

Output area

RFT (AAAA/BB/CCC) DDFNNNN TO (DDDD/EE/FFFF) DDFNNNN

LIT(GGGG)

Extraction
variable

Output area

RFT (VAAA/BB/CC) DDFNNNN TO (DDDD/EE/FFFF) DDFNNNN

LIT(GGGG)

Input record or
Literal

Note area

RFT (AAAA/BB/CCC) DDFNNNN TO (DDDD/EE/FFFF) DDF0000

NOTE LIT(GGGG)

Extraction
variable

Note area

RFT (VAAA/BB/CC) DDFNNNN TO (DDDD/EE/FFFF) DDF0000

Source

NOTE LIT(GGGG)

Where:
AAAA is the beginning field position of the source data from an input record or literal.
VAAA is the beginning field position of the source data in an extraction variable.
BB is one of the following: 1) the length of the source data from an input record or literal, or 2) the beginning position of the source
data from an extraction variable.
CCC is the format of the source data from an input record or the hard coded ‘LIT” if the source is a literal.
CC is the length when the source data is from an extraction variable.
DDFNNNN is the delimited data field number. When the source is not a delimited file, NNNN is 0000.
DDDD is the beginning field position of the reformatted data in the output area or the note area.
EE/FFFF are the length and format of reformatted field in the output area or the note area.
NOTE indicates that the output area is the note area.
GGGG (up to 16 Gs) is the literal if the source is a literal. Otherwise it is blanks.
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Balancing in Direct Input Mode
This chapter explains how to run balancing in direct input mode. This
application interface mode enables you to specify the control values to be
used in balancing directly, rather than having them extracted from input
sources as they are in file interface mode. Each control value is specified by
you as a direct input transaction.
This chapter contains the following sections:








“Purposes of Direct Input Mode” on page 395
“Direct Input Processing” on page 396
“Creating and Running Direct Input Balancing Job” on page 396
“Using the Direct Input Window” on page 397
“Creating Direct Input Transaction Records Manually” on page 399
“Creating Direct Input JCL” on page 401

Note:

All of the application interface modes have similar JCL and DD
statements. An EXEC statement executes either an ACR/Summary
program or an application program (which, in turn, invokes ACR/
Summary). The DD statements point the ACR/Summary software
modules to data and definitions and provide for report output. For more
information, see Running Balancing Jobs and Other JCL in Batch on
page 369.

Purposes of Direct Input Mode
Direct input mode is useful for the purposes such as the following:

 Processing data that is not available on your system. For example, your
balancing might require entry of the current prime rate, obtained by
making a telephone call to the bank.

 Testing new balancing jobs. It allows you to validate ACR/Summary
definitions and produce sample control reports without processing
application programs or files.

 Priming the history database.
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Direct Input Processing
The Direct Input (UAC3000) program is used to run direct input balancing.
The direct input transactions you create will be stored in the direct input
file. This file can contain multiple sets of data, each for a different job ID, as
explained below. The default direct input file is the DIRDATA member in
your TRANLIB.
When UAC3000 is executed, it reads a complete set of direct input data
from the direct input file and then invokes the file interface (ACR2000)
balancing function, which performs the balancing specified in the job
definitions for the direct input job ID.
When control is returned to UAC3000, the program attempts to read
another set of direct input data. If another set of direct input data is found,
the balancing function is again invoked, but for the job ID specified in that
set of data. This continues until no more sets of direct input data
transactions remain to be processed in the direct input file.

Creating and Running Direct Input Balancing Job
Use the following procedure:
1. Create the job definitions. The process is very similar to setting up

definitions for a job to be run in file interface mode (described in
“Entering Basic Job Information” on page 155 and “Creating Job
Definitions” on page 193.
2. Create the direct input transactions through the Direct Input Window.

See “Using the Direct Input Window” on page 397.
3. Create and submit the JCL. by selecting the following from the Job

Window: Setup > Create JCL > Direct Input JCL. For more
information, see “Direct Input JCL Panel” on page 378.
4. To view these reports, look for DDNames UNIACR, UNIRCR, and

UNIUSR from your output facility. When the job runs, it generates a
Control Report (UNIACR), a Direct Input Transaction Report
(UNITR). If specified, it will also create a Recap Report (UNIRCR).
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Using the Direct Input Window
To access the Direct Input window, from the Job Window, select Window
> Direct Input Data.
File Edit Help
------------------------------------------------------------------------Direct Input Window
Row 1 from 6

_
A. Library Information:
_
< NEW... >
_
B. Data Parameters:
_
< NEW... >
_
C. Data Fields:
_
< NEW... >
***************************** Bottom of data ****************************

F7=Up
F9=Swap

F8=Down

For each option, select New to display the corresponding panel. The
options, with corresponding page numbers, are as follows:

 Library Information. See "Data Library Information Panel" below.
 Data Parameters. See “Direct Input Data Parameters Panel” on
page 398

 Data Fields. See “Data Entry Panel” on page 398

Data Library Information Panel
Data Library Information
Direct input data library:
Dataset name: USERIDA.SUM.TRANLIB_________________________
Member name: DIRDATA_ Reuse member? Y (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Dataset name. Library that will store the data. Defaults to the transaction
library file specified on the User File Defaults panel. Change if appropriate.
Member name. Member that will store the data. Defaults to DIRDATA.
Change if appropriate.
Accept. The next panel will display.
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Direct Input Data Parameters Panel
Direct Input Data Parameters
Job name: . . ________
Cycle number: ________
F1=Help

F2=Split

Step name: . . ________ Qual: __
Run number:
___ Control field: ____
F3=Exit

F5=Accept

F9=Swap

Job name, Step name, and Qualifier (if applicable). Complete these
fields to identify the direct input job.
Cycle number. Cycle number to be assigned to the current run.
Run number. (Optional). Run number to be assigned to the current run.
Control field. If you are using alternate balancing rules, enter the control
field in the format 01Xn, where n is the rule set number.
Press F5 to accept. The next panel will display.

Data Entry Panel
Use this panel to enter the control values.
Data Entry
Internal item number: I

000

Enter numeric data: _______________________________
or text data: ________________________________________
________________________________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Internal Item Number. Identify the internal item or extended internal
item that will store the value you want to input. Complete this 2-part field
with the following:

 1-digit item type indicator (I for internal item or X for extended internal
item).

 3-digit item number.
Enter numeric data...or text data. Complete one of the fields with the
data to be stored in the specified item.

 Numeric data. Stores numeric or date function data.
For numeric data, enter up to 15 digits (30 for extended data).
For a date function, enter an @, followed the data format indicator,
followed by the date:
Valid date format indicators for this field:
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1 YYMMDD
2 MMDDYY
3 MMDDCCYY
4 DDMMYY
5 YYJJJ
6 DDMMCCYY
For example:
@1060101
Where @ identifies this value as a date function, 1 specifies the date
format YYMMDD, and 060101 is the date value.

 Text data. Enter up to 8 characters (80 for extended data).
When you complete the panel and press F5, the following will happen.

 Numeric values will be right-justified and padded to the left with
leading zeros. The sign will indicate whether the value is negative or
positive.

 You will receive an ITEM ADDED message.
You can then optionally complete the panel again to add another control
value. When you press F3, all control values you have entered will be
displayed in the Direct Input Window. Save your direct input data.

Creating Direct Input Transaction Records
Manually
You can use your edit facility to create the direct input transaction records
yourself.
To specify a set of direct input data for one job ID, you will need to create
two types of records, both of which will be stored in the direct input file.
This file can be a member of a PDS or a separate sequential file. By default
the data is stored in the TRANLIB with the member name DIRDATA.
Each set of data in the direct input file will correspond to one job ID and will
consist of one Record 1 type, followed one or more Record 2 types.
Transaction records beginning with an asterisk (*) in position 1 can be used
to supply comments and are not processed.
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The record layouts are described below.

Direct Input Record Layouts
Direct Input Record Layout - Record 1
Field#

Description

Position

Length

Format

Value

1

Job ID

1-18

18

X(18)

2

Transaction Type

19

1

9(1)

1

3

Transaction Sequence

20-22

3

9(3)

000

4

Cycle Number

23-30

8

9(8)

0000000099999999

5

Run Number

31-33

3

9(3)

000-999

6

Control Field

34-37

4

X(4)

Blanks or
01X1-01X9

7

Reserved

38-80

43

X(43)

Blanks

Value

Direct Input Layout - Record 2
Field#

Description

Position

Length

Format

1

Job ID

1-18

18

X(18)

21

Transaction Type

19

1

9(1)

2, 3

3

Item Number

20-22

3

9(3)

001-100

42

Transaction Sequence

23-24

2

X(2)

01, 02

53

Control Value

25-65

41

6

Reserved

66-80

15

X(15)

Blanks

1 - Transaction Type: 2=for internal item, 3=for extended internal item
2 - Transaction Sequence: 01=for numeric control value, or the first 40 characters of text control value
02=for the last 40 character of text control value.
3 - Control Value:
If numeric, consists of 31 characters. The first character must be a + or - sign.
This is followed by the numeric value padded to the left with leading zeroes. For example,
+000056789012345678901234567890.
If text, the first 40 characters will be put in Transaction Sequence 01 record starting with a quote.
The last 40 characters will be put in Transaction Sequence 02 record ending with the quote.

400

Infogix, Inc.

Balancing in Direct Input Mode  11
Creating Direct Input JCL

Creating Direct Input JCL
For instructions, see “Running Balancing Jobs and Other JCL in Batch” on
page 369.
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12
Balancing in Program Interface
Mode
This chapter discusses program interface mode. Program interface is
typically used for new applications or applications whose programs are
being developed or modified. It requires simple source code additions to
your application to extract the application control values and call the
appropriate program interface program.
Because program interface requires changes to your application programs,
it should be implemented by a programmer. The ACR/Summary code will
need to be tested as the application changes.
This chapter contains the following sections:

 “Two Methods of Using Program Interface Mode” on page 403
 “Procedure for Using the UAC2000PI API” on page 404
 “Procedure for Using the UAC1000 Balancing Program with COBOL”
on page 409

 “Executing the Program” on page 430

Two Methods of Using Program Interface Mode
When you use program interface, you can choose between the following
methods.

Using the UAC200PI Application Program Interface (API)
The UAC200PI application program interface can be used to pass the file
and job information to UAC2000, the ACR/Summary file interface
program, which extracts the data based on your file definitions and then
performs the balancing.
With this approach, you can create and maintain your definitions for file
extraction through the ACR/Summary interface, eliminating the need to
code and maintain program statements in your source code to perform the
extraction.

Using the UAC1000 Balancing Program
This is the original program interface method. You can use either a COBOL
compiler or the IBM High Level Assembler for the UAC1000 method.
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With this approach, you must add program statements to your application
code to extract the data. Your application then calls the UAC1000 program,
which checks the accumulated data and performs the balancing.
UAC1000 checks the data at the point where it is accumulated, allowing
earlier detection of errors. Less maintenance is required to the ACR/
Summary definitions because the data is loaded by the program.

Procedure for Using the UAC2000PI API
Source Code Statements (COBOL)
When you use program interface mode, additional program statements are
added to your application code to call UAC200PI after allocating the
appropriate files. The additional statements needed for COBOL programs
are explained below.

COPY Statement
A COPY statement that defines the linkage between programs must be
added to the working storage section of your application program. The
UAC2FILE copybook can be found in the COPYLIB dataset unloaded
during installation. Here is an example of the COPY statement.
COPY UAC2FILE
The following figure shows the contents of UAC2FILE.
* Copybook for use with UAC200PI.
01 UAC200PI-AREA.
05 UAC200PI-LAYOUT-VERSION
05 UAC200PI-JOB-STEP-QUAL.
10 UAC200PI-JOB
10 UAC200PI-STEP
10 UAC200PI-QUAL
05 UAC200PI-CYC
05 UAC200PI-FILES.
10 UAC2000PI-ENTRY OCCURS
15 UAC200PI-DDNAME
15 UAC200PI-DSN
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PIC X(2) VALUE '01'.
PIC
PIC
PIC
PIC

X(8).
X(8).
X(2).
9(8).

100 TIMES.
PIC X(8) VALUE SPACES.
PIC X(44) VALUE SPACES.
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Procedure Division Statements
You will need some or all of the following procedure division statements
depending on your situation. For ease of maintenance, we recommend that
these statements be grouped together in their own paragraph or section,
whenever possible.
Note:

Do not initialize the group level UAC200PI-AREA. Initial values for some
fields are required which are set within the copybook. The following
section describes the fields to be set by the program.

Loading the Job ID (Required)
Pass the job name and step name through the UAC200PI-JOB and
UAC200PI-STEP fields.
When JSQs (job/step/qualifiers) are used, a statement is needed to move
the appropriate value to the UAC200PI-QUAL field. For example:
MOVE 'A1' TO UAC200PI-QUAL.
The specific value moved depends on the value of the JSQ (UAC200PIQUAL) used in the corresponding job definitions.
Note:

Unlike file interface, JSQs do not execute automatically one after
another.

Loading the Cycle Number
A PIC 9(8) field stores the cycle number. The application program should
include the necessary statements to initialize this field (if the cycle number
is provided by using automatic cycle processing. Or, the program should fill
in a cycle override). Here is an example:
MOVE PRODUCTION-CYCLE TO UAC200PI-CYC.

Loading the Run Number
When a run number is used, it can be set to any value from 1 to 999. If a run
number is not used, it should be set to zero. Following is an example to set
the run number:
MOVE '088' TO ACR-RUN-NUMBER.

Loading the Files
The UAC200PI-Files area is a table (array) containing the DDNames and
data set names that you want to use for balancing. For each DDName, a
corresponding file name must be specified. You can specify up to 100
DDNames and file names.
ACR/Summary will apply the file extraction rules defined by each DDName
in this table against the data in its corresponding file name.
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For example, if your job uses two files, and your file extraction definitions
have the DDNames GENLEDGR and BALSHEET associated with them,
you would move those names into UAC-200PI-Files along with the names
of the associated datasets as shown below:
MOVE
MOVE
MOVE
MOVE

'GENLEDGR' to UAC200PI-DDNAME(1)
'PRGEN.LEDGER.DATA' to UAC200PI-DSN(1)
'BALSHEET' to UAC200PI-DDNAME(2)
'PRBAL.SHEET.DATA' to UAC200PI-DSN(2)

Issuing the CALL Statement
After all fields are loaded, you need to call UAC200PI. The following
sample, PFISAMP, is located in your SRCELIB.
Note:
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The call to UAC200PI can be dynamic or static. Using a dynamic call will
make it easier to take full advantage of features implemented in future
releases.
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IDENTIFICATION DIVISION.
PROGRAM-ID. PFISAMP.
ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
WORKING-STORAGE SECTION.
* THIS PROGRAM IS A SAMPLE SHOWING HOW TO CALL UAC200PI
* DIRECTLY IN PROGRAM INTERFACE MODE.
01

MY-WORKING-STORAGE.
05 FILLER
PIC X(40)
VALUE
'WORKING-STORAGE FOR PFISAMP STARTS HERE.'.
COPY UAC2FILE.
05 PGM-TO-CALL

PIC X(8)
VALUE 'UAC200PI'.

PROCEDURE DIVISION.
*---------------------------------------------------------------*
ATTEMPT TO CALL ACR SUMMARY FILE INTERFACE FROM A PROGRAM *---------------------------------------------------------------0000-PROGRAM-CONTROL.
MOVE 'yourjob '
TO UAC200PI-JOB.
MOVE 'yourstep'
TO UAC200PI-STEP.
MOVE SPACES
TO UAC200PI-QUAL.
MOVE '00000001'
TO UAC200PI-CYC.
MOVE SPACES
TO UAC200PI-FILES.
MOVE 'yourdd '
TO UAC200PI-DDNAME(1).
MOVE 'your.filename' TO UAC200PI-DSN(1).
CALL PGM-TO-CALL USING UAC200PI-AREA.
DISPLAY 'RETURN-CODE IS ' RETURN-CODE.
GOBACK.

Processing the Return Code
After the balancing function has completed, if your job/step rules specify to
set the return code, ACR/Summary returns a 4-digit code to the application
program through the RETURN-CODE field. The application program may
include statements to examine this code and take appropriate action.
For example:

 DISPLAY 'ACR RETURN CODE =' RETURN-CODE.
 IF RETURN-CODE NOT = ZEROES
PERFORM 9000-OUT-OF-BALANCE.
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Setting the Step Completion Code
When you are using UAC200PI program interface, the return code field will
be set depending on the Set Return Code option in your ACR/Summary
rules. You must code your rules so that it sets the return-code field.
For example, suppose you have coded your rules so that they set return
codes of values between 3001 and 3999 when out of balance.
If you want those rules to set the return-code field when out of balance, you
must set the option in your ACR/Summary rules to the following: Yes highest balancing return code.

Compiling and Link-Editing the Program
Obtain the standard COBOL compile and link-edit JCL procedure for your
site. Modify the compile step to include the necessary DD statement to
identify the dataset name of the COPY library containing the UAC2FILE
member. This is usually the SRCELIB DD statement in the compile step.
Check with your systems programmer to find out the dataset name of this
COPY library.
For a static call, modify the link-edit step to include the necessary DD
statement to identify the dataset name that contains the UAC200PI object
module. This is usually the SYSLIB DD statement in the link-edit step.
Check with your systems programmer to find out the dataset name of the
LOAD library. Finally, submit the JCL and create a program load module.
For a dynamic call, no changes to the link-edit step are necessary.
The instructions for executing the program are the same regardless of
whether you use the UAC200PI method or the UAC1000 method. For
instructions, see “Executing the Program” on page 430
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Procedure for Using the UAC1000 Balancing
Program with COBOL
You can use either a COBOL compiler or the IBM High Level Assembler for
UAC1000. To use the IBM High Level Assembler, see “Procedure for Using
the UAC1000 Balancing Program with Assembler” on page 428.
Starting release 9.0, ACR/Summary supports processing of additional
Date, and Time formats in the Program Interface Mode (UAC1000 user
program).
In order to use the extended capabilities, you need to use the new
copybook, ACRXAREA, and compile all programs that use Program
Interface.
The new copybook for Program Interface mode, ACRXAREA, offers these
extended functionality:

 Return of 999 history items
 Additional Date formats
 CCYYJJJ
 DDMMMYY
 DDMMMCCYY
 MMMDDYY
 MMMDDCCYY
 Time formats with and without AM/PM indicator.
 HHMM
 HHMMSS
 HHMMSSNN
Go to, “Program Interface Mode using ACRXAREA Copybook” on
page 418, if you intend to use the extended Date and Time formats.

Program Interface Mode using ACRAREA Copybook
When you use program interface mode, additional program statements are
added to your application code to extract the control values and call
UAC1000. The additional statements needed for COBOL programs are
explained below.

COPY Statement
A COPY statement that defines the linkage between programs must be
added to the working storage section of your application program. The
ACRAREA copybook can be found in the COPYLIB dataset unloaded during
installation. Here is an example of the COPY statement.
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COPY ACRAREA
The following figure shows a partial listing of the ACRAREA copy member.
01

ACR-AREA.
05 ACR-DATA-REL-VERSION
05
05

PIC X(9)
VALUE '0400/0000'.
ACR-DATA-CONTROL-AREA
PIC X(900) VALUE SPACES.
FILLER REDEFINES ACR-DATA-CONTROL-AREA.
10 ACR-RETURN-CODE
PIC X(4).
10 ACR-CONTROL-FIELD
REDEFINES
ACR-RETURN-CODE.
15 ACR-CONTROL-OPTION
PIC X(2).
88 USE-ALT-BAL-RULE
VALUE '01'.
15 ACR-CONTROL-VALUE
PIC X(2).
10 ACR-OPTIONS
PIC X(6).
10 ACR-VALUE-AREA.
15 ACR-VALUE
OCCURS 100 TIMES.
20 ACR-FIELD
PIC X(8).
20 ACR-COUNT
REDEFINES
ACR-FIELD
PIC S9(15)
COMP-3.
20 ACR-AMOUNT
REDEFINES

Procedure Division Statements
You will need some or all of the following procedure division statements
depending on your situation. For ease of maintenance, we recommend that
these statements be grouped together in their own paragraph or section,
whenever possible.
Note:

Do not initialize the group level ACR-AREA. Initial values for some fields
are required which are set within the copybook. The following section
describes the fields to be set by the program.

Loading the Job ID
There are two ways to set the job ID for program interface:

 Leave the ACR-JOB-NAME and ACR-STEP-NAME fields blank and
they will be set to the currently executing job name and step name.

 Pass in the job name and step name through the ACR-JOB-NAME and
ACR-STEP-NAME fields.
When JSQs (job/step/qualifiers) are used, a statement is needed to
move the appropriate value to the ACR-QUALIFIER field. For
example:
MOVE 'A1' TO ACR-QUALIFIER.
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The specific value moved depends on the value of the JSQ (ACRQUALIFIER) used in the corresponding job definitions.
Note:

Unlike file interface, JSQ’s do not execute automatically one after
another.

Loading the Cycle Number
Cycle number is a PIC 9(8) field that stores the cycle number. The
application program should include the necessary statements to initialize
this field (unless the cycle number is provided by using automatic cycle
processing or cycle override). Here are some examples:
MOVE
MOVE
MOVE
MOVE

PRODUCTION-DAY TO ACR-CYCLE-DAY.
PRODUCTION-MONTH TO ACR-CYCLE-MONTH.
PRODUCTION-YEAR TO ACR-CYCLE-YEAR.
PRODUCTION-CENTURY TO ACR-CYCLE-CENTURY.

Loading the Run Number
When the run number is used, it may be set to any value from 1 to 999
(unless the Run Number is provided by using automatic cycle processing or
cycle override). For example:
MOVE '088' TO ACR-RUN-NUMBER.

This statement is not necessary if automatic cycle processing is being used
or if run numbers are not being used.
Loading the Balancing Control Field for Alternate Balancing Rules
Alternate balancing rules allow you to balance different information based
on criteria you set in your application program. For more information, see
“Using Alternate Balancing Rules” on page 245.
The ACR-CONTROL-FIELD is a 4-character field that allows you to specify
alternate balancing rules. Up to 10 different sets of rules may be specified
for a Job ID. The first digit of the rule number uniquely identifies a rule set.
Rule numbers 001 - 100 are used unless the alternate rule option is
specified by setting the ACR-CONTROL FIELD to 01Xr, where r is the
desired rule set.
For example, to execute alternate rules 101 - 200 when the month changes,
you might code:
IF FIRST-DAY-OF-MONTH
MOVE '01X1' TO ACR-CONTROL-FIELD.
Note:

Leave this blank if you are not using this feature.
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Loading the Internal Item Values
These statements load the control value fields in ACR-AREA with the
appropriate internal item values after they have been processed by the
application program.
The control value fields in ACR-AREA are redefined as described below:
ACR-COUNT, ACR-AMOUNT, ACR-DATE, and ACR-TEXT.
ACR-COUNT control value fields have PIC S9(15) format. ACR-AMOUNT
control value fields have PIC S9(13)V99 format. ACR-TEXT control value
fields have PIC X(8) format.
ACR-XI-COUNT, ACR-XI-AMOUNT, and ACR-XI-TEXT.
ACR-XI-COUNT control value fields have PIC S9(30) format. ACR-XIAMOUNT control value fields have PIC S9(28)V99 format. ACR-XI-TEXT
control value fields have PIC X(80) format.
For example:
MOVE TOTAL-DOLLARS TO ACR-AMOUNT(1).
MOVE TOTAL-RECORDS TO ACR-COUNT(2).
MOVE DIVISION-NAME TO ACR-TEXT(3).

The values of the subscripts to be used with the ACR-COUNT, ACRAMOUNT, ACR-TEXT, ACR-DATE fields refer to the corresponding
internal item numbers as specified in the ACR/Summary definitions.
Therefore, I-004 would be written as:
MOVE CLOSING-PRICE TO ACR-AMOUNT(4).

For date functions, you must specify both the date format into ACR-DATEFMT and the date value into ACR-DATE-VAL with the appropriate
subscript corresponding to the internal item.
MOVE 1 TO ACR-DATE-FMT (1).
MOVE 930101 TO ACR-DATE-VAL (1).

The valid values for ACR-DATE-FMT and the required formats for ACRDATE-VAL are listed below:







1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ

 6. DDMMCCYY
 8. CYYMMDD
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 9. CCYYMMDD
Increasing Efficiency
The ACR-FILE-DISP-IND option decreases the amount of opens and closes
done to the definition database. The valid values for this parameter are:

 O. Open database
 C. Close database
 Blank. Database will be opened and closed with each call
If O is specified, the database will be opened once and will not be closed
until C, the last call parameter, is passed. If this option is left blank, the
database will be opened and closed with each call, reducing the overall
efficiency of the system.
Warning:

If O is passed to open the database in the first call, C must be
passed on the last call to close the database, otherwise the
definition databases will remain open and future conflicts may occur.

Issuing the CALL Statement
After all fields are loaded, this statement invokes the ACR/Summary
program interface module. For example:
CALL 'UAC1000' USING ACR-AREA.
Note:

The call to UAC1000 can be either dynamic or static. Using a dynamic
call will make it easier to take full advantage of features implemented in
future releases.
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WORKING-STORAGE SECTION.
.
.
COPY ACRAREA.
.
.
PROCEDURE DIVISION.
.
.
MOVE PRODUCTION-DATE
TO
ACR-CYCLE-NUMBER.
MOVE BATCH-NUMBER
TO
ACR-RUN-NUMBER.
MOVE DIVISION-NUMBER
TO
ACR-QUALIFIER.
MOVE TOTAL-DOLLARS
TO
ACR-AMOUNT(1).
MOVE TOTAL-RECORDS
TO
ACR-COUNT(2).
MOVE DIVISION-NAME
TO
ACR-TEXT(3).
MOVE REGION-DOLLARS
TO
ACR-XI-AMOUNT(1).
MOVE REGION-NAMES
TO
ACR-XI-TEXT(2).
.
.
CALL 'UAC1000' USING ACR-AREA.
IF ACR-RETURN-CODE NOT = ZEROES
PERFORM 9000-OUT-OF-BALANCE.
GOBACK.

Processing the Return Code
After the balancing function has completed, ACR/Summary returns a 4digit code to the application program through the ACR-RETURN-CODE
field. The application program may include statements to examine this
code and take appropriate action.
For example:

 DISPLAY 'ACR RETURN CODE =' ACR-RETURN-CODE.
 MOVE ACR-RETURN-CODE TO RETURN-CODE
 IF ACR-RETURN-CODE NOT = ZEROES
PERFORM 9000-OUT-OF-BALANCE.

Setting the Step Completion Code
When you are using Program Interface, the system will not automatically
set a step completion code. You must code your application so that it
evaluates the return-code field and passes the ACR-Return-Code to the
IBM Return-Code field as appropriate.
For example:
Suppose you have coded your rules so that they set return codes of values
between 3001 and 3999 when out of balance. If you want those rules to set
the return-code field when out of balance, you would code the following
logic in your application program:
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IF ACR-RETURN CODE > 3000
MOVE ACR-RETURN-CODE TO RETURN-CODE
ELSE
MOVE ZERO TO RETURN-CODE
END-IF

Compiling and Link-Editing the Program
Obtain the standard COBOL compile and link-edit JCL procedure for your
site. Modify the compile step to include the necessary DD statement to
identify the dataset name of the COPY library containing the ACRAREA
member. This is usually the SYSLIB DD statement in the compile step.
Check with your systems programmer to find out the dataset name of this
COPY library.
For a static call, modify the link-edit step to include the necessary DD
statement to identify the dataset name that contains the UAC1000 object
module. This is usually the SYSLIB DD statement in the link-edit step.
Check with your systems programmer to find out the dataset name of the
LOAD library. Finally, submit the JCL and create a program load module.
For a dynamic call, no changes to the link-edit step are necessary.
The instructions for executing the program are the same regardless of
whether you use the UAC200PI method or the UAC1000 method. For
instructions, see “Executing the Program” on page 430.

Returned Values from the Balancing Function
When the program interface mode (UAC1000) was called, the ACR-AREA
contained those values loaded into it by the program (e.g., cycle number,
internal item values, etc.). However, when the program interface mode
returns control to the application program, the control value fields in ACRAREA will be overlaid to contain certain other values, as follows:

History Item Values
When control is returned to the program, the internal item values are
overlaid with the history item values associated with the Job ID. History
item E-001 is returned in ACR-FIELD(1), history item E-002 in ACRFIELD(2), and so forth.
If the history item contains extended data, the history item is returned in
ACR-XI-FIELD(1).
These values can have special meaning, as follows:
High-Values (X`FF'). No history items were defined for these control
value fields.
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Low-Values (X`00'). History items were defined for these control value
fields, but the histories for the specified relative cycles were not found in the
database.
In all other cases, the fields will contain the history item value.

Return Code
Note that the field ACR-RETURN-CODE is redefined as ACR-CONTROLFIELD, which can be loaded by the program to invoke alternate rules. After
the balancing function is complete, any value in the ACR-CONTROLFIELD is overlaid with the balancing return code. The field ACR-RETURNCODE can be tested to control further processing, in “Procedure Division
Statements” on page 410.
Note:

If calling UAC1000 multiple times in one step, move spaces or the
desired return code to the ACR-RETURN-CODE field in the user
program after the call to UAC1000. If using alternate balancing rules,
move the desired rule set to the ACR-CONTROL-FIELD. This will
ensure an accurate return code and/or alternate balancing rule set for
each job that is executed for this step.

In Program Interface Mode, setting a return code in the Job Run Options
will not abend your job. To abend a job based on a return code, you must
pass the return code to the system and abend the job in your JCL. Below is
an example of the program code that you would want to include:
IF ACR-RETURN CODE > 3000
MOVE ACR-RETURN-CODE TO RETURN-CODE
ELSE
MOVE ZERO TO RETURN-CODE
END-IF

Job ID
The field ACR-JOB-ID will contain the job name, step name, and JSQ used
by the balancing function, whether supplied by the program or
automatically retrieved from the operating system.
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Cycle ID
The ACR-CYCLE-NUMBER and ACR-RUN-NUMBER fields will contain
the current cycle ID used by the balancing function, whether supplied by
the program or obtained in other ways.
Note:

If calling UAC1000 multiple times in one step, move spaces or the
desired Cycle ID to ACR-CYC-ID in the user program after the call to
UAC1000. This will ensure an accurate Cycle ID for each job that is
used in this step.

Programs Using Subprograms
In this case, an application program calls other programs. Control values
may be accumulated within the calling and called programs. An example of
this situation may be handled as follows:
1. In the calling program:
a. Place the COPY ACRAREA statement in the WORKING-STORAGE

section.
b. Include the necessary MOVE statements to load the control values

obtained in this program.
c. Call the other application program, including ACRAREA as a

parameter in the CALL statement.
d. Call UAC1000.
e. Test the balancing return code.
2. In the called programs:
a. Place the COPY ACRAREA statement in the LINKAGE section.
b. Include ACR-AREA in the parameter list of the USING clause of

the PROCEDURE DIVISION statement.
c. Insert the necessary MOVE statements to load the control values

obtained in this program.
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d. Use GOBACK to return to the calling program.
A.

Calling Program
.

.
WORKING-STORAGE SECTION.
COPY ACRAREA.
PROCEDURE DIVISION.
.
.
MOVE
MOVE
MOVE
MOVE

PRODUCTION-DATE TO ACR-CYCLE-NUMBER.
ZEROES TO ACR-RUN-NUMBER.
TOTAL-AMOUNT TO ACR-AMOUNT(1).
TOTAL-COUNT TO ACR-COUNT(2).

PERFORM 9000-PROCESS-RETURN-CODE.
CALL 'MODULE01' USING PASS-FIELDS, ACR-AREA.
CALL 'UAC1000' USING ACR-AREA.
STOP RUN.
B.

Called Program (MODULE01)
.
.
LINKAGE SECTION.
COPY ACRAREA.
PROCEDURE DIVISION USING PASS-FIELDS, ACR-AREA.

.
.
MOVE DOLLARS-XYZ TO ACR-AMOUNT(3).
MOVE ITEMS-XYZ TO ACR-COUNT(4).
GOBACK.

3. Proceed to “Executing the Program” on page 430.

Program Interface Mode using ACRXAREA Copybook
When you use program interface mode, additional program statements are
added to your application code to extract the control values and call
UAC1000. The additional statements needed for COBOL programs are
explained below.

COPY Statement
A COPY statement that defines the linkage between programs must be
added to the working storage section of your application program. The
ACRXAREA copybook can be found in the COPYLIB dataset unloaded
during installation.
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Procedure Division Statements
You will need some or all of the following procedure division statements
depending on your situation. For ease of maintenance, we recommend that
these statements be grouped together in their own paragraph or section,
whenever possible.
Note:

Do not initialize the group level ACR-AREA. Initial values for some fields
are required which are set within the copybook. The following section
describes the fields to be set by the program.

Loading the Job ID
There are two ways to set the job ID for program interface:

 Leave the ACR-JOB-NAME and ACR-STEP-NAME fields blank and
they will be set to the currently executing job name and step name.

 Pass in the job name and step name through the ACR-JOB-NAME and
ACR-STEP-NAME fields.
When JSQs (job/step/qualifiers) are used, a statement is needed to
move the appropriate value to the ACR-QUALIFIER field. For
example:
MOVE 'A1' TO ACR-QUALIFIER.

The specific value moved depends on the value of the JSQ (ACRQUALIFIER) used in the corresponding job definitions.
Note:

Unlike file interface, JSQ’s do not execute automatically one after
another.

Loading the Cycle Number
Cycle number is a PIC 9(8) field that stores the cycle number. The
application program should include the necessary statements to initialize
this field (unless the cycle number is provided by using automatic cycle
processing or cycle override). Here are some examples:
MOVE
MOVE
MOVE
MOVE

PRODUCTION-DAY TO ACR-CYCLE-DAY.
PRODUCTION-MONTH TO ACR-CYCLE-MONTH.
PRODUCTION-YEAR TO ACR-CYCLE-YEAR.
PRODUCTION-CENTURY TO ACR-CYCLE-CENTURY.

Loading the Run Number
When the run number is used, it may be set to any value from 1 to 999
(unless the Run Number is provided by using automatic cycle processing or
cycle override). For example:
MOVE '088' TO ACR-RUN-NUMBER.
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This statement is not necessary if automatic cycle processing is being used
or if run numbers are not being used.
Loading the Balancing Control Field for Alternate Balancing Rules
Alternate balancing rules allow you to balance different information based
on criteria you set in your application program. For more information, see
“Using Alternate Balancing Rules” on page 245.
The ACR-CONTROL-FIELD is a 4-character field that allows you to specify
alternate balancing rules. Up to 10 different sets of rules may be specified
for a Job ID. The first digit of the rule number uniquely identifies a rule set.
Rule numbers 001 - 100 are used unless the alternate rule option is
specified by setting the ACR-CONTROL FIELD to 01Xr, where r is the
desired rule set.
For example, to execute alternate rules 101 - 200 when the month changes,
you might code:
IF FIRST-DAY-OF-MONTH
MOVE '01X1' TO ACR-CONTROL-FIELD.
Note:

Leave this blank if you are not using this feature.

Loading the Internal Item Values
These statements load the control value fields in ACR-AREA with the
appropriate internal item values after they have been processed by the
application program.
The control value fields in ACR-AREA are redefined as described below:
ACR-COUNT, ACR-AMOUNT, ACR-DATE, and ACR-TEXT.
ACR-COUNT control value fields have PIC S9(15) format. ACR-AMOUNT
control value fields have PIC S9(13)V99 format. ACR-TEXT control value
fields have PIC X(8) format.
ACR-XI-COUNT, ACR-XI-AMOUNT, and ACR-XI-TEXT.
ACR-XI-COUNT control value fields have PIC S9(30) format. ACR-XIAMOUNT control value fields have PIC S9(28)V99 format. ACR-XI-TEXT
control value fields have PIC X(80) format.
For example:
MOVE TOTAL-DOLLARS TO ACR-AMOUNT(1).
MOVE TOTAL-RECORDS TO ACR-COUNT(2).
MOVE DIVISION-NAME TO ACR-TEXT(3).
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The values of the subscripts to be used with the ACR-COUNT, ACRAMOUNT, ACR-TEXT, ACR-DATE fields refer to the corresponding
internal item numbers as specified in the ACR/Summary definitions.
Therefore, I-004 would be written as:
MOVE CLOSING-PRICE TO ACR-AMOUNT(4).

For Date functions, you must specify both the date format into ACR-DATEFMT and the date value into ACR-DATE-VAL with the appropriate
subscript corresponding to the internal item.
For example, to move a date to an internal item 10 and to internal item 16
Numeric date
MOVE 'D' TO ACR-TYPE-ID(10)
MOVE '1' TO ACR-DATE-FMT(10)
MOVE 680429 TO ACR-DATE-VAL(10)

Alpha date
MOVE 'D' TO ACR-TYPE-ID(16)
MOVE 'B' TO ACR-DATE-FMT(16)
MOVE '04OCT62' TO ACR-DATE-TEXT(16)

The valid values for ACR-DATE-FMT, and the required data formats for
ACR-DATE-VAL are listed below:















1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
8. CYYMMDD
9. CCYYMMDD
A. CCYYJJJ
B. DDMMMYY
C. DDMMMCCYY
D. MMMDDYY
E. MMMDDCCYY

ACR/Summary User Guide for z/OS

421

12  Balancing in Program Interface Mode
Procedure for Using the UAC1000 Balancing Program with COBOL

For Time functions, you must specify the Time format, and then move the
time either to the ACR-TIME-TEXT or ACR-TIME-VAL field. Move “Y” to
ACR-TIME-AMPM-IND if you pass the AM/PM indicator.
The valid values for ACR- TIME-FMT, and the required data formats for
ACR-TIME-VAL or ACR-TIME-TEXT are listed below

 1. HHMM
 2. HHMMSS
 3. HHMMSSNN
For example:
Numeric time
MOVE 'T' TO ACR-TYPE-ID(13)
MOVE '2' TO ACR-TIME-FMT(13)
MOVE 'N' TO ACR-TIME-AMPM-IND(13)
MOVE 201504 TO ACR-TIME-VAL(13)

Alpha time
MOVE 'T' TO ACR-TYPE-ID(14)
MOVE 2 TO ACR-TIME-FMT(14)
MOVE 'Y' TO ACR-TIME-AMPM-IND(14)
MOVE '081503AM' TO ACR-TIME-TEXT(14)

Now, 999 history items may be returned as a combination of both Internal
Items (II) and Extended Internal Items (XI).
Depending on the history item number and type, they will be returned into
the correct II or XI layout located in that array by the number it is defined
in the product.
For example if your first 5 history items are II type items you will access
them from the first 5 of the II buffer; if the next 5 are XI you will access the
XI buffer in position 6 through 10.

Increasing Efficiency
The ACR-FILE-DISP-IND option decreases the amount of opens and closes
done to the definition database. The valid values for this parameter are:

 O. Open database
 C. Close database
 Blank. Database will be opened and closed with each call
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If O is specified, the database will be opened once and will not be closed
until C, the last call parameter, is passed. If this option is left blank, the
database will be opened and closed with each call, reducing the overall
efficiency of the system.
Warning:

If O is passed to open the database in the first call, C must be
passed on the last call to close the database, otherwise the
definition databases will remain open and future conflicts may occur.

Issuing the CALL Statement
After all fields are loaded, this statement invokes the ACR/Summary
program interface module. For example:
CALL 'UAC1000' USING ACR-AREA.
Note:

The call to UAC1000 can be either dynamic or static. Using a dynamic
call will make it easier to take full advantage of features implemented in
future releases.

WORKING-STORAGE SECTION.
.
.
COPY ACRXAREA.
.
.
PROCEDURE DIVISION.
.
.
MOVE PRODUCTION-DATE
TO
ACR-CYCLE-NUMBER.
MOVE BATCH-NUMBER
TO
ACR-RUN-NUMBER.
MOVE DIVISION-NUMBER
TO
ACR-QUALIFIER.
MOVE TOTAL-DOLLARS
TO
ACR-AMOUNT(1).
MOVE TOTAL-RECORDS
TO
ACR-COUNT(2).
MOVE DIVISION-NAME
TO
ACR-TEXT(3).
MOVE REGION-DOLLARS
TO
ACR-XI-AMOUNT(1).
MOVE REGION-NAMES
TO
ACR-XI-TEXT(2).
.
.
CALL 'UAC1000' USING ACR-AREA.
IF ACR-RETURN-CODE NOT = ZEROES
PERFORM 9000-OUT-OF-BALANCE.
GOBACK.

Processing the Return Code
After the balancing function has completed, ACR/Summary returns a 4digit code to the application program through the ACR-RETURN-CODE
field. The application program may include statements to examine this
code and take appropriate action.
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For example:

 DISPLAY 'ACR RETURN CODE =' ACR-RETURN-CODE.
 MOVE ACR-RETURN-CODE TO RETURN-CODE
 IF ACR-RETURN-CODE NOT = ZEROES
PERFORM 9000-OUT-OF-BALANCE.

Setting the Step Completion Code
When you are using Program Interface, the system will not automatically
set a step completion code. You must code your application so that it
evaluates the return-code field and passes the ACR-Return-Code to the
IBM Return-Code field as appropriate.
For example:
Suppose you have coded your rules so that they set return codes of values
between 3001 and 3999 when out of balance. If you want those rules to set
the return-code field when out of balance, you would code the following
logic in your application program:
IF ACR-RETURN CODE > 3000
MOVE ACR-RETURN-CODE TO RETURN-CODE
ELSE
MOVE ZERO TO RETURN-CODE
END-IF

Compiling and Link-Editing the Program
Obtain the standard COBOL compile and link-edit JCL procedure for your
site. Modify the compile step to include the necessary DD statement to
identify the dataset name of the COPY library containing the ACRXAREA
member. This is usually the SYSLIB DD statement in the compile step.
Check with your systems programmer to find out the dataset name of this
COPY library.
For a static call, modify the link-edit step to include the necessary DD
statement to identify the dataset name that contains the UAC1000 object
module. This is usually the SYSLIB DD statement in the link-edit step.
Check with your systems programmer to find out the dataset name of the
LOAD library. Finally, submit the JCL and create a program load module.
For a dynamic call, no changes to the link-edit step are necessary.
The instructions for executing the program are the same regardless of
whether you use the UAC200PI method or the UAC1000 method. For
instructions, see “Executing the Program” on page 430.
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Returned Values from the Balancing Function
When the program interface mode (UAC1000) was called, the ACR-AREA
contained those values loaded into it by the program (e.g., cycle number,
internal item values, etc.). However, when the program interface mode
returns control to the application program, the control value fields in ACRAREA will be overlaid to contain certain other values, as follows:

History Item Values
When control is returned to the program, the internal item values are
overlaid with the history item values associated with the Job ID. History
item E-001 is returned in ACR-FIELD(1), history item E-002 in ACRFIELD(2), and so forth.
If the history item contains extended data, the history item is returned in
ACR-XI-FIELD(1).
These values can have special meaning, as follows:
High-Values (X`FF'). No history items were defined for these control
value fields.
Low-Values (X`00'). History items were defined for these control value
fields, but the histories for the specified relative cycles were not found in the
database.
In all other cases, the fields will contain the history item value.

Return Code
Note that the field ACR-RETURN-CODE is redefined as ACR-CONTROLFIELD, which can be loaded by the program to invoke alternate rules. After
the balancing function is complete, any value in the ACR-CONTROLFIELD is overlaid with the balancing return code. The field ACR-RETURNCODE can be tested to control further processing, in “Procedure Division
Statements” on page 410.
Note:

If calling UAC1000 multiple times in one step, move spaces or the
desired return code to the ACR-RETURN-CODE field in the user
program after the call to UAC1000. If using alternate balancing rules,
move the desired rule set to the ACR-CONTROL-FIELD. This will
ensure an accurate return code and/or alternate balancing rule set for
each job that is executed for this step.

In Program Interface Mode, setting a return code in the Job Run Options
will not abend your job. To abend a job based on a return code, you must
pass the return code to the system and abend the job in your JCL. Below is
an example of the program code that you would want to include:
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IF ACR-RETURN CODE > 3000
MOVE ACR-RETURN-CODE TO RETURN-CODE
ELSE
MOVE ZERO TO RETURN-CODE
END-IF

Job ID
The field ACR-JOB-ID will contain the job name, step name, and JSQ used
by the balancing function, whether supplied by the program or
automatically retrieved from the operating system.

Cycle ID
The ACR-CYCLE-NUMBER and ACR-RUN-NUMBER fields will contain
the current cycle ID used by the balancing function, whether supplied by
the program or obtained in other ways.
Note:

If calling UAC1000 multiple times in one step, move spaces or the
desired Cycle ID to ACR-CYC-ID in the user program after the call to
UAC1000. This will ensure an accurate Cycle ID for each job that is
used in this step.

Programs Using Subprograms
In this case, an application program calls other programs. Control values
may be accumulated within the calling and called programs. An example of
this situation may be handled as follows:
1. In the calling program:
a. Place the COPY ACRXAREA statement in the WORKING-

STORAGE section.
b. Include the necessary MOVE statements to load the control values

obtained in this program.
c. Call the other application program, including ACRXAREA as a

parameter in the CALL statement.
d. Call UAC1000.
e. Test the balancing return code.
2. In the called programs:
a. Place the COPY ACRXAREA statement in the LINKAGE section.
b. Include ACR-AREA in the parameter list of the USING clause of

the PROCEDURE DIVISION statement.
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c. Insert the necessary MOVE statements to load the control values

obtained in this program.Use GOBACK to return to the calling
program.
A.

Calling Program
.

.
WORKING-STORAGE SECTION.
COPY ACRXAREA.
PROCEDURE DIVISION.
.
.
MOVE
MOVE
MOVE
MOVE

PRODUCTION-DATE TO ACR-CYCLE-NUMBER.
ZEROES TO ACR-RUN-NUMBER.
TOTAL-AMOUNT TO ACR-AMOUNT(1).
TOTAL-COUNT TO ACR-COUNT(2).

PERFORM 9000-PROCESS-RETURN-CODE.
CALL 'MODULE01' USING PASS-FIELDS, ACR-AREA.
CALL 'UAC1000' USING ACR-AREA.
STOP RUN.
B.

Called Program (MODULE01)
.
.
LINKAGE SECTION.
COPY ACRXAREA.
PROCEDURE DIVISION USING PASS-FIELDS, ACR-AREA.

.
.
MOVE DOLLARS-XYZ TO ACR-AMOUNT(3).
MOVE ITEMS-XYZ TO ACR-COUNT(4).
GOBACK.

3. Proceed to “Executing the Program” on page 430.
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Procedure for Using the UAC1000 Balancing
Program with Assembler
Assembler programs can call UAC1000. Using Assembler requires an
experienced Assembler programmer.

Source Code Requirements
When you use program interface mode, additional program instructions
are added to your application code to extract the control values and call
UAC1000.

DSECT
The DSECT ACRAAREA can be found in the COPYLIB dataset unloaded
during installation. Following is a partial listing of member ACRAAREA.
ACRDSECT DSECT
DC
CL9'0400/0000'
ACR RELEASE/VER NUMBER
DC
900CL1' '
DC
8000CL1' '
ORG
ACRDATA
*------------------------------------------------------------------ACRRC
DS
CL4
RETURN CODE FIELD
ORG
ACRRC
ACRCNTL DS
CL4
ALT BAL CONTROL FIELD
ORG
ACRCNTL
ACRCNTO DS
CL2
ALT BAL CONTROL OPTION
ACRCNTV DS
CL2
ALT BAL CONTROL VALUE
ACROPT
DS
CL6
ACR RUN TIME OPTS
*------------------------------------------------------------------ACRFLDS DS
100CL8
100 ACR INTERNAL ITEMS
ACRVER
ACRDATA
ACRXDAT

Instructions
You will need to perform some or all of the following tasks:

 Load the job ID





Load the cycle number
Load the run number
Load the balancing control field for alternate balancing rules
Load the internal item values

Issuing the CALL Instruction
After all fields are loaded, this instruction invokes the ACR/Summary
program interface module UAC1000.
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For an example of the CALL, reference member PIASM in the SRCELIB
dataset. The previously mentioned ACRAAREA has been incorporated
directly into the program.

Return Values from the Balancing Function
When the program interface mode (UAC1000) was called, the ACRAAREA
contained those values loaded into it by the program, such as job ID, cycle
number, internal item values, and so on. However, when the program
interface mode returns control to the application program, the control
value fields in ACRAAREA are overlaid to contain other values, as follows:

History Item Values
When control is returned to the application program, internal item values
are overlaid with history item values associated with the job ID.

Job ID
The ACRJOB field will contain the job name, step name, and JSQ used by
the balancing function, whether supplied by the program or automatically
retrieved from the operating system.

Cycle ID
The ACRCNUM and ACRNBR fields will contain the current cycle ID and
run number used by the balancing function.

Processing the Return Code
After balancing has completed, ACR/Summary returns a 4-digit code to the
application program through the ACRRC field. The application program
may include instructions to examine this code and take appropriate actions.

Setting the Step Completion Code
When using the program interface, the system will not automatically set a
step completion code. You must code your application so that it evaluates
the return code field and passes the ACR-Return-code to the IBM Returncode register as appropriate.

Compiling and Linking the Program.
Use the High Level Assembler and Linkage Editor (BINDER) to compile
and link the program.
Proceed to “Executing the Program” on page 430, below.
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Executing the Program
When the application program is executed, it executes the call to the
program interface module specified within the application program.
The application program can call either 1) UAC200PI, which invokes the
ACR/Summary UAC2000 file interface program, using the UAC2FILE
copybook, or 2) UAC1000, which invokes balancing directly, using the
appropriate copybook (ACRAREA or ACRXAREA).
After balancing is completed, control returns to the application program,
which can proceed with further processing.
To support the execution of program interface balancing, the ACR/
Summary files must be allocated using DD statements or a combination of
dynamic allocation through the user options file and user program file
allocation. Use either of the following methods as appropriate:

 Allocating ACR/Summary files using DD statements:
Edit the application program JCL to add the ACR/Summary DD
statements. See “ACR/Summary DD Statements” on page 364 for
more information.

 Combination of dynamic allocation and user program files:
 In the user options file, specify all the dynamic allocations for
definition files, history files, SYSOUT, and all report files. See
“Dynamic Allocation of Files” on page 118 for more information.

 In the UNICNTL user exit, add the control file name.
 In the UNIUOPT user exit, add the user options file name.
The UAC1000 JCL is shown on the following page.
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UAC1000 (Program Interface Mode) JCL
//**********************************************************************
//** JCL TO EXECUTE APPLICATION PROGRAM IN PROGRAM INTERFACE MODE
**
//**
(UAC1000)
**
//**********************************************************************
//ACRSTEP EXEC PGM=APPLPGM
//STEPLIB DD DSN=APPL.LOADLIB,DISP=SHR
//
DD DSN=XXXXXXXX.UNI.TAPESHIP.LOADLIB,DISP=SHR
//APPLFIL1 DD DSN=SAMPLE.APPL.FILE1,DISP=SHR
//APPLFIL2 DD DSN=SAMPLE.APPL.FILE2,DISP=SHR
//UNICF
DD DSN=XXXXXXXX.UNI.UNICF,DISP=SHR
//UNIUF
DD DSN=XXXXXXX.UNI.UOPT,DISP=SHR
//SYSUDUMP DD SYSOUT=*
//SYSDBOUT DD SYSOUT=*
//SYSOUT
DD SYSOUT=*
//UNIDF
DD DSN=XXXXXXXX.UACR.DEFN,DISP=SHR
//UNIHF
DD DSN=XXXXXXXX.UACR.HIST,DISP=SHR
//UNIACR
DD SYSOUT=*,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNIACR2 DD SYSOUT=*,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNIACR3 DD SYSOUT=*,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNIACR4 DD SYSOUT=*,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNIEXTR DD DSN=&&UNIEXTR,
//
DISP=(MOD,PASS),
//
UNIT=SYSDA,
//
SPACE=(TRK,(10,10),RLSE),
//
DCB=(RECFM=FB,LRECL=132,BLKSIZE=1320)
//UNIWXML DD DSN=&&SUMWXML,
//
DISP=(NEW,DELETE),
//
UNIT=SYSALLDA,
//
SPACE=(TRK,(10,10),RLSE),
//UNICRXML DD DSN=&&SUMCRXML,
//
DISP=(NEW,DELETE),
//
UNIT=SYSALLDA,
//
SPACE=(TRK,(10,10),RLSE),
//
DCB=(RECFM=FB,LRECL=2000,BLKSIZE=0)
//UNIFRXML DD DSN=&&SUMFRXML,
//
DCB=(RECFM=FB,LRECL=2000,BLKSIZE=0),
//
DISP=(NEW,DELETE),
//
UNIT=SYSALLDA,
//
SPACE=(TRK,(10,10),RLSE)
//UNIUFR
DD SYSOUT=*,
//
DCB=(RECFM=VBA,LRECL=255)
//UNIRCR
DD SYSOUT=&OUT,
//
DCB=(RECFM=FBA,LRECL=80,BLKSIZE=80)
//UNIUSR
DD SYSOUT=*,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNISSR2 DD SYSOUT=&OUT,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
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Balancing in Spool Monitor Mode
This chapter discusses the spool monitor application interface mode. It
contains the following sections:







“Understanding Spool Monitor Mode” on page 433
“Executing Spool Monitor” on page 434
“Control Parameters” on page 434
“Creating the Spool Monitor (ACRSPMF) Control Record” on page 436
“Creating the SUM2000 JCL” on page 437

Understanding Spool Monitor Mode
Spool monitor is a front-end facility that provides the ability to search the
JES2 spool for selected outputs to use in future balancing steps.
Note:

To use spool monitor, your loadlib must be APF authorized.

How Spool Monitor Works
When application jobs are executed, output is normally placed in the sysout
class specified in the JCL where it is then picked up by report distribution
packages. The outputs are stored on the spool volume by the job entry
subsystem (JES2) of the operating system. A sample allocation would be:
//UNIACR

DD SYSOUT=A

which routes the output that is associated with the UNIACR DD into output
class A.
To utilize the spool monitor facility, a user would submit the spool monitor
JCL. This starts a job that will run until cancelled by the operator. At userspecified intervals, ACRSPMF (this is the program name for spool monitor)
performs the following:

 Spool monitor (ACRSPMF) monitors a specified dedicated sysout class
queue for job output as specified through definitions. If no output is
found, the ACRSPMF program will wait until the next timing interval.

 If job output is found, ACRSPMF dynamically creates a sequential
dataset containing the output data found on the spool.
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 ACRSPMF then searches a user-defined library for a member with the
same name as the application job name for the output that was found.
If this is found, ACRSPMF submits a file interface job (UAC2000) using
the spooled dataset as input.

 Optionally, ACRSPMF then requeues the original JES2 output listing to
a new output class specified in ACRSPMF. Otherwise the output report
is purged.

 Logs a trace of activity to a trace file.
The above bulleted items are repeated until an operator cancels the task.

Executing Spool Monitor
To run spool monitor, complete the following tasks:
1. Generate the spool monitor control record, ACRSPMF. This record

indicates which sysout class to scan and what to do with the data once
it is found. For more information, see “Creating the Spool Monitor
(ACRSPMF) Control Record” on page 436.
2. Create job and file definitions for the data being balanced.
3. Create the SUM2000 JCL. For more information, see “Creating the

SUM2000 JCL” on page 437 below.
4. Generate the spool monitor (ACRSPMF) JCL and place the JCL in a

JES2-accessible PROCLIB. The library contains the dataset to which
the ACRJLIB points.
5. Submit the ACRSPMF JCL, which will then wait for the appropriate

output to appear in the queue.

Control Parameters
ACRSPMC is a sequential dataset containing one record. This record is
required and should be setup at installation by a system programmer
through the user interface.

434

Infogix, Inc.

Balancing in Spool Monitor Mode  13
Control Parameters

ACRSPMC Record Layout
Fld

Description

Pos

Length

Format

Value

1

Reserved

1-8

8

X(8)

ACRSPMF

2

Reserved

9

1

X(1)

Blanks

3

DSN Prefix

10-17

8

X(8)

4

Reserved

18

1

X(1)

5

Sysout Class

19

1

X(1)

6

Reserved

20

1

X(1)

7

Requeue Class

21

1

X(1)

8

Reserved

22

1

X(1)

9

Output Unit Type

23-30

8

X(8)

10

Reserved

31

1

X(1)

11

Output Volser

32-37

6

X(6)

12

Reserved

38

1

X(1)

Blanks

13

Wait Time

39-42

4

9(4)

1 - 9999

14

Reserved

43

1

X(1)

Blanks

15

Space Allocation

44-47

4

9(4)

0 - 9999

16

Reserved

48

1

X(1)

Blanks

17

Retention Period

49-52

4

9(4)

0 - 9999

18

Reserved

53

1

X(1)

Blanks

19

Destination ID

54-61

8

X(8)

20

Reserved

62

1

X(1)

Blanks

21

Route Code

63-64

2

X(2)

01 - 16

22

Reserved

65-80

16

X(16)

Blanks

ACR/Summary User Guide for z/OS

Blanks

Blanks

Blanks

Blanks

435

13  Balancing in Spool Monitor Mode
Creating the Spool Monitor (ACRSPMF) Control Record

Creating the Spool Monitor (ACRSPMF) Control
Record
The Control record is stored in the Spool Monitor Parm File under
DDNAME ACRSPMC, which is created during the Initial Setup process.
Follow the procedure below to create the spool monitor control record.
Select Setup > Spool monitor to display the Spool Monitor Parameters
panel.
Spool Monitor Parameters
Input information:
Prefix name for allocated datasets: ________
Sysout class: . . . . . . . . . . . _
Output information:
Requeue class: _
Wait time before checking JES for work: ____ (1 TO 9999 seconds)
Output volume: ______ Output unit type: ________
Destination ID of output class: ________
Sequential dataset space allocation: ____
Sequential dataset retention period: ____

(0 TO 9999 tracks)
(0 TO 9999 days)

Routing code for WTO console messages: __

(1 TO 16, blank)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Input information:
Prefix name for allocated datasets. An alphabetic character followed
by up to eight alphanumeric characters. All datasets created by the spool
monitor facility, ACRSPMF, will be dynamically allocated with this highlevel prefix.
Sysout class. Output class identifier (A-Z, 0-9). Select a held class if a
Requeue class is specified below. We recommend that this class be
devoted to Infogix products.
Output information:
Requeue class. Optional. If specified, this parameter will be the output
class to which the spool monitor facility will requeue the JES2 files upon
completion of processing. Often users will queue the data to an Infogix
reserved class and then requeue to the normal output class after balancing
has completed.
Wait time... Number of seconds to wait.

436

Infogix, Inc.

Balancing in Spool Monitor Mode  13
Creating the SUM2000 JCL

Output Volume. Volume serial number to which the sequential datasets
created by ACRSPMF will be written.
Output unit type. Unit name where the sequential datasets created by
ACRSPMF will be stored for JES2.
Destination ID of output class. Destination ID of the output class that
ACRSPMF will request from JES2 to use as input. Valid values for JES2 are
LOCAL or ANYLOCAL.
Sequential dataset space allocation. Space allocation, in tracks (09999) for the sequential datasets created by the spool monitor facility,
ACRSPMF.
Sequential dataset retention period. Retention period, in days (09999) for the sequential datasets created by the spool monitor facility.
Routing code for WTO console messages. Applies to all write to
operator messages issued by the spool monitor. If blank, defaults to the
system specified default for messages.
When you accept your entries, the ACR/Summary Job Window displays
with this message:
Option(s) replaced

For the layout of the completed record, see “ACRSPMC Record Layout” on
page 435.

Creating the SUM2000 JCL
Because the spool monitor is a front-end facility that executes the file
interface facility, you need to create the SUM2000 JCL. This JCL resides in
the library you specified in the ACRJLIB DD statement in the spool monitor
JCL.

ACRJLIB Dataset
ACRJLIB is allocated as a partitioned dataset (LRECL = 80, RECFM = FB).
Each member of ACRJLIB contains the JCL for executing the ACR/
Summary file interface program (UAC2000) for a particular application
job. Besides the statements required for any SUM2000 job, this JCL will
contain as many additional DD statements as there are user files to process.
Although most of these DD statements will identify normal sequential
datasets (such as report files), one DD statement is reserved for use by the
spool monitor program. The spool monitor program will modify this DD
statement to point to the output sequential file containing the copied JES2
spool output.
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After the spool monitor processes an output class (i.e. copies it to a
sequential dataset), it searches for the corresponding JCL. The JCL for this
job is obtained from a partitioned dataset (PDS) referred to by the
DDNAME ACRJLIB in the spool monitor JCL. The spool monitor will
search ACRJLIB's directory for a member with the same name as the job it
is currently processing. The JCL will then be copied, edited to supply the
DSN (dataset name) of the copied JES2 output, and submitted to the JES2
internal reader.
//************************************************************
//*
*
//* JCL STATEMENTS TO PROCESS SPOOL MONITOR DATASETS
*
//*
*
//************************************************************
//*
//UAC2000 PROC OUT=,
OUTPUT CLASS
//
UACPARM=,
UACDEFN DSN
//
UACDEFN=,
UACDEFN DSN
//
UACHIST=
UACHIST DSN
//ACRSTEP EXEC PGM=UAC2000,PARM='&UACPARM'
//*
//STEPLIB DD DSN='UACR.LOADLIB',DISP=SHR
//UNICF
DD DSN='UACR.ACRCNTL',DISP=SHR
//UNIUF
DD DSN='UACR.ACRUOPT',DISP=SHR
//SYSUDUMP DD SYSOUT=&OUT
//SYSDBOUT DD SYSOUT=&OUT
//SYSOUT
DD SYSOUT=&OUT
//UNIDF
DD DSN=&UACDEFN,DISP=SHR
//UNIHF
DD DSN=&UACHIST,DISP=SHR
//UNIACR
DD SYSOUT=&OUT,
//
DCB=(RECFM=FBA,LRECL=133,BLKSIZE=133)
//UNIRCR
DD SYSOUT=&OUT,
//
DCB=(RECFM=FBA,LRECL=80,BLKSIZE=80)
//
PEND
//ACRSTEP EXEC UAC2000,
//
OUT='*',
//
UACPARM='JNAM=XXXXXXXX,STEP=XXXXXXXX,CYC#=00000001',
//
UACDEFN='UACR.DEFN',
//
UACHIST='UACR.HIST'
*/REPORT
DD
//
DISP=SHR

ACRJLIB DD Statement
If a member matching the job name is found, the spool monitor will edit the
JCL to insert the name of the newly created sequential dataset in the JCL.
The spool monitor will scan the JCL looking for a particular DD statement
to modify. To indicate to spool monitor the correct JCL statement to use,
the following rules must be observed:
1. There must be an asterisk in column 1.
2. The DDNAME must appear in columns 3 through 10.
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3. The letters ‘DD' must appear in columns 12-13.
Sample DD statement in ACRJLIB member:

*/REPORT

DD

Sample DD Statement after ACRSPMF modification:

//REPORT

Note:

DD DSN=UACR.JOBA.D88207.T1812000,

For information on how to create spool monitor JCL, see Spool Monitor
JCL Panel on page 380.

Output Sequential Datasets
Each time ACRSPMF finds selected output for a job, it dynamically
allocates a unique dataset. The name of this dataset (DSN) has the following
format:
Prefix.Jobname.Dyyddd.Thhmmsss
Where:

 Prefix: Dataset prefix is taken from Field “3” in the ACRSPMC
parameter record.

 Jobname: Is the name of the job whose syout class is being processed.
 Dyyddd: “D” followed by the current Julian date.
 Thhmmsss: “T” followed by the current time in hours, minutes,
seconds, and tenths of seconds.
The generated dataset is cataloged, and its DSN will be inserted
automatically in the JCL of the corresponding ACRJLIB member.
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14
Using the History Analysis
Function
This chapter discusses history analysis, a feature you can use to analyze and
report on selected history data to identify trends in your balancing
processes.
This chapter contains the following sections:











“Report Types” on page 441
“Opening the History Analysis Window” on page 442
“Entering Basic Analysis Information” on page 443
“Setting Up Columns” on page 446
“Setting Up Rows” on page 453
“Setting Up Rules” on page 461
“Setting Up a Legend” on page 464
“Generating the Report” on page 465
“History Analysis Report Samples” on page 465

Report Types
When you start your report by completing the basic analysis information,
you can specify one of the following report types:
1. Job IDs. If you specify the horizontal axis as job IDs, the vertical axis

will contain internal item values for the run cycles you specify. This
format will let you analyze internal items across jobs.
2. Relative cycles. If you specify the horizontal axis as relative cycles, the

vertical axis will contain internal item values for the specified job IDs.
This format enables you to analyze trends in internal items over a
period of time.
3.

Internal items. If you specify the horizontal axis as internal items, the
vertical axis will contain internal item values for the job IDs and run
cycles you specify. This format allows you to display and analyze
different internal items for the same job.
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Opening the History Analysis Window
From the Job Window, select Window > History Analysis to display the
History Analysis Window. Press F8 to see all of the information.
File Edit Help
-----------------------------------------------------------------------History Analysis Window
Row 1 from 19

_
A. Basic Analysis Information
_
Basic Report Information:
_
Title:
_
Contents:
_
Columns/page:
_
Run Options:
_
Set Return Code:
No
_
Truncate/Round Results:
Truncate
_
Cycle Table Name:
_
Cycle Reference ID:
_
Variable Cycle Reference ID:
_
B. Columns: 000
_
< NEW... >
_
C. Rows: 000
_
< NEW... >
_
D. Rules: 000
_
< NEW... >
_
E. Legend: 000
_
< NEW... >
***************************** BOTTOM OF DATA*****************************
Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

The sections of the window are as follows:
A. Basic analysis information. This includes the basic report information
and the run options for all of the history records to process. See “Entering
Basic Analysis Information” on page 443.
B. Columns. This section defines the horizontal axis of the report. See
“Setting Up Columns” on page 446.
C. Rows. This section defines the vertical axis of the report. See “Setting Up
Rows” on page 453.
D. Rules. This section defines how to analyze the data. See “Setting Up
Rules” on page 461.
E. Legend. This section allows you to include an Explanation of Codes
section on the last page of the report. This section will list and describe the
exception code for each rule you defined. See “Setting Up a Legend” on
page 464.
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You can complete the information in the order it is presented on the
Window, and the corresponding screen will be displayed.
Note:

The indented information (Title, Contents, Columns/page, Set
Return Code, Truncate/Round Results, and so on) will be filled in
for you when you select Basic Report Information and Run
Options, respectively, and complete the corresponding screens.

Entering Basic Analysis Information
Report Information Panel
Report Information
History analysis ID: ________________
Enter a title for the analysis report:
________________________________________
Last update by:
Date:
Specify the contents of the horizontal axis:
__ 1. Job IDs
2. Relative cycles
3. Internal items

Time:

Indicate the number of columns:
__ 1. Four
2. Six
3. Eight
4. Twelve
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

History Analysis ID. Enter a unique, descriptive ID for this set of history
analysis definitions. If you want the history analysis report to be generated
when you run a particular balancing job, make your history analysis ID the
same as the ID of that balancing job.
Enter a title for the analysis report. Enter a descriptive title,
Last update by/Date/Time. This displays the ID associated with the
most recent update to this set of definitions, along with the date and time of
the update.
Specify the contents of the horizontal axis. Valid options:
1. Job IDs. The horizontal axis will contain job IDs. Relative cycles and

internal items will appear in the vertical axis.
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2. Relative cycles. The horizontal axis will contain relative cycles. Job ID’s

and internal items will appear in the vertical axis.
3. Internal items. The horizontal axis will contain internal items. Job ID’s

and relative cycles will appear in the vertical axis.
Indicate the number of columns. Indicate the number of columns that
will be printed on the History Analysis report. Keep the following in mind:

 If you choose 6 or more columns and your field sizes exceed 11 positions
for 6 columns, 8 positions for 8 columns, or 7 positions for 12 columns,
the values will not be printed. An overflow message will be displayed.

 If you define 12 columns, the Description column will not print due to
space limitations. To print this column, select 8 instead of 12. All
columns, including the Description column, will print. Columns that do
not fit on the page will print on a separate page.
Note:

When you complete the screen and exit, the indented
information under Basic Report Information will be filled in on the
History Analysis Window.

Run Options
If you select Run options, the Run Options panel will be displayed.
Run Options
Select options to access:
_ Set return code...
_ Truncate/round results...
_ Cycle table information...
_ Cycle reference information...
_ Variable cycle reference...

F1=Help

F2=Split

F3=Exit

F9=Swap

You can select multiple options at once. The corresponding screens will be
displayed based on your selections. The screens will not be shown here
because they consist of only one field or a set of related fields.

Set Return Code
Set a step completion code if one or more rules not satisfied?
Indicate whether you want to set a return code. Later in this chapter, when
you specify the rules, you will specify the return code to set.
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Truncate/round Results
Select a truncation/rounding option. Indicate how the results
produced by calculated items should be displayed.
Round results rounds the number to the nearest 1.0. For example, if the
number is 415.67, the system rounds the number to 416.
Truncate results truncates the number at the specified number of decimals.
For example, if the number is 415.67 and you specify 0 decimals, the system
truncates the number to 415.)

Cycle Table Information
Enter a table name. Optionally identify the name of a cycle table that will
be used to validate the cycles extracted from the history database. If a match
is not found on this table, the history record will not be included in the
analysis. You must set up the cycle table before the history analysis
document is created. See “Setting Up Cycle Tables” on page 732.

Cycle Reference Information
Enter cycle reference job ID (Job name, Step name, Qualifier).
These fields are not applicable if you are generating the history analysis
directly from balancing (see “Generating the Report” on page 465), because
the analysis will use the same cycle ID as that of the job. However, if you are
generating the analysis independently, you can pass the cycle number in
through a JCL parm or you can specify a cycle reference job ID in this field.
When you do this, the cycle ID of the history analysis run (both the cycle
number and the run number) will be set to be the same as that of the most
recent run of the specified reference job.

Variable Cycle Reference
Enter variable cycle job ID (Job name, Step name, Qualifier).
These fields are applicable only to relative cycle history analysis reports.
The variable cycle ID identifies the job ID whose cycle ID determines
whether control values will be extracted for analysis. Items whose cycle ID
is greater than the variable cycle reference job ID, will be extracted if option
3 is selected for the Print the Column Value field on the Detail Column
panel. See “Second Detail Column Panel” on page 447.
Note:

When you complete the Run Options and exit, the indented
information under Run Options will be filled in on the History
Analysis Window.
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Setting Up Columns
A history analysis report may have up to 100 columns, although a
maximum of 12 columns can be printed. A column can be either a detail
column or a summary column.

 A detail column contains values taken directly from the history
database. Detail columns need to be defined before summary columns.

 A summary column contains values resulting from performing
computations on the values in other columns.
Information in any column may be printed or suppressed. If printing is
suppressed, the values in the column are still available for calculations.
The fields that display when setting up columns will vary depending on the
type of report selected in Basic Analysis Information.

Setting Up Detail Columns
First Detail Column Panel
Under the Columns section of the History Analysis Window, select New >
Detail. The (First) Detail Column Panel panel displays.
Detail Column
Column number:
001
Print in column: ___

Enter column
Line 1: . .
Line 2: . .
Line 3: . .

heading text:
. . __________________
. . __________________
. . __________________

Print the column headings?
1
1. Yes
2. No
3. Print the cycle date that corresponds to the column
Specify
1_ 1.
2.
3.
4.

how to print the heading:
Center
Left justify
Right justify
Print as entered

F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Column number. Defaults to the next available column number.
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Print in column. A number (1 to 100) indicating the printing order for the
column. For example, if you wanted to print this column third, enter 3.
Leave this field blank if you want the column to print in the order indicated
by the Column number field.
Enter column heading text. Enter a descriptive title for the column. The
length of the column heading depends on how many columns you specified
to print per page:
Columns
Per Page

Column Heading Length

4

18 positions per line

6

11 positions per line

8

8 positions per line

12

7 positions per line

Print the column headings. The system displays this field only for a
relative cycle report. Choose an option:
1. Yes. Print the column heading as entered above.
2. No. Leave the column heading blank.
3. Print the cycle date that corresponds to the column.

Specify how to print the heading. Specify a justification option for the
heading.

Second Detail Column Panel
The fields displayed on the second Detail Column panel depend on your
selection in the Specify the contents of the horizontal axis field on
the Report Information panel. The available options are Job IDs, Relative
cycles, and Internal items. See “Report Information Panel” on page 443.
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Detail Column - Job ID
The system displays the following screen for a job ID report.
Detail Column
Retrieve values from job ID:
Job name:
Step name:
Qualifier:
Print the column values?
1
1. Yes
2. No
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Retrieve values from job ID. If you are creating a job ID report, enter
the job ID from which to retrieve values. Only information for this job ID
will display in this column.
Print the column values? Valid options:
1. Yes. Print the column values.
2. No. Suppress printing of the column values. The values in the column

will still be available for calculations.
Detail Column - Relative Cycle
The system displays the following screen for a relative cycle report.
Detail Column
Relative cycle: +000

(-999 to +000)

If an exact cycle match not found?
1
1. An exact match is required
2. Search backward in cycle table for next valid entry
3. Search forward in cycle table for next valid entry
Print the column values?
1
1. Yes
2. No
3. Only if the cycle ID is > than the ID of the variable
cycle job

F1=Help
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Relative cycle. If you are creating a relative cycle report, enter a value (999 to +000) to indicate the relative cycle (relative to the most recent cycle)
for which information will display in this column. The most recent cycle is
represented by +000, the previous cycle is -001, and so on.
If an exact cycle match not found? If you are creating a relative cycle
report, specify what to do if an exact cycle match is not found.
1. An exact match is required. The system will bring in cycles from

history that have a corresponding entry in the specified cycle table.
2. Search backward in cycle table for next valid entry. The system will

search backward in the cycle table until it finds a match between a
cycle table entry and a history record.
3. Search forward in the cycle table for next valid entry. The system will

search forward in the cycle table until it finds a match between a cycle
table entry and a history record.
Print the column values? Valid options:
1. Yes. Print the column values.
2. No. Suppress printing of the column values. The values in the column

will still be available for calculations.
3. Only if the cycle ID is > than the ID of the variable cycle job. This

option only appears if you are creating a relative cycle report. The
variable cycle is the one you specified in the run options.
Detail Column - Internal Item
The system displays the following screen for an internal item report.
Detail Column
Retrieve values from internal item number:
Print the column values?
1
1. Yes
2. No

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Retrieve values from internal item number. If you are creating an
internal item report, enter the internal item number (1-100) for which
information will be displayed in this column.
Print the column values? Valid options:
1. Yes. Print the column values.
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2. No. Suppress printing of the column values. The values in the column

will still be available for calculations.

Setting Up Summary Columns
Summary columns contain values resulting from computations performed
on the values in other columns (for example, a summary column could be
an average of the values of several other columns). The other columns can
be detail columns or other summary columns.

First Summary Column Panel
Under the Columns section of the History Analysis Window, select New >
Summary. The system displays the Summary Column panel.
Summary Column
Column number:
001
Print in column: ___

Enter column
Line 1: . .
Line 2: . .
Line 3: . .
Specify
1_ 1.
2.
3.
4.

heading text:
. . __________________
. . __________________
. . __________________

how to print the heading:
Center
Left justify
Right justify
Print as entered

F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Column number. Defaults to the next available column number.
Print in column. A number (1 to 100) indicating the printing order for the
column. For example, if you wanted to print this column third, enter 3.
Leave this field blank if you want the column to print in the order indicated
by the Column number field.

450

Infogix, Inc.

Using the History Analysis Function  14
Setting Up Columns

Enter column heading text. Enter a descriptive title for the column. The
length of the column heading depends on how many columns you specified
to print per page:
Columns
Per Page

Column Heading Length

4

18 positions per line

6

11 positions per line

8

8 positions per line

12

7 positions per line

Specify how to print the heading. Specify a justification option for the
heading.

Second Summary Column Panel
Summary Column
Specify a computation range:
Begin in column: ___
End in column:
___
Select a computation to perform across range:
__ 1. Total
2. Difference
3. Product
4. Division
5. Maximum
6. Minimum
7. Range
8. Average
9. Percentage
10. Variance
11. Standard deviation
12. Variance (non-Biased)
13. Standard deviation (non-Biased)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify a computation range:
Begin in column. The beginning number of the range for computations.
For example, if you wanted to compute the total of columns 1 - 4 in column
5, you would enter 1.
End in column. The ending number of the range for computations.
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Select a computation to perform across range. The column you are
currently creating will contain the results of the computation. Options:
1. Total. The sum of all columns in the range.
2. Difference. The difference between the beginning column of the range

and the ending column.
3. Product. The product of the beginning column of the range times the

ending column.
4. Division. The result of the beginning column of the range divided by

the ending column.
5. Maximum. The value of the largest column in the range.
6. Minimum. The value of the smallest of any column in the range.
7. Range. The maximum value minus the minimum value.
8. Average. The average of all columns, beginning column to ending

column.
9. Percentage. The result of the beginning column of the range divided by

the ending column times 100.
10. Variance. The average of the squares of the difference of all columns

from the mean.
11. Standard deviation. The square root of the variance.
12. Variance (non-Biased). The average of the squares of the difference of

all columns from the mean of a sample of the entire population of
values.
13. Standard deviation (non-Biased). The square root of the variance of a

sample of the entire population of values.
Note:
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Third Summary Column Panel
Summary Column
Will the value of the intersection of a row
and column be calculated as part of the
column? . . . . . . . . . . . . . . . . . . . _
Print the column values?

_

(Y/N)

(Y/N)

Number of decimals: . . . _

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Will the value of the intersection of a row and column be
calculated as part of the column? Options:
Y. The value of the intersection of the row and column will be the value
calculated as part of the column.
N. The value of the intersection of the row and column will be the value
calculated as part of the row.
Print the column values? Options:
Y. Print the column values.
N. Suppress printing of the column values. The values in the column are
still available for calculations.
How this indicator is set can affect certain combinations of row and column
summaries significantly. For example, the intersection of a SUM type
summary row and a PCT type summary column will have significantly
different values, depending upon the setting of this indicator.
Number of decimals. The number of decimal places for the data being
analyzed.

Setting Up Rows
A history analysis report may have up to 100 rows. A row can be one of the
following types.

 A detail row contains values taken directly from the history database.
Detail rows need to be defined before summary rows. For instructions,
see “Setting Up Detail Rows” on page 454.

 A summary row contains values resulting from performing
computations on the values in other rows. For instructions, see “Setting
Up Summary Rows” on page 458.
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 A format row allows you to print a character symbol in every column of
the row to improve readability.
The fields that display when setting up rows will vary depending on the type
of report selected in Basic Analysis Information. For instructions, see
“Setting Up Format Rows” on page 460.

Setting Up Detail Rows
First Detail Row Panel
Under the rows section of the History Analysis Window, select New >
Detail. The system displays the Detail row panel.
Detail Row
Row number: 001
Enter row description:
________________________________________
Print row description?
1 1. Yes
2. No
3. Print the cycle date that corresponds to the row
Select a heading print option:
1 1. Center
2. Left justify
3. Right justify
4. Print as entered
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Row number. Defaults to the next available number.
Enter row description. The description of the contents of the row.
Print row description. This field displays only if you are printing a Job
ID or Internal item report. Options:
1. Yes. (Default) to print the row description text.
2. No. Suppress the row description text.
3. Print the cycle date that corresponds to the row as the row description.

Select a heading print option. Specify a justification option.
When you press F5, one of the following will be displayed:

 For a job ID report, the system displays the second Detail Row panel on
page 455.
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 For a relative cycle report, the system displays the second Detail Row
panel on page 456.

 For an internal item report, the system displays the second Detail Row
panel on page 457.

Second Detail Row Panel
The fields displayed on the second Detail Row panel depend on your
selection in the Specify the contents of the horizontal axis field on
the Report Information panel. The available options are Job IDs, Relative
cycles, and Internal items. See “Report Information Panel” on page 443.
Detail Row - Job ID
The system displays the following screen for a job ID report.
Detail Row
Retrieve values from relative cycle: 00
If an exact cycle match not found:
1
1. An exact match is required
2. Search backward in the cycle table for the next valid
entry
3. Search forward in the cycle table for the next valid
entry
Retrieve values from internal item number:
Print the row values?
1
1. Yes
2. No
3. Only if the cycle ID is > than the ID of the variable
cycle job

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Retrieve values from relative cycle. Enter a value (-999 to +000) to
indicate the relative cycle (relative to the most recent cycle) for which
information will display in this row. The most recent cycle is represented by
+000, the previous cycle is -001, and so on.
If an exact cycle match not found. Specify the processing that should
take place if an exact cycle match is not found.
1. An exact match is required. The system will bring in cycles from

history that have a corresponding entry in the specified cycle table.
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2. Search backward in cycle table for next valid entry. The system will

search backward in the cycle table until it finds a match between a
cycle table entry and a history record.
3. Search forward in the cycle table for next valid entry. The system will

search forward in the cycle table until it finds a match between a cycle
table entry and a history record.
Retrieve values from internal item number. The internal item
number that contains the value needed.
Print the row values? Valid options:
1. Yes. Print the row values.
2. No. Suppress printing of the row values. The values in the row will still

be available for calculations.
3. Print the row values only if the cycle ID is greater than the ID of the

variable cycle job. The variable cycle is the one you specified in the run
options.
Detail Row - Relative Cycles
The system displays the following screen for a relative cycles report.
Detail Row
Retrieve values from job ID:
Job name:
Step name:
Qualifier:
Retrieve values from internal item number:
Print the row values?
1
1. Yes
2. No

F1=Help
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Retrieve values from job ID. Specify the job that contains the values to
use in the report in the Job name, Step name, and Qualifier fields.
Retrieve values from internal item number. The internal item
number that contains the value needed.
Print the row values? Valid options:
1. Yes. Print the row values.
2. No. Suppress printing of the row values. The values in the row will still

be available for calculations.
Detail Row - Internal Items
The system displays the following screen for an internal items report.
Detail Row
Retrieve values from job ID:
Job name:
Step name:
Qualifier:
Retrieve values from relative cycle:
If an exact cycle match not found:
1
1. An exact match is required
2. Search backward in the cycle table for the next valid
entry
3. Search forward in the cycle table for the next valid
entry
Print the row values?
1
1. Yes
2. No
3. Only if the cycle ID is > than the ID of the variable
cycle job

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Retrieve values from job ID. Specify the job that contains the values to
use in the report in the Job name, Step name, and Qualifier fields.
Retrieve values from relative cycle. Enter a value (-999 to +000) to
indicate the relative cycle (relative to the most recent cycle) for which
information will display in this row. The most recent cycle is represented by
+000, the previous cycle is -001, and so on.
If an exact cycle match not found. Specify the processing that should
take place if an exact cycle match is not found.
1. An exact match is required. The system will bring in cycles from

history that have a corresponding entry in the specified cycle table.
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2. Search backward in cycle table for next valid entry. The system will

search backward in the cycle table until it finds a match between a
cycle table entry and a history record.
3. Search forward in the cycle table for next valid entry. The system will

search forward in the cycle table until it finds a match between a cycle
table entry and a history record.
Print the row values? Valid options:
1. Yes. Print the row values.
2. No. Suppress printing of the row values. The values in the row will still

be available for calculations.
3. Print the row values only if the cycle ID is greater than the ID of the

variable cycle job. The variable cycle is the one you specified in the run
options.

Setting Up Summary Rows
Summary rows contain values resulting from computations performed on
the values in other rows (for example, a summary row could be an average
of the values of several other rows).

First Summary Row Panel
Under the Rows section of the History Analysis Window, select New >
Summary. The system displays the (First) Summary Row panel.
Summary Row
Row number: 001
Enter row description:
________________________________________
Specify
1_ 1.
2.
3.
4.

a row print option:
Center
Left justify
Right justify
Print as entered

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Row number. Defaults to the next available number.
Enter row description. The description of the contents of the row.
Specify how to print the heading. Specify a justification option.
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Second Summary Row Panel
Summary Row
Specify a computation range:
Begin in row:
___
End in row: . . ___
Select a computation to perform across range:
__ 1. Total
2. Difference
3. Product
4. Division
5. Maximum
6. Minimum
7. Range
8. Average
9. Percentage
10. Variance
11. Standard deviation
12. Variance (non-Biased)
13. Standard deviation (non-Biased)
Print the row values? _
F1=Help
F2=Split

(Y/N)
F3=Exit

Number of decimals: _
F5=Accept
F9=Swap

Specify a computation range:
Begin in row. The number of the beginning row of the range for
computations. For example, if you wanted to compute the total of rows 1 4 in row 5, you would enter 1.
End in row. The number of the ending row of the range for computations.
Select a computation to perform across range. Options:
1. Total. The sum of all rows in the range.
2. Difference. The difference between the beginning row of the range and

the ending row.
3. Product. The product of the beginning row of the range times the

ending row.
4. Division. The result of the beginning row of the range divided by the

ending row.
5. Maximum. The value of the largest row in the range.
6. Minimum. The value of the smallest of any row in the range.
7. Range. The maximum value minus the minimum value.
8. Average. The average of all rows, beginning row to ending row.
9. Percentage. The result of the beginning row of the range divided by the

ending row times 100.
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10. Variance. The average of the squares of the difference of all rows from

the mean.
11. Standard deviation. The square root of the variance.
12. Variance (non-Biased). The average of the squares of the difference of

all rows from the mean of a sample of the entire population of values.
13. Standard deviation (non-Biased). The square root of the variance of a

sample of the entire population of values.
Note:

See Appendix C, “Non-Biased Variance and Standard Deviation
Computations on page 745” for more information on using Variance
(non-Biased) and Standard deviation (non-Biased) computations.

Setting Up Format Rows
Format rows allow you to print a character symbol in every column of the
row to improve readability. For example, you can use format rows to add
blank lines, supply section separators, or underline columns being totalled.
Under the Rows section of the History Analysis Window, select New >
Format. The system displays the Format Row panel
Format Row
Row number: 001
Enter row description:
________________________________________
Specify
1_ 1.
2.
3.
4.

a row print option:
Center
Left justify
Right justify
Print as entered

Format character: _
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Row number. Defaults to the next available number.
Enter row description. The description of the contents of the row.
Specify a row print option. Specify a justification option for the row.
Format character. The character that should print in every column of the
row. Leave blank to print a blank line.
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Setting Up Rules
(First) Rules Window
In the Rules section of the History Analysis Window, select New. The
Rules panel displays. Rules are used to compare values in the analysis
window with values in the analysis base:

 The analysis base is the column or row to be used as the basis for
comparison.

 The analysis window is made up of the rows and columns to be
compared against the analysis base.
For example, suppose your rule specifies that the information in column 1
(the analysis base) should be compared to the values in columns 2 - 4 and
rows 1 - 4 (the analysis window) to determine if the values are equal. The
analysis function will check the value of column 1, row 1 to see if it is equal
to column 2, row 1, column 3, row 1, and column 4, row 1. Next, column 1,
row 2 will be compared against, column 2, row 2, column 3, row 2, etc. Any
values that are not equal will be reported as exceptions.
Tolerance is the amount of acceptable deviation from the value in the
analysis base.
Rules
Rule number: 001
Analysis base:
__ 1. Column
2. Row

Column/row number: ___

Analysis window:
From column: ___
From row:
___
Specify
1 1.
2.
3.
4.
5.
6.

rule
Base
Base
Base
Base
Base
Base

F1=Help

Format:
1 1. Count
2. Amount
3. Text

To column:
___
To row: . . ___

to apply:
equals window
does not equal window
is greater than window
is greater than or equal to window
is less than window
is less than or equal to window

F2=Split

F3=Exit

F5=Accept

F9=Swap

Rule number. Defaults to the next available number.
Analysis base. Specify whether a row or column will be used as the
analysis base (the basis for comparison).
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Column/Row number. Specify the column or row number (1 to 100) to
be used as the analysis base.
Format. The type of data in the analysis window.
1. Count. Display the item as a number with embedded commas and

decimals as determined by the Decimals field. If the value is negative, a
trailing minus sign (-) will print unless the default formatting for
negative values has been overridden in the user options.
2. Amount. A dollar amount with two decimal places.
3. Text. A text string

Analysis Window: Use this section to specify the rows and columns to be
compared against the analysis base.
From/To column. Column numbers (001-100) of the beginning and
ending columns of the analysis window, respectively.
From/To row. Row numbers (001-100) of the beginning and ending rows
of the analysis window, respectively.
Specify a rule to apply. Select a condition that must be met. If this
condition is not met, an exception will be reported.
1. Base equals window.
2. Base does not equal window.
3. Base is greater than window.
4. Base is greater than or equal to window.
5. Base is less than window.
6. Base is less than or equal to window.
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(Second) Rules Window
Rules
Exception code to set when rule not satisfied: _
Return code to set: 0000
Number of decimals: _
Set a tolerance?
_ (Y/N)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Exception code to set when rule not satisfied. A character that will
print next to any value in the report that is outside of the tolerance for this
rule. Avoid using arithmetic operators.
Return code to set. An optional return code to indicate that an exception
was encountered. Codes between 0050 and 3999 are recommended
because they do not duplicate system-generated codes.
Number of decimals. Number of decimals to use when printing the item.
The default is 0 for a count and 2 for an amount.
Set a tolerance? If you selected option 1 (Base equals window) or option
2 (Base does not equal window) for Specify rule to apply on the previous
panel, indicate whether you want to set a tolerance. Tolerance is the amount
of acceptable deviation from the value in the analysis base. If you select Y,
the Tolerance panel will be displayed.

Tolerance Panel
If you indicated to set a tolerance, the Tolerance panel displays.
Tolerance
Select a tolerance indicator:
__ 1. Absolute tolerance
2. Percentage tolerance
3. Do not set tolerance
Tolerance: ________

F1=Help
F9=Swap
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Select a tolerance indicator. The type of tolerance to be applied.
1. Absolute tolerance. The tolerance will indicate the maximum amount

which the value in the analysis window can deviate from the value in
the analysis base.
2. Percentage tolerance. The tolerance will indicate the maximum

percentage which the value in the analysis window can deviate from
the value in the analysis base.
3. Do not set tolerance. A tolerance will not be specified.

Tolerance. The absolute or percentage tolerance for this rule.

Setting Up a Legend
Use this section of the History Analysis Window to include an Explanation
of Codes section on the last page of the history analysis report. This section
will list and describe the exception code for each rule you defined.
From the History Analysis Window, under Legend, select New. The Legend
Information panel displays.
Legend Information
Exception
Message text
code
---------------------------------------_
________________________________________
________________________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Exception code. Type an exception code that you want to include in the
Explanation of Codes section.
Message text. Describe the exception code.
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Generating the Report
You can generate a history analysis report in one of two ways, as explained
in the following sections.

 You can generate the report when you run a particular balancing job. To
do this, on the Report Information panel, make your history analysis ID
the same as the ID of that balancing job.

 You can generate the history analysis report independently. To do this:
1. Follow the instructions in this chapter to create a set of history

analysis definitions. Save the definitions.
2. Create the history analysis JCL as described in “History Analysis

JCL Panel” on page 379. Run the JCL as described in “Creating,
Editing, and Submitting JCL” on page 370.
3. View the history analysis report. Look for the DDName UNISSR2

in your output facility.

History Analysis Report Samples
The report samples shown below identify the type of data that appears
across the horizontal axis of the report: (job IDs, relative cycles, or internal
items). The remaining types of data will appear on the vertical axis.

Job ID Format Example
Over the last five years, a large retail store has opened six new stores.
Balancing jobs have been set up for each store to report total sales, gross
profit, and profit margin on an annual basis. The results were stored in the
history database.
You use this data to create the following report, which analyzes the increase
in total sales earned per year, the percent increase in the gross profit per
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year, and the percent increase in the profit margin per year.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 17:41:10

INFOGIX, INCORPORATED
SUMMARY SPREADSHEET REPORT
REGIONAL SALES TOTALS

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION:0000087/0000115

SPREADSHEET ID=JOBID
CYCLE#=20000631 RUN#=000

ROW#
----1
2
3
4
5
6
7

DESCRIPTION
------------------------------------TOTAL SALES
GROSS PROFIT
PROFIT MARGIN
INCREASE IN TOTAL SALES
PERCENT INCREASE IN GROSS PROFIT
PERCENT INCREASE IN PROFIT MARGIN

STORE 1
TOTALS
---------$51,432.25
$71,005.00
$32,586.30
---------$ 4,500.50
12
5

STORE 2
TOTALS
---------$42,094.53
$32,028.50
$23,456.50
---------$ 1,001.25
8
6

STORE 3
TOTALS
---------$24,870.98
$23,660.57
$13,886.50
---------$
857.22
10
7

STORE 4
TOTALS
---------$63,980.12
$63,001.20
$ 5,553.10
---------$ 960.58
18
11

STORE 5
TOTALS
---------$15,665.05
$14,660.00
$ 8,438.50
---------$
980.75
12
8

STORE 6
TOTALS
---------$23,587.98
$22,669.00
$10,230.00
---------$
325.87
5
2

Relative Cycles Format
A large insurance company bills patients for services rendered by each
surgeon. A balancing job produces a monthly report that identifies
delinquent accounts with payments beyond 30, 60 and 90 day and stores
the results in history. You use the historical data to create the following
report, which analyzes the number of accounts that are delinquent beyond
30, 60 and 90 days for the last six months.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:11:15

INFOGIX, INCORPORATED
SUMMARY SPREADSHEET REPORT
DELIQUENT ACCOUNT TOTALS

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION:0000087/0000115

SPREADSHEET ID=RELCYC
CYCLE#=20000631 RUN#=000

ROW#
----1
2
3

DESCRIPTION
-------------->30 DAYS DELIQUENT
>60 DAYS DELIQUENT
>90 DAYS DELIQUENT

01/31/09
-----------215
141
80

02/28/09
-----------213
98
50

03/31/09
-----------191
157
60

04/30/09
-----------112
77
43

05/31/09
-----------95
57
32

06/30/09
-----------68
36
12

Internal Item Format
A telecommunications company provides internet hosting services for four
regions. Each region tracks the number of prospects, the type of service sold
to those prospects, and the number of prospects that did not purchase
either service. A balancing job ran last month for each region to report on
these metrics. Internal items were used to store the metrics, which were
then stored in the history database. You create the following report to
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analyze by region the number of prospects for each service, the type of
service that is most in demand, and the number of prospects that did not
purchase the service.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 06:12:32

INFOGIX, INCORPORATED
SUMMARY SPREADSHEET REPORT
HOSTING SVC REGION REPORT

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION:0000087/0000115

SPREADSHEET ID=INTITEM
CYCLE#=20080821 RUN#=000

ROW#
----1
2
3

DESCRIPTION
------------------------------------# OF PROSPECTS
MOST DEMANDED SERVICE
# OF PROSPECTS NO PURCHASE

REGION 1
---------815
T1
624
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REGION 2
---------613
DSL
415

REGION 3
---------174
WIRELESS
61

REGION 4
---------242
DSL
53
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15
Using DB2 Tables as Input
Sources
Before using the information provided in this chapter, read “Creating File
Definitions” on page 261 for an overview of input source definition. This
chapter focuses specifically on using DB2 tables as input sources.
Before you can extract data from DB2 tables, your DB2 systems
administrator must establish your DB2 environment. For more
information, see the ACR/Summary and ACR/Detail Installation Guide
for z/OS.
Note:

File definitions for DB2 tables cannot be ported across platforms.

This chapter contains the following sections:







“Completing the Input Sources Panel” on page 470
“Completing the DB2 Information Panel” on page 471
“Using the DB2 Free-Form Editor” on page 473
“Using the DB2 Extraction Method” on page 484
“Extraction Variable Codes” on page 489
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Completing the Input Sources Panel
To extract data from a DB2 table, select Input Source from the Job
Window to display the Input Sources panel. Following is an example of the
panel completed for a DB2 input source.
Input Sources
File number: 002
Comments exist: N Add/Change Comments: N
File description: NAME QUERY________
File DDNAME: EMPDD___ Qualifier: __
DSName: EMP.ESN8710_________________________________
Display the above DSName in the Extract Window? N (Y/N)
If yes, specify the range of lines to display: 00000 to

(Y/N)

00000

File organization:
4_ 1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
Is this file a model? N
Use model definitions? N

(Y/N)
(Y/N)

File DDNAME: ________
Qualifier:
__
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

File Number. Verify or change the sequentially assigned number.
Comments exist. If the indicator is Y, user-defined comments exist
regarding this input source.
Add/Change Comments. Enter Y if you want to add or change user
comments regarding this input source. The panel for comments will display
after you specify the file organization information. For more information,
see “Adding Job or File Comments” on page 177.
File Description. Complete this field.
File DDName. Enter the DDNAME. The first character must be
alphabetic. For DB2 input sources, the DDNAME is simply a way to identify
your definitions.
Qualifier. Complete if appropriate.
DSName. Leave blank.
Display the above DSName in the Extract Window. Enter N. DB2
input sources cannot be displayed.
If yes. Specify the range of lines to display.
File Organization. Select DB2.
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Is this file a model? Enter Y if this is going to be a base file for modeling.
For more information, see “Modeling Job and File Definitions” on
page 639.
Use model definitions? Enter Y if this file is going use definitions from
a base model.
File DDNAME. If this file will use model definitions enter the DDNAME
of the file whose definitions you want to use.
Qualifier. Complete if the file whose definitions you want to use has a
qualifier.
When you accept, the DB2 File Information panel will be displayed.

Completing the DB2 Information Panel
DB2 Information
Specify DB2 information:
Are you using the DB2 freeform editor?
1_ 1. Yes
2. No
Table name:
__________________
Table owner: ________
Reset extraction variables? Y (Y/N)
Display SQL in SYSOUT? N (Y/N)

F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Specify DB2 information:
Are you using the DB2 freeform editor. Select one of the following:
1. Yes. Enables you to extract the data by pasting information from an

existing SQL query. This option supports lengthy, complex queries and
table joins. If you specify this option, do not complete the Table Name
and Table Owner fields. For more information, see “Using the DB2
Free-Form Editor” on page 473.
2. No. Indicates that you will use the DB2 Extraction method. This builds

the query dynamically based on your extraction definitions. The
selection clause is limited to 40 bytes. For more information, see
“Using the DB2 Extraction Method” on page 484.
Table name. Skip if you are using the DB2 Freeform Editor. If not, enter
the name of the DB2 table from which values will be extracted.
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Table owner. Skip if you are using the Freeform Editor. Otherwise the
entry is optional.
Reset Extraction Variables.
N. Use extraction variables from the preceding file extraction during
the current file extraction.
Y. Reset all extraction variables to zero (0) before beginning this file
extraction. Use this if you will be using extraction variables to supply
values to another input source.
Display SQL in SYSOUT. Set this to Y if you want the SQL being
executed to be displayed in SYSOUT at run-time.
After you accept your entries, the Comment panel or the Job Window
displays. Do one of the following:

 If the Comments panel displays, enter your comments and press F5.
 To use the DB2 Freeform Editor, go to the next section.
 If you are using the DB2 extraction method, go to “Using the DB2
Extraction Method” on page 484.
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Using the DB2 Free-Form Editor
What is the DB2 Freeform Editor?
The DB2 Freeform Editor makes it easy for you to use a tested, valid SQL
query to extract data from your DB2 tables. It supports lengthy, complex
queries, including table joins. The editor provides panels for pasting in the
SELECT, FROM, and WHERE clauses of the query.
Note:

If a floating-point value is extracted by ACR/Summary using the
Freeform SQL feature, the value is processed as an approximate
numeric datatype.The value has an approximate representation
of decimal value, rather than an exact representation. In general,
a number is approximately represented as a fixed number of
significant digits (significand) and scaled using an exponent. The
base for the scaling is normally two, ten, or sixteen. In ACR/
Summary, the significand is 15.
Example:
Using the Freeform SQL feature via the ODBC or Oracle Direct
Access method, the floating-point value
678901234567890.987654999 becomes
678901234567891.000000000. After the floating-point value is
extracted, processed and rounded by ACR/Summary the
approximate representation of the floating-point value in decimal
format is 9. 678901234567891.000000000. The significand in
this case is 15.

Restrictions
 Queries that require a value from a WHERE clause to an internal item
or extraction variable are not supported. Only a SELECT clause can
return a value to an item.

 Queries that use an * in the SELECT clause are not supported. Column
names must be specified so that the returned values can be mapped to
internal items.

 The DB2 Freeform Editor panels are designed to process valid, tested
SQL. They do not check the validity of SQL. The only panel edits
provided are as follows:

 Freeform DB2 SELECT Statement panel. The statement must begin
with SELECT. If column functions are included, an AS statement
must be entered for each function. Fully qualified column names are
limited to 160 bytes.

 Freeform DB2 FROM Statement panel. The statement must begin
with FROM.
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 Freeform DB2 WHERE Statement panel. The statement must begin
with WHERE. You can include other clauses within the WHERE
clause, but the first word must be WHERE.

Sample Query
We will illustrate the DB2 Freeform Editor by showing how to use the editor
to enter the following query:
SELECT LASTNAME, SUM(BONUS)
FROM DSN8710.EMP
WHERE CV-001 = 'SMITH'

Completing the Freeform DB2 Statement Panel
After you have completed the Input Sources panel and the DB2 File
Information panel as described previously in this chapter, (you must have
selected the DB2 Freeform Editor on DB2 File Information panel), the Job
Window will be displayed. Open the Extract Window and select Edit >
Add to display the Freeform DB2 Statement panel.
This panel enables you to select the portion of your query that you will paste
in.
Freeform DB2 statement
1

1.
2.
3.

Select statement..
From statement...
Where statement..

F1=Help

F3=Exit

Select the SELECT Statement option to display the Freeform DB2 SELECT
Statement panel. See “Completing the Freeform DB2 SELECT Statement
Panel” on page 474.
Select the FROM Statement option to display the Freeform DB2 FROM
Statement panel. See“Completing the Freeform DB2 FROM Statement
Panel” on page 481.
Select the WHERE Statement option to display the Freeform DB2 WHERE
Statement panel. See “Completing the Freeform DB2 WHERE Statement
Panel” on page 482.

Completing the Freeform DB2 SELECT Statement Panel
Copy and paste the SELECT clause from your query into the panel, as in the
following example. The column name can be up to 160 bytes in length.
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The panel does not check the validity of the SQL with these exceptions: 1)
The statement must begin with SELECT, and 2) if column functions are
included, an AS statement must be entered. In this example, the statement
selects only one column and specifies one column function,

SUM(BONUS).
Freeform DB2 SELECT Statement
SELECT LASTNAME, SUM(BONUS) AS ITEM-002_________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

e

After you paste in the SELECT clause and accept your entry, the pertinent
panels for entering file definitions for any columns and column functions
specified will be displayed. These are the same panels used for entering
extraction definitions for non-DB2 sources. We will show you only the
panels corresponding to this example.
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Completing the Input Field Item Panel for the Column
The Input Field Item panel for the LASTNAME column displays.
Input Field Item
DB2 column name: LASTNAME__________
Data type
1_ 1. Character
2. Numeric
Is this input field a date? N (Y/N)
Is the destination an extended item? N (Y/N)
Will this field be translated using a translation table?

F1=Help

F2=Split

F3=Exit

F5=Accept

N

(Y/N)

F9=Swap

DB2 column name. Displays the column name specified on the previous
panel.
Data type. In this case, the data type is Character. The following table
shows how DB2 column types are formatted in ACR/Summary.
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Field Formats for DB2
Field Formats for DB2
DB2 Data Type

ACR/Summary
Format

Integer

Binary

Small Int

Binary

Big Int

Binary

Decimal

Packed decimal

Numeric

Packed decimal

Float

Packed decimal - Do
not specify position/
length

Double

Packed decimal - Do
not specify position/
length

Char

Text

Var Char

Text

Long Var char

Text

Date

Numeric

Time

Numeric or text

Timestamp

Extended Text

Is this input field a date? If you enter Y, you will be presented with a
panel for specifying the date format. For this example, accept the default N.
Is the destination an extended item? Enter Y if the extracted value will
be a number with 16 to 30 digits or a text value with 9 to 80 characters.
Will this field be translated using a translation table? Enter Y if the
field will be translated. Later you will be presented with a panel for
specifying the table name. For this example, accept the default N.
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Completing the Output Value Panel for the Column
Output Value
Specify
3_ 1.
2.
3.

output format:
Amount
Count
Text

Assign to internal item number: I 001
or
Extraction variable number: ___
Override sign processing?

F1=Help

F2=Split

N

F3=Exit

(Y/N)

F5=Accept

F9=Swap

Specify the output format. In this example, Text would be selected.
Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Here, we accept the default to assign the value to internal item I-001.
Extraction variable number. You would complete this field if you
wanted to assign the value to an extraction variable.
Override sign processing? You would enter Y if you wanted to specify
overrides for the reverse sign and negative sign indicators specified in the
User Options File. For this example, skip this field.
Accept your entries. The panels that will display next depend on your
entries on the Output Value panel.
In this example, the Internal Items panel, explained in “Defining Internal
Items” on page 196, will be displayed. After you complete the Internal Items
panel, the Input Field Item panel for the SUM(BONUS) column function
will be displayed.

478

Infogix, Inc.

Using DB2 Tables as Input Sources  15
Using the DB2 Free-Form Editor

Completing the Input Field Item Panel for the Column Function
The Input Field Item panel for the SUM(BONUS) column function is shown
below.
Input Field Item
DB2 column name: ITEM-002__________
Data type
2_ 1. Character
2. Numeric
Is this input field a date? N (Y/N)
Is the destination an extended item? N (Y/N)
Will this field be translated using a translation table?
F1=Help

F2=Split

F3=Exit

F5=Accept

N

(Y/N)

F9=Swap

DB2 column name. The field item specified by the AS ITEM-002
statement will be displayed in the DB2 column name field. For this
example, the data type should be numeric.
Accept the default entries for the other fields to display the next panel. You
will not be completing the following fields:
Is this input field a date? Enter Y if the field is a date.
Is the destination an extended item? Enter Y if the extracted value will
be a number with 16 to 30 digits or a text value with 9 to 80 characters. For
more information, see “Processing of Print Leading Zeros Indicator” on
page 194 and “Defining Extraction Variables” on page 201.
Will this field be translated using a translation table. Enter Y if the
field needs to be translated.
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Completing the Output Value Panel for the Column Function
Output Value
Specify
2_ 1.
2.
3.

output format:
Amount
Count
Text

Assign to internal item number: I 002
or
Extraction variable number: ___ (1-999)
Override sign processing?
F1=Help

F2=Split

N

F3=Exit

Extended? N

(Y/N)
F5=Accept

F6=ExtVar

F9=Swap

For this example, set the output format to Count. Accept the default entries
for the other fields.
Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Here, we accept the default to assign the value to internal item I-001.
Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, you would press F6. If you enter a number for an extraction
variable that has not yet been defined, the “Extraction Variables Panel” on
page 205 will be displayed. For this example, skip this field.
Extended? This field displays the entry from the Is the destination an
extended item? field in the Input Field Item panel (No). For this
example, skip this field.
Override sign processing? Enter Y if you wanted to specify overrides for
the reverse sign and negative sign indicators specified in the User Options
File. For this example, skip this field.
The panels that will display next depend on your entries on the Output
Value panel. In this example, only the Internal Items panel will be
displayed. After you complete the Internal Items panel, the Extract Window
will be displayed.
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Completing the Freeform DB2 FROM Statement Panel
From the Extract Window, select Edit > Add. When the Freeform DB2
Statement panel displays, select From statement to display the Freeform
DB2 FROM Statement panel. Paste in the FROM clause from your SQL
query, as shown in this example.
The panel does not check the validity of SQL with this exception: The
statement must begin with FROM.
Freeform DB2 FROM Statement
FROM DSN8710.EMP________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Command ===> ____________________________________________________________
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

After you complete and accept the panel, the Extract Window will be
displayed.
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Completing the Freeform DB2 WHERE Statement Panel
From the Extract Window, select Edit > Add. When the Freeform DB2
Statement panel displays, select Where statement to display the Freeform
DB2 WHERE Statement panel.
You can paste in the WHERE clause from your SQL query. (In addition to
the WHERE clause, the panel is intended for entry of any clauses other than
SELECT and FROM.) To include an extraction variable in the WHERE
statement, press F6. You can then select from a list of extraction variables.
See “Completing the Extraction Variable List Window” described on
page 483. The example below shows a WHERE statement that includes an
extraction variable.
The panel does not check the validity of SQL with this exception: The
statement must begin with WHERE.
Freeform DB2 WHERE Statement
WHERE :CV-001 = 'SMITH'________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=Items

F9=Swap

After completing the panel, press F5 to return to the Extract Window. See
“Sample File Definitions for the DB2 Freeform Editor” on page 484.
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Completing the Extraction Variable List Window
Press F6 from the Freeform DB2 WHERE Statement panel to display this
panel. This panel enables you to select an extraction variable to include in
the Freeform DB2 WHERE Statement. The following panel shows a sample
list
Extraction Variable List Window

Row 1 from 3

_
001 EXTENDED EV - TEXT
_
002 EXTENDED EV - AMOUNT
_
003 EXTENDED EV COUNT
********************* Bottom of data **********************
Command Line ===> _______________________________________
F1=Help
F3=Exit
F7=Up
F8=Down

Select the extraction variable you want to include. The Extraction Variable
Parms panel displays.

Completing the Extraction Variable Parms Panel
Extraction Variable Parms
Is this extraction variable extended? N
Is this extraction variable Numeric? N

F1=Help

F2=Split

F3=Exit

(Y/N)
(Y/N)

F5=Accept

F9=Swap

Is this extraction variable extended? Enter Y if this is true.
Is this extraction variable numeric? Enter Y if this is true.
The Freeform DB2 WHERE Statement panel displays again, showing the
WHERE statement with the selected extraction variable. You can include
additional extraction variables in the same way. For information on
extraction variable codes, see “Extraction Variable Codes” on page 489.
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Sample File Definitions for the DB2 Freeform Editor
When you have completed your definitions, the Extract Window will be
displayed with your completed file definitions for this input source, as in
the example below.
File Edit View Window Help
-------------------------------------------------------------------------Extract Window
Row 1 to 6 of 6
File name: EMPDD
__ FREEFORM SELECT LASTNAME, SUM(BONUS) AS ITEM-002
__ FREEFORM FROM DSN8710.EMP
__ FREEFORM WHERE :CV-001 = 'SMITH'
__
PICK UP I-001 FROM DB2 COLUMN LASTNAME
__
PICK UP I-002 FROM DB2 COLUMN FIRSTNME
***************************** Bottom of data ******************************
Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Query Displays in SYSOUT if Specified
If you set the field Display SQL in SYSOUT on the DB2 Information
panel to Y, the query will display in SYSOUT at run-time.

Using the DB2 Extraction Method
This method builds the query dynamically based on your extraction
definitions. The selection clause is limited to 40 bytes.

Sample Query
We will illustrate the DB2 extraction method by showing how to create file
definitions corresponding to the following query:
SELECT LASTNAME
FROM DSN8710.EMP
WHERE :CV-001 = EMPNO

Getting Started
To use the DB2 Extraction method, complete these steps:
1. Complete the Input Sources panel as described earlier in this chapter.
2. Complete the DB2 File Information panel as described earlier in this

chapter. Make sure you select the following:

 Select No to the question about using the DB2 Freeform Editor.
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 Specify the table name (in this example, EMP) and the table owner
(in this example, DSN8710). This information will supply the
FROM clause information for your query.
3. After you accept your entries, the Freeform Comment Entry Area panel

or the Job Window will be displayed. Open the Extract Window and
select Edit > Add.

Completing the Select a Definition Type panel
Select a definition type:
1_ 1. DB2 record...
2. Field item...
F1=Help

F3=Exit

Select a definition type. Options:
1. DB2 record. This displays the DB2 Record panel, which serves the

purpose of a SQL WHERE clause: It provides criteria to select rows to
retrieve from the table.
2. Field item. This displays the Input Field Item panel. This identifies the

column values that will be extracted or accumulated from the selected
rows (the SELECT clause information)
Here, we select DB2 record. The DB2 Record panel will display.
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Completing the DB2 Record Panel
Use this panel to define the WHERE clause information.
DB2 Record
Column name: EMPNO_____________
Argument data type:
1_ 1. Character
2. Numeric
Argument value:
:CV-001_________________________________
Relationship of column name value to the argument value:
1_ 1. Column value is equal to the argument value
2. Column value is less than the argument value
3. Column value is greater than the argument value
4. Column value is not equal to the argument value
5. Column value is less than or equal the argument value
6. Column value is greater than or equal the argument
value
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Column Name. Enter the name of the column to be used in the
comparison (in this case, EMPNO).
Argument Data Type. Indicate the data type of the comparison.
Argument Value. Enter the character string or the extraction variable to
be used as the value of the comparison argument.

 If you are using a character string, enter the string.
 If you are using a value from an extraction variable, use the codes
described in “Extraction Variable Codes” on page 489. Here, we will use
the value of extraction variable 1, which is a text value, as indicated by
the codes :CV-001.
Relationship of column name value to the argument value.
Indicate the type of comparison to be made between the values in the
column name and the argument fields. Here option 1 is selected.
Accept your entries to return to the Extract Window. Select Edit > Add >
Field Item to display the Input Field Item panel.
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Completing the Input Field Item Panel
Use this panel to identify the column from which to extract the field item.
Input Field Item
DB2 column name: LASTNAME _________
Data type
1_ 1. Character
2. Numeric
Is this input field a date? N (Y/N)
Is the destination an extended item? Y (Y/N)
Will this field be translated using a translation table?

F1=Help

F2=Split

F3=Exit

F5=Accept

N

(Y/N)

F9=Swap

DB2 column name. Name of the column from which to extract data (in
this case, LASTNAME).
Data type. In this case, the data type is Character.
Is this input field a date? If you enter Y, you will be presented with a
panel for specifying the date format. For this example, accept the default N.
Is the destination an extended item? Enter Y if the extracted value will
be a number with 16 to 30 digits or a text value with 9 to 80 characters.
Will this field be translated using a translation table? Enter Y if the
field will be translated. Later you will be presented with a panel for
specifying the table name. For this example, accept the default N.

Completing the Output Value Panel
Use this panel to format the value from the column and specify where the
value will be stored.
Output Value
Specify
3_ 1.
2.
3.

output format:
Amount
Count
Text

Assign to internal item number: I 001
or
Extraction variable number: ___ (1-999)
Override sign processing?
F1=Help

F2=Split
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F3=Exit

Extended? N

(Y/N)
F5=Accept

F6=ExtVar

F9=Swap
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Specify output format. In this case, the format is Text.
Assign to internal item number. The internal item or extended
internal item where the value will be stored. This field consists of two parts:

 A 1-digit item type indicator. This displays the item type (I for internal
item or X for extended internal item) based on your selection on the
preceding panel.

 A 3-digit item number. This number is assigned by the system, but you
can change it.
Here, we accept assign the value to internal item I-001.
Extraction variable number. If you want to assign the value to an
extraction variable, blank out the internal item number and complete with
the extraction variable number. To select from the list of existing extraction
variables, press F6. If you enter a number for an extraction variable that has
not yet been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? This field displays the entry you made in the Is the
destination an extended item? field in the Field Value panel.
Override sign processing? You would enter Y if you wanted to specify
overrides for the reverse sign and negative sign indicators specified in the
User Options File. For this example, skip this field.
Accept your entries to display the next panel. In this example, only the
Internal Items panel will be displayed. After completing the panel, the
Extract Window will be displayed showing your completed definitions.

Sample File Definitions for the DB2 Extraction Method
When you have completed your definitions, the Extract Window will be
displayed with your completed file definitions for this input source, as in
the following example:
File Edit View Window Help
---------------------------------------------------------------------Extract Window
Row 1 to 5 of 5
__
SELECT IF COLUMN VALUE = :CV-001
__
PICK UP VALUE FROM DB2 COLUMN LASTNAME STORE IN I-001
***************************** Bottom of data **************************
Command Line ===> ____________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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Query Displays in SYSOUT if Specified
If you set the field Display SQL in SYSOUT on the DB2 Information
panel to Y, the query will display in SYSOUT at run-time.

Extraction Variable Codes
This section provides guidelines and valid formats for extraction variable
codes that can be used in DB2 Where statements.
Note:

 If you are using the DB2 Freeform Editor, extraction
variables are entered in the Freeform DB2 WHERE
Statement Panel described in this chapter and can appear on
either or both sides of the comparison. For example:
Field name1 or extraction variable = field name2 or
extraction variable
 If you are using the DB2 extraction method, any extraction
variables are entered in the DB2 Record Panel’s Argument
Value field.

Format for a regular extraction variable:
:CV-nnn (for a text extraction variable column) or :NV-nnn (for a
numeric extraction variable)
where nnn is the number of the extraction variable (for
example, 001).
:CV-nnn or :NV-nnn must be followed by a space unless it is the only
thing in the field.
If you want to concatenate text type extraction variables, 2 regular
extraction variables can be combined to make a longer text value. For
example,

:CV-001 :CV-002 = ‘upto16characters’
space
space
Format for an extended extraction variable:
:CXV-nnn (for a text extraction variable column) or :NXV-nnn (for a
numeric extraction variable).
Two text type extended extraction variables can be combined to make a
text value up to 160 characters long. For example:

:CXV-001 :CXV-002 = ‘upto160characters’
space
space
Format for a field name
ACR/Summary User Guide for z/OS
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To specify a field name, just enter the correct field name. Casesensitivity depends on your database. Spaces always count.
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16
Using the Batch Utilities
This chapter describes the batch utilities and contains the following
information:

 Instructions for "Accessing the Batch Utilities" below.
 Instructions for “Running the Batch Utilities” on page 492.
 Information specific to each batch utility, which includes the following
as appropriate:






Description
Panel documentation
Record layouts
Output reports.

 A description and sample of the “Transaction Listing Report” on
page 546

Accessing the Batch Utilities
To access the batch utilities, from the Job Window select Setup >
Database Utilities and do one of the following:

 Select Database report utilities to run the utilities described in the
following sections:
“List Definitions Utility” on page 493
“Cross-Reference Internal Items Utility” on page 503
“Cross-Reference File Definitions Utility” on page 505
“List Histories Utility” on page 507
“Reprint Control Report Utility” on page 510
“Print Management Report Utility” on page 512
“Print Control Update Information Report Utility” on page 514

 Select Database update utilities to run the utilities described in the
following sections:
“Delete History Utility” on page 516
“Update History Database Utility” on page 519
“Copy History Database Utility” on page 520
“Reorganize History Utility” on page 526
“Archive/Restore History Utility” on page 528
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“Extract History Utility” on page 533
“Build Batch Transactions Utility” on page 539
“Update From Batch Transactions Utility” on page 540
“Create Comma Delimited Text File Utility” on page 543

 The following utility must be run manually.
“Lock or Free History Database Utility” on page 545

Running the Batch Utilities
Run the batch utilities as follows:
1. Access the utility as described in the preceding section.
2. In most cases the Library Information panel displays. Complete it as

follows:
Dataset name. Defaults to the JCL library file specified on the User
File Defaults panel, but you can change it.
Member name. Shows the default member name that will be saved
in your PROCLIB. You can change it if needed.
If additional fields are required for a particular utility, they will be
described in the pertinent section below.
3. The utility’s entry panel will display. There may be a second entry

panel, depending on how you complete the first panel. If a selection
panel displays, after making your selection, the corresponding entry
panel will display. The selection and entry panels are explained in the
section for each utility below.
4. After you complete the entry panel, the JCL displays, and you can edit

or submit it.
5. Review the output for the utility’s output DDNAME. The generated

JCL will output any reports you create to the SYSOUT for your job. If
you want to view the reports from the user interface, change the report
DD statements to go to the file name defaults you specified during
setup. (The output DDNAMES referenced here are the default
DDNAMES.) You can then select Edit > Edit JCL from the Job
Window to view a dataset.
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List Definitions Utility
This utility generates the Definition Database Listing Report, which lists
definitions from the definition database. The report is useful for
establishing an audit trail or troubleshooting.
The documentation for this utility includes the following sections:

 “List Definitions Entry Panel” on page 493
 “Definition Database Listing Report” on page 494

List Definitions Entry Panel
List Definitions
Job name: USERID__
Definition database to list from:
USERID.SUM.DEFN___________________________
Specify type of definitions to list:
__ 1. Jobs
2. Files
3. History analysis
4. Internal/Cycle tables
5. External tables
6. All definitions
7. Job and associated files
F1=Help
F2=Split
F3=Exit
F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Definition database to list from. The definition database for which
definitions will be listed. You can optionally change it.
Specify type of definitions to list. Enables you to restrict the type of
definitions to list:

 All definitions. The report will include a Database History and Statistics
section

 Any other option. Lists the selected type of the definition. If you select
a specific type of definition, you can also specify a range on the next
panel.
Note:

The Job and associated files option allows you to list batch
transaction definition records for all or selected job definitions and
for their associated input source files at the same time.

To view samples of the reports, see the next sections.
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Definition Database Listing Report
The DDNAME for the report in your output will be UNIDLR. The report
sections generated depend on your selections on the List Definitions Entry
panel.
Definition Database Listing: Database History and Statistics
This section is generated if you select All as the type of definitions to list.
It provides detailed information about the database, including date and
time of initialization, date and time of last update, and number of records
by type.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 10:40:23

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=YOURFILE.SUM.HIST
DATA BASE HISTORY AND STATISTICS
-------------------------------DATE AND TIME OF INITIALIZATION:
yy/mm/dd
DATE AND TIME OF LAST UPDATE:
yy/mm/dd
DATE AND TIME OF LAST UPDATE:
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
NUMBER OF
AGGREGATE
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BASIC INFORMATION RECORDS:
INTERNAL ITEM RECORDS:
EXTERNAL ITEM RECORDS:
BALANCING RULE RECORDS:
SPECIAL INSTRUCTION RECORDS:
RECAP ITEM RECORDS:
FILE ITEM RECORDS:
USER REPORT ITEM RECORDS:
FILE INFORMATION RECORDS:
RECORD INFORMATION RECORDS:
FIELD INFORMATION RECORDS:
SELECTION FIELD RECORDS:
DETAIL FIELD RECORDS:
RUN HISTORIES:

COPYRIGHT INFOGIX, INC.
PAGE 001
DATA BASE VERSION: 0000019/*****

AT 16:23:22
AT 16:41:15
mm/dd/yy

AT 11:41:35

8
17
4
12
7
4
4
5
4
7
9
1
3
26
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Definition Database Listing: Index of Definition Keys
This section is generated if you select All definitions on the entry panel. It
provides a list of definition keys by type.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 13:36:15

XYZ COMPANY

DEFINITION KEY
____________________
ACCESS3 STEP06
ACCMD361 000000
BOOKCLUBVERIFY
BOOKCOST 000000
CARENTL COMPARE
CARENTL1 000000
CARENTL2 000000
CLAIMS
000000
CLAIMS STEP1
CONDRULE 000000
CURRENCY
DAILY
000000
DOMESTICSALES
IFTHEN STEP1
ILLINOIS 000000
JOBXYZ UPDATE
JOBXYZ UPDATE TO
MONTH CONVERSION
MONTHEND
OFFICE01 000000
OFFICE0101000000
OHIO
000000
RESULTS
SALES
DAILY
SAMPLE UPDATE
STATE CODE/ABBR
STATEDEF 000000
STATEOH SALES
STATES SALES
STATESILSALES
SUMM0501 000000
TOTALS
TOTALS STEP1
TOTLCOST 000000
TOTSALQ3 000000
TRANSLATE STATES
UPDTRPT
000000
UPDT0501 000000

COPYRIGHT INFOGIX, INC

DEFINITION DATA BASE LISTING
DATA BASE VERSION: 0000078/*******
DSN=USERID.SUM.DEFN
INDEX OF DEFINITION KEYS
________________________
TYPE
COMMENTS
_______________
________________________________________
JOB ID
FILE-ID
JOB ID
FILE-ID
JOB ID
FILE-ID
FILE-ID
FILE-ID
JOB ID
FILE-ID
TABLE-ID
TRANSLATION TABLE
FILE-ID
JOB ID
JOB ID
FILE-ID
JOB ID
JOB ID
TABLE-ID
TRANSLATION TABLE
TABLE-ID
CYCLE TABLE
FILE-ID
FILE-ID
FILE-ID
SPREADSHEET-ID
JOB ID
JOB ID
TABLE-ID
EXT. TRANSLATION TABLE
FILE-ID
JOB ID
JOB ID
JOB ID
FILE-ID
SPREADSHEET-ID
JOB ID
FILE-ID
FILE-ID
TABLE-ID
EXT. TRANSLATION TABLE
FILE-ID
FILE-ID
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Definition Database Listing: Detailed Job Definitions - Page 1 of 2
A detailed job listing is generated if you select Jobs or All as the type of
definitions to list. This report lists the basic job information settings and
item and report definitions for each job in the definition database.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 13:50:20

A.
B.

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED DEFINITIONS
________________________

PAGE 001
DATA BASE VERSION: 0000004/*******

JOB ID:
OVERPUNCTEST1
ALTERNATE JOB ID KEYS:
NONE
BASIC INFORMATION:
PRODUCT:
ACR/S
SYSTEM NAME:
PROBLEMS WITH OVERPUNCH
NUMBER OF HISTORIES RETAINED:
1
LAST UPDATE BY:
SAMPUSR
DATE: yy/mm/dd
RUN OPTIONS:
STORE RUN HISTORY:
YES
PRINT ACR:
YES
PRINT RECAP:
NO
SET RETURN CODE:
NO
PRINT SECOND COPY OF ACR:
NO
MODEL PROCESSING:
NO
FILE CONTROL DEFINITIONS:
NO
USER EXIT ACCESS:
NO
CYCLE TABLE ID:
CYCLE REFERENCE JOB ID KEY:
CYCLE INCREMENT:
0
AUTOMATIC CYCLE OPTION:
AUTO RERUN REQUIRED:
USE SYSTEM DEFAULT
HISTORY AUDIT TRAIL:
USE SYSTEM DEFAULT
TRUNCATE/ROUND DECIMALS:
ROUND
PRINT 22 CHARACTER NUMERIC:
NONE
CONTROL REPORT XML EXPORT OPT:DEFAULT TO USER OPTIONS
OUTPUT OPTIONS:
ENHANCEMENTS ACTIVATED:
YES
STORE BALANCING EXTRACT FILE: YES
REPORT SIZE - COPY 1:
132
REPORT SIZE - COPY 2:
132
SECTION PRINT OPTIONS:
INTERNAL ITEMS - COPY 1
: PRINT SECTION
INTERNAL ITEMS - COPY 2
: PRINT SECTION
INTERNAL ITEMS - EXTRACT
: DO NOT STORE EXTRACT RECORD
EXTENDED INTERNAL ITEMS - COPY 1 : PRINT SECTION
EXTENDED INTERNAL ITEMS - COPY 2 : DO NOT PRINT THE SECTION
EXTENDED INTERNAL ITEMS - EXTRACT: DO NOT STORE EXTRACT RECORD
HISTORY ITEMS - COPY 1
: PRINT SECTION
HISTORY ITEMS - COPY 2
: PRINT SECTION
HISTORY ITEMS - EXTRACT
: DO NOT STORE EXTRACT RECORD
CALCULATED ITEMS - COPY 1
: PRINT SECTION
CALCULATED ITEMS - COPY 2
: PRINT SECTION
CALCULATED ITEMS - EXTRACT
: DO NOT STORE EXTRACT RECORD
BALANCING RULES - COPY 1
: PRINT SECTION
BALANCING RULES - COPY 2
: PRINT SECTION
BALANCING RULES - EXTRACT
: DO NOT STORE EXTRACT RECORD
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Definition Database Listing: Detailed Job Definitions - Page 2 of 2
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 13:50:20

B.

C.

D.

E.

F.

G.

J.

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED DEFINITIONS
________________________

COPYRIGHT INFOGIX, INC
PAGE 002
DATA BASE VERSION: 0000004/*******

JOB ID:
OVERPUNCTEST1
BASIC INFORMATION:
SPECIAL INSTRUCTIONS - EXTRACT
: DO NOT STORE EXTRACT RECORD
DESCRIPTION PRINT OPTIONS:
HISTORY ITEMS - COPY 1 DESC.
: PRINT HISTORY ITEM DESCRIPTION
CALCULATED ITEMS - COPY 1 DESC. : PRINT DESCRIPTION AND FORMULA
BALANCING RULES - COPY 1 DESC.
: PRINT DESCRIPTION AND FORMULA
HISTORY ITEMS - COPY 2 DESC.
: PRINT HISTORY ITEM DESCRIPTION
CALCULATED ITEMS - COPY 2 DESC. : PRINT DESCRIPTION AND FORMULA
BALANCING RULES - COPY 2 DESC.
: PRINT DESCRIPTION AND FORMULA
HISTORY ITEMS - EXTRACT DESC.
: STORE FIRST RECORD LAYOUT
CALCULATED ITEMS - EXTRACT DESC. : STORE FIRST RECORD LAYOUT
BALANCING RULES - EXTRACT DESC. : STORE FIRST RECORD LAYOUT
INTERNAL ITEMS:
ITEM
DESCRIPTION
L/R/C FORMAT DEC CI# REQD COM
________ ________________________________________________________________________________ _____ ______ ___ ___ ____ ___
I-001
RIGHT ALIGNED ZONED DECIMAL AS FF4
SHOULD BE 1000
LEFT
COUNT
0
NO
I-002
RIGHT ALIGNED ZONED DECIMAL AS FF41
SHOULD BE 10001
LEFT
COUNT
0
NO
EXTENDED INTERNAL ITEMS:
ITEM
DESCRIPTION
FORMAT DEC CI# REQD COM
________ ________________________________________________________________________________
______ ___ ___ ____ ___
X-001
EXT RT ALIGNED ZONED DECIMAL AS FF4
SHOULD BE 1,000
COUNT
0
NO
EXTRACTION VARIABLES:
ITEM
DESCRIPTION
DEC
________ ________________________________________________________________________________ ___
V-101
DEC 4
4
HISTORY ITEMS:
ADD
MOST
EQ
------------ VARIABLE CYCLE -----------ITEM
JOB
STEP
QUAL ITEM
CYC CYC RECENT REQD CYC
IND JOB
STEP
QUAL CYC RECENT CYC FMT
________ ________ ________ ____ _____ ____ ____ ______ ____ ___
___ ________ ________ ____ ____ ______ ________
E-001
CYCLE12
STEP1
I-002 -002 NO
NO
YES
NO
NO
CALCULATED ITEMS:
ITEM
CALCULATION FORMULA
FORMAT DEC REQD COM COND CYC FMT
________ _________________________________________________________________________________ ______ ___ ____ ___ ____ ________
C-001
ITEMS X-001 + I-002
COUNT
0 NO
N
C-002
1 INTO @CYCLE
DATE
0 NO
N
MMDDCCYY
BALANCING RULES:
RULE TYPE
BALANCING FORMULA
CODE ACTION FORMAT TOL. TOL. VALUE
_____ ______ ______________________________________________________________________________ ____ ______ ______ ____ __________
R-001 ACT
ITEMS X-001 EQ XV-101
0000 NONE
TEXT
NONE
COM:
CALC ITEM:001
USER REPORT ITEMS:
PRINT OPTION:
(Z) IF IN BALANCE
XML OPTION:
(9) DEFAULT TO USER OPT
FIXED SPACING:
(Y) YES
SPACING WIDTH:
5
WRAP INDICATOR:
( ) TRUNCATE EXTENDED ITEM
USER REPORT TITLE
COLUMN HEADING 1
COLUMN HEADING 2
COLUMN HEADING 3
COLUMN HEADING 4
________________________________________ __________________ __________________ __________________ __________________
SCR 874 ALIGNMENT OF DECIMALS
COL 1 NUMBER
COLUMN SEPARATOR CHARS
ITEM DESCRIPTION
ITEM 1 ITEM 2 ITEM 3 ITEM 4
1234
________________________________________ ______ ______ ______ ______
____
COLUMN ONE
I-001
COLUMN TWO
I-002
USER REPORT PAGE HEADERS
HEADING
COLUMN COLUMN ITEM TYPE ITEM#
WIDTH POS.
LITERAL
OPTION
______ ______ ____ ____ _____
_____ ____
_______
______
000
(L ) LITERAL
18
1
This is Literal 1:
CENTER
000
(I ) INTRNL ITEM
1
20
20
CENTER
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Definition Database Listing: Detailed File Definitions
A detailed file listing is generated if you select Files or All as the type of
definitions to list. The report provides detailed information on each file ID
processed. (The full heading is shown only for page 1.)
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 12:46:48

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=R99UC47.SUM45.DEFN
DETAILED FILE DEFINITIONS
_________________________

COPYRIGHT INFOGIX, INC. 2015
PAGE 001
DATA BASE VERSION: 0000954/*******

FILE ID:
UGRPT1F
FILE DESCRIPTION: FLYER REPORT
A. FILE INFORMATION:
ACCESS MODE:
DATA SET ORGANIZATION:
NUMBER OF RECORDS SCANNED:
DD NAME FOR HARD COPY:
FILE MODEL - FILE ID:
LAST UPDATE BY:
DDF INFORMATION:

REFERENCES:

C.

START OF DATA SET
SEQUENTIAL FILE/REPORT
50

R99UC47
USE DDF
_______
NO
JOB
________
UGRPT1

BASE MODEL: NO
DATE: 15/06/10
DELIM 1 DELIM 2
_______ _______

FIXED DATA
__________

RESET EXT VAR

TIME: 10.20.49
DELIM 3 DELIM 4
_______ _______

DON'T DISPLAY SQL

DELIM 5
_______

ENCLS
_____

STEP
QUAL
________ ____
SAMPLE

RECORD INFORMATION:
REC ID
TYPE
OCC
POS
LEN IND DDF VALUE
______ ________ ___ __________ ___ ___ ____ ________________________________________________________________________________
000001 EMBEDDED
1
11
8 NNN
FF48379
REC ID FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC/TIME FMT TRAN TABLE / OPTION
______ ____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
000001
1
97
8
ALPHA
NO
1 INP FLD INT ITEM TEXT
000001
2
89
4
NUMERIC
NO
2 INP FLD INT ITEM COUNT
000001
3
41
10
NUMERIC
NO
3 INP FLD INT ITEM AMOUNT
000001
4
52
8
NUMERIC
NO
4 INP FLD INT ITEM DATE
000001
5
61
8
NUMERIC
NO
5 INP FLD INT ITEM TIME
HHMMSS
000001
6
70
8
NUMERIC
NO
7 INP FLD INT ITEM COUNT
000001
7
11
30
ALPHA
NO
1 INP FLD INT XTND TEXT
000001
8
81
3
ALPHA
NO
8 INP FLD INT ITEM TEXT
000001
9
81
3
NUMERIC
NO
9 INP FLD INT ITEM TEXT
FLYEROFFICETABLE YES
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ACR/S releasenumber
DATE: yy/mm/dd
TIME: 12:47:08

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=R99UC47.SUM45.DEFN
DETAILED FILE DEFINITIONS
_________________________

COPYRIGHT INFOGIX, INC. 2015
PAGE 002
DATA BASE VERSION: 0000954/*******

FILE ID:
UGRPT6F
FILE DESCRIPTION: FLYER REPORT
A. FILE INFORMATION:
ACCESS MODE:
DATA SET ORGANIZATION:
DD NAME FOR HARD COPY:
FILE MODEL - FILE ID:
FILE TRANSLATION TABLE:
LAST UPDATE BY:
DDF INFORMATION:

REFERENCES:

REC-ID: 001001
SELECT:

ACCESS MODE 6
SEQUENTIAL FILE/REPORT

RESET EXT VAR

DON'T DISPLAY SQL

BASE MODEL: NO
R99UC47
USE DDF
_______
NO
JOB
________
UGRPT6

FIXED DATA
__________

DATE: 15/06/10
DELIM 1 DELIM 2
_______ _______

TIME: 10.16.22
DELIM 3 DELIM 4
_______ _______

DELIM 5
_______

ENCLS
_____

STEP
QUAL
________ ____
SAMPLE

SELECTION TYPE SEQ POS LEN FORMAT TYPE
______________ ___ _____ ___ ________ ____
= TO VALUE 1
001
1
2 ALPHA
TEXT
COMMENT- Include FF flights only
COMMENT-

EXT
___
NO

INP
TYP
___
INP

LVL
NBR
___
1

DDF TRN OPT
____ _______

LOG REL SEL
EXT
OPR NBR KEY SAME VAR
VALUE
DDF
___ ___ ___ ____ ______ ____________________ ____
AND
FF

OUTPUT AREA
___________

EXT VAR
_______

REFORMAT:

INPUT 001
1
1 ALPHA
LIT
NO
INPUT AREA
OUTPUT 104
1 ALPHA
COMMENT- Insert '&' at position 104 to connect route code and flight number
COMMENTINPUT 002
1
7 ALPHA
INP
NO
INPUT AREA
OUTPUT 105
7 ALPHA

DETAILS:

001
97
7 ALPHA
TEXT
002
90
3 NUMERIC TEXT
003
81
3 ALPHA
TEXT
COMMENT- get office city
COMMENT004
81
3 NUMERIC TEXT
COMMENT- get office city
COMMENT005
42
8 NUMERIC SUM
COMMENT- Accumulate ticket price
COMMENT006
52
8 NUMERIC DATE
007
61
8 NUMERIC TIME
008
70 10 NUMERIC TEXT
009
97
8 ALPHA
TEXT
010
1
3 ALPHA
TEXT
COMMENT- Extract the origin city from route
COMMENT011
5
3 ALPHA
TEXT
COMMENT- Extract the destination city from route
COMMENT012
11 30 ALPHA
TEXT
013
11 14 ALPHA
TEXT
014
25 15 ALPHA
TEXT
015
97 16 ALPHA
TEXT
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LITERAL
____________________
&

DEC IN EV# OUT ITEM# ACC OPT DDF SIGN TRAN TBL/LITERAL/OPT
___ __ ___ ___ _____ _______ ____ ____ ____________________
NO
I-001 L DTL
NO
I-002 L DTL
NO
I-010 L DTL

NO

I-011 L DTL

NO

I-003 ADD

NO
NO
NO
NO
NO

EV

1

NO

EV

1

NO
NO
NO
NO

I-004
I-005
I-007
EV
001
I-008

L
L
L
L
L

DTL
DTL
DTL
DTL
DTL

FLYEROFFICETABLE/NO

TM FMT:HHMMSS

I-009 L DTL

X-001
X-002
X-003
X-004

L
L
L
L

DTL
DTL
DTL
DTL

499

16  Using the Batch Utilities
List Definitions Utility

Note:

FILE ID:
SAMPLE10
FILE DESCRIPTION: SAMPLE FILE 5
A. FILE INFORMATION:
ACCESS MODE:
DATA SET ORGANIZATION:
FILE MODEL - FILE ID:
DDF INFORMATION:

REFERENCES:

C.

In the following Total/Tally/Hash example, the DEC (Extract
Decimal Indicator) column applies only to total (not hash or tally)
records.
PAGE 002

TOTAL/TALLY/HASH
SEQUENTIAL FILE/REPORT
BASE MODEL: NO
USE DDF FIXED DATA DELIM 1
_______ __________ _______
YES
0
JOB
STEP
QUAL
________ ________ ____
DDF2
AM5

PASS EXT VAR
DELIM 2
_______
&

DELIM 3
_______

DELIM 4
_______

DELIM 5
_______

ENCLS
_____

RECORD INFORMATION:
REC ID
TYPE
OCC
POS
LEN IND DDF VALUE
______ ________ ___ __________ ___ ___ ____ ________________________________________________________________________________
000001 TALLY
1
7 N
1 CHICAGO
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
1
1
INT ITEM
000002 TALLY
1
7 N
1 NEWYORK
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
2
2
INT ITEM
000003 TOTAL
1
7 N
1 CHICAGO
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
3
0
0
2
NUMERIC
YES
3
INT ITEM
000004 TOTAL
0
0 Y
1
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
4
0
0
2
NUMERIC
YES
4
INT ITEM
000005 HASH
1
7 N
1 CHICAGO
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
____ ______
___ ____
_______
___ ____ _______ ________ __________ ____ ____________ _____________________
5
5
INT ITEM
000006 HASH
1
7 X
1 CHICAGO
FLD# POS
LEN DDF
FORMAT
DEC ITEM IN AREA OUT AREA FIELD TYPE SIGN CYC FMT/PART TRAN TABLE / OPTION
000007 HASH
0
0 Y

Detailed Table Definitions - Internal Translation Table
A detailed table listing similar to the one shown below is generated if you
select Internal/Cycle tables or All on the entry panel. This example shows
information for an internal translation table.
ACR/S releasenumber
DATE: 15/06/11
TIME: 11:21:42

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=R99UC47.SUM45.DEFN
DETAILED TABLE DEFINITIONS
__________________________

COPYRIGHT INFOGIX, INC. 2015
PAGE 001
DATA BASE VERSION: 0000954/*******

TABLE-ID: FLYEROFFICETABLE
LAST UPDATE BY: R99UC47
DATE: 15/06/08
TIME: 14.35.07
ITEM
TABLE INPUT / TABLE OUTPUT
________ ________ ________________________________________________________________________________
001
INPUT
000000000000000000000000000002
OUTPUT
NAPERVILLE
002
INPUT
000000000000000000000000000001
OUTPUT
CHICAGO
003
INPUT
000000000000000000000000000003
OUTPUT
LISLE

NUMERIC
_______
Y
N
Y
N
Y
N

Detailed Table Definitions - Cycle Table
This example shows information for a cycle table.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 16:04:28

TABLE-ID: MONTHEND
LAST UPDATE BY: SAMPUSR
ENTRY #.
1
________ ________
001-010
20080131
011-020
20081131
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XYZ COMPANY

COPYRIGHT INFOGIX, INC

DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED TABLE DEFINITIONS
__________________________

2
________
20080229
20081231

DATE: yy/mm/dd
3
4
________ ________
20080331 20080430
00000000 00000000

TIME: 15:11:54
5
6
________ ________
20080531 20080630
00000000 00000000

7
________
20080731
00000000

DATA BASE VERSION: 0000078/*******

8
________
20080831
00000000

9
________
20080930
00000000

0
________
20081031
00000000
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Detailed Table Definitions - External Translation Table
A detailed table listing similar to the one shown below is generated if you
select External (translation) tables or All on the entry panel.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 13:36:15

TABLE-ID: SAMPLE
A. TABLE INFORMATION:
TABLE DESCRIPTION:
BUILD OPTION:
STORAGE OPTION:
DATA SET ORGANIZATION:
INPUT FILE DDNAME:
LAST UPDATE BY:
DDF INFORMATION:

B.

C.

D.

F.

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED TABLE DEFINITIONS
__________________________

TRANSLATE LONG NUMBER TO SHORT NUMBER
FIRST LOOKUP
ACCESS MEMORY
SEQUENTIAL
LONGNUM
SAMPUSR
DATE: yy/mm/dd
USE DDF FIXED DATA DELIM 1 DELIM 2
_______ __________ _______ _______
NO

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: 0002185/*******

TIME: 15:11:54
DELIM 3 DELIM 4
_______ _______

DELIM 5
_______

ENCLS
_____

I/O PARAMETERS:
PARAMETER
PARAMETER NAME
REFERENCE FORMAT
DEC LEN
PARAMETER DESCRIPTION
_________ ________________________________________ _________ _______ ___ ___ ________________________________________
1 LONG NUMBER TO SHORT NUMBER
FEXT
COUNT
0
0 30-DIGIT NUMBER TO 8-DIGIT NUMBER
TABLE COLUMNS:
COLUMN
COLUMN NAME
FORMAT
DEC LEN ORDER
COLUMN DESCRIPTION
______ ________________________________________ _______ ___ ___ _____ ________________________________________
1 SHORT NUMBER
COUNT
0
0
1 8-DIGIT
2 LONG NUMBER
COUNT
0
0
0 30-DIGIT
LOOKUP RULES:
RULE RULE TYPE
LH OPERAND RH OPERAND
SELECTION TYPE
LITERAL/ACTION
TERM IND
NEXT TABLE
____ __________ __________ __________ __________________ ________________ ________ ________________
1 SELECTION: P001
C002
EQUAL TO
2 ASSIGN:
C001
P001
TABLE BUILD RULES:
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
1
10
12
NUMERIC INP
EQUAL TO
LIT
NO NO
NO
111222333444
222333444555
333444555666
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
2
10
31
NUMERIC INP
EQUAL TO
LIT
YES NO
NO
***SEE BELOW***
SELECT VALUE:
111222333444555666777888999000+
SELECT VALUE:
222333444555666777888999000111+
SELECT VALUE:
333444555666777888999000111222+
COLUMN ASSIGNMENT:
RULE POS
LEN DDF
FORMAT
TYPE
DATE FMT LH OPERAND RH OPERAND
LITERAL
____ ____ ___ ____ _______ _______ ________ __________ __________ ________________
3
10
31
NUMERIC COUNT
XV001
COLUMN ASSIGNMENT:
RULE POS
LEN DDF
FORMAT
TYPE
DATE FMT LH OPERAND RH OPERAND
LITERAL
____ ____ ___ ____ _______ _______ ________ __________ __________ ________________
4
10
31
NUMERIC COUNT
XV002
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
5
10
12
NUMERIC INP
GRT THAN EQ
LIT
NO NO
NO
111222333444
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
6
10
31
NUMERIC INP
GREATER THAN
LIT
YES NO
NO
***SEE BELOW***
SELECT VALUE:
111222333444555666777888999000+
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
7
1
16
PACKED
XV001
EQUAL TO
XV002
YES NO
NO
***SEE BELOW***
SELECTION CRITERIA:
RULE POS
LEN DDF FORMAT
LH OPR
SELECTION TYP RH OPR EXT BEGIN LOCATE
LITERAL
____ ____ ___ ____ _______ ______
_____________ ______ ___ _____ ______ ________________
8
1
16
PACKED
XV001
GREATER THAN
LIT
YES NO
NO
***SEE BELOW***
SELECT VALUE:
111222333444555666777888999000+
COLUMN ASSIGNMENT:
RULE POS
LEN DDF
FORMAT
TYPE
DATE FMT LH OPERAND RH OPERAND
LITERAL
____ ____ ___ ____ _______ _______ ________ __________ __________ ________________
9
10
6
NUMERIC COUNT
C001
COLUMN ASSIGNMENT:
RULE POS
LEN DDF
FORMAT
TYPE
DATE FMT LH OPERAND RH OPERAND
LITERAL
____ ____ ___ ____ _______ _______ ________ __________ __________ ________________
10
10
31
NUMERIC COUNT
C002
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Definition Database Listing: Detailed Spreadsheet (History Analysis)
Definitions
A detailed spreadsheet (history analysis) listing similar to the one shown
below is generated if you select History analysis or All on the entry panel.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 14:38:39

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED SPREADSHEET DEFINITIONS
________________________________

COPYRIGHT INFOGIX, INC.
PAGE 001
DATA BASE VERSION: 0000095/*******

SPREADSHEET ID:
RESULTS
1. SPREADSHEET INFORMATION.
DESCRIPTION:
FORMAT:
ROUND SUM RESULTS:
CYCLE TABLE ID:
CYCLE REFERENCE JSA:
VARIABLE CYC REFERENCE JSA:
NO. OF COLUMNS PER PAGE:
LAST UPDATE BY:
DECIMAL PROCESSING TYPE:
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 14.38.39

SALES RESULTS FROM PREVIOUS MONTH
JOB ID
NO

4
SAMPUSR
NEW

DATE: yy/mm/dd

TIME: 15:11:54

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
DSN=USERID.SUM.DEFN
DETAILED SPREADSHEET DEFINITIONS
________________________________

COPYRIGHT INFOGIX, INC.
PAGE 001
DATA BASE VERSION: 0000095/*******

SPREADSHEET ID:
TOTALS
1. SPREADSHEET INFORMATION.
DESCRIPTION:
FORMAT:
ROUND SUM RESULTS:
CYCLE TABLE ID:
CYCLE REFERENCE JSA:
VARIABLE CYC REFERENCE JSA:
NO. OF COLUMNS PER PAGE:
DECIMAL PROCESSING TYPE:
2. COLUMN DEFINITIONS.

QUARTERLY SALES REPORT
INTERNAL ITEM
NO

4
NEW

COL
DETAIL COL. INFO
SUM COL INFO
HDG
COL#
DESCRIPTION
TYPE
OPT.
INT. ITEM NBR
TYP BEG END DEC TYP
____ ______________________________________________________ _______ _____ __________________ ___ ___ ___ ___ _____
1 TOTAL
BAKERY
SALES
DETAIL
PRINT
001
TEXT
2 TOTAL
DELI
SALES
DETAIL
PRINT
002
TEXT
3 TOTAL
PRODUCE
SALES
DETAIL
PRINT
003
TEXT
4 TOTAL
MONTHLY
SALES
DETAIL
PRINT
004
TEXT
3. ROW DEFINITIONS.
ROW
--------DETAIL ROW INFO------SUM ROW INFO
HDG
ROW#
DESCRIPTION
TYPE
OPT.
JOB ID KEY
CYCLE#
TYP BEG END DEC TYPE
____ ________________________________________ _______ _____
__________________ __________ ___ ___ ___ ___ _____
1
DETAIL
PRINT
TOTALS STEP1
-003
TEXT
2
DETAIL
PRINT
TOTALS STEP1
-002
TEXT
3
DETAIL
PRINT
TOTALS STEP1
-001
TEXT
4
DETAIL
PRINT
TOTALS STEP1
+000
TEXT
4. ANALYSIS RULES.
----ANALYSIS WINDOW------------ANALYSIS PARAMETERS----------RULE
COLUMN #
ROW #
BASE
---TOLERANCE---RELATION LEGEND RETURN FORMAT
BEGIN END
BEGIN END
COL/ROW #
TYPE
QUANTITY
DEC
TYPE
CODE
CODE
IND
_____
_____ ___
_____ ___
___________ ____
_________ ___
________ ______ ______ ______
1
1
3
2
4
ROW
1
NONE
0
0
LE
!
3010
A

MOST
REC.
____
NO
NO
NO
NO
MOST
REC.
____
NO
NO
NO
NO

HDG
JUST
_____
CENTR
CENTR
CENTR
CENTR
HDG
JUST
_____
LEFT
LEFT
LEFT
LEFT

SPREADSHEET ID:
TOTALS
5. LEGEND CODE DEFINITIONS.
LEG# CODE
L E G E N D
T E X T
____ ____ ________________________________________________________________________________
1
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Cross-Reference Internal Items Utility
The Cross Reference Internal Items utility generates the Definition
Database Cross Reference Report for internal items, which shows where
internal (or extended internal) items are used so that you will know the
impact of changing an item.
Note:

When you complete the Library Information panel for this utility,
you need to enter the definition database on which you are
reporting.

Cross-Reference Internal Items Panel
Cross-Reference Internal Items
Job name: USERID___
Job
Start with: ________
End at: . . ________

F1=Help
F9=Swap

F2=Split

Step
________
________

Qualifier
__
__

F3=Exit

F5=Accept

Start with/End at. Job name, step name, and qualifier (if applicable) that
indicates the starting point and/or ending point of the range of definitions
to be cross-referenced. If you leave all fields blank, all jobs will be included.
If you fill in only the Start with field, only one job ID will be included.

Cross Reference Internal Items Report
This report is generated by running the Cross Reference Internal Items
utility. The output DDNAME will be UNIDXR.
For each internal item or extended internal item defined for a job ID, the
report lists the item’s description and any job ID that has a related item
number. Related items can include the following reference types: history
items, calculated items, rules, field items, and history analysis definitions.
If the internal item is referenced by a calculated item from another job, and
the referencing calculated item is also stored as an internal item in the same
job, the report prints an indicator (*) next to the calculated item and a note
at the end of the report.
For each related item, the report lists:

 Its value type (input, output, count, amount, text, or decimal positions).
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 Its reference type.
The TYPE column at the right margin of the report uses information
specified in the Internal Items (or Extended Internal Items) panel. It
consists of 3 characters indicating the following:

 First character. This field does not appear for extended internal items.
It identifies your entry in the Column field indicating in which column
on the Control Report the item will print: L = Left, R = Right,
C=Calculated Item

 Second character. It identifies your entry in the Format field: C =
Count, A = Amount, D = Date. T = Text

 Third character. If you selected Count or Amount in the Format field, it
shows the number of decimals for the item.
Example
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 16:16:27
JOB ID
ITEM#
------------------ ----ATEST
STEP1
I-001
ATEST

STEP1

I-002

ATEST
ATEST

STEP1
STEP1

I-003
I-004

ATEST

STEP1

I-005

ATEST
ATEST

STEP1
STEP1

I-006
X-001

ATEST

STEP1

X-002

ATEST

STEP1

X-003

ATEST
ATEST

STEP1
STEP1

X-004
X-005

ATEST

STEP1

X-006

INFOGIX, INCORPORATED
COPYRIGHT INFOGIX, INC
INFOGIX DATA BASE UTILITY
PAGE 001
DEFINITION DATA BASE CROSS REFERENCE REPORT
DATA BASE VERSION: 0000004/*******
DSN=USERID.SUM.DEFN
D E S C R I P T I O N / R E F E R E N C E S
------------------------------------------------------------------------------------------------------DESCRIPTION: TOTAL FOR JOHNSON AMOUNT 11111111112222TOTAL FOR JOHNSON AMOUNT 33333333334444 TYPE: LA2
REFERENCES: ATEST
STEP1
C-005*
ATEST
STEP1
R-010
DESCRIPTION: DOUGLAS SHORT TEXT
DOUGLAS SHORT TEXT
TYPE: LT0
REFERENCES: ATEST
STEP1
E-001
ATEST
STEP1
R-003
DESCRIPTION: TOTAL AMOUNT FOR JOHNSON COUNT
TOTAL AMOUNT FOR JOHNSON COUNT
TYPE: LC0
DESCRIPTION: DOUGLAS MED TEXT
DOUGLAS MED TEXT
TYPE: LT0
REFERENCES: ATEST
STEP1
E-006
DESCRIPTION: DOUGLAS AMOUNT
DOUGLAS AMOUNT
TYPE: LA2
REFERENCES: ATEST
STEP1
C-005*
DESCRIPTION: DOUGLAS COUNT
DOUGLAS COUNT
TYPE: LC0
DESCRIPTION: DOUGLAS LONG TEXT
DOUGLAS LONG TEXT
TYPE: T0
REFERENCES: ATEST
STEP1
E-005
DESCRIPTION: DOUGLAS SHORT TEXT 40
DOUGLAS SHORT TEXT 40
TYPE: T0
REFERENCES: ATEST
STEP1
E-004
ATEST
STEP1
R-001
ATEST
STEP1
R-002
ATEST
STEP1
R-004
ATEST
STEP1
R-005
DESCRIPTION: NELSON LONG NUMBER AMOUNT
NELSON LONG NUMBER AMOUNT
TYPE: A2
REFERENCES: ATEST
STEP1
R-010
DESCRIPTION: NELSON LONG NUMBER COUNT
NELSON LONG NUMBER COUNT
TYPE: C0
DESCRIPTION: NELSON 31 111111111112222222222233333333NELSON 31 444444444445555555555566666666 TYPE: A2
REFERENCES: ATEST
STEP1
E-007
DESCRIPTION: NELSON 30
NELSON 30
TYPE: A2
REFERENCES: ATEST
STEP1
C-009

* - THIS CALCULATED ITEM IS STORED AS AN INTERNAL ITEM. RUN THE CROSS REFERENCE UTILITY TO DETERMINE ANY INDIRECT REFERENCES.
***********************************************************END OF REPORT************************************************************
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Cross-Reference File Definitions Utility
The Cross Reference File Definitions utility generates the Definition
Database Cross Reference Report for file definitions, which shows where a
particular file definition is used. You can allocate a second file definition to
search against two databases. The output DDNAME will be UNIDXR.
Note:

When you complete the Library Information panel for this utility,
you need to enter the first, and optionally, the second definition
database on which you are reporting.

File Definitions Panel
File Definitions
File DDname
Start with: ________
End at: . . ________
F1=Help

F2=Split

Qualifier
__
__
F3=Exit

F5=Accept

F9=Swap

Start with. Optionally enter the File DDname and qualifier (if any) that
will be the starting point of the range of files to be displayed.
If you leave all fields on the panel blank, all files in the database will be
displayed. If you specified a second database, the report will include the
files from both databases.
If you complete only the Start with fields, only the files that exactly match
your entry will be displayed.
End at. Optionally enter the file name and qualifier (if any) that will be the
ending point of the range to be displayed. If you complete only the End at
fields, all files from the beginning of the database up to and including the
End at file will be displayed. If you specified a second database, the report
will include the files from both databases. The utility processes both
databases in the same manner.

Cross Reference File Definitions Report
This report lists all the file definitions used within the first database, and if
specified, the second database. The report allows you to find job definitions
that use the same file definitions.
The report displays the following information:

 File ID
 File description
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 Database name
 Job names that reference the file ID
The report uses an indicator (*) to show which file ID is referenced by
model definitions and an indicator (#) to show which file ID is referenced
by an alternate job.
Example
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 16:16:27

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE CROSS REFERENCE REPORT
FILE DEFINITIONS

COPYRIGHT INFOGIX, INC. 2013
PAGE 001
DATA BASE VERSION: 0000097/*******

0 FILE ID
D E S C R I P T I O N / R E F E R E N C E S
---------- ------------------------------------------------------------------------------------------------------------------------0FILE1A

DESCRIPTION: FILE 1 A
JOB1
FILEREF
JOB1R1 FILEREF
/JOB1
JOB1R2 FILEREF
/JOB1
JOB2
FILEREF
/FILE2A

DATABASE: USER01.SUM.DEFN
FILEREF
FILEREF
*

TYPE: PS

#
#

0FILE1A

DESCRIPTION: FILE 1 A
JOB1
TEST1
JOB2
TEST2
*

DATABASE: USER02.SUM.DEFN

TYPE: PS

0FILE2A

DESCRIPTION: FILE 2 A
JOB2
FILEREF

DATABASE: USER01.SUM.DEFN

TYPE: PS

* - USE FILE AS MODEL DEFINITIONS
# - ALTERNATE JOB/PRIMARY JOB
***********************************************************END OF REPORT************************************************************

506

Infogix, Inc.

Using the Batch Utilities  16
List Histories Utility

List Histories Utility
This utility generates the History Data Base Listing Report. This report can
be useful for viewing and analyzing the contents of your history database,
keeping an audit trail, and debugging. Four report types can be included:






Database History and Statistics
Index of ACR Histories
Summary of ACR Histories
History Data Detail Report

The documentation for this utility includes the following sections:

 “List Histories Panel” on page 507
 “History Data Base Listing Report” on page 508. This section describes
and illustrates the report types.

List Histories Panel
List Histories
Job name: USERID A
History database to list from:
USERID.SUM.HIST___________________________
Definition database to use as reference:
USERID.SUM.DEFN___________________________
Type of
2_ 1.
2.
3.
4.
5.

Report:
Statistics, index, summary, detail
Statistics, index, summary
Statistics, index
Statistics
Detail
Job
Step
Qualifier
Start with: -------- -------- -End at: . . ________ ________ __

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Field definitions:
Job name. Your default jobname, which you can optionally change.
History database to list from. The history database for which history
records will be listed. You can optionally change it.
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Definition database to use as reference. Definition database that will
be used as a reference in formatting the history records. You can optionally
change it.
Type of Report. To select a type, see the descriptions and samples in
“History Data Base Listing Report” on page 508.
Start with/End at. Job name, step name, and qualifier (if applicable) that
indicates the starting point and/or ending point of the range of definitions
to be included. If you leave both fields blank, history records for all jobs will
be included. If you only fill in the Start with field, history records for only
one job ID will be included.

History Data Base Listing Report
All report sections requested except the History Data Detail Report will be
combined and output with the DDNAME UNIHLR.
The History Data Detail information, if requested, is generated as a
separate report in your output with the DDNAME UNIHSTD.
Depending on the type of report you choose, the List Histories utility
generates the following report sections:






Database History and Statistics
Index of ACR Histories
Summary of ACR Histories
History Data Detail Report

See the examples of each report in the next section.
History Data Base Listing: Database History and Statistics
This section provides detailed information about an individual history
database. This includes the date and time of initialization and last update,
original estimated number of unique job IDs (specified when you initialized
the database), original average number of histories per job ID (specified
when you initialized the database), and number of histories in the database.
The original estimated number of unique job IDs and original average
number of histories per job ID information will be 0 unless the database
was initialized in Release 3.1 or higher.
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Used refers to the history records associated with the range of records
specified on the List Histories panel. If no range was specified, all records
in the history database are included.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 13:36:15

XYZ COMPANY
INFOGIX
DATA BASE UTILITY
HISTORY DATA BASE LISTING
DSN=USERID.SUM.DEFN
DATA BASE HISTORY AND STATISTICS
________________________________
DATE AND TIME OF INITIALIZATION:
DATE AND TIME OF LAST UPDATE:

07/09/15
08/01/29

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: *******/0000088

AT 09:13:13
AT 11:07:26

ORIGINAL ESTIMATED NUMBER OF UNIQUE JOB IDS:
ORIGINAL AVERAGE NUMBER OF HISTORIES PER JOB IDS:
NUMBER OF JOB ID KEYS:
MAXIMUM:
USED:
AVAILABLE:
NUMBER OF ACR HISTORIES (INCLUDING ADJUSTMENTS):
MAXIMUM:
USED:
AVAILABLE:

0
0

32
21
11
300
31
269

History Data Base Listing: Index of ACR Histories
This section lists every job ID in the history database along with the number
of histories (cycles) for each job ID.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 08:59:25

JOB ID
-----------------BOOKCLUBVERIFY
IFTHEN STEP1
SAMPLE UPDATE

XYZ COMPANY

NUMBER OF
HISTORIES
--------1
1
1

JOB ID
-----------------CARENTL COMPARE
JOBXYZ UPDATE
STATEOH SALES

HISTORY DATA BASE LISTING
DSN=USERID.SUM.DEFN
INDEX OF ACR HISTORIES
NUMBER OF
HISTORIES
JOB ID
-------------------------1
CLAIMS STEP1
5
JOBXYZ UPDATE TO
1
STATES SALES

COPYRIGHT INFOGIX, INC
DATA BASE VERSION: *******/0000056

NUMBER OF
HISTORIES
--------1
2
1

JOB ID
-----------------DOMESTICSALES
SALES
DAILY
TOTALS STEP1

NUMBER OF
HISTORIES
--------1
1
4

History Data Base Listing: Summary of ACR Histories
This section provides information about each Job ID in the history database
including cycle and run numbers, run date, run time, return code, and
status of reruns and/or updates.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 14:08:45
0
0
JOB ID
CYCLE#
------------------ -------FONSERV STEP1
20080830
20080830
IFTHEN STEP1
20080830
JOBXYZ UPDATE
20080830
JOBXYZ UPDATE TO 20080830
20080830
20080830

XYZ COMPANY
HISTORY DATA BASE LISTING
DSN=USERID.SUM.DEFN
SUMMARY OF ACR HISTORIES
RETURN
---LAST RERUN IF ANY--RUN# CODE STATUS RUN DATE RUN TIME
DATE
TIME
NO.
---- ------ ------ ---------- -------- ---------- -------- --000 3001
08/08/30
08:12:44
000 3001 ***UPD 08/08/30
08:12:43
000 0000
08/08/30
08:08:36
000 0000
08/08/30
07:49:04
000 0000
08/08/30
07:43:53
000 0000
08/08/30
07:45:12
000 0000
08/08/30
07:49:08

COPYRIGHT INFOGIX, INC
DATA BASE VERSION: *******/0000011

DATABASE
DEFN
------0000086
0000086
0000086
0000085
0000085
0000085
0000085

VERSION
HISTORY
------0000010
0000009
0000008
0000005
0000002
0000004
0000006

PROGRAM
NAME
-------UAC2000
UAC2000
UAC2000
UAC2000
UAC2000
UAC2000
UAC2000

History Data Base Listing: History Data Detail Report
This is a separate report generated when you select one of the options that
include Detail.
The DDNAME for the report in your output will be UNIHSTD.

ACR/Summary User Guide for z/OS

509

16  Using the Batch Utilities
Reprint Control Report Utility

This report shows either selected history records or every history record
and the values stored for it.
ACR/S releasenumber
XYZ COMPANY
DATE: yy/mm/dd
HISTORY DATA DETAIL
TIME: 13:08:56
HISTORY DATA BASE LISTING
<--JOB ID
---> CYCLE
RUN
RETURN CODE PROG NAME REC STAT
SAMPLE
REPORTS
00000001 000
1111
UAC2000
VALUES:
1:(
5700 )
2:(
6108 )
3:(
6:(
-1835 )
EXTENDED VALUES:
1:(773-745-9900
2:(HOME ABC
3:(MEGA ABC
4:(630-510-1685
5:(DISCOUNT XYZ
6:(630-483-2610
<--JOB ID
---> CYCLE
RUN
RETURN CODE PROG NAME REC STAT
SAMPLE
REPORTS
00000002 000
0000
UAC2000
VALUES:
1:(
5149 )
2:(
5190 )
3:(
6:(
-4160 )
EXTENDED VALUES:
1:(630-505-1800
2:(INFOGIX, INC.
3:(BANK XYZ
4:(773-376-4700
5:(FINANCIAL XYZ
6:(312-738-2204

COPYRIGHT INFOGIX, INC
REPORT ID: UT0501
PAGE
1
DATA BASE VERSION: 0000012/*******

-1032 )

4:(

6110 )

5:(

-758 )

)
)
)
)
)
)

-3869 )

4:(

5193 )

5:(

-1195 )

)
)
)
)
)
)

Reprint Control Report Utility
This utility reprints the (Balancing) Control Report for a job using control
values stored in the history database and rules stored in the definition
database. This enables you to generate the report without rerunning the
job.
Note:

XML generation of the Control Report is not supported by this
utility.

Because the definitions used are the current ones, if the definitions have
been modified since the original run, the Control Report results will differ
from those of the original run.
The documentation for this utility includes the “Control Report (Reprint)
Panel” on page 511.
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Control Report (Reprint) Panel
Control Report (Reprint)
Job name: USERID
Definition database: USERID.SUM.DEFN___________________________
History database:
USERID.SUM.HIST___________________________
Job name: ________ Step name: ________
Cycle number: ________ Run number: ___

F1=Help

F2=Split

F3=Exit

Qual: __

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Definition database. Should be the definition database containing the
definitions for the job ID you want to see on the Control Report. Change if
necessary.
History database. Should be the history database containing the
histories for the job ID you want to see on the Control Report. Change if
necessary.
Job name/Step Name/Qual. Job ID whose information you want to be
reprinted on the Control Report.
Cycle Number. Cycle number of the job whose information you want to
be reprinted on the Control Report.
Run number. Run number (if applicable) of the job whose information
you want to be reprinted on the Control Report.
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Print Management Report Utility
This report analyzes and prints the contents of the history database based
on user-defined selection criteria. Managers can use this utility to analyze
the functioning of the system. For example, they can run a report showing
all the return codes greater than 0 (all out-of-balance jobs) for a particular
time period. The criteria are shown on the panel below.
Note:

When you complete the Library Information panel for this utility,
in addition to the Dataset Name and Member Name fields, you
need to enter the names of the definition and history databases
to be used in the report.

The documentation for this utility includes the following sections:

 “Print Management Report Panel” on page 512.
 “Print Management Report” on page 514.

Print Management Report Panel
The Print Management Report panel displays.
Job name: USERID
Selection range for report:
From:
Return code: . . . . . ____
Job ID: . . . . . . . __________________
Absolute time: . . . . ___________
Relative time: . . . . ______
Absolute cycle ID: . . ___________
Relative cycle number: ___
Reference job ID: . . __________________

F1=Help

F2=Split

F3=Exit

To:
____
__________________
___________ (YYJJJHHMMSS)
______ (DDHHMM)
___________
___

F5=Accept

F9=Swap

Field definitions:
Note:

The From and To fields allow you to specify the range of job IDs that
will appear on the report. All of the selection range criteria work in
conjunction with one another. For example, you could print all jobs
starting with ABC to XYZ that ran in the last 24 hours with return
codes greater than 0.

Job name. Your default jobname, which you can optionally change.
Return Code. Range of return codes to be included.
Job ID. Range of job IDs to be included.
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Absolute time. Range of the absolute times to be included. Allows you to
print ad hoc reports on past activity. For example, you can print the results
for 05/01/08 to 06/01/08. 00000000000 is a valid entry for the From
field, and 99999999999 is a valid entry for the To field.
Note:

An entry in this field will cause the system to look for the latest run or
rerun dates in the specified period. For example, suppose your
history database has one job with an initial run date of 07/001 and a
rerun date of 07/091, and another job with an initial run date of 07/
091 and a rerun date of 07/121. Setting an Absolute time range of
07090000000 to 07100000000 will cause the system to include only
the first job.

Relative time. Range of relative times to be included. Allows you to set up
a job that can be run repeatedly. For example, you can set up a report to
print every morning that lists the results for the past 24 hours.
Note:

An entry in this field will cause the system to look for both run dates
and re-run dates in the specified period. For example, suppose your
history database has one job with an initial run date of 98/001 and a
rerun date of 98/091, and another job with an initial run date of 98/
091 and a rerun date of 98/121. If the current date is 98/151, setting
a Relative time range of 500000 to 700000 will cause the system to
include both jobs.

Absolute Cycle ID. Range of the absolute cycle IDs to be included. Allows
you to print the results for a particular cycle regardless of the real time it
actually ran. If you enter a cycle number in the From field but use the
default (0) in the To field, only the information on the cycle in the From
field will print. Enter cycle numbers exactly as stored in the history
database. Otherwise, the century value will be populated with zeros and the
cycle range may be invalid.
Relative Cycle number. Range of relative cycle numbers to be included.
For example, you could specify to print the +000 cycle to the -001 cycle to
get the last two runs of each key.
Reference Job ID. Reference cycle job ID to be referenced.
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Print Management Report
The DDNAME for the report in your output will be UNIMR.
Balancing Summary (Print Management) Report (Page 1 of 2)
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 09:33:43
SELECTION CRITERIA:

DATA BASE:

XYZ COMPANY
INFOGIX
DATA BASE UTILITY
INFOGIX
BALANCING SUMMARY
PARAMETER
---------------------------------RETURN CODES
JOB ID KEYS
ABSOLUTE TIME (YY:JJJ:HH:MM:SS)
RELATIVE TIME (DD:HH:MM)
ABSOLUTE CYCLE-ID
RELATIVE CYCLES
CYCLE REFERENCE JOB ID
DEFINITIONS = YOURFILE.SUM.DEFN
HISTORY
= YOURFILE.SUM.HIST

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: 0000086/0000010

FROM
TO
-------------------- -------------------0000
9999
ALL
ALL
ALL
ALL
ALL
NONE

Balancing Summary (Print Management) Report (Page 2 of 2)
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 09:33:43
JOB ID
-----------------FONSERV STEP1
IFTHEN STEP1
JOBXYZ UPDATE
JOBXYZ UPDATE TO

XYZ COMPANY
INFOGIX
DATA BASE UTILITY
INFOGIX
BALANCING SUMMARY
RETURN
ACR REPORT TITLE
CYCLE
RUN
CODE
RUN DATE
---------------------------------------- -------- --- ------ -------TOTAL COMPARISONS
20080330 000
3001
08/03/30
BIMONTHLY SALES REPORT
20080515 000
0000
08/05/15
MONTHLY FILE UPDATE SYSTEM
20080601 000
0000
08/06/01
MONTHLY FILE UPDATE SYSTEM
20080601 000
0000
08/06/01
10000000 000
0000
08/08/30
10000001 000
0000
08/08/30

COPYRIGHT INFOGIX, INC
PAGE 002mm
DATA BASE VERSION: 0000086/0000010
RUN TIME
-------08:12:43
08:08:36
07:49:04
07:43:53
07:45:12
07:49:08

RERUNS
-----0
0
0
0
0
0

ADJ
---

RESULTS
--------------OUT OF BALANCE
IN BALANCE
IN BALANCE
IN BALANCE
IN BALANCE
IN BALANCE

Print Control Update Information Report Utility
This utility prints a report of the most recent updates to definitions from the
definition database, including the ID associated with the change and the
date and time of the change in yy/mm/dd format. You can limit the listing
based on definition type and date.
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Control Update Information Report Panel
Control Update Information Report
Job name: USERIDA
Definition database to list from:
USERID.DET.DEFN___________________________
Specify
__ 1.
2.
3.
4.
5.
6.
7.

type of definitions to list:
Jobs
Files
History analyses
Internal/Cycle tables
External tables
All definitions
Job and associated Files

Date (YYMMDD) From: ______
F1=Help

F2=Split

F3=Exit

To: ______
F5=Accept

F9=Swap

Job name. This displays your default jobname, which you can optionally
change.
Definition database to list from. This displays the definition database
for which definition updates will be listed. You can optionally change it.
Specify type of definitions to list. This enables you to restrict the type
of definition updates to list:

 All definitions. The report will list updates for all definition types.
 Any other option. The report will list updates for the selected type of the
definition.
Note:

The Job and associated files option allows you to list updates to
batch transaction definition records for all or selected job definitions
and for their associated input source files at the same time.

Date (YYMMDD) From/To. If you want to limit the report to a specific
date, complete the From field. To limit the report to a range of dates,
complete the To date also.
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Control Update Information Report
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 11:49:02

XYZ COMPANY
INFOGIX DATA BASE UTILITY
DEFINITION DATA BASE LISTING
CONTROL UPDATE INFORMATION
DSN=R99UC47.SUM.DEFN
FROM DATE: yy/mm/dd
TO DATE: yy/mm/dd
ID
TYPE
LAST UPDATE BY
-------------------------------------------------------------------------DDF2
AM5
JOB
DDF3
AM1EMB
JOB
DDF4
AM1REF
JOB
DDF5
AM4REL
JOB
DDF5
AM4REL
USER REPORT
UserId
DDF2F1
000000
FILE
DDF3F1
000000
FILE
DDF4F1
000000
FILE
DDF5F1
000000
FILE
ABC
CYCLE TABLE
EXTBTXEQ
EXT TRAN TABLE
JIRA3090ETTA
EXT TRAN TABLE
JIRA3090ETTB
EXT TRAN TABLE
NAME TRANSLATION
INT TRAN TABLE
UBS-DELIM-DATES
EXT TRAN TABLE
YEARCNV1NUM
EXT TRAN TABLE
COMCALLSTEP1
HISTORY ANALYSIS
DDF
HISTORY ANALYSIS
UserId
HA1397
HISTORY ANALYSIS
SCR2180R1
HISTORY ANALYSIS
VOLANALAR1
HA REPORT

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: 0000996/*******

DATE
--------

TIME
--------

yy/mm/dd

12:56:33

yy/mm/dd

12:56:33

Delete History Utility
This utility can delete one or multiple history records by job ID, cycle, and
date. Wildcards can be used in the Job ID From field to select multiple job
IDs.
Delete history can be used for the following situations:






A job ran that was not scheduled to run.
A job ran with the wrong cycle number.
A job ran in the wrong order.
A job ID in your history database is no longer needed.

Note:

Delete history performs a logical delete. The physical history records are
not removed from the file until the Reorganize history utility is executed.

The documentation for this utility includes the “Delete History Panel” on
page 517.
This utility generates the Transaction Listing Report. The DDNAME for the
report in your output will be UNITR. For more information, see
“Transaction Listing Report” on page 546.
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Delete History Panel
Delete History
Job name: USERID__
History database: TEST1.SUM.HIST____________________________
Delete:
Job ID From:
To:
Cycle From:
To:
Date
From:
To:

________
________
________
________
________
________

Dual History Database:
F1=Help

F2=Split

________
________
___
___

__
__

Wildcard: _

__________________________________________
F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
History database. Database from which history is to be deleted. Entries
under the Delete heading will be combined to select one or multiple history
records for deletion based on job ID, cycle ID, and date.
Job ID From. Optionally enter a job name, step name and qualifier (if
any). In this field only, you can optionally use a character that you specify
in the Wildcard field in any of the 18 field positions (job name, step name,
and qualifier), enabling you to select multiple job IDs. Each wildcard is
specific to its location and represents any character in that position. For
example, the Job ID mask ABCD************** represents any Job ID
starting with ABCD (i.e. a job prefix). The Job ID mask A*C***************
represents any Job ID starting with A and having a C in the third position.
Wildcards can be used only if you leave the Job ID To field blank. The
following characters are not supported:
& (ampersand)
^ (caret)
. (period)
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You can leave the Job ID From field blank, as noted below.
Note:

Using From and To combinations for Job ID, Cycle, and Date:
If both From and To are left empty, all records for that Job ID, Cycle,
or Date will be candidates for deletion.
If both From and To are completed, only records within that range
will be candidates for deletion.
If only From is completed, that one job ID, job ID mask, cycle, or
date will be a candidate for deletion. Because a mask uses wildcard
characters, one job ID mask can be used to select multiple job IDs
as candidates for deletion.
If only To is completed, records prior to and including that job ID,
cycle, or date will be candidates for deletion.

Wildcard. Wildcard character if you want to use wildcards in the Job ID
From field, as explained in the note above.
Job ID To. Complete if you want to specify the end of range of job IDs or
if you want to select all job IDs prior to and including the specified job ID,
as explained in the note on Using From and To combinations for Job ID,
Cycle, and Date above.
Cycle From. Complete if you want to specify one specific cycle or you want
to specify the beginning of a range of cycles, as explained in note on Using
From and To combinations for Job ID, Cycle, and Date above. If you
complete only the cycle number portion of the field, all run numbers for
that cycle number will be selected. Enter the cycle ID exactly as it is stored
in the history database.
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Cycle To. Complete if you want to specify the end of a range of cycles or if
you want to select records for all cycles prior to and including the specified
cycle ID, as explained in the note on Using From and To combinations for
Job ID, Cycle, and Date above. If you complete only the cycle number
portion of the field, all run numbers for that cycle number will be selected.
Enter the cycle ID exactly as it is stored in the history database.
Date From. Enter a date in Gregorian format if you want to select records
for one date or you want to specify the beginning of a range of dates, as
explained in the note on Using From and To combinations for Job ID,
Cycle, and Date above.
Date To. Enter a date in Gregorian format if you want to specify the end of
a range of dates or if you want to delete records for dates prior to and
including the specified date, as explained in the note on Using From and
To combinations for Job ID, Cycle, and Date above.
Dual History Database. Complete if you want the same information to
be deleted from the dual history database. If you are keeping a dual history
you most likely will want to keep it in sync with the primary history
database. If you want to delete only information from the dual history
database, change the name in the History Database field to that of the dual
history database.

Update History Database Utility
This utility updates (i.e., replaces) one or more control values in the history
database for a specified job ID and cycle ID. It can be used to correct outof-balance situations when you have the proper data to run your job.
The documentation for this utility includes the “Update History Panel” on
page 520
This utility generates the Transaction Listing Report. The DDNAME for the
report in your output will be UNITR. For more information, see
“Transaction Listing Report” on page 546.

ACR/Summary User Guide for z/OS

519

16  Using the Batch Utilities
Copy History Database Utility

Update History Panel
Update History
Job name: USERID__
History database: USR1.SUM.HIST_____________________________
Job name: ________ Step name: ________ Qual: __
Cycle number: ________ Run number: ___
Update:
Internal item number: I ___
New value: _________________________________________
_________________________________________
Internal item number: I ___
New value: _________________________________________
_________________________________________
Internal item number: I ___
New value: _________________________________________
F1=Help
F2=Split
F3=Exit
F5=Accept F9=Swap

Job name. Your default jobname, which you can optionally change.
History database. Verify or change the history database to be updated.
Job name/Step Name/Qual. Job ID whose information you want to
update.
Cycle number. Cycle number of the job whose information you want to
update.
Run number. Run number (if applicable) of the job whose information
you want to update.
Internal Item Number. Identify the internal item or extended internal
item to be updated. Complete this 2-part field with the following:

 1-digit item type indicator (I for internal item or X for extended internal
item).

 3-digit item number.
New value. The new value (text or a positive or negative number) to be
stored in the internal item.

Copy History Database Utility
This utility copies history records based on the option you choose in the
Copy History panel. You can specify up to five items to update.
The documentation for this utility includes the following sections:

 “Copy History Panel” on page 521
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“Copy All Records Panel” on page 522
“Copy Selected History Panel” on page 522
“Unload History Panel” on page 523
“Reload History Panel” on page 524
“History Database Report” on page 525

All Copy History options generate the Transaction Listing Report. The
DDNAME for the report in your output will be UNITR. For more
information, see “Transaction Listing Report” on page 546.

Copy History Panel
Copy History
Choose an option:
__ 1. Copy all records
2. Copy selected records
3. Unload records to a work file
4. Reload records from a work file

F1=Help

F2=Split

F3=Exit

F9=Swap

Choose an option. When you make your selection, the appropriate panel
displays as shown on the following pages. For more information, see the
following sections:
“Copy All Records Panel” on page 522
“Copy Selected History Panel” on page 522
“Unload History Panel” on page 523
“Reload History Panel” on page 524

Note:

 If you choose Unload records to a work file, when you
complete the Library Information panel for the utility, you need
to enter the DSName of the sequential work file to which the
records will be unloaded along with the associated Volume
and Unit.
 If you choose Reload records to a work file, when you
complete the Library Information panel for the utility, you need
to enter the DSName of the sequential work file from which
the records will be reloaded.
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Copy All Records Panel
Copy All Records
Job name: USERID
Copy from history database:
DSName: USERID.SUM.HIST___________________________
Copy to history database:
DSName: __________________________________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Copy from history database. Verify or change the name of the DSName
for the history database to copy from.
Copy to history database. Enter the name of the DSName for the history
database to copy to. This database must already have been defined and
initialized.

Copy Selected History Panel
This option allows you to copy a test job into a production database. In this
way you could copy a particular day/week/month’s activities from one
database to another. You can also use this utility for debugging purposes.
Copy Selected History
Job name: USERID
Copy from history database:
DSName: USERID.SUM.HIST___________________________
Copy to history database:
DSName: __________________________________________
Job
Start with: ________
End at: . . ________
From:
To:

YR
__
YR
__

F1=Help

MO
__
MO
__

DA
__
DA
__

F2=Split

Step
________
________
HR
__
HR
__

MN
__
MN
__

Qualifier
__
__

SE
__
SE
__

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
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Copy from history database. Optionally change the DSName of the
history database to copy from.
Copy to history database. Enter the DSName of the history database to
copy to. This database must already exist and be initialized.
Start with/End at. Job ID that indicates the starting point and ending
point of the range of definitions to be included.
From/To. Beginning/end of the range of run dates and times of the
histories to be copied. Use the format YYMMDDHHMMSS. Valid values for
HH are 00-23. If the job has been rerun, the date and time of the rerun are
used.

Unload History Panel
This panel displays when you select Unload records to a work file. Use this
option to:

 Backup/restore your files.
 Move a history database from one CPU to another.
 Create a tape to send to technical support.
Unload History
Job name: USERID
Unload from history database:
DSName: USERID.SUM.HIST___________________________
Unload to sequential work file:
DSName: __________________________________________
Volume: ______ Unit: SYSALLDA
Job
Start with: ________
End at: . . ________
From:
To:

YR
__
YR
__

F1=Help

MO
__
MO
__

DA
__
DA
__

F2=Split

Step
________
________
HR
__
HR
__

MN
__
MN
__

Qualifier
__
__

SE
__
SE
__

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Unload from history database. Optionally change the name of the
history database to unload from.
Unload to sequential work file. Sequential file to unload to.
Volume. Volume serial number on which the sequential file will be placed.

ACR/Summary User Guide for z/OS

523

16  Using the Batch Utilities
Copy History Database Utility

Unit. Unit where the sequential file will be stored.
Start with/End at. Job ID that indicates the beginning/ending record of
the range to be unloaded.
From/To. Beginning/end of the range of run dates and times of the
histories to be copied. Use the format YYMMDDHHMMSS. Valid values for
HH are 00-23. If the job has been rerun, the date and time of the rerun are
used.

Reload History Panel
Warning:

The Copy History reload option opens and closes the history
database only once, which speeds up processing time
significantly.
Because the history file will not be opened and closed for each
record, to ensure the integrity of the file, you MUST lock the
history file before starting a reload and unlock the file after the
reload is complete. For instructions on locking and unlocking,
see Lock or Free History Database Utility on page 545.

This panel displays when you choose Reload records from a work file. You
would use this if you had already unloaded from one history database and
were ready to reload to the same or another history database.
Reload History
Job name: USERID
Reload from sequential work file:
DSName: __________________________________________
Reload to history database:
DSName: USERID.SUM.HIST___________________________
Job
Start with: ________
End at: . . ________
From:
To:

YR
__
YR
__

F1=Help

MO
__
MO
__

DA
__
DA
__

F2=Split

Step
________
________
HR
__
HR
__

MN
__
MN
__

Qualifier
__
__

SE
__
SE
__

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Reload from sequential work file. Enter the name of the file to reload
from. This file must have been previously populated using the Unload
utility.
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Reload to history database. Optionally change the name of the history
database to reload to.
Start with/End at. Job ID that indicates the beginning/ending record of
the range to be reloaded.
From/To. Beginning/end of the range of run dates and times of the
histories to be copied. Use the format YYMMDDHHMMSS. Valid values for
HH are 00-23. If the job has been rerun, the date and time of the rerun are
used.

History Database Report
For all Copy History options, with the exception of Copy all records, the
History Database Report is generated.
The DDNAME for this report in your output will be UNIHTR. The examples
below show the output for each of the options above.
History Database Copy Report - Summary of Histories Copied
When you run Copy History with the Copy Selected Records option, the
report lists each history record copied with information about the record.
The following is an example:
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:01:11

XYZ COMPANY
INFOGIX
DATA BASE UTILITY
HISTORY DATA BASE COPY REPORT
SUMMARY OF HISTORIES COPIED

FROM: USR1.SUM.HIST
RETURN
CODE
---0000
0000

JOB ID
CYCLE# RUN#
------------------ -------- --SALES
DAILY
20080501 000
SALES
DAILY
20080502 000

RUN DATE
-------08/05/01
08/05/02

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: *******/0000015

TO: USR1.SUM.HISTC
RERUN
RERUN
DATABASE VERSION PROGRAM
RUN TIME TYPE
DATE
TIME
DEFN /HISTORY
NAME
-------- ------ -------- -------- ---------------- -------14:59:21
0000095 0000013 UAC2000
15:00:33
0000095 0000014 UAC2000

History Database Unload Report - Summary of Histories Unloaded
When you run Copy History with the Unload records to a work file option,
the report lists each history record unloaded with information about the
record. The following is an example:
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:08:57
FROM: USR1.SUM.HIST
RETURN
CYCLE# RUN# CODE
-------- --- ---20080204 000 3010
20080204 000 0000
20080205 000 0000
20080205 000 0000
20080203 000 0000
20080204 000 0000
20080303 000 0000
20080401 000 0000
20080502 000 0000

JOB ID
-----------------JOBXYZ UPDATE
JOBXYZ UPDATE TO
JOBXYZ UPDATE
JOBXYZ UPDATE TO
FLYER
DAILY
FLYER
DAILY
CARENTL COMPARE
SALES
DAILY
SALES
DAILY

RUN DATE
-------08/02/04
08/02/04
08/02/05
08/02/05
08/02/03
08/02/04
08/03/03
08/04/01
08/05/02

XYZ COMPANY
COPYRIGHT INFOGIX, INC
INFOGIX
DATA BASE UTILITY
PAGE 001
HISTORY DATA BASE UNLOAD REPORT
DATA BASE VERSION: *******/0000015
SUMMARY OF HISTORIES UNLOADED
TO: USR1.SUM.HISTC
RERUN
RERUN
DATABASE VERSION PROGRAM
RUN TIME TYPE
DATE
TIME
DEFN /HISTORY
NAME
-------- ------ -------- -------- ---------------- -------07:44:34
0000093 0000002 UAC2000
07:44:38
0000093 0000003 UAC2000
07:53:04
0000094 0000004 UAC2000
07:53:08
0000094 0000005 UAC2000
08:50:08
0000094 0000007 UAC2000
08:51:48
0000094 0000009 UAC2000
14:57:48
0000095 0000012 UAC2000
14:59:21
0000095 0000013 UAC2000
15:00:33
0000095 0000014 UAC2000
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History Database Reload Report - Summary of Histories Reloaded
When you run Copy History with the Reload records from a work file
option, the report lists each history record reloaded with information about
the record. The following is an example:
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:11:18
FROM: USR1.SUM.HISTW
RETURN
CYCLE# RUN# CODE
-------- --- ---20080503 000 0000
20080503 000 0000
20080504 000 0000
20080504 000 3010
20080505 000 0000
20080505 000 0000
20080505 000 0000
20080506 000 0000
20080506 000 0000

JOB ID
-----------------CARENTL COMPARE
FLYER
DAILY
FLYER
DAILY
JOBXYZ UPDATE
JOBXYZ UPDATE
JOBXYZ UPDATE TO
JOBXYZ UPDATE TO
SALES
DAILY
SALES
DAILY

RUN DATE
-------08/05/03
08/05/03
08/05/04
08/05/04
08/05/05
08/05/05
08/05/05
08/05/06
08/05/06

XYZ COMPANY
COPYRIGHT INFOGIX, INC
INFOGIX
DATA BASE UTILITY
PAGE 001
HISTORY DATA BASE RELOAD REPORT
DATA BASE VERSION: *******/*******
SUMMARY OF HISTORIES RELOADED
TO: USR1.SUM.HIST
RERUN
RERUN
DATABASE VERSION PROGRAM
RUN TIME TYPE
DATE
TIME
DEFN /HISTORY
NAME
-------- ------ -------- -------- ---------------- -------14:57:48
0000095 0000012 UAC2000
08:50:08
0000094 0000007 UAC2000
08:51:48
0000094 0000009 UAC2000
07:44:34
0000093 0000002 UAC2000
07:53:04
0000094 0000004 UAC2000
07:44:38
0000093 0000003 UAC2000
07:53:08
0000094 0000005 UAC2000
14:59:21
0000095 0000013 UAC2000
15:00:33
0000095 0000014 UAC2000

Reorganize History Utility
This utility reorganizes the contents of a history database in place or
reorganizes data into a new history database. This utility also removes
logically deleted records from the database. Based on the structure of the
database, we suggest you run this utility regularly to ensure optimum
processing efficiency.
If you reorganize into a new database, you can reorganize into a larger,
smaller, or same size database. If you choose a database smaller than your
current one, be sure the smaller database has been initialized with enough
Estimated number of unique job IDs to match the number of unique
job IDs contained in the current database. Also ensure that the product of
this number and the Average number of histories per job ID will be
able to accommodate the total number of histories in the current database.
See “Reorganize History (Into a New Database) Panel” on page 527.
You can run the Reorganize History Utility when you run the Lock History
Database Utility, which locks the history database and prevents other jobs
from being executed. After running the Reorganize History Utility,
remember to free the history database. Refer to “JCL to Lock the History
Database” on page 545 and “JCL to Free the History Database” on page 546
for information on how to lock and free the history database.
The documentation for this utility includes the following sections:

 “Reorganize History Panel” on page 527
 “Reorganize History (Into a New Database) Panel” on page 527
 “History Database Reorg Report” on page 528
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Reorganize History Panel
Reorganize History
Choose an option:
__ 1. Reorganize data in history database
2. Reorganize data into a new history database

F1=Help

F2=Split

F3=Exit

F9=Swap

Enter the option you want. If you choose option 2, you will need to complete
the panel shown below.

Reorganize History (Into a New Database) Panel
Reorganize History (Into a new database)
Reorganize data from:
DSName: USERID.SUM.HIST___________________________
Place reorganized data into:
DSName: __________________________________________
Managementclass: ________ Storageclass: ________
Dataclass: ________ Volume: ______
Estimated number of unique job IDs: . . 00000050 (1-99999999)
Average number of histories per job ID: ___ (1-999)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Reorganize data from DSName. Optionally change the dataset name
(DSName) of the history database to reorganize data from.
Place reorganized data into DSName. Database that will become the
new, relocated, and reorganized version of the history database.
Managementclass/Storageclass/Dataclass/Volume. For the
reorganized history database, complete any combination of the
Managementclass, Storageclass, Dataclass, and Volume fields that is valid
at your site.
Estimated number of unique job IDs. Estimated number of unique
job IDs that you anticipate storing in the reorganized history database. This
number is used for calculating DASD space requirements. This is typically
larger than the original database parameters. The field defaults to 10.
Average number of histories per job IDs. Average number of
histories per job ID that you anticipate will be stored in the reorganized
history database. This field is multiplied by the number entered for
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estimated number of unique job IDs to determine the size of the history
database. This in combination with the previous field is typically larger than
the original database parameters. This field defaults to 10.

History Database Reorg Report
This report is generated when you run the Reorganize History utility.
The DDNAME for the report in your output will be UNIHRR.
The report lists the including Job ID, Cycle Number, Run Number, etc. for
logical records deleted. The report will be blank if no logical records were
marked for deletion when the reorg was run.
Example
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 16:25:38

INFOGIX, INCORPORATED
INFOGIX DATA BASE UTILITY
HISTORY DATA BASE
REORG REPORT

COPYRIGHT INFOGIX, INC
PAGE 001
DATA BASE VERSION: *******/0000163

SUMMARY OF DROPPED ACR HISTORIES
RETURN
JOB ID
CYCLE# RUN# CODE
------------------ -------- ---- -----CLIFF
SU
20080206 000 0000
FREEFORMSTEP01
20080331 000 3003
INVENTORCLAS01 01 20080401 000 3081
MISCITEMSTEP01
20080406 000 0000

RUN DATE
---------2008/02/06
2008/03/31
2008/04/01
2008/04/06

RUN TIME
-------08:59:23
09:51:30
10:25:35
11:59:23

TYPE
-----***DEL
***UPD
***UPD
***DEL

DATABASE
DEFN
------0000595
0000594
0000532
0000595

VERSION
HISTORY
------0000024
0000020
0000019
0000024

PROGRAM
NAME
-------UAC2000
ADSRAXAA
UAC2000
UAC2000

LOAD LIBRARY
---------------------------------------R99UC02.LOADLIB
TSO.LINKLIB
UNI.UNISEC.PLUS.C24.B04
R99UC02.LOADLIB

Archive/Restore History Utility
This utility allows you to do the following:

 Establish a generation data group (GDG) using IBM IDCAMS utility.
 Archive data from a database to sequential archive files. The archived
history records are marked to ensure they will not be re-archived.

 Restore archived sequential files by copying them to a new history
database.
The documentation for this utility includes the following sections:
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“Archive/Restore History Panel” on page 529
“Archive File-IDCAMS Panel” on page 529
“Archive History Panel” on page 530
“Archive File Layout” on page 531
“Restore History Panel” on page 532
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Archive/Restore History Panel
Archive/Restore History
Choose an option:
__ 1. Establish archive generation data group (GDG)
2. Archive history
3. Restore history
F1=Help

F2=Split

F3=Exit

F9=Swap

Choose an option. Enter the option you want and the corresponding
panel will be displayed:
1. Establish archive generation data group (GDG). See "Archive File-

IDCAMS Panel" below.
2. Archive history. See “Archive History Panel” on page 530.
3. Restore history. See “Restore History Panel” on page 532.

Archive File-IDCAMS Panel
c

Archive File-IDCAMS
Job name: USERID
Archive file to:
DSName: __________________________________________
Number of generations to keep: 010 (1 to 255)

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Archive file to DSName. Dataset name of the file that the ACR/
Summary database will be copied to.
Number of generations to keep. Number of generations of the archive
file to keep.
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Archive History Panel
This panel displays when you choose Archive history from the Archive/
Restore History panel.
Archive History
Job name: USERID
Archive records from:
DSName: USERID.SUM.HIST___________________________
Archive records to:
DSName: __________________________________________
Managementclass: ________ Storageclass: ________
Dataclass: ________ Volser: ______ Unit: SYSALLDA
DSCB model: __________________________________________
Job
Start with: ________
End at: . . ________

F1=Help

F2=Split

Step
________
________

F3=Exit

Qualifier
__
__

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Archive records from DSName. Optionally change the name of the
database to archive from.
Archive records to DSName. Name of the file that will hold the
archived records.
Managementclass, Storageclass, Dataclass. For the archive history
database, complete any combination of the Managementclass,
Storageclass, and Dataclass fields that is valid at your site.
Volser. Volume serial number of the storage device where your archive file
will reside.
Unit. DASD unit that will store the file.
DSCB model. A zero-track VTOC entry required only in non-SMS
managed sites to control DCB consistency.
Start with/End at. Job IDs that indicates the starting point and ending
points of the range of history records to be archived.
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Archive File Layout
Archive File Header Record Layout
Fld #

Description

Position

Length

Format

Value

1

Record Type

1

1

9(1)

0

2

Reserved

2-210

209

X(209)

Blanks

3

Archive Date

211-214

4

9(4)

Packed

4

Archive Time

215-218

4

X(4)

Packed

5

Reserved

219-222

4

X(4)

0400

6

Reserved

223-9200

8978

X(8978)

Blanks

Archive File Detail Record Layout
Fld #

Description

Position

Length

Format

Value

1

Record Type

1

1

9(1)

1

2

Job ID

2-19

18

X(18)

3

Cycle Number

20-25

6

9(6)

4

Reserved

26-28

3

X(3)

5

Record ID

29-32

4

9(4)

6

Filler

33-210

178

X(178)

7

Run Date

211-214

4

9(6)

Packed

8

Run Time

215-218

4

9(6)

Packed

9

Load Library Name

219-262

44

X(44)

10

Program Name

263-270

8

X(8)

11

Reserved

271-275

4

X(4)

12

ACR Return Code

275-278

4

X(4)

13

Internal Items 1-100

279-1078

800

100 x(8)

14

Reserved

1079-1200

122

Reserved

15

Extended Internal Items 1100

1201-9200

8000

100 X(80)
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Restore History Panel
This panel displays when you choose Restore history from the Archive/
Restore History panel. This utility is used to reload records from an
archived file. Archived history records may be used to retain balancing
histories and control values for the long term. This may be necessary, for
example, to satisfy government regulations or to provide a time series for
use in an analysis function or in other statistical reporting packages.
Restore History
Job name: YOURJOBA
Restore records from:
DSName: __________________________________________
GDG:
+000
Restore records into:
DSName: USERID.SUM.HIST___________________________
Estimated number of unique job IDs: . . 00000100 (1-99999999)
Average number of histories per job ID: 010 (1-999)
Job
Start with: ________
End at: . . ________

F1=Help

F2=Split

Step
________
________

F3=Exit

Qualifier
__
__

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Restore records from DSName. Name of the archive file that contains
the history records to be restored.
GDG. Number of the generation data group to be restored. +000 is the
most recent.
Restore records into DSName. Name of the history database that will
be created and updated.
Estimated number of unique job IDs field. Optionally change. This
number is used for calculating DASD space requirements.
Average number of histories per job ID. Optionally change. This field
is multiplied by the number entered for estimated number of unique job
IDs to determine the size of the target history database.
Start with/End at. Job ID that indicates the starting point and ending
point of the range of history records to be restored.
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Extract History Utility
This utility enables you to enter a number of user-defined criteria and
extract records from the history database to a physical sequential file using
one of two options:

 Packed format. Use this option to extract history records for 1) auditing
or historical purposes or 2) to transfer the data to an application that
requires comma-delimited format. For 2), after the extraction, you
must run a second utility to convert the extracted data to commadelimited format. See “Create Comma Delimited Text File Utility” on
page 543.

 Unpacked (alternate) format. Use this option to create an extract file
using unpacked data in order to easily move history data to another
platform or product. You can optionally specify a platform identifier, a
relative date indicator, and a cycle date format indicator. The file can be
used with other Infogix, Inc. products to view the history records in a
web browser.
Regardless of the option you use, the data extracted includes the job ID
used to store the history, its cycle ID, its overall return code, and the
internal item values stored.
This utility generates the Transaction Listing Report. For more
information, see “Transaction Listing Report” on page 546.
The documentation for this utility includes the following sections:







“(First) Extract History Panel” on page 534
“(Second) Extract History Panel (Packed Format)” on page 535
“Optional Alternate Format Parameters Panel” on page 536
“Extract History File (Packed) Layout” on page 537
“Extract History File (Alternate) Layout” on page 538
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(First) Extract History Panel
Extract History
Job name: USERID
Extract records from:
DSName: USERID.SUM.HIST___________________________
Extract to work file:
DSName: __________________________________________
Start with:
Job name: ________ Step name: ________
Cycle number: ________ Run number: ___
Generic terminator: *
End at:
Job name: ________ Step Name: ________
Cycle number: ________ Run number: ___

Use alternate format (EXTWV):
F1=Help

F2=Split

F3=Exit

N

Qual: __

Qual: __

(Y/N)
F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Extract records from DSName. Optionally change the name of the
dataset from which the records will be extracted.
Extract to work file DSName. Name of the dataset which will store the
extracted records.
Start with/End at. Job ID, cycle number, and run number that indicate
the starting point and/or ending point of the range of definitions to be
included. The cycle number and run number are not required, but if you
complete one of these fields, you must complete both.
You can use a generic terminator in any of the Start with fields as
described below.
Generic terminator. The character specified here (you can change it) can
be used as follows:

 At the end of a string of alphanumeric characters in the Start with:
Job Name, Step Name, and/or Qualifier fields to extract all job IDs
that begin with the string. For example, if you enter AR* in the Start
with: Job Name field, all jobs whose job names begin with AR will be
extracted.
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 At the end of the Start with: Cycle Number and/or Run Number
fields to select all cycles or runs that begin with the string. If you are
going to use a generic terminator in these fields, the generic terminator
must be numeric.
Use Alternate Format. Enables you to specify that you want to use the
unpacked (alternate) option described in the introduction to “Extract
History Utility” on page 533.

 If you leave the default N, the next panel will be the (second) Extract
history panel shown below.

 If you enter Y, the next panel will be the “Optional Alternate Format
Parameters Panel” on page 536.

(Second) Extract History Panel (Packed Format)
This panel displays if you have N in the Use Alternate Format field on
the preceding panel.
Extract History
Extract
__ 1.
2.
3.
4.
5.

records from range with:
Highest cycle
Lowest cycle
Highest run date/time
Lowest run date/time
Extract all records

Choose an extract output option:
__ 1. Include logically deleted records and audit trail records
2. Include logically deleted records, no audit trail records
3. Include audit trail records, no logically deleted records
4. No audit trail records, no logically deleted records
5. Only extract logically deleted records
6. Only extract audit trail records
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Extract records from range with. Identifies the job run to be extracted
from the specified range.
Choose an extract output option. Specify the type of records to extract.
The term audit trail records refers to records that track reruns.
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Optional Alternate Format Parameters Panel
This panel displays if you enter Y in the Use Alternate Format field on
the preceding panel.
Optional Alternate Format Parameters
Platform Identifier: ____________________
Relative date: . . . ____ (-998 to +998)
Cycle Date Format:
__ 1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. CCYYMMDD
9. CCYYJJJ
10. YYJJJN (J0/J9)
11. CCYYJJJN (J0/J9)
F1=Help
F5=Accept

F2=Split
F7=Prev

F3=Exit
F8=Next

F4=Retain
F9=Swap

Platform Identifier. Optionally enter a unique identifier for the platform
from which the history record was extracted. For use when history data
from various platforms will be combined.
Relative date. Complete if you want to begin the extraction based on a
date relative to the current system date. An entry of +000 starts the
extraction with the system date. To start with a different date, enter a
relative number from -998 to +998.
Cycle Date Format. If you want to use this extract to do trending of other
Infogix products, specify the format you use for your cycle numbers in the
history database.
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Extract History File (Packed) Layout
Fld
#
1

Description

Position

Length

Format

Balancing Job Information
Job Name

1-8

8

X(8)

2

Step Name

9-16

8

X(8)

3

Qualifier

17-18

2

X(2)

4

Cycle Number

19-26

8

9(8)

5

Run Number

27-29

3

9(3)

Value

6

Reserved

30-39

10

X(10)

7

Run Type

40

1

X(1)

Space, D, R,
F

8

Run Date

41-44

4

S9(7)

Packed

9

Extract Run Time

45-48

4

S9(7)

Packed

10

Program Name

49-56

8

X(8)

11

Return Code

57-60

4

X(4)

12

Rerun Date

61-64

4

S9(7)

Packed

13

Rerun Time

65-68

4

S9(7)

Packed

14

Rerun Count

69-72

4

S9(7)

Packed

151

Run Value-X

73-872

800

100 X(8)

161

Run Value-N

73-872

800

100 S9(15)

17

Extended Run Value-X

873-8872

8000

100 X(80)

18

Extended Run Value-N

873-8872

8000

100 S9(30)
100 Filler
X(64)

Packed

Packed

1 - These positions can be populated by 100 8-byte alphanumeric fields or 100 15-byte packed
fields.
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Extract History File (Alternate) Layout
Fld #

Description

Position

Length

Format

1

Job Name

1-8

8

X(8)

2

Step Name

9-16

8

X(8)

3

Qualifier

17-18

2

X(2)

4

Cycle Number

19-26

8

9(8)

5

Run Number

27-29

3

9(3)

8

Run Date

30-37

8

9(8)

7

Run Time

38-43

6

9(6)

8

Return Code

44-47

4

X(4)

9

Rerun Date

48-55

8

9(8)

10

Rerun Time

56-61

6

9(6)

11

Rerun Count

62-69

8

9(8)

12

Run Value Count

70-72

3

9(3)

13

Cycle Date

73-80

8

X(8)

14

Format Indicator

81-1880

1800

100 X(1)

15

Run Value-X

81-1880

1800

100 X(8)
100 Filler X(9)

16

Run Value-N

81-1880

1800

100 X(1)
100 9(16)

17

Extended Run Count

18811883

3

9(3)

18

Extended Format Indicator

18849983

8100

100 X(1)

19

Extended Run Value-X

18849983

8100

100 X(80)

20

Extended Run Value-N

18849983

8100

100 X(1)
100 9(31)

21

Reserved

99849990

7

X(7)
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Build Batch Transactions Utility
Use this utility to build batch transaction definition records from the
records in the definition database. This is useful for making mass definition
changes, creating an audit trail, and transferring definitions between
platforms, among other purposes. The definitions can be reloaded into the
“Update From Batch Transactions Utility” on page 540.
The documentation for this utility includes the following sections:

 “Build Batch Transactions Panel” on page 539
 “Build ACRUPDT Report” on page 540

Build Batch Transactions Panel
Build Batch Transactions
Job name: USERID__
Create batch cards from:
DSName: USERID.SUM.DEFN___________________________
Store batch cards into:
DSName: USERID.SUM.TRANLIB________________________
Member: ________
Specify type of definitions to include:
__ 1. Jobs
2. Files
3. History analysis
4. Internal/Cycle tables
5. External tables
6. All definitions
7. Job and associated Files
F1=Help
F2=Split
F3=Exit
F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Create batch cards from: DSName. Optionally change the name of the
dataset to be used to create batch cards.
Store batch cards into: DSName. We recommend you use the default
DSName TRANLIB. The file TRANLIB is also used by the Update from
Batch Transactions utility and has the correct length attributes for the
program to use. If you use your own file, it must be a PDS, 80 byte LRECL,
FB dataset.
Store batch cards from: Member. Select a name that will be
meaningful for the definitions you are creating.
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Specify type of definitions to include. Specify a definition type. Notice
that you can select All definitions. For any type other than All definitions, a
panel for specifying a range will be displayed.
Note:

The Job and associated files option allows you build batch
transaction definition records for all or selected job definitions
and for their associated file definitions at the same time.

Build ACRUPDT Report
This report shows each batch transaction record processed. For an
explanation of the record structure, see “Format of Batch Definition
Transaction Records” on page 736.
The DDNAME for the report in your output will be UNIDBR.
The sample report below has been shortened to show only the file definition
transaction records (F records).
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 11:21:27
TRANS RECORD
NO.
TYPE
----- -----------00001 FILE-ID
00002
00003
00004
00005
00006
00007
00008
00009
00010
00011
00012
00013
00014
00015
00016
00017
00018
00019
00020
00021
00022
00023
00024
00025
00026
00027

XYZ COMPANY
INFOGIX DATA BASE UTILITY
BUILD ACRUPDT REPORT
DSN=USERID.SUM.DEFN

COPYRIGHT INFOGIX, INC
DATA BASE VERSION: 0000086/*******

T R A N S A C T I O N
----+----1----+----2----+----3----+----4----+----5----+----6----+----7----+----8
SAMPLE
000000 F0 0001*
SAMPLE
000000 F0 0001A1PSA00100
0000000
YN
SAMPLE
000000 F0 0002A
THIS IS A SAMPLE
SAMPLE
000001 F2 0001A3LOCATION:
00100
N
SAMPLE
000001 F2 0002A3
0002090002
SAMPLE
000001 F3 0011A0012041001C
A
N
SAMPLE
000002 F2 0001A300100
N
SAMPLE
000002 F2 0002A3
0014010014
SAMPLE
000002 F3 0011A0011122001T
A
N
SAMPLE
000002 F3 0021A0024292002T
A
N
SAMPLE
000002 F3 0031A0071121003C
A
N
SAMPLE
000003 F2 0001A3LOCATION:
00200
N
SAMPLE
000003 F2 0002A3
0002090002
SAMPLE
000003 F3 0011A0012041002C
A
N
SAMPLE
000004 F2 0001A300200
N
SAMPLE
000004 F2 0002A3
0014010014
SAMPLE
000004 F3 0011A0011122006T
A
N
SAMPLE
000004 F3 0021A0024282003T
A
N
SAMPLE
000004 F3 0031A0070141005A
A
N
SAMPLE
000005 F2 0001A3LOCATION:
00300
N
SAMPLE
000005 F2 0002A3
0002090002
SAMPLE
000005 F3 0011A0012041004C
A
N
SAMPLE
000006 F2 0001A300300
N
SAMPLE
000006 F2 0002A3
0014010014
SAMPLE
000006 F3 0011A0011122004T
A
N
SAMPLE
000006 F3 0021A0024262005T
A
N
SAMPLE
000006 F3 0031A0069151006A
A
N

Update From Batch Transactions Utility
This utility allows you to update a definition database with definitions
created previously. This is particularly helpful for moving definitions from
a test to a production environment or sharing definitions with other users
or areas.
You can also use this utility to copy definitions from another user’s
TRANLIB.
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The utility adds, deletes, and/or replaces existing definitions in the
definition database with the definitions created by running the Build Batch
Transactions utility. If there are validation errors, the utility ends with an
error message and the database is not updated.
Note:

If you have Infogix Insight, you can have the batch cards and
audit information on ACR/Summary and ACR/Detail definition
updates (including the ID associated with the change and the
date and time of the change) sent to Infogix Insight during batch
update. For information on implementing this feature, see the
Definition Audit information in the ACR/Summary and ACR/
Detail Installation Guide for z/OS.

The documentation for this utility includes the following sections:

 “Update from Batch Transactions Panel” on page 541
 “Definition Database Update Report” on page 541

Update from Batch Transactions Panel
Update From Batch Transactions
Job name: USERID
Update:
DSName: USERID.SUM.DEFN___________________________
With batch definitions found in:
DSName: USERID.SUM.TRANLIB________________________
Member: ________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Field definitions:
Job name. Your default jobname, which you can optionally change.
Update DSName. Optionally change the definition dataset to be updated.
With batch definitions found DSName. Optionally change the dataset
where the batch definitions can be found.
Member name. Member that contains the batch transactions.

Definition Database Update Report
This report (output DDName UNIUPDT) is generated by the Update from
Batch Transactions utility and consists of 2 sections. Each section contains
a numbered list of the transactions processed, sorted by transaction key.
The first section shows any validation messages generated for each
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transaction. The second section lists the processing that took place related
to each transaction, including any records purged, added, deleted, or
replaced.
For an explanation of the record structure, see “Format of Batch Definition
Transaction Records” on page 736.
The sample report below has been shortened to show only the file definition
transaction records (F records).
Page 1 of 2
ACR/S releasenumber
XYZ COMPANY
COPYRIGHT INFOGIX, INC
DATE: yy/mm/dd
DEFINITION DATA BASE UPDATE REPORT
PAGE 001
TIME: 14:47:37
DSN=USERID.SUM.DEFN
DATA BASE VERSION: 0000089/*******
----------------------------------------------------- TRANSACTION VALIDATION ----------------------------------------------------TRANS
NO.
T R A N S A C T I O N
VALIDATION MESSAGES
----- ----+----1----+----2----+----3----+----4----+----5----+----6----+----7----+----8 --------------------------------------------00001 SAMPLE
000000 F0 0001*
00002 SAMPLE
000000 F0 0001A1PSA00100
0000000
YN
00003 SAMPLE
000000 F0 0002A
THIS IS A SAMPLE
00004 SAMPLE
000001 F2 0001A3LOCATION:
00100
N
00005 SAMPLE
000001 F2 0002A3
000009
Y
00006 SAMPLE
000001 F2 0003A300002
00007 SAMPLE
000001 F3 0011A0000041001C
A
N
00008 SAMPLE
000001 F3 0012AN00012
00009 SAMPLE
000002 F2 0001A300100
N
00010 SAMPLE
000002 F2 0002A3
000001
Y
00011 SAMPLE
000002 F2 0003A300014
00012 SAMPLE
000002 F3 0011A0000122001T
A
N
00013 SAMPLE
000002 F3 0012AY00011
00014 SAMPLE
000002 F3 0021A0000292002T
A
N
00015 SAMPLE
000002 F3 0022AY00024
00016 SAMPLE
000002 F3 0031A0000121003C
A
N
00017 SAMPLE
000002 F3 0032AN00071
00018 SAMPLE
000003 F2 0001A3LOCATION:
00200
N
00019 SAMPLE
000003 F2 0002A3
000009
Y
00020 SAMPLE
000003 F2 0003A300002
00021 SAMPLE
000003 F3 0011A0000041002C
A
N
00022 SAMPLE
000003 F3 0012AN00012
00023 SAMPLE
000004 F2 0001A300200
N
00024 SAMPLE
000004 F2 0002A3
000001
Y
00025 SAMPLE
000004 F2 0003A300014
00026 SAMPLE
000004 F3 0011A0000122006T
A
N
00027 SAMPLE
000004 F3 0012AY00011
00028 SAMPLE
000004 F3 0021A0000282003T
A
N
00029 SAMPLE
000004 F3 0022AY00024
00030 SAMPLE
000004 F3 0031A0000141005A
A
N
00031 SAMPLE
000004 F3 0032AN00070
00032 SAMPLE
000005 F2 0001A3LOCATION:
00300
N
00033 SAMPLE
000005 F2 0002A3
000009
Y
00034 SAMPLE
000005 F2 0003A300002
00035 SAMPLE
000005 F3 0011A0000041004C
A
N
00036 SAMPLE
000005 F3 0012AN00012
00037 SAMPLE
000006 F2 0001A300300
N
00038 SAMPLE
000006 F2 0002A3
000001
Y
00039 SAMPLE
000006 F2 0003A300014
00040 SAMPLE
000006 F3 0011A0000122004T
A
N
00041 SAMPLE
000006 F3 0012AY00011
00042 SAMPLE
000006 F3 0021A0000262005T
A
N
00043 SAMPLE
000006 F3 0022AY00024
00044 SAMPLE
000006 F3 0031A0000151006A
A
N
00045 SAMPLE
000006 F3 0032AN00069
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Page 2 of 2
ACR/S releasenumber
XYZ COMPANY
COPYRIGHT INFOGIX, INC
DATE: yy/mm/dd
DEFINITION DATA BASE UPDATE REPORT
PAGE 002
TIME: 14:47:37
DSN=USERID.SUM.DEFN
DATA BASE VERSION: 0000089/*******
----------------------------------------------------- TRANSACTION PROCESSING ----------------------------------------------------TRANS
NO.
T R A N S A C T I O N
RECORD KEY
ACTION
----- ----+----1----+----2----+----3----+----4----+----5----+----6----+----7----+----8 ------------------------ --------00001 SAMPLE
000000 F0 0001*
SAMPLE
000000 F0 000 PURGED
SAMPLE
000001 F2 000 PURGED
SAMPLE
000001 F3 001 PURGED
SAMPLE
000002 F2 000 PURGED
SAMPLE
000002 F3 001 PURGED
00002 SAMPLE
000000 F0 0001A1PSA00100
0000000
YN
00003 SAMPLE
000000 F0 0002A
THIS IS A SAMPLE
SAMPLE
000000 F0 000 ADDED
00004 SAMPLE
000001 F2 0001A3LOCATION:
00100
N
00006 SAMPLE
000001 F2 0003A300002
SAMPLE
000001 F2 000 ADDED
00007 SAMPLE
000001 F3 0011A0000041001C
A
N
00008 SAMPLE
000001 F3 0012AN00012
SAMPLE
000001 F3 001 ADDED
00009 SAMPLE
000002 F2 0001A300100
N
00011 SAMPLE
000002 F2 0003A300014
SAMPLE
000002 F2 000 ADDED
00012 SAMPLE
000002 F3 0011A0000122001T
A
N
00013 SAMPLE
000002 F3 0012AY00011
SAMPLE
000002 F3 001 ADDED
00014 SAMPLE
000002 F3 0021A0000292002T
A
N
00015 SAMPLE
000002 F3 0022AY00024
SAMPLE
000002 F3 002 ADDED
00016 SAMPLE
000002 F3 0031A0000121003C
A
N
00017 SAMPLE
000002 F3 0032AN00071
SAMPLE
000002 F3 003 ADDED
00018 SAMPLE
000003 F2 0001A3LOCATION:
00200
N
00020 SAMPLE
000003 F2 0003A300002
SAMPLE
000003 F2 000 ADDED
00021 SAMPLE
000003 F3 0011A0000041002C
A
N
00022 SAMPLE
000003 F3 0012AN00012
SAMPLE
000003 F3 001 ADDED
00023 SAMPLE
000004 F2 0001A300200
N
00025 SAMPLE
000004 F2 0003A300014
SAMPLE
000004 F2 000 ADDED
00026 SAMPLE
000004 F3 0011A0000122006T
A
N
00027 SAMPLE
000004 F3 0012AY00011
SAMPLE
000004 F3 001 ADDED
00028 SAMPLE
000004 F3 0021A0000282003T
A
N
00029 SAMPLE
000004 F3 0022AY00024
SAMPLE
000004 F3 002 ADDED
00030 SAMPLE
000004 F3 0031A0000141005A
A
N
00031 SAMPLE
000004 F3 0032AN00070
SAMPLE
000004 F3 003 ADDED
00032 SAMPLE
000005 F2 0001A3LOCATION:
00300
N
00034 SAMPLE
000005 F2 0003A300002
SAMPLE
000005 F2 000 ADDED
00035 SAMPLE
000005 F3 0011A0000041004C
A
N
00036 SAMPLE
000005 F3 0012AN00012
SAMPLE
000005 F3 001 ADDED
00037 SAMPLE
000006 F2 0001A300300
N
00039 SAMPLE
000006 F2 0003A300014
SAMPLE
000006 F2 000 ADDED
00040 SAMPLE
000006 F3 0011A0000122004T
A
N
00041 SAMPLE
000006 F3 0012AY00011
SAMPLE
000006 F3 001 ADDED
00042 SAMPLE
000006 F3 0021A0000262005T
A
N
00043 SAMPLE
000006 F3 0022AY00024
SAMPLE
000006 F3 002 ADDED
00044 SAMPLE
000006 F3 0031A0000151006A
A
N
00045 SAMPLE
000006 F3 0032AN00069
SAMPLE
000006 F3 003 ADDED

Create Comma Delimited Text File Utility
The Create Comma Delimited Text File utility can only be used after you
have created an extract file from the Extract History utility (see “Extract
History Utility” on page 533).
The utility reads the extract file and creates a text file with sequential fields
separated by commas.
The file is in the following format: Job name, step name, qualifier, cycle
number, run number, run type, run date, run time, return code, rerun date,
rerun time, rerun count, items.
All text values are surrounded by quotation marks.
All dates appear either in the MM/DD/YY format if the century value is 19
or the MM/DD/CCYY format if the century value is not 19.

ACR/Summary User Guide for z/OS

543

16  Using the Batch Utilities
Create Comma Delimited Text File Utility

Once created, the comma delimited text file can be downloaded to the
desktop. Most desktop spreadsheet applications require an extension of
.csv when opening a comma-delimited file, so use this extension when
downloading.

Create Comma Delimited Text File Panel
The Create Comma Delimited Text File panel displays.
Create Comma Delimited Text File
Job name: USERID__
Extract file: . . . .
Definition database:
Comma delimited file:
Volume: . . . . . . .

F1=Help

F2=Split

__________________________________________
USERID.SUM.DEFN___________________________
__________________________________________
______ Unit: SYSALLDA

F3=Exit

F5=Accept

F9=Swap

Job name. Your default jobname, which you can optionally change.
Extract File. Extract file output created by the Extract History Utility that
is to be reformatted into a comma delimited file.
Definition database. Database that contains all of the definitions for the
information contained in the extract file.
Comma delimited file. Name to be given to the comma delimited file
when it is created.
Volume. Volume that the work file will be stored on.
Unit. Unit name where the work file will be stored.
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Create Comma Delimited Text File Record Layout
Fld #

Description

Position

Length

Format

Value

1

Function Name

1

8

X(8)

BUILDCSV

2

Reserved

9

1

X(1)

3

File Name

10-17

8

X(8)

ACRSH

4

Transaction Sequence

18-20

3

X(3)

Blanks

5

Reserved

21-80

60

X(60)

Blanks

Lock or Free History Database Utility
The Lock/Free History Database utility enables you to lock/free the history
database with respect to updates from other jobs. Locking will prevent
other jobs from updating the history database. This is something you
should do when running the Reorganize History utility or the Copy History
Database utility Reload option. After you finish your work in the history
database, free the history database so that other jobs can once again update
the history database.
This utility is not available from the utility menu. Use the standards at your
business site to generate the JCL for this utility.

JCL to Lock the History Database
To lock the history database to prevent other jobs from trying to access it,
use the following JCL:
//job card
//*
//* THIS STEP LOCKS ACR/S DATA BASE (UNIHF)
//*
//LOCKHF
EXEC PGM=UNIHPROT,PARM=’LOCK’
//STEPLIB
DD DSN=UNI.LOADLIB.CVS,DISP=SHR
//UNICF
DD DSN=UNI.UNICF,DISP=SHR
//UNIHF
DD DSN=YOURFILE.TEST.UACHIST,DISP=SHR
//SYSUDUMP DD SYSOUT=*
//SYSDBOUT DD SYSOUT=*
//SYSOUT
DD SYSOUT=*
//*
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JCL to Free the History Database
To free the history database so that other jobs can once again access it, use
the following JCL:
//job card
//*
//* THIS STEP FREES ACR/S DATA BASE (UNIHF)
//*
//FREEHF
EXEC PGM=UNIHPROT,PARM=’FREE’
//STEPLIB
DD DSN=UNI.LOADLIB.CVS,DISP=SHR
//UNICF
DD DSN=UNI.UNICF,DISP=SHR
//UNIHF
DD DSN=YOURFILE.TEST.UACHIST,DISP=SHR
//SYSUDUMP DD SYSOUT=*
//SYSDBOUT DD SYSOUT=*
//SYSOUT
DD SYSOUT=*
//*

Transaction Listing Report
All of the Copy History options and multiple other ACR/Summary
processes generate the Transaction Listing Report.
The DDNAME for the report in your output will be UNITR.
This report shows the process that was executed and any validation
messages. The specific content depends on the type of processing that
generated the report.
This report is generated when you run any of a variety of processes. These
include:







Direct Input Balancing
Delete History
Extract History
Update History
Create Comma Delimited Text File

Following is an example.
Utility Transaction Listing - After Copy All Records
ACR/S releasenumber
INFOGIX, INCORPORATED
COPYRIGHT INFOGIX, INC
DATE: yy/mm/dd
INFOGIX
DATA BASE UTILITY
PAGE 001
TIME: 12:52:54
UTILITY TRANSACTION LISTING
-----------------------------------------------------------------------------------------------------------------------------------TRANS
NO.
T R A N S A C T I O N
VALIDATION MESSAGES
----- ----+----1----+----2----+----3----+----4----+----5----+----6----+----7----+----8 --------------------------------------------00001 COPY
HF
#UTL000I: PROCESSING COMPLETED WITHOUT ERRORS
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Using the Online Utilities
This chapter discusses the online utilities. These include utilities for
maintaining definitions, moving definitions into production, browsing the
history database, performing date conversion, and editing/submitting JCL.
This chapter contains the following sections:









“Accessing On-Line Utilities” on page 547
“Backup Definition Library” on page 548
“Restore Definition Library” on page 550
“Create Batch Transactions” on page 565
“Perform History Browse” on page 567
“Perform Date Conversion” on page 572
“Perform Time Conversion” on page 573

Accessing On-Line Utilities
To access the on-line utilities, select Run > On-line Options. The OnLine Options panel displays.

On-Line Options Panel
On-Line Options
Choose an option:
__ 1. Backup definition library
2. Restore definition library
3. Create batch transactions
4. Perform history browse
5. Perform date conversion
6. Perform time conversion
F1=Help

F2=Split

F3=Exit

F9=Swap

Select the option you want. The option is explained in the referenced
section:
1. Backup definition library. See “Backup Definition Library” on

page 548.
2. Restore definition library. See “Restore Definition Library” on

page 550.
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3. Create batch transactions. See “Create Batch Transactions” on

page 565.
4. Perform history browse. See “Perform History Browse” on page 567.
5. Perform date conversion. See “Perform Date Conversion” on page 572.
6. Perform time conversion. See “Perform Time Conversion” on page 573.

Backup Definition Library
Just as you back up your definition and history databases for disaster
recovery purposes, you should also back up your definition library
periodically. After the backup, you can delete any unneeded definitions,
which clutter up your definition library and decrease processing efficiency.
One advantage of backing up your definition library is that all of your
dataset names from the Input Source panels are saved and can be restored.
If you restore from the database, rather than from the definition library,
these dataset names from the Input Source panels are lost.
From the Job Window, Select Run > On-line Options > Backup
Definition Library to display the Backup On-Line Options panel.

Backup On-line Options Panel
Backup On-Line Options
Specify
__ 1.
2.
3.
4.
5.
6.

which definitions to backup:
All definitions
Job definitions only
File definitions only
History analysis definitions only
Internal/Cycle table definitions only
External table definitions only

F1=Help

F2=Split

F3=Exit

F9=Swap

Select the option you want and press Enter to display the Backup Definition
Library panel.
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Backup Definition Library Panel
Backup Definition Library
Definition library to backup:
DSName: USERIDA.SUM.DEFNLIB
Member: TBLU01
Specify a backup dataset:
DSName: USERIDA.SUM.DEFNLIB
Member: ________
Please specify a copy option:
__ 1. Merge with backup, do not overlay duplicates
2. Merge with backup, replace duplicates
3. Replace backup dataset with definition library dataset

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Definition library to backup: DSName and Member. Display the
definition library and member that is currently active.
Specify a backup dataset: DSName. Displays the definition library
dataset name indicated in the User File Defaults panel.
Member. A meaningful name for the member that will store the backup.
Please specify a copy option. Valid options are:
1. Merge with backup, do not overlay duplicates. Adds the contents of the

definition library dataset to the backup file. If the backup has
definitions with the same name this option will not overlay them.
2. Merge with backup, replace duplicates. Adds the contents of the

definition library to the backup file. If the backup dataset has
definitions with the same name, replace the backup definitions with
these definitions in the definition library.
3. Replace backup dataset with definition library dataset. Deletes the

contents of the backup file and replaces it with the contents of the
definition library.
When you press F5, the following will happen:

 If you chose to backup all definitions, a message will display when the
backup is complete.

 If you chose to backup individual definitions, the Backup/Restore
Definition List Window displays. Select the IDs to be backed up. (To
find an item in a long list, enter F followed by a space followed by all or
the first part of the name of the item. The specified item will display at
the top of the list.) A message will display when the backup is complete.
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Restore Definition Library
This option allows individual definitions or the entire definition library to
be restored from the definition database.
From the Job Window, select Run > On-line Options > Restore
Definition Library to display the (First) Restore Definition Library
panel.

(First) Restore Definition Library Panel
Restore Definition Library
Specify
__ 1.
2.
3.
4.
5.
6.
7.

which definitions to restore:
All definitions
Job definitions only
File definitions only
History analysis definitions only
Internal/Cycle table definitions only
External table definitions only
Job definitions and associated file
definitions

Select range to display?
F1=Help

F2=Split

N

F3=Exit

(Y/N)
F9=Swap

Specify which definitions to restore. Select the option you want.
Select range to display. Enter Y if you want to specify a range of the
selected definition type to select from. This can speed up processing of a
large database and make it easier to select the definitions to be restored.
When you press Enter, one of the following will happen:

 If you entered Y for Select range to display, one of the "Range
Panels" shown below will display.

 If you did not enter Y for Select range to display, the "(Second)
Restore Definition Library Panel" will display.
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Range Panels
Job Definitions (Range) Panel
If you chose to specify a range, and you selected option 2 (Job definitions
only) or option 7 (Job definitions and associated file definitions) on the
(First) Restore Definition Library panel, the following panel will display.
Option 7 restores not only the jobs you select from the range but also all
input source files associated with those jobs.
Job Definitions
Job
Start with: ________
End at: . . ________
F1=Help

F2=Split

Step
________
________
F3=Exit

Qualifier
__
__
F5=Accept

F9=Swap

Start with. Optionally enter the job name, step name, and qualifier (if any)
that will be the starting point of the range of jobs to be displayed.
In the job name and/or step name portions of the Start with fields only, you
can use a generic terminator (*). Enter the * symbol at the end of a string of
characters to extract all jobs whose job names and/or step names begin
with the string. For example, you could complete the panel as shown below:
Job
Start with: ABC*____
End at: . . ________

Step
Step*___
________

Qualifier
__
__

These entries will cause the system to display all jobs with job names
beginning with the string ABC whose step names begin with the string Step.
If you leave all fields on the panel blank, all jobs in the database will be
displayed.
If you complete only the Start with fields, only the job that exactly matches
your entry will be displayed. The generic terminator is not allowed.
End at. Optionally enter the job name, step name, and qualifier (if any)
that will be the ending point of the range to be displayed. If you complete
only the End at fields, all jobs from the beginning of the database up to and
including the End at job will be displayed.
Press F5 to display the “(Second) Restore Definition Library Panel” on
page 555.
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File Definitions (Range) Panel
If you are restoring from a range of file definitions, the following panel will
display.
File Definitions
File DDname
Start with: ________
End at: . . ________
F1=Help

F2=Split

Qualifier
__
__
F3=Exit

F5=Accept

F9=Swap

Start with. Optionally enter the File DDname and qualifier (if any) that
will be the starting point of the range of files to be displayed.
In the File DDname portion of the Start with field only, you can use a
generic terminator (*). Enter the * symbol at the end of a string of
characters to display all files whose DDnames begin with the string.
If you leave all fields on the panel blank, all files in the database will be
displayed.
If you complete only the Start with fields, only the file that exactly matches
your entry will be displayed. The generic terminator is not allowed.
End at. Optionally enter the file name and qualifier (if any) that will be the
ending point of the range to be displayed. If you complete only the End at
fields, all files from the beginning of the database up to and including the
End at file will be displayed.
Press F5 to display the “(Second) Restore Definition Library Panel” on
page 555.
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History Analysis Definitions (Range) Panel
If you are restoring from a range of history analysis definitions, the
following panel will display.
History Analysis Definitions
History analysis ID
Start with: ________________
End at: . . ________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Start with. Optionally enter the history analysis ID that will be the starting
point of the range of IDs to be displayed.
In the Start with field only, you can use a generic terminator (*). Enter the
* symbol at the end of a string of characters to display all history analysis
IDs that begin with the string.
If you leave all fields on the panel blank, all history analysis IDs in the
database will be displayed.
If you complete only the Start with field, only the history analysis ID that
exactly matches your entry will be displayed. The generic terminator is not
allowed.
End at. Optionally enter the history analysis ID that will be the ending
point of the range to be displayed. If you complete only the End at field, all
IDs from the beginning of the database up to and including the End at ID
will be displayed.
Press F5 to display the “(Second) Restore Definition Library Panel” on
page 555.
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Table Definitions (Range) Panel
If you are restoring from a range of internal and cycle table definitions
(option 5 on the (First) Restore Definition Library panel), or from a range
of external table definitions (option 6 on the same panel), the following
panel will display. The type of tables displayed will correspond to the option
you selected.
Table Definitions
Table ID
Start with: ________________
End at: . . ________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Start with. Optionally enter the table ID that will be the starting point of
the range of tables to be displayed.
In the Start with field only, you can use a generic terminator (*). Enter the
* symbol at the end of a string of characters to display all tables whose table
IDs begin with the string.
If you leave all fields on the panel blank, all tables in the database will be
displayed.
If you complete only the Start with field, only the table that exactly matches
your entry will be displayed. The generic terminator is not allowed.
End at. Optionally enter the table ID that will be the ending point of the
range to be displayed. If you complete only the End at field, all tables from
the beginning of the database up to and including the End at table will be
displayed.
Press F5 to display the "(Second) Restore Definition Library Panel" shown
below.
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(Second) Restore Definition Library Panel
Restore Definition Library
Restore to current definition library:
DSName: USERIDA.SUM.DEFNLIB
Member: TBLU01
Definition database to restore from:
DSName: USERIDA.SUM.DEFN__________________________
Please specify a restore option:
__ 1. Merge dataset with definition library, do not replace
duplicates
2. Merge dataset with definition library, replace duplicates
3. Delete like records and replace with source dataset

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Restore to current definition library: DSName and Member.
Displays the target DSName and member that the data will be restored to.
The DSName is the current definition library in the User File Defaults
panel. The member name will always be TBLU01. This member name is
used internally to process selections and cannot be changed from this
panel. If you would like to restore the definitions to another dataset you
must change the default in the User File Defaults panel.
Definition database to restore from. Verify or change the source
where the data will be restored from.
Please specify a restore option. Valid options are:
1. Merge dataset with definition library, do not replace duplicates. Adds

definitions from the definition database to the definition library
without changing definitions currently in the definition library. If the
definition database has data with the same name as found in the
definition library, do not overlay. After using this option, the contents
of the definition library may still be different from the contents of the
definition database. Definitions existing only in the definition library
will not be deleted, and definitions in the definition library that are
different from but have the same name as definitions in the definition
database will not have been updated.
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2. Merge dataset with definition library, replace duplicates. Places the

contents of the definition database in the definition library. After using
this option, the definitions you specified will be identical in the
definition library and the definition database, because the option will
have replaced the definition library definitions with the definition
database definitions.
3. Delete like records and replace with source dataset. Deletes the

contents of the definition library and replaces it with the selected
contents from the definition database. If you have chosen a specific
type of definition (i.e. job) it deletes and replaces only that definition
type. After using this option, only those definitions you selected from
the definition database will exist in the definition library for the
specified type of definition.
When you press Enter, one of the following will happen:

 If you chose to restore all definitions, the Restore Completed message
will appear in the top right hand corner.

 If you chose to restore any individual definitions, the Backup/Restore
Definition List Window displays.

Backup/Restore Definition List Window
Backup/Restore Definition List Window

Row 1 from 20

Select items to backup/restore. When finished PF3 to
exit.
ID List
Description
_
JOBXYZ STEP10
MONTHLY REPORT
_
TEST
STEP1
TEST REPORT
************************** BOTTOM OF DATA ***************************

Command ===> ________________________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Select the IDs to be restored. When you press Enter, the appropriate ID list
will display. To find a definition in a long list, enter F followed by a space
and the ID you want to locate. The specified job ID will display at the top of
the list.
When the restore is complete, a message will appear at the top right corner
of the panel.
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Examples: Restoring Job Definitions Only
The following examples will help clarify how each restore option works. Be
sure to read completely through all of the examples before you begin. In the
examples below, we will restore only job definitions. You can restore any or
all of the definitions (job, file, history analysis, internal table or external
table) from the backup file.

TOTALS STEP 1 (Current Job Definitions)
Following is the Job Window for TOTALS STEP1 showing all of the current
job definitions as stored in the definition library.
File Edit View Run Setup Window Help
-------------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 21

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

D.

Basic Job Information
Job Information:
TOTALS
STEP1
Report Options:
INDIVIDUAL DEPT TOTALS
Input Sources: 001
TOTALS1
XXXX.XXXX(TOTSALE3)
< NEW... >
Internal Items: 003
001
MEAT SALES
002
DELI SALES
003
TOTAL MONTHLY SALES
< NEW... >
Extended Internal Items: 000
< NEW... >

Command Line ===> _________________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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TOTALS STEP1 (Backed Up Job Definitions)
Following is the Job Window for TOTALS STEP1 showing all of the job
definitions in the backup:
File Edit View Run Setup Window Help
-------------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 23

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

Basic Job Information
Job Information:
TOTALS
STEP1
Report Options:
DEPARTMENT TOTALS
Input Sources: 001
TOTALS1
XXXX.XXXX(TOTSALE3)
< NEW... >
Internal Items: 005
001
BAKERY SALES
002
DELI SALES
003
MEAT SALES
004
TOTAL MONTHLY SALES
005
QUARTERLY SALES
< NEW... >

Command Line ===> _________________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

There are several differences between current job definitions and the
backed up job definitions:
Totals Step 1 (Current Job
Definitions)

Totals Step 1 (Backed Up Job
Definitions)

Control Report Title is:

Control Report Title is:

INDIVIDUAL DEPT TOTALS

DEPARTMENT TOTALS

Number of Internal items is 3

Number of Internal items is 5

Internal Item 1 is described as Meat
Sales

Internal Item 1 is described as Bakery
Sales

Internal Item 3 is described as Total
Monthly Sales

Internal Item 3 is described as Meat
Sales

Keep in mind that the restore compares items by item number, not by
description.
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Results of Restore Option 1 (Merge dataset with definition
library, do not replace duplicates)
When you complete the restore by selecting option 1 (Merge dataset with
definition library, do not replace duplicates), you will see the results as
shown in the panel below.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 23

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

Basic Job Information
Job Information:
TOTALS
STEP1
Report Options:
INDIVIDUAL DEPT TOTALS
Input Sources: 001
TOTALS1
XXXX.XXXX(TOTSALE3)
< NEW... >
Internal Items: 005
001
MEAT SALES
002
DELI SALES
003
TOTAL MONTHLY SALES
004
TOTAL MONTHLY SALES
005
QUARTERLY SALES
< NEW... >

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

Notice that the Control Report Title, internal item 1, internal item 2 and
internal item 3 remained the same as the ones in the current definition
library because option 1 does not replace duplicates.
Items 4 and 5 have been added because option 1 is a merge option.
Use option 1 when you want to retain changes to the specified definitions
that are now in the definition library while restoring deleted definitions.
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Results of Restore Option 2 (Merge dataset with definition
library, replace duplicates)
When you complete the restore by selecting option 2 (Merge dataset with
definition library, replace duplicates), you will see the results as shown in
the panel below.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 23

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

Basic Job Information
Job Information:
TOTALS
STEP1
Report Options:
DEPARTMENT TOTALS
Input Sources: 001
TOTALS1
XXXX.XXXX(TOTSALE3)
< NEW... >
Internal Items: 005
001
BAKERY SALES
002
DELI SALES
003
MEAT SALES
004
TOTAL MONTHLY SALES
005
QUARTERLY SALES
< NEW... >

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

This option places the contents of the definition database in the definition
library. After using this option, the definitions you specified (in this case,
the definitions for TOTALS STEP1, will be identical in the definition library
and the definition database, because the option will have replaced the
definitions for the job in the definition library with those in the definition
database. You can verify this by comparing the panel above with the panel
in “TOTALS STEP1 (Backed Up Job Definitions)” on page 558.
Use option 2 when you want to replace the specified definitions that are
now in the definition library with definitions from the definition database
without deleting or changing other definitions in the definition library. For
example, if you have jobs A, B, and C in your definition library, and you
choose to restore job B, jobs A and C remain as they are in the definition
library.
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Results of Restore Option 3 (Delete like records and replace
with source datasets)
When you complete the restore by selecting 3 (Delete like records and
replace with source datasets), you will see the results as shown in the panel
below.
File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 23

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

Basic Job Information
Job Information:
TOTALS
STEP1
Report Options:
DEPARTMENT TOTALS
Input Sources: 001
TOTALS1
XXXX.XXXX(TOTSALE3)
< NEW... >
Internal Items: 005
001
BAKERY SALES
002
DELI SALES
003
MEAT SALES
004
TOTAL MONTHLY SALES
005
QUARTERLY SALES
< NEW... >

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

This job now contains all of the job definitions as stored in the backup file.
Use option 3 with care because it deletes all of the definitions of the
specified type from the definition library and restores only the definitions
you select. For example, if you have jobs A, B, and C in your definition
library, and you choose to restore job B, jobs A and C will be deleted from
the definition library.

Examples: Restoring File Definitions Only
The following examples will help clarify how each restore option works. Be
sure to read completely through all of the examples before you begin. In the
examples below, we will restore only file definitions. You can restore any or
all of the definitions (job, file, history analysis, internal table or external
table) from the backup file.
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TOTALS STEP 1 (Current File Definitions)
Following is the Extract Window for TOTALS STEP1 showing all of the
current file definitions as stored in the definition library.
File Edit View Window Help
----------------------------------------------------------------------Extract Window
Row 1 to 4 of 4
__
SELECT IF POS 0031 FOR 04 = DELI
__
REFORMAT POSITION 0021 FOR 05 POSITIONS TO POS 0062 FOR 02 POSITIO
__
SELECT IF POS 0021 FOR 07 = PRODUCE
__
TOTAL THE VALUES AT 0032 FOR 08, STORE IN I-001
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

TOTALS STEP1 (Backed Up File Definitions)
Following is the Extract Window for TOTALS STEP1 showing all of the file
definitions in the backup:
File Edit View Window Help
----------------------------------------------------------------------Extract Window
Row 1 to 5 of 5
__
SELECT IF POS 0031 FOR 05 = STORE
__
TOTAL THE VALUES AT 0039 FOR 02, STORE IN I-001
__
TOTAL THE VALUES AT 0060 FOR 10, STORE IN I-002
__
SELECT IF POS 0021 FOR 07 = PRODUCE
__
TOTAL THE VALUES AT 0032 FOR 08, STORE IN I-003
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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Notice the differences and similarities:
Totals Step 1 (Current File
Definitions)

Totals Step 1 (Backed Up File
Definitions)

Difference

SELECT IF POS 0031 FOR 04 =
DELI

SELECT IF POS 0031 FOR 05 =
STORE

Statements are
different

REFORMAT POSITION 0021
FOR 05 POSITIONS TO POS
0062 FOR 02 POSITIONS

Not in backup file.

TOTAL THE VALUES AT 0039
FOR 02, STORE IN I-001

In backup file only.

TOTAL THE VALUES AT 0060
FOR 10, STORE IN I-002

In backup file only.

SELECT IF POS 0021 FOR 07 =
PRODUCE

SELECT IF POS 0021 FOR 07 =
PRODUCE

Identical

TOTAL THE VALUES AT 0032
FOR 08, STORE IN I-001

TOTAL THE VALUES AT 0032
FOR 08, STORE IN I-003

Value is stored in
different internal
items.

Keeping this comparison in mind, see the results of each restore option.

Results of Restore option 1 (Merge dataset with definition
library, do not replace duplicate)
File Edit View Window Help
----------------------------------------------------------------------Extract Window
Row 1 to 6 of 6
__
SELECT IF POS 0031 FOR 04 = DELI
__
REFORMAT POSITION 0021 FOR 05 POSITIONS TO POS 0062 FOR 02 POSITIO
__
TOTAL THE VALUES AT 0039 FOR 02, STORE IN I-001
__
TOTAL THE VALUES AT 0060 FOR 10, STORE IN I-002
__
SELECT IF POS 0021 FOR 07 = PRODUCE
__
TOTAL THE VALUES AT 0032 FOR 08, STORE IN I-001
***************************** Bottom of data****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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Notice the following:

 The first SELECT statement did not change.
 The REFORMAT statement remained.
 The two DETAIL statements from the backup file were added after the
REFORMAT statement.

 The second SELECT statement did not change.
 The final DETAIL statement did not change.
Option 1 enables you to retain changes to the specified definitions that are
now in the definition library while restoring deleted definitions.

Results of Restore option 2 (Merge dataset with definition
library area, replace duplicates)
File Edit View Window Help
----------------------------------------------------------------------Extract Window
Row 1 to 6 of 6
__
SELECT IF POS 0031 FOR 05 = STORE
__
TOTAL THE VALUES AT 0039 FOR 02, STORE IN I-001
__
TOTAL THE VALUES AT 0060 FOR 10, STORE IN I-002
__
SELECT IF POS 0021 FOR 07 = PRODUCE
__
TOTAL THE VALUES AT 0032 FOR 08, STORE IN I-003
***************************** Bottom of data****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

This option places the contents of the definition database in the definition
library. After using this option, the definitions you specified (in this case,
the file definitions for TOTALS STEP1) will be identical in the definition
library and the definition database, because the option will have replaced
the file definitions in the definition library with the file definitions in the
backup file. You can verify this by comparing the panel above with the panel
in “TOTALS STEP1 (Backed Up File Definitions)” on page 562.
Option 2 allows you to replace the specified definitions that are now in the
definition library with definitions from the definition database without
deleting or changing other definitions in the definition library. For
example, if you have jobs A, B, and C in your definition library, and you
choose to restore the file definitions for job B, file definitions for jobs A and
C remain as they are in the definition library.
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Results of Restore Option 3 (Delete like records and replace
with source dataset)
File Edit View Window Help
----------------------------------------------------------------------Extract Window
Row 1 to 5 of 5
__
SELECT IF POS 0031 FOR 05 = STORE
__
TOTAL THE VALUES AT 0039 FOR 02, STORE IN I-001
__
TOTAL THE VALUES AT 0060 FOR 10, STORE IN I-002
__
SELECT IF POS 0021 FOR 07 = PRODUCE
__
TOTAL THE VALUES AT 0032 FOR 08, STORE IN I-003
***************************** Bottom of data****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

In this case, all the file definitions were deleted and replaced with the file
definitions stored in the backup file.
Use option 3 with care because it deletes all of the definitions of the
specified type from the definition library and restores only the definitions
you select. For example, if you have jobs A, B, and C in your definition
library, and you choose to restore the file definitions for job B, the file
definitions for jobs A and C will be deleted from the definition library.

Create Batch Transactions
Use this utility to convert definitions in your definition library to batch
transactions. These are 80-character records stored in a PDS member that
reflect the information stored in the definition library and in the definition
database. Batch transactions can be used for the following purposes:

 To move job and file definitions into a production environment in a
secure way.

 To be used as an audit trail of what has been moved to the production
database.

 To be stored for use as a disaster recovery file.
To create batch transactions, from the Job Window, select Run > On-line
Options > Create batch transactions. The Batch Transaction panel
displays.
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Batch Transaction Panel
Batch Transaction
Specify where you would like to place the batch transaction:
DSName: . . . . . . . . USERIDA.SUM.TRANLIB_______________________
Under what member name: ________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

DSNAME. Verify or change the default dataset where the transaction
records will be stored.
Under what member name. Enter the name of the member where the
records will be stored.
Press F5 to accept and display the Batch Transaction Definitions List.

Batch Transaction Definitions List
Batch Transaction Definition List

Row 1 from 22

Select which definitions to include:
ID List
Type
Description
_
ANALYSIS HISTORY
ANALYSIS
ANALYSIS OF MONTHLY HISTORI
_
CONVERT STATE
XTABLE
_
DB2TEST
FILE ID
DB2INPUT SOURCE
_
DB2TEST STEPTEST
JOB ID
CONTROL REPORT
_
INTERNAL CONVERT
TRNTB ID
_
INVENTORY
CYCTB ID
_
MODE1
FILE ID
ACCESS1
_
TESTIN
FILE ID
TESTINPUT
_
TESTJOB STEPTEST
JOB ID
CONTROL REPORT
Command ===> ________________________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Select the definitions to be included. Typically, batch transactions are
created for a job and all the file definitions that go with it. The Type column
uses the following abbreviations that may not be intuitive:
ANALYSIS: History Analysis ID
CYCTB ID: Cycle Table ID
TRNTB ID: Internal Translation Table ID
XTABLE: External Translation Table ID
When you press Enter, a message indicating the number of rows of IDs
selected appears. Press Enter and exit.
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To edit/submit batch transactions that have been created, select Run >
Edit/Submit. For batch record layouts, see “Batch Definition
Transactions” on page 735.

Perform History Browse
History browse lets you look at the contents of your history database,
including:

 Job ID and status
 Highest return code generated when the cycle was run
 Cycle number and run number
 Run date and start time
 Internal item numbers, descriptions and values (including information
for reruns)






History update level
Definition update level
Load library used
Program

Note:

While history browse is being executed, the definition database cannot
be read or updated by any other job.

To browse history, from the Job Window, select Run > On-line Options
> Perform History Browse. The History Browse panel displays.

History Browse Panel
History Browse
Specify your databases:
Definition DB: SYS1.SUM.TEST.DEFN________________________
History DB:
SYS1.SUM.TEST.HIST________________________
Set search criteria for data viewing?

F1=Help

F2=Split

F3=Exit

Y

(Y/N)

F9=Swap

Definition DB/History DB. Verify or change the default definition and
history database names.
Set search criteria for data viewing? The default entry Y will enable
you to set search criteria.
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History Browse Search Criteria Panel
History Browse Search Criteria
Choose histories:
Job ID:
Run date:
Cycle ID:
Return codes:

From
__________________
_____
________
____

View deleted histories?
F1=Help

N

To
__________________
_____ (YYJJJ)
________
____

(Y/N)

F3=Exit

Job ID From/To. Optionally enter the range of job IDs to browse.
Portions of a job ID can be entered. For example, you can enter ABC to view
all the jobs that begin with ABC.
Run Date From/To. Optionally enter the range of dates of the history
records to be browsed. Use Julian format YYJJJ.
Cycle ID From/To. Optionally enter the range of cycle IDs of the history
records to be browsed.
Return codes From/To. Optionally enter the range of return codes of
the history records to be browsed.
View deleted histories? Enter Y to override the default of N and view all
of the records that have been marked for deletion using the Delete History
utility (that is, they have been logically deleted) but have not yet been
deleted by running the Reorganize History utility (which physically deletes
the records marked for deletion).
Press Enter to display the Job ID Selection List panel. This panel lists the
job IDs you specified along with the number of history records (also called
cycles) stored for each.
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Job ID Selection List Panel
Job ID Selection List

Row 1 from 14

Select a job ID to examine:
Ascending or Descending Order? D

_
_
_
_
_
_
S

Job
--------

Step
--------

CYCLE
FONSERV
HASHABC
HASHALL
HASHEXT
SCR2633
TESTJOBA

DATES
STEP1
STEP1
STEP1
STEP1
STEP1
STEP1

Qual
----

Number of
Histories
--------1
1
1
1
1
1
4

Command Line ===> _______________________________________

Select a job ID to examine:
Ascending or Descending Order? Options:
D. Cycles will be shown in descending order, that is, with the most
recent/highest cycle numbers first.
A. Cycles will be shown in ascending order, that is, with the oldest/
lowest cycle numbers first.
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Run Record Selection List Panel
Select a job and press Enter to display the Run Record Selection List panel.
This panel shows the cycles of this job along with other information as
identified in the column headings. The information displayed will be
limited if you set limitations on the History Browse Search Criteria panel.
Run Record Selection List

Row 1 from 6

Select a specific record:

Job
--------

Hist Cycle
Step
Qual Stat Number
------- -- --- --------

Run Retn
Nbr Code
--- ----

-------Exec--------Date
Time
---------------

_
TESTJOBA STEP1
20080617 000
mm/dd/yy
13:58:46
_
TESTJOBA STEP1
20080616 000
mm/dd/yy
13:55:09
_
TESTJOBA STEP1
20080615 000
mm/dd/yy
13:54:56
_
TESTJOBA STEP1
20080614 000
mm/dd/yy
13:54:31
***************************** Bottom of data *****************************

Command ===> ____________________________________________________________
F1=Help F3=Exit F7=Up
F8=Down

Select a cycle to view the Summary Run Information panel.
Summary Run Information
Job ID: SMOKE3V3
BUILD1
Run information:
Return code:
Cycle number: 20080617
Run date: 06.167
Rerun date: 00/00/00

View additional information? N
View extended internal items? N
Item

Internal Item Description

001
002
003

INVALID TRANSACTIONS
VALID TRANSACTIONS
INPUT TRANSACTIONS

Row 1 from 9

Run number: 000
Start time: 13:58:45
Rerun time: 00:00:00
Number of reruns:
(Y/N)
(Y/N)
Value
67
9,800
9,867

Command ===> ____________________________________________________________
F1=Help F3=Exit F7=Up
F8=Down

Job ID. The history record being reviewed.
Return code. The highest return code set for this job.
Cycle number. The cycle number of this record.

570

Infogix, Inc.

Using the Online Utilities  17
Perform History Browse

Run number. The run number of this job.
Run date. The original date the job was run in YYJJJ format.
Start time. Indicates the actual start time.
Rerun date. Indicates the date of the last rerun. If this field is blank, this
job has been run only once.
Rerun time. The last time this job was rerun.
Number of reruns. The number of times this key has been stored using
the same cycle number. If this field is blank, the job has never been rerun.
View additional information. Change to Y to display the additional
Run Information panel after you have completed this panel.
View extended internal items? Change to Y to display an additional
panel showing any extended internal items for the selected history record.
Item. The internal item number.
Description. Description entered for the item.
Value. Value stored in this item.
Page down to the information for each internal item stored for this history
record.
After you finish viewing the panel, the following will display if specified:

 If you answered Y to View additional information? when you press
Enter, the "Summary Run Information Panel" shown in the next
section, displays.

 If you answered Y to View extended internal items? after viewing
the Summary Run Information (if selected), press F3 to see the
“Summary Run Information - Extended Internal Item Panel” on
page 572.

Summary Run Information Panel
Summary Run Information
History update level: 12
Definition update level: 15
Load library used: SYS1.LOADLIB
Program: UAC3000

F1=Help

F3=Exit

History update level. The number of times the history database has been
updated since it was initialized.
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Definition update level. The number of times the definition database
has been updated since it was initialized.
Load library used. Library name.
Program. The program that was executed.

Summary Run Information - Extended Internal Item Panel
Summary Run Information - Extended Internal Item Row 1 from 17
Job ID: EXPAND1
STEP1
Cycle number: 20080519

Run number: 003

Extended Internal Item:
ITEM: 001
ITEM: 002
ITEM: 003
ITEM: 004
ITEM: 005

DESCRIPTION: X COUNT
VALUE:
123,456,789,012,345,678,901,234,567,890
DESCRIPTION: X COUNT (-VE)
VALUE:
123,456,789,012,345,678,901,234,567,890 DESCRIPTION: X AMOUNT
VALUE: $ 1,234,567,890,123,456,789,012,345,678.90
DESCRIPTION: X AMOUNT (-VE)
VALUE: 1,234,567,890,123,456,789,012,345,678.90 DESCRIPTION: X DATE (12/01/2008)
VALUE: 20071201

Command ===> ____________________________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Job ID/Cycle number/Run number. Identifies the history record.
Extended Internal Item. Lists each extended internal item stored for
this history record, including its description and value.

Perform Date Conversion
This utility allows you to convert between Gregorian and Julian dates and
date count values. The date count value is the number of days since
December 31, 1600.
Typically this utility is used to determine a date count value for a Gregorian
date, because dates are stored as date count values in the history database.
To use this utility, from the Job Window, select Run > On-Line Options
> Perform Date Conversion. The Date Conversion panel displays.
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Date Conversion Panel
Date Conversions
Input date format:
__ 1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
6. DDMMCCYY
7. CYYMMDD
8. CCYYMMDD
9. CCYYJJJ
10. DDMMMYY
11. DDMMMCCYY
12. MMMDDYY
13. MMMDDCCYY
Input Date Count:
F1=Help

F2=Split

Input date:

______

_________

Resulting date count:

Resulting date (CCYYMMDD):

F3=Exit

F9=Swap

Input date format. Specify the input format of the date or leave this field
blank to convert a date count to a date.
Input date. If you are converting a Gregorian or Julian date to a date
count, enter the date in the format specified in the Input date format field.
Resulting date count. If you are converting a Gregorian or Julian date to
a date count, shows the resulting date count.
Input Date Count. If you are converting a date count to a date in the
format CCYYMMDD, enter the date count in the format NNNNNN.
Resulting date (CCYYMMDD). If you are converting a date count to a
date, shows the resulting date.

Perform Time Conversion
This utility allows you to convert time between HHMMSSNN format and a
centisecond value.
Typically this utility is used to convert time to a centisecond value, as time
is stored as a centisecond value in the history database.
The utility helps you to understand and expand the usage of the time
formatting capabilities.
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To use this utility, from the Job Window, select Run > On-Line Options
> Perform time conversion. The Time Conversion panel displays.

Time Conversion Panel
Time Conversion
>>>>>Convert to centiseconds:
No. of days: ________ Time (HHMMSSNN): ________
Resulting centiseconds:

>>>>>Convert from centiseconds to HHMMSSNN:
Centiseconds: _______________
Resulting time:

F1=Help

F2=Split

(No. of days)

F3=Exit

(HHMMSSNN)

F9=Swap

No of days. Enter the number of days to convert to a centisecond value.
This field is optional.
Time (HHMMSSNN). Enter the time (in HHMSSNN format) to convert
to a centisecond value.
Resulting centiseconds. If you are converting days/time to centisecond,
shows the resulting centisecond value.
Centiseconds. Enter the centisecond value to convert to days/time value.
Resulting time. If you are converting a centisecond time value to days/
time (HHMMSSNN format), shows the resulting days and time value.
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This chapter explains how to create a Free-Form Report. It contains the
following sections:










“What is a Free-Form Report?” on page 575
“Creating a Free-Form Report” on page 575
“Setting the Justification Options” on page 589
“Editing the Report Width” on page 590
“Deleting the Report” on page 590
“Editing the Report Codes” on page 590
“Printing the Free-Form Report” on page 593
“Viewing a Free-Form Report” on page 594

What is a Free-Form Report?
The Free-Form Report is a custom report that can include any of the control
values obtained when the job is run, along with their descriptions.
Depending on your selections, the report can include the job ID, cycle
numbers, return codes, messages, report titles, internal items, history
items, calculated items, rules, and free-form text. You determine where to
place the information on the report.
By default, this report is not printed. When you run the balancing job, you
can change the print options to print the report 1) regardless of whether the
job is out of balance, 2) only when the job is out-of-balance or 3) only when
the job is in-balance. The DDNAME for the report in your output will be
UNIUFR.

Creating a Free-Form Report
This section describes how to get started and how to enter information in
the report.
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Planning the Free-Form Report
Decide what type of information you want to include and where you want
to position it in the report. Planning is important because, although you can
edit the report after you create it, it is difficult to do so through the panels
and may require you to edit the report codes.

Completing the Report Information Panel
From the Job window, do one of the following:

 Select Window > Free-Form Reports.
 Select Report Options > Free-form Report.
The system displays the Report Information panel.
Report Information
Report width?

000

(1-250)

Print with ASA Characters?

F1=Help

F2=Split

Y

F3=Exit

(Y/N)

F5=Accept

F9=Swap

Report Width? Indicate the number of spaces (1-250) for the report
width.
Print with ASA Characters? Indicate whether to print the report with
ASA characters. If this flag is set to No and you run the job online, the first
position in the report is truncated.
Press F5. The system displays the Report Painting Window. When you
finish reading the Report Painting Window, press Enter. The Summary
Report Window displays. You will place fields on this panel from left to
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right, top to bottom. You cannot insert fields on the panel. You can only add
to the end of the report. Be sure to follow your report plan from left to right
for each line of the report.
Edit View Help
-----------------------------------------------------------------------Summary Report Window
Lines 0001 0011 Col 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7--

Command Line ===> ______________________________________ Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right

Selecting the Type of Information to Add
In the Summary Report Window, position the cursor where you want to
begin reserving space for the first item of data and select F6 (Add). The
Define Report Field panel displays.
Define Report Field
Choose the type of field to be defined:
__ 1. Control values...
2. Control value description...
3. Job information...
4. Free-form text...

Select the first field type you want to include in the report.
1. Control values. These are the values for the internal (or extended

internal) items, history items, calculated items, and rules you set up in
the job. For more information, see “Entering Control Values” on
page 578.
2. Control value descriptions. These are the descriptions of the items

you set up in the job.
3. Job information. This includes the Job ID, cycle numbers, return

codes, messages, report title, user name, page number, run date, and
run time for a specific job.
4. Free-Form Text. This consists of literals or text that you enter

yourself.
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Entering Control Values
If you selected the control values option from the Define Report Field panel,
the Item List Window will be displayed. This panel lists all of the following
types of items that you defined for your job:
Internal items (I-xxx)
Extended internal items (X-xxx)
History items (E-xxx)
Calculated items (C-xxx)
Rules, either standard or conditional (R-xxx)
where xxx is the item number.
Item List Window
_
_
_
_
_
_

I-001
I-002
X-001
E-001
C-001
R-001

Row 1 from 16

NUMBER OF VALID INPUT TRANSACTIONS
COMMENTS
X COUNT_
E-001 NUMBER OF VALID TRANSACTIONS
PREV COUNT
VARIABLE
VALID TRANSACTIONS = TOTAL VALID TRANSACTIONS WITH DESCRIPTION

Command Line ===> _______________________________________________________
F1=Help
F2=Split F3=Exit
F7=Up
F8=Down
F9=Swap

Select an item whose value you want to place in the report. One of the
following panels will display:

 If you select an internal item, extended internal item, history item, or
calculated item, the “Control Values Panel” on page 579 will display.

 If you select a standard rule, the “Standard Rule Values Panel” on
page 580 will display.

 If you select a conditional rule, the “Conditional Rule Result Panel” on
page 581 will display.
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Control Values Panel
This panel displays if an internal item, extended internal item, history item,
or calculated item was selected in the Item List Window
Control Values
Value number: I

001

Enter the portion of the value to be painted:--(NOTE: Leave blank to paint the entire value) |
|-Available for text values only
From position: ___ Length: ___
------------|
Number of positions over which to display this value? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Value Number. Identifies the item you selected on the previous panel.
This 2-part field displays the following:

 1-digit item type indicator (I for internal item, X for extended internal
item, E for history item, or C for calculated item).

 3-digit item number.
From position. Only valid for items formatted as text. If you want to print
only part of the text value, specify the first position of the value to be
printed.
Length. If you completed the From position, specify the length you want
to print.
Number of positions over which to display the field. Enter a
number of spaces to reserve for the item on the report, up to the width of
the report. To calculate this number, include formatting characters such as
commas and decimals, then add two to the length of the longest control
value you want to display, because the last two positions of the field are
reserved for a negative value indicator. For examples, see “How Control
Values Display in the Report Window” on page 582.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.
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Standard Rule Values Panel
This panel displays if a standard rule was selected in the Item List Window.
Standard Rule Values
Rule number: 001
If the rule is out of balance:
1_ 1. Display the return code
2. Display the variance
3. Display the return code message
Enter the portion of the return code message to print:
(Leave blank to print the entire return code message)
From position:
Length:
Number of positions over which to display this value? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

Rule number. Number associated with the rule.
If the rule is out of balance. Specify whether the report will show the
rule’s return code, its variance, or the return code message.
Enter the portion of the return code message to print. You can
print all or part of the return code message. To print only a part of the
message, specify the start position in the From position field, and specify
the number of characters to print in the Length field.
Number of positions over which to display. Enter a number of
spaces to reserve for the item on the report, up to the width of the report.
When calculating this number, add two to the length of the longest control
value you want to display on the report, because the last two positions of the
field are reserved for a negative value indicator.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.
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Conditional Rule Result Panel
This panel displays if a conditional rule was selected in the Item List
Window.
Conditional Rule Result
Rule number: 002
If the rule is out of balance:
1 1. Display the return code
2. Display the return code message
Enter the portion of the return code message to print:
(Leave blank to print the entire return code message)
From position:
Length:
Number of positions over which to display this value? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-s
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

Rule number. Defaults to the next available number. We recommend
that you let this field increment automatically.
If the rule is out of balance. Specify whether the report will show the
rule’s return code or the return code message.
Enter the portion of the return code message to print. You can
print all or part of the return code message. To print only a part of the
message, specify the start position in the From position field, and specify
the number of characters to print in the Length field.
Number of positions over which to display. Enter a number of
spaces to reserve for the item on the report, up to the width of the report.
For details, see “How Control Values Display in the Report Window” on
page 582.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.
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How Control Values Display in the Report Window
When you press F5, you will see a display indicating the items you
added. The values will be displayed using 9 or X in place of the actual
data because the extracted values will not be available until you run the
job.
Displaying Amounts or Counts
If the value is an amount or count, the system will display 9s in place of the
actual digits. If the value uses decimals, some of the 9s will be after the
decimal point. After the 9s, 2 positions are reserved for a negative value
indicator. Data from internal items, extended internal items, history items,
and calculated items is supported.
Example: Count Value from an Internal Item
Assume that you want to include internal item I-001 left-justified starting
in position 1. This item stores the following value:
-3,189,274,578,623.00

You need to reserve a minimum of 22 positions to show the whole value: 15
positions for the digits, 5 for the commas and decimal point, and 2 for the
sign. You decide that you want to leave blank space after the value, so you
reserve 23 positions.
The value will appear as follows (a ruler has been added to show the
positions of the displayed value). The next position available on the report
will be position 24.
----+----1----+----2----+----3----+----4----+----5----+----6----+----5----+----6-9,999,999,999,999.99-

Example: Amount Value from an Extended Internal Item
Assume that you want to include extended internal item X-001 left justified
starting in position 1. This item stores the following value:
$3,189,274,578,623,555,928,725,827,010.00

This value contains the maximum number of digits (30) supported for
extended numeric data.
You need to reserve a minimum of 43 positions to show the whole value: 30
positions for the digits, 10 for the commas and decimal point, 2 for the sign,
and 1 for the currency symbol. You decide that you want to leave blank
space after the value, so you reserve 44 spaces.
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The value will appear as follows (a ruler has been added to show the
positions of the displayed value). The next position available on the report
will be position 45.
----+----1----+----2----+----3----+----4----+----5----+----6----+----5----+----6-$9,999,999,999,999,999,999,999,999,999.99-

Displaying Text
If the control value is in text format, the system displays Xs in the positions
you reserved for the item. Data from internal items, extended internal
items, history items, and rules is supported.
Example: Text Value from an Internal Item
If you reserve 10 positions starting at position 1, the first 8 for an internal
item value and the last 2 for empty spaces, the following will be displayed
(a ruler has been added to show the positions of the displayed value):
----+----1----+----2----+----3----+----4----+----5----+----6----+----5----+----6----+----7----+----8
XXXXXXXXXX

Example: Text Value from an Extended Internal Item
If you reserve 80 spaces starting at position 1 for an extended internal item
value, the following will be displayed. Use the scroll keys to see all 80 if your
terminal display shows 72.
----+----1----+----2----+----3----+----4----+----5----+----6----+----5----+----6----+----7----+----8
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

Displaying Dates
If the value is a date, the system displays 00/00/00.
Displaying Rule Return Codes or Variances
For standard rules, the system displays either the rule’s return code or its
variance, depending on what you selected in the Standard Rule Values
panel. A variance will be represented just like an amount or count.
Extended values are supported.
Displaying Conditional Rule Results
For conditional rules, the system displays the rule result.
When you run the job and print the report, the actual values will be
displayed.
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Entering Control Value Descriptions
To add the item description to the item you just added to the report, in the
Summary Report Window, position the cursor where you want to begin
reserving space for the description and select F6 (Add) > Control Value
Descriptions, and select the item whose description you want in the Item
List Window. The Control Values Description panel will be displayed.
Control Value Description
Description: NUMBER OF VALID INPUT TRANSACTIONS

Enter the portion of the description to be painted:
(Leave blank to paint the entire description)
From position: __

Length:

__

Number of positions over which to display? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

The item description will be displayed. Complete the remaining fields based
on the field descriptions for the “Control Values Panel” on page 579.

Displaying a Control Value Description after Entry
After you accept your entries in the Control Value Description panel, the
Summary Report Window displays showing the item description you
selected.
Edit View Help
-----------------------------------------------------------------------Summary Report Window
Lines 0001 0011 Col 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-9999999999.99 -

NUMBER OF VALID INPUT TRANSACTIONS

Command Line ===> ______________________________________ Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right
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Entering Job Information
To include job information in the report, in the Summary Report Window,
position the cursor where you want to begin reserving space for the
information and select F6 (Add) > Job Information.
Job Information
Choose the type of field to be defined:
__ 1. Job ID ...
2. Cycle number...
3. Return code...
4. Message...
5. Report title ...
6. User name...
7. Page number...
8. Run date...
9. Run time...
F1=Help

F2=Split

F3=Exit

F9=Swap

Select the type of job information you want to add. A panel corresponding
to your selection will display.

 Except for the Messages panel, all of the panels for entering job
information are the same except for the title. You can use the field
descriptions for the "Job ID Panel" to complete the panel you select.

 If you select the Messages option, see “Messages Panel” on page 587.
Job ID Panel
Use this panel as a model to add any type of job information to the report
except messages.
Job ID
Number of positions over which to display the job ID? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Number of positions over which to display the field. Number of
spaces (no larger than the report width) you want to reserve for the item in
the report.
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For example, if the item you are adding to the report is 20 characters long
and you enter 30 in this field, there will be an extra 10 blank spaces in front,
in back, or on both sides of the item depending on the justification you
choose in the next step.
The value will begin at the next available position and span across the
number of positions that you enter in this field.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.

Displaying Job Information after Entry
The following example shows a sample Summary Report Window after a
Job ID has been specified.
Edit View Help
-----------------------------------------------------------------------Summary Report Window
Lines 0001 0011 Col 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-9999999999.99 -

NUMBER OF VALID INPUT TRANSACTIONS

JOBXYZ

/

/UPDATE

Command Line ===> ______________________________________ Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right
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Messages Panel
If you select Messages from the Job Information panel, the Messages panel
displays.
Messages
Paint the entire message?

Y

(Y/N)

If no, specify the portion to be painted:
From position: ___

Length:

___

Number of positions over which to display the message?

___

How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Paint the entire message? Enter N and complete the next 2 fields if you
do not want the entire message to be printed.
From position. Starting position of the message. (This is not a position
on the report line.) For example, if you do not want to include the first 4
characters of a message, you would enter a 5.
Length. Number of characters of the message to print. For example, the if
the message is 20 characters long and you do not want to include the last 5
characters, enter 15.
Number of positions over which to display the message? The text
will begin at the next available position and span across the number of
positions (no larger than the width of the report) that you enter.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.
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Displaying a Message after Entry
The following example shows a sample Summary Report Window after a
message has been specified.
Edit View Help
------------------------------------------------------------------------Summary Report Window
Lines 0001 0011 Col 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-9999999999.99 -

NUMBER OF VALID INPUT TRANSACTIONS

JOBXYZ /UPDATE
MESSAGE HERE

/

Command Line ===> ______________________________________ Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right

Entering Free-Form Text
To include free-form text, in the Summary Report Window, position the
cursor where you want to begin reserving space for the text and select Add
> Free-form text. The Free-Form Text panel will be displayed.
Free-Form Text
----+----1----+----2----+----3----+----4
Enter text: ________________________________________
Number of positions over which to justify the entered text? ___
How should this field be justified?
1_ 1. Left
2. Right
3. Centered
4. As-is
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Enter text. Enter the text you want to include.
Number of positions over which to justify the entered text.
Number of spaces you want to reserve for the text in the report.
How should this field be justified. Select an option. For more
information, see “Setting the Justification Options” on page 589.
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Displaying Free-Form Text after Entry
The following example shows a sample Summary Report Window after
free-form text has been specified.
Edit View Help
------------------------------------------------------------------------Summary Report Window
Lines 0001 0011 Col 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7-9999999999.99 -

NUMBER OF VALID INPUT TRANSACTIONS

JOBXYZ /UPDATE /
MESSAGE HERE
This is an example of Free-Form Text

Command Line ===> ______________________________________ Scroll ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right

Setting the Justification Options
When placing an item on the report, you will complete the following field,
How should this field be justified?, to select left, right, or center
justification or the as-is option. Regardless of your choice, the value that
will appear on the report will be limited by the number of positions
specified for the field on the report.
The As-is option specifies that no justification will be applied and leading
and trailing spaces will be retained. Because the number of positions
reserved for the field on the report does not change based on the size of the
item value you are including, the placement and size you specify are
important.

Example of As-is Versus Left/Right Justification
This example shows the results of as-is vs. left justification when the value
is smaller than the number of positions specified
Assume that you are placing a text value on the report. The value consists
of 2 leading spaces, followed by 123, followed by 2 trailing spaces (7
characters). You enter 8 as the number of positions to reserve for the field
on the report.

 If you use as-is justification, the value will print as 8 characters,
consisting of 2 spaces, followed by 123, followed by 3 spaces.

ACR/Summary User Guide for z/OS

589

18  Setting Up Free-Form Reports
Editing the Report Width

 If you use left justification, the value will print as 8 characters,
consisting of 123, followed by 5 spaces.

 If you use right justification, the value will print as 8 characters,
consisting of 5 spaces, followed by 123.

Editing the Report Width
To change the report width, from the Summary Report Window, select Edit
> Report Width. Change the width and press F5.

Deleting the Report
To delete the report, from the Summary Report Window, select Edit >
Delete.

Editing the Report Codes
Viewing the Report Codes
The information you enter in the Report Window is represented by a string
of codes that indicate each item entered and information such as its
justification, length, and position. You can view and edit these codes. To
view the codes, from the Report Window select View > Codes. The Report
Codes Update panel displays.
Report Codes Update
_
_
_
_

Row 1 to 4 of 4

{L030} DX001(01:20)
" "{L028} X001
"\N"{L030} DI002(01:20)
{L020} I002(001:008)

In the example above, there is a description of an extended internal item,
the value of an extended internal item, a description of a regular internal
item, and the value of a regular internal item. The following sections will
explain the codes and then tell you how to edit them.

Types of Codes
Following is a description of each type of report code. Report codes consist
of a combination of a constant string, format specifier, and symbolic.
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Constant String Codes
Constant strings are enclosed in double quotes (" ") and may contain
formatting escape sequences. These codes include:
Code

Represents

"\F"

Form feed. The information that follows this code will begin on the top
of the next page

"\N"

New line. Adds a new line.

"\""

Adds a quote character in the string

"\\"

Adds one \ to the character string. For example, the following code
would print the string JAMES at the top of the output page and then
advance to the next line: "\FJAMES\N"

Format Specifier Codes
Format specifiers are enclosed in curly brackets and contain:

 The letter C (center), R (right), L (left) or A (As is). For more
information on justification, see “Setting the Justification Options” on
page 589.

 A number specifying the fixed width.
For example, the format specifier {C40} indicates that the item is center
justified over the next 40 characters.
Symbolics
Symbolics represent the item type that you add to the Free-Form Report.
They end with one of the following:

 A blank space
 " (a double quote symbol)
 { (an open curly bracket)
Symbolics referring to text may also contain codes indicating the portion of
the text you want to include in the form (i:j), where i is the position and j is
the length. For example, DI1(47:6) represents an internal item description
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for internal item 1 beginning at position 47 for a length of 6. There would be
a space after the close parenthesis symbol at the end. Below is a list of
symbolics.
Code

Represents

CY

Cycle number.

Innn1

Internal item values.

DInnn1

Description of the internal item.

Xnnn1

Extended internal item values

DXnnn1

Description of the extended internal item

Ennn1

History item values.

DEnnn1

Description of history item values.

Cnnn1

Calculated items.

DCnnn1

Description of calculated item values.

RCnnn

Rule return code, where nnn is the rule number. For the overall
return code, nnn=000.

RSnnn

Return code message, where nnn is the rule number.

RVnnn

Rule variance values, where nnn is the rule number.

DRnnn

Description of rule item values, where nnn is the rule number.

S

Message string for the return code.

$PAGE

The current page number in the user formatted report.

$DATE

The execution date for the free-form report. The date is
formatted according to the date criteria in the User Options file.

$TIME

The execution time for the free-form report; the time is
formatted as hh.mm.ss.

$CUST

The user name from the control file.

$BJTITLE

The report (title) from the basic job information.

$JID

The job ID in the JJJJJJJJ/SSSSSSSS/QQ format, where J is
the Job Name, S is the Step Name, and Q is the qualifier.

1

592

nnn represents the item number, for example, 001.

Infogix, Inc.

Setting Up Free-Form Reports  18
Printing the Free-Form Report

Deleting, Inserting, and Replacing Rows of Code
Edits You Can Make
 To delete one or more rows of code, enter D to the left of the rows.

 To insert a blank row below one or more rows, enter I to the left of the
rows.

 To replace code in one or more rows, type over it. To avoid overtyping,
first press the Insert key. If your changes do not fit on the row, insert a
blank row.
Ways to Make Edits

 You can make your edits one at a time, pressing Enter after each change.
 You can edit multiple lines of code at once, performing different kinds
of edits at the same time. The system makes all specified changes after
you press Enter.
Messages
The system generates one of the following online messages indicating
whether your edits passed the validation checks:

 CODES UPDATED
 CODES DID NOT PASS EDITS

Printing the Free-Form Report
To set the report to print when the job runs, select Edit > Print Options
to display the Free-Form Print Options panel. You must go into this panel
to print the report.
Free-Form Print Options
Select a choice for printing the Free-Form report:
1_ 1. Do not print the report
2. Print the report
3. Print the report only when out-of-balance
4. Print the report only when in-balance
Freeform Report XML option:
1_ 1. Default to User Options
2. Do not generate
3. Generate, write to file
4. Generate, autoload to database
F1=Help

F2=Split
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Note:

When a job has multiple qualifiers, you need to select Print the
report for each qualifier you want to print.

Select a choice for printing the Free-Form report. Select the option
you want. The default is Do not print. You must change it to get the report.
Free-Form XML Option. This field applies only when running in batch.
It enables you to set a job-level option for generating a copy of the report in
XML format. Your setting here will override the corresponding systemwide (user options) XML option (see “XML Options” on page 129). You can
override the job-level option you set here at the JCL level. For JCL override
instructions, see “SUM2000 JCL Parms for the File Interface Balancing
Program” on page 388. The options are as follows:
1. Default to user options. Defaults to the option specified for the

Freeform report field in user options.
2. Do not generate. Do not generate the report in XML format.
3. Generate, write to file. Create a copy of the report in XML format and

write to the file specified.
4. Generate, autoload to database. Create a copy of the report in XML

format and write to the associated database. The fail option and
maximum size are specified in user options.

Viewing a Free-Form Report
To view the Free-Form Report, after running the job online, select View >
Free-Form Report. After running the job in batch, look for the DDNAME
UNIUFR.
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Setting Up User Reports
This chapter explains how to create a User Report. It contains the following
sections:






“What is a User Report?” on page 595
“Setting Up a User Report” on page 595
“Completing the User Report Panels” on page 597
“User Report Samples with Field Definitions” on page 610

What is a User Report?
The User Report is a custom report limited to 8 columns that prints any of
the data that can be included in the Control Report in the order that you
specify.

Setting Up a User Report
Following is a procedure for setting up the report:
1. Several system-wide options for report formatting can be set in your

user options. See “Setting the User Options” on page 115.
2. If you have not already done so, from the Job Window, select and

complete the Job Information for the balancing job.
3. From the Job Window, select Report Options > User Report to

display and make your selections from the User Report Window. For
more information, see “User Report Window” on page 597.
4. From the User Report Window, select User Report Information to

display the User Report Properties panel. This panel enables you to
select the standard format of up to 4 columns or the enhanced format
of up to 8 columns. The enhanced format supports the display of
extended data without wrapping. For instructions, see “User Report
Properties Panel” on page 597.
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5. When you press F5 after completing the properties panel, a panel for

defining the column headings will be displayed. The fields will differ
depending on whether you are using the standard or enhanced format.
For instructions, see “User Report Column Headings Panels: Standard
and Enhanced Formats” on page 599. Complete the panel and press F5
to display the User Report Window.
6. You can optionally define a one-line header containing a variety of

information types that will appear above the column headings on each
page of the report. To do this, see “User Report Page Header
Information Panel” on page 600.
7. From the User Report Window, select User Report Detail Lines >

New to display the User Report Detail Lines panel. The fields will
differ depending on whether you are using the standard or enhanced
format. For instructions, see “User Report Detail Lines Panels:
Standard and Enhanced Formats” on page 602. Complete the panel
again for each line of data (up to 100) you want to include in the report.
You can insert a detail line between existing detail lines. Enter I next to
a detail line to insert a new line below the selected line.
8. From the User Report Window, optionally select User Report

Header/Trailer Lines > New to display the Header/Trailer
Options (Selection) Panel. This panel allows you to select options for
defining up to 2 header lines and 2 trailer lines (in addition to the
standard report header) to appear on each page. An additional panel
will display depending on the option you select. For more information,
see “User Report Header/Trail Options (Option Selection) Panel” on
page 606.
9. To generate the report, run the job. The DDNAME for the report in

your output will be UNIUSR.

596

Infogix, Inc.

Setting Up User Reports  19
Completing the User Report Panels

Completing the User Report Panels
User Report Window
From the Job Window, select Report Options > User Report to display
and complete the User Report Window.
ACR/Summary User Report Window

Row 1 from 6

_
A. User Report Information
_
Title:
_
B. User Report Page Header Information:000
_
< NEW... >
_
B. User Report Detail Lines: 000
_
< NEW... >
_
C. User Report Header/Trailer Lines: 000
_
< NEW... >
************************ Bottom of data ************************

Command Line ===> _______________________________________________
F1=Help F3=Exit F7=Up
F8=Down

User Report Properties Panel
From the User Report Window, select User Report Information to
display the User Report Properties panel.
User Report Properties
Report title:

________________________________________

Specify a print option:
2
1. Do not print the
2. Print the report
3. Print the report
4. Print the report

report
for all balancing steps
only if a job is out of balance
only if the job is in balance

User Report XML option:
1_ 1. Default to user options
2. Do not generate
3. Generate, write to file
4. Generate, autoload to database
Enhanced Format: N (Y/N)
Wrap Data: N (Y/N)
Width: 132 (70-250)
Fixed Spacing: N (Y/N)
Number of spaces between columns: __

F1=Help

F2=Split
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Report title. Assign a meaningful name to the report.
Specify a print option. Options:
1. Do not print the report.
2. Print the report for all balancing steps. This is the default option.
3. Print the report only if a job is out of balance.
4. Print the report only if a job is in balance.

User Report XML option. This field applies only when running in batch.
It enables you to set a job-level option for generating a copy of the report in
XML format. Your setting here will override the corresponding systemwide (user options) XML option (see “XML Options” on page 129). You can
override the job-level option you set here at the JCL level. For JCL override
instructions, see “SUM2000 JCL Parms for the File Interface Balancing
Program” on page 388. The options are as follows:
1. Default to user options. Defaults to the option specified for the User

report field in user options.
2. Do not generate. Do not generate the report in XML format.
3. Generate, write to file. Create a copy of the report in XML format and

write to the file specified.
4. Generate, autoload to database. Create a copy of the report in XML

format and write to the associated database. The fail option and
maximum size specified in user options will apply.
Enhanced Format. Options:
N. Do not use the enhanced format. Produces a report with up to 4
columns, each with a maximum width of 18 (or 22 if 22-character
formatting is specified, as explained in “22-Character Numeric
Formatting” on page 141). Wrapping of characters within the column
can be specified. If you use this format and wrapping is not specified,
values that will not fit will be truncated. To avoid truncation, text
values will require room for all characters and 2 additional positions
for single quotes that will be printed around the item.
Y. Use the enhanced format. This format supports the display of
extended data without wrapping. Produces a report with up to 8
columns. Wrapping of characters within the column cannot be
specified. Values that do not fit will be truncated. To avoid truncation,
text values will require room for all characters and 2 additional
positions for single quotes that will be printed around the item.
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Wrap Data. If you are not using enhanced format, you can change to Y to
wrap characters that do not fit in the columns.
Width. If you are using the enhanced format, you can specify any report
width within the range shown on the panel.
Fixed Spacing. For enhanced format, you can choose to print columns
with the same number of spaces between each column.
Number of spaces between columns. If you specified Y for Fixed
Spacing, specify the number of spaces to separate each column. Valid
values are 0-99.
When you press F5, the appropriate column headings panel shown in the
next section will be displayed, depending on whether you selected the
enhanced format.

User Report Column Headings Panels: Standard and Enhanced
Formats
User Report Standard Column Headings Panel: Standard
Format
User Report Standard Column Headings
Column
Column
Column
Column

heading
heading
heading
heading

F1=Help
F5=Accept

1:
2:
3:
4:

__________________
__________________
__________________
__________________

F2=Split
F9=Swap

F3=Exit

Column heading fields. Specify the headings that will appear in up to 4
columns across the report.
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User Report Enhanced Column Headings Panel: Enhanced
Format
This panel displays if you selected Enhanced Format on the User Report
Properties panel.
User Report Enhanced Column Headings
Col
Col
Col
Col
Col
Col
Col
Col

heading
heading
heading
heading
heading
heading
heading
heading

F1=Help

1:
2:
3:
4:
5:
6:
7:
8:

________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________

F2=Split

F3=Exit

F5=Accept

Pos:
Pos:
Pos:
Pos:
Pos:
Pos:
Pos:
Pos:

000
000
000
000
000
000
000
000

Len:
Len:
Len:
Len:
Len:
Len:
Len:
Len:

00
00
00
00
00
00
00
00

F9=Swap

Column heading fields. Specify the headings that will appear in up to 8
columns across the report.
Pos. Position. Specify the position on the line where this heading should
start. For example, if the report is 250 characters wide, you might want one
of the headings to start at position 210.
Len. Length. Specify the number of characters in the heading.

User Report Page Header Information Panel
You can optionally define a one-line header containing a variety of
information types that will appear above the column headings on each page
of the report. To do this, from the User Report Window, select New under
User Report Page Header Information to display the User Report
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Page Header Information Panel. This panel enables you to specify one item
to be included in the page header line. You can define additional page
header items by accessing this panel again.
User Report Page Header Information
Header number: 001
Select one :

Sel Pos
_ 000
F1=Help

1.
2.
3.
4.
5.
6.

Internal item
History item
Calculated item
Rule return code
Extended internal item
Literal

Len Num Just
00 ___ _

F2=Split

F3=Exit

Literal
______________________________________
F5=Accept

F6=Items

F9=Swap

Header number. The system assigns the header number incrementally.
Select one. Displays the types of information you can choose from for this
header item.
Sel. Do one of the following:

 If you want this page header item to contain the value of a specific item
defined for the job (this can be an internal item, extended internal item,
history item, calculated item, or the return code for a specific rule),
position the cursor in this field and press F6 to display the Item List
Window, shown in the sample below. Select the item from the list.
After you press Enter, the Sel (item type) and Num (item number)
fields will be populated. (Alternatively, you can enter the item type and
item number manually.)
Item List Window
_
_
_
_
_
_

I-001
I-002
I-003
I-004
I-005
I-006

Row 1 from 83

TEXT INTERNAL ITEM
COUNT INTERNAL ITEM
AMOUNT INTERNAL ITEM
DATE INTERNAL ITEM
2 TEXT II
2 COUNT II

Command Line ===> _______________________________________________________
F1=Help F3=Exit F7=Up
F8=Down

 If you want this page header to contain a literal, enter 6 in this field and
complete the Literal field.
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Pos. Position. Specify the leftmost position of this page header item on the
line.
Len. Length. Specify the number of characters to reserve for the value of
this page header item on the line.
Num. Enter the item number for any item type except literal unless this
was entered automatically. For Rule return code, you can enter an
individual rule number to specify the return code for an individual rule, or
999 to print the overall return code for the job.
Just. Enter L, R, or C to specify left, right, or center justification.
Literal. If the item type is literal, enter the literal.
After pressing F5 to accept your entries, you can enter optionally select
User Report Page Header Information as needed to enter additional
items to include in the page header.

User Report Detail Lines Panels: Standard and Enhanced Formats
After specifying the report properties, column headings, and page headers,
from the User Report Window, select User Report Detail Lines. The User
Report Detail Lines panel (standard or enhanced format) will be displayed.
Use this panel to define the information that will appear in each of up to 100
lines to appear on the report. To create a blank line, leave all of the column
information blank.

User Report Detail Lines Panel: Standard Format
User Report Detail Lines
Line number: 001
Description: ________________________________________
Select one item type per column:
1. Internal item
2. History item
3. Calculated item
4. Rule return code
5. Fill character
6. Extended internal item

Column
Column
Column
Column

1
2
3
4

F1=Help
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:
:
:
:

Item type
_
_
_
_

F2=Split

Item #
___
___
___
___

F3=Exit

or

Fill character
_
_
_
_

F5=Accept

F6=Items

F9=Swap
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Line number. Defaults to the next available number.
Description. An optional description for the information on this line that
will appear in the leftmost column of this report line.
Select one item type per column. Displays the types of information
you can choose to be displayed in each column on this line.
Item type. Do one of the following:

 If you want the column to contain the value of a specific item defined for
the job (this can be an internal item, extended internal item, history
item, calculated item, or the return code for a specific rule), position the
cursor in this field and press F6 to display the Item List Window, shown
in the sample below.
Item List Window
_
_
_
_
_
_

I-001
I-002
I-003
I-004
E-001
R-001

Row 1 from 7

1
2
3
4
HIST 1
RULE 1

Command Line ===> _______________________________________________________
F1=Help F3=Exit F7=Up
F8=Down

Select the item from the list. After you press Enter, the Item type and
Item # fields will be populated. (Alternatively, you can enter the item
type and item number manually.)

 If you want the column value to be the overall rule return code for the
job, enter 4 in this field and enter 999 in the Item # field.

 If you want the column to be populated by fill characters, enter 5 in this
field and complete the Fill character field.
Item #. If the Item Type for this column is not a fill character, and you
already selected the item you want as described in the instructions for the
Item type field above, this field will already be populated. If you want the
column value to be the overall rule return code for the job, enter enter 999
in the Item # field as described above.
Fill character. If the Item Type for this column is a fill character, enter the
character you want to fill the column on this line. Blanks are not allowed.
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User Report Detail Lines Panel: Enhanced Format
This panel displays if you selected Enhanced Format on the User Report
Properties panel.
User Report Detail Lines
Line number: 001
Select one per column:

Column 1:
Column 2:
Column 3:
Column 4:
Column 5:
Column 6:
Column 7:
Column 8:
F1=Help

Sel
_
_
_
_
_
_
_
_

Pos Len
000 00
000 00
000 00
000 00
000 00
000 00
000 00
000 00
F2=Split

1.
2.
3.
4.
5.
6.
7.

Internal item
History item
Calculated item
Rule return code
Fill character
Extended internal item
Literal

Num Fill Literal
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
___ _
________________________________________
F3=Exit
F5=Accept
F6=Items
F9=Swap

Line number. This field defaults to the next available number.
Select one item type per column. Displays the kinds of information
you can choose to be displayed in each column on this report line.
Sel. For each column, specify the item type whose value will appear in this
column on this line.

 If you want the column to contain the value of a specific item defined for
the job (this includes the return code for a specific rule), position the
cursor in this field and press F6 press F6 to display the Item List
Window, shown in the sample below.
Item List Window
_
_
_
_
_
_

I-001
I-002
I-003
I-004
E-001
R-001

Row 1 from 7

1
2
3
4
HIST 1
RULE 1

Command Line ===> _______________________________________________________
F1=Help F3=Exit F7=Up
F8=Down
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Select the item from a list of all items defined for the job. After you
press Enter, the Sel and Num fields will be populated. (Alternatively,
you can enter the item type and item number manually.)

 If you want the column value to be the overall rule return code for the
job, enter 4 in this field and enter 999 in the Num field.

 If you want the column to be populated by fill characters, enter 5 in this
field and complete the Fill character field.

 If you want the column value to be a literal, enter 7 in this field and
complete the Literal field.
Pos. Position. Specify the leftmost position of this column on this line. For
example, if the report is 250 characters wide, the leftmost position of one of
the columns on this line could be position 200.
Len. Length. Specify the number of characters to reserve for the value in
this column on this line. For text items, add 2 to the length of the value
when calculating the required length because the value will be printed
between single quotes.
Num. If the selection in the Sel field for this column is not fill character
(#5) or literal (#7), enter the number of the item type whose value will
appear in this column on this line. For Rule return code, you can enter an
individual rule number to specify the return code for an individual rule, or
999 to print the overall return code for the job.
Fill character. If item type indicated in the Sel field for this column on
this line is #5 (fill character), enter the character you want. Blanks are not
allowed.
Literal. If the item type for this column on this line is literal, enter the
literal.
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User Report Header/Trail Options (Option Selection) Panel
From the User Report Window, optionally select User Report Header/
Trailer Lines to display the Header/Trailer Options (Option Selection)
Panel. This panel allows you to define up to 2 header lines and 2 trailer lines
(in addition to the standard report header identifying the product, release,
date, time, type of report, etc.) to appear on each page.
Header/Trailer Options
Select a print item:
__ 1. Cycle ID...
2. Literal value...
3. User-defined job ID...
4. Job name/step name/JSQ...
5. Return code to always print...
6. Messages to print if issued...

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Select a print item. Indicate the type of information you want to be
displayed in either the header or trailer of the report.
1. Cycle ID. The cycle number and run number. Displays the “Header/

Trailer Options (Cycle ID) Panel” on page 607
2. Literal Value. Literal text based on the results of the balancing process.

Displays the “Header/Trailer Options (Literal Value) Panel” on
page 608
3. User-defined Job ID. The job name, step name, and qualifier. Displays

the “Header/Trailer Options Panel” on page 609, which is shared by
options 3 through 6.
4. Job name/step name/JSQ. The job name, step name, and qualifier

with slashes as delimiters. Displays the “Header/Trailer Options
Panel” on page 609, which is shared by options 3 through 6.
5. Return code to always print. The highest return code for this job.
6. Messages to print if issued. The message associated with the highest

return code for the job. Displays the “Header/Trailer Options Panel”
on page 609, which is shared by options 3 through 6.
Complete the panel corresponding to the option you selected. These panels
are documented in the next section, "Individual Header/Trailer Options
Panels."
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Individual Header/Trailer Options Panels
Header/Trailer Options (Cycle ID) Panel
Header/Trailer Options (Cycle ID)
Title number:
001
Specify line type:
__ 1. Header
2. Trailer
From:
Position: . . . . . __
To:
Position: . . . . . ___

Specify line number:
__ 1. Line 1
2. Line 2

Length: __

Length: ___

Specify cycle type:
1_ 1. User-defined cycle ID
2. MM/DD/YY
3. YY/MM/DD
4. DD/MM/YY
5. MM/DD/YY RRR
6. YY/MM/DD RRR
7. DD/MM/YY RRR
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

Title number. Indicates the number of the header/trailer option you are
defining. It defaults to the next available number.
Specify line type. Indicate whether you want the cycle ID to appear in the
header or trailer.
Specify Line Number. Indicate on which of the two available lines in the
header or trailer you want to place the information.
From Position. Position where the cycle ID should begin printing.For
example, if your cycle ID is 20080929 and you want 0929 to appear in the
header or trailer, you would enter 5, indicating the fifth position of the cycle
number.
(From) Length field. Number of characters of the cycle ID that you want
to print. For example, if your cycle ID was 20080929 and you want 0929 to
appear in the header or trailer, you enter 4.
To Position. Indicate the position on the print line you want the cycle ID
to begin.
(To) Length. Length of the cycle ID on the report line. When the From and
To lengths are not the same, truncation or padding with spaces occurs.
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Specify Cycle Type. Cycle format of the cycle ID you are specifying. This
should be the format used when the job was created. Valid options are:

 Option 1. User-defined Cycle ID. Your own defined cycle ID, which does
not conform to the current date.

 Other options: MM = month, DD = day, YY = year, RRR = run number.
Header/Trailer Options (Literal Value) Panel
This option allows you to place text in the header or trailer based on the
results of the balancing process.
Header/Trailer Options (Literal Value)
Title number:
001
Select an option:
__ 1. Always print literal value
2. Print literal value only when job is in balance
3. Print literal value only when job is out of balance
Specify line type:
__ 1. Header
2. Trailer
Literal value

Specify line number:
__ 1. Line 1
2. Line 2
1 ----+----1----+----2
. . . ____________________

From:
Position: . . . . . 00
To:
Position: . . . . . 000

F1=Help

F2=Split

Length: 00

Length: 000

F3=Exit

F5=Accept

F9=Swap

Title number. Indicates the number of the header/trailer option you are
defining. It defaults to the next available number.
Select an option. When to print the literal.
1. Always print the literal value.
2. Print literal value only when job is in balance.
3. Print literal value only when job is out of balance.

Specify line type. Indicate whether you want information in the header
or trailer.
Specify Line Number. Indicate on which of the two available lines you
want to place the information.
Literal value. 1 to 20 alphanumeric characters.
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From Position. First position of the literal that you want to appear in the
header or trailer.
(From) Length. Length of the literal to print.
To Position. Position on the print line you want the literal to begin.
(To) Length. Length of the literal on the report line. When the From and
To lengths are not the same, truncation or padding with spaces occurs.

Header/Trailer Options Panel
Options 3 through 6 on the Header/Trailer Options (option selection) panel
correspond to this panel.
Header/Trailer Options
Title number:
001
Specify line type:
__ 1. Header
2. Trailer
From:
Position: . . . . . 00
To:
Position: . . . . . 000

F1=Help

F2=Split

Specify line number:
__ 1. Line 1
2. Line 2

Length: 00

Length: 000

F3=Exit

F5=Accept

F9=Swap

Title number. Indicates the number of the header/trailer option you are
defining. It defaults to the next available number.
Specify line type. Indicate whether you want information in the header
or trailer.
Specify Line Number. Indicate on which of the two available lines you
want to place the information.
From Position. First position of the selected information type that you
want to appear in the header or trailer.
(From) Length. Length of the selected information type to print.
To Position. Position on the print line you want the selected information
type to begin.
(To) Length. Length of the selected information type on the report line.
When the From and To lengths are not the same, truncation or padding
with spaces occurs.
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User Report Samples with Field Definitions
Standard Format
ACR/S release#
DATE: yy/mm/dd
TIME: 15:02:09

XYZ COMPANY
BALANCING USER REPORT
ENERGY REPORT - 12/2005

COPYRIGHT INFOGIX, INC.
PAGE 001
DATA BASE VERSION: 0000006/0000005

Energy Usage by Type and Date
DESCRIPTION
---------------------------------------NATURAL GAS
OIL
COAL

RECEIPTS
-----------------74,814,392,365.85
1211217599245.34
$1,289,336,185.67

IN BALANCE

DATE
-----------------yy/mm/dd
yy/mm/dd
yy/mm/dd

(RETURN CODE = 0000)

Enhanced Format
ACR/S release#
DATE: ccyy/mm/dd
TIME: 15:21:02

XYZ COMPANY
BALANCING USER REPORT
USER REPORT ENHANCED FORMAT

COPYRIGHT INFOGIX, INC.
PAGE 001
DATA BASE VERSION: 0000014/0000012

ENHUSR /STEP1
/
Inventory per Company by Count, Amount, and Date
DATE
ccyy/06/18
ccyy/04/15
ccyy/10/14
ccyy/12/03
ccyy/01/07
ccyy/05/05
ccyy/02/29

COUNT 1
65,329
76,783
56,298
85,234
42,735
81,351
42,333

AMOUNT 1
$842.00
$1,674.00
$1,254.00
$2,697.00
$392.00
$628.00
$791.00

**OUT OF BALANCE**

AMOUNT 2
$847.00
$1,674.00
$1,254.00
$2,697.00
$362.00
$628.00
$791.00

COMPANY
'CROSS MANUFACTURING'
'PARKER EQUIPMENT'
'BIC RESEARCH'
'ROSEART PICTURES'
'SANFORD STEEL'
'DIXON MASONRY'
'FABER MARKETING'

(RETURN CODE = 1224)

Report Fields
The fields can be interpreted as follows:
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Field

Description

Description

An optional description that prints in the far left column only
if the report is in the standard format.

Page Header

An optional one-line header containing a variety of
information types that will appear above the column
headings on each page of the report.
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Field

Description

Column
headings

Headings for up to 4 columns (8 for the enhanced format)
specified by the user.

Detail lines

The lines below the heading line can be populated by values
from internal items, extended internal items, history items,
calculated items, rule return codes, literals, fill characters, or
blanks.

Header/trailer
lines

Additional information may be defined to appear in custom
header and/or trailer lines that print on each report page in
addition to the standard report header.
Not shown in the example.
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20
Using File Control Balancing
This chapter describes file control balancing, a feature that enables you to
detect incorrect input files before they are processed and avoid most of the
work of processing a rerun.
This chapter contains the following sections:

 “Understanding File Control Balancing” on page 613
 “Example of File Control Balancing” on page 619
 “Using GDGs in File Control Balancing” on page 623

Understanding File Control Balancing
File Control Balancing Vs. (Typical) Control Value Balancing
ACR/Summary supports two types of balancing:

 Control value balancing. This is the typical type of balancing that has
been discussed in the rest of this manual, where the system extracts
values from input source files to use in rules. These rules verify the
accuracy of totals, subtotals, record counts, dates and text.

 File control balancing. This type of balancing is used to verify that one
or more files used as input to the current job matches the appropriate
output file created in a previous job-step. If a mismatch is found, you
specify whether the system should 1) abend the job or 2) process the job
and generate error messages that will appear in the File Control
Balancing Report.

File Types Supported
The file types supported include the following:







Sequential datasets.
Partitioned (PDS) datasets.
Generation data groups (GDGs).
VSAM files.
Database files.
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ACR/Connector Restriction
When using ACR/Connector, File Control balancing is not available across
platforms.

Using File Control Balancing with Control Value Balancing
You cannot combine file control balancing with control value balancing in
a single ACR/Summary job-step. If you need to verify the accuracy of totals,
subtotals, record counts, dates and text, create one or more separate ACR/
Summary control value balancing job-steps.

Setting Up File Control Balancing
As will be detailed in “Verifying Multiple Input Files” on page 617, multiple
input files from multiple sources can be verified against multiple output
files.
For ease of understanding, the following procedure assumes that you are
verifying only a single input file that uses the following jobs and files:

 Job A. This job creates output file A. This file is intended for use as input
to Job B.

 Job B. This job runs later and uses file B as input.
Before Job B uses file B as input, you want to verify that file B matches file
A.
1. In job A, create an ACR/Summary FCAPTURE job-step. This job-step

must be after the application job-step that generates output file A. Set
up the FCAPTURE step as follows:
a. In the basic file information, set Perform File Control to Y. This

will change the appearance of the Internal Items panel so you can
create a file control internal item in the next step.
b. Use a file control internal item (which will be detailed below) to

capture the following information that identifies file A:

 The dataset name (DSN).
 The partitioned dataset (PDS) member name, if applicable.
 The first volume serial number (VOLSER).
Job A stores history, so that this file control internal item will be
available for use in the FVERIFY step in Job B.
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2. In job B, create an ACR/Summary FVERIFY job-step. This job-step

must be before the application job-step that uses file B as input. Set up
the FVERIFY step as follows:
a. In the basic file information, set Perform File Control to Y.
b. Use a file control internal item to capture information that

identifies file B (the DSN, PDS member name if applicable, and the
first VOLSER).
c. Use a file control history item (this is exactly the same as a regular

history item) to retrieve the identifying information for file A that
was captured in the FCAPTURE step from the history database.
Note:

The ACR/Summary features associated with internal and history
items in typical control value balancing jobs (such as variable
cycle and relative cycle) can also be used when defining file
control internal and history items.

d. Create a rule to match the information for file B from the file

control internal item defined in step 2b against information from
the file control history item defined in step 2c.
Set the Rule Action field to determine what the system will do if it
encounters a mismatch. Specify either 1) Set a completion code (in
this case the input file will be used even if it is not the correct file,
or 2) Set an abend code. This will stop processing.
The rule should also be assigned a return code and corresponding
message. The message should include the job and step names
associated with the mismatched files along with the message text.
If a mismatch is found, #U (Infogix) messages will be generated showing
the actual DSNs, PDS member names (if applicable), and first VOLSER of
the mismatched files along with the step names and DDNames of the files
allocated. This information will appear in the File Control Balancing
Report.
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Sample File Control Balancing Report
Following is an example of the report.
ACR/S releasenumber
DATE: yy/mm/dd
TIME: 15:31:15

INFOGIX, INCORPORATED
BALANCING CONTROL REPORT
SAMPLE FILE CONTROL BALANCING REPORT
JOB=INPUT
STEP=CAPTURE QUAL=
CYCLE#=20070305 RUN#=000

COPYRIGHT UNITECH SYSTEMS, INC.
PAGE 0001
DATA BASE VERSION: 0000092/0000021

A.

INTERNAL FILE CONTROL ITEMS:
-----------------DATA SET INFORMATION-------------------------- -----STEP----- -----DD-------ITEM NO.
DSN
MEMBER
VOLSER
NAME
OCC
NAME
CONCAT
------- -------------------------------------------- -------- -------------- --- -------- -----I-001
R99UC15.SUM1.XXXX.G0028V00
UNI006
STEP1
001 DDXXX
001
DESCRIPTION: JOBB STEPX DSN INFO
B. EXTERNAL FILE CONTROL ITEMS:
-----------------DATA SET INFORMATION-----------------------ITEM NO.
DSN
MEMBER VOLSER
JOB
STEP QUAL ITEM CYCLE# RUN RUN DATE RUN TIME
------- -------------------------------------------- -------- ------ -------- -------- --- ---- -------- --- ---------- -------E-001
R99UC15.SUM1.XXXX.G0027V00
UNI006 INPUT
CAPTURE
001 20080222 000 mm/dd/yy 15:12:55
DESCRIPTION: JOBA STEPX DSN INFO
D. BALANCING RULES & RESULTS:
ITEM NO.
BALANCING RULE
RESULT
ERROR
--------------------------------------------------R-001
I-001 EQ E-001
**OUT OF BALANCE**
** DSN **
E. SPECIAL INSTRUCTIONS:
RETURN
RULE NO.
CODE
INSTRUCTIONS
-------- ------ -------------------------------------------------------------------------------1.
2223
CURRENT FILE NOT THE SAME AS THE FILE IN HISTORY!!!!

**OUT OF BALANCE**
(RETURN CODE = 2223)
UNITECH DATABASE: R99UC43.SUM1.DEFN
(DF)
/ R99UC43.SUM1.HIST
JOB START DATE=mm/dd/yy
PROGRAM= UAC2000 LOAD LIBRARY NAME=UNI.TAPESHIP.releasenumber.LOADLIB
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File Control Balancing Job Flow
The following diagram illustrates the file control balancing job flow.

Application Step
..
Application Step n

Stores file
information
in history

ACR/Summary File Capture Step

captures info from application output file

History
Database

ACR/Summary File Verify Step

verifies input file against the output file

Application Step
..
Application Step n

Retrieves file
information
from history

Verifying Multiple Input Files
The explanation above was simplified to aid in understanding. Actually file
control balancing can be used to capture information from multiple output
files and verify it against multiple input files, as follows:

 You can use multiple FCAPTURE steps to capture information about
multiple output files. You can also use a single FCAPTURE step to
capture information about up to 10 files that are output in the same job.
To capture information for more than 10 files, create additional
FCAPTURE job-steps using JSQs (qualifiers).

 You can use multiple FVERIFY steps to verify multiple input files. The
input files can be from a different job, from a previous run of the same
job, from a previous step in the same job, or from a combination of these
sources. You can also use a single FVERIFY step to verify up to 10 files
that are input to the same job.
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Completing the Internal Items Panel for File Control Balancing
When Perform File Control is set to Y, the Internal Items panel displays
as shown below. All other panels are the same as when the field is set to N.
Internal Items
Internal
Item number
001

-------------- Description ------------________________________________________
______________________________

Step name: ________
Step occurrence:

(1-999)

DDname: ________
Concatenation number:
F1=Help

F2=Split

(1-32)
F3=Exit

F5=Accept

F9=Swap

Internal item number. A number (001 to 010) identifying the file
control internal item. This number defaults to the next available internal
item number.
Description. Optionally describe the file that this item will store.
Step name. The step within the job where the relevant file is located.
Step occurrence. If this step name is used more than once in the job,
indicate the occurrence (001 to 999) of the step that this item references.
DDName. The name of the DD statement where the relevant file is
allocated.
Concatenation number. For concatenated datasets, enter the
concatenation number (002 to 032) within the DD where the referenced
file is located. Use 001 for datasets that are not concatenated.
Press F5 to accept.

Defining File Control Balancing Rules
For file control balancing, the balancing rules must be standard rules
defined as and active with a valid return code and associated message.
Specify only one item on each side of the operator as in the examples below.
Item
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LHS
(Internal Item)

(operator)

RHS
(History Item)

R-001:

(I-001)

EQ

(E-001)

R-002:

(I-1)

EQ

(E-2)
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Example of File Control Balancing
The following example shows how to set up file control balancing to verify
files between two daily payroll jobs.

Job PAY1 without File Control Balancing
Job PAY1 applies final payroll adjustments to the old payroll master file,
and outputs a new payroll master file.
The unmodified JCL for Job PAY1 looks like this:
//PAY1
JOB (PROD,0789,FIN),'PAYROLL UPDATE',CLASS=A,MSGCLASS=X
//*
//PAYUPDT EXEC PGM=PAY31200
//STEPLIB
DD DSN=PROD.PAYROLL.LOADLIB,DISP=SHR
//PAYADJST DD DSN=PROD.PAYROLL.ADJUST(+0),DISP=SHR
//OPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+0),DISP=SHR
//NPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+1),DISP=(NEW,CATLG),
//
UNIT=SYSALLDA,VOL=SER=PRD001,SPACE=(CYL,(10,1),RLSE)
//UPDTREPT DD SYSOUT=A
//

We will be adding a file control balancing step, PAY1 FCAPTURE, to this
job.

Job PAY2 without File Control balancing
Job PAY2 reads the new payroll master from PAY1 and prints the paychecks
and a payroll register.
The unmodified JCL for Job PAY2 looks like this:
//PAY2
JOB (PROD,0789,FIN),'PAYROLL CHECKS',CLASS=A,MSGCLASS=X
//*OUTPUT CHKS FORMS=CHKS
//*
//PRTCHKS EXEC PGM=PAY57800
//STEPLIB
DD DSN=PROD.PAYROLL.LOADLIB,DISP=SHR
//OPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+0),DISP=SHR
//TAXWHOLD DD DSN=PROD.PAYROLL.TAXWHOLD(+1),DISP=(NEW,CATLG),
//
UNIT=SYSALLDA,VOL=SER=PRD001,SPACE=(CYL,(1,1),RLSE)
//PAYCHKS
DD SYSOUT=K,FORMS=CHKS
//PAYRGSTR DD SYSOUT=A
//

We will be adding a file control balancing step, PAY2 FVERIFY, to this job.
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Creating the ACR/Summary Definitions for PAY1 FCAPTURE
1. Specify the Basic Job Information:
Job name
Step name
Report Title:
Store New History:
Set Return Code:
Perform File Control:

PAY1
FCAPTURE
Capture Output for Payroll
Adjustments Job
Y
Y
Y

2. Create a file control internal item to capture output file information for

the new payroll master created in step PAYUPDT:
File Control Internal Item Number:
File Control Item Description:
Step Name/Step Occurrence:
DDName/Concatenation Number:

001
New Payroll Master File
PAYUPDT/001
NPAYMSTR/001

JCL for Job PAY1 with File Control Balancing
In the generated JCL for Job PAY1, the FCAPTURE step is added as the last
step in the job stream. This enables it to capture and store file information
from the new payroll master that is output by the PAYUPDT step.
//PAY1
JOB (PROD,0789,FIN),'PAYROLL UPDATE',CLASS=A,MSGCLASS=X
//*
//PAYUPDT EXEC PGM=PAY31200
//STEPLIB
DD DSN=PROD.PAYROLL.LOADLIB,DISP=SHR
//PAYADJST DD DSN=PROD.PAYROLL.ADJUST(+0),DISP=SHR
//OPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+0),DISP=SHR
//NPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+1),DISP=(NEW,CATLG),
//
UNIT=SYSALLDA,VOL=SER=PRD001,SPACE=(CYL,(10,1),RLSE)
//UPDTREPT DD SYSOUT=A
//*
//FCAPTURE EXEC PGM=UAC2000
//STEPLIB
DD DSN=PROD.UACRC31.LOADLIB,DISP=SHR
//UNICF
DD DSN=PROD.UACR.UNICF,DISP=SHR
//UNIDF
DD DSN=PROD.UACR.UNIDF,DISP=SHR
//UNIHF
DD DSN=PROD.UACR.UNIHF,DISP=SHR
//UNIACR
DD SYSOUT=A
//SYSOUT
DD SYSOUT=A
//
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Creating the ACR/Summary Definitions for PAY2 FVERIFY
1. Specify the Basic Job Information:
Job name
Step name
Report Title:
Store New History:
Return Code Indicator:
Perform File Control:

PAY2
FVERIFY
Verify Input for Print Paychecks
Job
Y
X - abend if out-of-balance
Y

2. Create a file control internal item to capture file information for the

current payroll master allocated in step PRTCHKS:
File Control Internal Item Number:
File Control Item Description:
Step Name/Step Occurrence:
DDName/Concatenation Number:

001
Current Payroll Master File
PRTCHKS / 001
COPAYMSTR / 001

3. Create a file control history item to retrieve the file information from

the file control item in PAY1 FCAPTURE from the history database.
This will retrieve the file information for the new payroll master file to
compare with the information for the current payroll master file.
File Control History Item Number:
External Job ID:
Relative Cycle Number:
Most Recent Indicator:
Internal Item Number:
Required item Indicator:
Variable Cycle Indicator:

001
PAY1 FCAPTURE
+00
N
001
Y
N

4. Define rule R-001 requiring that the current payroll master allocated

to PAY2 be the same file as the new payroll master created in PAY1:
Balancing Rule Number:
Balancing Rule Formula:
Return Code:
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5. Define a message for return code 1000 that indicates the action to take

when the DSNs or VOLSERs for the two files being compared are not
equal:
Message Item:
Return Code:
Message Text:

001
1000
WRONG PAYROLL MASTER -RERUN WITH CORRECT
MASTER FILE.

JCL for Job PAY2 with File Control Balancing
In the generated JCL for Job PAY2, the FVERIFY step is added as the first
step in the job stream. This enables it to verify file information from the
current payroll master against the information for the new payroll master
that was output by Job PAY1 before using it as input to the PRTCHKS step.
//PAY2
JOB (PROD,0789,FIN),'PAYROLL CHECKS',CLASS=A,MSGCLASS=X
//*OUTPUT CHKS FORMS=CHKS
//*
//FVERIFY EXEC PGM=UAC2000
//STEPLIB
DD DSN=PROD.UACRC31.LOADLIB,DISP=SHR
//UNICF
DD DSN=PROD.UACR.UNICF,DISP=SHR
//UNIDF
DD DSN=PROD.UACR.UNIDF,DISP=SHR
//UNIHF
DD DSN=PROD.UACR.UNIHF,DISP=SHR
//UNIACR
DD SYSOUT=A
//SYSOUT
DD SYSOUT=A
//*
//PRTCHKS EXEC PGM=PAY57800
//STEPLIB
DD DSN=PROD.PAYROLL.LOADLIB,DISP=SHR
//OPAYMSTR DD DSN=PROD.PAYROLL.MASTER(+0),DISP=SHR
//TAXWHOLD DD DSN=PROD.PAYROLL.TAXWHOLD(+1),DISP=(NEW,CATLG),
//
UNIT=SYSALLDA,VOL=SER=PRD001,SPACE=(CYL,(1,1),RLSE)
//PAYCHKS
DD SYSOUT=K,FORMS=CHKS
//PAYRGSTR DD SYSOUT=A
//

Performing the Balancing for the Example
When PAY1 FCAPTURE is executed, it will capture the dataset name and
first volume serial number of the updated payroll master file output by the
job and store the information as file control internal item 001 in the history
database.
When PAY2 FVERIFY is executed, it will do the following:
1. Capture the DSN and VOLSER of the current payroll master file in a

file control internal item.
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2. Retrieve the DSN and VOLSER of the updated payroll master file

(output by PAY1) as file control history item E-001.
3. Apply rule R-001 to see if the DSN and VOLSER information from the

two files above are the same.
4. Based on the rule results, one of the following will happen:

 If the files do not match, the message for return code 1000 will be
printed on the File Control Balancing Report, and the job will
abend.

 If the files match, job/step PAY2 PRTCHKS will be executed to
produce the paychecks and payroll register.

Using GDGs in File Control Balancing
This section shows you how to overcome the limitations on referring to
GDGs in situations where:

 Steps reference GDGs that have not yet been created.
 The GDG generation numbers have been changed in previous steps.
For example:
STEP

Description

1

Creates GDG(+1)

2

Any processing step.

3

Verifies the dataset to be used in step 4, but the dataset to be
confirmed is the GDG(+0) dataset (see step 4) has not yet run.

4

Processes the data, GDG (+0)

In this example, step 3 references the dataset information from step 4, but
the step 4 datasets have not yet been created. The catalog lookup causes the
dataset just created in step 1 to be considered the (+0) dataset. You will not
get the intended results because the catalog and the “to be executed” control
blocks will be out of sync.
To overcome this limitation, you can use one of the following approaches:

 Put step 1 and step 2 in one job and put step 3 and step 4 in a separate
job. The catalog issue happens only when all of the steps are in the same
job.
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 Add a dummy card to any prior or currently executing step (in this
example, step 2 and step 3). This will force a control block build and
change the verify to reference the intended dataset. For example:
//DREFER DD DSN=MY.GDG(+0),DISP=SHR,UNIT=(,,DEFER)

The DEFER parameter prevents unneeded and unwanted tape
mounts. The dataset defines will refer to DD name DREFER and the
step to which it was added instead of the dataset used in step 4.
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This chapter explains cycle IDs and describes the methods you can use to
set, verify, and/or override a cycle ID. It contains the following sections.

 “What is a Cycle ID?” on page 625
 “Methods of Setting the Cycle ID (in Order of Precedence)” on page 627
 “Setting the Cycle ID at Runtime (File Interface Mode Only)” on
page 628

 “Completing the Cycle Processing Options Panel” on page 629
 “Using the Cycle ID (UNICNUM and UNICNUM1) User Exits” on
page 633

 “Using an Options File (UNIOF)” on page 633

What is a Cycle ID?
A cycle ID is used to uniquely identify each run of a job. Cycle IDs are
especially important for storing and retrieving values from history records
(results of previous job runs) for use in the current job. Cycle IDs are
processed in ascending order.
A cycle ID consists of a cycle number and a run number, as described below:

Cycle Number
This is a number of up to 8 digits that must be greater than zero. Often the
best choice for a cycle number is the system date in Gregorian or Julian date
format. However, any ascending number can be used. There are a variety of
methods of assigning the cycle number.

Run Number
The run number consists of 3 digits and defaults to 000, which is often
sufficient if you use the system date as the cycle number and the job runs
only once a day. Run numbers other than 000 are most typically used for
jobs that use the system date as the cycle number and run multiple times
per day. A unique number for each run allows the history of each run to be
stored and retrieved for use in another job, as demonstrated in the next
section.

ACR/Summary User Guide for z/OS

625

21  Setting Up Cycle Processing
What is a Cycle ID?

Reasons for Using Run Numbers Other than 000
The most typical cases in which run numbers other than 000 are required
are as follows:
Storing Results of Multiple Runs of a Job on the Same Day
Run numbers are required for a job (we will call it Job A) when both of the
following are true:

 Job A uses the system date as its cycle number.
 Job A runs multiple times on the same day and needs to store history
for each run. In this case a unique run number is required for each run
so that each run will have a unique cycle ID. Otherwise the history
record for each run of Job A on the same date would overwrite the
previous history record, and only the last run of the day would be
stored.
Job

Cycle
Number

Run Number

Job A

20051127

001

Job A

20051127

002

Two Jobs Run on the Same Day and one Uses History from the Other
Suppose that in addition to Job A (described above), another job (Job B)
runs on the same day. The following are true of Job B:

 Job B uses the system date for its cycle number portion of the cycle ID.
 Job B needs to retrieve cycles of history from Job A. Job B’s cycle ID
(cycle number plus run number) must therefore be equal to or higher
than that of any cycle IDs of Job A that Job B needs to retrieve.
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Cycle
Number

Run Number

Job A

20051127

001

Job A

20051127

002

Job B

20051127

999
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Methods of Setting the Cycle ID (in Order of
Precedence)
The methods of setting, verifying, and/or overriding a cycle ID are listed
below in order of precedence from highest to lowest, along with reference
to detailed information. Keep the order of precedence in mind when
considering the method or methods you will use.
All methods except #2 (entering the cycle ID at runtime) are available in all
application interface modes.
1. Options File (DDNAME UNIOF). For details, see “Using an Options

File (UNIOF)” on page 633.
2. The cycle ID can be entered at runtime through a JCL parameter

(batch) or on the Balancing Run Options panel (online). This method
is available in file interface mode only, For details see “Setting the
Cycle ID at Runtime (File Interface Mode Only)” on page 628
3. The cycle ID can be set by the UNICNUM and UNICNUM1 user exits.
4. The cycle number can be extracted from the input source using file

definitions or set by Program Interface. For information, see “Creating
File Definitions” on page 261 or “Loading the Cycle Number” on
page 411.
5. Automatic cycle processing can be set up through the Cycle Processing

panel. For details, see “Completing the Cycle Processing Options
Panel” on page 629.
The following sections describe each method, starting with the methods
that are used most frequently.
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Setting the Cycle ID at Runtime (File Interface Mode
Only)
Completing the Balancing Run Options Panel in Online Mode
When running online, you can enter the cycle number and, if appropriate,
the run number at runtime in the Balancing Run Options panel.

Using JCL Parameters in Batch Mode
When running in batch, you can specify RERUN or CYC# and RUN#
parameters to set the cycle ID in the JCL. For more information, see
“SUM2000 JCL Parms for the File Interface Balancing Program” on
page 388. These parameters are typically used for testing or reruns.

Rerun Parameter
To rerun the latest cycle, use the RERUN parameter, which automatically
defaults to the latest cycle.

Cycle Number and Run Number Parameters
These parameters are used to rerun a cycle other than the most recent one.
The CYC# (cycle number) and RUN# (run number) parameters must be
specified.
Usually these parameters are used only in testing or rerun situations
because, if use the date as the cycle number, you will have to change the
date before each execution.
Note:
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in program interface mode. For more information, see Using an
Options File (UNIOF) on page 633

Infogix, Inc.

Setting Up Cycle Processing  21
Completing the Cycle Processing Options Panel

Completing the Cycle Processing Options Panel
This panel provides options for either of the following: 1) to automatically
generate all or part of the cycle ID (this is called automatic cycle processing
or 2) to verify cycle numbers against a cycle table.
Note:

Use Similar Cycle Processing Options for Related Jobs:
If you use the options on this panel to set the cycle ID, ensure
that related jobs use similar cycle processing techniques.
Examples of how jobs can be related include:
Jobs can be related through history items. History items are
retrieved based on both job ID and cycle ID. If the current job
uses a history item from a previous run of another job, the two
jobs are related
Jobs can be related through variable cycle processing. Variable
cycle processing enables you to specify a history item in the
current job that will be retrieved by referencing the run date and
time and/or the cycle ID of another job. The retrieving job and the
referenced job are related.
Cycle Processing Options

Use cycle processing? (Y/N)
Reference cycle job ID:
Job name:
________
Step name:
________
Qualifier:
__

N

Cycle table name:

________________

Select a cycle number computation if applicable:
_ 1. (J0) YYJJJn RRR, where n = 0-9 set by reference job, RRR = 000
2. (J9) YYJJJn RRR, where n = 9, RRR = 000
3. (G0) YYMMDD, RRR = 000
4. (G1) YYMMDD, RRR set by reference job
5. (G9) YYMMDD, RRR equals 999
6. (X0) Cycle number set in job, RRR = 000
7. (X1) Cycle number set in job, RRR set by reference job
8. (X9) Cycle number set in job, RRR equals 999

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Use cycle processing? Options:
N. Indicates that the cycle ID will be set either by 1) extracting the
cycle number from an input source based on your file definitions or 2)
by entering the cycle number (and optionally a non-000 run number)
in the Balancing Run Options panel when you run the job. When N is
selected, do not complete the remaining fields on the panel.
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Y. Indicates that you want to have the all or part of the cycle ID (cycle
number and run number) generated automatically. When Y is selected,
you must complete some of the remaining fields as specified below.
Reference cycle job ID: Job name/Step name/Qualifier. Complete
if you want to use cycle reference processing. When you do this, the cycle ID
of the current job (both the cycle number and run number) will be set to be
the same as that of the most recent run of the specified reference job. Cycle
reference processing is useful when you want all jobs in an application
system job stream to use the same cycle number. For example, you can
ensure that two jobs will always be given the same cycle number regardless
of whether they run before or after midnight.
If you use cycle reference processing, leave the remaining fields blank.
Cycle table name. If the cycle number is to be verified against a cycle
table, enter the cycle table name. For more information, see “Setting Up
Cycle Tables” on page 732.
If you complete this field, leave the other fields blank.
Select a cycle number computation.
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Valid options:
Note:

In the following options:
The 2 digits in parentheses represent the value that will be stored
in the Cycle Option field in the corresponding batch transaction
record.

RRR represents the 3-digit run number.
The date formats (YYJJJ, etc.) all represent the current system
date and use the following conventions:
DD represents the day number. Days less than 10 must have
a leading 0.
MM represents the 2-digit month number.
CC represents the 2-digit century.
YY represents the 2-digit year.
JJJ represents the 3-digit Julian day.
MMM represents the 3-character month (JAN, FEB, etc.).
1. J0. YYJJJn, RRR, where n=0-9 set by reference job, RRR = 000.

Here, n is a number between 0 and 9 based on the reference job ID.
RRR is 000. If YYJJJ is greater than the corresponding value for the
most recent cycle number of the reference job ID, n is set to 0.
Otherwise, n is incremented by 1.
2. J9. YYJJJn, RRR, where n=9, RRR = 000. This option is often used

for a job that retrieves control values from jobs using a J0 designation.
The 9 ensures that all jobs having an identical or lower cycle number
will be retrieved.
Only one cycle per calendar day is allowed. Any runs with the same
system date will result in a duplicate run error. To do a rerun, see
“Using JCL Parameters in Batch Mode” on page 628.
3. G0. YYMMDD, RRR=000. Any runs with the same system date will

result in a duplicate run error. To do a rerun, see “Using JCL
Parameters in Batch Mode” on page 628.
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4. G1. YYMMDD, RRR is set by reference job. Use this option if you have

a job that runs multiple times a day and you want to store each run in
history. To set the run number, the history database is searched for the
most recent cycle number of the reference job ID, and if it is the same
as the system date, the run number of the reference job ID is
incremented by 1 and used as the current job’s run number. For
example:
20130421 001 - cycle number and run number of reference job ID
20130421 002 - cycle number and run number of current job
If the system date is greater than the most recent reference job ID, the
run number is set to 001.
5. G9. YYMMDD, RRR=999. This is often used for a job that retrieves

control values from jobs using a G0 or G1 designation. RRR=999
ensures that all jobs having the same cycle number but with a lower
run number will be retrieved.
Only one cycle per calendar day is allowed. Any runs with the same
system date will result in a duplicate run error. To do a rerun, add a
parm in the JCL.
6. X0. Cycle number set in job, RRR=000. The cycle number is extracted

from the input source using file definitions. Only one cycle per cycle
number is allowed.
7. X1. Cycle number set in job, RRR set by reference job. The cycle

number is extracted from the input source using file definitions. To set
the run number, the history database is searched for the most recent
cycle number of the reference job ID, and if it is the same as the system
date, the run number of the reference job ID is incremented by 1 and
used as the current job’s run number.
If the cycle number extracted or entered is greater than the most recent
reference job ID, the run number is set to 001.
8. X9. Cycle number set in job, RRR=999. The cycle number is extracted

from the input source using file definitions and the run number is 999.
This is often used for a job that retrieves control values from jobs using
an X0 or X1 designation. Specifying 999 as the run number ensures
that all jobs having the same cycle number but with a lower run
number will be retrieved.
If a job with RRR=000 attempts to retrieve a history item from a job
with a non-zero run number, the run number of the target job is not
considered. If both jobs use non-zero run numbers, the run number of
the target job is considered.
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Using the Cycle ID (UNICNUM and UNICNUM1)
User Exits
The cycle ID (UNICNUM and UNICNUM1) user exits enable programmers
to modify the COBOL code to perform generation, manipulation, or
verification of a cycle ID set by another method.
These source members are identical, and both are invoked after the cycle ID
is set. However, they are called at different times. See “Cycle Number
(UNICNUM and UNICNUM1) User Exits” on page 671 for more
information and source listings, and use the member that is appropriate to
your processing.

Using an Options File (UNIOF)
An options file (UNIOF) is another method of setting the cycle ID. The
options file provides two options (cycle override and history insert) for
setting the cycle ID. When an option file is used, any other method of
setting the cycle ID will be overridden.
You can use an options file in any application interface mode, but it is most
often used in program interface mode, where it reduces the need for coding
changes to application programs.

Using an Options File
To use the options file, do the following:
1. Create the options file based on "Creating an Options File" below.
2. Add the required DD statement to the job’s JCL as described in

"Pointing to the Options File with the UNIOF DD Statement" below.
3. Required for the history insert option only: Do one of the following:

 Select Setup > User Options. When the User Options panel
appears, set Allow insert of history records to Y.

 Set the History Inserts field in the UNIXOPT record (see
“UNIXOPT Record Layout” on page 151) to Y.
4. Run the job.
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Creating an Options File
Edit the sequential dataset UNIOF LRECL (record length 80). The records
should use the “Options File (UNIOF) Record Layout” on page 635. The file
can contain up to 100 records.
Each record in the file specifies a job ID (job/step/qualifier) and
information for setting the cycle ID for that job. Only one record is allowed
per job ID.
Each record will specify either the cycle override option or the history insert
option. Descriptions of each option and a record layout are provided below.

Pointing to the Options File with the UNIOF DD Statement
Add a DD statement to the corresponding job’s JCL to point to the options
file dataset. Use the following DDNAME: UNIOF.
For example,
//UNIOF DD DSN=UNI.OPTIONS,DISP=SHR

When the job runs, UNIOF will be searched for the matching record and the
cycle ID will be set based on that record.

Cycle Override Option
When the cycle override option is specified, and the corresponding job
runs, its cycle ID will be reset to the cycle ID specified in the UNIOF record.
This cycle ID will be passed to the balancing function.
In addition:

 The cycle ID may be assigned to other runs depending on your entries
in the Job ID fields.

 The run number may be incremented in subsequent runs based on your
entry in the multi-run indicator field.

History Insert Option
Use this option to enable you to add records to the database with cycle
numbers lower than those of the records already stored there. This kind of
insert is normally prohibited.
You might need to do this, for example, if a daily balancing job doesn’t run
and the omission isn’t caught until the next day’s job has already run and
updated the history database.
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When the history insert option is specified, and the corresponding job runs,
its cycle ID will be reset to the cycle ID specified in the Options File
(UNIOF) record. This cycle ID will be passed to the balancing function. The
history insert option works like the cycle override option except that it
allows the history record for this run to be inserted in the history database
even if its cycle ID is lower than that of the other cycle IDs in the database.

Guidelines for Options File Processing
 Both the cycle number and the run number must be entered in the
options file record. You cannot use a CYC# parameter.

 If a duplicate cycle ID is used, an error message indicating that an insert
will not take place will be issued. Utilize the run number to insert
additional records with the same cycle number.

 If the record that is being inserted has the lowest cycle ID for a
particular job ID and the number of histories being stored per job ID
has been exceeded, the new record will not be inserted and an error
message will be issued.

 If, for the same job run, you include two options files (one specifying a
cycle override and one specifying a history insert) or one options file
containing two records for the same job ID (one specifying a cycle
override and one specifying a history insert), the setting for the first
file/record encountered will be used.

 Asterisks can be entered in the Job ID fields as specified in the “Options
File (UNIOF) Record Layout” on page 635.

Options File (UNIOF) Record Layout
The options file must be created using the following record layout. The file
can contain up to 100 records.
FLD#

DESCRIP.

POS.

LENGTH

FORMAT

VALUE

1

Comment
Indicator

1

1

X(1)

Blank or * comment)

2

Transaction
Code

2-3

2

X(2)

01 - Cycle Override,
02 - History Insert

3

Reserved

4-5

2

X(2)

Blank

4

Job ID1

6-23

18

X(18)

Job ID.
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FLD#

5

DESCRIP.

POS.

LENGTH

FORMAT

VALUE

Job1

6-13

8

X(8)

Enter a specific job name or
fill the field with asterisks.

Step1

14-21

8

X(8)

Enter a specific step name or
fill the field with asterisks.

Qualifier1

22-23

2

X(2)

Enter a qualifier or fill the field
with asterisks.

24-34

11

9(11)

Cycle ID fields (cycle number
and run number) must be
completed.

Cycle
Number

24-31

8

9(8)

The cycle number to be
assigned.

Run
Number

32-34

3

9(3)

The run number to be
assigned.

Cycle ID

6

Multi-Run
Indicator

35

1

X(1)

Y - When cycle override is
specified, increments the
cycle number after every use
in the current job step
Blank or N - does not
increment the cycle number.

7

Run Date &

36-47

12

X(12)

These fields apply only when
the history insert option is
specified.

Date2

36-41

6

9(6)

When the history insert option
is specified, enter the date in
YYMMDD format.

Time2

42-47

6

9(6)

When the history insert option
is specified, enter the time in
HHMMSS format.

Reserved

48-49

2

X(2)

Blanks

Spaces

50-79

30

X(30)

Blanks

Time

2

1

Job ID fields: If you want the cycle ID specified to be applied to all jobs, steps, and JSQs, fill
the job, step, and qualifier fields with asterisks [*] (or fill only the job and step fields with
asterisks and leave the qualifier field blank). To restrict the JSQs to be processed, you can fill
the job and step fields with asterisks and enter a specific qualifier in the Qualifier field.
2

The run date and time entered will be written to the database as the run date and time as if the
job actually ran on the date/time specified. The reports will show this date and time also.
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Modeling Job and File Definitions
This chapter explains how to model job and file definitions. This feature can
save you significant effort in creating and maintaining balancing jobs while
reducing errors. This chapter contains the following sections:






“What Is Modeling?” on page 639
“Modeling Terminology” on page 640
“Modeling Job Definitions” on page 640
“Modeling File Definitions” on page 644

What Is Modeling?
Modeling allows file definitions and job definitions stored in the definition
database to be referenced by one or more balancing jobs. Consisting of a
base model or template that contains the definitions, and a model user
that uses the definitions, modeling reduces the need to recode definitions
and ensures consistency between balancing jobs that have the same
requirements.
A single balancing job can model job definitions, file definitions, or both.
Benefits of modeling include the following:

 Decreases the amount of maintenance required by allowing you to
change the base job and have all model users utilize the change.

 Reduces the need to re-enter definitions for balancing jobs with similar
extraction and/or balancing requirements.

 Decreases the size of the definition database by storing one set of core
definitions that are referenced by other balancing jobs.

 Ensures balancing jobs are using the same definitions (i.e., meet the
same requirements).
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Modeling Terminology
The following terminology is used here when describing modeling:

Base Model
The base model, or base, contains the definitions stored on the definition
database which are referenced by balancing jobs. The base definitions can
exist within a balancing job, a template, or an input source.
A template is a set of core definitions that are referenced by a modeling
job. A template consists of only file definitions or job definitions. It cannot
be run independent of the balancing job that is referencing the definitions.

Model User
The model user uses the definitions in the base model. Based on the type
of definitions modeled, the model user can be a file or a job.
There is no limit to the number of model users that can be created; the only
restriction is the base and the model user must exist on the same definition
database.
Base model definitions cannot be deleted by the model user. Therefore the
base model and template must contain only the definitions to be modeled.

Modeling Job Definitions
Overview of Job Modeling
Modeling job definitions allows you to have a standard set of controls that
can be executed from any job. For example, you could use modeling to
consistently bring in a cycle from an input source and have it applied
consistently across all jobs.
You can also use modeling to consistently execute JSQs. For example, if you
have multiple jobs that are similar, you can create a common base job, then
define only the differences in the model users. Then, if the common
elements defined in the base job change, you need only make the changes
in the base job, and they will be applied to all model users.
Note:
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For more information on JSQs, see What is a Job/Step/Qualifier
(JSQ)? on page 159.
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Job Definitions that Can Be Modeled
Job definitions that can be modeled include:









Internal items
Extended internal items
Calculated items
History items
Balancing rules
Messages
Control Report Copy 1

 User Report
 Free-Form Report
Job definitions that cannot be modeled include:











Store history
Set return code
Cycle processing
Control Report Copy 2
Recap Report
Round results
22-character numeric formatting
Control Report XML Option
Job comments

How Model User and Base Model Job Definitions Are Merged
When the model user job runs, the criteria described below will be applied
to merge the model user job definitions and the base model definitions into
a single executable set of run-time definitions:

 Some or all of the base model’s item numbers (such as I-004, E-002, R006) may be duplicated in the model user job definitions. In such cases,
the duplicate items from the model user job definitions take
precedence and will be used instead of the base model's corresponding
items.
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 When the model user contains items whose item numbers are not
duplicated in the base model, these items will be included when the
model user job runs, in addition to the base model job definitions.
Note:

Because of the nature of free-form report definitions, you
cannot merge the base model’s free-form report definitions
with those of the model user. If you create a free-form
report in your current model user job, that report will
override the report in the base model. This will happen
even if you set your current job’s free-form report print
options to Do not print the report.

The following diagram shows how a sample model user Job A's
definitions would look at run time, after referencing base model Job M.

Using Model Definitions
Model User: Job A: Run-Time Definitions
Model Base: Job M

Common Information

replaced by Job A

I-001 from Job M
Job M Job Definitions
Basic Job Information
I-001
I-002
I-003
E-001
E-002
R-001

I-002 from Job M
I-003
I-004

replaced by Job A
added by Job A

E-001 from Job M
E-002 from Job M
R-001 from Job M
R-002

added by Job A

Job A Job Definitions
Basic Job Information
(Using Job M as model)
I-003
I-004
R-002
Balancing Function
ACR/Summary
Definition database
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Specifying a Job as a Model User
If you want the current job to be a model user (that is, you want the
current job to use job definitions from another job, the base model) you
need to do the following:
1. From the Job Window, select Job Information. After completing the

job ID and control report title, you need to complete the options under
Select options to access as appropriate. To specify modeling, select
Job run options > Model Definitions. The Model Definitions
panel will display.
Model Definitions
Select one of the following options:
1_ 1. This job will not use model definitions
2. The current job definitions will be merged with model
job ID's
3. This model job ID and all job IDs with the same job
name and step name but with different JSQs from the
model will execute when the job is submitted
Model definition
Job name:
Step name:
Qualifier:

F1=Help

job ID:
________
________
__

F2=Split

F3=Exit

F5=Accept

F9=Swap

2. On the Model Definitions panel, change the default to one of the

following options to specify how model definitions will be used with
this job:
2

The current job definitions will be merged with model Job ID’s.
The current job will use both the base model definitions and the
definitions that you set up within this (model user) job.

3. This model job ID and all job IDs with the same job name and step

name but with different qualifiers from the model will execute
when the job is submitted. With this option, the base model that
is specified in the Model Job ID field below will execute, along
with any jobs that share the same job name and step name as the
model job that have different qualifiers.
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The following example illustrates this option:
Job A

Job A is submitted.

Job B Step 10

Job B
Step 10
01

Job B
Step 10
02

Job A points to Job B Step 10 for the model definitions.

Job B
Step 10
03

Job B
Step 10
04

Job B Step 10 and all
jobs that have the
same job and step
name but different
qualifiers from the
model will be executed
when Job A is
submitted.

4. Complete the Model Definition Job ID fields with the job ID of the

base model. The model user is the job or template that contains the
definitions stored on the definition database that will be referenced in
the current job.

Using Embedded Masks in History Items
In the History Job ID, an embedded mask (*) may be used for modeling.
When job modeling is used, the asterisk causes the corresponding character
from the current job id to replace the asterisk in the History Item’s Job ID.
This is also true of a mask in the Variable Cycle Job ID field. When job
modeling is used, the asterisk causes the corresponding character from the
current job ID to replace the asterisk in the Variable Cycle Job ID.

Modeling File Definitions
Purposes of File Modeling
File modeling is applicable in access modes 1 through 5. It enables you to
define a set of file definitions for an input source as a base model to create
definitions for another input source, the model user. File modeling is
typically used when input sources have identical layouts and have similar
extraction requirements. Since the values are in the same location and
extracted in the same manner, modeling eliminates the need to recode the
file definitions. For example, you could set up similar file definitions for
similar sales reports generated by each store within a nationwide chain.
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File modeling is also useful if you want to produce separate Control Reports
for multiple subsets of the same report(s) or file(s). For example, a store
might generate a monthly report listing sales information for every
department. You could use file modeling to create similar file definitions for
each department, and then set up balancing jobs to generate a Control
Report for each department.
To ensure consistency in the extraction process, the base model input
source and the model user input source should use the same access mode.

File Definitions that Can Be Modeled
All of the file definition types for access modes 1 through 5 can be modeled.
These include:

 Begin/end/reset reference records
 Embedded keys






File keys
Relative record (access modes 1-4 only)
Total/tally/hash records
Page/line records
Field items

Guidelines for a Defining a Base Model for File Modeling
The base model must include only definitions needed by every model user.
You cannot, when defining the model user, delete definitions from the base.
However, you can add to or replace definitions from the base.
If a set of definitions for an input source that you want to use as a base
model includes any definitions that will not be required by every model
user, delete the extra definitions from the base. In some situations, this may
mean that you need to create a base model whose definitions are not
complete enough to use by themselves, but that simply serve as the starting
point for all the other file definitions you want to set up.
The procedures you need to follow in order to create and use model file
definitions are described in the following sections:

Specifying a Base Model for File Modeling
1. Bring up the Input Sources panel for the file definitions you want to

use as a base model.
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2. Note the DDNAME (and Qualifier, if any) of this input source. You will

need it when you define the model user.
3. Enter Y for Is this file a model?
Note:

Later in the procedure, this step will cause the following to
happen:
 If you are creating new file definitions, when you are finished
creating them, press F3 until you view the Model Sequence
Window. This allows you to set sequence numbers. If you do
not set this field to Y, the Model Sequence Window will be
bypassed and the definitions will be assigned sequence
numbers starting at 000001 and incrementing by 1.
 If you are working with base model file definitions created in
an earlier version of ACR/Summary, setting this field to Y
before you open the file in the Extract Window retains
existing sequence/item numbers. If you do so, in the Model
Sequence Window, your record sequence numbers will be
renumbered starting at 000001 and any patterned sequence
you had previously established will be lost. This may cause
problems when you model user jobs that reference the base
model.

4. Press F5 to display the panels required for defining an input source. If

you have not already completed them, do so.
5. When the Job Window displays, save the definitions.
6. Open the Extract Window and select the file ID of the input source you

are defining as your base model.
7. If the dataset is viewable, it appears in the Extract Window. If you have

not created definitions, do so now. Otherwise go to the next step.
8. Select View > Definitions to view and edit the definitions for use as a

base model.
Note:

If you need to keep existing file definitions before making edits,
make a copy of them.

9. Delete any definitions not needed by every model user.
10. Press F3 twice to display the Model Sequence Window. An example is

shown below. (If you are creating the definitions for the first time, both
the Old and New columns will be blank.)
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Model Sequence Window

Row 1 to 5 of 5

Old
Old New
New
Sequence Group Values
000001 000 000001 000
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 1
000002 000 000002 000
OCC 001 OF EMBEDDED KEY=ITEM1
000002 001 000002 001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-001
000003 000 000003 000
OCC 001 OF EMBEDDED KEY=ITEM2
000003 001 000003 001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-002
***************************** Bottom of data***************************

Command Line ===>_______________________________________________________
F1=Help
F2plit
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap

11. Complete the New columns. Your goal is to uniquely identify each

definition based on the following guidelines and range restrictions:

 The 6-digit (leftmost) New column allows you to assign or change
the record sequence number. The record sequence number
uniquely identifies the selection group. Every definition within the
same selection group will share the same record sequence number.
Although selection groups can be numbered sequentially, as in the
example above, using 000001, 000002, 000003, etc. without gaps
is not recommended. You need to leave gaps between record
sequence numbers in a base model so that when you define model
users, you can add selection groups between the base model
definitions as needed.
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The following example shows the 6-digit New column with the
recommended gaps (000001, 000005, and 000010).
Model Sequence Window

Row 1 to 5 of 5

Old
Old New
New
Sequence Group Values
000001 000 000001
000
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 1
000002 000 000005
000
OCC 001 OF EMBEDDED KEY=ITEM1
000002 001 000005
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-001
000003 000 000010
000
OCC 001 OF EMBEDDED KEY=ITEM2
000003 001 000010
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-002
***************************** Bottom of data***************************

Command Line===>_________________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap

 The 3-digit New column identifies the item number. This number
uniquely identifies each definition within a selection group. The
first definition within a selection group must have an item number
of 000. Additional items within a group must be numbered
sequentially, but you can leave gaps. For example, although 000,
001, 002 are valid item numbers, you could use 000, 005, 010.

 The type of file definition restricts the sequence numbers and item
numbers that can be used, as follows:

 File keys, which are used in access mode 3, must have a record
sequence number of 000000 and an item number of 001-999.

 Reference records, embedded keys and the other selection
related definitions must have a record sequence number of
000001-999999 and an item number of 000.

 Field items must have a record sequence number of 000001999999 and an item number of 001-999.
Note:
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12. Definitions from the base model will not be displayed in the model

user job. But you will need to have information on these definitions
and their sequence/item numbers when you set up the model user
definitions. To do this, either 1) make a screen print of the definitions
for your reference or 2) run the List Definitions utility to print out the
file definitions and their sequence numbers.
13. Press F5 to exit the Model Sequence Window.
14. Save the definitions.

Specifying a Model User and Adding/Replacing File Definitions
1. Ensure that you have specified the base model as described in the

previous section, “Base Model” on page 640.
2. Create or open the job that will use file modeling.
3. Create the input source for the model user. Select Input Sources >

New to display the Input Sources panel. When you complete the
panel, make sure you do the following:

 Enter a unique File DDNAME for this set of file definitions (NOT
the DDNAME of the base model.

 Accept N for Is this file a model?.
 Select Y for Use model definitions?
 Enter the File DDNAME and Qualifier, if any, of the base model
input source.
4. Press F5 and complete the panels as appropriate.
5. When the Job Window displays, open the Extract Window.
6. Select the file ID of the model user input source from the list. If the

dataset is viewable, it appears in the Extract Window.
7. Select Edit > Add and add any new or replacement definitions.

(Remember, definitions from the base model will not appear in the
model user. Refer to the screen print you made of the definitions
from the base model when deciding what new or replacement
definitions you need to add.)
8. Press F3 twice to display the Model Sequence Window. This window

displays the new definitions you added and enables you to assign
sequence/item numbers so that the new definitions will either replace
or be added to the definitions from the base model.
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 Replacing a definition from the base model: Refer to the
screen print of base model definitions and their sequence numbers.
In the New columns next to a definition that will be used as a
replacement, enter the record sequence number and item number
of the base model definition you want to replace.
In the following example, the first definition in the base model had
the sequence/item number 00001/000. This sequence/item
number is now assigned to a new definition so that the
corresponding definition from the base model will be replaced in
the model user.
Model Sequence Window

Row 1 to 4 of 4

Old
Old New
New
Sequence Group Values
______ ___ 000001
000
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 2
***************************** Bottom of data ****************************

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap

 Adding a selection group: Refer to the screen print of base
model definitions and their sequence numbers. Complete the New
columns next to the definitions you are adding with a unique record
sequence number and appropriate item numbers.
In the following example, the last selection group in the base used
the sequence number 00010. Sequence/item numbers have been
assigned to a new selection group so that the selection group will be
added at the end of the base model definitions.
Model Sequence Window
Old

Row 1 to 4 of 4

Old

New
New
Sequence Group Values
000015
000
OCC 001 OF EMBEDDED KEY=ITEM3
000015
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-003
***************************** Bottom of data *****************************

Command Line ===> ________________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap
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Note:

To insert a selection group between two selection groups from
the base model (such as between 000001 and 000005), assign
a record sequence number between the numbers of the existing
selection groups (such as 000003). If the record sequence
numbers in the base model do not allow you to add your
selection group in the correct sequence, we recommend that you
change the numbers in the base model, leaving gaps as
recommended in “Guidelines for a Defining a Base Model for File
Modeling” on page 645.

 To add a new definition to an existing selection group
from the base model, refer to your list of base model definitions
and their sequence numbers to see how the existing items within the
selection group are numbered. Enter the existing selection group’s
record sequence number in the 6-digit New column. In the 3-digit
New column, enter an appropriate item number that is unique
within the selection group.
9. After you complete the Model Sequence Window, the Job Window

displays. Create an internal (or extended internal) item for each field
value defined in the base model. Because internal (or extended
internal) items are job definitions rather than file definitions, they will
not be merged in from the base model. If you want to model job
definitions too, see “Modeling Job Definitions” on page 640.
10. Finish defining the job. When you run the job, a copy of the base model

file definitions will be merged with the file definitions you defined here
to create a new set of model user file definitions. If you open the
Extract Window and Definitions from the View menu, you will see
result of the merge.

Example: File Modeling
Suppose you work at corporate headquarters for a chain of 20 retail stores.
Each month, each store electronically submits an identical inventory report
to you. You create file definitions for one of these reports and then use them
as a base model for file definitions for all the other reports. The first line of
each report contains a two-digit number that uniquely identifies the store
that submitted the report. You substitute a file definition for each store’s
report to reference the store’s unique identification number.
File modeling would also be useful if all of the stores’ inventory counts were
included in the same lengthy report and you wanted to generate a separate
Control Report for each store’s inventory. You would set up file definitions
for the first store’s inventory and then use them as a base model for each of
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the other stores. You could set up an individual job for each store, enabling
you to produce separate Control Reports for each store’s inventory. If you
wanted to balance some different values for certain stores, you could do
that too by adding file definitions for those stores.
The example that follows shows how to set up model user file definitions for
Store 2 using Store 1’s definitions as a base model. The procedure for setting
up model user file definitions for stores 3 through 20 would be identical.
The input source is a single report listing inventory information for each of
the 20 stores. Store 1 and Store 2’s inventory information, as displayed in
the Extract Window, is shown below.
File Edit View Run Window Help
----------------------------------------------------------------------Extract Window
File name: STORE1
LINES 00000011 COL 00001 00072
----+----1----+----2----+----3----+----4----+----5----+----6----+----7STORE 1
UNITS IN STOCK
ITEM1
10
ITEM2
15

STORE 2
ITEM1
ITEM2
ITEM3

13
21
34

Command Line ===> _______________________________________ Scroll ===>PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right
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Example: Specifying a Base Model for File Modeling
STORE1, STEP1 is a job that balances store 1’s inventory.
Job Information
Job name: STORE1
Step name: STEP1
Qualifier:
Enter control report title:
STORE 1 INVENTORY CONTROL_______________
Select options to access:
_ Job run options...
_ Cycle processing options...
_ Alternate job ID information...
_ Rerun/audit trail options...
_ Extract file options...
_ Display/change comments...
F2=Split
F3=Exit
F5=Accept
F9=Swap

F1=Help

To use the file definitions for store 1 as a base model, enter Y for Is This
File A Model?
Input Sources
File number: 001
Comments exist: N Add/Change Comments: N
File description: INVENTORY CONTROL_
File DDNAME: STORE1__ Qualifier: __
DSName: STORES.INVENTORY(CNTL)______________________
Display the above DSName in the Extract Window? Y (Y/N)
If yes, specify the range of lines to display: 00001 to

(Y/N)

00100

File organization:
1_ 1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
Is this file a model? Y
Use model definitions? N

(Y/N)
(Y/N)

File DDNAME: _________
Qualifier:
__
F1=Help
F2=Split
F3=Exit
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In the base model, Store 1’s file definitions use the store’s number (1) as a
beginning reference. Then, they pick up two values: counts for stock item 1
and stock item 2.
File

Edit

View

Run

Window Help
Extract Window

Row 1 to 5 of 5

__
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 1
__
OCC 001 OF EMBEDDED KEY=ITEM1
__
PICK UP VALUE AT 0034 FOR 02, STORE IN I-001
__
OCC 001 OF EMBEDDED KEY=ITEM2
__
PICK UP VALUE AT 0034 FOR 02, STORE IN I-002
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

So that we can use Store 1’s file definitions as a base model, we bring up
the Model Sequence Window (by pressing F3 twice) and enter sequence
numbers for each file definition.
Note:

Sequence numbers would appear in the Old columns if these are
existing definitions.

Model Sequence Window
Old

Row 1 to 5 of 5

Old

New
New
Sequence Group Values
000001
000
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 1
000005
000
OCC 001 OF EMBEDDED KEY=ITEM1
000005
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-001
000010
000
OCC 001 OF EMBEDDED KEY=ITEM2
000010
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-002
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap
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Definitions from the base model will not be displayed in the model user
job. But we will need to have information on these definitions and their
sequence/item numbers to set up the model user definitions. We make a
screen print of the definitions for reference.
We accept the sequence numbers and save the file definitions.

Specifying a Model User and Adding/Replacing File Definitions
A second job, STORE2, STEP1, will balance store 2’s inventory. This job will
be the model user.
Job Information
Job name: STORE2__
Step name: STEP1___
Qualifier: __
Enter control report title:
STORE 2 INVENTORY CONTROL_______________
Select options to access:
_ Job run options...
_ Cycle processing options...
_ Alternate job ID information...
_ Rerun/audit trail options...
_ Extract file options...
_ Display/change comments...
F2=Split
F3=Exit
F5=Accept
F9=Swap
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In the STORE2 job, we define an input source named STORE2. To use the
STORE1 file definitions as a base model for the STORE2 definitions, we
choose Y for Use Model Definitions? and enter the DDNAME of the base
model, STORE1.
Input Sources
File number: 001
Comments exist: N Add/Change Comments: N
File description: STORE 2 INVENTORY_
File DDNAME: STORE2__ Qualifier: __
DSName: STORES.INVENTORY(CNTL)______________________
Display the above DSName in the extract window? Y (Y/N)
If yes, specify the range of lines to display: 00001 to

(Y/N)

00100

File organization:
1_ 1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
Is this file a model? N
Use model definitions? Y

(Y/N)
(Y/N)

File DDNAME: STORE1__
Qualifier:
__
F1=Help
F2=Split
F3=Exit

F5=Accept

F9=Swap

We will press F5 and complete the panels as appropriate until the Job
Window is displayed. Then we will select Window > Extract, and select
the name of the new input source we just added. If the input source is
viewable, it will be displayed in the Extract Window.
We will then select Edit > Add and add any new or replacement
definitions. (Remember, definitions from the base model will not appear
in the model user. We will need to refer to the screen print of the
definitions from the base model when deciding what new or replacement
definitions to add.)
First we will add a definition to replace the first definition from the base
model. The base model uses 1 (for Store 1) as the beginning reference. The
replacement definition uses 2 (for Store 2).
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We also add a new selection group that picks up an inventory count for
stock item 3. Store 1 did not carry this item but store 2 does. The new
definitions are shown below.
File Edit View Run Window Help
-----------------------------------------------------------------------Extract Window
Row 1 to 3 of 3
__
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 2
__
OCC 001 OF EMBEDDED KEY=ITEM3
__
PICK UP VALUE AT 0034 FOR 02, STORE IN I-003
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

We will now assign the same sequence number to the replacement
definition as the corresponding beginning reference definition in the base
model that we want to replace.
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We assign new sequence numbers to the two definitions in the new
selection group that will pick up the inventory count for stock item 3.
Because the stock item 3 record is after the other records that already have
corresponding selection groups in the base model definitions, we give the
new selection group a higher number than any of the existing groups. The
numbers we will assign are shown below.
Model Sequence Window
Old

Row 1 to 3 of 3

Old

New
New
Sequence Group Values
000001
000
SET BEGIN REF AT OCC 001 OF REFERENCE KEY= 2
000015
000
OCC 001 OF EMBEDDED KEY=ITEM3
000015
001
PICK UP VALUE AT 0034 FOR 02, STORE IN I-003
***************************** Bottom of data*****************************

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Accept
F7=Up
F8=Down
F9=Swap

Next, we add internal items 1 and 2 for the values picked up by the base
model definitions. We need to add them because they will not be merged
from Store 1’s definitions into the Store 2 job since they are job definitions.
Note that we already defined internal item 3 when we added the definition
to pick up the inventory count for stock item 3.
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File Edit View Run Setup Window Help
-----------------------------------------------------------------------ACR/Summary Job Window
Row 1 from 19

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.

C.

D.

Basic Job Information
Job Information:
STORE2
STEP1
Report Options:
STORE 2 INVENTORY CONTROL
Input Sources: 001
STORE2
STORES.INVENTORY(CNTL)
< NEW... >
Internal Items: 003
001
STOCK ITEM 1
002
STOCK ITEM 2
003
STOCK ITEM 3
< NEW... >
Extended Internal Items: 000
< NEW... >

Command Line ===>_______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

We save our definitions. When we run the job, the definitions we want to
add and replace for STORE2 will be merged with the STORE1 base model
definitions. This produces the following set of STORE2 model user file
definitions in the definition database:
000001
000005
000005
000010
000010
000015
000015

000
000
001
000
001
000
001

SET BEGIN REF AT OCC 001 OF REFERENCE
OCC 001 OF EMBEDDED KEY=ITEM1
PICK UP VALUE AT 0034 FOR 02, STORE
OCC 001 OF EMBEDDED KEY=ITEM2
PICK UP VALUE AT 0034 FOR 02, STORE
OCC 001 OF EMBEDDED KEY=ITEM3
PICK UP VALUE AT 0034 FOR 02, STORE
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Using User Exits
This chapter describes the user exit programs. These are COBOL source
files supplied with ACR/Summary, which you can modify to perform
whatever special processing task is necessary. You can make changes to the
source code, and then recompile and link-edit the programs to replace the
standard versions of these programs supplied with ACR/Summary.
This chapter contains the following sections:









“Using the User Exit Programs” on page 661
“Control File (UNICNTL) User Exit” on page 663
“User Options File (UNIUOPT) User Exit” on page 667
“Job Name/Step Name (UNIJNAM) User Exit” on page 669
“Cycle Number (UNICNUM and UNICNUM1) User Exits” on page 671
“File Interface (UNIEXIT) User Exit” on page 674
“User Exit Example” on page 677

Using the User Exit Programs
The source code for the User Exit Programs discussed in this chapter is
located in the UNI.SRCELIB and UNI.COPYLIB datasets provided on the
installation tape. Each of the user exit programs in UNI.SRCELIB contains
copy statements for working storage areas, which are found in
UNI.COPYLIB. Listings of the COBOL programs and copy statements are
shown later in this chapter.
You can use any text editor, such as ISPF Edit, to modify the source code.
Then, use COBOL compile JCL (valid for your site) to compile and link-edit
the programs. Include UNI.COPYLIB in the SYSLIB DD statements, and
link-edit the programs into the load library where ACR/Summary is found,
replacing the standard versions supplied with the installation (an
alternative method is to link-edit the programs into a separate load library,
which should be concatenated above the load library in your job JCL).
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The application interface mode used determines which user exit programs
are called. The table below shows which modes use which exits, and also
indicates when the particular exits are called.
User Exit
Program

File Interface
Mode

Program
Interface Mode

Direct Input
Mode

UNICNTL

STARTUP

STARTUP

STARTUP

UNIUOPT

STARTUP

STARTUP

STARTUP

UNIJNAM

STARTUP

STARTUP

N/A

UNICNUM

BALANCING

BALANCING

BALANCING

UNIEXIT

SHUTDOWN

N/A

N/A

Notes:
Startup: The user exit program is called at application interface startup (in the
order shown in the table) before the balancing function is invoked.
Balancing: The user exit program is called by the balancing function just before
balancing takes place.
Shutdown: The user exit program is called by the file interface program after
the balancing function is finished.
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Control File (UNICNTL) User Exit
This exit can be used in all application interface modes to customize default
data center-dependent information.
Note:

Because the options in this user exit will override system defaults, this
exit should be closely controlled.

Available options include:

 Licensee Name
This name that identifies your corporation will appear on all
ACR/Summary reports that use this exit. This can also be done when
you create your control file.

 Lines per page
This parameter determines the number of lines per page on all
ACR/Summary reports. The default value is 60.

 ACR/Summary Control File dataset name
This field allows you to specify the name of the ACR/Summary Control
File (see the example at the end of this chapter). This exit program
overrides what is in your DD statement in the JCL.

 Enqueue/reserve wait time
This parameter specifies the maximum time an ACR/Summary
program will wait if another job has exclusive possession of
ACR/Summary files. The default is 900 seconds (15 minutes).
Source code for the UNICNTL user exit program and the UNICNTL copy
member is shown in the following figures. The exit program and the copy
member show the fields that contain the various options. Follow the
directions within the source code.
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IDENTIFICATION DIVISION.
PROGRAM-ID.

UNICNTL.

EJECT
ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
FILE SECTION.
EJECT
WORKING-STORAGE SECTION.
01

Place your
control file
name here

Change
other
working
storage
values as
necessary

FILLER.
05 FILLER
PIC X(40)
VALUE
'WORKING-STORAGE FOR UNICNTL STARTS HERE.'.
05 WS-CNTL-USER-INFO.
10 WS-CNTL-DSNAME
PIC X(12)
VALUE 'XXXXXXXX.XXX'.
*--------------------------------------------------------------*
THE FOLLOWING VALUES WILL CAUSE THE BALANCING SYSTEM *
TO APPLY DEFAULTS.
*
1. USER NAME OF SPACES
*
2. PAGE SIZE OF ZEROS
*
3. WAIT TIME OF ZEROS
*
4. RESERVE OPTION OF SPACES
*
5. RETURN CODES OF 9999
*--------------------------------------------------------------10 WS-CNTL-USER-NAME
PIC X(40) VALUE SPACES.
10 WS-CNTL-PAGE-SIZE
PIC 9(3) VALUE ZEROS.
88 WS-CNTL-PAGE-SIZE-OK
VALUES 30 THRU 999.
10 WS-CNTL-WAIT-SECONDS
PIC 9(4) VALUE 600.
88 WS-CNTL-WAIT-SECONDS-OK VALUE 600 THRU 3600.
10 WS-CNTL-RESERVE
PIC X(1) VALUE 'Y'.
88 WS-CNTL-RESERVE-OK
VALUE 'Y' 'G' 'N'.
10 WS-CNTL-RETURN-CODE-I
PIC 9(4) VALUE 9999.
88 WS-CNTL-RETURN-CODE-I-OK VALUE 0 THRU 4000.
10 WS-CNTL-RETURN-CODE-W
PIC 9(4) VALUE 9999.
88 WS-CNTL-RETURN-CODE-W-OK VALUE 0 THRU 4000.
10 WS-CNTL-RETURN-CODE-E
PIC 9(4) VALUE 9999.
88 WS-CNTL-RETURN-CODE-E-OK VALUE 0 THRU 4000.
01
05
05

WS-ENV-VARIABLE.
WS-ENV-DD
WS-ENV-VALUE

PIC X(8) VALUE 'dd_UNICF'.
PIC X(12) VALUE SPACES.
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EJECT
LINKAGE SECTION.
01 UNICNTL-AREA.
COPY UNIXCNTL.
EJECT
PROCEDURE DIVISION USING UNICNTL-AREA.
0000-MAIN-LOGIC.
*-----------------------------------------------------------*
THE USER HAS THE OPTION OF PROVIDING THE CONTROL FILE *
DATASET NAME. MOVE THE FILE NAME REQUIRED AND SET
*
ENVIRONMENT VARIABLE AS SHOWN BELOW.
*------------------------------------------------------------

Uncomment
these lines

*
*
*
*

MOVE WS-CNTL-DSNAME
DISPLAY WS-ENV-DD
DISPLAY WS-ENV-VALUE

TO CNTL-DSNAME
WS-ENV-VALUE.
UPON ENVIRONMENT-NAME.
UPON ENVIRONMENT-VALUE.

*-----------------------------------------------------------*
THE FOLLOWING VALUES ARE PRESET IN WORKING STORAGE.
*
THE USER MUST PROVIDE THE DEFAULT PARAMETERS FOR THE
*
1. THE NAME TO USE AT THE TOP OF ALL REPORTS
*
2. REPORT PAGE SIZE IN NUMBER OF LINES
*
3. THE NUMBER OF SECONDS TO WAIT FOR A CLEAR HISTORY *
4. TO USE RESERVE OR ENQUE LOGIC
*
5. THE INCREMENT FOR INFORMATION LEVEL MESSAGES.
*
6. THE INCREMENT FOR WARNING
LEVEL MESSAGES.
*
7. THE INCREMENT FOR ERROR
LEVEL MESSAGES.
*
*
THESE VALUES ARE ACCEPTED FROM THE CONTROL FILE
*
WHEN NOT PROVIDED/ CHANGED HERE.
*-----------------------------------------------------------MOVE
MOVE
MOVE
MOVE
MOVE
MOVE
MOVE

WS-CNTL-USER-NAME
WS-CNTL-PAGE-SIZE
WS-CNTL-WAIT-SECONDS
WS-CNTL-RESERVE
WS-CNTL-RETURN-CODE-I
WS-CNTL-RETURN-CODE-W
WS-CNTL-RETURN-CODE-E

TO
TO
TO
TO
TO
TO
TO

CNTL-USER-NAME.
CNTL-PAGE-SIZE.
CNTL-WAIT-SECONDS.
CNTL-RESERVE-OPTION.
CNTL-RETURN-CODE-I.
CNTL-RETURN-CODE-W.
CNTL-RETURN-CODE-E.

GOBACK.

UNICNTL User Exit Source Listing (Part 2 of 2)
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* MBRNAME = UNIXCNTL
*-------------------------------------------------------------*
THIS AREA ALLOWS THE USER TO OVERIDE THE SYSTEM DEFAULTS *
FOR:
*
1. THE CONTROL FILE DATASET NAME
*
2. THE NAME TO APPEAR AT THE TOP OF ALL REPORTS
*
3. THE NUMBER OF LINES PER PAGE ON REPORTS
*
4. THE NUMBER OF SECONDS TO WAIT FOR THE HISTORY
*
FILE TO CLEAR FROM THE PREVIOUS USER
*
5. WHETHER TO USE AN OS RESERVE AND ENQUE OR JUST
*
AN OS ENQUE WHEN ACCESSING HISTORY.
*
6. A RETURN CODE INCREMENT FOR INFORMATION MESSAGES *
7. A RETURN CODE INCREMENT FOR WARNING MESSAGES
*
8. A RETURN CODE INCREMENT FOR ERROR MESSAGES
*-------------------------------------------------------------05
05

05

CNTL-DSNAME
PIC X(44).
CNTL-USER-INFO.
10 CNTL-USER-NAME
PIC X(40).
10 CNTL-PAGE-SIZE
PIC 9(3).
88 CNTL-PAGE-SIZE-OK
VALUE 30 THRU 999.
10 CNTL-WAIT-SECONDS
PIC 9(4).
88 CNTL-WAIT-SECONDS-OK VALUE 060 THRU 3600.
10 CNTL-RESERVE-OPTION
PIC X.
88 CNTL-RESERVE-OPTION-OK VALUE 'Y' 'N' 'G'.
88 CNTL-RESERVE-OPTION-YES
VALUE 'Y'.
88 CNTL-RESERVE-OPTION-GLOBAL VALUE 'G'.
88 CNTL-RESERVE-OPTION-NO
VALUE 'N'.
10 CNTL-RETURN-CODE-I
PIC 9(4).
88 CNTL-RETURN-CODE-I-OK
VALUE 0 THRU 4000.
88 CNTL-RETURN-CODE-I-DEFAULT VALUE ZERO.
10 CNTL-RETURN-CODE-W
PIC 9(4).
88 CNTL-RETURN-CODE-W-OK
VALUE 0 THRU 4000.
88 CNTL-RETURN-CODE-W-DEFAULT VALUE ZERO.
10 CNTL-RETURN-CODE-E
PIC 9(4).
88 CNTL-RETURN-CODE-E-OK
VALUE 0 THRU 4000.
88 CNTL-RETURN-CODE-E-DEFAULT VALUE 4000.
FILLER
PIC X(40).

UNICNTL Copy Member
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User Options File (UNIUOPT) User Exit
This exit can be used in all application interface modes to provide a systemwide default User Option Dataset Name. You can use this exit to ensure
that, throughout the system, all users are using the same user options. (For
more information on user options, see “Setting the User Options” on
page 115). If a UNIUF DD statement is supplied in the JCL, it will override
the name provided in this exit.
Source code for the UNIUOPT User Exit Program and the UNIUOPT copy
member is shown in the tables below.
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IDENTIFICATION DIVISION.
PROGRAM-ID.

UNIUOPT.

ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
FILE SECTION.
EJECT
WORKING-STORAGE SECTION.
01

FILLER.
05 FILLER
PIC X(40)
VALUE
'WORKING-STORAGE FOR UNIUOPT STARTS HERE.'.
05 WS-UNIUOPT-DSNAME
PIC X(12)
VALUE 'XXXXXXXX.XXX'.

01

WS-ENV-VARIABLE.
05 WS-ENV-DD
WS-ENV-VALUE

Fill in your user
file options
name here

05

PIC X(8) VALUE 'dd_UNIUF'.
PIC X(12) VALUE SPACES.

EJECT
LINKAGE SECTION.
01 UNIUOPT-AREA.
COPY UNIUOPT.
EJECT
PROCEDURE DIVISION USING UNIUOPT-AREA.
*-----------------------------------------------------------*
THE USER MAY MODIFY THE DATASET NAME USED FOR THE USER *
OPTIONS FILE. MOVE THE DATASET NAME REQUIRED TO THE
*
UNIUOPT AREA AND SET ENVIRONMENT VARIABLE AS SHOWN
*
BELOW.
*------------------------------------------------------------

Uncomment
these lines

*
*
*
*

MOVE WS-UNIUOPT-DSNAME TO UOPT-DSNAME
WS-ENV-DD.
DISPLAY WS-ENV-DD
UPON ENVIRONMENT-NAME.
DISPLAY WS-ENV-VALUE UPON ENVIRONMENT-VALUE.

GOBACK.

UNIUOPT User Exit Source Listing
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* MBRNAME = UNIXUOPT
*-----------------------------------------------------------05

UOPT-DSNAME

PIC X(44).

UNIUOPT Copy Member

Job Name/Step Name (UNIJNAM) User Exit
There are several ways to determine your job ID.

 via the ACR/Summary user interface
 using the user exit described in this section
 pass the job, step, and qualifier in through a file interface JCL parm or
through the linkage section of a program interface job.
This exit can be used in file interface mode or program interface mode to
modify the job name and step name the job name and step name set by
another method. The original job names, step names, and PROC step
names obtained from the operating system are provided in this exit.
UNIJNAM is called dynamically at execution time by the ACR/Summary
File Interface Program or Program Interface Program. This User Exit
Program may be changed and recompiled to process the job name and step
name as needed.
Follow the directions in the source to modify the program. Source code for
the UNIJNAM user exit program and the UNIJNAM copy member is
shown in the tables below.
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IDENTIFICATION DIVISION.
PROGRAM-ID. UNIJNAM.
ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
WORKING-STORAGE SECTION.
01

FILLER.
05 FILLER
PIC X(40)
VALUE 'WORKING-STORAGE FOR UNIJNAM STARTS HERE.'.

LINKAGE SECTION.
01 JOB-NAME-AREA.
COPY UNIXJNAM.
EJECT
PROCEDURE DIVISION

USING JOB-NAME-AREA.

*---------------------------------------------------------------*
INSERT COBOL STATEMENTS TO PROCESS JOB AND STEP NAMES HERE.*
THE USER MAY MODIFY THE JOB OR STEP NAME TO BE USED IN THE *
BALANCING PROCESS. THE UNIJNAM AREA IN LINKAGE PROVIDES
*
THE USER WITH THE CURRENT JOB, STEP, AND PROC STEP NAMES. *---------------------------------------------------------------GOBACK.

UNIJNAM User Exit Source Listing

* MBRNAME = UNIXJNAM
*-----------------------------------------------------------*
THE USER IS PROVIDED WITH THE JOB, STEP AND PROCSTEP
*
OF THE CURRENT JOB ID. THE JOB NAME AND/OR STEP NAME
*
CAN BE CHANGED IN THIS EXIT.
*-----------------------------------------------------------05
05

JNAM-LENGTH
JNAM-JOB-STEP-INFO.
10 JNAM-JOB-NAME
10 JNAM-STEP-NAME
10 JNAM-PROCSTEP-NAME

PIC 9(5)

COMP VALUE 28.

PIC X(8).
PIC X(8).
PIC X(8).

UNIJNAM Copy Member
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Cycle Number (UNICNUM and UNICNUM1) User
Exits
The UNICNUM and UNICNUM1 source members can be used in all
application interface modes to modify the cycle ID used in balancing.
These source members are identical, and both are invoked after the cycle ID
is set. However, they are called at different times. Use the member
appropriate to your processing needs as follows:

 If you are using cycle generation options X1 or G1 and want to modify
your cycle ID, use UNICNUM1.

 Otherwise, use UNICNUM, which is called after another method has
already set the cycle number.
The output of these members replaces the input cycle ID information.
IDENTIFICATION DIVISION.
PROGRAM-ID. UNICNUM.
ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
FILE SECTION.
WORKING-STORAGE SECTION.
01

FILLER.
05 FILLER
PIC X(40)
VALUE
'WORKING-STORAGE FOR UNICNUM STARTS HERE.'.
LINKAGE SECTION.
01 CNUM-AREA.
COPY UNICNUM.
EJECT
PROCEDURE DIVISION

USING CNUM-AREA.

*--------------------------------------------------------------*
THE USER MAY ADD CODE HERE TO MODIFY THE CYCLE NUMBER
*
FOR ACR PROCESSING. THE CNUM AREA IN LINKAGE IS PROVIDED *
FOR THAT PURPOSE.
*--------------------------------------------------------------GOBACK.

UNICNUM User Exit Source Listing
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IDENTIFICATION DIVISION.
PROGRAM-ID. UNICNUM.
ENVIRONMENT DIVISION1.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
FILE SECTION.
WORKING-STORAGE SECTION.
01

FILLER.
05 FILLER
PIC X(41)
VALUE
'WORKING-STORAGE FOR UNICNUM STARTS HERE.'.
LINKAGE SECTION.
01 CNUM-AREA.
COPY UNICNUM.
EJECT
PROCEDURE DIVISION

USING CNUM-AREA.

*--------------------------------------------------------------*
THE USER MAY ADD CODE HERE TO MODIFY THE CYCLE NUMBER
*
FOR ACR PROCESSING. THE CNUM AREA IN LINKAGE IS PROVIDED *
FOR THAT PURPOSE.
*--------------------------------------------------------------GOBACK.

UNICNUM1 User Exit Source Listing
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----------------------------------------------------------THE USER IS PROVIDED WITH THE JOB, STEP AND ACR NUMBER OF THE CURRENT JSQ. THE CYCLE NUMBER FOR THAT JSQ
CAN BE CHANGED IN THIS EXIT.
----------------------------------------------------------05

05

CNUM-JSQ.
10 CNUM-JOB-NAME
10 CNUM-STEP-NAME
10 CNUM-ACR-NBR
CNUM-CYC.
10 CNUM-CC
10 CNUM-CYC-DT.
15 CNUM-YY
15 CNUM-MM
15 CNUM-DD
10 CNUM-CYC-RUN

PIC X(8).
PIC X(8).
PIC X(2).
PIC X(2).
PIC
PIC
PIC
PIC

9(2).
9(2).
9(2).
9(3).

UNICNUM Copy Member
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File Interface (UNIEXIT) User Exit
This exit is used in file interface mode to set the step return code or to issue
a user abend, if required. The exit is provided to allow you to tailor this
feature to meet your site standards.
Source code for the UNIEXIT user exit program and the UNIEXIT copy
member is shown in the tables below.
IDENTIFICATION DIVISION.
PROGRAM-ID. UNIEXIT.
ENVIRONMENT DIVISION.
CONFIGURATION SECTION.
INPUT-OUTPUT SECTION.
FILE-CONTROL.
DATA DIVISION.
WORKING-STORAGE SECTION.
01 FILLER.
05 FILLER
PIC X(40)
VALUE
'WORKING-STORAGE FOR UNIEXIT STARTS HERE.'.
05 ACR-ABEND-CODE
PIC S9(4) COMP-3.
LINKAGE SECTION.
01 ACR-EXIT-AREA.
COPY UNIEXIT.
EJECT
PROCEDURE DIVISION

USING ACR-EXIT-AREA.

*---------------------------------------------------------------*
THE FOLLOWING CODE IS USED BY THE SYSTEM WHEN HANDLING
*
RETURN CODE SETTING AND REQUESTS FOR ABENDS. THE USER MAY *
ADD CONDITIONAL CUSTOM CODE HERE. IT IS NOT EXPECTED THAT *
THE PROVIDED CODE WILL BE CHANGED.
*----------------------------------------------------------------

UNIEXIT User Exit Source Listing (Part 1 of 2)
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0000-PROGRAM-CONTROL.
PERFORM 1000-PROGRAM-BEGIN.
PERFORM 2000-PROCESS-EXIT.
PERFORM 3000-PROGRAM-END.
EJECT
1000-PROGRAM-BEGIN.
IF EXIT-RETURN-CODE NOT NUMERIC
DISPLAY '#UBS002E: RETURN CODE IS NOT NUMERIC.'
PERFORM 3000-PROGRAM-END.

EJECT
2000-PROCESS-EXIT.

This will
set a return
option

*-------------------------------------------------------------* INSERT COBOL STATEMENTS TO PROCESS EXIT HERE *-------------------------------------------------------------IF EXIT-OPTION-SET-RETURN-CODE
DISPLAY 'STEP COMPLETION CODE ' EXIT-RETURN-CODE
MOVE EXIT-RETURN-CODE TO RETURN-CODE.

EJECT
3000-PROGRAM-END.
COPY VSEEOJ.
GOBACK.

UNIEXIT User Exit Source Listing (Part 2 of 2)
One Example of Exit Processing
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0000-PROGRAM-CONTROL.
PERFORM 1000-PROGRAM-BEGIN.
PERFORM 2000-PROCESS-EXIT.
PERFORM 3000-PROGRAM-END.
EJECT
1000-PROGRAM-BEGIN.
IF (EXIT-OPTION-ABEND
AND EXIT-RETURN-CODE NOT NUMERIC)
DISPLAY '#UBS002E: RETURN CODE IS NOT NUMERIC.'
PERFORM 3000-PROGRAM-END.
EJECT
2000-PROCESS-EXIT.
*-------------------------------------------------------------* INSERT COBOL STATEMENTS TO PROCESS EXIT HERE *-------------------------------------------------------------IF EXIT-OPTION-SET-RETURN-CODE
MOVE EXIT-RETURN-CODE TO RETURN-CODE.
IF (EXIT-OPTION-ABEND
AND EXIT-RETURN-CODE NUMERIC
AND EXIT-RETURN-CODE IS GREATER THAN ZERO)
MOVE EXIT-RETURN-CODE TO ACR-ABEND-CODE
CALL 'UNIABND'
USING
ACR-ABEND-CODE.
EJECT
3000-PROGRAM-END.
GOBACK.

UNIEXIT User Exit Source Listing (Part 2 of 2)
Another Example of Exit Processing
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----------------------------------------------------------THE USER IS PROVIDED WITH THE EXIT OPTION REQUIRED
WHEN THE CURRENT JSQ WAS DEFINED. THE RETURN CODE
IS REFLECTS THE HIGHEST RETURN CODE SET BY THE CALLING PROGRAM. IT IS NOT EXPECTED THAT THE USER WOULD
MODIFY THESE FIELDS.
----------------------------------------------------------05
05

05

EXIT-AREA-LENGTH
PIC S9(5)
COMP VALUE +9.
EXIT-OPTION
PIC X.
88 EXIT-OPTION-SET-RETURN-CODE VALUE 'Y'.
88 EXIT-OPTION-ABEND
VALUE 'X'.
EXIT-RETURN-CODE
PIC 9(4).

UNIEXIT Copy member

User Exit Example
Here's an example of how to edit the UNICNTL and UNIUOPT user exit
programs to provide default UNICF and UNIUF dataset names for dynamic
file allocation.
1. Edit the PDS member UNICNTL in UNI.SRCELIB.
a. Change the value of Working-Storage field

WS-CNTL-DSNAME from the dummy value
XXXX.XXXXXXXX.XXXXXXXX to a name like
XXXX.UNI.UNICNTL, where XXXX is replaced by the highlevel qualifier(s) for your ACR/Summary Control File.
b. Remove the comment asterisk from Column 7 of the Procedure

Division statement:
MOVE WS-CNTL-DSNAME TO CNTL-DSNAME.
c. Save the changes to the member.
2. Edit the PDS member UNIUOPT (see the figures after the heading

“User Options File (UNIUOPT) User Exit” on page 667) in
UNI.SRCELIB.
a. Change the value of Working-Storage field

WS-UNIUF-DSNAME from the dummy value
XXXX.XXXXXXXX.XXXXXXXX to a name like
XXXX.UNI.UNIUOPT, where XXXX is replaced by the highlevel qualifier(s) for your ACR/Summary User Options File.
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b. Remove the comment asterisk from Column 7 of the Procedure

Division statement:
MOVE WS-UNIUF-DSNAME TO UOPT-DSNAME.
c. Save the changes to the member.
3. Use the COBOL compile JCL valid for your site to compile and link-

edit both programs into the load library containing the ACR/Summary
system.
Be sure to include UNI.COPYLIB in the SYSLIB DD statements, and
link-edit the programs into the ACR/Summary load library, replacing
the standard versions supplied with the installation (an alternative
method is to link-edit the programs into a separate load library, which
should be concatenated above the ACR/Summary load library in your
job JCL). By making these changes and dynamically allocating other
ACR/Summary files, you can reduce the number of ACR/Summary DD
statements necessary in your ACR/Summary JCL and consolidate the
names used by all ACR/Summary production jobs.
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Using Translation Tables and
Cycle Tables
This chapter explains internal and external translation tables and cycle
tables. It contains the following sections:









“Translation Table Processing” on page 679
“Internal Vs. External Translation Tables” on page 680
“Creating an External Translation Table” on page 683
“External Translation Table Trace Report” on page 722
“Incorporating an Translation Table into a Balancing Job” on page 729
“Defining and Using Internal Translation Tables” on page 730
“Setting Up Cycle Tables” on page 732

Translation Table Processing
Translation table processing allows you to change a value from an input
source to a different, more understandable or usable value for processing
and reporting. A translation table is a set of rules that indicate the values
that should be changed, when to change them, and the what the new values
should be.
Translation occurs after data to be translated is extracted from the input
source and before the value is stored in an item. In the following graphic, a
state abbreviation, AK, is extracted from a report file.
Translation
occurs here

Input file

Extracted
data
AK

To
Balancing

Definition
Database
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In the translation process, extracted data is compared to values in the
translation table. If a match is found, the extracted value is translated.
Then, the translated value either replaces the original value, or (for external
tables only) is stored as an extraction variable. The translated value can
then be used in balancing.
In the following graphic, the extracted state abbreviation AK is translated
into the state code 01.
Extracted
data
AK

Translation
Table

Translated
data
01

Internal Vs. External Translation Tables
External and internal translation tables are both used to translate field
items (access modes 1-5), detail fields (access modes 6-7) and extraction
variables for balancing purposes.
Characteristics that are not shared by the two types of tables are described
in the following sections.

What is an Internal Translation Table?
An internal translation table is a table consisting of two columns (input and
output). You create it by defining up to 999 input/output entries. This type
of table is suitable for performing simple one-to-one translations within an
ACR/Summary job.
For example, suppose you are balancing values from two reports, and you
decide to use a region number (01, 02, etc.) as the field value. However, the
region number does not show up on one of the reports. Only the region
name (Dallas, New York, etc.) appears. To address this situation, you would
set up an internal translation table with the region names that need to be
translated as input and the corresponding region numbers as output.
For more complex translations where the data is more dynamic, use an
external translation table, which is described in the next section.
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External Translation Table Example
Before you start to build an external translation table, it may be helpful to
have a simple example. The table will translate the 2-character abbreviation
into a two-position numeric code so that the data on two input reports can
be balanced.

The Reports
Report 1 shows total quarterly sales figures by state, using the 2-position
numeric code. Report 2 shows monthly sales figures by state, using a 2character postal abbreviation.
Using the code as input, we can output the postal abbreviation and balance
the quarterly figures on Report 1 to the monthly figures on Report 2.
XYZ COMPANY

QUARTERLY SALES FIGURES
Q3, 2009

STATE
01
02
03
.
.
.
.
XYZ COMPANY

STATE
AK
AK
AK
AL
AL
AL
.
.
.
.

TOTAL
175,000.00
225,000.00
120,000.00

MONTHLY SALES FIGURES
Q3, 2009
TOTAL
50,000.00
25,000.00
100,000.00
100,000.00
100,000.00
25,000.00.

The Source Data
The source data contains the data needed to do the translation. The system
will read this source data and build a translation table based on the
definitions.
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In this example, the source data is as follows:
01000001AK
02000002AL
03000003AZ
04000004CA
05000005CO
06000006DE
07000007GA

For our translation we will use the first two characters and the last two
characters. The middle characters will not be used in the translation
process.

The Build Table
The table to be built will consist of two columns: one for the numeric state
code and one for the alphanumeric state abbreviation. During extraction, if
the system comes across a field value or detail field to be translated, it looks
for the name of the translation table related to the value of the field and
then looks for a match in that table. If it finds a match, it performs the
translation and returns the result to the extraction process.
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Code

Abbreviation

01

AK

02

AL

03

AZ

04

CA

05

CO

06

DE
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Creating an External Translation Table
Getting Started
To create or edit an external translation table, do the following:
From the Job Window, select Window > Translation tables to display
the Translation panel.

Translation Panel
Translation
Choose an option:
__ 1. Process an external table
2. Process an internal table
Save extraction variables to job? N

F1=Help

F2=Split

F3=Exit

(Y/N)

F9=Swap

Choose an option. Select option 1.
Save extraction variables to job. This field applies only to external
translation tables. Enter Y if you want to save the extraction variables
defined as part of the table definitions along with any other extraction
variables defined in the currently open job.
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When you press Enter, the Translation Table Window displays.

Translation Table Window
File Edit Window Help
--------------------------------------------------------------------Translation Table Window
Row 1 from 14

_
_
_
_
_
_
_
_
_
_
_
_
_

A.

B.
C.
D.
E.
F.

Basic Table Information:
Table ID:
Dataset Organization:
Build Option:
Input-Output Parameters: 000
< NEW... >
Table Columns: 000
< NEW... >
Table Lookup Rules: 000
< NEW... >
Build Preparation Rules: 000
< NEW... >
Constant Table Data: 000

Command Line ===> ___________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

The following sections will explain how to use the window.

Defining Basic Table Information
Translation Table Information
To define the table ID, select Table ID under Basic Table Information. The
External Table Information panel is displayed.
Translation Table Information
Table ID: ________________
Description: ________________________________________
Last update by:
F1=Help

F3=Exit

Date:

Time:

F5=Accept

Table ID. Assign a meaningful name. It must be the same as the table
name used to translate the key or detail field.
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Description. Describe the table. Alternatively, if you are accessing a
VSAM file, you have the key to the file, and you expect all items to be found
on the file, you can access the VSAM file randomly by using the literal
@ONEROW as the description. For more about the ONEROW feature, see
“Using VSAM ONEROW Processing” on page 691.
Last update by/Date/Time. This displays the ID associated with the
most recent update to this set of definitions, along with the date and time of
the update.

Dataset Organization
From the Translation Table Window, select Dataset Organization. The
Dataset Organization panel is displayed.
Dataset Organization
Choose the dataset organization below:
1
1. Sequential input file...
2. Keyed VSAM file...
3. User program...
4. Constant translation data
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

Choose the dataset organization below. Options:
1. "Sequential Input File" (see below). Specify this if you are using

physical sequential dataset.
2. “Keyed VSAM File” on page 687. Specify this if you are using a VSAM

KSDS (keyed sequential dataset) file.
3. “User Program” on page 688. Specify this if the source of the table is

accessed through a user access program.
4. “Constant Translation Data” on page 689. Specify this if you are using

constant translation data.
When you press F5 to accept. A second panel is displayed corresponding to
the dataset organization type you indicated.
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Sequential Input File
If you indicated that dataset organization is a sequential input file, the
following panel is displayed.
Sequential Input File
DDNAME:
DSName:
Display
If yes,

________
____________________________________________
the above DSName in the extract window?
Y (Y/N)
enter number of lines to display: . . . . 00100 (1-99999)

Use delimited data fields? N
F1=Help

F2=Split

F3=Exit

(Y/N)
F5=Accept

F9=Swap

DDName. The file’s DDname.The first character must be alphabetic. The
file DDNAME must match the DDNAME in the JCL that points to the
report or dataset to which the file descriptions will be applied.
DSName. Name of the dataset containing the source data.
Display the above DSName in the extract window? Leave the Y
(only available for physical sequential and VSAM KSDS files) if you want to
view the data in the Extract Window, which allows you to mark-andcapture columns when building rules as described in “Mark-and-Capture
Method” on page 697.
If yes, enter number of lines to display. Enter the number of lines to
display (from the top of the source data) if you answered Yes.
Use delimited data fields. If the source dataset is in delimited format
and you will be extracting delimited fields using the field number directly,
enter Y. If you are using a user program such as UUPDLIM or you are
specifying the position and length in the record, enter N. For more
information about extracting directly from a delimited data file, see
“Extracting Directly from a Delimited Data File” on page 356.
Press F5 to accept. If you specified that you are using a delimited data file,
the "Delimited Data File Information Panel" displays, as shown below.
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Delimited Data File Information Panel
Delimited Data File Information
Specify the length of fixed data area:
Delimiter character: _

_

_

0000
_

(1-1000)
_

Enclosure character: _
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify the length of fixed data area. Enter the length of the fixed area
of the delimited file.
Delimiter character. Enter one to five characters that will be used to
delimit the fields in each record. Use t or T to indicate a tab.
Enclosure character. Specify the character that will be used to indicate
the start and end of the text field. The delimited character will be ignored
between the enclosure characters.

Keyed VSAM File
If you indicated that the dataset organization is a keyed VSAM file, the
Keyed VSAM File panel is displayed.
Keyed VSAM File
DDNAME:
DSName:
Display
If yes,

F1=Help

________
____________________________________________
the above DSName in the extract window?
Y (Y/N)
enter number of lines to display: . . . . 00100

F2=Split

F3=Exit

F5=Accept

F9=Swap

DDName. The file’s DDname.The first character must be alphabetic. The
file DDNAME must match the DDNAME in the JCL that points to the
report or dataset to which the file descriptions will be applied.
DSName. Name of the dataset containing the source data.
Display the above DSName in the extract window? Leave the Y
(only available for physical sequential and VSAM KSDS files) if you want to
view the data in the Extract Window, which allows you to mark-andcapture columns when building rules.
If yes, enter number of lines to display. Enter the number of lines to
display (from the top of the source data) if you answered Yes.
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User Program
User programs can be called by ACR/Summary to access input sources that
ACR/Summary does not access directly. If you indicated that the dataset
organization is a user program, the panel shown below displays.
User Program
DDNAME: ________
Specify user program information:
Program name: ________
Program parm area: __________________
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

DDName. The file’s DDname.The first character must be alphabetic. The
file DDNAME must match the DDNAME in the JCL that points to the
report or dataset to which the file descriptions will be applied.
Specify user program information:
Program name. Enter the user program name. It can be your program or
one of the Infogix user programs, which are as follows:

 UUPDLIM. The Delimited Field Access Method can be used to extract
data from files containing records of variable length fields, separated by
one or more separator characters or delimiters. (Delimited data can
also be extracted directly without a user program. See the Delimited
Data Field Num field in “Physical Sequential File Information Panel”
on page 264.)

 UUPEDIF. The Infogix EDI Access Method can be used to extract data
from EDI files (in X12 format).

 UUPVREC. The Infogix Variable Record Access Method can be used to
extract data from variable length records consisting of a fixed “header”
area and a variable number of “line” areas.

 UUPXML. The Infogix XML Access Method can be used to extract data
from XML files.
Program parm area. Parameters to pass information to the user
program. Each program name specified above will need information to be
passed. Up to 18 characters can be passed via this field.
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Constant Translation Data
Constant translation data provides the features of external translation
tables (multiple lookup parameters and columns, complex lookup
capabilities) with the simplicity and control of an internal translation table.
You define all of the data for the translation table yourself.
You can define as many columns as you want, as long as you observe the
maximums provided in “Maximum Lengths for Regular and Extended
Data” on page 196.
Constant translation does not need an exact match of the extracted data to
the input column. Selection criteria can be used.
The left-hand side can contain character or numeric data. You can choose
“At end” to signal that when the end of the table is reached, additional
processing should occur.
An extra section (section F. Constant Table Data) displays on the
Translation Table Window. This section enables you to specify the data
records from which the table’s columns will be built. You may have up to
999 of these records, although for easier maintenance you would probably
switch to physical sequential organization before you got to 999 data
definitions.
Constant Table Data Panel
Select Constant Table Data, on the Translation Table Window, to define
constant table items. Each of these items is a data record from which you
will build the table’s columns. You may have up to 999 constant table items.
Select New under Constant Table Data to define a constant table item. The
Constant Table panel appears.
Constant Table
Item number: 001

(1-999)

Specify table data information:
________________________________________
________________________________________
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

Item number. Number of this table item.
Specify table data information. An example of constant data might be
cost center names and numbers. For instance, you might want to translate
cost center locations (Dallas, Atlanta, etc.) into cost center numbers (100,
170, etc.). In this case you would enter Dallas 100 in the field. Dallas

ACR/Summary User Guide for z/OS

689

24  Using Translation Tables and Cycle Tables
Creating an External Translation Table

represents column 1 and 100 represents column 2. You would allow a
certain number of spaces in between the cost center name and the cost
center number, depending on the number of characters in the longest cost
center name. For example, if the longest name is 20 characters long, the
first entry might look like this.
Constant Table
Item number: 001

(1-999)

Specify table data information:
DALLAS______________100_________________
________________________________________
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap

When you build the rules, you would create two column assignment
records. You would specify position 1 for 20 characters for column 1 and
position 21 for 3 characters for column 2.

Defining the Build Options
To define the build options, select Build Option. The Build Option panel
is displayed.
Build Option
Specify an option indicating when the table data should be
built:
1

1.
2.

Note:

First time
Each lookup
Option 2 should only be used when the building of
the table depends on the input-output parameters.

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify an option indicating when the table data should be built.
Options:
1. First time. Specify this if you intend to load and use the translation

data from the source data as it exists.
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2. Each lookup. Specify this if you intend to use extraction variables in

the build rules and therefore will be rebuilding the table rows for each
lookup based on the values of input-output parameters. Use this
option if you want to randomly access a VSAM KSDS file for each
lookup using the ONEROW feature. This feature builds a one-row
“table” of translation columns based on key information passed in via
input-output parameters (extraction variables), as detailed in "Using
VSAM ONEROW Processing" below.
Press F5 to accept.

Using VSAM ONEROW Processing
If your source data is a keyed VSAM file, you can access the file randomly
using a feature called ONEROW. This feature enables you to rebuild the
table every time you translate an item using only one member.
The built table would look as follows if you processed the Alaska record
from the “External Translation Table Example” on page 681:
Code

Abbreviation

01

AK

Then, when you translated the Alabama record, the built table would look
like this:
Code

Abbreviation

02

AL

The ONEROW feature can save processing time if the following are true:

 You have the key to the VSAM file.
 You expect all items to be found on the file.
 You will not process the same translation more than once.
Implementing ONEROW Processing
To implement ONEROW processing, enter @ONEROW in the Table
Description dialog box and specify to build the table with each lookup.
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Implementing ONEROW Processing
To implement ONEROW processing, enter @ONEROW in the Description
field on the Translation Table Information panel, and specify to build the
table with each lookup.

Specifying Input-Output Parameters
Input-output parameters define a name for the value to be translated,
specify the format for the translated value on reports, and specify the source
from which the value will be extracted (and to which it will be output after
translation). The source can be extracted data (from a key or detail field) or
an extraction variable.
To define input-output parameters, select New under Input-Output
Parameters on the Translation Table Window. The Input-Output
Parameters panel is displayed.
Input-Output Parameters
Item number: 002

(1-999)

Name: . . . ________________________________________
Description: ________________________________________
Type:
4_ 1.
2.
3.
4.

Count
Amount
Date
Text

Decimals: _

Length: __

Specify parameter source:
1_ 1. Extracted data
2. Extraction variable
Extraction variable number: ___

F1=Help

F2=Split

F3=Exit

(1-999)

Extended? N

F5=Accept

F6=ExtVar

(Y/N)

F9=Swap

Item Number. This number will be referred to in the lookup rules.
Name. Enter a meaningful name that will be displayed on the Translation
Table Window next to the item number. We recommend that you include IO in the name to distinguish the item from like-named columns.
Description. Describe the parameter.
Type. The data format in which the parameter should be displayed. See
“Understanding Field Formats” on page 288 for an explanation of the
formats.
Decimals. For amounts, enter the number of decimals for the parameter.
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Length. The length of the parameter. For formats Count, Amount, and
Date, partial extraction is not allowed, so do not enter a length. For text, see
“Maximum Lengths for Regular and Extended Data” on page 196.
Specify parameter source. Select an option to indicate whether the data
source (which the translated data will be passed back to) is an extracted
value (i.e., detail field or key field) or an extraction variable.
Extraction Variable Number. If the parameter is an extraction variable
value, enter the number of the variable. To select from the list of existing
extraction variables, press F6. If you enter a number for an extraction
variable that has not yet been defined, the “Extraction Variables Panel” on
page 205 will be displayed.
Extended? If you completed the Extraction Variable Number field,
enter Y if this extraction variable was formatted to store a packed decimal
number up to 16 bytes long (30 digits) or text that up to 80 characters long.
When setting this indicator, you must be consistent. See “Consistency in
Specifying Extended Format for an Extraction Variable” on page 201.
Press F5 to accept.

Using Extraction Variables in External Translation Tables
The following table summarizes the possible uses of extraction variables in
external translation table definitions:
Definition

Source

Target

Input-Output
Parameter

Extraction Variable

Extraction Variable

Selection Record

Extraction Variable (LHS)

Extraction Variable (RHS)

Reformat Record

Extraction Variable

Extraction Variable

Column
Assignment Record

Extraction Variable

Extraction Variable
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Defining the Table Columns
The Table Columns panel enables you to define each of the columns for the
translation process, both before and after translation. To define table
columns, select New under Table Columns on the Translation Table
Window. The Table Columns panel is displayed.
Table Columns
Item number: 001
Name:

(1-999)

. . . ________________________________________

Description: ________________________________________
Type:
4
1.
2.
3.
4.

Count
Amount
Date
Text

Decimals: _

Length: __

Is this column used to sort the table? N
Specify the sort key number: ___

F1=Help

F2=Split

F3=Exit

(Y/N)

(1-10)

F5=Accept

F9=Swap

Item Number. Verify or change the column number (001-999) for the
value. You will reference this number during the table build process. This
number will automatically increment.
Name. A descriptive name for the column.
Description. Optionally enter a more extensive description.
Type. The data format in which the column should be displayed. See
“Understanding Field Formats” on page 288 for an explanation of the
formats.
Decimals. For amounts, enter the number of decimals.
Length. The length (width) of the column.
Is this column used to sort the table? Enter Y if you want to use this
column as a sort key for the table. You can use up to 10 sort keys (80 bytes
total) to increase the table’s processing efficiency.
Specify the sort key number. If the column is used to sort the table,
indicate the sort order of this column.
Press F5 to accept. To add another column, select New from the
Translation Table Window.
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Defining Build Preparation Rules
Build preparation rules are used if all of the following are true:
1. The source data is stored on a VSAM KSDS file.
2. You want to process the file from a location other than the first record.
3. The source data is accessed by key.

Build preparation rules will issue a start on the VSAM file key for the values
specified. This can improve processing speed if you are not reading the
entire file.
Always use build preparation rules for the ONEROW feature. For more
information, see “Using VSAM ONEROW Processing” on page 691.

Build Preparation Rules Panel
Select NEW under Build Preparation Rules. The Build Preparation Rules
panel is displayed. You will use this panel to retrieve the key to the VSAM
file.
Build Preparation Rules
Item number: 001
Specify the source of input:
2
1. Literal area...
2. Parameter number...
Specify output information:
Field position: ____

F1=Help

F2=Split

Field length: __

F3=Exit

Field format:
2
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zone decimal
5. Binary
F5=Accept

F9=Swap

Specify the source of input. Indicate the type of input source to be used
for this rule.
1. Literal area. The input will be coming from the literal area.
2. Parameter number. The input will be coming from an input-output

parameter.
Specify output information:
Field position. Enter the first position of the key to the VSAM file.
Field length. Enter the number of positions in the key.

ACR/Summary User Guide for z/OS

695

24  Using Translation Tables and Cycle Tables
Creating an External Translation Table

Field format. The format of the value. See “Understanding Field
Formats” on page 288 for an explanation of the formats.
Press F5 to accept.

 If you chose Literal area, the Build Preparation Rules (Literal Area)
panel is displayed.

 If you chose Parameter number the Build Preparation Rules (Parameter
Number) panel is displayed.

Build Preparation Rules (Literal Area)
If you selected Literal Area as the input source, the following panel is
displayed.
Build Preparation Rules (Literal Area)
Literal: ____________________
Field position: 0001

F1=Help

F2=Split

Field length: 80

F3=Exit

2

Field format:
1. Numeric
2. Alphanumeric

F5=Accept

F9=Swap

Literal. Enter characters for the literal.
Field position. Enter the position where the literal begins relative to the
beginning of the literal area. The position and length together must not
exceed 81.
Field length. Length of the literal relative to the input field position.
Field format. The format of the value. See “Understanding Field
Formats” on page 288 for an explanation of the formats.
Press F5 to accept.

Build Preparation Rules (Parameter Number)
If you selected Parameter Number as the source, the following panel is
displayed.
Build Preparation Rules (Parameter Number)
Parameter number: ___
Field position: 0001

F1=Help
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(1-999)
Field length: 08

F3=Exit

Field format:
2
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zone decimal
5. Binary
6. Unsigned packed
F5=Accept
F9=Swap
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Parameter number. Enter the number of the input-output parameter to
be used.
Field position. Enter the input field position relative to the beginning of
the input-output parameter. The position and length together must not
exceed the size of the input-output parameter. See “Maximum Lengths for
Regular and Extended Data” on page 196.
Field length. Enter the length of the input-output parameter value that
you want to include.
Field format. Indicate the format of the value. See “Understanding Field
Formats” on page 288 for an explanation of the formats.
Press F5 to accept.

Defining Table Build Rules
A table build rule defines the criteria for finding a field in the source data
and assigning it to a column in the table being built.

Two Methods of Creating Table Build Rules
Mark-and-Capture Method
Your input source data will appear in the Extract Window if all of the
following are true:

 You completed the Basic Table Information fields correctly.
 You set the field Display the above DSName in the extract
window? on the Input Files panel to Y.

 Your file organization is physical sequential or VSAM KSDS
Here is an example of the Extract Window displaying source data:
File Edit View Window Help
--------------------------------------------------------------------Translation Table Extract Window
LINES 00000007 COL 0001
0072
----+----1----+----2----+----3----+----4----+----5----+----6----+---01000001AK
02000002AL
03000003AZ
04000004CA
05000005CO
06000006DE
07000007GA
Command Line ===> ___________________________________ SCROLL ===> PAGE
F1=Help
F2=Split
F3=Exit
F4=Actions F5=Repeat
F6=Add
F7=Up
F8=Down
F9=Swap
F10=Left
F11=Right
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To use mark-and-capture, position the cursor on the first position of the
source data for the column you are going to build and press F6. The system
displays the Select the Table Build Rule Type panel.
Manual Method
With this method, you manually specify the position and length of columns.
This method is available for all file types. It is the only method available if
the source data will be extracted from a user program.
You might also use manual definition if you have binary or packed data to
be defined for a physical sequential field or a VSAM KSDS. The Extract
window will display the source data in text and display numeric format.
This means, for example, that if you have a hexadecimal field, you would
not see the actual hexadecimal values.
To use the manual method, from the Extract Window, press F6 (Add). The
system displays the Select the Table Build Rule Type panel.
Select the Table Build Rule Type Panel
Regardless of whether you used mark-and-capture or the manual method,
the following panel will appear.
Select the table build rule type:
__

1.
2.
3.
4.
5.

Selection record...
Relative record...
Reformat record...
Column assignment record...
Process control record...

For a selection record, enter comparison values
in extended format: N (Y/N)
F1=Help

F3=Exit

Select the table build rule type. Options:
1. Selection Record. This rule type defines the criteria for selecting

records from the external data source or from an extraction variable.
Values will later be extracted from the selected records and assigned to
the external translation table See “Selection Records” on page 699.
2. Relative Record. This rule type indicates the number of records to

advance from the currently selected record. See “Relative Records” on
page 706.
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3. Reformat Record. This rule type reformats values from 1) the external

data source, 2) a literal, or 3) an extraction variable and outputs the
reformatted values to the output area or to an extraction variable. See
“Reformat Records” on page 706.
4. Column Assignment Record. If the selection records are satisfied, this

rule type extracts a column value from the 1) the external data source,
2) a literal or 3) an extraction variable and assigns it to a translation
table column or to an extraction variable. See “Column Assignment
Record” on page 711.
5. Process Control Record. This rule type determines the processing

(either a control key break or “at end” processing) to be performed
after a selection group has been satisfied. See “Process Control Record”
on page 715
For a selection record, enter comparison values in extended
format. Enter Y if your table build rule type is a selection record and the
comparison value or values will be a number with 16 to 30 digits or a text
value with 9 to 80 characters.
Press F5 to accept.
A second panel is displayed corresponding to the build rule type you
indicated. The following sections describe how to fill out each of the
different panels for the different build rule types.

Selection Records
Selection Record Panel
If you indicated from the Build Rule Type panel that your rule type is a
selection record, the following panel is displayed.
Selection Record
Specify the source of input:
1
1. Input record...
2. Extraction variable...

Specify
1
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

the selection type:
Equal to...
Not equal to...
Greater than...
Less than...
Greater than or equal to...
Less than or equal to...
Not blank...
Blank...
Character data...
Numeric data...

Process selection only one time? N (Y/N)
Read input until selection found? N (Y/N)
F1=Help

F2=Split
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Specify the source of input. Options:
1. Input record. The source as an input record.
2. Extraction variable. The source is an extraction variable.

Specify the selection type. Options:
1. Equal to. The input source is equal to the yet to be specified literal or

extraction variable.
2. Not equal to. The input source is not equal to the yet to be specified

literal or extraction variable.
3. Greater than. The input source is greater than the yet to be specified

literal or extraction variable.
4. Less than. The input source is less than the yet to be specified literal or

extraction variable.
5. Greater than or equal to. The input source is greater than or equal to

the yet to be specified literal or extraction variable.
6. Less than or equal to. The input source is less than or equal to yet to be

specified literal or extraction variable.
7. Not blank. The input source is not blank.
8. Blank. The input source is blank.
9. Character data. The input source is alphabetic (A-Z or spaces).
10. Numeric data. The input source contains numeric data (0-9)

Process selection one time only? Change to Y if your selection criteria
are met multiple times in the file and you want to use only the first
occurrence.
Read input until selection found? Change to Y if you want to skip a
portion of the input file, that is, to read records until this particular
selection condition is met.
Press F5 to accept. One of the following will display:

 If you specified the source of input for the selection as input record, the
"Selection Record (Input Record) Panel" displays, as shown in the next
section.

 If you specified the source of input for the selection as extraction
variable, the “Selection Record (Extraction Variable)” on page 702
displays.
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Selection Record (Input Record) Panel
Selection Record (Input Record)
----+----1----+----2----+----3----+----4
S
54
5,900
5,954
Delimited data field number: 0001 (1-1000)
Field format:
Field position: 0019 Field length: __ 2
1
Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed
F1=Help
F2=Split
F3=Exit
F5=Accept F9=Swap
Line reference

Line Reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor.
Otherwise it is blank.
Delimited data field number. If you entered Y for Use delimited
data fields on the Sequential Input File panel and you are extracting from
the delimited area of the file, enter the field number (this number is
displayed automatically if you used the mark-and-capture method).
Otherwise leave the field blank.
Field Position. Enter the first position of the selection field. The field will
be pre-filled if you used mark-and-capture.
Field Length. Enter the length of the selection field.
Field Format. Indicate the field format of the selection field. See
“Understanding Field Formats” on page 288 for an explanation of the
formats. If you choose the numeric field format type, any blank in the
selection field will be treated as a zero.
Press F5 to accept. If you used a selection type of equal, not equal, greater
than, less than, greater than or equal to, or less than or equal to, the “Specify
the Right Side of the Selection Comparison Panel” on page 703 is displayed.
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Selection Record (Extraction Variable)
Selection Record (Extraction Variable)
Extraction variable number: ___

Field position: 0026

F1=Help

F2=Split

(1-999)

Field length: 08

F3=Exit

Extended? N

(Y/N)

Field format:
1_ 1. Packed Decimal
2. Alphanumeric

F5=Accept

F6=ExtVar

F9=Swap

Extraction Variable Number. Enter the number of the extraction
variable that will be the source of input for the selection. To select from the
list of existing extraction variables, press F6. If you enter a number for an
extraction variable that has not yet been defined, the “Extraction Variables
Panel” on page 205 will be displayed.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number up to 16 bytes long (30 digits) or text that up to 80
characters long. When setting this indicator, you must be consistent. See
“Consistency in Specifying Extended Format for an Extraction Variable” on
page 201.
Field Position. Enter the first position of the selection field. The field will
be pre-filled if you used mark-and-capture.
Field length. Enter the length of the selection field. See “Maximum
Lengths for Regular and Extended Data” on page 196.
Field format. Format of the value stored in the extraction variable. For
more about the options, see “Understanding Field Formats” on page 288.
Press F5 to accept. If you used a selection type of equal, not equal, greater
than, less than, greater than or equal to, or less than or equal to, the Specify
The Right Side Of The Comparison panel is displayed. See below.
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Specify the Right Side of the Selection Comparison Panel
Specify the right side of the selection comparison:
Literal: ________________

Additional literal? N

(Y/N)

OR
Extraction variable number: ___

F1=Help

F2=Split

F3=Exit

(1-999)

F5=Accept

F6=ExtVar

F9=Swap

Literal. If you used mark-and-capture, this displays the first 16 bytes of
data beginning with the position where you placed the cursor. Otherwise it
is blank. To compare the selection field value to a literal, overtype if
appropriate and enter the literal value to use for the comparison.
Additional literal. Enter Y if 1) your selection type is Equal to or Not
equal to and 2) you want to evaluate against one or more literals in
addition to the literal specified here.
Extraction Variable Number. To compare the selection field value to
the value of an extraction variable, enter the number of the extraction
variable. To select from the list of existing extraction variables, press F6. If
you enter a number for an extraction variable that has not yet been defined,
the “Extraction Variables Panel” on page 205 will be displayed.
Depending on your entries, after you press F5, an additional panel may be
displayed:

 If 1) your entry in the For a selection field, enter comparison
values in extended format field on the “Select the Table Build Rule
Type Panel” on page 698 was N, and 2) you entered Y in the
Additional literal field above, the “Additional Comparison Values
Panel” on page 325 will display.

 If your entry in the For a selection field, enter comparison
values in extended format field on the “Select the Table Build Rule
Type Panel” on page 698 was Y, one of the following panels will display:

 If you are comparing against one or more alphanumeric values, the
"Comparison Values (Extended Format - Alphanumeric) Panel" in
the following section will be displayed.

 If you are comparing against one or more numeric values, the
“Comparison Values (Extended Format - Numeric) Panel” on
page 705 will be displayed.
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Additional Comparison Values
Use this panel to evaluate a value extracted from the current record or from
an extraction variable against one or more literals in addition to the literal
you entered on the Specify the Right Side of the Selection Comparison
panel.
Additional Comparison Values
Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F1=Help

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F2=Split

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F3=Exit

F5=Accept

Comparison Value
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________
________________

F9=Swap

Comparison Values (Extended Format - Alphanumeric) Panel
Use this panel in one of the following ways:
If you are comparing against an extended alphanumeric extraction
variable, complete the Extraction variable number field to specify the
variable you want to use.
Otherwise do one of the following:

 If your selection type is Equal to or Not equal to, you can compare
against up to 8 extended alphanumeric values by completing the Value
fields.

 If your selection type is Greater than, Less than, Greater than or
equal to, or Less than or equal to, you can enter only one extended
alphanumeric value against which to compare, and this value must be
entered in the Value 1 field.
If you are using the Value fields and you want to include blanks in the
comparison, leave Value 1 blank. Any other blank fields will be ignored.
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The Value fields are case sensitive.
Comparison Values (Extended Format - Alphanumeric)
Extraction variable number: ___

Value 1:
Value 2:
Value 3:
Value 4:
Value 5:
Value 6:
Value 7:
Value 8:
F1=Help

(1-999)

OR

----+----1----+----2----+----3----+----4
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
________________________________________
F2=Split
F3=Exit
F5=Accept
F6=ExtVar

F9=Swap

Comparison Values (Extended Format - Numeric) Panel
Use this panel in one of the following ways:
If you are comparing against an extended alphanumeric extraction
variable, complete the Extraction variable number field to specify the
variable you want to use.
Otherwise do one of the following:

 If your selection type is Equal to or Not equal to, you can compare
against up to 28 extended numeric values by completing the Value
fields.

 If your selection type is Greater than, Less than, Greater than or
equal to, or Less than or equal to, you can enter only one extended
numeric value against which to compare, and this value must be
entered in the Value 1 field.
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If you are using the Value fields and you want to include zeros in the
comparison, leave Value 1 blank. Any other blank fields will be ignored.
Comparison Values (Extended Format - Numeric)
Extraction variable number: ___

1:
3:
5:
7:
9:
11:
13:
15:
17:
19:
21:
23:
25:
27:

(1-999)

Comparison Value
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F1=Help

F2=Split

F3=Exit

2:
4:
6:
8:
10:
12:
14:
16:
18:
20:
22:
24:
26:
28:

OR
Comparison Value
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________
_______________________________

F5=Accept

F6=ExtVar

F9=Swap

Relative Records
A relative record is one whose location is relative to another record.
Relative records are used when 1) there is a record with data you want to
extract but does not contain anything that can be used as a selection record
and 2) the record always comes a specific number of records after another
identifiable record.
If you indicated from the Build Rule Type panel that your rule type is a
relative record, the panel below is displayed.
Relative Record
Specify the number of input records to advance from
The currently selected record: ___ (1-999)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify the number of records to read from the currently
selected record. Complete as explained above.
Press F5 to accept.

Reformat Records
If you indicated from the Build Rule Type panel that your rule type is a
reformat record, the Reformat Record panel is displayed. This rule type
reformats values from 1) the external data source, 2) a literal, or 3) an
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extraction variable and outputs the reformatted values to the output area or
to an extraction variable. Regardless of where the data to be reformatted
originates, the reformatting/moving is done in memory only and does not
change the input source, extraction variable, or literal.
For example, assume there are two fields in the external data source that
you want to use as one when you build the translation table. You can use
reformatting to reposition the fields in memory so they are next to one
another.
Reformat Record Panel
Reformat Record
Specify
1_ 1.
2.
3.

the input source to reformat:
Input record...
Literal area...
Extraction variable...

Specify output field information:
Delimited data field number: ____

(1-1000)
Field format:
Field position: ____ Field length: __ 2_ 1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed
Extraction variable number: ___ (1-999) Extended? N (Y/N)
F1=Help

F2=Split

F3=Exit

F5=Accept

F6=ExtVar

F9=Swap

Specify the input source to reformat. Options:
1. Input Record. The data being reformatted is from the currently

selected input record. If you select this option, the next panel to be
displayed will be the “Reformat Field (Input Record) Panel” on
page 709.
2. Literal Area. The data being reformatted is from the Literal Area

contained within the Reformat Field definition itself. If you select this
option, the next panel to be displayed will be the “Reformat Field
(Literal Area) Panel” on page 710, which allows you to specify the
literal.
3. Extraction variable. The data being reformatted is stored in an

extraction variable. If you select this option, the next panel to be
displayed will be the “Reformat Field (Extraction Variable) Panel” on
page 710.

ACR/Summary User Guide for z/OS

707

24  Using Translation Tables and Cycle Tables
Creating an External Translation Table

Specify output field information:
Delimited data field number. If you entered Y for Use delimited
data fields on the Sequential Input File panel and you are reformatting to
the delimited area of the file, enter the field number. Otherwise leave the
field blank.
Field Position. The entry should be the first position to be occupied by the
reformatted data. If a number is already entered, change if needed.
Field Length. Enter the length for the reformatted data.
Field Format. Indicate the field format you want for the reformatted data.
See “Understanding Field Formats” on page 288 for an explanation of the
formats. If you are reformatting a value from and/or to an extraction
variable, the only valid format is alphanumeric.
Extraction variable number. If the target of the value to be
reformatted is an extraction variable, enter an extraction variable number.
(Source and target can be the same extraction variable or different
extraction variables.) To select from the list of existing extraction variables,
press F6. If you enter a number for an extraction variable that has not yet
been defined, the “Extraction Variables Panel” on page 205 will be
displayed.
Extended? If you completed the Extraction Variable Number field,
enter Y if the reformatted value will be a packed decimal number up to 16
bytes long (30 digits) or text that up to 80 characters long. When setting
this indicator, you must be consistent. See “Consistency in Specifying
Extended Format for an Extraction Variable” on page 201.
Press F5 to accept.
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Reformat Field (Input Record) Panel
If the value to be reformatted is from the input source, the Reformat Field
(Input Record) panel displays.
Reformat Field (Input Record)

Line reference

----+----1----+----2----+----3----+----4
01000001AK
________________________________________

Delimited data field number: ____

Field position: 0001

F1=Help

F2=Split

(1-1000)

Field length: __

F3=Exit

Field format:
2
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

F5=Accept

F9=Swap

Line Reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor.
Otherwise it is blank.
Delimited data field number. If you entered Y for Use delimited
data fields on the Sequential Input File panel and you are extracting from
the delimited area of the file, enter the field number (this number is
displayed automatically if you used the mark-and-capture method).
Otherwise leave the field blank.
Field Position. Enter the first position of the field to be reformatted. If a
number is already entered, change if needed.
Field Length. Enter the length of the field to be reformatted.
Field Format. Indicate the format of the field to be reformatted. See
“Understanding Field Formats” on page 288 for an explanation of the
formats.
Press F5 to accept.
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Reformat Field (Literal Area) Panel
If the value to be reformatted is a literal, the Reformat Field (Literal Area)
panel displays.
Reformat Field (Literal Area)
Literal area: ALFA________________
Field position: 0001

F1=Help
F5=Accept

F2=Split
F9=Swap

Field length: 20

F3=Exit

Literal area. If you used mark-and-capture, this displays the first 20 bytes
of data beginning with the position where you placed the cursor. Otherwise
it is blank. Type over as appropriate to enter up to 80 characters to be
reformatted.
Field position. Enter the first position occupied by the field to be
reformatted relative to the beginning of the literal area.
Field length. Enter the number of characters to be reformatted.
Reformat Field (Extraction Variable) Panel
If the field to be reformatted is from an extraction variable, the Reformat
Field (Extraction Variable) panel displays.
Reformat Field (Extraction Variable)
Extraction variable number: ___

Field position: 0001

F1=Help

F2=Split

(1-999)

Field length: 08

F3=Exit

Extended? N

(Y/N)

Field format:
2_ 1. Packed decimal
2. Alphanumeric

F5=Accept

F6=ExtVar

F9=Swap

Extraction variable number. If the source of the value to be
reformatted is an extraction variable, enter its number. (Source and target
can be the same extraction variable or different extraction variables.) To
select from the list of existing extraction variables, press F6. If you enter a
number for an extraction variable that has not yet been defined, the
“Extraction Variables Panel” on page 205 will be displayed.

710

Infogix, Inc.

Using Translation Tables and Cycle Tables  24
Creating an External Translation Table

Extended? Enter Y if this extraction variable was formatted or, if new, will
be formatted to store a number of up to 30 digits (16 bytes in packed
decimal format) or up to 80 characters of text. When setting this indicator,
you must be consistent. See “Consistency in Specifying Extended Format
for an Extraction Variable” on page 201.
Field position. The first position to be reformatted relative to the
beginning of the extraction variable value.
Field length. The number of characters to be reformatted.

Column Assignment Record
If you indicated from the Build Rule Type panel that your rule type is a
column assignment record, the Column Assignment Record panel is
displayed. If the selection records are satisfied, this rule type extracts a
column value from the 1) the external data source, 2) a literal or 3) an
extraction variable and assigns it to a translation table column or to an
extraction variable.
Column Assignment Record
Specify the input source

-----------------Item Type: __

1.
2.

1.
2.
3.

Target Assignment
Column
Variable

Field Type: _
1. Amount
2. Count
3. Text
Date Format: __
1. YYMMDD
2. MMDDYY
3. MMDDCCYY
4. DDMMYY
5. YYJJJ
F1=Help

1_

F2=Split

Input record...
Literal area...
Extraction variable...
-------------------

Item Number: ___

Extended? N

(Y/N)

4. Date
5. Tally
6. Total
6.
7.
8.
9.
10.

DDMMCCYY
CYYMMDD
YYMMDDCC
CCYYJJJ
DDMMMYY

F3=Exit

F5=Accept

11. DDMMMCCYY
12. MMMDDYY
13. MMMDDCCYY

F6=ExtVar

F9=Swap

Specify the input source. Options
1. Input Record. The source is the currently selected input record.
2. Literal Area. The source is a literal that you will specify on the

following panel.
3. Extraction variable. The source is an extraction variable.

Target Assignment:
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Item Type. Options:
1. Column. The target item is a column number.
2. Variable. The target item is an extraction variable.

Item Number. The number of the column or extraction variable that will
store the value from the source. If the item type is extraction variable, you
can select from the list of existing extraction variables by pressing F6. If you
enter a number for an extraction variable that has not yet been defined, the
“Extraction Variables Panel” on page 205 will be displayed.
Extended? Enter Y if (target) Item Type is (Extraction) Variable and the
value will be a packed decimal number up to 16 bytes long (30 digits) or text
that up to 80 characters long. When setting this indicator, you must be
consistent. See “Consistency in Specifying Extended Format for an
Extraction Variable” on page 201.
Field Type. Field type for the target column.
1. Amount. See “Understanding Field Formats” on page 288.
2. Count. See “Understanding Field Formats” on page 288 for an

explanation of the formats.
3. Text. See “Understanding Field Formats” on page 288.
4. Date. Display the column value as a date.
5. Tally. Display the column value as a tally (count).
6. Total. Display the column value as a total.

Date Format. If the field type is Date, complete the field. The date formats
shown on this panel are explained in “Date Formats that Use DD, MM, C,
CC, YY, JJ, and/or MMM” on page 353.
Press F5 to accept. One of the following panels will display so that you can
provide more information about the source data.

 If the input source is an input record, the "Column Assignment Record
(Input Record) Panel" below will display.

 If the input source is a literal, the “Column Assignment Record (Literal
Area)” on page 713 will display.

 If the input source is an extraction variable, the “Column Assignment
Record (Extraction Variable)” on page 714 will display.
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Column Assignment Record (Input Record) Panel
If the source is an input record, define the input record on this panel.
Column Assignment Record (Input Record)

Line reference

----+----1----+----2----+----3----+----4
S
12
1,900
912

Delimited data field number: ____

Field position: 0019

F1=Help

(1-1000)

Field length:

F2=Split

__

F3=Exit

Field format:
2 1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed
F5=Accept
F9=Swap

Line Reference. If you used mark-and-capture, this displays the first 80
bytes of data beginning with the position where you placed the cursor.
Otherwise it is blank.
Delimited data field number. If you entered Y for Use delimited
data fields on the Sequential Input File panel and you are extracting from
the delimited area of the file, enter the field number (this number will be
displayed automatically if you used the mark-and-capture method).
Otherwise leave the field blank.
Field Position. This field should show the first position of the field that
should populate the column.
Field Length. Enter the field length
Field Format. Specify a format. See “Understanding Field Formats” on
page 288 for an explanation of the formats.
Press F5 to accept.
Column Assignment Record (Literal Area)
If the source is a literal, define the literal on this panel.
Column Assignment Record (Literal Area)
Literal area:

Field position: 0001

F1=Help

F2=Split
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Field length: 16

F3=Exit

Field format:
2_ 1. Numeric
2. Alphanumeric
F5=Accept

F9=Swap
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Literal area. If you used mark-and-capture, this displays the first 16 bytes
of data beginning with the position where you placed the cursor. Otherwise
it is blank. Overtype as appropriate to define the literal
Field position. Defaults to 0001. Change as appropriate.
Field length. Defaults to the maximum of 16. Change as appropriate.
Field Format. Specify a format. See “Understanding Field Formats” on
page 288 for an explanation of the formats.
Column Assignment Record (Extraction Variable)
If the source is an extraction variable, define the extraction variable on this
panel.
Column Assignment Record (Extraction Variable)
Extraction variable number: ___
Field position: 0001

F1=Help

F2=Split

(1-999)

Field length: 16

F3=Exit

Extended? N (Y/N)
Field format:
2_ 1. Packed Decimal
2. Alphanumeric

F5=Accept

F6=ExtVar

F9=Swap

Extraction Variable Number. Enter the number of the extraction
variable that will be the source for the record. To select from the list of
existing extraction variables, press F6. If you enter a number for an
extraction variable that has not yet been defined, the “Extraction Variables
Panel” on page 205 will be displayed.
Extended? Enter Y if this extraction variable was formatted to store a
packed decimal number up to 16 bytes long (30 digits) or text that up to 80
characters long. When setting this indicator, you must be consistent. See
“Consistency in Specifying Extended Format for an Extraction Variable” on
page 201.
Field position. The first position of the value to use as a source for the
column, relative to the beginning of the extraction variable value.
Field length. The number of characters to be used as the source for the
column.
Field format. The format of the value. See “Understanding Field
Formats” on page 288 for an explanation of the formats.
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Process Control Record
This panel is optional. A process control rule enables you to specify the
processing that should take place after a selection group has been satisfied.
Process Control Rule
Specify the action to be taken:
__ 1. Stop the build process
2. Write a row now
F1=Help
F9=Swap

F2=Split

F3=Exit

F5=Accept

Specify the action to be taken. Specify the processing that should occur
after a selection group has been specified.
1. Stop the build process. This will prevent further IO on the file. Select

this option to save processing time in the following situations:

 When you are using the ONEROW feature. For more information,
see “Using VSAM ONEROW Processing” on page 691.

 When you are processing a portion of a file and you know you have
completed building the table before the end of the file is reached.
2. Write a row now. Write a row out when a selection group has been

satisfied.

Viewing the Definitions
To verify that the definitions have been added, from the Translation Table
Window, select Window > Translation Table Extract > View >
Definitions. The following figure shows the Definition Review panel for
the first column assignment .
File Edit View Window Help
--------------------------------------------------------------------Definition Review
Row 1 TO 1 OF 1
ASSIGN INPUT IN POS 0001 FOR 02 POSITIONS TO COLUMN 001
*************************** BOTTOM OF DATA ****************************

Command Line ===> ____________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap
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Selecting a Lookup Rule Type
Table lookup rules tell the system what to do when it encounters a value to
translate. The three types of lookup rules work together. They are processed
sequentially in the following order: 1) Selection, 2) Assign, 3) Flow.
To define a table lookup rule, from the Translation Table Window, select
New under Table Lookup Rules to display the Select a lookup rule type
panel.
Select a lookup rule type:
__

1. Selection...
2. Assign...
3. Flow...
F1=Help
F3=Exit

Select a lookup rule type. Options:
1. Selection. Identifies the values to be evaluated and states the

comparison operator.
2. Assign. Specifies the value to assign when the selection rule is satisfied.

For example, when an input-output parameter is equal to a particular
column from the table, assign it the value of another column from the
table.
3. Flow. Specifies the processing that should occur when a selection rule

and an assign rule are processed. By default, processing will terminate.
Press Enter to view the Selection Rule panel. Go to the appropriate section:

 “Defining a Selection Rule” on page 717
 “Defining an Assign Rule” on page 720
 “Defining a Flow Rule” on page 721
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Defining a Selection Rule
This type of rule can compare input-output parameters to table columns or
to other input-output parameters. For example:
IF INPUT-OUTPUT PARAMETER 1 EQ TABLE-COLUMN 1
The assign (lookup) rule associated with this selection (lookup) rule will be
activated when the equation is true.
A selection rule also can specify that when the end of the table is
encountered, additional processing should occur.

Selection Rule Panel
Selection Rule
Specify the selection type:
__ 1. Equal to...
2. Not equal to...
3. Greater than...
4. Less than...
5. Greater than or equal to...
6. Less than or equal to...
7. Not blank...
8. Blank...
9. Character data...
10. Numeric data...
11. At end
F1=Help
F2=Split
F3=Exit
F9=Swap

F5=Accept

4. Specify the selection type. Options:
1. Equal to. Determine whether the left-hand side and the right-hand side

of the selection rule are equal.
2. Not equal to. Determine whether the left-hand side and the right-hand

side of the selection rule are not equal.
3. Greater than. Determine whether the left-hand side is greater than the

right-hand side of the selection rule.
4. Less than. Determine whether the left-hand side is less than the right-

hand side of the selection rule.
5. Greater than or equal to. Determine whether the left-hand side is

greater than or equal to the right-hand side of the selection rule
6. Less than or equal to. Determine whether the left-hand side is less than

or equal to the right-hand side of the selection rule
7. Not blank. Determine whether the left-hand side of the selection rule is

not blank.
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8. Blank. Determine whether the left-hand side of the selection rule is not

blank.
9. Character data. Determine whether the left-hand side of the selection

rule contains character data.
10. Numeric data. Determine whether the left-hand side of the selection

rule contains numeric data.
11. At end. Signal that when the end of the table is reached, additional

processing should occur.
Press F5 to accept.

 If you chose selection type 1 - 6, see "Selection Criteria (LHS/RHS)
Panel" below.

 If you chose selection type 7 - 10, see “Selection Type (LHS Only) Panel”
on page 719,

 If you chose selection type 11, the Translation Table Window is
displayed.

Selection Criteria (LHS/RHS) Panel
Selection Criteria
Specify the left side of the comparison:
Item type:
2_ 1. Input-output parameter
2. Table column

Item number: ___

(1-999)

Specify the right side of the comparison:
Item type:
__ 1. Input-output parameter
2. Table column

Item number: ___

(1-999)

OR
Literal: ________________

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify the left side of the comparison:
Item type. Options:
1. Input-output parameter. Use the specified input-output parameter as

the left side of the comparison.
2. Table column. Use the specified table column as the left side of the

comparison.
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Item Number. Number of the input-output parameter or table column
for the left side of the comparison.
Specify the right side of the comparison.
Item type. Options:
1. Input-output parameter. Use the specified input-output parameter as

the right side of the comparison.
2. Table column. Use the specified table column as the right side of the

comparison.
Item Number. Number of the input-output parameter or table column
for the right side of the comparison.
Literal. To specify a literal value for the right side instead of using an item
type and item number, enter the value to be used on the right-side of the
comparison.
Press F5 to accept.

Selection Type (LHS Only) Panel
If you indicated selection criteria 7-10 on the Selection Rule panel, the
following panel is displayed.
Selection Criteria
Item type:
2
1. Input-output parameter
2. Table column
Item number: 000 (1-999)
F1=Help
F2=Split
F3=Exit
F9=Swap

F5=Accept

Item type. Options:
1. Input-output parameter. Use the specified input-output parameter as

the left side of the comparison.
2. Table column. Use the specified table column as the left side of the

comparison.
Item Number. Number of the input-output parameter or table column
for the left side of the comparison.
Press F5 to accept.

ACR/Summary User Guide for z/OS

719

24  Using Translation Tables and Cycle Tables
Creating an External Translation Table

Defining an Assign Rule
Use the Assign rule panel to specify the value to assign when the selection
rule is satisfied..
Assign Rule
Specify the input-output parameter to set: ___

(1-999)

Specify an item number or literal value to use:

Item number: ___

(1-999)

Item type:
__ 1. Input-output parameter
2. Table column

OR
Literal: ________________
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Specify the Input-Output parameter to set. Number of the inputoutput parameter that will be assigned a value from another input-output
parameter, from a table column, or from a literal.
Specify an item number or literal value to use. Do one of the following:

 Complete the Item number and Item type fields:
Item number. The number of the source to use in the assignment.
Item type. Options:
1. Input-output parameter. Assign the value from the designated

input-output parameter into the input-output parameter to be set.
2. Table column. Assign the value from the designated table column

into the input-output parameter.

 Literal. Specify a literal value to use in the assignment
Press F5 to accept.
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Defining a Flow Rule
A flow rule is initiated based on the evaluation of a selection rule, or a
selection rule and an assign rule. There are three types of flow rules:
Use this rule type

To

Terminate

Terminate the lookup for this table and indicate
success or failure. You can initiate another table
lookup.

Skip row

Skip a particular row in a table.

Continue lookup

End this selection group and continue processing.
Either the next selection group or the next row is
processed.

Flow Rule Panel
Flow Rule
Choose a lookup flow action:
1
1. Terminate...
2. Skip row
3. Continue lookup
F1=Help
F2=Split
F3=Exit
F9=Swap

F5=Accept

Choose an option to determine the lookup flow action. Options:
1. Terminate. Terminate processing once the selection rules and assign

rules have been met.
2. Skip row. Skip the row once the selection rules and assign rules have

been met.
3. Continue lookup. Continue the lookup once the selection rules and

assign rules have been met.
Press F5 to accept.
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Terminate Options Panel
If you indicated terminate as the lookup flow action the following panel is
displayed.
Terminate Option
Specify terminate option:
1
1. Report success
2. Report failure
Next table: ________________
F1=Help
F2=Split
F3=Exit
F9=Swap

F5=Accept

Specify terminate option. Options:
1. Report success. Report the success of the selection and assign rules.
2. Report failure. Report the failure of the selection and assign rules.

Next table. Name of the next table to use in the lookup rules, if any.
Press F5 to accept.

Additional Steps
See the following sections:

 "External Translation Table Trace Report" in the next section. This
report is optional.

 In the balancing job, make the specifications explained in
“Incorporating an Translation Table into a Balancing Job” on page 729

External Translation Table Trace Report
This report is available for access modes 6 and 7 when you run a job in
batch. It provides the following information for a requested input file ID:

 A formatted list of the table build rule definitions as they were loaded in
preparation for building the external translation table.

 For each input record processed, the following information is provided:
 The record count plus the first 132 characters of the input record
 The processing of each table build rules against the record to build
the external table. This includes the following:

 The table build rule definition.
 LH Value: The value as extracted from the input source.
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 RH Value: The value from the external table column to which
the LH Value is being compared.

 Action Taken: Whether the comparison passed or failed.
 For rules that passed the comparison, the value assigned to
replace the original value from the input source.

 Details about each translation attempt.
The information below is divided into the following sections:

 “Generating and Viewing the Report” on page 723
 “External Definition List Section” on page 724
 “Table Build Rule Processing Per Record Section” on page 725
 “Formatting of Table Build Rules” on page 726
Note:

You can generate another type of Trace Report that shows the
processing of the file definitions against each record in the input
source. For information on that report, see Trace Report on
page 390.

Generating and Viewing the Report
To generate the report, complete the following steps:
1. Add the UNIETR DD statement after the UNIACR4 DD statement as

shown below:
//UNIETR DD SYSOUT=&OUT,
// DCB=(RECFM=FBA,LRECL=133, BLKSIZE=133)
2. Add the following two lines to the end of your balancing JCL:
//STEPNAME.UNITRACE DD *
EXTDD

T

In these two lines, STEPNAME is the stepname for your balancing job, and
EXTDD is the File DDName of your external translation table. The T must
be in column 30.
Note:

You can generate both the regular Trace Report and the External
Translation Table Trace Report with the following lines in your JCL:
//STEPNAME.UNITRACE DD *
FILEDD<-----Input file’s DD generates regular Trace Report
EXTDD
T<-External table’s DD
followed by T in
column 30 generates
External Translation
Table Trace Report
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Like the regular Trace Report, the External Translation Table Trace Report
will be named UNIETR and can be viewed through your site’s normal
facility for viewing job output (e.g., IOF, SDSF).

External Definition List Section
The first section is a formatted list of the table build rule definitions.
Following is an example.The first report section, a sample of which is
shown below, is a formatted list of the table build rule definitions.
Note:

In the following report excerpts, extended values are printed as
follows:
 Extended LH values (from the input source) that will not fit on
a line are indicated with SEE VALUE BELOW.
 Extended RH values (from the external table column to which
the LH Value is being compared) that will not fit on a line are
indicated with SEE LITERAL.
The extended values are then printed on separate lines.

EXTERNAL DEFINITION LIST: LONG NUMBER
----------------------------------------------------------------------------------SELECT(0010/12/NUM/ NA ) INPUT (EQUAL
) LIT (000111222333444 )
(000222333444555 )
(000333444555666 )
SELECT(0010/31/NUM/ NA ) INPUT (EQUAL
) LIT *SEE VALUE BELOW*
SELECT LITERAL:
(111222333444555666777888999000 )
SELECT LITERAL:
(222333444555666777888999000111 )
SELECT LITERAL:
(333444555666777888999000111222 )
ASGN(0010/31/CNT/ NA ) INPUT (001/NUM/XVAR)
ASGN(0010/31/CNT/ NA ) INPUT (002/NUM/XVAR)
SELECT(0010/12/NUM/ NA ) INPUT (GT
) LIT (000111222333444 )
SELECT(0010/31/NUM/ NA ) INPUT (GT
) LIT *SEE VALUE BELOW*
SELECT LITERAL:
(111222333444555666777888999000 )
SELECT(0001/16/PAC/0001) XVAR (EQUAL
) XVAR(0002)
SELECT(0001/16/PAC/0001) XVAR (GT
) LIT **SEE VALUE BELOW*
SELECT LITERAL:
(111222333444555666777888999000 )
ASGN(0010/06/CNT/ NA ) INPUT (001/NUM/COL )
ASGN(0010/31/CNT/ NA ) INPUT (002/NUM/COL )
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Table Build Rule Processing Per Record Section
This section shows the processing of each table build rule against each
record in the data source to build the external translation table.
EXTERNAL TABLE RECORD 00000001
----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0----5----0OMPE3112 111222333444555666777888999000+ONE MUSEUM PARK EAST
---------------------------------------------------------------------------------------------------------------------------EXTERNAL DEFINITION LIST: LONG NUMBER
LH VALUE
RH VALUE
ACTION TA
---------------------------------------------------------------------------------------------------------------------------SELECT(0010/12/NUM/ NA ) INPUT (EQUAL
) LIT (000111222333444 )
(000111222333444+) ***SEE LITERAL*** PASSED
(000222333444555 )
(000333444555666 )
SELECT(0010/31/NUM/ NA ) INPUT (EQUAL
) LIT *SEE VALUE BELOW*
*SEE VALUE BELOW* ***SEE LITERAL*** PASSED
LH VALUE:
111222333444555666777888999000
SELECT LITERAL:
(111222333444555666777888999000 )
SELECT LITERAL:
(222333444555666777888999000111 )
SELECT LITERAL:
(333444555666777888999000111222 )
ASGN(0010/31/CNT/ NA ) INPUT (001/NUM/XVAR)
111222333444555666777888999000+
ASGN(0010/31/CNT/ NA ) INPUT (002/NUM/XVAR)
111222333444555666777888999000+
SELECT(0010/12/NUM/ NA ) INPUT (GT
) LIT (000111222333444 )
(000111222333444+) ***SEE LITERAL*** PASSED
SELECT(0010/31/NUM/ NA ) INPUT (GT
) LIT *SEE VALUE BELOW*
*SEE VALUE BELOW* ***SEE LITERAL*** FAILED
LH VALUE:
111222333444555666777888999000
SELECT LITERAL:
(111222333444555666777888999000 )

For each input record processed, the following information is provided:

 The record count plus the first 132 characters of the input record
 The processing of each table build rule against the record to build the
external table. This includes the following:

 The table build rule definition.
 LH (Left-Hand) Value:
For selection criteria rules, the LH Value column shows the source
value evaluated by the rule.
For column assignment rules, the LH Value column shows the
value to be assigned to the external table column or extraction
variable if the record passes the evaluation.

 RH Value: This shows the value from the external table column to
which the LH Value is being compared.

 Action Taken: This shows whether the comparison passed or failed.
 For rules that passed the comparison, the value assigned to replace
the original value from the input source is shown.
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Formatting of Table Build Rules
Delimited Data Extraction Formats
Selection Criteria Field Format: Delimited Data Field Extraction
Format
SELECT(AAAA/BB/CCC/DDFN) I/DDF (FFFFFF)
SELECT(AAAA/BB/CCC/DDFN) I/DDF (FFFFFF) LIT GGGGGGGGGGGGGGGG
Where:
AAAA/BB/CCC are the input field position/length.
DDFN is the delimited data field number.
I/DDF indicates that the input is from a delimited data field.
FFFFFF is the selection operator.
LIT indicates comparison to a literal.
GGGGGGGGGGGGGGGG is the literal. If non-extended, this can be up to 16 bytes long. If extended, this can be a number of up to 16 digits or a text
value of up to 80 characters.

Column Assignment Field Format: Delimited Data Field Extraction
Format
ASGN(AAAA/BB/CCC/DDFN) I/DDF (FFFF/GG/HHH/DDFN) O/DDF
Where:
AAAA/BB/CCC/DDFN are the input field position/length/format. DDFN is the input delimited data field number.
I/DDF indicates that the input is from a delimited data field.
FFFF/GG/HHH/DDFN are the output field position/length/format. DDFN is the output delimited data field number.
O/DDF indicates that the output is assigned to a delimited data field.

Reformat Field Format: Delimited Data Field Extraction
Format
RFMT(AAAA/BB/CCC/DDFN) I/DDF (FFFF/GG/HHH/DDFN) O/DDF
Where:
AAAA/BB/CCC/DDFN are the input field position/length/format. DDFN is the input delimited data field number.
I/DDF indicates that the input is from a delimited data field.
FFFF/GG/HHH/DDFN are the output field position/length/format. DDFN is the output delimited data field number.
O/DDF indicates that the reformatted output is assigned to a delimited data field.
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Non-delimited Extraction Formats
Selection Criteria Field Formats
Source Value is
Compared to

Comparison
Value is

Input Record
or Extraction
Variable

Literal (Nonextended)

SELECT (AAAA/BB/CCC/NNNN) EEEEE (FFFFFF) LIT (GGGGGGGGGGGGGGGG)

Input Record
or Extraction
Variable

Literal
(Extended)

SELECT (AAAA/BB/CCC/NNNN) EEEEE (FFFFFF) LIT *SEE VALUE BELOW*
SELECT LITERAL: (GGGGGGGGGGGGGGGG)

Input Record

Extraction
variable

(Extraction variable is non-extended)
SELECT (AAAA/BB/CCC/NNNN) EEEEE (FFFFFF) EVAR(NNNN)

Format

(Extraction variable is extended)
SELECT (AAAA/BB/CCC/NNNN) EEEEE (FFFFFF) XVAR(NNNN)
Where:
AAAA/BB/CCC/NNNN are the source field position/length/format/extraction variable number. NNNN will be NA when the source is not an extraction
variable.
EEEEE is the source of input, which can be one of the following: INPUT indicates the source is an input record. EVAR and XVAR indicate the source is a
regular or extended extraction variable, respectively.
FFFFFF is the selection operator.
LIT indicates comparison to a literal.
EVAR or XVAR on the right side indicate comparison to a regular or extended extraction variable.
GGGGGGGGGGGGGGGG indicates that the comparison is against a literal. If non-extended, this can be up to 16 bytes long. If extended, *SEE VALUE
BELOW* is printed and the literal, which can be a number of up to 30 digits or a text value of up to 80 characters, is printed on a separate line.
NNNN on the right side indicates that the comparison is against an extraction variable and provides the extraction variable number.

Reformat Record Format
Format
RFMT (AAAA/BB/CCC/DDDD) EEEEE (FFFF/GG/HHH) (JJJJ)
Where:
AAAA/BB/CCC/DDDD are the source field position/field length/field format.
DDDD is the source extraction variable number.
EEEEE is the source of input, which can be one of the following: INPUT indicates the source is an input record. EVAR or XVAR indicate the source is a
regular or extended extraction variable, respectively.
FFFF/GG/HHH are the target field position/field length/field format.
JJJJ is the target where the reformatted value is placed. If the target is an extraction variable, this will be the extraction variable number. If the target is the
input field or a literal, NA will print.
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Column Assignment Field Format
Format
ASGN(AAAA/BB/CCC/DDDD) EEEEE (FFF/GGG/HHHH) LIT JJJJJJJJJJJJJJJJ
Where:
AAAA/BB/CCC/NNNN are the source field position/length/format/extraction variable number. NNNN will be NA when the source is not an extraction
variable.
EEEEE is the input source type.
FFF is a column or extraction variable number.
GGG is the format.
HHHH is the literal EVAL or COL
JJJJJJJJJJJJJJJJ is the literal value to assign. If numeric, it can be up to 16 bytes. If alphanumeric, it can be up to 80 bytes.

Process Control Field Format
Format
BLDTBL (AAAA) STOP/WRITE
Where AAAA is the process control flow, which will be either STOP (“at end” processing) or WRITE (write a control key break).

Table Lookup Rule Processing for Each Record
This section shows the processing of translation attempts. Each attempt
shows the processing of the table lookup rules to a value for which
translation has been specified.
Following is an example of two translation attempts, ET000001 and
ET000002:
ET000001
ET000001
ET000001
ET000001
ET000002
ET000002
ET000002
ET000002
ET000002

LOOKUP SEL001 (101 EQ 101) PASSED
LOOKUP SEL002 (001 EQ 001) PASSED
ASGN COLM(003) VAL(John Smith) TO XVAR 003
ASGN COLM(004) VAL(000000000006955+) TO EVAR 004
LOOKUP SEL001 (102 EQ 101) FAILED
LOOKUP SEL001 (102 EQ 102) PASSED
LOOKUP SEL002 (001 EQ 001) PASSED
ASGN COLM(003) VAL(Rebecca Taft) TO XVAR 003
ASGN COLM(004) VAL(000000000007930+) TO EVAR 004

Selection lookup rules compare values to be translated that are passed from
input-output parameters to the values from external table columns or from
other extraction variables using the specified selection type.
If the value passes the selection lookup rules, the associated assignment
lookup rules are processed. Assignment lookup rules assign a value from a
specified translation table column, extraction variable, or literal to the
input-output parameter. The parameter then passes the translated value to
the reconciliation process.
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In attempt 1 (ET000001), the value to be translated was processed by the
first 2 selection lookup rules and in both cases it passed. As a result, 2
assignments were made:

 John Smith was moved to extended extraction variable (XVAR) 003.
 6955 was moved to extraction variable (EVAR) 004.
In attempt 2 (ET000002), the next value to be translated was processed by
the first selection lookup rule and failed. The value is then processed
against the next record from the external translation table.
The value passed the next 2 selection lookup rules, so the following
assignments were made:

 Rebecca Taft is moved to extended extraction variable (XVAR) 003.
 7930 was moved to extraction variable (EVAR) 004.

Incorporating an Translation Table into a
Balancing Job
This section explains how to incorporate an internal or external translation
table into a balancing job. The connection is specified at the field item or
detail field level. You can connect the extraction process to the translation
process before or after you define the translation table.

Specifying a Translation Table for a Field Value
Procedure:
1. On the Field Values panel for the field to be translated (see “Defining

Field Values” on page 299), complete the Will this field be translated
using a translation table? field with a Y. When you have completed the
panel, press F5. Complete the additional screens that display and press
F5 after each.
2. When the Translation Table panel displays, complete the table

information. For instructions, see “Translation Table Panel” on
page 307.
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Specifying a Translation Table for a Detail Field
Procedure:
1. On the Detail Field Source (Input Record) panel for the field to be

translated (see “Detail Field Source (Input Record) Panel” on
page 336), complete the Will this field be translated using a translation
table? field with a Y. When you have completed the panel, press F5.
Complete the additional screens that display and press F5 after each.
2. When the Translation Table Information panel displays, complete the

table information. For instructions, see “Translation Table
Information Panel” on page 342.

DD Statements for JCL
Note:

No JCL edits are required when you use an internal translation
table.

DD Statement Required in JCL for External Translation Table
Before you can use an external translation table, you are required to add a
DD statement for it to your balancing JCL.
For example,
//EXTTBL1

DD DSN=USERIDA.DET.EXTTBL1, DISP=SHR

Where EXTTBL1 is the DD that was specified in the data organization of
that external table.

Defining and Using Internal Translation Tables
Procedure
This section shows you how to define an internal translation table. For
more information, see “Translation Table Processing” on page 679 and
“Internal Vs. External Translation Tables” on page 680
1. Select Window > Translation tables > Process an internal

table. The Internal Table Window displays.
2. Select Table Name to display the Translation Table Name panel.

Specify a table name. Enter a name for the table.
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Last update by/Date/Time. This displays the ID associated with
the most recent update to this set of definitions, along with the date
and time of the update.
Press F5 to accept.
3. Define the data format of the input value (From Column) and the

data format of the output translated value (To Column).
For example: If you wish to convert an abbreviation of State Name to
its actual name, select Field Format “Text” for both From and To
Columns. If you wish to convert a Date value in DDMMYY format to a
Date value in MMDDCCYY format, select Field Format and Date
Format as Date and DDMMYY for From Column, and select Field and
Date Format as Date and MMDDCCYY for To Column.
If the Field Format is “Date”, specify the appropriate Date Format
If the Field Format is “Time”, specify the Time Format. Select AM/PM
if the value contains AM or PM specification.
The Field Format, Date Format, Time Format specifications for the “To
Column” should match the field type of the destination field. If the
formats do not match, the program displays error and stops further
processing. You need to resolve those mismatches before resubmitting
your job.
4. Select New under Translation Table Entries on the Internal Table

Window to display the Translation Table Items panel.
Item number. This field automatically increments every time you
add translation table items. You can have up to 999 translation table
items.
String to be translated. Enter the value to be translated. This is the
value that will be passed in from extraction processing from a field
value or detail field.
Translate to. Enter what the translated value should be. This is the
field that will be passed back to the field value or detail field. The field
can hold up to 80 characters.
Define additional items for translation as needed.
Save the table.
Incorporate the translation table into the job. See “Incorporating an
Translation Table into a Balancing Job” on page 729.
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To make Internal Translation table processing more efficient, instead of
reloading an Internal Translation table multiple times, the whole table is
loaded into memory when the table is referenced for the first time.

Internal Translation Table Example
Suppose you want to use the division number (01, 02, etc.) as the field value
or detail field (for access modes 6 and 7) but the division name (Dallas, New
York, etc.) shows up on a report. You can translate the division name to the
division number using translation tables.
To address this situation, you set up and name an internal translation table.
It should contain a list of division names as table input, and division
numbers as table output, as follows:.
Table Input

Table Output

Dallas

01

New York

02

Chicago

03

Next, define the field value information in the file extraction definitions
that will extract the division name. Specify, that the field should be passed
through the table, and to list any missing entry.
When the balancing function is executed, the division name is extracted
from the report. The translation table is searched for a corresponding input
entry. If an input entry is found, the table output is moved to the field value;
if not, a warning message may be issued in the SYSOUT and processing
halted or continued (depending on the translation table option chosen).

Setting Up Cycle Tables
A cycle table is a table populated with up to 1000 valid cycle numbers. Cycle
tables are used in balancing or in history analysis to verify whether the cycle
number being processed is valid.

 Balancing example: A company wishing to ensure that a job runs only
on Mondays, could set up a cycle table for use with a balancing job. The
table would contain only Monday dates. They would then specify that
table be used in the job definitions. If a job runs with an invalid cycle
number, processing will stop immediately.
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 History analysis example: Cycle tables are used to verify the data being
retrieved from the history database. If a cycle number does not exist on
the cycle table, the retrieved data will not be used in history analysis.
Cycle tables must be and saved to the definition database before they can be
used.

Creating a Cycle Table
1. To create a cycle table, select Window > Cycle tables. The Cycle

Table Window displays.
Cycle Table Window

Row 1 from 4

_
A. Cycle Table Information:
_
Table name:
_
B. Cycle Table Entries:
_
< NEW... >
***************************** BOTTOM OF DATA ****************************

Command Line ===> _______________________________________________________
F1=Help
F2=Split
F3=Exit
F4=Actions F7=Up
F8=Down
F9=Swap

2. Select Table name to display the Cycle Table Name panel
Cycle Table Name
Specify a table name: ________________
Last update by:

F1=Help

F2=Split

Date:

F3=Exit

F5=Accept

Time:

F9=Swap

Specify a table name. Enter a name for the cycle table.
Last update by/Date/Time. This displays the ID associated with
the most recent update to this set of definitions, along with the date
and time of the update.
3. Then select New to display the Cycle Table Entry panel. Enter the first

cycle number. The cycle number is an 8-digit number that is combined
with and a 3-digit run number to uniquely identify the application
processing cycle that is to be verified. Cycle numbers are usually based
on system dates, but any ascending number may be used. You must
enter cycle numbers in ascending order. Accept your entries.
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4. Repeat the process for each additional cycle number you are adding to

the table. All of the cycle numbers will be listed in the order in which
you added them.
5. Select File > Save. On the Save panel, for the Choose a save option

field, choose option 1, Save to definition library and definition
database. This will enable you to run a balancing job or a set of history
analysis definitions that uses this table.
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Batch Definition Transactions
Definition information can be written to the ACR/Summary database in
one of two ways: by saving in the user interface or 2) by updating batch
definition transactions. This appendix describes the format and use of
batch definition transactions. It contains the following sections:

 What Is a Batch Definition Transaction? on page 735
 Updating the Definition Database on page 738
 Purging Definitions on page 739

What Is a Batch Definition Transaction?
A batch definition transaction is a record stored in the definition database
and used to apply changes to ACR/Summary definitions in batch.
ACR/Summary definitions include job definitions, file definitions, history
analysis definitions, and table definitions. Each type of definition is divided
into definition information categories. A category contains multiple fields
containing related definition information. For example, internal item
information is one category of job definitions. Definition fields for internal
items include information such as the internal item number and the item
description. These are all fields containing information related to that
category of information.
Each batch definition transaction record consists of 80 positions
containing all of the information for a particular ACR/Summary definition
along with a transaction type specifying how the transaction will be applied
to the definition database. Each type of batch transaction record is
identified by a transaction code.
The records are created in a sequential file using the following methods:

 The user interface utility to build batch transactions from the definition
database is described in Build Batch Transactions Utility on page 539.

 The user interface can be used to create batch definition transactions
from the online definitions. This feature is often used to create a
template of the transaction format, which can then be cloned and
modified as needed. See Create Batch Transactions on page 565.
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The manual creation and modification of definitions is not recommended.
Manually coded batch definition transactions are more prone to entry
errors than the user interface panels because they do not have the built-in
error checking and across field checking or validation of the panels.

Format of Batch Definition Transaction Records
Transaction Key
Each 80-character record begins with a 26-position transaction key that
identifies each transaction and specifies how to process it.
Note:

Records with an asterisk (*) in position 1 are treated as
comments and are ignored during processing.

The transaction key consists of the following:

Transaction ID (18 Positions)
The transaction ID specifies the specific transaction as follows:
Job definitions. 18-character Job ID.
File definitions. 10-character file ID, the six-digit record sequence number,
and two blanks.
History analysis definitions. 16-character history analysis ID and 2 blanks.
Table definitions. 16- character table name and two blanks.

Transaction Code (3 Positions)
This is a 2- or 3-character code identifying the category of information on
the transaction record. Codes beginning with:

 J are job definitions;





F are file definitions;
S are history analysis definitions
T are cycle table or internal translation table definitions.
X are external translation table definitions

Following the letter are one or two digits that differentiate the transaction
layout from others within the same category: For example, J0 (Basic Job
Information), J2 (Internal Item Information), and J25 (File Control
Internal Item Information).
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Transaction Number (3 Positions)
This is a number identifying the specific transaction within its category,
such as internal item number or field item number.

Transaction Sequence (1 Position)
This is a number identifying the sequence of the records for a transaction.
Sometimes a transaction requires 2 or more 80-character transaction
records to contain all the definition information. The transaction sequence
number is used to control the sequence of those records.

Transaction Type (1 Position)
A code specifying how the transaction is to be applied to the definition
database. Valid transaction types are:
Code

Meaning

A

Add a new definition record to the database.

D

Delete an existing record from the database. When a
transaction consists of more than one transaction record, only
the first record (Transaction Sequence 1) is needed for delete
processing. This record needs only the transaction key.

R

Replace an existing record in the database.

*

Purge: Delete all definitions of the specified transaction key
from the definition library or the definition database. For more
details, see Purging Definitions on page 739.

Processing Batch Definition Transaction Sets
A set of batch definition transactions is usually headed by a single purge
transaction type, and then followed by a complete set of one or more Add
transactions that contain your job, file, table, or history analysis definition
parameters. For example, a set might contain a basic job information purge
transaction (to delete all previous definitions for that job ID from the
definition database), immediately followed by a basic job information Add
transaction, and then followed by internal item Add, and so on. In other
words, you purge all of the old definitions and add the new ones.
Batch definition transactions are automatically sorted by transaction key by
the batch update utility before they are applied to the definition database.
This means that the purge type is always applied first (i.e., the utility
program will first purge the database of any previous definitions for that
transaction ID, and then process all the other batch definition transactions
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that add to the database). This ensures that no “leftover” definitions will
interfere with your new definitions, and that the set of Add transactions you
process contains the complete set of definitions.
Alternatively, instead of purging a complete set of definitions and then
adding the complete revised set to the database, you can Add, Replace and/
or Delete individual definitions. The resultant executable definitions will be
a combination of whatever definitions were originally in the database, with
the individual Add, Replace and Delete transactions applied against them.
The set of transactions you process is only a subset of the complete set. For
this reason, this method is rarely used, and thus the transaction types R and
D are rarely used.

Updating the Definition Database
Once the batch definitions have been created, you use the update utility in
the SUMUPDT member to apply them to the Definition database. The
update utility processes the batch definition transactions in two passes:
first, the transactions are validated; then, if all the transactions are valid,
they are applied to the Definition database.
The transaction validation edits each individual transaction to ensure that
valid interrelated information is entered in the proper columns. Each
transaction is also printed in the transaction validation section of the
Definitions Update Report (shown in Appendix A). For example, the
Number of Histories to Retain field in Basic Job Information must be
numeric and greater than zero. If it is not, an error message will appear to
the right and on the line below the transaction on the Transaction
Validation Report.
If all transactions are valid, transaction processing is performed. Using the
transaction type from each transaction's key, the update utility attempts to
Add, Delete, Replace, or Purge the specified transaction. If any errors occur
(such as trying to add a definition that already exists in the database),
processing stops and no subsequent transactions are applied. Transactions
encountered before the update error will be applied correctly. Any error
messages will be printed, along with the transactions in the Transaction
Processing section of the Definitions Update Report.
Once applied to the Definition database, any of the Application Interface
modes can be used to test the definitions.
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Purging Definitions
The Purge transaction type (*) mentioned in the preceding sections can be
used to delete all definitions for the specified transaction key from the
definition library or the definition database. This transaction type is valid
only for the definition types shown below:
Transaction
Code

Transaction
Type

J0

*

Basic Job Information Transaction Layout. Job
definitions include the User Report.

F0

*

Basic File Information Transaction Layout

S0

*

History Analysis Information Transaction
Layout

T0

*

Cycle Table or Internal Translation Table
Transaction Layout

X0

*

External Translation Table Information
Transaction Layout

Definition Type

For example, to delete all file definitions for the file DD EMPSALES, you
could submit a batch transaction with the following purge card:
EMPSALES 000000
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Guide to Reports
In this guide, information regarding specific output reports, including
samples, appears in the section where the corresponding utility or other
process is explained. Following is a table to help you find information about
individual reports.
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Reports Table
Report and Page Number

Source

SYSOUT (Product Messages) Report

Multiple Processes

page 383

Control Report

Balancing

page 180

Recap Report

Balancing

page 189

User Report

Balancing

page 180

Free-Form Report

Balancing

page 575

Trace Report

Balancing in Access Mode 6
or 7

page 390

External Translation Table Trace Report

Balancing when using an
external translation table

page 722

History Analysis Report

History Analysis

page 441

Database Initialization Report

Database Initialization

page 39

Database History and Statistics Report

List Definitions Utility - All

page 494

Index of Definition Keys Report

List Definitions Utility - All

page 495

Detailed Job Definitions Report

List Definitions Utility - Job or
All

page 496

Detailed File Definitions Report

List Definitions Utility - File or
All

page 498

Detailed Table Definitions Report (Internal
Translation Table)

List Definitions Utility Internal/Cycle Table or All

page 500

Definition Database Listing: Detailed Table
Definitions (Cycle Table)

List Definitions Utility Internal/Cycle Table or All

page 500

Detailed Table Definitions Report (External
Translation Table)

List Definitions Utility External (translation) Tables
or All

page 501

Detailed Spreadsheet Definitions

List Definitions Utility History Analysis or All

page 502

Build ACRUPDT Report

Build Batch Transactions
Utility

page 539

Definition Database Update Report

Update from Batch
Transactions Utility

page 540
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Report and Page Number

Source

Definition Database Cross Reference Report
for Internal Items

Cross Reference Internal
Items Utility

page 503

Definition Database Cross Reference Report
for File Definitions

Cross Reference File
Definitions Utility

page 516

Database History and Statistics Report

List History Utility - All

page 508

Index of ACR Histories Report

List History Utility - All

page 509

Summary of ACR Histories Report

List History Utility - All

page 509

History Data Detail Report

List History Utility - All or
Detail

page 509

Transaction Listing Report

Multiple Utilities

page 546

History Database Copy Report - Summary of
Histories Transferred

Copy History Utility - Copy
All Records, Copy Selected
Records

page 525

History Database Copy Report - Summary of
Histories Unloaded

Copy History Utility - Unload
Records from a Work File

page 525

History Database Copy Report - Summary of
Histories Reloaded

Copy History Utility - Reload
Records to a Work File

page 526

History Database Reorg Report

Reorganize History Utility

page 526

Print Management Report

Print Management Utility

page 512

Control Update Information Report Utility

Batch Update Utility

page 514

Extracted Values Report (online)

Online extraction

page 361
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C
Non-Biased Variance and Standard
Deviation Computations
The history analysis function includes two computation types that can be
used to calculate a “non-biased” or “moving range” variance or standard
deviation across a range of columns or rows. Variance (Non-Biased) and
Standard Deviation (Non-Biased) computation types are appropriate for
calculations based on a sample rather than on an entire population. These
computation types provide additional options for the field Select a
computation to perform across range.
This appendix contains the following sections:

 “Field Descriptions and Formulas” on page 745
 “Examples” on page 747

Field Descriptions and Formulas
The following field definitions will help you understand the differences
between Variance and Standard Deviation computation types and Variance
(Non-Biased) and Standard Deviation (Non-Biased) computation types.
For additional information, see the section “Examples” on page 747 after
the field descriptions.
Note:

In the formulas shown here:
n represents the number of values included in the computation.
x represents each value used in the computation.
The symbol
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Variance Field
Choose the Variance computation type to calculate the variance if the
columns (or rows) you are using in your computation make up the entire
population of values. For example, use this computation type if your
population consists of 10 cycles and you are using the values of all 10 cycles
to calculate the variance. This computation type uses the following formula:

n x –  x
Variance = -------------------------------------n2
2

2

Variance (Non-Biased) Field
Choose the Variance (Non-biased) computation type to calculate the
variance if the columns (or rows) you are using in your computation are a
sample of the entire population of values. For example, use this
computation type if your population consists of 100 cycles and you are
using a sample made up of 10 of these cycles to calculate the variance. This
computation type uses the following formula:

n x –  x
Variance  Non – Biased  = --------------------------------------n n – 1
2

2

Standard Deviation Field
Choose the Standard Deviation field to calculate the standard deviation
if the columns (or rows) you are using in your computation make up the
entire population of values. For example, use this field if your entire
population consists of 10 cycles and you are using the values of all 10 cycles
to calculate the standard deviation. This computation type uses the
following formula:

S tan dard Deviation
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Standard Deviation (Non-Biased) Field
Choose the Standard Deviation (Non-biased) computation type to
calculate the standard deviation if the columns (or rows) you are using in
your computation are a sample of the entire population of values. For
example, use this computation type if your population includes 100 cycles
and you are using a sample consisting of 10 of these cycles to calculate the
variance. This computation type uses the following formula:

n x2 –   x 
--------------------------------------nn – 1

2

S tan dard Deviation  Non – Biased 

=

Examples
Assume you are interested in using the History Analysis feature to create a
report for 10 cycles having the following values:
1345

1370

1301

1318

1368

1350

1322

1303

1310

1299

We will use these values to show how you can appropriately use the
computation types described previously.
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Using the Variance Computation Type to Compute the Variance of
A Population
If the 10 cycles you are using in your computation make up the entire
population, calculate the variance using the Variance computation type,
which uses the following formula:

n x –  x
Variance = -------------------------------------n2

2

2

The variance will be 678.84, as demonstrated in the following table:

x

x2

1345

1809025

1301

1692601

1368

1871424

1322

1747684

1310

1716100

1370

1876900

1318

1737124

1350

1822500

1303

1697809

1299

1687401

x

2

17658568

748

n x

2

176585680

 x

2

176517796

n x –  x
2

67884

2

n x –   x
--------------------------------------n2
2

2

678.84
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Using the Variance (Non-Biased) Computation Type to Compute
the Variance of a Sample
If the 10 cycles you are using in your computation are a sample of the entire
population, calculate the variance using the Variance (Non-Biased)
computation type, which uses the following formula:

n x –  x
Variance  Non – Biased  = --------------------------------------nn – 1

2

2

The variance will be 754.27, as demonstrated in the following table:

x

x2

1345

1809025

1301

1692601

1368

1871424

1322

1747684

1310

1716100

1370

1876900

1318

1737124

1350

1822500

1303

1697809

1299

1687401

x

2

17658568

n x

2

176585680
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 x

2

176517796

n x –  x
2

67884

2

n x –   x
--------------------------------------nn – 1
2

2

754.27
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Using the Standard Deviation Computation Type to Compute the
Standard Deviation of a Population
If the 10 cycles you are using in your computation make up the entire
population, calculate the standard deviation using the Standard
Deviation computation type, which uses the following formula:

S tan dard Deviation

=

n x2 –   x 2
--------------------------------------n2

The standard deviation will be 26.054, as demonstrated in the following
table:

x

x2

1345

1809025

1301

1692601

1368

1871424

1322

1747684

1310

1716100

1370

1876900

1318

1737124

1350

1822500

1303

1697809

1299

1687401

x

2

17658568

750

n x

2

176585680

 x

2

176517796

n x –  x
2

67884

2

n x2 –   x 
--------------------------------------n2
2

26.054
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Using the Standard Deviation (Non-Biased) Computation Type to
Compute the Standard Deviation of a Sample
If the 10 cycles you are using in your computation are a sample of the entire
population, calculate the standard deviation using the Standard
Deviation (Non-Biased) computation type, which uses the following
formula:

n x2 –   x 
--------------------------------------n n – 1

2

S tan dard Deviation  Non – Biased 

=

The standard deviation will be 27.463, as demonstrated in the following
table:

2

x

x

1345

1809025

1301

1692601

1368

1871424

1322

1747684

1310

1716100

1370

1876900

1318

1737124

1350

1822500

1303

1697809

1299

1687401

 x2

17658568

n x

2

176585680

ACR/Summary User Guide for z/OS

 x

2

176517796

n x –   x
2

67884

2

n x –  x
--------------------------------------n n – 1
2

2

27.463
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Glossary
A

alternate balancing rules

access mode

This feature allows you to define additional sets of
balancing rules for a single job.

This file organization method determines how the
input source file is read and processed.

alternate balancing rule set

 Access Mode 1 selects the first X records
from the input source and places them in the
file access area, a temporary storage area.
 Access Mode 2 selects the last X records from
the input source and places them in the file
access area, a temporary storage area.
 Access Mode 3 selects records based on file
keys and places them in the file access area, a
temporary storage area.
 Access Mode 4 selects the nth record and the
records after it and places them in the file
access area, a temporary storage area.
 Access Mode 5 processes all records in an
input source using selection groups and derives
either a total of a particular amount, a tally of
the records, or the hash value of the file.
 Access Mode 6 processes all records in the
input source using selection groups. All criteria
must be met on the same record.
 Access Mode 7 processes all records in the
input source using selection groups. All
selection criteria must be met, but not on the
same record.

ACR/Connector
The ACR/Connector product extends the
capabilities of ACR/Summary and ACR/Detail
across multiple platforms, processors, and
geographic locations. Its cross-platform features
include history item retrieval and synchronization
of jobs and other processes.

ACR/Summary and ACR/Detail server
This server is the interface between the
Workbench/client and the batch portion of the
application, which resides on the platform. The
main function of this server is to execute the job
and return the results to the Workbench/client.
The server can run as a service or a daemon.

active rule
See standard rule and conditional rule.
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A numeric identifier indicates that an alternate
balancing rule is part of a rule set. Alternate
balancing rule sets are useful when the same job is
run by different departments or for different
processing periods.

alternate job ID
An alternate job ID is a job/step without any
associated rules that is used to execute a different
job ID. An alternate job ID is used primarily for
testing and applies only to jobs run on z/OS or in
batch.

analysis rule
See history analysis rule.

application interface mode
This is the bridge between your application and
the ACR/Summary application.The application
interface mode offers different processing modes
to extract data from your application into
ACR/Summary.

assignment rule
This type of lookup rule specifies the values to
assign when the selection rule is satisfied. For
example, if an untranslated value equals a value in
the translation table, translate that value to the
value of another column from the table.

automatic cycle processing
This method of cycle processing allows the system
to generate the cycle number or the entire cycle ID
automatically, usually based on the system date.

B
balancing
Balancing uses file definitions to extract control
values from application files and reports, applies
rules that calculate, compare, and verify the
extracted control values, and produces the
requested balancing reports.
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balancing extract file

comma delimited text file

This output file contains formatted data and
balancing results from a job run. The results in
the extract file can be passed to other platforms or
downloaded for use in a PC application.

This is a text file that contains sequential fields
separated by commas and text values surrounded
by quotation marks. The file can be read by most
PC applications, such as spreadsheets.

balancing rule

completion code

Balancing rules consist of standard and
conditional rules. These rules determine if your
reports, files, and other information sources are in
or out of balance.

A completion code is a system code that indicates
whether the job completed or why the job did not
complete. See also return code.

base model

A conditional rule uses IF/THEN logic to
determine if a condition is true or false based on
the combined status of up to 10 other rules. An
active conditional rule is evaluated, and if the
condition is met, takes one of the following
actions: activates a calculation, sets a return code,
or activates other rules. An inactive conditional
rule takes no action.

In modeling, the base model is the balancing job,
template, or input source that contains the
definitions to be modeled.

batch definition transaction record
This is an 80-character record, stored in the
transaction library, and used to apply changes to
definitions in batch. Each record contains
information for a particular definition and a
transaction type code that specifies how to apply
the transaction to the definition database.

begin reference record
This file definition type, for access modes 1
through 4, marks the beginning of a subset of
records, called a reference area, within the file
access area to be scanned for the data to extract.

build rules
See table build rules.

C
calculated item
A calculated item specifies mathematical
manipulation of values that can include internal
items, extended internal items, history items,
other calculated items, or literals. Calculated
items can be used in rules or on Free-form
Reports and User Reports.

column assignment
This table build rule extracts column values from
the source data and loads them into the
translation table.
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conditional rule

Control Report
This report is the primary output of a job run. It
shows both the components and the results of the
run. By default, the system automatically
generates this report.

control value
A control value is a count, amount, text item, or
date obtained during an extraction, or a value for
an internal item, calculated item, history item, or
rule input by a user for the job.

cycle generation
Cycle generation determines how the cycle ID is
assigned, either manually or automatically.

cycle ID
A cycle ID, which consists of an 8-digit cycle
number and a 3-digit run number, uniquely
identifies each run of a job. If numbers are not set
up to increment for each cycle, the system assigns
the default, 000, as the run number. Cycle IDs
must be numeric and greater than zero, and they
are typically processed in ascending order.

cycle number
The cycle number, which is part of the cycle ID, is
an 8-digit ascending number that identifies the
processing cycle for a job. Usually, cycle numbers
are in ccyymmdd format.
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cycle override

definition

Cycle override is an option that passes cycle IDs to
the balancing function, when implemented
through the options file. This option is typically
used during a rerun to override a cycle ID that was
set by another method. When in effect, if a cycle
override for the current job ID is found in the
options file, the associated cycle ID is set as the
current cycle ID.

A definition is a set of parameters that determines
how a process is performed. Definition types
include job, file, table, and history analysis.

cycle processing
This process generates or verifies cycle IDs. Three
types of cycle processing are available: cycle
reference processing, automatic cycle processing,
and cycle tables.

cycle reference processing
In this method of cycle ID generation, the job gets
its cycle number from a previously executed
reference job. This type of processing is useful
when a job stream spans multiple system dates
and you want to keep the same cycle number
during the job stream.

cycle table
A cycle table is used to verify cycle numbers. In
history analysis, a cycle table can verify the cycle
number of the record that has been retrieved for
analysis. In balancing, a cycle table can verify the
cycle number before assigning it to a job run.

D
database
See definition database or history database.

database initialization
Database initialization is the process that creates
or deletes and re-creates the definition or history
database.

database utilities
Database utilities are programs that are used to
view, list, or maintain the definition and history
databases.

DDNAME
The data definition name (DDNAME) identifies a
file in the JCL. The DDNAME is equal to the file
name in the file ID.
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definition database
This database is a keyed file that stores the job,
file, table, and history analysis definitions.

definition library
This temporary workspace, also called the online
work area, stores a working copy of your saved
definitions.

detail field
This file definition type, for access modes 6 and 7,
specifies the value to extract, whether to total or
tally the extracted value, and whether to store the
result in an internal item, extended internal item,
or extraction variable.

direct input mode
This application interface mode lets you specify
the control values to execute a run. This mode is
used to process data that is not available on your
system, to test new balancing jobs, and to prime
the history database.

DSN
The dataset name (DSN or DSName) represents
the catalogued name of a particular computer file.

dynamic allocation
Dynamic allocation causes all steps at your site to
run with the same definition and history
databases unless these dataset names are
overridden in the JCL. Dynamic allocation
minimizes the number of DD statements needed
in your production JCL to run the product.

E
embedded key
This file definition type, for access modes 1
through 4, locates a record by searching for a text
string within the selected file access area.

end reference record
This file definition type, for access modes 1
through 4, marks the end of a subset of records,
called a reference area, within the file access area
to be scanned for the data to extract.
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error message

extraction variable

If the user interface cannot perform a requested
function, the system displays a message that tells
you what the problem is, and often, what to do
about it. System messages typically begin with #U
and are documented in the Messages and Codes
guide.

An extraction variable is a storage place where
regular or extended data from file definitions or
external translation table definitions is held for
further processing.

exception code

field format

This code prints next to items on the History
Analysis Report that are outside of the tolerance
for the analysis rule.

Field format refers to the six choices to display
selection, extraction, or output field information.
Field formats include number, text, packed,
signed numeric, binary, and unsigned packed.

exception reporting
See history analysis.

extended data
Extended data is the data from extended internal
items. Like data from regular internal items,
extended data can be used in calculated items,
history items, rules, reports, and output files.

extended internal item
An extended internal item is a storage place for a
control value (count, amount, text item, or date)
extracted or accumulated when a job is run, or a
control value that results from the manipulation
of item values in a calculated item. An extended
internal item allows extraction and storage of a
number with up to 30 digits or a text value with
up to 80 characters. See also internal item.

external translation table
An external translation table is used to translate
and match values across input sources. For
example, you might want to translate a state name
into a 2-character state abbreviation. An external
translation table is built at run time, usually by
referencing an external data source.

F

field item
This file definition type, for access modes 1
through 4, or for relational database tables,
defines the position and length of the data to
extract from the specified record. The extracted
data can be stored in an internal item, extended
internal item, or extraction variable.

file access area
File access area is a work area for records selected
from the input source. Access modes 1 through 4
use the file access area to avoid processing all the
records in the input file.

file control balancing
This feature enables you to detect incorrect input
files before processing, and if a mismatch is
found, determine whether to abend the job or
continue processing and generate error messages.

file control item
This type of internal item can verify that an
application job stream is using the correct files.
Each file control item stores the dataset name and
the first volume serial number of one file.

extract file

file definition

An extract file lets you easily pass information
between platforms or products. You can use the
Extract History Utility to create a history extract
file to easily move history data. You can create a
formatted extract file that contains information
extracted during balancing and use the
information to generate correction transactions.

A file definition specifies how to locate and extract
values from records in the selected input files.

extract definition

file ID
A file ID is a unique identifier for the input source.
It consists of an 8-character file name and an
optional 2-character file name qualifier that is
usually used for repetitive processing of the same
file during a job.

See file definition.
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file interface mode

history analysis

This is the typical mode to extract control values
directly from your business application. No source
code changes are required.

A history analysis job produces exception reports
for data that lies outside a specified range. A
history analysis job is useful for identifying trends
in your balancing processes.

file item
A file item is job definition information that
associates a job ID with a file ID. File items are
automatically generated when you create an input
source.

history analysis definition

file key

history analysis ID

This file definition type, for access mode 3,
specifies a character string (the key value) and the
position of the first character of the key value. The
system searches the input file, and if it finds the
character string, selects individual records or a
block of records and places them in the file access
area.

This is a unique name, up to 16-characters long,
for the set of history analysis process definitions.

file name
This is the 8-character prefix of the file ID. See
also DDNAME and file ID.

file name qualifier
This is an optional 2-character suffix to the file
name. See also file ID.

file organization
File organization refers to the type of input file
processed for the job.

flow rule
This type of lookup rule specifies the system
response after a value is translated. By default,
processing stops.

FNQ
See file name qualifier.

A history analysis definition specifies how to set
up the processes and reports to analyze and report
on data from the history database.

History Analysis Report
This report shows the results of a history analysis
job.

history analysis rule
A history analysis rule compares values in the
analysis window with values in the analysis base.

History Data Detail Report
This report shows history records and their values
for a range of jobs. steps, and qualifiers.

history database
This database is a relative-record file that stores
the results of previous runs for use in another run
of the same job or in another job. Each history
record contains a job ID, cycle ID, and the control
values extracted for each internal or extended
internal item.

history insert
History insert refers to the insertion of history
records regardless of the cycle ID.

history item

H

A history item specifies retrieval of a value
extracted in a previous run of the same job or of a
different job from the history database so that the
value can be used in the current job. Each history
item you define can be used in calculated items or
rules in the current job.

hash record

I

Free-Form Report
A Free-Form Report is a fully customizable report
that can include any of the control values obtained
from a job run.

This file definition type, for access mode 5,
computes the hash value of a sequential file and
stores the result in an internal item or extraction
variable. Hashing can be used to determine
whether two files are identical.
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inactive rule
See standard rule and conditional rule.
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input area

job-step qualifier (JSQ)

When you define selection criteria, this option
indicates that you will extract data from a position
within the current record.

The job-step qualifier is an optional 2-character
identifier that is the last part of the job ID. Jobstep qualifiers distinguish multiple invocations of
a balancing run with the same job and step name.

input source
An input source is typically a file or report from
your application that contains the data to extract
for use in a job.

internal item

JSQ
See job-step qualifier.

L

An internal item is a storage place for a control
value (count, amount, text item, or date) extracted
or accumulated when a job is run, or a control
value that results from the manipulation of item
values in a calculated item. An internal item
allows extraction and storage of a number with up
to 15 digits or a text value with up to 8 characters.
See also extended internal item,

lookup rules

internal translation table

A message is user-defined information associated
with a return code set by a balancing rule. A
message usually identifies why a step is not in
balance and outlines the correction procedures.
Messages print on the Control Report, and
optionally, on the User Report, Free-Form
Report, and z/OS console. Messages can be direct
or indirect.

An internal translation table is used to translate
values from an input source. the internal table
consists of two columns, input and output. You
define up to 999 input/output entries. This type of
table is suitable for performing simple, static,
one-to-one, text-to-text translations within a job.

J

Lookup rules tell the system what to do when it
encounters a value to translate. There are three
types of lookup rules: selection, assignment, and
flow.

M
message

model definition

job definition

See modeling.

A job definition defines the rules and processing
options required to execute a job run.

model user

job ID
A job ID is a compound data element that
identifies a job and its definitions. It consists of an
8-character job name, an 8-character step name,
and an optional 2-character qualifier.

job name
A job name is an 8-character name that, together
with the step name, identifies the job. This is the
first portion of the job ID. See also job ID.

job step
A job step represents one step in a multi-step job.
A job step can execute an application, utility, or
ACR program, which in turn invokes a job run.
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In modeling, this is the file or job that uses the
definitions from the base model.

modeling
This feature allows file definitions and job
definitions stored in the definition database to be
referenced by one or more balancing jobs.
Modeling reduces the need to recode definitions
and ensures consistency between balancing jobs
that have the same requirements.

O
options file
The options file (UNIOF) is a file that you create
manually to use the cycle override and history
insert features, which are related to cycle
processing.

Infogix, Inc.

Glossary

out-of-balance condition

reference area

An out-of-balance condition exists when not all of
the stipulations in your rules have been met.

This is a logical area that is between the beginning
and end reference points. The reference area can
include all or a subset of records in the file access
area.

out-of-balance message
See message.

P
page/line record
This file definition type, for access modes 1
through 4, selects records in fixed-block
addressing (FBA) format based on a report page
number and line number.

process control
This table build rule specifies the action to take
after a selection group has been satisfied.

processing error
See error message.

program interface mode
This application interface mode requires a
COBOL compiler or the IBM High Level
Assembler. It uses simple source code additions to
your application to extract the control values and
call the appropriate program interface program.
This mode is best used for new applications or
applications in a state of development or
modification.

Q
qualifier
In the job ID, qualifier is the optional 2-character
field that identifies multiple invocations of a job
with the same job/step name. In the file ID,
qualifier is the optional 2-character identifier that
indicates that the input file is processed more
than one time for a balancing run. See also jobstep qualifier.

R
Recap Report
This user-defined report summarizes the results
of multiple jobs.

reference record
See begin reference record and end reference
record.

reformat field
See reformat record.

reformat record
Reformat record is both a file definition type and
a table build rule. As a file definition type for
access modes 6 and 7, it specifies how to
rearrange or combine detail values from the input
records, a literal, or an extraction variable and
outputs the reformatted values to the output area
or to an extraction variable. As a table build rule,
it uses the same procedure to reformat a column
value before using the value in a column
assignment.

relative cycle
A relative cycle points to a history record of a
previously run job relative to the current run.
Relative cycles are numbered -998 to +000. A
relative cycle of +000 refers to the current cycle, 001 refers to the prior cycle, and so forth.

relative record
Relative record is both a file definition type and a
table build rule. As a file definition type, available
in all access modes except 5, it locates a record by
specifying a number of records to move in relation
to the last record selected. The move can be
backward (toward the beginning of the file) or
forward (toward the end of the file). As a table
build rule, used in conjunction with selection
criteria, it uses the same procedure to identify the
relative position from a selected record.

Reorganize History Utility
This utility physically deletes all logically deleted
records from the history database.

reset reference record
This file definition type, for access modes 1
through 4, resets the beginning or ending point of
the reference area to the entire file access area.
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return code

selection group

A return code is a user-defined four-digit code
that indicates the result of a job run. Return codes
and their associated messages appear on the
Control Report, and optionally, on the User
Report, Free-form Report, and z/OS console.

A selection group consists of one or more
consecutive selection fields that, when evaluated
together, determine whether to extract data to
process from the current record.

rule

This type of lookup rule compares the
untranslated values from input/output
parameters to the values in a translation table.
When the selection rule is satisfied, the data from
the selected table row becomes available for
assignment and flow rules.

A rule is a set of criteria to apply to the values of
internal items, extended internal items, calculated
items, or history items to determine if values
extracted from an input source are in or out of
balance. A single job may need to have multiple
rules to determine if a variety of values are in
balance. If one or more rules are out of balance,
the entire job is considered out of balance. See
also standard rule and conditional rule.

rule action
A rule action is the step that the system will take if
a rule is out of balance.

selection rule

sequence number
The sequence number is an automaticallyassigned unique identifier for the selection group
and file definition combination. In modeling, you
can change this number to correspond with the
model job.

spool monitor mode

See conditional rule and standard rule.

This application interface mode processes
message class output from the JES spool. It
automatically invokes the file interface program
at the completion of each application job. See also
file interface mode.

run

standard rule

rule set
See alternate balancing rule set.

rule type

A run is a single execution of a job or process.

run number
The run number, which is part of the cycle ID, is a
3-digit ascending number that enables unique
identification of multiple runs of a job with the
same cycle number.

S
selection criteria
See selection group.

selection field
Selection field is both a file definition type and a
table build rule. As a file definition type for access
modes 6 and 7, it locates records in the input area
that contain a specified value. The specified value
can be a text literal, numeric literal, or extraction
variable. As a table build rule, it uses the same
procedure to define criteria for selecting records
from the source data.
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A standard rule compares values from any
combination of internal, extended internal,
calculated, and history items to determine if they
are in or out of balance. It uses a rule equation in
the left-side/operator/right-side format. An active
standard rule sets a return code, performs a
calculation, or abends the job. An inactive
standard rule is evaluated only within a
conditional rule.

step name
A step name is an 8-character name that, together
with the job name, identifies the job. This portion
of the name enables you to assign a distinct name
to each step of a multiple step job. See also job ID.

T
table build rules
Table build rules are selection criteria that tell the
system how to extract parts of the source data to
build a translation table.
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table definition

transaction record

A table definition identifies the table name and
the type of information on the transaction record.
The definition includes the specifications needed
to access the data stored in a table. Table
definitions types include external translation
tables, internal translation tables, and cycle
tables.

See batch definition transaction record.

table ID
See table name.

table name
A table name is a unique 16-character ID that
identifies the translation or cycle table.

tally items
See tally record.

tally record
This file definition type, for access mode 5, counts
all records or counts records that meet specific
criteria and associates the resulting count with an
internal or extended internal item.

total item
See total record.

total record
This file definition type, for access mode 5, sums
the values in a specified field and places the sum
in an internal or extended internal item.

Trace Report
This report has two uses. For an input source, in
access mode 6 or 7, or for an external translation
table, the report shows each record in an input file
along with each extraction definition processed
against that record. For an external translation
table, the report also shows the lookup processing
of the table definitions.

TRANLIB
See transaction library.

transaction code
This code identifies the transaction type of a batch
transaction record.

transaction library
This PDS/user file, TRANLIB, is used within the
user interface to maintain batch definition
transactions.
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translation table
See external translation table and internal
translation table.

U
UNIOF
See options file.

Update History Utility
This utility can change one or more control values
in the history database. Use this utility to correct
an out-of-balance condition.

user exit
A user exit program is COBOL source code,
delivered with the product, that you can modify to
perform special processing.

user options
User options are local configuration settings such
as currency, negative signs, date and time, and
report formats.

user program
A user program is an external COBOL program
that enables access to an input source type that
ACR/Summary cannot access directly.

User Report
This user-defined report can contain any or all of
the data from a Control Report, in a specified
sequence.

utilities
See database utilities.

V
validation error
The system displays this error if it receives input
that it cannot recognize.

variable cycle processing
Variable cycle processing enables you to control
the retrieval of a history item based on the run
date and time or the cycle ID of another job or
both. Variable cycle processing accommodates
situations where the run date and time of other
jobs provide the basis for specifying history items
in the current job.
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Index
Numerics
22-character numeric formatting option 138

A
access mode
access mode 1 251
access mode 2 252
access mode 3 253
access mode 4 256
access mode 5 256, 287
access mode 5 file definitions 287
access mode 6 260
access mode 6 and 7 differences 263
access mode 6 example 261
access mode 7 263, 265
access mode 7 processing 264
file definitions 270, 296
selecting 250
Access User Exit panel 156
ACR/Connector
Domain Table 41
ACR/Summary
major features 14
ACRJLIB 509
ACRSPMF 508
advance record in access modes 6-7 307
allocate user files 34
alternate balancing rule 227
Alternate Job ID 159
analyzing your balancing needs 48
application interface mode 14, 48
Archive history 599
audit trail options
see rerun/audit trail options
automatic rerun 131, 160, 391

B
Backup Definition Library 620
balancing 15, 379
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balancing job
see job
batch
running balancing in 383
batch definition transaction
overview 751
processing 753
purging 755
record format 752
transaction code 752
transaction ID 752
transaction key 752
transaction list 756
transaction number 753
transaction sequence 753
transaction type 753
batch utilities
accessing 563
archive/restore history 599
Build ACRUPDT Report 611
build batch transactions 610
Control Update Information Report 585
Copy History Database 591
Create Comma Delimited Text File 614
Cross-Reference File Definitions 576
Cross-Reference Internal Items 574
Delete History 587
extract history 604
free history database 616
List Definitions 565
List Histories 578
lock history database 616
Print Management Report 583
Reorganize History 597
Reprint Control Report
utility 581
running 564
Update from Batch Transactions 611
Update History Database 590
Build ACRUPDT Report 611
Build batch transactions 610
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C
calculated items 207
conditional 207
century values
calculation 329
verifying 330
comments, file 168
comments, job 168
conditional calculated items 207
Control report 171, 179
Control Update Information Report
utility 585
Copy History Database 591
Create Batch Transactions 637
Create Comma Delimited Text File 614
Cross-Reference File Definitions utility 576
Cross-Reference Internal Items utility 574
currency formats
user options 121
customer support 16
cycle accumulation 204
cycle ID 147, 697
setting 699
cycle numbers
as is format 328
display and printing 330
extraction 327
format options 328
partial date format 328
storage of 330
cycle processing 697
options 701
order of precedence 699
cycle tables 465

D
database
definition 32
history 32
Database Definition Listing Report 566
database initialization 390
Database Initialization Report 41
databases
overview 26
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datasets
overview 26
dates
conversion 644
display and printing 330
extraction 327
format options 328
formats in user options 120
storage of 330
DB2 input source
DB2 extraction method 555
DB2 Freeform Editor 544
DD statements for ACR/Summary JCL 395
defaults for ACR/Summary
user options 48
definition
type 148
definition database 32
updating in batch 754
Definition Database Cross Reference Report
file definitions 576
internal items 574
Definition Database Update Report 612
definition library 27
automatically compress 137
definition type
detail field 312
embedded key 277
field value 279
file key 271, 343
page/line record 276
reference record 272, 344
reformat field 308
relative (advance) record in access modes
6-7 307
relative record in access modes 1-4 275
selection field 296
tally record 288
total record 289
definitions referenced by deleted items
deleting 237
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definitions, file
adding 325
changing 325
copying 326
deleting 326
editing 324
inserting 326
repeating 326
Delete History
utility 587
delimited data, direct extraction of 245, 330
detail field 312, 365
source input record 314
direct input mode 477
creating transaction records manually 481
setting up 478
transaction record layouts 482
direct messages 231
direct spool file organization
input source 247
documentation 13
dual history 134
dynamic allocation
partitioned data sets 119
physical sequential files 119
sysout 120
user option 118
VSAM files 119

E
editing definitions
Expert File Editor 333
embedded key
definition type 277
embedded key record 345
embedded key substitution 194
equal cycle comparison 205
execution parameters
see parameters
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Expert File Editor 333
DB2 record 351
detail field 365
editing definitions 333
embedded key record 345
field item 352, 369
file key 343
freeform DB2 from statement 372
freeform DB2 select statement 368
freeform DB2 where statement 373
page/line record 347
reference record 344
reformat field 362
relative record 347
selection field 356
setting up an input source file 335
total/tally record 348
extended internal items 186, 190
external translation table
basic table information 416
build options 422
build preparation rules 427
characteristics of 412
columns, definition of 426
example 413
flow rules 453
input-output parameters 424
processing 411
selection record 431
table build rules 429
VSAM ONEROW processing 423
External Translation Table Trace Report 454
Extract file
options 161
record layout 163
Extract history 604
Extract Window
opening 266
view definitions 324
Extracted Values panel 377
Extracted Values Report (online) 377
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extraction
full 375
step 375
step x records 375
Extraction Trace Report 472
extraction variable 192, 196, 197
extended formatting 192
pre-Release 4.1 generation 193
uses in external translation tables 425

F
field formats for file definitions 268
field item 352
Expert File Editor 369
field value
definition type 279
file comments 168
file control balancing 685
rules 690
file definitions 241
see also Expert File Editor
see also modeling
access mode 5 287
access modes 1-4 270
access modes 6-7 296
methods of entering 267
viewing 324
file interface JCL panels 388
file interface mode 467
JCL 469
UNIEXEO 143
file key
definition 253
definition type 271, 343
File organization
user program 248
file organization 244
direct spool 247
VSAM 246
Free History Database 616
freeform DB2 from statement
Expert File Editor 372
freeform DB2 select statement
Expert File Editor 368
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freeform DB2 where statement
Expert File Editor 373
Free-Form Report
accessing 648
As-is option 661
deleting 662
editing the codes 661
editing the width 662
justification options 661
overview 647
planning 648
print options 665
viewing 666
Free-Form report
creating 183
function keys
navigate 25

G
global processing options 127

H
hash record 256, 287
hash records 348
history analysis 513
function 15
reports 537
standard deviation (non-biased 881
variance (non-biased 881
History Analysis JCL panel 393
History Browse 639
History Data Detail Report 580
history database 32
History Database Listing Report 579
History Database Reorg Report 599
History Database Report 596
history insert 136
history items 198
cycle accumulation 204
equal cycle comparison 205
variable cycle 201

I
indirect messages 234
initial setup 32
initialization, databases 37
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input source 49
DB2 table 541
defining 241
deleting 324
Interface
user 14
internal items 186
internal translation table 412
characteristics of 412
processing 411
internal translation tables
defining 463
item numbers 720

J
JCL
creating 383
DD statements for 395
edit 387
file interface 469
spool monitor 509
submit 387
job
copying 46
deleting 48
flow 149
opening an existing job 42
opening, saving, copying 42
saving 43
job card 36
job comments 168
job definitions 185
see also modeling
calculated items 207
deleting 237
extended internal items 186
history items 198
internal items 186
messages 230
navigating 237
rules 213
Job ID
alternate 159
job ID 147
job/step/qualifier 151
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JSQ
see job/step/qualifier

L
library information 37
List Definitions
utility 565
List Histories
utility 578
Lock History Database 616

M
manual method of entering file definitions
267
mark-and-capture method 267
message
global 124
messages 230
direct 231
example 235
indirect 234
inserting item description 232
inserting item value 232
processing 230
modeling 711
file definitions 716
job definitions 713
terminology 712

N
navigate
function keys 25
navigation
job definitions 237
negative signs
user options 122

O
ONEROW processing, VSAM 423
On-line help
context sensitive 23
How Do I?... 24
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on-line options
accessing 619
Backup Definition Library 620
Create Batch Transactions 637
History Browse 639
Perform Date Conversion 644
Restore Definition Library 622
on-line utilities
see on-line options
options file 705
cycle override 706
history insert 706
record layout 707
order of precedence 226

P
page/line record 347
definition type 276
Panels
defining 22
entry 22
selection 23
panels
part of 21
parameters
file interface mode 470
JCL for file interface mode 470
UAC2000 470
Perform date conversion 644
Perform File Control panel 156
physical sequential 244
physical sequential file
input source 244
print commas field 239
print commas in amount fields option 137
print commas in count fields option 137
print format field 238
Print Management Report 585
utility 583
printing
Free-form Report 665
procedure library 29
Product Messages Report 397
program interface mode 485
UNIEXEO 144
program interface mode, see also UAC200PI
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method, UAC1000 method
see also
prompt before exit option 137
purging definitions 755

Q
qualifier
see job/step/qualifier

R
Recap Report 180
reference record
definition type 272, 344
reformat field 308, 362
relative record in access modes 1-4 275
relative record in access modes 6-7 307
Reorganize History 597
report file defaults 35
reports 617, 877
22-character numeric format 170
Build ACRUPDT Report 611
Control Report 171, 179
Control Update Information 585
Cross Reference Report for file definitions
576
Cross Reference Report for internal items
574
Database Definition Listing 566
Database Initialization 41
Definition Database Update Report 612
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External Translation Table Trace Report
454
Extracted Values Report (online) 377
Extraction Trace Report 472
history analysis 537
History Data Detail Report 580
History Database Listing 579
History Database Reorg Report 599
History Database Report 596
options 170
Print Management 585
Product Messages (SYSOUT) Report 397
Recap Report 180
table of all reports 877
Trace Report 472
User Report 667
viewing 380
Reprint Control Report
utility 581
rerun audit trail 135
rerun/audit trail 160
Rerun/audit trail options 160
Restore Definition Library 622
Restore history 599
round results 157
rule
alternate balancing 227
conditional 219
active 220
evaluation of 221
inactive 220
processing when item is not found 226
reporting status 226
standard 213
active 214
inactive 214
rules 213
tolerance 218
run number
reasons for using non-default 698
run-time parameters
see parameters

S
selection field 257, 296, 356
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selection group 259, 260
using item numbers 720
using sequence numbers 719
sequence numbers 719
Set Return Code Panel 155
setup 32
allocate user files 34
database initialization 37
library information 37
report file defaults 35
user file defaults 33
skip processing
rules 218
spool monitor file 31
Spool Monitor JCL panel 394
spool monitor mode 505
ACRJLIB 509
ACRSPMC 506
ACRSPMF control record 508
SUM2000 509
store all reruns 135
Store History panel 154
SYSOUT 397

T
tally record 256, 287, 288
time
formats in user options 120
tolerance/skip processing
rules 218
total record 256, 287, 289
total/tally records 348
Trace Report 472
Transaction Listing Report 617
transactions library 28
translation table
using in a job 461
truncate/round results 157
tutorial 53

U
UAC1000 method
program interface 485, 486
program interface, Assembler 500
program interface, COBOL 491
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UAC2000PI method
program interface 485
UNICNTL User Exit 735
UNICNUM User Exit 743
UNICNUM1 User Exit 743
UNIDSN 138, 140
UNIEXEO 138, 143
file interface mode 143
program interface mode 144
UNIEXIT 156
UNIEXIT User Exit 746
UNIJNAM User Exit 741
UNIOUT 139, 140
UNIPDS 139, 140
UNIUOPT User Exit 739
UNIXOPT 138, 144
Update from Batch Transactions 611
Update History Database
utility 590
User Exit 156
user exit program 733
User Exit Programs
editing 749
user exit programs
UNICNTL 735
UNICNUM 743
UNICNUM1 743
UNIEXIT 746
UNIJNAM 741
UNIUOPT 739
user file defaults 33
User interface 14
user interface 19
User options
XML options 128
user options 48, 113
22-character numeric formatting 138
automatic rerun 131
compress definition library 137
currency formats 121
date/time formats 120
dual history 134
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dynamic allocation
partitioned data sets 119
sysout 120
user option 118
VSAM files 119
global processing options 127
history insert 136
negative sign override 122
print commas in amount fields 137
print commas in count fields 137
prompt before exit 137
rerun audit trail 135
store all reruns 135
write to operator messages 123
user options file 30
editing 138
User program files as input sources 248
User programs
UUPDLIM 248
UUPEDIF 249
UUPVREC 249
UUPXML 249
User Report 667
sample 682
setting up 667
utilities 15
see batch utilities
see on-line options
UUPDLIM
user program 248
UUPEDIF
user program 249
UUPVREC
user program 249
UUPXML
user program 249

V
variable cycle 201
variable cycle processing 399
VSAM file organization
input source 246
VSAM ONEROW processing 423
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W
windows
parts of 20
write to operator messages
user options 123

X
XML 179
XML options 128
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